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1 System components

This section contains information on the use of steel and concrete system
components that ship with Tekla Structures.

Components are tools that you can use to connect parts in the model.
Components automate tasks and group objects so that Tekla Structures treats
them as a single unit. You can save the properties of a component and use
them in other projects. Tekla Structures contains a wide range of predefined
system components by default.

Components adapt to changes in the model, which means that Tekla
Structures automatically modifies a component if you modify the parts it
connects.

All components are stored in the Applications & components catalog. Click
the Applications & components button in the side pane to open the
Applications & components catalog.

See also

Steel components (page 34)

Concrete components (page 2765)
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2 Steel components

This section contains information on the use of steel components that ship
with Tekla Structures.

If you know which component you need, you can press F1 in the component
dialog box to quickly access the correct help page. Some components use
locally installed help files in a legacy format, which you can only access by
pressing F1 in the component dialog box.

More components are available in Tekla Warehouse for you to download and
install.

You can also modify many of the existing components and create your own
custom components, see .

2.1 Shear tab connections
This section introduces components that can used in shear tab connections.

• Shear plate (34) (page 35)

• Welded shear plate (43) (page 39)

• Shear tab plate connection (80) (page 55)

• Shear plate (103) (page 60)

• Two sided shear plate (118) (page 74)

• Column with shear plate (131) (page 84)

• Bolted moment connection (134) (page 107)

• Shear plate simple (146) (page 133)

• Welded to top flange (147) (page 178)

• Welded to top flange S (149) (page 204)

• Moment connection (181) (page 231)
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• Full depth (184) (page 258)

• Full depth S (185) (page 285)

• JP Full depth special (185) (page 316)

• Shear plate tube column (189) (page 331)

Shear plate (34)
Shear plate (34) connects a beam to a column or to another beam with a
shear tab that is welded to the main part and bolted to the web of the
secondary beam.

Objects created

• Shear tab

• Bolts

• Welds

Use for

Situation Description
Beam connected to a column with a
shear tab that is welded to the main
part and bolted to the secondary part.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Shear tab
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Picture tab
Use the Picture tab to define the connection dimensions.

Dimensions

 Description Default
1 Horizontal distance from the bolt group to the

main part
2 Shear tab edge distance from the secondary

part top and bottom
 

3 Gap between the main part and the secondary
part

10 mm

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
Plate Thickness of the shear

tab
Half the bolt thickness
rounded up to: 8, 10,
12, 16, 20, 25, 30,
35, 40, 45, and so
on.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the shear tab position.

Position

Option Description
Placing Select whether the shear tab is placed

on the left side or on the right side.

Bolts
Define the bolt properties.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Steel components 37 Shear tab connections



Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

General tab

Click the link below to find out more:

General tab
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Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Create welds

Welded shear plate (43)
Welded shear plate (43) connects two beams using a shear tab welded to the
secondary beam web and bolted to a stiffener plate welded to the main part
web.

Objects created

• Shear tab

• Stiffener

• Shim plate

• Bolts

• Welds

Use for

Situation Description
Shear tab welded to the secondary
beam and bolted to a stiffener
welded to the main part.

Limitations

This connection cannot be used for connections between beams and columns.

Selection order

1. Select the main part (beam).
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2. Select the secondary part (beam).

The connection is created automatically when the secondary beam is
selected.

Part identification key

 Description
1 Stiffener
2 Shear tab

Picture tab
Use the Picture tab to define the plate positions.

Dimensions
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 Description Default
1 Edge distance between the stiffener and the

main part flange.
0

2 Shear tab top and bottom edge distance. By default, the
shear tab position
and dimensions are
defined by the bolt
group edge
distances. The
default position for
the shear tab top
and bottom edges
can be overwritten
with the top and
bottom edge
distances.

3 Distance between the stiffener edge and
secondary part end.

 

4 Gap between the main part web and the
shear tab.

10 mm
Changing the value
moves the bolt
group
correspondingly.

5 Edge distance between the shear tab and
stiffener bottom.

 

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
Stiffener Thickness, width and height

of the stiffener.
By default, the height
is defined by the bolt
group vertical edge
distances.

If you do not enter a
width, the stiffener
width will be defined
based on the flange
width. The default
value for the stiffener
thickness is the web
thickness.
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Option Description Default
Plate Thickness and width of the

shear tab.

The height is defined by the
bolt group edge distances.
You can also modify the
height with shear tab top and
bottom distances on the
Picture tab.

The default value for
the end plate
thickness is half of the
screw diameter.

Filler Thickness of the shim plate.  

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the shear tab position, stiffener type and
chamfers, and shim plate assembly.

Sheart tab position

Option Description
Default

Near side

AutoDefaults can change this option.
Automatic

Near side
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Option Description
Near side

Both sides

Far side

Stiffener creation

Option Description
Default

Determined by shear tab

AutoDefaults can change this option.

Full

Determined by shear tab

Tekla Structures determines the size
of the stiffener based on the shear
tab size. Tekla Structures attempts to
keep the bottom edges of the
stiffener plate and shear tab level, if
possible.

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.
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Option Description
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Chamfer dimensions

  
1 Horizontal chamfer dimension
2 Vertical chamfer dimension

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.
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Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Select how to measure the dimensions for horizontal bolt

group position.

• Left: From the left edge of the secondary part to the
leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the

center line of the bolts.

• Right: From the right edge of the secondary part to the
rightmost bolt.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

6 Dimension for vertical bolt group position.

Steel components 46 Shear tab connections



 Description
7 • Top: From the upper edge of the secondary part to the

uppermost bolt.

• Middle: From the center line of the bolts to the center line
of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

Select how to measure the dimensions for vertical bolt group
position.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Notch tab
Use the Notch tab to automatically create notches for the secondary beams
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
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Option Description
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.
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Option Description
Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.
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Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.
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Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.
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Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Shear tab plate connection (80)
Shear tab plate connection (80) connects a beam to a column, or a beam to
a beam, with a shear tab that is bolted to the secondary part and welded to
the main part. It is also possible to create flange stiffeners for beam to column
connections and web stiffeners for beam to beam connections.

Objects created

• Shear tab

• Stiffeners

• Bolts

• Welds

Use for

Situation Description
Beam connected to a column with a
shear tab

Selection order

1. Select the main part (column or beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Shear tab
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Picture tab
Use the Picture tab to define the connection dimensions.

Dimensions

 Description
1 Horizontal distance from the main part to the first bolt
2 Vertical distance from the secondary part upper edge and lower

edge to the shear tab upper and lower edge
3 Gap between the main part and secondary part

By default, the gap value is zero.
4 Distance from the secondary part upper and lower edge to the

upper and lower flange of the stiffener

By default, this distance is zero and the stiffener is created at
secondary part upper and lower edge level.

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
Tab plate Thickness of the shear

tab
10 mm

Upper fl. stiffener Thickness, width, and
height of the stiffener

Lower fl. stiffener Thickness, width, and
height of the stiffener

Web stiffener Thickness, width, and
height of the stiffener

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
where you can enter the
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the beam cut, and the stiffener types and
dimensions.

Beam cut and shear tab location

Option Description
Beam cut • Beveled: Perpendicular to the

beam axis.

This is the default value.

• Square: Square to the main part.
Tab location Tab location in relation to the

secondary beam web.

Both creates two tab plates, one to
the left and another to the right side
of the web.

The default is Left.

Opposite web stiffener

Option Description
Height • Full: Stiffener height is equal to

the distance between the main
part flanges.

This is the default value.

• Partial: Stiffener is cut at the
lower level edge of the shear tab.

• Half: Stiffener height is equal to
Partial + 0.5*(Full - Partial).
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Option Description

Tolerance Vertical distance between the web
stiffener and the main part flanges

By default, the tolerance is zero.
Angle Define the angle.

By default, the angle is zero.
Chamfer type Select the chamfer type.

No chamfer usually causes a clash
between the stiffener and the I profile
rounding.

Chamfer X Horizontal chamfer dimension

For arc chamfers, the horizontal
dimension is the radius of the arc.

Chamfer Y Vertical chamfer dimension

Flange stiffeners

  
Tolerance Distance between the flange

stiffeners and the main part flanges

By default, the tolerance is zero.
Chamfer type Select the chamfer type.

No chamfer usually causes a clash
between the stiffener and the I profile
rounding.

By default, a line chamfer is created.
Chamfer X Horizontal chamfer dimension

For arc chamfers, the horizontal
dimension is the radius of the arc.

Chamfer Y Vertical chamfer dimension
Direction • Column: Stiffeners are

perpendicular to the main part.

• Beam: Stiffeners are parallel to
the secondary part flange.
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General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Bolt properties

Define the bolt properties and bolt group dimensions.

Click the link below to find out more:

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Welds

Click the link below to find out more:

Create welds

Shear plate (103)
Shear plate (103) connects a beam to a beam or to a column with a shear tab.
The shear tab is welded to the main part and bolted to the secondary beam.

Objects created

• Shear tab

• Bolts

• Welds

• Cuts
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Use for

Situation Description
Shear tab connected to a beam.

Shear tab connected to a beam.

The secondary beam is skewed.

Shear tab connected to a beam.

The secondary beam is sloped and skewed.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary beam is
selected.
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Part identification key

 Part
1 Shear tab

Picture tab
Use the Picture tab to control the position of the shear tab.

Shear tab dimensions

 Description
1 Cut of the secondary part.

Cutting the secondary part creates a gap between the main part and
the secondary part.

The cut is defined from the main part web.
2 Distance from the top edge of the secondary beam to the top edge of

the shear plate.
3 Distance from the bottom edge of the secondary beam to the bottom

edge of the shear tab.
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Shear tab position

Option Description
Default

The shear tab is on the left side of the
secondary beam web.

AutoDefaults can change this option.
The shear tab is on the left side of the
secondary beam web.

The shear tab is on the right side of
the secondary beam web.

Beam flange cut

Option Description
Default

Square

AutoDefaults can change this option.
Cuts the end of the flange bevel.

Cuts the end of the flange square.

Parts tab
Use the Parts tab to control the shear tab properties.

Shear plate

Part Description
Plate Shear tab thickness and height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
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Option Description
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.
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Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.
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Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
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Option Description
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions
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 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

BCSA notch definition

Define whether the notch is created according to British Constructional
Steelwork Association (BCSA) specifications.

Option Description
Default Notch dimensions.
Yes Creates a 50 mm notch for simple beam-to-beam

connections.
No Use the options on this Notch tab to define the notch

dimensions.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

2 Number of bolts.
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 Description
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each space
between bolts. For example, if there are 3 bolts, enter 2 values.

4 Dimension for horizontal bolt group position.
5 Dimension for vertical bolt group position.
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.
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 Description
• Below: From the lower edge of the secondary part to the lowest bolt.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.
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Option Description Default
Thread in mat Defines whether the

thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Bolting direction 2

General tab
Click the link below to find out more:

General tab

Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab
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Welds
Click the link below to find out more:

Two sided shear plate (118)
Two sided shear plate (118) connects two beams to a beam or a column with
shear tabs. The shear tabs are welded to the main beam or column, and
bolted to the secondary beams.

Objects created

• Shear tabs (2)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Simple shear tabs connected to a beam.
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Situation Description
Simple shear tabs connected to a beam.

The other secondary beam is sloped.

Simple shear tabs connected to a column
web.

Limitations

The upper edges on the shear tabs should be on the same level.

Selection order

1. Select the main part (beam or column).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.

Part identification key

 Part
1 Shear tab
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Picture tab
Use the Picture tab to control the position of the shear tabs.

Shear tab dimensions

 Description Default
1 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

The cut is defined from the main part web.
2 Distance from the bottom edge of the

secondary beam to the bottom edge of the
shear tab.

3 Distance from the top edge of the first
secondary beam to the top edge of the shear
plate. The top edges of the shear tabs are
aligned to the same level.

50 mm

Shear tab position

Option Description
Default

The shear tab is on the left side of the
secondary beam web.

AutoDefaults can change this option.
The shear tab is on the left side of the
secondary beam web.
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Option Description
The shear tab is on the right side of
the secondary beam web.

Beam flange cut

Option Description
Default

Square

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.

Square

Cuts the end of the flange square.

Parts tab
Use the Parts tab to control the shear tab properties.

Part Description
Plate Shear tab thickness and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Notch tab
Use the Notch tab to create notches for the secondary beams and to control
the notch properties. Define the notches for both secondary beams.

Notch shape

Define the notch shape for the top and the bottom of the secondary beam.

Option Option Description
Default

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

AutoDefaults can change
this option.
No notch

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

Define the notch
dimensions. In beam-to-
beam connections with a
sloped secondary beam,
the depth is measured
as shown in the picture.

Creates a notch on both
sides of the secondary
part.

Define the notch
dimensions.
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Option Option Description
Creates a chamfered
notch on both sides of
the secondary beam.

Define the chamfer
dimensions.
Creates a strip.

Define the length of the
strip. The flanges are cut
completely.
Creates a special type of
square notch.

Define the notch
dimensions. The notch is
square to the secondary
beam. There are no
default values for the
length or the depth.

Notch dimensions

Define the top and the bottom dimensions of the notch if you have set the
BCSA notch def option to No.

 Description
1 Vertical notch dimension.
2 Horizontal notch dimension.

Notching side

Define on which side of the secondary beam the notch is created. You can
define the side for both the top and the bottom of the secondary beam.
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Option Description
Default

Creates notches on both sides.

AutoDefaults can change this option.
Creates notches on both sides.

Creates a notch on the left side.

Creates a notch on the right side.

BCSA notch definition

Define whether the notch is created according to British Constructional
Steelwork Association (BCSA) specifications.

Option Description
Default Notch dimensions.
Yes Creates a 50 mm notch for simple beam-to-beam

connections.
No Use the options on this Notch tab to define the notch

dimensions.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions
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 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

4 Define the horizontal bolt edge distance.
5 Dimension for vertical bolt group position.
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.
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 Description
• Below: From the lower edge of the secondary part to the lowest

bolt.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.
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Option Description Default
Tolerance Gap between the bolt

and the hole.
 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.
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If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Column with shear plate (131)
Column with shear plate (131) connects a beam to a column with a single
shear tab or double shear tabs. The shear tab is welded to the main part web
and stiffeners, and bolted to the secondary part web. The secondary beam can
be leveled or sloped.
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Objects created

• Shear tabs (1 or 2)

• Stiffeners (optional)

• Welds

• Bolts

• Cuts

Use for

Option Description
Two shear tabs and four stiffeners.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key
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 Part
1 Shear tab

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Picture tab
Use the Picture tab to control the position of the shear tab, and the beam
flange and the web cuts.

Dimensions

Description Default
1 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

10 mm

2 Height of the chamfered part of the shear
tab.

50 mm

3 Distance from the edge of the main part to
the corner of the shear tab.

20 mm

4 Size of the strip made to the secondary part
flange.

The cut of the flange is defined from the
shear tab edge.

20 mm
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Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.

Beam web cut

Define how the secondary beam web end is cut. The beam is viewed from the
top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the web bevel when
the end of the secondary beam is cut
bevel.
Square

Cuts the end of the web square even
if the end of the secondary beam is
cut bevel.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.
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Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Beam bottom flange cut

Option Description
Default

Notch

Define the notch dimensions.

AutoDefaults can change this option.
Notch

Define the notch dimensions.

The bottom of the secondary beam is
notched if the shear tab crosses the
flange.
Flange cut

The secondary beam flange is cut on
the same side as the shear tab if the
shear tab crosses the flange.

Plates tab
Use the Plates tab to control the size, position, number, orientation and shape
of the shear tab.

Shear tab plate

Option Description
Tab plate Shear tab plate thickness, width and

height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shear tab shape

Option Description
Default

Shear tab corner is chamfered.

AutoDefaults can change this option.

Automatic

Shear tab corner is chamfered.

Shear tab corner is chamfered.

Shear tab corner is not chamfered.
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Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer
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Option Description
Concave arc chamfer

Gap between shear tabs

 Description Default
1 Gap between the secondary part web

and shear tab.

This only affects connections with two
shear tabs.

0

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab
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Option Description
Near side and far side shear tab

Near side shear tab

Shear tab orientation

Option Description
Default

Sloped

AutoDefaults can change this option.
Automatic

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Sloped

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Square

Modified sloped

Same as the Sloped option, but the
vertical edge of the shear tab
connected to the secondary beam is
cut perpendicular to the secondary
beam flange.

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.
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Stiffener plate dimensions

Option Description
Top NS Top near side stiffener thickness,

width and height.
Top FS Top far side stiffener thickness, width

and height.
Bottom NS Bottom near side stiffener thickness,

width and height.
Bottom FS Bottom far side stiffener thickness,

width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.
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Option Description
Stiffeners are perpendicular to the
main part.

Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.

Stiffeners are created.

Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.

Automatic

Line chamfered stiffener plates
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Option Description
Square stiffener plates

Stiffener plates with a gap for the
main part web rounding

Line chamfered stiffener plates

Stiffener gap

Description
1 Distance from the edge of the flange to the edge of the

stiffener.
2 Size of the gap between the flanges and the stiffener.

Stiffener positions
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 Description
1 Size of the gap between the stiffener and the beam web edge.
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
5 Size of the gap between the top far side stiffener and the beam flange

edge.

Chamfer dimensions

 Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer
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Option Description
Convex arc chamfer

Concave arc chamfer

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.

Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.

 Description
1 Dimension for vertical bolt group position.
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 Description
2 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.
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 Description
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
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Option Description
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.
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Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.
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Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
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Option Description
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
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Option Description
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
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Option Description
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design type tab
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Bolted moment connection (134)
Bolted moment connection (134) connects a beam to a column web or
flange. The shear tab is welded to the main part web or flange, and bolted to
the secondary part web. The secondary part can be leveled or sloped and/or
skewed.

Objects created

• Shear tab (1 or 2)

• Flange plates (2)

• Shim plates

• Stiffeners (optional)

• Web doubler plate (optional)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Beam connected to column web.
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Situation Description
Beam connected to column flange.

Selection order

1. Select the main part (column ).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Shear tab
2 Upper flange plate
3 Lower flange plate
4 Shim plate
4 Stiffener

NOTE Tekla Structures uses values in the joints.def file to create this
component.
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Picture tab
Use the Picture tab to control the position of the shear tab, and the beam
flange and web cuts.

Dimensions

 Description
1 Shear tab edge distance from the main part flange edge.
2 Cut of the secondary part.

Cutting the secondary part creates a gap between the main part and
the secondary part.

3 Distance from the shim plate edge to the flange plate edge.
4 Distance from the edge of the secondary part to the edge of the flange

plate.

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
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Option Description
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.

Beam bevel cut

 Description
1 Bevel of the beam end cut.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Shear plate tab
Use the Shear plate tab to control the size, position, number, orientation and
shape of the shear tab.
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Shear tab

Option Description
Tab plate Shear tab plate thickness, width and

height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.
3 Vertical and the horizontal dimension of the shear tab chamfer.
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Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Chamfer type dimensions

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer
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Option Description
Line chamfer

Concave arc chamfer

Shear tab orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square

Sloped

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Square

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
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Option Description
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab

Near side and far side shear tab

Near side shear tab

Flange plate tab
Use the Flange plate tab to control the size, position, number, orientation and
shape of the flange plates and shim plates.

Plates

Part Description Default
Upper flange plate Upper flange plate

thickness.
20 mm

Lower flange plate Lower flange plate
thickness.

20 mm

Upper deck fill Upper deck shim plate
thickness and width.

10 mm

Lower deck fill Lower deck shim plate
thickness and width.

0

Upper loose fill Upper shim plate
thickness.

 

Lower loose fill Lower shim plate
thickness.

 

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Flange plate chamfers

Description
1 Horizontal dimension of the flange

plate chamfer.
2 Vertical dimension of the flange plate

chamfer.
3 Vertical and horizontal dimension of

the flange plate chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.
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Option Description
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Chamfer type dimensions

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer
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Option Description
Concave arc chamfer

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position, and type.

Stiffener plate dimensions

Option Description
Top NS Top near side stiffener thickness,

width and height.
Top FS Top far side stiffener thickness, width

and height.
Bottom NS Bottom near side stiffener thickness,

width and height.
Bottom FS Bottom far side stiffener thickness,

width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.

Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.

Stiffeners are created.
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Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.

Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding

Line chamfered stiffener plates

Stiffener gap

Description
1 Distance from the edge of the flange to the edge of the

stiffener.
2 Size of the gap between the flanges and the stiffener.
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Stiffener positions

 Description
1 Size of the gap between the near side stiffener and the

beam web edge.
2 Size of the gap between the top near side stiffener and

the beam flange edge.
3 Size of the gap between the bottom near side stiffener

and the beam flange edge.
4 Size of the gap between the top far side stiffener and

the beam flange edge.
5 Size of the gap between the bottom far side stiffener

and the beam flange edge.
6 Size of the gap between the far side stiffener and the

beam web edge.

Chamfer dimensions

 Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm
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Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Line and arc chamfer

Shear bolts tab
Use the Shear bolts tab to control the properties of the bolts that connect the
shear tab to the secondary part.

Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.
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 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest bolt.

7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1
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Option Description
Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Flange bolts tab
Use the Flange bolts tab to control the properties of the bolts that connect
the flange plate to the secondary part.

Bolt group dimensions

Bolt group dimensions affect the size and shape of the flange plate.
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 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest bolt.

7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

8 Flange plate edge distance from the main part web.
9 Select the offset origin part for the bolt group.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered
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Option Description
Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Slots in deck fill plates and loose fill plates

Option Description
Slots in deck fill plates, Slots in
loose fill plates

Select whether slottes holes are
created in deck fill and loose fill
plates.

Doubler plate tab
Use the Doubler plate tab to create doubler plates to strengthen the web of
the main part.

Web plate

Option Description
Web plate Web plate thickness and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Doubler plates

Option Description
Default

Doubler plates are not created.

AutoDefaults can change this option.

Doubler plates are not created.

Doubler plate is created on the far
side.

Doubler plate is created on the near
side.

Doubler plates are created on both
sides.

Doubler plate edge shape

Option Description
Default

Bevel doubler plates

AutoDefaults can change this option.
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Option Description
Bevel doubler plates

Enter the angle in 

Square doubler plates

Doubler plate cuts

Option Description
Default

Doubler plates are not cut.

AutoDefaults can change this option.

Doubler plates are not cut.

Doubler plates are cut in the area that
connects the main part web and
flange.
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General settings

Description
1 Edge distance from the column flange.
2 Doubler plate edge distance.

Edge distance is the distance from the center of a hole to the edge of
the part.

3 Edge distance of the doubler plate in relation to the bottom of the
secondary part.

4 Number of holes.
5 Hole spacing.

Use a space to separate hole spacing values. Enter a value for each
space between holes. For example, if there are 3 holes, enter 2
values.
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Weld hole size

 Description
1 Hole diameter.
2 Slot length.
3 Slot width.

General tab

Click the link below to find out more:

General tab

Design type tab

Click the link below to find out more:

Design type tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Shear plate simple (146)
Shear plate simple (146) connects a beam to a beam, or a beam to a column
with a single square shear tab or double shear tabs. The shear tab is welded to
the main part web and flanges, and bolted to the secondary beam web. The
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secondary beam can be leveled or sloped and/or skewed. A stiffener plate on
the opposite side of the main beam web is optional.

Objects created

• Shear tab (1 or 2)

• Stiffener (optional)

• Haunch plates (optional)

• Weld backing bars (optional)

• Seat angles

• Welds

• Bolts

• Cuts

Use for

Situation Description
Simple shear tab connected to a beam.

Simple shear tab connected to a beam.

Some bolts have been deleted.
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Situation Description
Simple shear tab connected to a beam.

The secondary part is skewed.

Simple shear tab connected to a beam.

The secondary part is sloped and skewed. The
bolts and shear tab are parallel with the
secondary part.

Simple shear tab connected to a beam with
haunches and a stiffener plate.

Simple shear tab connected to a beam.

The secondary part is sloped and skewed.
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Situation Description
Simple shear tab connected to a column flange.

Simple shear tab connected to a column flange/
edge.

Simple shear tab connected to a column flange
with seat angle options.

Simple shear tab connected to a column flange.

Some bolts have been deleted.

Selection order

1. Select the main part (column or beam).
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2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Part identification key

 Part
1 Shear tab
2 Haunch plate

Picture tab
Use the Picture tab to control the beam end, flange, and web cuts.

Dimensions
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 Description Default
1 Size of the strip made to the secondary part

flange.

The cut of the flange is defined from the
shear tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

20 mm
2 The beam gap dimension adjusts the gap

between the main part web and the
secondary beam web.

The dimension is measured either square to
the main part or in the same direction as the
secondary part. This option applies in square
and skewed framing conditions.

The dimension is only used when the Beam
end cut option is set to default or
automatic.

20 mm

Square to the main part

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.
Square cut closer to the main part
web

Cuts the end of the secondary beam
square and places the beam closer to
the main part web.
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Option Description
Clipped flange

Cuts the corner of the flange at the
end of the secondary beam.

Beam web cut

Define how the secondary beam web end is cut. The beam is viewed from the
top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the web bevel when
the end of the secondary beam is cut
bevel.
Square

Cuts the end of the web square even
if the end of the secondary beam is
cut bevel.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.
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Beam bottom flange cut

Option Description
Default

Flange cut

AutoDefaults can change this option.
Notch

The bottom of the secondary beam is
notched if the shear tab crosses the
flange.

Enter the notch radius and height.
Flange cut

The secondary beam flange is cut on
the same side as the shear tab if the
shear tab crosses the flange.

Plates tab
Use the Plates tab to control the size, position, number, orientation and shape
of the shear tab.

Parts

Option Description
Tab plate Shear tab plate thickness, width and height.
Plate washer Plate washer thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Option Description Default
Finish Describes how the part

surface has been
treated.

 

Shear tab position

Define the number and the side of shear tabs in single shear tab connections.

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab

Near side and far side shear tab

Near side shear tab

Gap between shear tab and secondary part

   
1 Gap between the secondary part web

and the shear tab.
0
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Shear tab position (sloped)

Define the position of shear tabs. The secondary part is sloped.

Option Description
Default

Shear tab edges reach the same level
in the main part.

AutoDefaults can change this option.
Shear tab edges reach the same level
in the main part.

Shear tabs have the same length.

Shear tab edge distance

Description
1 Distance between the main part web and the edge of the shear tabs.

Shear tab end cut

Option Description
Default

The shear tab end is not cut.

AutoDefaults can change this option.
Square

The shear tab end is not cut.

Bevel

The shear tab end is cut parallel to
the main part web.
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Shear tab chamfers

Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.

Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Shear tab orientation

Option Description
Default

Sloped

AutoDefaults can change this option.
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Option Description
Automatic

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Sloped

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Square

Modified sloped

Same as the Sloped option, but the
vertical edge of the shear tab
connected to the secondary beam is
cut perpendicular to the secondary
beam flange.

Plate washer

Define plate washers for bolts and select the plate washer side.

Option Description
Default

No plate washer

AutoDefaults can change this option.

No plate washer

One plate washer
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Option Description
Individual square plate washers for
each bolt

Individual round plate washers for
each bolt

Option Description
Select whether the plate washer is
created for one shear tab or both
shear tabs.

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.

Opposite web stiffener plate dimensions

Option Description
Opposite web stiffener Opposite web stiffener plate

thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Stiffener creation

Option Description
Default

No stiffeners are created.

AutoDefaults can change this option.

Full

Creates a full stiffener of the same
height as the web of the main part.

Determined by shear tab

Tekla Structures determines the size
of the stiffener based on the shear
tab size. Tekla Structures attempts to
keep the bottom edges of the
stiffener plate and shear tab level, if
possible.
Partial

Leaves a gap between the stiffener
plate and the bottom flange of the
main part.
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Option Description
No stiffeners are created.

Stiffener gap

 Description
1 Size of the gap between the main part flanges and the stiffener.
2 Size of the gap between the main part web and the stiffener.

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.
Stiffeners are perpendicular to the
main part.

Stiffeners are parallel to the
secondary part.

Stiffener chamfers
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 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Steel components 149 Shear tab connections



Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).

Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
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Option Description
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Creates notches on both sides of the secondary
beam. The cuts are square to the secondary beam.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.
The notch size is measured from the edge of the
main beam flange and from the outer edge of the
top flange of the main beam.

Enter the horizontal and vertical values for the cuts.

Steel components 151 Shear tab connections



Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
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Option Description
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
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Option Description
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
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Option Description
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Dimension from web to flange cut
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 Description
1 Define the distance between the web and the flange cut.

BCSA notch definition

Define whether the notch is created according to British Constructional
Steelwork Association (BCSA) specifications.

Option Description
Default Notch dimensions.
Yes Creates a 50 mm notch for simple beam-to-beam

connections.
No Use the options on this Notch tab to define the notch

dimensions.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.

Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.

 Description
1 Dimension for horizontal bolt group position.

When the secondary beam is sloped or skewed, define whether the
horizontal dimension is measured from the bolt group to the edge of
the secondary part, or from the bolt group to the main part web.

• Sloped, to the secondary part
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 Description
• Skewed, to the secondary part

• Sloped, to the main part

• Skewed, to the main part

The default is that the horizontal dimension is measured from the bolt
group to the edge of the secondary part.

Ensure that the Beam end cut on the Picture tab is set to square

.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.

When the secondary beam is sloped, define whether the vertical
dimension is measured from the bolt group to the edge of the
secondary part, or from the bolt group to the edge of the main part.

• Vertical sloped dimension, to the secondary part

• Vertical dimension, to the secondary part
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 Description
• Vertical dimension, to the main part

• Vertical dimension, to the center line of the main part

The default is that the vertical dimension is measured from the bolt
group the edge of the secondary part (sloped dimension).

Ensure that the Beam end cut on the Picture tab is set to square

.
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.
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 Description
• Below: From the lower edge of the secondary part to the lowest

bolt.

7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from
top to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4
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Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Bolting direction 2

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.
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Option Description Default
Thread in mat Defines whether the

thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.
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Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access hole types

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.
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Option Description Default
Round weld access hole  

Square weld access hole  

Diagonal weld access
hole

 

Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
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Option Description
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.

Top flange is prepared.

Bottom flange is prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.

Weld backing bar creation

Option for bottom backing bar Description
Default

Backing bars are created inside the
flanges.

AutoDefaults can change this option.
No backing bars are created.

Backing bars are created inside the
flanges.
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Option for bottom backing bar Description
Backing bars are created outside the
flanges.

Weld backing bar length

Enter the length of the weld backing bar in the box below the options.

Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange

Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

Angle box tab
Use the Angle box tab to add a seat angle.
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Seat angle

The purpose of seat angles is to carry loads from the secondary part. Seat
angles can be positioned to top, bottom or both flanges of the secondary part.
The seat angle can be stiffened, and bolted or welded to the main and
secondary parts.

Option Description
Stiffeners Stiffener thickness, width and height.
Profile Seat angle profile by selecting it from

the profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Seat angle position

Option Description
Default

No seat angle is created.

AutoDefaults can change this option.
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Option Description
No seat angle is created.

Seat angle is created at the top of the
flange.

Seat angle is created at the bottom of
the flange.

Seat angles are created on both sides
of the flange.

Seat angle attachment

Seat angle is positioned at the top or at the bottom of the secondary part.

Option for top seat
angle

Option for bottom seat
angle

Description

Default

Bolted

Seat angle is bolted to
the main part and to the
secondary part.

AutoDefaults can change
this option.
Bolted

Seat angle is bolted to
the main part and to the
secondary part.
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Option for top seat
angle

Option for bottom seat
angle

Description

Welded-bolted

Seat angle is welded to
the main part and bolted
to the secondary part.

Bolted-welded

Seat angle is bolted to
the main part and
welded to the secondary
part.

Welded

Seat angle is welded to
the main part and to the
secondary part.

Seat angle stiffener type

Option Description
Default

Rectangular stiffener plate

AutoDefaults can change this option.
Rectangular stiffener plate

Triangular stiffener plate

The line connecting the ends of the
seat angle legs defines the stiffener
plate shape.

Stiffener offset dimension

Define the offset of bevel cuts for triangular stiffeners.
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 Description
1 Horizontal offset dimension
2 Vertical offset dimension

Seat angle rotation

Option Description
Default

Seat angle is not rotated.

AutoDefaults can change this option.
Seat angle is not rotated.

Seat angle is rotated horizontally 90
degrees.

To stiffen the rotated seat angle,
select the Middle stiffeners option in
the Middle stiffener position list.

Seat angle orientation

Option Description
Default

The longer leg of the seat angle is
connected to the secondary part.

AutoDefaults can change this option.
The longer leg of the seat angle is
connected to the secondary part.

The longer leg of the seat angle is
connected to the main part.

Automatic

The longer leg of the seat angle is
connected to the part where bolts
reach furthest from the seat angle
corner.
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Seat angle side stiffener position

Option Description
Default

No side stiffeners are created.

AutoDefaults can change this option.
No side stiffeners are created.

Near side stiffeners are created.

Far side stiffeners are created.

Near side and far side stiffeners are
created.

Seat angle middle stiffener position

Option Description
Default

According to bolts

AutoDefaults can change this option.
No middle stiffener plate is created.

Middle stiffeners

The stiffener plate is positioned in the
middle of the seat angle.

Enter the number of middle stiffeners
in the Number of middle stiffeners
box.

Multiple stiffeners are centered and
equally spaced.
According to bolts

The stiffener plate is positioned
between the bolts in the middle of
the bolt spacing.
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Option Description
By default, stiffener is created
between every two bolts.

Enter the number of middle stiffeners
in the box below the According to
bolts option.

Seat angle offset

 Description
1 Seat angle horizontal offset from the center line of the main

part.

Seat angle gap

 Description
1 Top gap and bottom gap between the seat angle and the secondary

part.
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Seat angle chamfers

 Description
1 Vertical dimension of the chamfer.
2 Horizontal dimension of the chamfer.

Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer
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BoxPBolts tab
Use the BoxPBolts tab to control properties of the bolts that connect the seat
angle to the main part.

Seat angle bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.

The dimension is defined from the middle line of the secondary beam.
2 Edge distance is the distance from the center of a bolt to the edge of

the part.

Bolt edge distance.
3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.

The dimension is defined from the bottom of the secondary beam.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.
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Option Description Default
Bolt standard Bolt standard to be used

inside the component.
Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

• Top refers to the bolt group that connects the top seat angle to the main
part.

• Bottom refers to the bolt group that connects the bottom seat angle to the
main part.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

BoxSBolts tab
Use the BoxSBolts tab to control the properties of the bolts that connect the
seat angle to the secondary part.

Seat angle bolt group dimensions

 Description
1 Dimension for vertical bolt group position.

The dimension is defined from the middle line of the secondary beam.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for horizontal bolt group position.

The dimension is defined from the bottom of the secondary beam.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.
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Option Description Default
Bolt standard Bolt standard to be used

inside the component.
Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

• Top refers to the bolt group that connects the top seat angle to the
secondary part.

• Bottom refers to the bolt group that connects the bottom seat angle to the
secondary part.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

General tab

Click the link below to find out more:

General tab

Design type tab

Click the link below to find out more:

Design type tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Welded to top flange (147)
Welded to top flange (147) connects two beams with a single shear tab or
double shear tabs. The shear tabs are welded to the main beam web and the
top flange, and bolted to secondary beam web. The secondary beam can be
leveled or sloped.

Objects created

• Shear tab (1 or 2)

• Stiffeners (optional)

• Haunch plates (optional)

• Weld backing bars (optional)

• Seat angles (optional)

• Bolts

• Welds
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• Cuts

Use for

Situation Description
Partial depth shear tab connected to the top flange
of a beam. Stiffener is created.

Partial depth shear tab connected to the top flange
of a beam. The secondary part is sloped. Stiffener
is created.

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key
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 Part
1 Shear tab

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Picture tab
Use the Picture tab to control the position of the shear tab, and the beam
flange and the web cuts.

Description Default
1 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

20

2 Size of the strip made to the secondary part
flange.

The cut of the flange is defined from the
shear tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

20

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.
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Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.
Square cut closer to the main part
web

Cuts the end of the secondary beam
square and places the beam closer to
the main part web.
Clipped flange

Cuts the corner of the flange at the
end of the secondary beam.

Beam web cut

Define how the secondary beam web end is cut. The beam is viewed from the
top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the web bevel when
the end of the secondary beam is cut
bevel.
Square

Cuts the end of the web square even
if the end of the secondary beam is
cut bevel.
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Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Beam bottom flange cut

Option Description
Default

Flange cut

AutoDefaults can change this option.
Notch

The bottom of the secondary beam is
notched if the shear tab crosses the
flange.

Enter the notch radius and height.
Flange cut

The secondary beam flange is cut on
the same side as the shear tab if the
shear tab crosses the flange.

Plates tab
Use the Plates tab to control the size, position, number, orientation and shape
of the shear tab.

Shear tab plate

Option Description
Tab plate Shear tab plate thickness, width and

height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.
3 Horizontal dimension of the shear tab exterior chamfer.
4 Vertical dimension of the shear tab exterior chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.
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Option Description
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab
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Option Description
Near side and far side shear tab

Near side shear tab

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.

Opposite web stiffener plate dimensions

Option Description
Opposite web stiffener Opposite web stiffener plate

thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Chamfer dimensions
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 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Stiffener creation

Option Description
Default

No stiffeners are created.

AutoDefaults can change this option.

Full

Creates a full stiffener of the same
height as the web of the main part.
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Option Description
Determined by shear tab

Tekla Structures determines the size
of the stiffener based on the shear
tab size. Tekla Structures attempts to
keep the bottom edges of the
stiffener plate and shear tab level, if
possible.
Partial

Leaves a gap between the stiffener
plate and the bottom flange of the
main part.

No stiffeners are created.

Stiffener gap

 Description
1 Size of the gap between the main part flanges and the stiffener.

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.
Stiffeners are perpendicular to the
main part.

Stiffeners are parallel to the
secondary part.

Steel components 187 Shear tab connections



Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
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Description
4 Width of the bottom haunch plate chamfer.

Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).

Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.
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Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
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Option Description
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.
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Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.
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Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.
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Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Dimension from web to flange cut

 Description
1 Define the distance between the web and the flange cut.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the main part.
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Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

4 Dimension for vertical bolt group position.
5 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

6 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within

Yes
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Option Description Default
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
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Option Description
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole
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Option Description Default
Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.
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Option Description
Top flange is prepared.

Bottom flange is prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.

Weld backing bars

Option for bottom backing bar Description
Default

Backing bars are created inside the
flanges.

AutoDefaults can change this option.
No backing bars are created.

Backing bars are created inside the
flanges.

Backing bars are created outside the
flanges.

Weld backing bar length

Enter the length of the weld backing bar in the box below the options.
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Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange

Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Welded to top flange S (149)
Welded to top flange S (149) connects two beams with a single shear tab or
double shear tab. The shear tabs are welded to the main beam web and the
top flange, and bolted to secondary beam web. The secondary beam can be
leveled or sloped.

Objects created

• Shear tab (1 or 2)

• Stiffener (optional)

• Haunch plates (optional)

• Weld backing bars (optional)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Partial depth shear tab connected to the
top flange of a beam.
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Situation Description
Partial depth shear tab connected to the
top flange of a beam. Stiffener is created.

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Shear tab
2 Haunch plate

NOTE Tekla Structures uses values in the joints.def file to create this
component.
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Picture tab
Use the Picture tab to control the position of the shear tab, and the beam
flange and the web cuts.

Dimensions

Description Default
1 Shear tab edge distance from the main part

flange edge.
0

2 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

20

3 Size of the strip made to the secondary part
flange.

The cut of the flange is defined from the
shear tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

20

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
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Option Description
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.
Square cut closer to the main part
web

Cuts the end of the secondary beam
square and places the beam closer to
the main part web.
Clipped flange

Cuts the corner of the flange at the
end of the secondary beam.

Beam web cut

Define how the secondary beam web end is cut. The beam is viewed from the
top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the web bevel when
the end of the secondary beam is cut
bevel.
Square

Cuts the end of the web square even
if the end of the secondary beam is
cut bevel.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.
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Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Beam bottom flange cut

Option Description
Default

Flange cut

AutoDefaults can change this option.
Notch

The bottom of the secondary beam is
notched if the shear tab crosses the
flange.

Enter the notch radius and height.
Flange cut

The secondary beam flange is cut on
the same side as the shear tab if the
shear tab crosses the flange.

Plates tab
Use the Plates tab to control the size, position, number, orientation and shape
of the shear tab.

Shear tab plate

Option Description
Tab plate Shear tab plate thickness, width and

height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.
3 Vertical and the horizontal dimension of the shear tab chamfer.

Steel components 209 Shear tab connections



Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Chamfer type dimensions

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer
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Option Description
Line chamfer

Concave arc chamfer

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab

Near side and far side shear tab

Near side shear tab
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Gap between shear tabs

 Description Default
1 Gap between the secondary part web

and shear tab.

This only affects connections with two
shear tabs.

0

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.

Opposite web stiffener plate dimensions

Option Description
Opposite web stiffener Opposite web stiffener plate

thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer
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Stiffener creation

Option Description
Default

No stiffeners are created.

AutoDefaults can change this option.

Full

Creates a full stiffener of the same
height as the web of the main part.

Determined by shear tab

Tekla Structures determines the size
of the stiffener based on the shear
tab size. Tekla Structures attempts to
keep the bottom edges of the
stiffener plate and shear tab level, if
possible.
Partial

Leaves a gap between the stiffener
plate and the bottom flange of the
main part.

No stiffeners are created.

Stiffener gap

 Description
1 Size of the gap between the main part flanges and the stiffener.
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Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.
Stiffeners are perpendicular to the
main part.

Stiffeners are parallel to the
secondary part.

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

Steel components 215 Shear tab connections



Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).
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Option Description
Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
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Option Description
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.
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Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.
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Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.
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Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.
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Dimension from web to flange cut

 Description
1 Define the distance between the web and the flange cut.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the main part.

Bolt group dimensions

Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.
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Description
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest bolt.
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Description
7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered
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Option Description
Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Bolting direction 2
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Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
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 Description
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole

 

Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and
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Option Description Default
Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.

Top flange is prepared.

Bottom flange is prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
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Option for top flange Option for bottom
flange

Description

Flange is not cut.

Flange is cut.

Weld backing bars

Option for bottom backing bar Description
Default

Backing bars are created inside the
flanges.

AutoDefaults can change this option.
No backing bars are created.

Backing bars are created inside the
flanges.

Backing bars are created outside the
flanges.

Weld backing bar length

Enter the length of the weld backing bar in the box below the options.

Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange
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Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

General tab
Click the links below to find out more:

General tab

Design tab
Click the links below to find out more:

Analysis tab
Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Moment connection (181)
Moment connection (181) connects a beam to a column or to a beam with a
single shear tab or double shear tabs. The shear tab is welded to the main part
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and bolted to the secondary part web. The secondary beam can be leveled or
sloped. Top and bottom flange plates may be welded to the secondary beam
and site-welded to the main column.

Objects created

• Shear tab (1 or 2)

• Top flange plate

• Bottom flange plate

• Stiffeners (4) (optional)

• Web doubler plate (optional)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Moment connection welded to a column
flange. The secondary part is sloped.

Moment connection welded to a column
flange. Beam weld preparation and weld
access hole options.
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Selection order

1. Select the main part (column or beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Shear tab
2 Top flange plate
3 Bottom flange plate
4 Top stiffener plate
5 Bottom stiffener plate

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Picture tab
Use the Picture tab to control the position of the shear tab, and the beam
flange and the web cuts.
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Dimensions

Description
1 Site welding distance from the edge of the top flange plate to the main

part flange.
2 Site welding distance from the edge of the bottom flange plate to the

main part web.
3 Distance from the edge of the shear tab to the top edge of the

secondary part.
4 Chamfer dimension of the shear tab.
5 Distance from the main part flange to the edge of the secondary part.

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
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Option Description
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Plates tab
Use the Plates tab to control the size, position, number, and shape of the
shear tab.

Plates

Option Description
Tab plate Shear tab plate thickness, width and

height.

Option Description
Top plate Top plate thickness, width and height.
Bottom plate Bottom plate thickness, width and

height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shear tab dimensions

 Description
1 Distance from the edge of the main part flange to the edge of the top

and bottom plate.
2 Distance from the flange of the secondary part to the edge of the top

and bottom plate.
3 Width of the chamfered end of the top and bottom plate.
4 Chamfering dimension of the top and bottom plate.

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 
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Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab

Near side and far side shear tab

Near side shear tab

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.

Stiffener plate dimensions

Option Description
Top NS Top near side stiffener thickness,

width and height.
Top FS Top far side stiffener thickness, width

and height.
Bottom NS Bottom near side stiffener thickness,

width and height.
Bottom FS Bottom far side stiffener thickness,

width and height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Stiffener positions

 Description
1 Size of the gap between the stiffener and the beam web edge.
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
5 Size of the gap between the top far side stiffener and the beam flange

edge.
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Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.

Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.

Stiffeners are created.
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Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.

Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding

Line chamfered stiffener plates

Stiffener gap

Description
1 Distance from the edge of the flange to the edge of the

stiffener.
2 Size of the gap between the flanges and the stiffener.
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Chamfer dimensions

 Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
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automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Steel components 242 Shear tab connections



Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.
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Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.
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Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.
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Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.
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Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1
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Option Description
Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Beam cut tab
Use the Beam cut tab to control the weld access holes, beam end
preparations, and flange cuts.

Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.
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 Description
5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access holes

Option Option Description
Default

Round weld access hole

AutoDefaults can change
this option.
Round weld access hole

Square weld access hole

Round weld access hole
with a radius that you
can define in

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.
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Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.

Beam end alignment

Option Description
Default

Beam end is not aligned.

Secondary part flange is not aligned
with the top and bottom plates.

AutoDefaults can change this option.
Beam end is not aligned.

Beam end is aligned.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.
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Option for top flange Option for bottom
flange

Description

Flange is cut.

Doubler plates tab
Use the Doubler plate tab to create doubler plates to strengthen the web of
the main part.

Web plate

Option Description
Web plate Web plate thickness and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Doubler plates

Option Description
Default

Doubler plates are not created.

AutoDefaults can change this option.

Doubler plates are not created.
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Option Description
Doubler plate is created on the far
side.

Doubler plate is created on the near
side.

Doubler plates are created on both
sides.

Doubler plate edge shape

Option Description
Default

Bevel doubler plates

AutoDefaults can change this option.

Bevel doubler plates

Enter the angle in 

Square doubler plates

Doubler plate cuts

Option Description
Default

Doubler plates are not cut.

AutoDefaults can change this option.
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Option Description
Doubler plates are not cut.

Doubler plates are cut in the area that
connects the main part web and
flange.

General settings

Description
1 Edge distance from the column flange.
2 Doubler plate edge distance.

Edge distance is the distance from the center of a hole to the edge of
the part.

3 Edge distance of the doubler plate in relation to the bottom of the
secondary part.

4 Number of holes.
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Description
5 Hole spacing.

Use a space to separate hole spacing values. Enter a value for each
space between holes. For example, if there are 3 holes, enter 2
values.

Weld hole size

 Description
1 Hole diameter.
2 Slot length.
3 Slot width.

General tab

Click the link below to find out more:

General tab

Design type tab

Click the link below to find out more:

Design type tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Full depth (184)
Full depth (184) connects two beams with a full depth shear tab. The shear
tab is welded to the main beam web and flanges, and bolted to the secondary
beam web. The secondary beam can be leveled or sloped. A stiffener plate on
the opposite side of the main beam web and the haunch plates welded to the
secondary beam flanges are optional.

Objects created

• Shear tab (1 or 2)

• Stiffener (optional)

• Haunch plates (optional)

• Weld backing bars (optional)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Full depth shear tab.

Full depth connection with a stiffener plate.

Steel components 258 Shear tab connections



Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Shear tab
2 Haunch plate

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Picture tab
Use the Picture tab to control the position of the shear tab, and the beam
flange and the web cuts.
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Dimensions

 Description Default
1 Cut of the secondary part.

The cut is defined from the main part web.

20 mm

2 Shear tab edge distance from the main part
flange edge.

3 Size of the strip made to the secondary part
flange.

The cut of the flange is defined from the
shear tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

10 mm

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
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Option Description
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.
Square cut closer to the main part
web

Cuts the end of the secondary beam
square and places the beam closer to
the main part web.
Clipped flange

Cuts the corner of the flange at the
end of the secondary beam.

Beam web cut

Define how the secondary beam web end is cut. The beam is viewed from the
top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the web bevel when
the end of the secondary beam is cut
bevel.
Square

Cuts the end of the web square even
if the end of the secondary beam is
cut bevel.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
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Option Description
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Beam bottom flange cut

Option Description
Default

Flange cut

AutoDefaults can change this option.
Notch

The bottom of the secondary beam is
notched if the shear tab crosses the
flange.

Enter the notch radius and height.
Flange cut

The secondary beam flange is cut on
the same side as the shear tab if the
shear tab crosses the flange.

Plates tab
Use the Plates tab to control the size, position, number, and shape of the
shear tab.

Shear tab plate

Option Description
Tab plate Shear tab thickness and width.
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Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer
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Option Description
Concave arc chamfer

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab

Near side and far side shear tab

Near side shear tab

Gap between shear tabs
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 Description Default
1 Gap between the secondary part web

and shear tab.

This only affects connections with two
shear tabs.

0

Shear tab end cut

Option Description
Default

The shear tab end is not cut.

AutoDefaults can change this option.
Square

The shear tab end is not cut.

Bevel

The shear tab end is cut parallel to
the main part web.

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.

Opposite web stiffener plate dimensions

Option Description
Opposite web stiffener Opposite web stiffener plate

thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Stiffener creation

Option Description
Default

No stiffeners are created.

AutoDefaults can change this option.

Full

Creates a full stiffener of the same
height as the web of the main part.

Determined by shear tab

Tekla Structures determines the size
of the stiffener based on the shear
tab size. Tekla Structures attempts to
keep the bottom edges of the
stiffener plate and shear tab level, if
possible.
Partial

Leaves a gap between the stiffener
plate and the bottom flange of the
main part.

No stiffeners are created.
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Stiffener gap

 Description
1 Size of the gap between the main part flange and the stiffener.
2 Distance from the edge of the main part flange to the edge of the

stiffener.

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.
Stiffeners are perpendicular to the
main part.

Stiffeners are parallel to the
secondary part.

Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.
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Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.
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Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).

Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
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Option Description
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.
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Option Description
Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.
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Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.
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Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.
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Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Dimension from web to flange cut

 Description
1 Define the distance between the web and the flange cut.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.

Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.
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 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1
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Option Description
Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Steel components 280 Shear tab connections



Option Description Default
Finish Describes how the part

surface has been
treated.

 

Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  
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Option Description Default
Square weld access hole  

Diagonal weld access
hole

 

Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.
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Option Description
Beam end is not prepared.

Top and bottom flange are prepared.

Top flange is prepared.

Bottom flange is prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.

Weld backing bars

Option for top backing
bar

Option for bottom
backing bar

Description

Default

Backing bars are created
inside the flanges.

AutoDefaults can change
this option.
No backing bars are
created.

Backing bars are created
inside the flanges.
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Option for top backing
bar

Option for bottom
backing bar

Description

Backing bars are created
outside the flanges.

Weld backing bar length

Enter the length of the weld backing bar in the box below the options.

Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange

Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

General tab
Click the links below to find out more:

General tab
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Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds tab

Click the link below to find out more:

Full depth S (185)
Full depth S (185) connects two beams with a full depth shear tab. The shear
tab is welded to the main beam web and flanges, and bolted to the secondary
beam web. The secondary beam can be leveled or sloped. A stiffener plate on
the opposite side of the main beam web and the haunch plates welded to the
secondary beam flanges are optional.

Objects created

• Shear tabs (1 or 2)

• Stiffener (optional)

• Haunch plates (optional)

• Weld backing bars (optional)

• Bolts

• Welds

• Cuts
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Use for

Situation Description
Full depth shear tab.

Full depth shear tab.

The secondary part is sloped.

Full depth shear tab.

The secondary part is sloped and skewed.
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Situation Description
Full depth shear tab.

The secondary part is offset. Some bolts
have been deleted.

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Shear tab
2 Haunch plate

NOTE Tekla Structures uses values in the joints.def file to create this
component.
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Picture tab
Use the Picture tab to control the position of the shear tab, and the beam
flange and web cuts.

Dimensions

 Description Default
1 Shear tab edge distance from the main part

flange edge.
0

2 Shear tab edge distance from the main part
flange edge.

0

3 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

20 mm

4 Size of the strip made to the secondary part
flange.

The cut of the flange is defined from the shear
tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

20 mm
5 Gap between the shear tab and the main part

web.
 

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
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Option Description
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.
Square cut closer to the main part
web

Cuts the end of the secondary beam
square and places the beam closer to
the main part web.
Clipped flange

Cuts the corner of the flange at the
end of the secondary beam.

Beam web cut

Define how the secondary beam web end is cut. The beam is viewed from the
top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the web bevel when
the end of the secondary beam is cut
bevel.
Square

Cuts the end of the web square even
if the end of the secondary beam is
cut bevel.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.
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Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Beam bottom flange cut

Option Description
Default

Flange cut

AutoDefaults can change this option.
Notch

The bottom of the secondary beam is
notched if the shear tab crosses the
flange.

Enter the notch radius and height.
Flange cut

The secondary beam flange is cut on
the same side as the shear tab if the
shear tab crosses the flange.

Plates tab
Use the Plates tab to control the size, position, number, and shape of the
shear tab.

Shear tab plate

Option Description
Tab plate Shear tab plate thickness, width and

height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.
3 Vertical and the horizontal dimension of the shear tab chamfer.
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Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Chamfer type dimensions

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer
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Option Description
Line chamfer

Concave arc chamfer

Inner shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.
3 Radius and the vertical dimensions of the shear tab inner chamfer.

Chamfer type

Option Option Description
Default

No chamfer

AutoDefaults can change
this option.
No chamfer

Line chamfer
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Option Option Description
Convex arc chamfer

Concave arc chamfer

Inner chamfer type

Option Description
Default

Concave arc chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Concave arc chamfer

Convex arc chamfer

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.

Steel components 294 Shear tab connections



Option Description
Far side shear tab

Near side and far side shear tab

Near side shear tab

Gap between shear tabs

 Description Default
1 Gap between the secondary part web

and shear tab.
0

Shear tab end cut

Option Description
Default

The shear tab end is not cut.

AutoDefaults can change this option.
Square

The shear tab end is not cut.

Bevel

The shear tab end is cut parallel to
the main part web.
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Shear tab orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square

Sloped

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Square

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.

Opposite web stiffener plate dimensions

Option Description
Opposite web stiffener Opposite web stiffener plate

thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Stiffener creation

Option Description
Default

No stiffeners are created.

AutoDefaults can change this option.

Full

Creates a full stiffener of the same
height as the web of the main part.

Determined by shear tab

Tekla Structures determines the size
of the stiffener based on the shear
tab size. Tekla Structures attempts to
keep the bottom edges of the
stiffener plate and shear tab level, if
possible.
Partial

Leaves a gap between the stiffener
plate and the bottom flange of the
main part.

No stiffeners are created.

Stiffener gap

 Description
1 Size of the gap between the main part flange and the stiffener.
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 Description
2 Distance from the edge of the main part flange to the edge of the

stiffener.
3 Gap between the opposite web stiffener and main part web.

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.
Stiffeners are perpendicular to the
main part.

Stiffeners are parallel to the
secondary part.

Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer
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Option Description
Line chamfer

Convex arc chamfer

Concave arc chamfer

Opposite web stiffener offset

Define the opposite web stiffener offset from the shear tab center line.

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.
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Option Description Default
Name Name that is shown in

drawings and reports.

Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.
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Option Description
Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).

Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Steel components 301 Shear tab connections



Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
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Option Description
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Steel components 303 Shear tab connections



Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
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Option Description
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions
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 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Dimension from web to flange cut

 Description
1 Define the distance between the web and the flange cut.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.

Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.

 Description
1 Dimension for horizontal bolt group position.
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 Description
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.
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 Description
• Below: From the lower edge of the secondary part to the lowest

bolt.

7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4
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Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Bolting direction 2

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole
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Option Description Default
Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.
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Option Description
Top flange is prepared.

Bottom flange is prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.

Weld backing bars

Option for top backing
bar

Option for bottom
backing bar

Description

Default

Backing bars are created
inside the flanges.

AutoDefaults can change
this option.
No backing bars are
created.

Backing bars are created
inside the flanges.

Backing bars are created
outside the flanges.

Weld backing bar length

Enter the length of the weld backing bar in the box below the options.
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Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange

Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

General tab
Click the link below to find out more:

General tab

Design tab
Click the link below to find out more:

Design tab
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Analysis tab
Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

JP Full depth special (185)
JP Full depth special (185) connects two beams with a full depth shear tab.
The shear tab is welded to the main beam web and flanges, and bolted to the
secondary beam web. The secondary beam can be leveled or sloped. A
stiffener plate can be created on the opposite side of the main beam web.

Objects created

• Shear tabs (1 or 2)

• Stiffener (optional)

• Bolts

• Welds

Use for

Situation Description
Full depth shear tab.
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Situation Description
Full depth shear tab.

The secondary part is sloped.

Full depth shear tab.

The secondary part is sloped and skewed.

Full depth shear tab.

The secondary part is offset. Some bolts
have been deleted.

Selection order

1. Select the main part (beam).
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2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Shear tab
2 Stiffener

Picture tab
Use the Picture tab to control the position of the shear tab, and the beam
flange and web cuts.

Dimensions

  
1 Shear tab edge distance from the main part flange edge.
2 Shear tab edge distance from the main part flange edge.
3 Cut of the secondary part.

Cutting the secondary part creates a gap between the
main part and the secondary part.

Steel components 318 Shear tab connections



  
4 Size of the strip made to the secondary part flange.

The cut of the flange is defined from the shear tab edge.

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.
Square cut closer to the main part
web

Cuts the end of the secondary beam
square and places the beam closer to
the main part web.
Clipped flange

Cuts the corner of the flange at the
end of the secondary beam.

Beam web cut

Define how the secondary beam web end is cut. The beam is viewed from the
top.

Option Description
Default

Bevel

AutoDefaults can change this option.
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Option Description
Bevel

Cuts the end of the web bevel when
the end of the secondary beam is cut
bevel.
Square

Cuts the end of the web square even
if the end of the secondary beam is
cut bevel.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Beam bottom flange cut

Option Description
Default

Flange cut

AutoDefaults can change this option.
Notch

The bottom of the secondary beam is
notched if the shear tab crosses the
flange.

Enter the notch radius and height.
Flange cut

The secondary beam flange is cut on
the same side as the shear tab if the
shear tab crosses the flange.
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Option Description
Shear tab cut

Enter the dimension to the secondary
part flange cut.

Shear tab shape

Option Description
Default

Square cut

AutoDefaults can change this option.
Square cut

Bevel cut

Plates tab
Use the Plates tab to control the size, position, number, and shape of the
shear tab.

Shear tab plate

Option Description
Tab plate Shear tab plate thickness, width and

height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Name Name that is shown in

drawings and reports.
 

Shear tab position

Option Description
Default

Near side shear tab

AutoDefaults can change this option.
Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Near side shear tab

Near side and far side shear tab

Far side shear tab

Shear tab orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square

Sloped

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Square
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Shear tab chamfers

 Description
1 Vertical dimension of the shear tab chamfer.
2 Horizontal dimension of the shear tab chamfer.
3 Shear tab chamfer radius.
4 Select the chamfer type.

Inner shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.
3 Shear tab chamfer radius.
4 Select the chamfer type.

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.
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Opposite web stiffener plate dimensions

Option Description
Opposite web stiffener Opposite web stiffener plate

thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Stiffener creation

Option Description
Default

No stiffeners are created.

AutoDefaults can change this option.

Full

Creates a full stiffener of the same
height as the web of the main part.

Determined by shear tab

Tekla Structures determines the size
of the stiffener based on the shear
tab size. Tekla Structures attempts to
keep the bottom edges of the
stiffener plate and shear tab level, if
possible.
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Option Description
Partial

Leaves a gap between the stiffener
plate and the bottom flange of the
main part.

No stiffeners are created.

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.
Stiffeners are perpendicular to the
main part.

Stiffeners are parallel to the
secondary part.

Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.
3 Select the chamfer type.
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Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

5 Dimension for vertical bolt group position.
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 Description
6 Select how to measure the dimensions for vertical bolt

group position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center
line of the secondary part.

• Below: From the lower edge of the secondary part to
the lowest bolt.
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 Description
7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and
separate the numbers with a space. Bolt numbers run
from left to right and from top to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab
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Welds

Click the link below to find out more:

Shear plate tube column (189)
Shear plate tube column (189) connects a beam to a tube column with a
shear tab. The shear tab goes through the tube column.

Objects created

• Shear tab (1 or 2)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Shear tab through a tube column with two
secondary parts.

Shear tab through a tube column with two
secondary parts. Shear tab extends to the top of
the column.
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Situation Description
Shear tab through a tube column with two
secondary parts and bolt alignment options.

The secondary parts can be leveled and/or
sloped.

Shear tab through a tube column with two
secondary parts.

A third secondary part has been added after the
connection was created.

Shear tab through a tube column with one
secondary part.

Selection order

1. Select the main part (column).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the component.
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Part identification key

 Part
1 Shear tab

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Picture tab
Use the Picture tab to control the position of the shear tab and to define how
the beam ends are cut.

Dimensions

 Description Default
1 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

20 mm
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 Description Default
2 Distance from the edge of the main part to

the top corner of the shear tab.
5 mm

3 Distance from the edge of the main part to
the bottom corner of the shear tab.

5 mm

4 Size of the strip made to the secondary part
flange.

The cut of the flange is defined from the
shear tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

20 mm

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Option Description
Default

Bevel

AutoDefaults can change
this option.
Automatic

If the secondary beam is
sloped less than 10
degrees, the beam end
is cut square. Otherwise,
the beam end is cut
bevel.
Square

Cuts the end of the
secondary beam square.
Bevel

Cuts the end of the
secondary beam parallel
to the edge of the main
part.

Plates tab
Use the Plates tab to control the size, position, number, orientation and shape
of the shear tab.
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Shear tab plate

Option Description
Shear plate Plate thickness.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shear tab dimensions

Description
1 Horizontal size of the cut created for the shear tab.

Equal size is created on both sides of the shear tab.
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Description
2 Vertical size of the cut created for the shear tab.

Equal size is created at the top and bottom of the shear tab.
3 Distance from the center line of the shear tab to the center line of the

main part.

Default value 0 places the shear tab at the center line of the main part.
4 Corner radius of the cut created for the shear tab.
5 Vertical dimension of the shear tab chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Concave arc chamfer

Shear tab cut

When the component is created near the column top, the upper edge of the
shear tab can be extended to the top of the column.

Option Description
Default

Line

AutoDefaults can change this option.
Line

Column top

The upper edge of the shear tab is
extended to the top of the main part.
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Shear tab shape

Option Description
Default

Perpendicular to the main part

AutoDefaults can change this option.
Perpendicular to the main part

Automatic

Shear tab edges are aligned in the
direction of the right secondary part.

Shear tab edges are aligned in the
direction of the left secondary part.

The edges of the shear tab are
connected at the intersection of the
secondary part edges.
Defined by both edges

Shear tab orientation

Define the shear tab orientation for both secondary parts.

Option Option Description
Default

Sloped

AutoDefaults can change
this option.
Automatic

Sloped or square

If the secondary part is
sloped less than 10
degrees, a square shear
tab is created.
Otherwise, the shear tab
is sloped in the direction
of the secondary part.
Sloped

Square
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Option Option Description
Sloped with square end
cut

Shear tab top corner shape

Define the shape of the shear tab top corner for both secondary parts.

Option Option Description
Default

Bevel

AutoDefaults can change
this option.
Bevel

Square

Shear tab bottom corner shape

Define the shape of the shear tab bottom corner for both secondary parts.

Option Option Description
Default

Bevel

AutoDefaults can change
this option.
Bevel

Square

Shear tab position

Option Description
Default

Near side

AutoDefaults can change this option.
Automatic

The shear tab is created to the near
side when the angle between the
main part and the secondary part is
less than 90 degrees.
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Option Description
Near side

Both sides

Far side

1stSecBolts and 2ndSecBolts tabs
Use the 1stSecBolts tab and the 2ndSecBolts tab to control the properties of
the bolts that connect the shear tab to the first and the second secondary
part.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
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 Description
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.
6 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered
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Option Description
Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab
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Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

2.2 Clip angle connections
This section introduces clip angle connection components available in Tekla
Structures.

Click the links below to find out more:

• Angle cleat (3) (page 343)

• Two sided angle cleat (25) (page 347)

• Clip angle (116) (page 351)

• Two sided clip angle (117) (page 361)

• Clip angle (141) (page 373)

• Two sided clip angle (143) (page 420)

Angle cleat (3)
Angle cleat (3) connects two beams or a beam to a column using one or two
bolted clip angles.

Objects created

• Clip angle (L profile)

• Bolts

• Welds
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Use for

Situation Description
Clip angle bolted between the parts.
The secondary part can be sloped.

Selection order

1. Select the main part.

2. Select the secondary part.

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Clip angle

Picture tab
Use the Picture tab to define the clip angle length, and the gap between the
main part and the clip angle.

Dimensions
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 Description
1 Clip angle edge distance from the secondary part upper edge.

You can control the clip angle length by defining the distance
from the secondary part upper and lower edge.

2 Clip angle edge distance from the secondary part lower edge.
3 Gap between the main part and the clip angle. By default, the

value is 0.

Parts tab
Use the Parts tab to define the clip angle properties.

Parts

Option Description Default
L profile Select the profile from

the profile catalog.
L150-100-10

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the location of the clip angles.

Steel components 345 Clip angle connections



Placing

Option Description
Placing By default, the clip angle is created on

the left side.

Middle creates two clip angles.

Notch tab
Use the Notch tab to define the secondary part notch dimensions.

Cut dimensions

 Description  
1 Dimension for the horizontal flange cut. 10 mm
2 Dimension for the vertical flange cut. The gap between

the notch edge and
the beam flange is
equal to the main
part web rounding.
The notch height is
rounded up to the
nearest 5 mm.

General tab

Click the link below to find out more:

General tab
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Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Bolts

Click the link below to find out more:

Welds

Click the link below to find out more:

Two sided angle cleat (25)
Two sided angle cleat (25) connects two beams to a beam or to a column
with one or two bolted clip angles.

Objects created

• Clip angles

• Bolts

Use for

Option Description
Two beams connected to a column or
a beam with bolted clip angles.

Selection order

1. Select the main part (column or beam).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

Click the middle mouse button to create the component.
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Part identification key

 Description
1 L profile
2 L profile 2

Picture tab
Use the Picture tab to define the L profile length and the gap between the
main part and the angle profiles. You can control the L profile length with the L
profile edge distance.

Dimensions

 Description
1 L profile edge distance from the first secondary part upper

edge.
2 L profile edge distance from the first secondary part lower edge.
3 Gap between the main part and the angle profile in the first

secondary part.

By default, the value is zero.
4 L profile 2 edge distance from the second secondary part upper

edge.
5 L profile 2 edge distance from the second secondary part lower

edge.
6 Gap between the main part and the angle profile in the second

secondary part.

By default, the value is zero.

Parts tab
Use the Parts tab to define the angle profile properties.
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Parts

Option Description Default
L profile Select the profile from the

profile catalog.
L150-100-10

L profile 2 Select the profile from the
profile catalog.

L150-100-10

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the position of the angle profiles.

Angle profile positions

Option Description
Placing, Placing 2 Define the number and side of angles

in single angle connections separately
for both sides.

Move L-prof. 2 in z direction, Move
L-prof. 2 in y direction

Move the position of angle profiles on
the secondary part side.

By default, the angle profiles are
symmetrical. For example, when
connecting skewed secondary beams,
the offsets can be used for placing the
angle profiles.
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Notch tab
Use the Notch tab to define the secondary part notch dimensions.

Cut dimensions

 Description Default
1 Dimensions for the horizontal flange cuts. 10 mm
2 Dimensions for the vertical flange cuts. The gap

between the
notch edge
and the beam
flange is equal
to the main
part web
rounding. The
notch height
is rounded up
to the nearest
5 mm.

Bolts

Click the link below to find out more:

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Steel components 350 Clip angle connections



Design tab

Click the link below to find out more:

Clip angle (116)
Clip angle (116) connects a beam to a beam or a column with a clip angle.

Objects created

• Clip angle (1 or 2)

• Bolts

• Cuts

Use for

Situation Description
Clip angle connection to a beam web.

Clip angle connection to a beam web.

The secondary beam is sloped.

Clip angle connection to a column flange.
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Situation Description
Clip angle connection to a column flange.

The secondary beam is sloped.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Clip angle

Picture tab
Use the Picture tab to control the clip angle dimensions and the clip angle
position.

Dimensions
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 Description Default
1 Cut length for the secondary part.  
2 Clip angle upper edge distance from the top

of the secondary beam.

The upper edge position of the angle modifies
the clip angle height.

Positive value moves the top position closer
to the beam center and thus decreases the
clip angle size. Negative values increase the
clip angle size.

If no value is entered,
bolts and bolt edge
distances define the size
of the clip angle.

3 Clip angle lower edge distance from the
bottom of the secondary beam.

The lower edge position of the angle modifies
the clip angle height.

Positive value moves the top position closer
to the beam center and thus decreases the
clip angle size. Negative values increase the
clip angle size.

If no value is entered,
bolts and bolt edge
distances define the size
of the clip angle.

4 Gap between the main part and the clip
angle.

 

5 Height of the clip angle.  

Clip angle position

Option Description
Default

Near and far side clip angles are
created.

AutoDefaults can change this option.
Near side clip angle is created.

Near side and far side clip angles are
created.

Far side clip angle is created.

Parts tab
Use the Parts tab to control the properties of the clip angle.
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Clip angle

Part Description
L profile Define the clip angle profile

by selecting it from the
profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Notch tab
Use the Notch tab to create notches for the secondary beam and to control
the notch properties.

BCSA notch definition

Define whether the notch is created according to British Constructional
Steelwork Association (BCSA) specifications.

Option Description
Default Notch dimensions.
Yes Creates a 50 mm notch for simple beam-to-beam

connections.
No Use the options on this Notch tab to define the notch

dimensions.
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Notch dimensions

Define the top and the bottom dimensions of the notch if you have set the
BCSA notch def option to No.

 Description
1 Vertical notch dimension.
2 Horizontal notch dimension.

Notch shape

Define the notch shape for the top and the bottom of the secondary beam.

Option Option Description
Default

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

AutoDefaults can change
this option.
No notch

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

Define the notch
dimensions. In beam-to-
beam connections with a
sloped secondary beam,
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Option Option Description
the depth is measured
as shown in the picture.

Creates a notch on both
sides of the secondary
part.

Define the notch
dimensions.
Creates a chamfered
notch on both sides of
the secondary beam.

Define the chamfer
dimensions.
Creates a strip.

Define the length of the
strip. The flanges are cut
completely.
Creates a special type of
square notch.

Define the notch
dimensions. The notch is
square to the secondary
beam. There are no
default values for the
length or the depth.

Notching side

Define on which side of the secondary beam the notch is created. You can
define the side for both the top and the bottom of the secondary beam.

Option Description
Default

Creates notches on both sides.

AutoDefaults can change this option.
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Option Description
Creates notches on both sides.

Creates a notch on the left side.

Creates a notch on the right side.

Bolts tab
Use the Bolts tab to control the bolt properties. The vertical position of bolts in
the main part must be aligned with the vertical position of bolts in the
secondary part. Vertical bolts cannot be staggered.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
2 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered
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Option Description
Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt group dimensions

 Description
1 Bolt edge distance.
2 Location where the bolts should be attached.
3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each space
between bolts. For example, if there are 3 bolts, enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.
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Option Description Default
Thread in mat Defines whether the

thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.
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Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab
Click the link below to find out more:

General tab

Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Two sided clip angle (117)
Two sided clip angle (117) connects two beams to a beam or a column using
clip angles. The clip angles are bolted to the secondary beams and to the main
part.

Objects created

• Clip angles (2 or 4)

• Bolts

• Cuts

Use for

Situation Description
Clip angle connection to a beam web.

Clip angle connection to a beam web.

Two secondary beams with different heights.

Clip angle connection to a beam web.

The other secondary beam is sloped.
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Situation Description
Clip angle connection to a column web.

Selection order

1. Select the main part (beam or column).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.

Part identification key

 Part
1 Clip angle

Picture tab
Use the Picture tab to control the dimensions and the position of the clip
angle.
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Dimensions

 Description Default
1 Cut length for the secondary part. 2.25 mm
2 Clip angle upper edge distance from the top

of the secondary beam.

The upper edge position of the angle
modifies the clip angle height.

Positive value moves the top position closer
to the beam center and thus decreases the
clip angle size. Negative values increase the
clip angle size.

If no value is entered,
bolts and bolt edge
distances define the size
of the clip angle.

3 Gap between the main part and the clip
angle.

 

Clip angle position

Option Description
Default

Near side and far side clip angles are
created.

AutoDefaults can change this option.
Near side clip angles are created.

Near side and far side clip angles are
created.

Far side clip angles are created.
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Parts tab
Use the Parts tab to control the clip angle properties.

Clip angle

Part Description
L profile, L profile 2 Define the clip angle profile by

selecting it from the profile
catalog.

Angle 1 length, Angle 2
length

Define the length of the clip angle
both on the first secondary part
and the second secondary part
side.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Move cleats to smaller web

Define the position of the cleats.

Notch tab
Use the Notch tab to create notches for the secondary beams and to control
the notch properties. Define the notches for both secondary beams.

Notch shape

Define the notch shape for the top and the bottom of the secondary beam.
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Option Option Description
Default

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

AutoDefaults can change
this option.
No notch

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

Define the notch
dimensions. In beam-to-
beam connections with a
sloped secondary beam,
the depth is measured
as shown in the picture.

Creates a notch on both
sides of the secondary
part.

Define the notch
dimensions.
Creates a chamfered
notch on both sides of
the secondary beam.

Define the chamfer
dimensions.
Creates a strip.

Define the length of the
strip. The flanges are cut
completely.
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Option Option Description
Creates a special type of
square notch.

Define the notch
dimensions. The notch is
square to the secondary
beam. There are no
default values for the
length or the depth.

Notching side

Define on which side of the secondary beam the notch is created. You can
define the side for both the top and the bottom of the secondary beam.

Option Description
Default

Creates notches on both sides.

AutoDefaults can change this option.
Creates notches on both sides.

Creates a notch on the left side.

Creates a notch on the right side.

Notch dimensions

Define the top and the bottom dimensions of the notch if you have set the
BCSA notch def option to No.
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 Description
1 Vertical notch dimension.
2 Horizontal notch dimension.

BCSA notch definition

Define whether the notch is created according to British Constructional
Steelwork Association (BCSA) specifications.

Option Description
Default Notch dimensions.
Yes Creates a 50 mm notch for simple beam-to-beam

connections.
No Use the options on this Notch tab to define the notch

dimensions.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
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 Description
2 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.
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 Description
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt group dimensions
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 Description
1 Bolt edge distance.
2 Location where the bolts should be attached.
3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:
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Analysis tab

Click the link below to find out more:

Analysis tab

Clip angle (141)
Clip angle (141) connects two beams, or a beam to a column, using bolted or
welded clip angles. The secondary beam can be leveled or sloped. Welded
haunch plates and seat angles are optional.

Objects created

• Clip angles (1 or 2)

• Stiffeners (optional)

• Top and bottom haunch plate (optional)

• Seat angle (optional)

• Seat stiffeners (optional)

• Bolts

• Plate washers (optional)

• Welds

• Cuts

Use for

Situation Description
Clip angle connection to column flange or web.

Single-sided/double-sided clip.

Welded/bolted, bolted/bolted, welded/welded
options.
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Situation Description
Clip angle connection to beam web.

Single-sided/double-sided clip.

Clip angle connection to column flange or web.

Single-sided/double-sided clip.

The secondary part is sloped. The secondary
part end can be cut square or bevel.

Clip angle connection to beam web.

Single-sided/double-sided clip.

The secondary part is sloped. There are several
notching options.

Clip angle connection to column flange or web.

Single-sided/double-sided clip.

Weld preparation and weld access holes for
moment connection.
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Situation Description
Clip angle connection to beam web.

Single-sided/double sided clip.

Option for weld preparation.

Clip angle connection to column flange.

Bottom flange is blocked or stripped for
erection.

Clip angle connection to column.

Seat angle option. Top/Bottom/Both.

Clip angle connection to column flange or web.

Single-sided/double-sided clip.

Haunch option. Top/Bottom/Both.
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Situation Description
Clip angle connection to column flange or web.

Single-sided/double-sided clip.

Secondary part is rotated.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Clip angles
2 Haunch plate
3 Seat angle
4 Seat stiffener
5 Web stiffeners

NOTE Tekla Structures uses values in the joints.def file to create this
component.
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Picture tab
Use the Picture tab to control the clip angle dimensions and to define how the
beam end is cut.

Dimensions

 Description Default
1 Cut length for the secondary part.

The cut is defined from the clip angle edge.

20 mm

2 Clip angle upper edge distance from the top
of the secondary beam.

The upper edge position of the angle
modifies the clip angle height.

Positive value moves the top position closer
to the beam center and thus decreases the
clip angle size. Negative values increase the
clip angle size.

If no value is entered,
bolts and bolt edge
distances define the size
of the clip angle.

3 Clip angle lower edge distance from the
bottom of the secondary beam.

The lower edge position of the angle
modifies the clip angle height.

Positive value moves the top position closer
to the beam center and thus decreases the
clip angle size. Negative values increase the
clip angle size.

If no value is entered,
bolts and bolt edge
distances define the size
of the clip angle.
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 Description Default
4 Size of the strip made to the secondary part

flange.

The cutting point of the flange is defined
from the clip angle edge.

The flange is
automatically stripped
when the clip angle
crosses the flange.

10 mm
5 Define the gap between the main part and

the clip angle.
0

Beam bottom flange cut

Option Description
Default

Flange cut

AutoDefaults can change this option.
Notch

The bottom of the secondary beam is
notched if the clip angle crosses the
flange.

Enter the notch radius and height.
Flange cut

The secondary beam flange is cut on
the same side as the clip angle if the
clip angle crosses the flange.

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.

Steel components 378 Clip angle connections



Option Description
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.

Parts tab
Use the Parts tab to control the size, position and orientation of the clip
angles.

Profile NS/FS

Option Description Default
Profile NS Near side clip angle

profile by selecting it
from the profile catalog.

Angle size is defined by
the bolt diameter.

The default name is
ANGLE.

Profile FS Far side clip angle profile
by selecting it from the
profile catalog.

Angle size determined
by the bolt diameter.

The default name is
ANGLE.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Clip angle position

Define the number of clip angles and the side of the clip angle in single clip
angle connections.

Option Description
Default

Near side and far side clip angles are
created.

AutoDefaults can change this option.

Automatic

If the main part is a tube profile, two
clip angles are created. Otherwise a
near side clip angle is created.

Near side clip angle is created.

Near side and far side clip angles are
created.

Far side clip angle is created.

Wrapped angle. Far side clip angle is
created.

Wrapped angle. Near side clip angle is
created.

Clip angle orientation

These options switch the unequal legs of the far side and the near side clip
angles.
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Option for near side Option for far side Description
Default

Not switched

AutoDefaults can change
this option.

Not switched

The clip angle is placed
on a connection so that
the longer leg is
connected to the
secondary part.
Switched

The clip angle legs are
switched so that the
longer leg is connected
to the main part.

Bolt spacing and weld gap

Option Description
1 Bolt spacing.
2 Weld gap.

Option Description
Default

Bolt spacing without weld gap

AutoDefaults can change this option.
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Option Description
Bolt spacing without weld gap

Bolt spacing with weld gap

Bolt spacing with weld gap that you
can define

Center of the bolt gage line

Option Description
Default

Center of the bolt gage line from the
center line of the secondary part.

AutoDefaults can change this option.

Center of the bolt gage line from the
center line of the secondary part.

Center of the bolt gage line from the
back of the secondary part web.

You can use this option when the
secondary part has a C or U profile.

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position, and type.
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Stiffener plate dimensions

Option Description
Top NS Top near side stiffener thickness,

width and height.
Top FS Top far side stiffener thickness, width

and height.
Bottom NS Bottom near side stiffener thickness,

width and height.
Bottom FS Bottom far side stiffener thickness,

width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.
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Option Description
Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.

Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.

Stiffeners are created.

Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.
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Option Description
Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding

Line chamfered stiffener plates

Stiffener gap

Option Description
Size of the gap between the flanges
and the stiffener.

Stiffener positions

 Description
1 Size of the gap between the stiffener and the beam web edge.
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 Description
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
5 Size of the gap between the top far side stiffener and the beam flange

edge.

Chamfer dimensions

 Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer
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Option Description
Convex arc chamfer

Concave arc chamfer

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).
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Option Description
Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beams
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
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Option Description
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.
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Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.
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Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.
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Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Bolts tab
Use the Bolts tab to control bolts and welds that connect the clip angle to the
main part and to the secondary part.
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Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
2 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.
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 Description
• Below: From the lower edge of the secondary part to the lowest

bolt.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

Staggering of bolts on clip angle

Option Description
Default

Bolts are not staggered.

AutoDefaults can change this option.
Bolts are not staggered.

The bolts that connect the clip angle to the secondary part
are on the same horizontal level as the bolts that connect
the clip angle to the main part.
Bolts on the main part are staggered.

The bolts that connect the clip angle to the main part are
moved downwards by half the bolt vertical spacing value.
Bolts on the secondary part are staggered.

The bolts that connect the clip angle to the secondary part
are moved downwards by half the bolt vertical spacing
value.
Bolts on the secondary part are staggered.

The bolts that connect the clip angle to the sloped
secondary part are parallel to the secondary part.
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Bolt group dimensions

 Description
1 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from
top to bottom.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

4 Bolt edge distance.
5 Location where the bolts should be attached.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3
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Option Description
Staggered type 4

Attachment type

Option Description
Default

Both parts are bolted.

AutoDefaults can change this option.

Automatic

When the main part is a tube profile, the clip angles are
welded to the main part and bolted to the secondary
part. Otherwise the clip angles are bolted to both parts.

Both parts are bolted.

Main part is welded and secondary is part bolted.

Main part is bolted and secondary part is welded.

Both parts are welded.
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Option Description
Main part is not bolted.

Secondary part is not welded.

Secondary part is not bolted.

Both parts are bolted and welded.

Number of clip angle welds

Define the number of welds that connect the clip angle to the main part
and/or the secondary part.

Option Description
Default

Three welds are created to the clip angle.

AutoDefaults can change this option.
Three welds are created to the clip angle.

One weld is created to the clip angle.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1
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Option Description
Bolting direction 2

Plate washers tab
Use the Plate washers tab to define the plate washer properties to the main
part and to the secondary parts.

Option Description
Plate washer Plate washer thickness, width and

height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Plate washer

Define plate washers for bolts and select the plate washer side.

Option Description
Default

No plate washer

AutoDefaults can change this option.
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Option Description
No plate washer

One plate washer

Individual square plate washers for
each bolt

Individual round plate washers for
each bolt

Option Description
Select whether the plate washer is
created for one clip angle or both clip
angles.
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Option Description
Select whether the plate washers are
placed symmetrically or
asymmetrically.

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole
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Option Description Default
Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.
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Option Description
Top flange is prepared.

Bottom flange is prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.

Weld backing bars

Option for top backing
bar

Option for bottom
backing bar

Description

Default

Backing bars are created
inside the flanges.

AutoDefaults can change
this option.
No backing bars are
created.

Backing bars are created
inside the flanges.

Backing bars are created
outside the flanges.

Weld backing bar length

Enter the length of the weld backing bar in the box below the options.
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Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange

Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

Angle box tab
Use the Angle box tab to add a seat angle.

Seat angle

The purpose of seat angles is to carry loads from the secondary part. Seat
angles can be positioned to top, bottom or both flanges of the secondary part.
The seat angle can be stiffened, and bolted or welded to the main and
secondary parts.

Option Description
Stiffeners Stiffener thickness, width and height.
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Option Description
Top angle, Bottom angle Selea the seat angle profile by

selecting it from the profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Seat angle position

Option Description
Default

No seat angle is created.

AutoDefaults can change this option.

No seat angle is created.

Seat angle is created at the top of the
flange.
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Option Description
Seat angle is created at the bottom of
the flange.

Seat angles are created on both sides
of the flange.

Seat angle attachment

Seat angle is positioned at the top or at the bottom of the secondary part.

Option for top seat
angle

Option for bottom seat
angle

Description

Default

Bolted

Seat angle is bolted to
the main part and to the
secondary part.

AutoDefaults can change
this option.
Bolted

Seat angle is bolted to
the main part and to the
secondary part.

Welded-bolted

Seat angle is welded to
the main part and bolted
to the secondary part.

Bolted-welded

Seat angle is bolted to
the main part and
welded to the secondary
part.
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Option for top seat
angle

Option for bottom seat
angle

Description

Welded

Seat angle is welded to
the main part and to the
secondary part.

Stiffener type

Option Description
Default

Rectangular stiffener plate

AutoDefaults can change this option.
Rectangular stiffener plate

Triangular stiffener plate

The line connecting the ends of the
seat angle legs defines the stiffener
plate shape.

Stiffener offset dimension

Define the offset of bevel cuts for triangular stiffeners.

 Description
1 Horizontal offset dimension
2 Vertical offset dimension

Seat angle rotation

Option Description
Default

Seat angle is not rotated.

AutoDefaults can change this option.
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Option Description
Seat angle is not rotated.

Seat angle is rotated horizontally 90
degrees.

To stiffen the rotated seat angle,
select the Middle stiffeners option in
the Middle stiffener position list.

Seat angle orientation

Option Description
Default

The longer leg of the seat angle is
connected to the secondary part.

AutoDefaults can change this option.
The longer leg of the seat angle is
connected to the secondary part.

The longer leg of the seat angle is
connected to the main part.

Automatic

The longer leg of the seat angle is
connected to the part where bolts
reach furthest from the seat angle
corner.

Side stiffener position

Option Description
Default

No side stiffeners are created.

AutoDefaults can change this option.
No side stiffeners are created.

Near side stiffeners are created.
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Option Description
Far side stiffeners are created.

Near side and far side stiffeners are
created.

Middle stiffener position

Option Description
Default

According to bolts

AutoDefaults can change this option.
No middle stiffener plate is created.

Middle stiffeners

The stiffener plate is positioned in the
middle of the seat angle.

Enter the number of middle stiffeners
in the Number of middle stiffeners
box.

Multiple stiffeners are centered and
equally spaced.
According to bolts

The stiffener plate is positioned
between the bolts in the middle of
the bolt spacing.

By default, stiffener is created
between every two bolts.

Enter the number of middle stiffeners
in the box below the According to
bolts option.
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Seat angle offset

 Description
1 Seat angle horizontal offset from the center line of the main

part.

Gap

 Description
1 Top gap and bottom gap between the seat angle and the secondary

part.

Chamfer dimensions

 Description
1 Vertical dimension of the chamfer.
2 Horizontal dimension of the chamfer.
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Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

BoxPBolts tab
Use the BoxPBolts tab to control properties of the bolts that connect the seat
angle to the main part.
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Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.

The dimension is defined from the middle line of the secondary beam.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.

The dimension is defined from the bottom of the secondary beam.

Top

Top refers to the bolt group that connects the top seat angle to the main part.

Bottom

Bottom refers to the bolt group that connects the bottom seat angle to the
main part.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

BoxSBolts tab
Use the BoxSBolts tab to control properties of the bolts that connect the seat
angle to the secondary part.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.

The dimension is defined from the middle line of the secondary beam.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

3 Number of bolts.
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 Description
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for horizontal bolt group position.

The dimension is defined from the bottom of the secondary beam.

Top

Top refers to the bolt group that connects the top seat angle to the secondary
part.

Bottom

Bottom refers to the bolt group that connects the bottom seat angle to the
secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab
Click the link below to find out more:

General tab

Design type tab
Click the link below to find out more:

Design type tab

Analysis tab
Click the link below to find out more:

Analysis tab
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Welds
Click the link below to find out more:

Two sided clip angle (143)
Two sided clip angle (143) connects two beams, or a beam to a column, using
single or double clip angles. The secondary beam can be leveled or sloped.
Welded haunch plates and a seat angle are optional.

Objects created

• Clip angles (2)

• Haunch plates (optional)

• Seat angle (optional)

• Weld backing bars (optional)

• Bolts

• Plate washers (optional)

• Welds

• Cuts

Use for

Situation Description
Clip angle connection.

Single-sided/double-sided clip.

Two secondary parts. Bolted/bolted, welded/
bolted, welded/welded options.
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Situation Description
Clip angle connection.

Single-sided/double-sided clip.

Two secondary parts. Bolted/bolted, welded/
bolted, welded/welded options.

Clip angle connection.

Single-sided/double-sided clip.

Two secondary parts.

Haunch option. Top/Bottom/Both

Clip angle connection.

Single-sided/double-sided clip.

Two secondary parts at different heights.
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Situation Description
Clip angle connection.

Single-sided/double-sided clip.

Two secondary parts.

Weld preparation and weld access holes for
moment connection.

Clip angle connection.

Single-sided/double-sided clip.

Two secondary parts.

Safety connection.

Clip angle connection.

Automatic notching of secondary part to
provide bolt clearance.
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Situation Description
Clip angle connection.

Single-sided/double-sided clip.

Two secondary parts rotated.

Clip angle connection.

Single-sided/double-sided clip.

Two secondary parts, one sloped.

Selection order

1. Select the main part (column or beam).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.

Part identification key
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 Part
1 Clip angles
2 Haunch plate

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Picture tab
Use the Picture tab to control the clip angle dimensions and to define how the
beam end is cut.

Dimensions

 Description Default
1 Cut length for the secondary part.

The cut is defined from the clip angle edge.

 

2 Define the gap between the main part and
the clip angle.

0

3 Clip angle upper edge distance from the top
of the secondary beam.

The upper edge position of the angle
modifies the clip angle height.

Positive value moves the top position closer
to the beam center and thus decreases the
clip angle size. Negative values increase the
clip angle size.

If no value is entered,
bolts and bolt edge
distances define the size
of the clip angle.
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 Description Default
4 Clip angle lower edge distance from the

bottom of the secondary beam.

The lower edge position of the angle
modifies the clip angle height.

Positive value moves the top position closer
to the beam center and thus decreases the
clip angle size. Negative values increase the
clip angle size.

If no value is entered,
bolts and bolt edge
distances define the size
of the clip angle.

Option Description
Sort secondaries by
profile height

Select whether the secondary parts are sorted
by their profile height.

When set to Yes, the highest secondary part is
always regarded as the first secondary part,
regardless of the selection order.

 Description Default
1 Size of the strip made to the secondary part

flange.

The cutting point of the flange is defined
from the clip angle edge.

The flange is
automatically stripped
when the clip angle
crosses the flange.

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Option Description
Default

Bevel

AutoDefaults can change
this option.
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Option Option Description
Automatic

If the secondary beam is
sloped less than 10
degrees, the beam end
is cut square. Otherwise,
the beam end is cut
bevel.
Square

Cuts the end of the
secondary beam square.
Bevel

Cuts the end of the
secondary beam parallel
to the edge of the main
part.

Beam bottom flange cut

Option Description
Default

Flange cut

AutoDefaults can change this option.
Notch

The bottom of the secondary beam is
notched if the clip angle crosses the
flange.

Enter the notch radius and height.
Flange cut

The secondary beam flange is cut on
the same side as the clip angle if the
clip angle crosses the flange.

Parts tab
Use the Parts tab to control the size, position and orientation of the clip
angles.
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Profile NS/FS

Option Description Default
Profile NS

Profile 2 NS

Near side clip angle
profile for the first and
the second secondary
parts by selecting it from
the profile catalog.

Angle size is defined by
the bolt diameter.

The default name is
ANGLE.

Profile FS

Profile 2 FS

Far side clip angle profile
for the first and the
second secondary parts
by selecting it from the
profile catalog.

Angle size is determined
by the bolt diameter.

The default name is
ANGLE.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Clip angle position

Option for the second
secondary part

Option for the first
secondary part

Description

Default

Near side and far side
clip angles are created.

AutoDefaults can change
this option.
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Option for the second
secondary part

Option for the first
secondary part

Description

Automatic

If the main part is a tube
profile, two clip angles
are created. Otherwise a
near side clip angle is
created.
Near side clip angle is
created.

Near side and far side
clip angles are created.

Far side clip angle is
created.

Near side clip angle orientation

These options switch the unequal legs of the near side clip angles.

Option for the second
secondary part

Option for the first
secondary part

Description

Default

Not switched

AutoDefaults can change
this option.
Not switched

The clip angle is placed
on a connection so that
the longer leg is
connected to the
secondary part.
Switched

The clip angle legs are
switched so that the
longer leg is connected
to the main part.

Far side clip angle orientation

These options switch the unequal legs of the far side clip angles.
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Option for the second
secondary part

Option for the first
secondary part

Description

Default

Not switched

AutoDefaults can change
this option.
Not switched

The clip angle is placed
on a connection so that
the longer leg is
connected to the
secondary part.
Switched

The clip angle legs are
switched so that the
longer leg is connected
to the main part.

Bolt spacing and weld gap

Optio
n

Description

1 Bolt spacing.
2 Weld gap.

Option Description
Default

Bolt spacing without weld gap

AutoDefaults can change this option.

Bolt spacing without weld gap
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Option Description
Bolt spacing with weld gap

Bolt spacing with weld gap that you
can define.

Center of the bolt gage line

Option Description
Default

Center of the bolt gage line from the
center line of the secondary part.

AutoDefaults can change this option.

Center of the bolt gage line from the
center line of the secondary part.

Center of the bolt gage line from the
back of the secondary part web.

You can use this option when the
secondary part has a C or U profile.

Safety connections

In Side 2 horizontal offset, enter a value to the field to move the clip angles in
horizontal direction on the side of the second secondary beam. Enter the
Vertical cut/offset and Horizontal cut dimensions.

Safety connection type

Define whether the created connection is a standard connection or a safety
connection.

Option Description
Default

No safety connection is created.

AutoDefaults can change this option.
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Option Description
No safety connection is created.

Clip angles are moved down to create
safety connection.

Enter the dimension in the Vertical
cut/offset field.
Clip angles are notched to create
safety connection.

Enter the notch dimensions in the
Vertical cut/offset and Horizontal
cut fields.

Safety connection location

Define the location of the safety connection.

Option Description
Default

On the first secondary beam

AutoDefaults can change this option.
On the first secondary beam

On the first secondary beam

On the second secondary beam

On the second secondary beam

On the first secondary beam

On the second secondary beam
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Option Description
On the first secondary beam and the
second secondary

On the second secondary beam and
the first secondary beam

Safety connection staggering

Define how the clip angles are staggered.

Option Description
Default

Staggered

AutoDefaults can change this option.
Staggered

Clip angle height is not modified, but
the clip angles are moved to create
safety connection.
Flush

Clip angle height is modified to create
safety connection, but the bottoms of
the angles are flush with each other.

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Haunch plate creation

Option for the second
secondary beam

Option for the first
secondary beam

Description

Default

Top and bottom haunch
plates are created, if
needed.

AutoDefaults can change
this option.
Automatic

Top or bottom haunch
plate or both are
created, if needed.

Top and bottom haunch
plates are always
created.

To create a single plate,
enter 0 in the thickness
(t) field for the haunch
plate you do not need
(top or bottom plate).
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Option for the second
secondary beam

Option for the first
secondary beam

Description

Haunch plates are not
created.

Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Notch tab
Use the Notch tab to automatically create notches for the secondary beams
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.
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Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
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Option Description
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.
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Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.
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Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.
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Cut dimensions

 Description Default
1 Dimensions for the horizontal

flange cuts.
10 mm

2 Dimensions for the vertical
flange cuts.

The gap between the notch edge
and the beam flange is equal to the
main part web rounding. The notch
height is rounded up to the nearest
5 mm.

Bolts tab
Use the Bolts tab to control the bolt group dimensions.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
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 Description
2 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.
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 Description
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Number of rows of bolts through the main part.

Staggering of bolts on clip angle

Option for
second

secondary

Option for first
secondary

Description

Default

Bolts are not staggered.

AutoDefaults can change this option.
Bolts are not staggered.

The bolts that connect the clip angle to
the secondary part are on the same
horizontal level as the bolts that
connect the clip angle to the main part.
Bolts on the main part are staggered.

The bolts that connect the clip angle to
the main part are moved downwards
by half the bolt vertical spacing value.
Bolts on the secondary part are
staggered.

The bolts that connect the clip angle to
the secondary part are moved
downwards by half the bolt vertical
spacing value.
Bolts on the secondary part are
staggered.

The bolts that connect the clip angle to
the sloped secondary part are parallel
to the secondary part.
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Attachment type

Option Description
Default

Both parts are bolted.

AutoDefaults can change this option.
Automatic

When the main part is a tube profile, the clip angles are
welded to the main part and bolted to the secondary part.
Otherwise the clip angles are bolted to both parts.
Both parts are bolted.

Main part is welded and secondary part is bolted.

Main part is bolted and secondary part is welded.

Both parts are welded.

Main part is not bolted.

Secondary part is not welded.

Secondary part is not bolted.

Both parts are bolted and welded.
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Bolt group dimensions

 Description
1 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate
the numbers with a space. Bolt numbers run from left to right
and from top to bottom.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

4 Bolt edge distance.
5 Location where the bolts should be attached.
6 Angle leg length.
7 Location where the bolts should be attached: Site / Workshop.

Bolt settings tab
Use the Bolt settings tab to control the bolts and welds that connect the clip
angle to the main part and to the secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.
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Option Description Default
Tolerance Gap between the bolt

and the hole.
 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.
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Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Same bolt length for all

Set this option to Yes to have the same bolt length for all bolts. The longest
bolt defines how long the shorter bolts are with extra length.

Use different settings for secondary parts

Set to Yes to define different settings for the second secondary part. The
default is that the same settings are used for both secondary parts.

Number of clip angle welds

Define the number of welds that connect the clip angle to the main part
and/or the secondary part.

Option Description
Default

Three welds are created to the clip angle.

AutoDefaults can change this option.
Three welds are created to the clip angle.

One weld is created to the clip angle.
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Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Bolting direction 2

Plate washers tab
Use the Plate washers tab to define the plate washer properties to the main
part and to the secondary parts.

Option Description
Plate washer Plate washer thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Plate washer

Define plate washers for bolts and select the plate washer side.
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Option Description
Default

No plate washer

AutoDefaults can change this option.

No plate washer

One plate washer

Individual square plate washers for
each bolt

Individual round plate washers for
each bolt

Option Description
Select whether the plate washer is
created for one clip angle or both clip
angles.
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Option Description
Select whether the plate washers are
placed symmetrically or
asymmetrically.

Angle box tab
Use the Angle box tab to add a seat angle.

Seat angle

The purpose of seat angles is to carry loads from the secondary part. Seat
angles can be positioned to top, bottom or both flanges of the secondary part.
The seat angle can be stiffened, and bolted or welded to the main and
secondary parts.

Option Description
Stiffeners Stiffener thickness, width and height.
Top angle NS, Bottom angle NS, Top
angle FS, Bottom angle FS

Select the seat angle profile by
selecting it from the profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Steel components 448 Clip angle connections



Option Description Default
Finish Describes how the part

surface has been
treated.

 

Top seat angle position

Option Description
Default

No seat angle is created.

AutoDefaults can change this option.
No seat angle is created.

Seat angle is created at the top of the
second secondary part flange.

Seat angle is created at the top of the
first secondary part flange.

Seat angles are created at the top of
both flanges.

Bottom seat angle position

Option Description
Default

No seat angle is created.

AutoDefaults can change this option.
No seat angle is created.

Seat angle is created at the bottom of
the second secondary part flange

Seat angle is created at the bottom of
the second secondary part flange.

Seat angles are created at the bottom
of both flanges.

Seat angle attachment

Seat angle is positioned at the top or at the bottom of the secondary part.
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Option for top seat
angle

Option for bottom seat
angle

Description

Default

Bolted

Seat angle is bolted to
the main part and to the
secondary part.

AutoDefaults can change
this option.
Bolted

Seat angle is bolted to
the main part and to the
secondary part.
Welded-bolted

Seat angle is welded to
the main part and bolted
to the secondary part.
Bolted-welded

Seat angle is bolted to
the main part and
welded to the secondary
part.
Welded

Seat angle is welded to
the main part and to the
secondary part.

Stiffener type

Option Description
Default

Rectangular stiffener plate

AutoDefaults can change this option.
Rectangular stiffener plate

Triangular stiffener plate
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Option Description
The line connecting the ends of the
seat angle legs defines the stiffener
plate shape.

Stiffener offset dimension

Define the offset of bevel cuts for triangular stiffeners.

 Description
1 Horizontal offset dimension
2 Vertical offset dimension

Seat angle orientation

Option Description
Default

The longer leg of the seat angle is
connected to the secondary part.

AutoDefaults can change this option.
The longer leg of the seat angle is
connected to the secondary part.

The longer leg of the seat angle is
connected to the main part.

Automatic

The longer leg of the seat angle is
connected to the part where bolts
reach furthest from the seat angle
corner.
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Seat angle rotation

Option Description
Default

Seat angle is not rotated.

AutoDefaults can change this option.
Seat angle is not rotated.

Seat angle is rotated horizontally 90
degrees.

To stiffen the rotated seat angle,
select the Middle stiffeners option in
the Middle stiffener position list.

Middle stiffener position

Option Description
Default

According to bolts

AutoDefaults can change this option.
No middle stiffener plate is created.

Middle stiffeners

The stiffener plate is positioned in the
middle of the seat angle.

Enter the number of middle stiffeners
in the Number of middle stiffeners
box.

Multiple stiffeners are centered and
equally spaced.
According to bolts

The stiffener plate is positioned
between the bolts in the middle of
the bolt spacing.

By default, stiffener is created
between every two bolts.

Enter the number of middle stiffeners
in the box below the According to
bolts option.
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Side stiffener position

Option Description
Default

No side stiffeners are created.

AutoDefaults can change this option.
No side stiffeners are created.

Near side stiffeners are created.

Far side stiffeners are created.

Near side and far side stiffeners are
created.

Seat angle offset

 Description
1 Seat angle horizontal offset from the center line of the main

part.

Chamfer dimensions

 Description
1 Vertical dimension of the chamfer.
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 Description
2 Horizontal dimension of the chamfer.

Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Gap
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 Description
1 Top gap and bottom gap between the seat angle and the secondary

part.

BoxPBolts tab
Use the BoxPBolts tab to control properties of the bolts that connect the seat
angle to the main part.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.

The dimension is defined from the middle line of the secondary beam.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.

The dimension is defined from the bottom of the secondary beam.
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Top

Top refers to the bolt group that connects the top seat angle to the main part.

Bottom

Bottom refers to the bolt group that connects the bottom seat angle to the
main part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

BoxSBolts tab
Use the BoxSBolts tab to control properties of the bolts that connect the seat
angle to the secondary part.

Bolt group dimension
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 Description
1 Dimension for vertical bolt group position.

The dimension is defined from the middle line of the secondary beam.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for horizontal bolt group position.

The dimension is defined from the bottom of the secondary beam.

Top

Top refers to the bolt group that connects the top seat angle to the secondary
part.

Bottom

Bottom refers to the bolt group that connects the bottom seat angle to the
secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.
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 Description
5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole

 

Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

R = 35
r = 10
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Option Description Default
Capital R defines the
large radius (height).

Small r defines the small
radius.

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.

Top flange is prepared.

Bottom flange is prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.
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Weld backing bars

Option for top backing
bar

Option for bottom
backing bar

Description

Default

Backing bars are created
inside the flanges.

AutoDefaults can change
this option.
No backing bars are
created.

Backing bars are created
inside the flanges.

Backing bars are created
outside the flanges.

Weld backing bar length

Enter the length of the weld backing bar in the box below the options.

Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange
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Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

General tab
Click the links below to find out more:

General tab

Design type tab
Click the links below to find out more:

Design type tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:
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2.3 Bent plate connections
This section introduces bent plate connection components available in Tekla
Structures.

Click the links below to find out more:

• Bent plate (151) (page 465)

• Bent plate (190) (page 490)

Bent plate (151)
Bent plate (151) connects a beam to a column or a beam using one or two
bolted or welded bent plates. The end of the beam can be cut square or bevel
to accommodate a sloping secondary beam. By default, notches are created to
the secondary beam flanges when needed. You can define on which side of
the secondary beam web the bent plate is placed in single plate connections.
Double plate connections can also be created. Haunch plates are created
welded to the secondary beam flanges when required.

Objects created

• Bent plates

• Haunch plates

• Stiffeners

• Bolts

• Cuts

• Welds

Use for

Situation Description
Beam connected to a column using a
bent plate.

Selection order

1. Select the main part (column or beam).

2. Select the secondary part.

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Description
1 Bent plate
2 Haunch plate

Picture tab
Use the Picture tab to define the connection dimensions.

Dimensions

 Description
1 Distance between the main part and the secondary part

(beam). By default, the distance is 20 mm.
2 Haunch plate height to the beginning of the chamfer.
3 Haunch plate width to the beginning of the chamfer.
4 Distance from the bent plate edge to the lower flange notch.

You can define this dimension if the plate extends below the
bottom of the secondary beam.
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Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Haunch plate creation

Options Description
Default

Haunch plates are not created.

AutoDefaults can change this option.
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Options Description
Haunch plates are not created.

Top and bottom haunch plates are
created.

Top haunch plate is created.

Bottom haunch plate is created.

Parts tab
Use the Parts tab to define the bent plate properties and positions.

Parts

Option Description
Bent plate NS Thickness of the near side bent plate.
Bent plate FS Thickness of the far side bent plate.
Top Web Ext Thickness, width and height of the top

web extension.
Btm Web Ext Thickness, width and height of the

bottom web extension.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Name Name that is shown in

drawings and reports.
 

Finish Describes how the part
surface has been
treated.

 

Dimensions

 Description
1 Gap between the right bent plate and the main part.
2 Gap between the left bent plate and the main part.
3 Gap between the right bent plate and the secondary part.
4 Gap between the left bent plate and the secondary part.
5 Collision plane change.

Bent plate position

  
Default

Creates two bent plates, near side and far side.

AutoDefaults can change this option.
Automatic

Near side and far side bent plates are selected
automatically.
Near side bent plate
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Far side bent plate

Far side switched

Creates a far side bent plate with a leg pointing to
the near side.
Near side switched

Creates a far side bent plate with a leg pointing to
the far side.
Creates two bent plates, near side and far side.

Attachment to the main part

Option Description
Default

The bent plate is bolted to the main
part.

AutoDefaults can change this option.
Automatic

The bent plate is bolted to the main
part.
The bent plate is bolted to the main
part.
The bent plate is welded to the main
part.
The bent plate is bolted and welded
to the main part.

Attachment to the secondary part

Option Description
Default

The bent plate is bolted to the
secondary part.

AutoDefaults can change this option.
Automatic

The bent plate is bolted to the
secondary part.
The bent plate is bolted to the
secondary part.
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Option Description
The bent plate is welded to the
secondary part.
The bent plate is bolted and welded
to the secondary part.

Attachment point control

Option Description
Default

The collision plane is not changed from the
default position.

AutoDefaults can change this option.
The collision plane is not changed from the
default position.

The collision plane is changed to the nearest
surface.

The collision plane is changed to the farthest
surface.

Top notch / Btm notch tab
Use the Top notch and Btm notch tabs to define the notch settings and
dimensions.

Notch dimensions

Option Option
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 Description
1 Horizontal dimension for the notch clearing.

The distance is measured from the intersection point of three
planes: top or bottom of the flange plane, end of the flange
plane, and the inner web or side surface, depending on the type
of clearance selected.

2 Vertical dimension for the notch clearing.

The distance is measured from the intersection point of three
planes: bottom of the flange plane, end of the flange plane, and
the inner web or side surface, depending on the type of
clearance selected.

3 Horizontal dimension for the notch override.

The distance is measured from the intersection point of three
planes: top of the flange plane, fitting plane, and the inner web
or side surface, depending on the type of clearance selected.

4 Vertical dimension for the notch override.

The distance is measured from the intersection point of three
planes: top of the flange plane, fitting plane, and the inner web
or side surface, depending on the type of clearance selected.

5 Radius of the notch cut.
6 Vertical notch orientation.

Notch settings

  
Do notch • Yes enables notching.

• No disables notching, but does
not disable stripping and flange
coping.

Use the Strip / Cope options for
disabling stripping and flange
coping.

Type of clearance • Side with flange

Use the main part flange and the
inner side plane of the secondary
part as a reference for the
clearing.

• Web with plate

Use the inner shear tab plane and
the inner web plane of the
secondary part as a reference for
the clearing.
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• Web with flange

Use the flange of the main part
and the inner web plane of the
secondary part as a reference for
the clearing.

Strip/Cope option • Automatic strip

Based on the shear tab shape and
edges, the connection strips the
secondary part flanges as
necessary.

• Never strip or cope

Stripping or coping is not done.

• Force strip

Connection always strips, even
when the shear tab edges are not
clashing or close to the secondary
part flanges. Set the notch cut
length in Forcing Dist and the
depth in Force Depth.

• Automatic flange cope

Based on the shear tab shape and
edges, the connection copes the
secondary part flanges as
necessary.

• Force flange cope

The connection always copes,
even when the shear tab edges
are not clashing or close to the
secondary part flanges. Set the
notch cut length in Forcing Dist
and the depth in Force Depth.

• Strip also other side

Both secondary part flanges are
stripped.

Flange cut options

Define the flange cut dimensions and the cut thickness.

Steel components 473 Bent plate connections



 Description
1 Dimension for additional flange cut.

The dimension is measured from the end of the beam if not
fitted, or from the fitting surface if fitted.

2 Dimension for additional flange cut.

The dimension is measured from the center line of the beam.

Vertical notch orientation

 Bottom  
Default

Square to the secondary
part.

AutoDefaults can change
this option.
Automatic

Square to the secondary
part.
Square to the secondary
part.

The notch is cut
vertically square relative
to the secondary part.
Square to main part

The notch is cut
vertically square relative
to the main part.

Notch orientation

Option Description
Default

Square to the main part.

AutoDefaults can change this option.
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Option Description
Automatic

Square to the main part.
Square to the secondary part.

The notch is cut horizontally square
relative to the secondary part.
Square to the main part.

The notch is cut horizontally square
relative to the main part.

Flange cuts tab
Use the Flange cuts tab to define how the flanges are cut.

Dimensions

 Description
1 Transversal dimension
2 Longitudinal dimension
3 • Top: Top flange is cut.

• Bottom: Bottom flange is cut.

• Both: Both the top and the bottom flange are cut.
4 • Near: Near side is cut.

• Far: Far side is cut.

• Both: Both the near and far side are cut.
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Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position, and type.

Stiffener plate dimensions

Option Description
Top NS Thickness, width, and height of the

top near side stiffener.
Top FS Thickness, width, and height of the

top far side stiffener.
Bottom NS Thickness, width, and height of the

bottom near side stiffener.
Bottom FS Thickness, width, and height of the

bottom far side stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.
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Option Description
Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.

Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.

Stiffeners are created.

Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.
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Option Description
Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding

Line chamfered stiffener plates

Stiffener gap

Option Description
Size of the gap between the flanges
and the stiffener.

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer
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Option Description
Line chamfer

Convex arc chamfer

Concave arc chamfer

Stiffener positions

 Description
1 Size of the gap between the stiffener and the beam web edge.
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
5 Size of the gap between the top far side stiffener and the beam flange

edge.

Bolts tab
Use the Bolts tab to control the bolt group dimensions and bolt properties.
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Bolt group dimensions

 Description
1 Select main bolted part: beam or bent plate.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

5 Select how to measure the dimensions for vertical bolt group
position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.
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 Description
• Middle: From the center line of the bolts to the center line

of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

6 Bolt edge distance.

Edge distance from the center of the bolt to the top of the
beam.

 Description
1 Select the location where the bolts should be attached.
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 Description
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts, enter
2 values.

5 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate
the numbers with a space. Bolt numbers run from left to right
and from top to bottom.

Bolt alignment

Main bolt alignment Secondary bolt
alignment

Description

Default

Square to the secondary
part.

AutoDefaults can change
this option.
Automatic

Square to the secondary
part.
Square to the secondary
part.
Square to the main part.

Vertically staggered.

Horizontally staggered.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.
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Option Description Default
Bolt standard Bolt standard to be used

inside the component.
Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.
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If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Staggering of bolts on clip angle

Option Description
Default

Bolts are not staggered.

AutoDefaults can change this option.
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Option Description
Bolts are not staggered.

The bolts that connect the clip angle to the secondary part
are on the same horizontal level as the bolts that connect
the clip angle to the main part.
Bolts on the main part are staggered.

The bolts that connect the clip angle to the main part are
moved downwards by half the bolt vertical spacing value.
Bolts on the secondary part are staggered.

The bolts that connect the clip angle to the secondary part
are moved downwards by half the bolt vertical spacing
value.
Bolts on the secondary part are staggered.

The bolts that connect the clip angle to the sloped
secondary part are parallel to the secondary part.

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Backing bar Thickness and width of the weld

backing bar.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Option Description Default
Finish Describes how the part

surface has been
treated.

 

Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  
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Option Description Default
Square weld access hole  

Diagonal weld access
hole

 

Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.
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Option Description
Beam end is not prepared.

Top and bottom flange are prepared.

Top flange is prepared.

Bottom flange is prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.

Weld backing bars

Option for top backing
bar

Option for bottom
backing bar

Description

Default

Backing bars are created
inside the flanges.

AutoDefaults can change
this option.
No backing bars are
created.

Backing bars are created
inside the flanges.
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Option for top backing
bar

Option for bottom
backing bar

Description

Backing bars are created
outside the flanges.

Weld backing bar length

Enter the length of the weld backing bar in the box below the options.

Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange

Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

General tab

Click the link below to find out more:

General tab
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Design type tab

Click the link below to find out more:

Design type tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Bent plate (190)
Bent plate (190) connects two beams or a beam and a column using one or
two bolted or welded bent plates. The secondary beam can be leveled or
sloped and/or skewed. Welded haunch plates are optional.

Objects created

• Bent plate (1 or 2)

• Stiffeners (optional)

• Top and bottom haunch plate (optional)

• Weld backing bars (optional)

• Bolts

• Welds

• Cuts
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Use for

Situation Description
Bent plate connecting two beams.

The secondary part is skewed.

Bent plate connected to a column flange.

The secondary part is skewed.

Bent plate connecting two beams.

The secondary part is skewed.

Bent plate connecting two beams.

The secondary part is skewed. The plate can be
placed to various locations.
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Situation Description
Bent plate connecting two beams.

The secondary part is skewed and sloped.

Bent plate connected to a column web.

The secondary part is skewed.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (beam). The connection is created automatically
when the secondary part is selected.

Part identification key
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 Part
1 Bent plate
2 Haunch plate

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Picture tab
Use the Picture tab to control the position of the bent plate and to define how
the beam end is cut.

Dimensions

 Description Default
1 Cut length for the secondary part.

The cutting point is defined from the bent
plate edge.

20 mm

2 Bent plate upper edge distance from the top
of the secondary part.

The upper edge position of the plate
modifies the bent plate height.

Positive value moves the top position closer
to the beam center and thus decreases the
bent plate size. Negative value increases the
bent plate size.

If no value is entered,
bolts and bolt edge
distances define the size
of the plate.

Steel components 493 Bent plate connections



 Description Default
3 Bent plate lower edge distance from the

bottom of the secondary part.

The lower edge position of the plate modifies
the bent plate height.

Positive value moves the bottom position
closer to the beam center and thus
decreases the plate size. Negative values
increase the plate size.

If no value is entered,
bolts and bolt edge
distances define the size
of the plate.

4 Size of the strip made to the secondary part
flange.

The cutting point of the flange is defined
from the bent plate edge.

The flange is
automatically stripped
when the bent plate
crosses the flange.

10 mm
5 Gap between the main part and the bent

plate.
0

Beam end cut

Define how the beam end is cut. The secondary part is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary part slopes less than
10 degrees, a square cut is created.
Otherwise, a bevel cut is made to the
end of the secondary part.
Square

Creates a square cut to the end of the
secondary part.
Bevel

Cuts the end of the secondary part
parallel to the edge of the main part.

Plates tab
Use the Plates tab to control the thickness, position and attachment of the
bent plate. The dimensions on the Picture tab and the Bolts tab also affect
the size of the bent plate.
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Bent plate NS/FS

Option Description
Bent plate Bent plate thickness.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Bent plate position

Option Description
Default

Near side and far side bent plate

AutoDefaults can change this option.

Automatic

Near side and far side bent plates are
created automatically.

Near side switched

Creates a near side bent plate with a
leg pointing to the far side.
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Option Description
Far side switched

Creates a far side bent plate with a leg
pointing to the near side.

Far side

Near side

Near side and far side

Main and secondary part attachment type

Option Description
Default

Bent plate is bolted to the main part.

AutoDefaults can change this option.

Automatic

Bolted

Bolted
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Option Description
Welded

Bolted and welded

Attachment point control

Define whether the bent plate is attached to the web or to the flange of the
main part.

Bolt spacing and weld gap

Option Description
Default

Define the bolt spacing. Weld gap is
not created.

AutoDefaults can change this option.

Define the bolt spacing. Weld gap is
not created.
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Option Description
Define the bolt spacing. Weld gap is
created.

Define the bolt spacing and the weld
gap.

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position, and type.

Stiffener plate dimensions

Option Description
Top NS Top near side stiffener thickness,

width and height.
Top FS Top far side stiffener thickness, width

and height.
Bottom NS Bottom near side stiffener thickness,

width and height.
Bottom FS Bottom far side stiffener thickness,

width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.

Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.
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Option Description
No stiffeners are created.

Stiffeners are created.

Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.

Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding

Line chamfered stiffener plates
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Stiffener gap

Option Description
Size of the gap between the flanges
and the stiffener.

Stiffener positions

 Description
1 Size of the gap between the stiffener and the beam web edge.
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
5 Size of the gap between the top far side stiffener and the beam flange

edge.

Chamfer dimensions
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 Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.
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Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).

Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beams
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
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Option Description
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.
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Option Description
Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.
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Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.
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Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.
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Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the bent
plate to the main part and to the secondary part.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
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 Description
2 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest bolt.

3 Number of bolts.
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 Description
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

Staggering of bolts on bent plate

Option Description
Default

Bolts are not staggered.

AutoDefaults can change this option.
Bolts are not staggered.

The bolts that connect the bent plate
to the secondary part are on the
same horizontal level as the bolts that
connect the bent plate to the main
part.
Bolts on the main part are staggered.

The bolts that connect the bent plate
to the main part are moved
downwards by half the bolt vertical
spacing value.
Bolts on the secondary part are
staggered.

The bolts that connect the bent plate
to the secondary part are moved
downwards by half the bolt vertical
spacing value.
Bolts on the secondary part are
staggered.

The bolts that connect the bent plate
to the sloped secondary part are
parallel to the secondary part.

Welds between parts

Define the number of welds created between the bent plate and secondary
part, and the bent plate and main part.
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Option Description
Welds between the bent plate and the
secondary part

Welds between the bent plate and the
main part

Bolt group dimensions

 Description
1 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from
top to bottom.

2 Number of bolts.
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 Description
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

4 Bolt edge distance.
5 Location where the bolts should be attached.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole
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Option Description Default
Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.
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Option Description
Top flange is prepared.

Bottom flange is prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.

Weld backing bars

Option for top backing
bar

Option for bottom
backing bar

Description

Default

Backing bars are created
inside the flanges.

AutoDefaults can change
this option.
No backing bars are
created.

Backing bars are created
inside the flanges.

Backing bars are created
outside the flanges.

Weld backing bar length

Enter the length of the weld backing bar in the box below the options.
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Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange

Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Steel components 519 Bent plate connections



Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

2.4 End plate connections and details
This section introduces components that can be used in end plate connection
and details.

• Seating cap plate (2) (page 521)

• Bearing plate (7) (page 530)

• Column - 2 beams (14) (page 538)

• Joining plates (14) (page 555)

• Wooden purlin shoe (15) (page 581)

• Two sided end plate (24) (page 569)

• Stiffened end plate (27) (page 591)

• Stub (28) (page 608)

• End plate (29) (page 621)

• Seating cap (37) (page 635)

• Haunch (40) (page 651)

• Cranked beam (41) (page 676)

• Hql connection (46) (page 689)

• Plate with nail (47) (page 695)

• Spacer plate (48) (page 698)

• Double plate (50) (page 707)

• Partial stiff end plate (65) (page 729)

• End plate (101) (page 748)

• End plate with compensating flange plates (111) (page 758)

• Two-sided end plate with compensating flange plates (112) (page 769)

• Two sided end plate (115) (page 781)

• Stub connection (119) (page 793)
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• Two sided end plate (142) (page 804)

• End plate (144) (page 834)

• End plate detail (1002) (page 866)

• Angle cut (1057) (page 868)

• Cast-in plate (1069) (page 871)

Seating cap plate (2)
Seating cap plate (2) connects a beam to the column head. The connection
creates two plates, one welded to the bottom of the beam and one to the
column head. The plates are bolted together.

Objects created

• Cap plates

• End plate

• Bolts

• Welds

Use for

Situation Description
Beam and column connected with
two cap plates that are bolted
together. The end plate is created to
the beam end.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (beam or column).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Description
1 Upper cap plate

Lower cap plate
2 End plate

Picture tab
Use the Picture tab to define the connection dimensions.

Dimensions

 Description Default
1 Cut distance of the secondary beam end from the

main part edge.
2 End plate edge distance from the main part edge. -10 mm

Positive
values move
the end plate
edge towards
the column
centre.
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Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description
Lower cap plate Thickness, width and height of the

cap plate.
Upper cap plate Thickness, width and height of the

cap plate.
End plate Thickness, width and height of the

end plate.

If you leave the plate thickness empty,
the end plate is not created.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the plate dimensions.
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Plate dimensions

 Description
1 End plate edge distance to the secondary part flange.

This distance affects the size of the end plate welded to the
secondary part end.

2 End plate edge distance to the upper cap plate.

This distance affects the size of the end plate welded to the
secondary part end.

3 Cap plate edge dimension.

Gap size

Define the limit value for the gap between the end plate and the secondary
beam. Use this when the beam is slightly curved or sloped to decide if the end
angle is so small that the beam end can be straight.

If the actual gap is smaller than this value, the end of the beam is left straight.

If the actual gap is larger than this value, the end of the beam is fitted to the
end plate.

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.
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Bolt group dimensions

 Description
1 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line
of the secondary part.
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 Description
• Below: From the lower edge of the secondary part to the

lowest bolt.

2 Dimension for vertical bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

6 Select how to measure the dimensions for horizontal bolt
group position.

• Left: From the left edge of the secondary part to the
leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the

center line of the bolts.

• Right: From the right edge of the secondary part to the
rightmost bolt.

7 Dimension for horizontal bolt group position.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within

Yes
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Option Description Default
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

General tab

Click the link below to find out more:

General tab
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Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Bearing plate (7)
Bearing plate (7) connects a beam to a column. A console seat plate welded
to the column carries the shear forces. The beam upper flange is bolted to an
L profile. The lower flange is bolted to a shim plate.

Objects created

• Console seat plate

• End plate

• Shim plate

• Clip angle (L profile)

• Bolts

• Welds

Use for

Option Description
Beam is connected to a column. The
clip angle, shim plate, and console are
created.

Selection order

1. Select the main part (column).

Steel components 530 End plate connections and details



2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Clip angle (L profile)
2 End plate
3 Shim plate

Console seat plate

Picture tab
Use the Picture tab to define the connection dimensions.

Dimensions
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 Description Default
1 Console seat edge distance from the end plate

lower edge.
 

2 Gap between the end plate and the column. 10 mm
3 End plate edge distance from the beam lower edge.

Positive values move the end plate lower edge
upward and negative values downward.

End plate
lower edge
is set to the
same
position as
the beam
lower edge.

4 End plate edge distance from the beam upper
edge.

Positive values move the end plate upper edge
downward and negative values upward.

10 mm

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description  
Seat Thickness, width, and

height of the console
seat.

Thickness: 30 mm
If the width is left empty,
the secondary beam
width is used.

If the height is left
empty, the secondary
beam height is used.

End plate Thickness and width of
the end plate.

Thickness: Equal to the
secondary part web
thickness (rounded up to
thickness 8, 10, 12, 16,
20, 25, 30, 35, 40, 45,
and so on).

If the width is left empty,
the secondary beam
width is used.
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Option Description  
Fitting plate Thickness of the shim

plate.
10 mm

L profile Select the profile from
the profile catalog.

L100-6

L seat Select the profile from
the profile catalog.

An angle console can be
created under the end
plate. When an L console
is used, the shim plate
and the console seat
plate are not created.

 

Parameters tab
Use the Parameters to control the end plate gap size.

Gap size

Define the limit value for the gap between the end plate and the secondary
beam. Use this when the beam is slightly curved or sloped to decide if the end
angle is so small that the beam end can be straight.

If the actual gap is smaller than this value, the end of the beam is left straight.

If the actual gap is larger than this value, the end of the beam is fitted to the
end plate.

Console Blt tab
Use the Console Blt tab to define the bolt group dimensions and bolt
properties of the console seat plate.
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Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

L-profile Blt tab
Use the L-profile Blt tab to define the bolt group dimensions and bolt
properties of the L profile bolts.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.
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 Description
3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts, enter
2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2
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Option Description
Staggered type 3

Staggered type 4

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Column - 2 beams (14)
Column - 2 beams (14) connects two beams to a column. The beam ends rest
on the column. The secondary beams can be horizontal or sloped.

Objects created

• End plates

• Cap plates

• Bolts

• Welds
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Use for

Situation Description
Connection between a column and two beams.

Connection between a column and a beam.

You can use the component with only one
secondary beam but then the settings are more
difficult to define, and there are fewer situations
where the component can be used.

If you use the component with only one secondary
beam, enter a negative value for the gap between
end plates.

Selection order

1. Select the main part (column).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.
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Part identification key

 Part
1 Column
2 Beam
3 Beam

Picture tab
Use the Picture tab to control the plate sizes.

Plate 1, 2, 3, 4

Plates 1 and 2 are the end plates on the beams. Plates 3 and 4 are the cap
plates between the columns and the beams.

Option Description
Plate 1, 2, 3, 4 Plate thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.
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Option Description Default
Material Material grade. The default material is defined

in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Plate 3 + 4

Define the type of the connection between the column and beams.

Option Description Example
2 plates Two plates are created.

The column is
chamfered twice.

Folded plate A folded plate is created.
The plate can be
unfolded on a workshop
drawing. The column is
chamfered twice.

1 plate One plate is created. The
plate is always oriented
horizontally. The column
is fitted perpendicularly.
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Option Description Example
Plate perp to column One plate is created. The

column is fitted
perpendicularly, even if
the column is positioned
in a skewed direction.

Plate distances

 Description Default
1 Plate distance from the beam edge. 5 mm
2 Gap between the end plates.

If you use the component with only one
secondary beam, enter a negative value.

 

3 Plate distance from the column edges.  
4 Plate distance from the column center.  

End plates

Select how the end plates are positioned.
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Gap size

Define the limit value for the gap between the end plate and the beam, or for
the gap between the cap plate and the column. Use this when the beam or the
column is slightly curved or sloped to decide if the end angle is so small that
the end can be straight.

If the actual gap is smaller than this value, the end of the beam is left straight.

If the actual gap is larger than this value, the end is fitted to the end plate or to
the cap plate.

The default value is 5 mm.

Bolts 1 - 2 tab
Use the Bolts 1 - 2 tab to control the bolts that connect the end plates.
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Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the center line

of the bolts.

• Right: From the right edge of the secondary part to the rightmost
bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each space
between bolts. For example, if there are 3 bolts, enter 2 values.

6 Dimension for vertical bolt group position.
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 Description
7 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest bolt.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Bolts 3/Bolts 4 tabs
Use the Bolts 3 and Bolts 4 tabs to control the bolts that connect the first
secondary beam or the second secondary beam to the column.
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Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the center line

of the bolts.

• Right: From the right edge of the secondary part to the rightmost
bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each space
between bolts. For example, if there are 3 bolts, enter 2 values.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Holes - Plate 1/Holes - Plate 2/Holes - Plates 3 and 4 tabs
Use the Holes tabs to control the galvanizing holes in the end plates.

Option Description
Bolt standard Select the bolt standard.
Bolt type Select the bolt type to define the

location where the bolts should be
attached.

Read data from You can select to use the
sinkholes.dat definition file to
specify the default values for
horizontal and vertical offsets, and
the diameters for upper and lower
holes.

The file is searched in the following
order: Environment common system
steel folder (..\Environments
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Option Description
\common\system\Steel), model
folder, XS_FIRM, XS_PROJECT and 
XS_SYSTEM folder.

You can also select to define the holes
in the component dialog box.

Number of holes

The center of a hole group is the middle point of the beam and the middle
point of the haunch, if the haunch exists. The hole groups are composed of 0,
1, 2 or 4 holes.

Option Description
Default

No holes

AutoDefaults can change this option.

No holes

1 hole

2 holes

4 holes
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Hole positions

 Description
1 Plates 1 and 2: Horizontal distance between the secondary

beam center and the upper hole.

Plates 3 and 4: Horizontal distance between the main part
center and the upper hole.

2 Plates 1 and 2: Horizontal distance between the secondary
beam center and the lower hole.

Plates 3 and 4: Horizontal distance between the main part
center and the lower hole.

3 Plates 1 and 2: Vertical distance between the secondary beam
center and the upper hole.

Plates 3 and 4: Vertical distance between the main part center
and the upper hole.

4 Plates 1 and 2: Vertical distance between the secondary beam
center and the lower hole.

Plates 3 and 4: Vertical distance between the main part center
and the lower hole.

5 Diameter of the lower hole.
6 Diameter of the upper hole.

General tab

Click the link below to find out more:

General tab
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Joining plates (14)
Joining plates (14) connects two beam ends using an end plate welded to
both beams. End plates are connected with bolts. Stiffeners and ear plates can
also be created.

Objects created

• End plates

• Shim plates

• Ear plates

• Stiffeners

• Bolts

• Welds

Use for

Situation Description
Beam ends connected with bolted
end plates. Stiffener is created.

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Description
1 End plate
2 Shim plate
3 Ear plate
4 Stiffener

Picture tab
Use the Picture tab to define the geometry of the connection.

Dimensions
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 Description Default
1 End plate edge distance from the main part

upper edge.

If you do not enter a value for the end plate
edge distance on the main part side, the
secondary part side value is used on the
main part side as well.

10 mm

2 End plate edge distance from the secondary
part upper edge.

10 mm

3 End plate edge distance from the main part
lower edge.

If you do not enter a value for the end plate
edge distance on the main part side, the
secondary part side value is used on the
main part side as well.

10 mm

4 End plate edge distance from the secondary
part lower edge.

10 mm

5 Ear plate edge distance from the end plate
upper edge.

38 mm

6 Shim plate vertical bolt edge distance. 1.5*bolt diameter
7 Stiffener edge inclination.

To get a rectangular stiffener, set the value to
0.

To get a triangular stiffener, enter the same
value here as for the stiffener width on the
Parts tab.

25 mm

8 Shim plate horizontal distance from the
secondary part end plate.

 

Parts tab
Use the Parts tab to define the part properties, and the shim plate shape and
bolt edge distance.

Parts

Option Description
Sec end plate Thickness, width, and height of the

secondary part end plate.
Prim end plate Thickness, width, and height of the

main part end plate.
Fitting plate 1, Fitting plate 2,
Fitting plate 3

Thickness of the shim plate.
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Option Description
Number of fitting pl. 1, Number of
fitting pl. 2, Number of fitting pl. 3

Number of shim plates.

Ear plates Thickness, width, and height of the
ear plates.

When you enter the ear plate
thickness, two ear plates are by
default created.

Stiffeners Thickness and width of the stiffeners.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Shim plate bolt edge distance

 Description
1 Horizontal bolt edge distance in the shim plate.
2 Vertical bolt edge distance in the shim plate.
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Shim plate shape

Option Description
Default

Holes are based on the bolt group of
the connection.

AutoDefaults can change this option.

Holes are based on the bolt group of
the connection.

Finger shim plate with horizontal
slots.

The plate can be installed from the
right or the left side of the
connection.

Finger shim plate with vertical slots.

The plate can be installed from the
top of the connection.

Two separate finger shim plates with
horizontal slots.

Two separate finger shim plates with
vertical slots.

Tolerance

Define the tolerance for the slots in finger shim plates. The width of the slot is
the bolt diameter + the tolerance. For two separate shim plates, also define
the tolerance between the plates.
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Parameters tab
Use the Parameters tab to define ear plate creation and dimensions.

Dimensions

 Description Default
1 Number of ear bolts

You can define the number of the holes
in the horizontal and vertical direction.

Horizontal: 1
Vertical: 2

2 Ear bolt spacing 3*hole diameter

If there are more than
two bolts in the bolt
group in one direction,
give the distances
separated by a space (for
example, 40 50).

3 Ear bolt edge distance

Edge distance is calculated from the
top and outside edges.

2.5*hole diameter

4 Ear bolt hole diameter  
5 Bolt edge distance to the edge of the

shim plate
 

Ear plate creation

Option Description
Default

Both ear plates are created.

AutoDefaults can change this option.
Both ear plates are created.
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Option Description
Ear plate 1 is created.

Ear plate 2 is created.

Gap size

Define the limit value for the gap between the end plate and the secondary
beam. Use this when the beam is slightly curved or sloped to decide if the end
angle is so small that the beam end can be straight.

If the actual gap is smaller than this value, the end of the beam is left straight.

If the actual gap is larger than this value, the end of the beam is fitted to the
end plate.

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions

  
1 Dimension for horizontal bolt group position.
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2 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost
bolt.

• Middle: From the center line of the secondary part to the
center line of the bolts.
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• Right: From the right edge of the secondary part to the

rightmost bolt.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts, enter
2 values.

6 Dimension for vertical bolt group position.
7 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.
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• Middle: From the center line of the bolts to the center line of

the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

8 Define which bolts are deleted from the bolt group.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Bolt comment

You can define a bolt comment.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Holes tab
Use the Holes tab to control the galvanizing holes in the end plates.

Option Description
Bolt standard Select the bolt standard.
Bolt type Select the bolt type to define the

location where the bolts should be
attached.
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Option Description
Read data from You can select to use the

sinkholes.dat definition file to
specify the default values for
horizontal and vertical offsets, and
the diameters for upper and lower
holes.

The file is searched in the following
order: Environment common system
steel folder (..\Environments
\common\system\Steel), model
folder, XS_FIRM, XS_PROJECT and 
XS_SYSTEM folder.

You can also select to define the holes
in the component dialog box.

Number of holes

The center of a hole group is the middle point of the beam and the middle
point of the haunch, if the haunch exists. The hole groups are composed of 0,
1, 2, or 4 holes.

Option Description
Default

No holes

AutoDefaults can change this option.

No holes

1 hole

2 holes
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Option Description
4 holes

Hole positions

  
1 Horizontal distance between the end plate center and the upper

hole.
2 Horizontal distance between the end plate center and the lower

hole.
3 Vertical distance between the end plate center and the upper

hole.
4 Vertical distance between the end plate center and the lower

hole.
5 Diameter of the lower hole.
6 Diameter of the upper hole.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Dstv connection properties

Click the link below to find out more:

Two-sided end plate (24)
Two-sided end plate (24) connects two beams to a column or to a beam
using a bolted end plate. One bolt group goes through all the three parts. This
connection is created and used in the same way as End plate (29) connection.

Objects created

• End plate

• Seat (plate or angle)

• Shim plates

• Stiffeners

• Welds

• Bolts

• Cuts

Use for

Situation Description
Beam-to-column end plate connection.

Steel components 569 End plate connections and details



Situation Description
Beam-to-beam end plate connection.

End plate connection with shim plates and a seat
angle.

Limitations

Do not use this connection when connecting a beam to a column flange.

Selection order

1. Select the main part (column or beam).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.
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Part identification key

 Part
1 End plate for the first secondary beam
2 Shim plate for the first secondary beam
3 Seat (plate or angle) for the first secondary beam
4 Shim plate for the second secondary beam
5 End plate for the second secondary beam
6 Seat (plate or angle) for the second secondary beam

Picture tab
Use the Picture tab to control the position of the end plate.

End plate position
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 Description
1 Gap between the main part and the end plate or the shim plate of the

second secondary beam.
2

3

End plate edge distance from the top or bottom of the second
secondary beam.

4 Gap between the main part and the end plate or the shim plate of the
first secondary beam.

5

6

End plate edge distance from the top or the bottom of the first
secondary beam.

Parts tab
Use the Parts tab to define the properties of the parts created.

Plate

Option Description Default
End plate End plate thickness,

width and height.

The width and height are
defined by the bolt
group edge distances.
The height can also be
entered as a plate edge
distance from the upper
and lower edge of the
secondary beam.

half of the bolt
diameter

Seat Define whether a seat is
created under the end
plate.

The seat is created only
if the seat thickness is
entered.

Adding a seat plate
moves the end plate by
default 20 mm below the
secondary beam
bottom.

width = end plate
width
height = secondary
beam height

L seat Define whether a seat
angle is created under
the end plate. The length

width = end plate
width
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Option Description Default
of the angle is defined
by the seat width.

If you enter a seat angle
profile, the seat will be
an angle instead of a
plate even if you have
entered the plate
thickness.

Adding a seat angle does
not move the end plate
in the same way as the
seat plate. To avoid
collision between the
angle and the secondary
beam, modify the end
plate or enter a gap
between the end plate
and the seat angle.

Fitting plate Shim plate thickness.

The plate is created only
if the plate thickness is
entered.

width and height =
defined by the bolt
group and the shim
plate edge
distances

Number or fitting pl. Define how many shim
plates are created.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Parameters tab
Use the Parameters tab to control the shim plate and end plate positions.

End plate dimensions

 Description Default
1

4

Vertical bolt edge distance for the shim plates.

The number and spacing of bolts affect the
size of the shim plates.

1.5*bolt diameter

2

3

Gap between the end plate and the seat (plate
or angle).

0 mm

5

6

Horizontal bolt edge distance for the shim
plates.

 

Shim plate and end plate positions

Define the position of the shim plates and the end plate in the second
secondary beam. The plates move in relation to the plates in the first
secondary beam. By default, the plates in the second secondary beam are
positioned so that holes are placed symmetrically. You may need to move the
plates, for example, when connecting skew or curved secondary beams.
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 Description
1 Define how much the plates are moved in vertical direction.
2 Define how much the plates are moved in horizontal direction.

Gap size

Define the limit value for the gap between the end plate and the secondary or
main beam. Use this gap when the beam is slightly curved or sloped to decide
if the end angle is so small that the beam end can be straight.

If the actual gap is smaller than this value, the beam end is left straight.

If the actual gap is larger than this value, the beam end is fitted to the end
plate.

Notch tab
Use the Notch tab to modify the horizontal and vertical cuts.

Cut dimensions
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 Description Default
1 Dimensions for the horizontal

flange cuts.
10 mm

2 Dimensions for the vertical
flange cuts.

The gap between the notch edge
and the beam flange is equal to the
main part web rounding. The notch
height is rounded up to the nearest
5 mm.

Bolts tab
Use the Bolts tab to control the properties of the bolts used.

Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the center line

of the bolts.

• Right: From the right edge of the secondary part to the rightmost
bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each space
between bolts. For example, if there are 3 bolts, enter 2 values.

6 Dimension for vertical bolt group position.
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 Description
7 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest bolt.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Wooden purlin shoe (15)
Wooden purlin shoe (15) creates a connection between a steel beam and a
wooden purlin. A purlin shoe is welded to the steel beam, in which a wooden
purlin is fitted. You can use various profiles to create the purlin shoe, for
example, U-shaped and L-shaped profiles. The purlin shoe has holes so the
wooden purlin can be connected using hexagon head wood screws.

Objects created

• Purlin shoe

• Bolts

• Welds
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Use for

Situation Description
Wooden purlin shoe, U profile.

Wooden purlin shoe, I profile.

Wooden purlin shoe.

Wooden purlin shoe, purlin is
notched.

Before you start

Create a steel beam and a purlin.

Selection order

1. Select the beam (main part).
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2. Select the wooden purlin (secondary part).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Purlin shoe profile
2 Bottom plate
3 Bolt group

Picture tab
Use the Picture tab to define the offset dimensions of the shoe profile, base
plate, and notch.
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Offset dimensions

 Description Default
1 Shoe profile offset from the purlin top.
2 Shoe profile offset from the steel beam top.

This dimension takes priority over the shoe profile
offset.

5 mm

3 Bottom plate offset in the direction of the wooden
purlin.

If you do not enter a value and the steel beam
bottom is further down than the wooden purlin
bottom, the bottom plate extends automatically to
the main part web. For example:

0
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 Description Default

4 Bottom plate offset in the direction of the main part. 0
5 Notch offset.

When the shoe profile width is insufficient, the
wooden purlin is notched.

Parts tab
Use the Parts tab to define the shoe profile and bottom plate properties.

Parts

Option Description
Bottom plate Thickness of the bottom plate.
Profile Select the shoe section profile from

the profile catalog.

If you do not select any profile, the
shoe profile shape selected in
Section type is used.

Section type Select the shoe profile section type.

Section type is used when a profile is
not defined in Profile.

Which profile is used depends on the
wooden purlin width. The shoe profile
has to be chosen so that the wooden
purlin fits the shoe without needing
to notch the wooden purlin.

Catalog profiles are used, except for
the last two options: U-shaped bent
plate and L-shaped bent plate. When
you use either of these, you can select
in Create shoe as whether the U-
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Option Description
shaped or L-shaped profile is created
as a folded plate or a polybeam.

If you create a polybeam, you can
create an unfolded bent plate
drawing with bent lines.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Section dimensions

 Description
1 Shoe profile width.

If you have selected a catalog section (UNP, UPE, INP, IPE, L) in
Section type you have to define a width that corresponds with
the catalog profiles.
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 Description
For example, if you have selected the UNP section, you can set
the width to 80 because this profile exists in the catalog. You
cannot use value 90 because the catalog does not contain a 
UNP90 profile.

If you use a value that is not valid, the shoe profile will
disappear.

2 Shoe profile flange height.

You can define the flange height for U-shaped bent plates and L-
shaped bent plates.

3 Shoe profile flange thickness.

You can define the flange thickness for U-shaped bent plates and
L-shaped bent plates.

Shoe reference line

Define the position of the shoe profile reference line.

L position

Select the shoe profile position if the profile is L shaped. The options are left or
right:

Create shoe as

If you have selected a U-shaped bent plate or an L-shaped bent plate in
Section type, you can select whether the plate is created as a folded plate or a
polybeam.

NOTE Select Polybeam to create an unfolded bent plate drawing with bent
lines.

If you select Folded plate, you cannot create an unfolded bent plate
drawing with bent lines.
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Holes tab
Use the Holes tab to define the hole properties and the pattern in the shoe
profile.

Basic properties

Option Description Default
Bolt standard Bolt assembly standard

to be used inside the
component.

The available standards
are defined in the bolt
assembly catalog.

The default value is
4014-8.8 .

Bolt size Hole diameter. 18 mm
Assembly type Location where the bolts

should be attached.
Site

Slotted holes

 Description Default
1 Vertical dimension of the slotted hole. 0, which

results in
a round
hole.

2 Horizontal dimension of the slotted hole, or
allowance for oversized holes.

0, which
results in
a round
hole.

Dimensions

Steel components 588 End plate connections and details



 Description
1 Hole edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Number of holes.
3 Hole spacing.

Use a space to separate the spacing values. Enter a value for
each space between holes. For example, if there are 3 holes,
enter 2 values.

Vertical offset

Define the vertical shift between the bolt groups.

If the purlin is screwed at the same height on both sides of the shoe profile,
the screws may hit each other. To prevent this, one hole pattern can be
vertically shifted. In this way, the screws cannot hit each other. The default
value is 0. For example:

Note that the vertical offset can only be used when you do not enter a vertical
edge distance for the bolt group to be shifted. If you enter a value for these
edge distances, the edge distance is applied and the hole pattern is not shifted
vertically.
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Extra weld parameters tab
Use the Extra weld parameters tab to define how the shoe profile is
connected to the main part.

Connect parts as

NOTE Set the desired connection type before adding the component in the
model.

If you have to change the connection type after you have added the
component in the model, you have to delete the component and
recreate it with the changed connection type.

Option Description
Secondary part of welding The shoe profile is dimensioned and

labeled as a welded part in the
assembly drawing. It is not possible to
create a separate assembly drawing
of the shoe profile.

Sub-assembly The shoe profile is added as a sub-
assembly. It is possible to create a
separate assembly drawing of the
shoe profile.

In the assembly drawing of the main
part, the position of the sub-assembly
is dimensioned but the dimensions of
the sub-assembly parts are not. This
is because this sub-assembly is
already fabricated when it is welded
to the main part. This results in better
readable assembly drawings.

General tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Welds

Click the link below to find out more:
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Stiffened end plate (27)
Stiffened end plate (27) connects two beams, or a beam to a column, using
an end plate at the secondary beam end and a T-shaped plate construction
consisting of a stiffener and a shear tab. The plates are connected with bolts.

Objects created

• End plate

• Shear tabs

• Stiffeners

• Shim plates

• Bolts

• Welds

Use for

Situation Description
Two beams connected with a bolted
end plate. Shear tab is created.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 End plate
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 Description
2 Shim plate
3 Front plate
4 Shear tab
5 Stiffener

Picture tab
Use the Picture tab to define the part positions.

Dimensions

 Description
1 Front plate edge distance from the main part flange.
2 End plate edge distance from the secondary part flange.
3 Gap between the front plate and the shim plate.
4 Shear tab edge distance from the main part flange.

This dimension has an effect on the shear tab size.

The lower box is for controlling the shear tab on the other side
of the main part.

5 Shear tab edge distance from the main part web.

The lower box is for controlling the shear tab on the other side
of the main part.

6 Stiffener edge distance from the shear tab edge.
7 Shear tab edge distance from the main part flange.

This dimension has an effect on the shear tab size.
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Gap size

Define the limit value for the gap between the end plate and the secondary
beam. Use this when the beam is slightly curved or sloped to decide if the end
angle is so small that the beam end can be straight.

If the actual gap is smaller than this value, the end of the beam is left straight.

If the actual gap is larger than this value, the end of the beam is fitted to the
end plate.

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
End plate Thickness of the end plate. 10 mm
Front plate Thickness and width of the front

plate.
Thickness: 10 mm
Width: Same as the
width of the end
plate

Move front plate
(column-beam
connection)

Select whether the front plate is
moved in column-to-beam
connections.

 

Shear plate Thickness, width and height of
the shear tab.

 

Fill shear plate
width

Select whether to use the 
XS_STANDARD_STIFFENER_WID
TH_TOLERANCE advanced option
for the width.

 

Stiffener Thickness and width of the
stiffener.

 

Bottom stiffener as
one plate

Select whether the bottom
stiffener is created as one plate.

 

Fitting plate 1,
Fitting plate 2,
Fitting plate 3

Thickness of the shim plate.  
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Option Description Default
Number of fitting
pl. 1, Number of
fitting pl. 2,
Number of fitting
pl. 3

Define the number of shim
plates.

 

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Shim plate bolt edge distance

 Description
1 Horizontal bolt edge distance in the shim plate.
2 Vertical bolt edge distance in the shim plate.
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Shim plate shape

Option Description
Default

Holes are based on the bolt group of
the connection.

AutoDefaults can change this option.

Holes are based on the bolt group of
the connection.

Finger shim plate with horizontal
slots.

The plate can be installed from the
right or the left side of the
connection.

Finger shim plate with vertical slots.

The plate can be installed from the
top of the connection.

Two separate finger shim plates with
horizontal slots.

Two separate finger shim plates with
vertical slots.

Tolerance

Define the tolerance for the slots in finger shim plates. The width of the slot is
the bolt diameter + the tolerance. For two separate shim plates, also define
the tolerance between the plates.
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Parameters tab
Use the Parameters tab to define the chamfers of the shear tab and
stiffeners.

Shear tab shape

  
Default

Full

Creates a full shear tab of the same
height as the web of the main part.

AutoDefaults can change this option.
Full

Shear tabs are created on both sides
of the main part web.

Partial shear tab is created on the
other side of the main part web.

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer
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Option Description
Convex arc chamfer

Concave arc chamfer

Chamfer dimensions

 Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions
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 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost
bolt.

• Middle: From the center line of the secondary part to the
center line of the bolts.
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 Description
• Right: From the right edge of the secondary part to the

rightmost bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

6 Select how to measure the dimensions for vertical bolt group
position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.
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 Description
• Middle: From the center line of the bolts to the center line of

the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

7 Dimension for vertical bolt group position.
8 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate
the numbers with a space. Bolt numbers run from left to right
and from top to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.
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Option Description Default
Thread in mat Defines whether the

thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Bolt type

Select the bolt type to define the location where the bolts should be attached.

Bolt comment

You can define a bolt comment.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.
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Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Bolting direction 2

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered
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Option Description
Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Holes - end plate tab
Use the Holes - end plate tab to control the galvanizing holes in the end plate.

Option Description
Bolt standard Select the bolt standard.
Bolt type Select the bolt type to define the

location where the bolts should be
attached.

Read data from You can select to use the
sinkholes.dat definition file to
specify the default values for
horizontal and vertical offsets, and
the diameters for upper and lower
holes.

The file is searched in the following
order: Environment common system
steel folder (..\Environments
\common\system\Steel), model
folder, XS_FIRM, XS_PROJECT and 
XS_SYSTEM folder.

You can also select to define the holes
in the component dialog box.

Number of holes

The center of a hole group is the middle point of the beam and the middle
point of the haunch, if the haunch exists. The hole groups are composed of 0,
1, 2 or 4 holes.

Steel components 603 End plate connections and details



Option Description
Default

No holes

AutoDefaults can change this option.

No holes

1 hole

2 holes
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Option Description
4 holes

Hole positions

 Description
1 Horizontal distance between the secondary beam center and the

upper hole.
2 Horizontal distance between the secondary beam center and the

lower hole.
3 Vertical distance between the secondary beam center and the

upper hole.
4 Vertical distance between the secondary beam center and the

lower hole.
5 Diameter of the lower hole.
6 Diameter of the upper hole.

Holes - front plate tab
Use the Holes - front plate tab to control the galvanizing holes in the front
plate.

Option Description
Bolt standard Select the bolt standard.
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Option Description
Bolt type Select the bolt type to define the

location where the bolts should be
attached.

Read data from You can select to use the
sinkholes.dat definition file to
specify the default values for
horizontal and vertical offsets, and
the diameters for upper and lower
holes.

The file is searched in the following
order: Environment common system
steel folder (..\Environments
\common\system\Steel), model
folder, XS_FIRM, XS_PROJECT and 
XS_SYSTEM folder.

You can also select to define the holes
in the component dialog box.

Number of holes

The center of a hole group is the middle point of the beam and the middle
point of the haunch, if the haunch exists. The hole groups are composed of 0,
1, 2 or 4 holes.

Option Description
Default

No holes

AutoDefaults can change this option.

No holes
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Option Description
1 hole

2 holes

4 holes

Hole positions
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 Description
1 Horizontal distance between the main beam center and the

upper hole.
2 Horizontal distance between the main beam center and the

lower hole.
3 Vertical distance between the main beam center and the upper

hole.
4 Vertical distance between the main beam center and the lower

hole.
5 Diameter of the lower hole.
6 Diameter of the upper hole.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Dstv connection properties

Click the link below to find out more:

Stub (28)
Stub (28) connects a crane beam to a column using a stub. The connection
also creates stiffeners to the column, beam, and stub, as well as a bearing
plate between the crane beam and the stub.
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Objects created

• Bearing plate

• Stiffeners

• Seat

• Bolts

• Rods

• Welds

Use for

Situation Description
Beam connected to a column with a
stub

Selection order

1. Select the main part (column).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.

Part identification key

 Description
1 Stub
2 Bearing plate
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 Description
3 Stiffener

Picture tab
Use the Picture tab to define the connection dimensions and stiffener
tolerances.

Dimensions

 Description Default
1 Gap between the stiffener plate and secondary

beam upper flange
0

2 Gap between the stiffener plate and secondary
beam lower flange

0

3 Gap between the stiffener plate and stub upper
flange

0

4 Gap between the stiffener plate and stub lower
flange

0

5 Bearing plate edge distance to the stub end

Changing the value automatically changes the
length of the stub profile.

10 mm

6 Stiffener plate edge dimension to the column
flange

0

7 Stiffener plate edge dimension to the column
flange

0

8 Edge distance from the secondary part flange to
the bearing plate end

Changing the value automatically changes the
length of the stub profile.

10 mm
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Dimensions

 Description
1 Stiffener edge distance from the stub flange
2 Gap dimension between the secondary parts
3 Stiffener edge distance from the stub flange

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
Bearing plate Thickness and height of

the bearing plate
Thickness = 20 mm
Width = 50 mm

Sec stiffeners Thickness, width, and
height of the secondary
part stiffeners

1.5*(secondary part web
thickness)

Prim. stiffeners Thickness, width, and
height of the main part
stiffeners

1.5*(main part web
thickness)

Cons stiffeners Thickness, width, and
height of the console
stiffeners

1.5*(console web
thickness)

Seat Select the profile from
the profile catalog.

HE300A

Option Description Default
Pos_no Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Material Material grade. The default material is

defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Class Part class number.
Finish Describes how the part

surface has been
treated.

Comment Add a comment about
the part.

Parameters tab
Use the Parameters tab to define the stiffener chamfers and dimensions.

Chamfer shape

Option Description
Default

Line chamfer

AutoDefaults can change this option.
No chamfer

This shape may cause a clash
between the stiffener and I profile
rounding.
Line chamfer

Convex chamfer

Concave chamfer
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Chamfer dimensions

Main part stiffener Secondary part stiffener

 Description
1 Horizontal chamfer dimension for the main part stiffener and

the secondary part stiffener
2 Vertical chamfer dimension for the main part stiffener and the

secondary part stiffener

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Dimension for horizontal bolt group position.
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 Description
4 Select how to measure the dimensions for horizontal bolt

group position.

• Left: From the left edge of the secondary part to the
leftmost bolt.

• Middle: From the center line of the secondary part to the
center line of the bolts.
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 Description
• Right: From the right edge of the secondary part to the

rightmost bolt.

5 Dimension for vertical bolt group position.
6 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.
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 Description
• Middle: From the center line of the bolts to the center line

of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

7 To modify the bolt assembly, select the Effect in modify
check box and click Modify.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Rods tab
Use the Rods tab to define the rod, nut, and washer properties and
dimensions.

Parts

Option Description
Rod profile Select the profile from the profile

catalog.
Nut profile Select the profile from the profile

catalog.
Nut 2 profile Select the profile from the profile

catalog.
Washer profile Select the profile from the profile

catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
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Option Description Default
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Comment Add a comment about

the part.
 

Hole creation

Select where the holes are created and define the hole tolerance.

Dimensions

 Description
1 Vertical edge dimension
2 Horizontal edge dimension

Assembly creation

Select whether to create an assembly.

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the assembly. If you want to create a hole only, clear all the
check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.
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Assembly dimensions

 Description
1 Width of the washer plate
2 Width of the nut profile
3 Width of the nut profile
4 Rod length to the beam flange
5 Rod length to the column flange

Hole tolerence

Option Description
Washer hole tolerance If you select Washer hole tolerance,

define the tolerance value.
Nut hole tolerance If you select Nut hole tolerance,

define the tolerance value.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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End plate (29)
End plate (29) connects a beam to a column or two beams to each other using
a bolted end plate. Stiffeners, seats and shim plates are optional.

Objects created

• End plate

• Seat angle or seat plate (optional)

• Shim plates (optional)

• Stiffeners (optional)

• Bent plate (optional)

• Welds

• Bolts

• Cuts

Use for

Situation Description
Beam-to-column end plate connection.

Beam-to-beam end plate connection.
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Situation Description
End plate connection with a shim plate and a
seat angle.

End plate connection with stiffeners.

Selection order

1. Select the main part (column or beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary beam is
selected.

Part identification key
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 Part
1 Shim plate
2 End plate
3 Seat (plate or angle)
4 Stiffener

Picture tab
Use the Picture tab to control the position of the end plate.

End plate position

 Description Default
1 End plate top position from the top of the

secondary beam.

If no value is entered, bolts and bolt edge
distances define the size of the end plate.
If you give both values, the position
distance override the bolt edge distance
values.

10 mm

2 End plate bottom position from the
bottom of the secondary beam.

 

3 Gap between the shim plate and the main
part.

If the shim plate does not exist, the
defined gap is created between the end
plate and the main part.

0 mm
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Parts tab
Use the Parts tab to define the properties of the parts.

Plate

Part Description Default
End plate End plate thickness,

width and height.

The width and height are
defined by the bolt
group edge distances.
The height can also be
entered as a plate edge
distance from the upper
and lower edge of the
secondary beam.

half of the bolt
diameter

Seat Define whether a seat is
created under the end
plate.

The seat is created only
if the seat thickness is
entered.

Adding a seat plate
moves the end plate by
default 20 mm below the
secondary beam
bottom.

width = end plate
width
height = secondary
beam height

L seat Define whether a seat
angle is created under
the end plate. The length

width = end plate
width

Steel components 624 End plate connections and details



Part Description Default
of the angle is defined
by the seat width.

If you enter a seat angle
profile, the seat will be
an angle instead of a
plate even if you have
entered the plate
thickness.

Adding a seat angle does
not drag the end plate in
the same way as the
seat plate. To avoid
collision between the
angle and the secondary
beam, modify the end
plate or enter a gap
between the end plate
and the seat angle.

Fitting Plate Shim plate thickness.

The plate is created only
if the plate thickness is
entered.

width = defined by
the bolt group and
the shim plate edge
distances

Number of fitting pl.
(DEF=1)

Define how many shim
plates are created.

Folded Plate Bent plate thickness,
width and height.

The plate is created only
if the plate thickness is
entered.

Bent plate can also be
used with ordinary shim
plates.

width = determined
from the bolt group
inner bolts
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Part Description Default
Stiffeners Define whether

stiffeners are created to
the column when a
beam is connected to
the column flange.

If you enter one of the
dimensions, stiffeners
are created.

thickness = 20 mm
width = width of the
column flange
height = height of
the column web

Upper horiz stiff Define whether
horizontal stiffeners are
created to the beam.

If you enter one of the
dimensions, stiffeners
are created.

thickness = 20 mm
width = width of the
beam flange
height = 300 mm

Lower horiz stiff

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to control the stiffener position and orientation.

Material of folded plate

Select the material of the bent plate. The default material is defined in the
Folded plate box on the Components tab in File menu --> Settings -->
Options.

.
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Stiffener positions

 Description Default
1

4

Distance between the beam horizontal
stiffener and the beam end.

 

2

3

Distance between the beam horizontal
stiffener and the beam flange.

0.25*beam height

5 Distance between the stiffener and the
main part flange.

 

6

7

Distance between the main part stiffener
and the beam flange.

 

Bent shim plate and seat length
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 Description Default
1 Length of the horizontal part of the bent

shim plate.
 

2 Distance between the end plate and the
seat.

When using seat angles, change either this
value or the size of the end plate to avoid
collision between the secondary beam and
the angle.

20 mm

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.

Bolt edge distances in shim plate

Define the bolt edge distances for shim plates. When these fields are empty,
shim plates are of the same size as the end plate.
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 Description
1 Vertical bolt edge distance in the shim plate.

The size of the shim plate is defined by the bolt group and the edge
distances. Vertical and horizontal edge distance define the distance
symmetrically. Positive dimension increases the shim plate size.

2 Horizontal bolt edge distance in the shim plate.

The size of the shim plate is defined by the bolt group and the edge
distances. Vertical and horizontal edge distance define the distance
symmetrically. Positive dimension increases the shim plate size.

Gap size to end plate

Define the limit value for the gap between the end plate and the secondary or
main part. Use this gap when the beam is slightly curved or sloped to decide if
the end angle is so small that the beam end can be straight.

If the actual gap is smaller than this value, the beam end is left straight.

If the actual gap is larger than this value, the beam end is fitted to the end
plate.

Bolts tab
Use the Bolts tab to control the properties of the bolts.

Bolt group dimensions
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 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.

• Middle: From the center line of the secondary part to the center
line of the bolts.
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 Description
• Right: From the right edge of the secondary part to the rightmost

bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Dimension for vertical bolt group position.
7 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3
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Option Description
Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Notch tab
Use the Notch tab to modify the horizontal and vertical cuts.
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Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

General tab
Click the link below to find out more:

General tab

Design tab
Design tab

Analysis tab
Analysis tab

Welds

Click the link below to find out more:

Seating cap (37)
Seating cap (37) connects a beam to a column head with an end plate welded
to the column head and bolted to the lower flange of the secondary beam. The
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connection also creates stiffeners to the secondary part web, and optionally
rectangular washer plates.

Objects created

• End plates

• Stiffeners

• Washer plates

• Bolts

• Welds

Use for

Option Description
Square beam connected to a column
with a bolted end plate.

Sloped beam connected to a column
with a bolted end plate.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.
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Part identification key

  
1 End plate
2 Stiffener

Picture tab
Use the Picture tab to define the geometry of the connection.

End plate positions

 Description Default
1 End plate edge distance to the main part flange.  
2 End plate edge distance from the secondary part

flange.

You can control the column end plate size in the
secondary part axis direction. Positive values move the
end plate edge towards the centre.

-10 mm

3 End plate edge distance to the main part flange.  
4 Distance between the end plate and the secondary

part.
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Stiffener positions

 Description Default
1 Distance between the stiffener plate and the secondary

beam flange.
0

Parts tab
Use the Parts tab to define the part properties.

Plates

Option Description Default
Prim end plate Thickness of the main

part end plate.
Half of the screw
diameter

The width is defined by
the bolt group horizontal
edge distances.

The height is defined by
the plate edge distances
from the left and right
edge of the column.

Sec stiffeners Thickness, width and
height of the stiffeners.

The default value for the
stiffener thickness is
1.5*secondary beam
web thickness rounded
upwards to: 8, 10, 12, 16,
20, 25, 30, 35, 40, 45,
and so on.

If you do not define the
width, stiffener width is
based on the flange
width.

The height is equal to
the distance between
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Option Description Default
the secondary beam
flanges.

Sec end plate Thickness of the
secondary part end
plate.

The size of the plate is
based on the
dimensions of the
secondary part. You can
control the dimensions
on the Picture tab.

1.5* secondary beam
web thickness rounded
upwards to: 8, 10, 12, 16,
20, 25, 30, 35, 40, 45,
and so on.

Washer plates Thickness, width and
height of the washer
plates.

Washer plates are small
rectangular plates used
as washers between the
bolt head and secondary
beam flange.

If you do not enter a
value for the thickness,
the plates are not
created.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Name Name that is shown in

drawings and reports.
 

Parameters tab
Use the Parameters tab to define the chamfer dimensions and stiffener
position.

Stiffener position

 Description
1 Define the stiffener offset from the secondary part web.
2 Define the stiffener offset from the main part flange.

By default, stiffeners are placed to the same plane as the column
flange. Positive offset values move stiffeners to the right and
negative to the left.

Stiffener angle

Option Description
Default

Stiffeners are created parallel to the
column flange.

AutoDefaults can change this option.
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Option Description
Stiffeners are created parallel to the
column flange.

Stiffeners are created perpendicular
to the secondary beam flange.

Gap size

Define the limit value for the gap between the end plate and the secondary
beam. Use this when the beam is slightly curved or sloped to decide if the end
angle is so small that the beam end can be straight.

If the actual gap is smaller than this value, the end of the beam is left straight.

If the actual gap is larger than this value, the end of the beam is fitted to the
end plate.

Option Description
Horizontal gap dimension

Vertical gap dimension
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Chamfer size

 Description
1 Horizontal chamfer dimension
2 Vertical chamfer dimension

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer
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Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
2 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.
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 Description
• Middle: From the center line of the bolts to the center line

of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

6 Dimension for horizontal bolt group position.
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 Description
7 Select how to measure the dimensions for horizontal bolt

group position.

• Left: From the left edge of the secondary part to the
leftmost bolt.

• Middle: From the center line of the secondary part to the
center line of the bolts.

Steel components 645 End plate connections and details



 Description
• Right: From the right edge of the secondary part to the

rightmost bolt.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Holes tab
Use the Holes tab to define the holes created in the end plates.

Option Description
Bolt standard Select the bolt standard.
Bolt type Select the bolt type to define the

location where the bolts should be
attached.

Read data from You can select to use the
sinkholes.dat definition file to
specify the default values for
horizontal and vertical offsets, and
the diameters for upper and lower
holes.

The file is searched in the following
order: Environment common system
steel folder (..\Environments
\common\system\Steel), model
folder, XS_FIRM, XS_PROJECT and 
XS_SYSTEM folder.

You can also select to define the holes
in the component dialog box.
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Number of holes

Option Description
Default

No holes

AutoDefaults can change this option.

No holes

1 hole

2 holes

4 holes
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Hole positions

 Description
1 Horizontal distance between the end plate center and the upper

hole.
2 Horizontal distance between the end plate center and the lower

hole.
3 Vertical distance between the end plate center and the upper

hole.
4 Vertical distance between the end plate center and the lower

hole.
5 Diameter of the lower hole.
6 Diameter of the upper hole.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab
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Welds

Click the link below to find out more:

Haunch (40)
Haunch (40) connects a beam to a column using a welded haunch, or a profile
haunch and a bolted end plate.

Objects created

• End plate

• Top plate

• Stiffeners

• Cap plate

• Web plate

• Haunch plates

• Compression flange plates

• Bolts

• Welds

Use for

Situation Description
Beam connected to a column using a
profile haunch and a bolted end
plate.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Description
1 Haunch plate
2 Stiffener
3 End plate
4 Top plate
5 Compression flange plate

Picture tab
Use the Picture tab to define the connection dimensions, chamfers, double
haunches, and rotation point.

Dimensions

 Description
1 Tolerance dimension from the stiffener edge to the column web.
2 Gap dimension between the column and the end plate.
3 Vertical stiffener dimension from the creation point.
4 End plate top position from the top of the secondary beam.
5 End plate bottom position from the haunch plate lower edge.

Steel components 652 End plate connections and details



Top plate chamfers

 Description
1 Horizontal chamfer dimension.
2 Vertical chamfer dimension.

Option Option Description
No chamfer

Line chamfer

Convex chamfer

Concave chamfer

Horizontal rafter double haunch

You can select to create a double haunch if the beam is horizontal. All the
plates welded to the lower haunch are mirrored on the upper haunch and the
end plate is extended.

Option Description
Default

Lower haunch is created.

AutoDefaults can change this option.
Lower haunch is created.

Double haunch is created.

Double haunch with column stiffeners
is created.
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Select rotation point

Option Description
Default

Rotation point is in the middle of the
beam lower flange.

AutoDefaults can change this option.
Rotation point is in the middle of the
haunch flange.

Rotation point is in the middle of the
beam lower flange.

 Description
1 Define the tolerance value between the column and the end

plate.

The maximum width is at the top of the end plate. There is no
tolerance at the lowest point of the end plate.

2 Select whether the tolerance is defined as a distance or as a
rotation angle (in degrees).

Parameters tab
Use the Parameters tab to define the part properties and to control stiffener
creation.

Parts

Option Description
End plate Thickness, width, and height of the

end plate.
Add. stiffener Thickness, width, and height of the

additional stiffener.
Rafter bottom stiffener Thickness, width, and height of the

beam bottom stiffener.
Compr. stiffener Thickness, width, and height of the

compression stiffener.
Top plate Thickness, width, and height of the

top plate.
Cap plate Thickness, width, and height of the

cap plate.
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Option Description
Diagonal stiffener Thickness and width of the diagonal

stiffener.
Beam stiffener Thickness, width, and height of the

beam stiffener.
Morris stiffener Thickness and width of the Morris

stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Compression flange plate position

Option Description
Compression flange plate edge
distance to the end plate bottom
edge.

If the haunch is not created, the plate
is positioned on the beam flange.

Cap plate position
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 Description Default
1 Cap plate edge distance from the column

flange.
5 mm
The cap plate is by
default 5 mm
smaller than the
profile.

2 Cap plate edge distance from the column
flange.

Define this dimension when the cap plate
width has not been defined.

5 mm

Option Description
Default

Cap plate is created parallel with the
beam.

AutoDefaults can change this option.
Cap plate is created parallel with the
beam.

Cap plate is horizontal.

Additional stiffener

Option Description
Default

Cap plate or stiffener is not created.

AutoDefaults can change this option.
Cap plate or stiffener is not created.

Cap plate or stiffener is not created.

Define the vertical dimension for
moving the column end fitting plane.
Cap plate and stiffener are created.

Define the vertical dimension for
moving the cap plate or the column
end fitting plane.
Horizontal stiffener is created.
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Option Description
Stiffener is created parallel with the
skewed beam.

Bottom flange stiffener

Option Description
Default

Stiffener is not created.

AutoDefaults can change this option.
Horizontal stiffener is created.

Stiffener is not created.

Skewed stiffener is created.

Morris stiffener

If a haunch is not created, the Morris stiffener is not created either.

Option Description
Default

Horizontal stiffener is created.

Define the upper stiffener dimension
from the column web.

AutoDefaults can change this option.
Horizontal stiffener is created.

Define the upper stiffener dimension
from the column web.
Stiffener is not created.

Skewed stiffener is created.

Define the upper stiffener dimension
from the column web.

Stiffener chamfer shape and dimensions

Option Description
No chamfer
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Option Description
Line chamfer

Convex chamfer

Concave chamfer

 Description
1 Horizontal chamfer dimension.
2 Vertical chamfer dimension.

Beam stiffener

Option Description
Default

Vertical stiffener in the direction of
the column.

AutoDefaults can change this option.
Vertical stiffener in the direction of
the column.
Stiffener is created perpendicular to
the beam axis.

Beam stiffener offset

Option Description
Beam stiffener offset from the default
position where the beam stiffener is
created. The default position is in the
place where the haunch profile flange
touches the secondary beam.

Extra length for haunch flange plate

Define the distance that extends the flange plate of a welded haunch.
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Parameter to avoid solid error

Define the distance value to avoid solid errors. If a haunch profile is selected,
and a chamfer is created in the profile, the haunch profile may disappear. You
can solve this issue by increasing this value. The default value is 0.5 mm.

Haunch tab
Use the Haunch tab to define the haunch plate properties, type, and
geometry.

Parts

Option Description
Haunch prof In Haunch type, select Profile or

Default.

Select the haunch profile from the
profile catalog.

Vert haunch pl In Haunch type, select Welded
plates.

Thickness of the haunch plate.
Horiz haunch pl In Haunch type, select Welded

plates.

Thickness and width of the haunch
plate.

Closure plate Thickness and height of the closure
plate.

Comp. flange pl Thickness, width, and height of the
flange plate.

Haunch prolongation If the connection is created with an
open beam, the beam bottom flange
can be extended to reach the end
plate.

Select to extend the beam bottom
flange on the Open beam tab.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Material Material grade. The default material is

defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Haunch parameters

 Description Default
1 Select the first dimension for the

haunch geometry.

If the selected dimension cannot be
used for the geometry, a red component
symbol is displayed.

For profile hauches: If only one
dimension is selected (first or second), a
symmetrical haunch is created using the
symmetrical cut for profile haunch
options.

A, L1 dimension where
L1 = 1/5 from the beam
length.

Profile haunch: a
symmetrical haunch
using the symmetrical
cut for profile haunch
options.
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 Description Default
2 Select the second dimension for the

haunch geometry.

If you select two dimensions that cannot
be used for the geometry, a red
component symbol is displayed.

For profile haunches: If only one
dimension is selected (first or second), a
symmetrical haunch is created using the
symmetrical cut for profile haunch
options.

A, L1 dimension where
L1 = 1/5 from the beam
length.

Profile haunch: a
symmetrical haunch
using the symmetrical
cut for profile haunch
options.

Symmetrical cut for profile haunch

Select the calculation method, and define the tolerance value (t) and saw plate
thickness (s) to create a symmetrical profile haunch. This setting is not used
for welded plates.

When measured, the tolerance distance might have an error between 0 mm –
2 mm, resulting from the approximations done during calculation. Check that
the result is as intended. Note that if you define the vertical cut distance at the
upper end of the hauch, the tolerance value is not used.

With saw plate thickness, you can control how much of the material will be
wasted because of the sawing.

Option Description
Default

Inner haunch flange to outer beam
flange calculation.

AutoDefaults can change this option.
Define the tolerance value from the
outer haunch plate flange, and the
saw plate thickness.

Define the tolerance value from the
inner haunch plate flange, and the
saw plate thickness.

Define the tolerance value from the
haunch plate web, and the saw plate
thickness.

Inner haunch flange to outer beam
flange calculation.
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Welds in the vertical haunch plate

Option Description
Default

Both welds are created.

AutoDefaults can change this option.
Weld is created on the secondary
beam.

Both welds are created.

Cut at the upper end of the haunch

Using this option you can select if the haunch is created as fitted to the
secondary beam, or if there should be some material left, as specified with the
d option.

Option Description
Default

Vertical cut at the upper end of the
haunch. Define the cut distance.

AutoDefaults can change this option.
The cut is perpendicular to the beam
flange.

Vertical cut at the upper end of the
haunch. Define the cut distance.

Haunch is not cut.

Haunch end cuts parallel (only for profiles)

Select Yes to create the haunch cut at the upper end and the haunch cut at the
lower end parallel to each other.

Cut at the lower end of the haunch (only for profile haunch)

Option Description
Default

Vertical cut at the lower end of the
haunch.

AutoDefaults can change this option.
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Option Description
Vertical cut at the lower end of the
haunch.

Haunch is not cut.

Extra plates
Use the Extra plates tab to define the web plate and bolt plate properties.

Parts

Option Descripton
Web plate Thickness, width, and height of the

web plate.
Upper bolt plate Thickness and width of the upper bolt

plate.
Lower bolt plate Thickness and width of the lower bolt

plate.
Plate on column Thickness and width of the plate on

the column.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Bolt plate

Option Description
Default

One bolt plate for each bolt in the
group.

AutoDefaults can change this option.
One bolt plate for each bolt in the
group.

One bolt plate for each column of
bolts in the group.

One bolt plate for all the bolts in the
group.

Bolt plate is not created.

Bolt plate dimensions

Option Description
Define the bolt plate height when
creating one bolt plate for each bolt in
the group.

Define the vertical bolt plate edge
distance for the first and last bolt in
the group when creating one bolt
plate for each column of bolts, or one
bolt plate for all the bolts in the
group.
Define the thickness of the horizontal
bolt plate that continues the column
flange.

If the first bolt in the beam bolt group
is positioned above the beam –
column collision area, a new bolt
plate is created for the first bolt row
in the group.

Create web plate

Option Description
Default

Web plate is not created.

AutoDefaults can change this option.
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Option Description
Web plate is not created.

One web plate is created on the right
side of the column web.

One web plate is created on the left
side of the column web.

Two web plates are created.

Web plate settings

Option Description Default
Web plate edge type Select how the web plate is cut

at the higher end.

Bevel cuts the web plate at the
same angle the column cap
plate is positioned. If the
column cap plate is horizontal
or does not exist, the web plate
is cut Square.

Square

Number of holes Define the number of holes in
the web plate.

2

Hole diameter Define the diameter of the
holes in the web plate.

20 mm

Horizontal, Vertical Define the web plate welding
size:

• Define the left and right
weld between the column
and the web plate.

• Define the lower vertical
edge for the web plate.

5 mm
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Web plate dimensions

Option Description Default
1 Distance from the edge of the extra plate

to the top of the cap plate.
5 mm

2 Hole edge distance of the first hole in the
web plate.

30 mm +
hole_diameter/2

3 Vertical spacing between the holes. 160 mm
4 Vertical hole edge distance to the lower

edge of the web plate.
30 mm +
hole_diameter/2

5 Number of holes in the columns. 1
6 Distance between the holes in the

columns.
hole_diameter x 2

Slotted holes

You can define slotted or oversized holes.

 Description
1 Vertical dimension of the slotted hole.
2 Horizontal dimension of the slotted hole, or allowance for

oversized holes.

Chamfers tab
Use the Chamfers tab to define the chamfer type and dimensions.

Chamfers

Define the chamfer type and dimensions separately for each corner.
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Chamfer Description Default
Chamfer 1 Select the chamfer type

and define the
dimensions.

This chamfer is available
for both profile and
welded plate haunches.

No chamfer

Chamfer 2 Select the chamfer type
and define the
dimensions.

This chamfer is available
for welded plate
haunches only.

No chamfer

Chamfer 3 Select the chamfer type
and define the
dimensions.

This chamfer is available
for welded plate
haunches only.

No chamfer

Holes tab
Use the Holes tab to control the galvanizing holes in the end plate.

Option Description
Bolt standard Select the bolt standard.
Bolt type Select the bolt type to define the

location where the bolts should be
attached.

Read data from You can select to use the
sinkholes.dat definition file to
specify the default values for
horizontal and vertical offsets, and
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Option Description
the diameters for upper and lower
holes.

The file is searched in the following
order: Environment common system
steel folder (..\Environments
\common\system\Steel), model
folder, XS_FIRM, XS_PROJECT and 
XS_SYSTEM folder.

You can also select to define the holes
in the component dialog box.

Hole positions and number of holes

Define the hole positions and the number of holes in the end plate and the
cap plate.

The hole group center in the end plate is the middle point of the rafter and the
middle point of the haunch, if the haunch exists. The hole group center in the
cap plate is the middle point of the column. The hole groups are composed of
0, 1, 2, or 4 holes.

Holes group in rafter Holes group in haunch Holes group in cap
plate
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 Description Default
D1 Define the hole diameter for the holes

positioned by the x1 and y1 dimensions.
20 mm

D2 Define the hole diameter for the holes
positioned by the x2 and y2 dimensions.

20 mm

x1 Define the x1 position of the
galvanization holes.

0

y1 Define the y1 position of the
galvanization holes.

0

x2 Define the x2 position of the
galvanization holes.

0

y2 Define the y2 position of the
galvanization holes.

0

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
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 Description
2 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost
bolt.

• Middle: From the center line of the secondary part to the
center line of the bolts.
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 Description
• Right: From the right edge of the secondary part to the

rightmost bolt.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

6 Dimension for vertical bolt group position.
7 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.
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 Description
• Middle: From the center line of the bolts to the center line of

the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Bolting direction 2

Open beam tab
Use the Open beam tab to create an open beam haunch. To create the
haunch, the beam web is cut and the profile is opened at a desired angle. A
welded plate is placed as the haunch web.

Create open beam

Option Description
Open beam is not created. This is the
default.
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Option Description
Open beam is created.

If you create an open beam, the
options on the Haunch tab are
ignored.

Haunch dimensions

 Description Default
1 Horizontal haunch dimension 300 mm
2 Vertical haunch dimension 300 mm

Beam extension

Option Description
Beam bottom flange is not extended.
This is the default.

Beam bottom flange is extended to
reach the end plate.

Haunch part to the beam

Option Description
The haunch is added to the beam.

Steel components 675 End plate connections and details



Option Description
The haunch is an independent part
that is welded to the beam. This is the
default.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Cranked beam (41)
Cranked beam (41) connects two beam ends. The beam ends are fitted to an
angle which is an average of the beam end angles. A plate can be created
between the connected parts.

Objects created

• End plates

• Haunch plates

• Stiffeners

• Bolts

• Welds
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Use for

Situation Description
Beam ends are fitted.

Beam ends are fitted. Tubular profiles
are used.

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 End plate
2 Haunch plate
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 Description
3 Stiffener

Picture tab
Use the Picture tab to define the geometry of the connection.

Dimensions

 Description
1 Define the gap between the parts.

The gap is created on both sides of the end plate.
2 Define the end plate edge distance from the top of the

secondary part.
3 Define the end plate edge distance from the bottom of the

main part.
4 Define the end plate edge distance to the left and right

edge of the secondary part.

Parts tab
Use the Parts tab to define the properties of the end plates, haunch plates,
and stiffeners.

Parts

Part Description
Plate Thickness, width and height of the end plate.
Sec plate Thickness, width and height of the secondary

end plate.
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Part Description
Haunch prof Select the haunch profile from the profile

catalog.
Vert haunch pl Thickness of the vertical haunch plate.
Horiz haunch pl Thickness and width of the horizontal

haunch plate.
Haunch prof 2 Select the second haunch plate profile from

the profile catalog.
Vert haunch pl 2 Thickness of the second vertical haunch

plate.
Horiz haunch pl 2 Thickness and width of the second horizontal

haunch plate.
Column stiffener Thickness, width and height of the column

stiffener.
Beam stiffener Thickness, width and height of the column

stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Parameters tab
Use the Parameters tab to define the plate positions and dimensions.
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Plate positions and dimensions

 Description
1 Gap between the end plates.

You can define the gap either as a distance or as an angle.
2 Select whether the gap is defined as a distance or as an

angle (degrees).

By default, the gap is created as a distance.
3 Haunch plate height
4 Gap between the stiffeners and beam flanges
5 Stiffener edge distance to the haunch edge
6 Haunch plate length
7 Haunch plate chamfer size

Parallel haunch end cuts

If you have selected the haunch profile from the profile catalog, you can select
that the haunch ends are cut parallel.

Chamfer dimensions
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1 Horizontal chamfer dimension
2 Vertical chamfer dimension

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.
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Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Dimension for vertical bolt group position.
4 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.
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 Description
• Middle: From the center line of the bolts to the center line

of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

5 Dimension for horizontal bolt group position.
6 Select how to measure the dimensions for horizontal bolt

group position.

• Left: From the left edge of the secondary part to the
leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the

center line of the bolts.

• Right: From the right edge of the secondary part to the
rightmost bolt.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Chamfers tab
Use the Chamfers tab to define the chamfer types and dimensions for the
haunch plate chamfers.

Chamfers

You can define each chamfer separately.
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Holes tab
Use the Holes tab to define the holes created in the end plates.

Hole dimensions

You can define the holes separately for the main part end plate and the
secondary part end plate. The main part end plate values are used as default
values for the secondary part end plate.

Option Description
Define the hole group dimensions in
the rafter.
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Option Description
Define the hole group dimensions in
the haunch.

Option Description
Bolt standard Select the bolt standard.
Bolt type Select the bolt type to define the

location where the bolts should be
attached.

Read data from You can select to use the
sinkholes.dat definition file to
specify the default values for
horizontal and vertical offsets, and
the diameters for upper and lower
holes.

The file is searched in the following
order: Environment common system
steel folder (..\Environments
\common\system\Steel), model
folder, XS_FIRM, XS_PROJECT and 
XS_SYSTEM folder.

You can also select to define the holes
in the component dialog box.
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General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Create welds

Hql connection (46)
Hql connection (46) connects two hollow tube profiles by using end plates
and stiffeners.

Objects created

• End plates

• Stiffeners

• Bolts

• Welds

Use for

Situation Description
Profiles connected with bolted end
plate
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Selection order

1. Select the main part.

2. Select the secondary part.

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 End plate
2 Stiffener

Picture tab
Use the Picture tab to define the connection dimensions.

Dimensions

 Description Default
1 Vertical position of the stiffeners

Define the distance from the top and bottom edge of
the end plate.

10 mm

2 Distance between the end plates  
3 End plate top and bottom distance from the

secondary beam edge
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 Description Default
1 Width of the plate connected to the main part  
2 End plate edge distance from the secondary part

edge
0.5*beam
web
thickness

3 Horizontal position of the stiffeners 10 mm

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
Plate to prim Thickness of the end

plate
1.5*main part web
thickness

End plate to sec Thickness of the end
plate

1.5*secondary part web
thickness

Stiffeners Thickness of the
stiffeners

0.5*bolt diameter

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Name Name that is shown in

drawings and reports.
 

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

General tab

Click the link below to find out more:

General tab
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Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Plate with nail (47)
Plate with nail (47) connects two hollow tube profiles with an end plate that
is welded to the secondary part, and two fastener plates with nails, one
welded to the end plate and the other welded to the main part.

Objects created

• End plate

• Fastener plate

• Welds

Use for

Situation Description
Profiles connected with end plate and
fastener plates

Selection order

1. Select the main part (column or beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Description
1 End plate
2 Fasterner plates

Picture tab
Use the Picture tab to define the connection dimensions.

Dimensions

 Description Default
1 End plate edge distance from the upper edge of the

secondary beam
0.5*beam
flange
thickness

2 Vertical position of the nail from the top of the end
plate

10 mm

3 End plate edge distance from the lower edge of the
secondary beam
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 Description Default
1 Horizontal position of the nail from the end plate

edge
0

2 Horizontal position of the end plate 0.5*beam
web
thickness

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
End plate to beam Thickness of the end

plate
1.5*secondary part web
thickness

Fastener plate Thickness and width of
the fastener plate

Thickness = 10 mm
Width = 30 mm

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

General tab

Click the link below to find out more:

General tab
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Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Spacer plate (48)
Spacer plate (48) connects a beam to a column with an end plate that is
welded to the beam and two bearing plates, one connected to the beam and
the other welded to the column. Spacer plates are created to fill the space
between the column and the bearing plate that is connected to the beam. The
situation occurs when the bearing plate connected to the column is thicker
than the bearing plate connected to the beam.

Objects created

• Bearing plate

• End plate

• Spacer plate

• Bolts

• Welds

Use for

Situation Description
Beam connected to a column

Selection order

1. Select the main part (column).
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2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 End plate to beam
2 Bearing plate to beam
3 Spacer plate
4 Bearing plate to column

Picture tab
Use the Picture tab to define the connection dimensions.

Dimensions

 Description Default
1 End plate top and bottom distance from the

secondary beam edge
0.5*beam
flange
thickness

2 Bearing plate edge dimension from the top of the
end plate

0

3 End plate edge distance from the main part Thickness
of the
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 Description Default
thicker
bearing
plate plus
1.0 mm

 Description Default
1 Bearing plate horizontal position from the end plate

edge
0

2 End plate horizontal position from the secondary
part edge

0

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
Bearing pl to prim Thickness and height of

the bearing plate
connected to the main
part

Thickness = 25 mm
Height = height of the
beam profile divided by
three and rounded up to
nearest 5 mm

End plate to beam Thickness of the end
plate

15 mm

Bearing pl to beam Thickness and height of
the bearing plate
connected to the
secondary part

Thickness = 30 mm
Height = height of the
beam profile divided by
three and rounded up to
nearest 5 mm

Spacer plates Thickness of the spacer
plates

2 mm
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions
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 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the
leftmost bolt.

• Middle: From the center line of the secondary part to the
center line of the bolts.
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 Description
• Right: From the right edge of the secondary part to the

rightmost bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

6 Select how to measure the dimensions for vertical bolt group
position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.
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 Description
• Middle: From the center line of the bolts to the center line of

the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

7 Dimension for vertical bolt group position.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes

Steel components 704 End plate connections and details



Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

General tab

Click the link below to find out more:

General tab
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Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Double plate (50)
Double plate (50) connects two beams and a column with double end plates.
Ear plates can be connected to the beam end plates.

Objects created

• End plates

• Stiffeners

• Ear plates

• Bolts

• Welds

Use for

Situation Description
Two beams connected to a column
with end plates

Selection order

1. Select the main part (column).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.
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Part identification key

 Description
1 Column end plates, upper and lower
2 Beam end plates
3 Stiffeners

Picture tab
Use the Picture tab to define the connection dimensions.

Dimensions

 Description Default
1 Stiffener plate width Equal to

lower
column
plate
width
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 Description Default
2 Distance from the top of the beam end plate to the

beam upper edge
-20 mm

3 Sitffener height -200 mm
4 Distance between the column end plate edges 0
5 Distance between the upper column end plates 0
6 Distance between the lower column end plate and

column edge
10 mm

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
Beam end plates Thickness of the end

plates
10 mm

Column end plates Thickness, width, and
height of the end plates

10 mm

Stiffener plates Thickness of the
stiffener plates

10 mm

End plates Thickness, width, and
height of the end plates

By default, ear plates are
not created.

To create ear plates,
enter the thickness.

Parameters tab
Use the Parameters tab to define the ear plate dimensions and position.

Dimensions

 Description Default
1 Distance between the end plate upper edge and ear

plate upper edge
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 Description Default
2 Number of the holes in the ear plate in the vertical

and horizontal direction
Vertical = 2
Horizontal =
1

3 Vertical and horizontal distance between the holes
in the ear plate

 

4 Distance from the center point of the outermost
hole in the ear plate to the ear plate outer edge

 

5 Distance from the center point of the uppermost
hole in the ear plate to the ear plate upper edge

 

6 Ear plate hole diameter  

Stiffener chamfer dimensions

 Description Default
1 Horizontal chamfer dimension 20 mm
2 Vertical chamfer dimension 20 mm

Ear plate position

Option Description
Default

Ear plates are created on both sides.

AutoDefaults can change this option.
Ear plates are created on both sides.

Ear plate is created on the left.

Ear plate is created on the right.
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Flange Blt tab
Use the Flange Blt tab to define the bolt group dimensions and bolt
properties.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost
bolt.
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 Description
• Middle: From the center line of the secondary part to the

center line of the bolts.

• Right: From the right edge of the secondary part to the
rightmost bolt.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

6 Dimension for vertical bolt group position.
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 Description
7 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line of
the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3
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Option Description
Staggered type 4

Web bolts tab
Use the Web bolts tab to define the bolt group dimensions and bolt
properties.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost
bolt.
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 Description
• Middle: From the center line of the secondary part to the

center line of the bolts.

• Right: From the right edge of the secondary part to the
rightmost bolt.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts, enter
2 values.

5 Dimension for vertical bolt group position.
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 Description
6 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line of
the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab
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Welds

Click the link below to find out more:

Fit haunch (51)
Fit haunch (51) connects a beam to a column with a connection plate and an
end plate that is welded to the column.

Objects created

• Column plate (end plate)

• Connection plate

• Triangular plate

• Bolts

• Welds

Use for

Situation Description
Beam connected to a column with a
connection plate and an end plate

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Description
1 Column end plate
2 Connection plate
3 Triangular plate

Picture tab
Use the Picture tab to define the connection dimensions.

Dimensions

 Description Default
1 Column plate edge distance from the secondary

part edge
0

2 Column plate edge distance from the column edge 0.5*connecti
on plate
width mm

3 Height of the triangular plate Main part
height/6
mm
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 Description Default
4 Width of the triangular plate Main part

height/6
mm

5 Connection plate edge distance from the column
edge

Main part
height/6
mm

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
Column plate Thickness and height of

the column plate
Thickness = 10 mm
Height = main part
height - main part flange
thickness mm

Connection plate Thickness, width, and
height of the connection
plate

Thickness = 10 mm
Width is calculated by
the bolt positions.

Height is equal to the
main part height.

Triangular plate Thickness of the
triangular plate

10 mm

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Select how to measure the dimensions for horizontal bolt

group position.

• Left: From the left edge of the secondary part to the
leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the

center line of the bolts.

• Right: From the right edge of the secondary part to the
rightmost bolt.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

6 Dimension for vertical bolt group position.

Steel components 725 End plate connections and details



 Description
7 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line
of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3
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Option Description
Staggered type 4

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Partial stiff end plate (65)
Partial stiff end plate (65) creates a beam-to-beam end plate connection. The
connection creates an end plate on the secondary beam, a stiffener plate and
a connection front plate at the main beam. In addition, stiffener plates can be
added to both sides, a bottom plate can be added to the bottom of the main
stiffener plate, and shim plates can be created.

Objects created

• End plate

• Shear tab

• Stiffeners

• Shim plates

• Bolts

• Welds
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Use for

Situation Description
Two beams connected with bolted
end plates.

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 End plate
2 Shim plate
3 Front plate
4 Shear tab
5 Stiffener

Picture tab
Use the Picture tab to define the part positions.
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Dimensions

 Description
1 Front plate edge distance from the main part flange.
2 End plate edge distance from the secondary part flange.
3 Front plate edge distance from the secondary part flange.
4 Gap between the front plate and the shim plate.
5 Gap between the shear tab and the front plate.

The lower box is for controlling the shear tab on the other side of
the main part.

6 Gap between the shear tab and the main part web.

The lower box is for controlling the shear tab on the other side of
the main part.

7 Stiffener edge distance from the main part web.
8 Shear tab edge distance from the main part web.

Gap size

Define the limit value for the gap between the end plate and the secondary
beam. Use this when the beam is slightly curved or sloped to decide if the end
angle is so small that the beam end can be straight.

If the actual gap is smaller than this value, the end of the beam is left straight.

If the actual gap is larger than this value, the end of the beam is fitted to the
end plate.
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Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description
End plate Thickness of the end plate.
Front plate Thickness and width of the front plate.
Shear plate Thickness, width and height of the end plate.
Fill shear plate width Select whether to use the 

XS_STANDARD_STIFFENER_WIDTH_TOLERAN
CE advanced option for the width.

Stiffener Thickness and width of the stiffener.
Bottom stiffener as one
plate

Select whether the bottom stiffener is
created as one plate.

Fitting plate 1, Fitting plate
2, Fitting plate 3

Thickness of the shim plate.

Bottom plate Select the bottom plate profile from the
profile catalog.

Profile Select a profile.

When you select a profile, this profile is
created instead of the front plate.

Profile rotation Select whether the profile is rotated
horizontally or vertically.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Option Description Default
Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Shim plate bolt edge distance

 Description
1 Horizontal bolt edge distance in the shim plate.
2 Vertical bolt edge distance in the shim plate.

Shim plate shape

Option Description
Default

Holes are based on the bolt group of
the connection.

AutoDefaults can change this option.

Holes are based on the bolt group of
the connection.

Finger shim plate with horizontal
slots.

The plate can be installed from the
right or the left side of the
connection.

Finger shim plate with vertical slots.

The plate can be installed from the
top of the connection.
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Option Description
Two separate finger shim plates with
horizontal slots.

Two separate finger shim plates with
vertical slots.

Tolerance

Define the tolerance for the slots in finger shim plates. The width of the slot is
the bolt diameter + the tolerance. For two separate shim plates, also define
the tolerance between the plates.

Parameters tab
Use the Parameters tab to define the chamfers of the shear tab and
stiffeners.

Shear tab chamfer dimensions

 Description Default
1 Horizontal chamfer dimension. 30 mm
2 Vertical chamfer dimension. 30 mm
3 Bottom chamfer dimension. 30 mm

Option Description
Default

Line chamfer

AutoDefaults can change this option.
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Option Description
No chamfer

Line chamfer

Convex chamfer

Concave chamfer

Shear tab shape

Option Description
Default

Full

Creates a full shear tab of the same height as
the web of the main part.

AutoDefaults can change this option.
Full

Shear tabs are created on both sides of the
main part web.

Partial shear tab is created on the other side
of the main part web.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.
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Option Description
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Chamfer dimensions

 Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.
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Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost
bolt.
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 Description
• Middle: From the center line of the secondary part to the

center line of the bolts.

• Right: From the right edge of the secondary part to the
rightmost bolt.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.
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 Description
6 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line of
the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

7 Dimension for vertical bolt group position.
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 Description
8 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate
the numbers with a space. Bolt numbers run from left to right
and from top to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Bolt type

Select the bolt type to define the location where the bolts should be attached.

Bolt comment

You can define a bolt comment.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
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Option Description
Bolting direction 1

Bolting direction 2

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Holes - end plate tab
Use the Holes - end plate tab to control the galvanizing holes in the end plate.

Option Description
Bolt standard Select the bolt standard.
Bolt type Select the bolt type to define the

location where the bolts should be
attached.

Read data from You can select to use the
sinkholes.dat definition file to
specify the default values for
horizontal and vertical offsets, and
the diameters for upper and lower
holes.

The file is searched in the following
order: Environment common system
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Option Description
steel folder (..\Environments
\common\system\Steel), model
folder, XS_FIRM, XS_PROJECT and 
XS_SYSTEM folder.

You can also select to define the holes
in the component dialog box.

Number of holes

The center of a hole group is the middle point of the beam and the middle
point of the haunch, if the haunch exists. The hole groups are composed of 0,
1, 2 or 4 holes.

Option Description
Default

No holes

AutoDefaults can change this option.

No holes

1 hole
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Option Description
2 holes

4 holes

Hole positions

 Description
1 Horizontal distance between the secondary beam center and the

upper hole.
2 Horizontal distance between the secondary beam center and the

lower hole.
3 Vertical distance between the secondary beam center and the

upper hole.
4 Vertical distance between the secondary beam center and the

lower hole.
5 Diameter of the lower hole.
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 Description
6 Diameter of the upper hole.

Holes - front plate tab
Use the Holes - front plate tab to control the galvanizing holes in the front
plate.

Option Description
Bolt standard Select the bolt standard.
Bolt type Select the bolt type to define the

location where the bolts should be
attached.

Read data from You can select to use the
sinkholes.dat definition file to
specify the default values for
horizontal and vertical offsets, and
the diameters for upper and lower
holes.

The file is searched in the following
order: Environment common system
steel folder (..\Environments
\common\system\Steel), model
folder, XS_FIRM, XS_PROJECT and 
XS_SYSTEM folder.

You can also select to define the holes
in the component dialog box.

Number of holes

The center of a hole group is the middle point of the beam and the middle
point of the haunch, if the haunch exists. The hole groups are composed of 0,
1, 2 or 4 holes.

Option Description
Default

No holes

AutoDefaults can change this option.
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Option Description
No holes

1 hole

2 holes

4 holes
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Hole positions

 Description
1 Horizontal distance between the secondary beam center and the

upper hole.
2 Horizontal distance between the secondary beam center and the

lower hole.
3 Vertical distance between the secondary beam center and the

upper hole.
4 Vertical distance between the secondary beam center and the

lower hole.
5 Diameter of the lower hole.
6 Diameter of the upper hole.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab
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Welds

Click the link below to find out more:

Dstv connection properties

Click the link below to find out more:

End plate (101)
End plate (101) connects a beam to another beam or to a column using an
end plate. The end plate is welded to the secondary beam and bolted to the
main part (beam or column).

Objects created

• End plate

• Bolts

• Welds

• Cuts

Use for

Situation Description
Beam to beam connection with a bolted end plate.

Beam to column connection with a bolted end plate.

Selection order

1. Select the main part (beam or column).
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2. Select the secondary part (beam).

The connection is created automatically when the secondary beam is
selected.

Part identification key

 Part
1 End plate

Picture tab
Use the Picture tab to control the position of the end plate.

End plate position

 Description Default
1 Gap between the main part and the end

plate.
2 mm

2 End plate edge distance to the secondary
part flange.

 

End plate tab
Use the End plate tab to control the properties of the end plate.
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Plate

Part Description
End plate Define the end plate thickness and

height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Option Description
End plate edge type Define how the end plate is cut. The

default is Rolled/Sawn.
Adapt to secondary part slope Select whether to align the end plate

with the secondary part slope.

Notch tab
Use the Notch tab to create notches for the secondary beam and to control
the notch properties.

BCSA notch definition

Define whether the notch is created according to British Constructional
Steelwork Association (BCSA) specifications.

Option Description
Default Notch dimensions.
Yes Creates a 50 mm notch for simple beam-to-beam

connections.
No Use the options on this Notch tab to define the notch

dimensions.
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Notch dimensions

Define the top and the bottom dimensions of the notch if you have set the
BCSA notch def option to No.

 Description
1 Vertical notch dimension.
2 Horizontal notch dimension.

Notch shape

Define the notch shape for the top and the bottom of the secondary beam.

Option Option Description
Default

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

AutoDefaults can change
this option.
No notch

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

Define the notch
dimensions. In beam-to-
beam connections with a
sloped secondary beam,
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Option Option Description
the depth is measured
as shown in the picture.

Creates a notch on both
sides of the secondary
part.

Define the notch
dimensions.
Creates a chamfered
notch on both sides of
the secondary beam.

Define the chamfer
dimensions.
Creates a strip.

Define the length of the
strip. The flanges are cut
completely.
Creates a special type of
square notch.

Define the notch
dimensions. The notch is
square to the secondary
beam. There are no
default values for the
length or the depth.

Notching side

Define on which side of the secondary beam the notch is created. You can
define the side for both the top and the bottom of the secondary beam.

Option Description
Default

Creates notches on both sides.

AutoDefaults can change this option.
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Option Description
Creates notches on both sides.

Creates a notch on the left side.

Creates a notch on the right side.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the center

line of the bolts.

• Right: From the right edge of the secondary part to the rightmost
bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.
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 Description
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Dimension for vertical bolt group position.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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General tab
Click the link below to find out more:

General tab

Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

End plate with compensating flange plates (111)
End plate with compensating flange plates (111) connects a beam to
another beam using an end plate with compensating flange plates. The end
plate is welded to the secondary beam and bolted to the main beam.

Objects created

• End plate

• Compensating flange plates

• Bolts

• Welds

• Cuts
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Use for

Situation Description
Connection with an end plate and compensating
flanges.

Connection with an end plate and compensating
flange plates.

The secondary beam is sloped.

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 End plate
2 Compensating flange plate
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Picture tab
Use the Picture tab to control the position of the plates.

Dimensions

 Description
1 Gap between the main beam and the end plate.
2 Distance from the inner edge of the flange plate to the secondary

beam flange.
3 Distance from the outer edge of the flange plate to the secondary

beam flange.
4 End plate edge distance to the main beam flange.

Description
1 Horizontal chamfer dimension of the flange plate.
2 Flange plate dimension that remains when a chamfer is created.
3 Inner chamfer dimension of the flange plate.

Parts tab
Use the Parts tab to control the plate properties.
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Plate

Part Description
End plate Define the end plate

thickness and height.
Compensating flange
plate

Define the flange plate
thickness, width, and
height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Notch tab
Use the Notch tab to create notches for the secondary beam and to control
the notch properties.

BCSA notch definition

Define whether the notch is created according to British Constructional
Steelwork Association (BCSA) specifications.

Option Description
Default Notch dimensions.
Yes Creates a 50 mm notch for simple beam-to-beam

connections.
No Use the options on this Notch tab to define the notch

dimensions.
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Notch dimensions

Define the top and the bottom dimensions of the notch if you have set the
BCSA notch def option to No.

 Description
1 Vertical notch dimension.
2 Horizontal notch dimension.

Notch shape

Define the notch shape for the top and the bottom of the secondary beam.

Option Option Description
Default

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

AutoDefaults can change
this option.
No notch

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

Define the notch
dimensions. In beam-to-
beam connections with a
sloped secondary beam,
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Option Option Description
the depth is measured
as shown in the picture.

Creates a notch on both
sides of the secondary
part.

Define the notch
dimensions.
Creates a chamfered
notch on both sides of
the secondary beam.

Define the chamfer
dimensions.
Creates a strip.

Define the length of the
strip. The flanges are cut
completely.
Creates a special type of
square notch.

Define the notch
dimensions. The notch is
square to the secondary
beam. There are no
default values for the
length or the depth.

Notching side

Define on which side of the secondary beam the notch is created. You can
define the side for both the top and the bottom of the secondary beam.

Option Description
Default

Creates notches on both sides.

AutoDefaults can change this option.
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Option Description
Creates notches on both sides.

Creates a notch on the left side.

Creates a notch on the right side.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the center line

of the bolts.

• Right: From the right edge of the secondary part to the rightmost
bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.
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 Description
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Dimension for vertical bolt group position.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Two-sided end plate with compensating flange plates (112)
Two-sided end plate with compensating flange plates (112) connects a
beam to two beams using end plates with compensating flange plates. The
end plates are welded to the secondary beams and bolted to the main beam.

Objects created

• End plates

• Compensating flange plates

• Bolts

• Welds

• Cuts
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Use for

Situation Description
Connection with end plates and compensating
flange plates.

Connection with end plates and compensating
flange plates.

Secondary beams are sloped.

Selection order

1. Select the main part (beam).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.

Part identification key

 Part
1 End plate
2 Compensating flange plate
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Picture tab
Use the Picture tab to control the position of the end plates and
compensating flange plates.

Dimensions

 Description
1 Gap between the main beam and the end plate.
2 End plate edge distance to the secondary beam flange.
3 Distance from the inner edge of the flange plate to the secondary

beam flange.
4 Distance from the outer edge of the flange plate to the secondary

beam flange.

 Description
1 Inner chamfer dimension of the flange plate.
2 Horizontal chamfer dimension of the flange plate.
3 Flange plate dimension that remains when a chamfer is created.

Parts tab
Use the Parts tab to control the plate properties.
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Plate

Part Description Default
End plate, Second end
plate

Define the end plate thickness
and height.

If you have defined the gap
between the main beam and the
end plate on the Picture tab, the
length entered on the Parts tab
is not taken into account.

If the secondary
part width is less
than 200mm, the
thickness of the
end plate is 8mm.
Otherwise, it is
10mm.

Compensating flange
plate, Second
compensating flange
plate

Define the flange plate
thickness, width, and height.

The same values are used for
the top and the bottom plates.

Width = The
default value is
based on rounding
(beam flange width
- beam web
thickness) / 2.0.

Height = 150mm
more than the
notch length

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Move plates 2 in y-direction

You can move the flange plates and the end plate on the second secondary
beam side in the y-direction. By default, the plates on the second secondary
side are positioned so that the holes are symmetric. To use this option, set the
horizontal bolt group position to the Middle position and define the horizontal
bolt group dimension on the Bolts tab. Moving the plates is useful especially
when the secondary beams are skewed or curved.
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Notch tab
Use the Notch tab to create notches for the secondary beams and to control
the notch properties. Define the notches for both secondary beams.

BCSA notch definition

Define whether the notch is created according to British Constructional
Steelwork Association (BCSA) specifications.

Option Description
Default Notch dimensions.
Yes Creates a 50 mm notch for simple beam-to-beam

connections.
No Use the options on this Notch tab to define the notch

dimensions.

Notch dimensions

Define the top and the bottom dimensions of the notch if you have set the
BCSA notch def option to No.

 Description
1 Vertical notch dimension.
2 Horizontal notch dimension.

Notch shape

Define the notch shape for the top and the bottom of the secondary beam.

Option Option Description
Default

Creates a square notch
on the top side or on the
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Option Option Description
bottom side of the
secondary beam.

AutoDefaults can change
this option.
No notch

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

Define the notch
dimensions. In beam-to-
beam connections with a
sloped secondary beam,
the depth is measured
as shown in the picture.

Creates a notch on both
sides of the secondary
part.

Define the notch
dimensions.
Creates a chamfered
notch on both sides of
the secondary beam.

Define the chamfer
dimensions.
Creates a strip.

Define the length of the
strip. The flanges are cut
completely.
Creates a special type of
square notch.

Define the notch
dimensions. The notch is
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Option Option Description
square to the secondary
beam. There are no
default values for the
length or the depth.

Notching side

Define on which side of the secondary beam the notch is created. You can
define the side for both the top and the bottom of the secondary beam.

Option Description
Default

Creates notches on both sides.

AutoDefaults can change this option.
Creates notches on both sides.

Creates a notch on the left side.

Creates a notch on the right side.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions
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 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.

• Middle: From the center line of the secondary part to the center
line of the bolts.
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 Description
• Right: From the right edge of the secondary part to the rightmost

bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Dimension for vertical bolt group position.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2
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Option Description
Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Two sided end plate (115)
Two sided end plate (115) connects two beams to a beam or a column using
end plates. The end plates are welded to the secondary beams and bolted to
the main part (beam or column).

Objects created

• End plates (2)

• Bolts

• Welds

• Cuts

Use for

Situation Description
End plates with two secondary beams. Automatic
notching for bolt clearance.
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Situation Description
End plates with two secondary beams at different
heights.

End plates with two secondary beams.

A square and a skewed secondary beam.

End plates with two secondary beams. Safety
connection.

End plates with two sloped secondary beams.
Various notching options.

Selection order

1. Select the main part (beam or column).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).
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4. Click the middle mouse button to create the connection.

Part identification key

 Part
1 End plate

Picture tab
Use the Picture tab to control the position of the end plates.

Dimensions

 Description Default
1 Gap between the main part and the end

plate.
2 mm

2 End plate edge distance to the secondary
beam flange.

50 mm

End plates tab
Use the End plates tab to control the properties of the end plates.
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Plate

Part Description
End plate, 2nd End plate Define the end plate thickness and

height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Move plates 2 in y-direction

You can move the end plate on the second secondary beam side in the y-
direction. By default, the plates on the second secondary side are positioned
so that the holes are symmetric. To use this option, set the horizontal bolt
group position to the Middle position and define the horizontal bolt group
dimension on the Bolts tab. Moving the plates is useful especially when the
secondary beams are skewed or curved.
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End plate Edge Type

Define how the end plate is cut. The default is Rolled/Sawn.

Notch tab
Use the Notch tab to create notches for the secondary beams and to control
the notch properties. Define the notches for both secondary beams.

Notch shape

Define the notch shape for the top and the bottom of the secondary beam.

Option Option Description
Default

Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

AutoDefaults can change
this option.
No notch

Steel components 785 End plate connections and details



Option Option Description
Creates a square notch
on the top side or on the
bottom side of the
secondary beam.

Define the notch
dimensions. In beam-to-
beam connections with a
sloped secondary beam,
the depth is measured
as shown in the picture.

Creates a notch on both
sides of the secondary
part.

Define the notch
dimensions.
Creates a chamfered
notch on both sides of
the secondary beam.

Define the chamfer
dimensions.
Creates a strip.

Define the length of the
strip. The flanges are cut
completely.
Creates a special type of
square notch.

Define the notch
dimensions. The notch is
square to the secondary
beam. There are no
default values for the
length or the depth.

Notch dimensions

Define the top and the bottom dimensions of the notch if you have set the
BCSA notch def option to No.
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 Description
1 Vertical notch dimension.
2 Horizontal notch dimension.

Notching side

Define on which side of the secondary beam the notch is created. You can
define the side for both the top and the bottom of the secondary beam.

Option Description
Default

Creates notches on both sides.

AutoDefaults can change this option.
Creates notches on both sides.

Creates a notch on the left side.

Creates a notch on the right side.

BCSA notch definition

Define whether the notch is created according to British Constructional
Steelwork Association (BCSA) specifications.

Option Description
Default Notch dimensions.
Yes Creates a 50 mm notch for simple beam-to-beam

connections.
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Option Description
No Use the options on this Notch tab to define the notch

dimensions.

Bolts tab
Use the Bolts tab to control the bolts properties.

Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the center line

of the bolts.

• Right: From the right edge of the secondary part to the rightmost
bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.
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 Description
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Dimension for vertical bolt group position.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Steel components 792 End plate connections and details



General tab
Click the link below to find out more:

General tab

Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Stub connection (119)
Stub connection (119) creates a connection between an H(I) type of column
and a beam. The beam can be of any type. The connection can create eight
stiffener plates and four haunch plates. The end plates are bolted to each
other, and the other plates are welded.

Objects created

• End plates

• Haunch plates

• Stiffeners

• Bolts

• Welds
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Use for

Situation Description
Stub connection with bolted end
plates and haunch plates.

The secondary part can be skewed or
sloped. Top and bottom haunch
plates can be created.

1 Secondary part web not directed to
the center of the column (top view).

2 Secondary part web not
perpendicular to the column
horizontally (top view).

3 Secondary part web not
perpendicular to the column vertically
(side view).

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).
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Part identification key

 Description
1 Stiffener plates
2 End plates
3 Haunch plates

Picture tab
Use the Picture tab to define end plate and stiffener dimensions.

Dimensions
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 Description Default
1 Distance from the column to the first end plate.

If the secondary part web is not perpendicular to
the column horizontally, this is the minimum
distance from the column to the first end plate.

100 mm

2 Distance between the end plates. 0 mm
3 Gap between the end plate and the beam web.  

 Descriptioin Default
1 Distance between the exterior face of the beam and

the exterior face of the front stiffener.
0 mm

2 Angle between the bottom front stiffener and the
horizon.

(This angle is valid only in the regular case).

0 degrees

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description
Top plate

Bottom plate

Middle plate

Thickness of the top, bottom and
middle plate.

Upper haunches

Lower haunches

Thickness of the upper and lower
haunches.

End plate 1 Thickness, width and height of the
end plate.
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Option Description
End plate 2 Thickness of the end plate.
Top stiffener

Bottom stiffener

Middle stiffener

Thickness of the top, bottom and
middle stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to control the stiffener creation, position and
chamfers.

Stiffener creation

Option Description
Default

Full

Creates a full stiffener of the same
height as the web of the main part.

AutoDefaults can change this option.
Full

Creates a full stiffener of the same
height as the web of the main part.
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Option Description
Full, both sides of the main part

Creates a full stiffener of the same
height as the web of the main part.

Stiffener gap

 Description
1 Distance between the stiffener and the column web
2 Distance between the stiffener and the column flange

Stiffener positions

 Description
1 Size of the gap between the top stiffener and the beam flange

edge.
2 Size of the gap between the bottom stiffener and the beam

flange edge.
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Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Bolts tab
Use the Bolts tab to define the bolt properties.

Steel components 799 End plate connections and details



Bolt group dimensions

 Description
1 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.
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 Description
• Middle: From the center line of the bolts to the center line of

the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

2 Dimension for vertical bolt group position.
3 Dimension for horizontal bolt group position.
4 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

5 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

6 Number of bolts.
7 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

8 Define which bolts are deleted from the bolt group.

Steel components 801 End plate connections and details



Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3
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Option Description
Staggered type 4

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Two sided end plate (142)
Two sided end plate (142) connects two beams to a beam or to a column
using bolted end plates. One bolt group goes through all the three parts.

Objects created

• End plates

• Shim plates

• Compensating flange plates (optional)

• Haunch plates (optional)

• Holes

• Bolts

• Welds

• Cuts
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Use for

Situation Description
End plate connection with two secondary parts.

Automatic notching for bolt clearance.

End plate connection with two secondary parts
and with a haunch plate.

Automatic notching for bolt clearance.

End plate connection with two secondary parts
at different heights.

End plate connection with two secondary parts.

The secondary parts can be square and/or
skewed.
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Situation Description
End plate connection with two secondary parts.

Safety connection.

End plate connection with two secondary parts.

The secondary parts can be leveled and/or
sloped.

Selection order

1. Select the main part (column or beam).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.

Part identification key

 Part
1 End plate for the first secondary part
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 Part
2 Shim plate for the first secondary part
3 End plate for the second secondary part
4 Shim plate for the second secondary part
5 Compensating flange plate for the first secondary part
6 Compensating flange plate for the second secondary part

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Picture tab
Use the Picture tab to control the positions of the end plates and
compensating flange plates.

Plate positions

 Description
1 End plate upper edge distance from the top of the first secondary

beam.
2 End plate lower edge distance from the bottom of the first secondary

beam.
3 End plate lower edge distance from the bottom of the second

secondary beam.
4 End plate upper edge distance from the top of the second secondary

beam.
5 Gap between the shim plates and the main part.

Gap for each side individually. If the shim plates are not used, the
defined gap is created between the end plate and the main part.

6 Upper compensation flange plate edge distance from the top of the
first secondary beam.
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 Description
7 Lower compensation flange plate edge distance from the top of the

first secondary beam.
8 Upper compensation flange plate edge distance from the top of the

second secondary beam.
9 Lower compensation flange plate edge distance from the top of the

first secondary beam.

Compensation flange plate arrangements

Option Description
Default

Compensation flange plates are not
created.

AutoDefaults can change this option.

Compensation flange plates are not
created.

Compensation flange plates are
created.

Egde distance from the top of the
secondary part.

Compensation flange plates are
created.

Edge distance from the top of the
main part.
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Compensating flange plate shapes

 Description
1 Compensating flange plate dimension that remains when a

chamfer is created.
2 Horizontal chamfer dimension of the compensating flange

plate.
3 Inner chamfer dimension of the compensating flange plate.

Sort secondaries by profile height

When you create a Two sided end plate (142) connection, the larger of the
two profiles is usually selected as the first secondary beam. If the profile is
later changed and the second secondary beam becomes larger than the first
secondary beam, the order of secondary beams can be redefined.

• Yes switches the secondary beams so that the largest beam automatically
becomes the first secondary beam.

• No does not change the order of secondary beams if the profile size is
changed.

Plates 1 tab
Use the Plates 1 tab to control the size of the end plate, shim plates and
compensating flange plates for the first secondary beam.

Plates

Option Description Default
End plate End plate thickness,

width and height.
thickness = 10 mm
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Option Description Default
Fitting Plate 1

Fitting Plate 2

Fitting Plate 3

Shim plate thickness.

The plate is created only
if the plate thickness is
given.

You can define up to
three different shim
plates.

0

Number of fitting pl. 1
(DEF=1)

Number of fitting pl. 2
(DEF=1)

Number of fitting pl. 3
(DEF=1)

Number of shim plates
for each thickness.

By default, 1 plate is
created.

Comp. flange pl Compensation flange
plate thickness, width
and height.

 

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Bolt edge distances in shim plate

Define the bolt edge distances for shim plates. When these fields are empty,
shim plates are of the same size as the end plate.
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 Description Default
1 Horizontal bolt edge distance in the shim

plate.
30 mm

2 Vertical bolt edge distance in the shim
plate.

30 mm

Shim plate shape

Option Description
Default

Holes are based on the bolt group of
the connection.

AutoDefaults can change this option.

Holes are based on the bolt group of
the connection.

Finger shim plate with horizontal
slots.

The plate can be installed from the
right or the left side of the
connection.

Finger shim plate with vertical slots.

The plate can be installed from the
top of the connection.
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Option Description
Two separate finger shim plates with
horizontal slots.

Two separate finger shim plates with
vertical slots.

Tolerance

Define the tolerance for the slots in finger shim plates. The width of the slot is
the bolt diameter + the tolerance. For two separate shim plates, also define
the tolerance between the plates.

Shim plate position

Option Description
Default

Shim plates are outside the main
part.

AutoDefaults can change this option.
Shim plates are outside the main
part.

Shim plates are inside the main part.

Gap size
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Define the limit value for the gap between the end plate and the secondary
beam. Use this when the beam is slightly curved or sloped to decide if the end
angle is so small that the beam end can be straight.

If the actual gap is smaller than this value, the end of the beam is left straight.

If the actual gap is larger than this value, the end of the beam is fitted to the
end plate.

Safety connections

In two-sided connections the safety connection options improve safety during
erection. Safety connection options move the end plate or create different
notches so that some of the bolts are in single shear instead of double shear.
This allows the first secondary beam to be connected while the crane moves to
get the next beam.

Option Description
Default

End plate with no notches.

AutoDefaults can change this option.

End plate with no notches.

One end plate is moved up to create a
safety connection.

One end plate is moved down to
create a safety connection.

One opposite upper corner of each
end plate is notched to create a safety
connection

One opposite upper corner of each
end plate is notched to create a safety
connection.
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Option Description
Diagonal opposite corners of each
end plate are notched to create a
safety connection.

Diagonal opposite corners of each
end plate are notched to create a
safety connection.

Safety connection location

Option Description
Default

Affects both the near side and the far
side end plates.

AutoDefaults can change this option.
Affects both the near side and the far
side end plates.

Affects only the near side end plate.

Affects only the far side end plate.

Safety connection cut type

Option Description
Default

Square cut. This selection affects only
safety connections that are created
with cuts. It does not affect safety
connections that shorten the plate.

AutoDefaults can change this option.
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Option Description
Square cut

Line cut

Concave arc cut

Safety connection cut dimensions

Option Description
Vertical cut/offset Define the height of the notch or the

vertical offset of the end plate.
Horizontal cut Define the width of the notch in the

end plate.
Radius Define the radius of the concave arc

cut.

Plates 2 tab
Use the Plates 2 tab to control the size of the end plate, shim plates and
compensating flange plates for the second secondary beam.

Plates

Option Description Default
End plate End plate thickness,

width and height.
thickness = 10 mm

Fitting Plate 1

Fitting Plate 2

Fitting Plate 3

Shim plate thickness.

The plate is created only
if the plate thickness is
given.

You can define up to
three different shim
plates.

0
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Option Description Default
Number of fitting pl. 1
(DEF=1)

Number of fitting pl. 2
(DEF=1)

Number of fitting pl. 3
(DEF=1)

Number of shim plates
for each thickness.

By default, 1 plate is
created.

Comp. flange pl Compensation flange
plate thickness, width
and height.

 

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Bolt edge distances in shim plate

Define the bolt edge distances for shim plates. When these fields are empty,
shim plates are of the same size as the end plate.
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 Description Default
1 Horizontal bolt edge distance in the shim

plate.
30 mm

2 Vertical bolt edge distance in the shim
plate.

30 mm

Shim plate shape

Option Description
Default

Holes are based on the bolt group of
the connection.

AutoDefaults can change this option.

Holes are based on the bolt group of
the connection.

Finger shim plate with horizontal
slots.

The plate can be installed from the
right or the left side of the
connection.

Finger shim plate with vertical slots.

The plate can be installed from the
top of the connection.

Two separate finger shim plates with
horizontal slots.

Two separate finger shim plates with
vertical slots.
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Tolerance

Define the tolerance for the slots in finger shim plates. The width of the slot is
the bolt diameter + the tolerance. For two separate shim plates, also define
the tolerance between the plates.

Shim plate position

Option Description
Default

Shim plates are outside the main
part.

AutoDefaults can change this option.
Shim plates are outside the main
part.

Shim plates are inside the main part.

Gap size

Define the limit value for the gap between the end plate and the secondary
beam. Use this when the beam is slightly curved or sloped to decide if the end
angle is so small that the beam end can be straight.

If the actual gap is smaller than this value, the end of the beam is left straight.

If the actual gap is larger than this value, the end of the beam is fitted to the
end plate.

Shim plate and end plate positions

Define the position of the shim plates and the end plate in the second
secondary beam. The plates move in relation to the plates in the first
secondary beam. By default, the plates in the second secondary beam are
positioned so that holes are placed symmetrically. You may need to move the
plates, for example, when connecting skew or curved secondary beams.
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 Description
1 Define how much the plates are moved in vertical direction.
2 Define how much the plates are moved in horizontal direction.

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate, Top plate 2 Top haunch plate thickness, width

and height.
Bottom plate, Bottom plate 2 Bottom haunch plate thickness, width

and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Haunch plate creation

Option for the second
secondary beam

Option for the first
secondary beam

Description

Default

Top and bottom haunch
plates are created, if
needed.

AutoDefaults can change
this option.
Automatic

Top or bottom haunch
plate or both are
created, if needed.

Top and bottom haunch
plates are always
created.

To create a single plate,
enter 0 in the thickness
(t) field for the haunch
plate you do not need
(top or bottom plate).
Haunch plates are not
created.

Haunch plate chamfers
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Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Notch tab
Use the Notch tab to automatically create notches for the secondary beams
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
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Option Description
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.
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Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.
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Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.
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Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions

 Description Default
1 Dimensions for the horizontal

flange cuts.
10 mm

2 Dimensions for the vertical
flange cuts.

The gap between the notch edge
and the beam flange is equal to the
main part web rounding. The notch
height is rounded up to the nearest
5 mm.

BCSA notch definition

Define whether the notch is created according to British Constructional
Steelwork Association (BCSA) specifications.
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Option Description
Default Notch dimensions.
Yes Creates a 50 mm notch for simple beam-to-beam

connections.
No Use the options on this Notch tab to define the notch

dimensions.

Bolts tab
Use the Bolts tab to control the properties of bolts that connect the end plates
to the main part.

Bolt group dimensions

Bolt group dimensions affect the size of the end plates.

 Description
1 Dimension for vertical bolt group position.
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 Description
2 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest bolt.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

Steel components 827 End plate connections and details



 Description
4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Dimension for horizontal bolt group position.
7 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.

• Middle: From the center line of the secondary part to the center line
of the bolts.
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 Description
• Right: From the right edge of the secondary part to the rightmost

bolt.

8 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.

Bolt comment

You can define a bolt comment.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Holes tab
Use the Holes tab to control the galvanizing holes in the end plates.

Option Description
Bolt standard Select the bolt standard.
Bolt type Select the bolt type to define the

location where the bolts should be
attached.

Read data from You can select to use the
sinkholes.dat definition file to
specify the default values for
horizontal and vertical offsets, and
the diameters for upper and lower
holes.

The file is searched in the following
order: Environment common system
steel folder (..\Environments
\common\system\Steel), model
folder, XS_FIRM, XS_PROJECT and 
XS_SYSTEM folder.

You can also select to define the holes
in the component dialog box.

Number of holes

The center of a hole group is the middle point of the beam and the middle
point of the haunch, if the haunch exists. The hole groups are composed of 0,
1, 2 or 4 holes.
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Option for the first
secondary beam

Option for the second
secondary beam

Description

Default

No holes

AutoDefaults can change
this option.

No holes

1 hole

2 holes

4 holes

Hole positions

Hole positions in the end plate of the first secondary beam.
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Hole positions in the end plate of the second secondary beam.

 Description
1 Horizontal distance between the secondary beam center and the

upper hole.
2 Horizontal distance between the secondary beam center and the

lower hole.
3 Vertical distance between the secondary beam center and the

upper hole.
4 Vertical distance between the secondary beam center and the

lower hole.
5 Diameter of the lower hole.
6 Diameter of the upper hole.
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General tab
Click the link below to find out more:

General tab

Design type tab
Click the link below to find out more:

Design type tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:

End plate (144)
End plate (144) connects a beam to a column or two beams to each other
using a bolted end plate. The secondary part can be leveled or sloped.

Objects created

• End plate

• Bent plate

• Shim plates (optional)

• Stiffeners (optional)

• Haunch plates (optional)

• Holes

• Bolts

• Seat angles

• Welds

• Cuts
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Use for

Situation Description
Beam-to-beam end plate connection.

The secondary part can either be leveled or
sloped, or squared or skewed.

There are several notching options.

Beam-to-beam end plate connection.

Extended plate with or without haunch plates.

End plate connection to a column flange or web.

The secondary part can either be leveled or
sloped, or squared or skewed.
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Situation Description
Full depth end plate connection to a column
flange or web.

The secondary part can either be leveled or
sloped, or squared or skewed.

End plate connection to a column web.

Extended plate with haunch plates.

End plate connection to a column flange with
column stiffener.

Column end plate connection.

The secondary part is rotated.
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Selection order

1. Select the main part (column or beam).

2. Select the secondary part (beam).

The connection is created automatically.

Part identification key

 Part
1 End plate
2 Shim plate
3 Stiffener
4 Haunch plate

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Example: Add an end plate using End plate (144)
In this example, you will connect a beam to a column using an end plate
connection. End plate (144) connects two beams, or a beam to a column,
using a bolted end plate.

1. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

2. Type 144 in the search box.

3. Double-click End plate (144) to open the component properties.

4. Click Apply to add the component using the default properties.

5. Select the main part (column).

6. Select the secondary part (beam). 
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Tekla Structures automatically adds the connection when you select the
beam.

Picture tab
Use the Picture tab to control the position of the end plate.

End plate position

 Description Default
1 End plate upper edge distance from the top

of the secondary beam.

A positive value moves the top position
closer to the beam center and thus
decreases the plate size. Negative values
increase the plate size.

10 mm

2 End plate lower edge distance from the
bottom of the secondary beam.
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 Description Default
3 Gap between the shim plate and the main

part.

If the shim plate is not used, the defined
gap is created between the end plate and
the main part.

0

Plates tab
Use the Plates tab to control the size of the end plate, bent plate, and shim
plates.

Plates

Option Description Default
End plate End plate thickness, width and

height.

The width and height are
defined by the bolt group
edge distances.

thickness = 10 mm

Folded Plate Bent plate thickness, width
and height.

The plate is created only if the
plate thickness is given.

thickness = 0
width = bolt
horizontal spacing
value - (1.5*the
bolt diameter)
height = 200 mm

Fitting plate 1, 2,
3

Shim plate thickness.

The plate is created only if the
plate thickness is given.

You can define up to three
different shim plates.

0

Number of fitting
plates

Number of shim plates for
each thickness.

By default, 1 plate is
created.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Material Material grade. The default material is

defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Bent shim plate length

Define the horizontal length of the bent shim plate. The default is 10*bent
plate thickness.

Shim plate position

Option Description
Default

Shim plates are created outside the
main part.

AutoDefaults can change this option.

Shim plates are created outside the
main part.

Shim plates are created inside the
main part.
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Shim plate shape

Option Description
Default

Holes are based on the bolt group of
the connection.

AutoDefaults can change this option.

Holes are based on the bolt group of
the connection.

Finger shim plate with horizontal
slots.

The plate can be installed from the
right or the left side of the
connection.

Finger shim plate with vertical slots.

The plate can be installed from the
top of the connection.

Two separate finger shim plates with
horizontal slots.

Two separate finger shim plates with
vertical slots.

Tolerance

Define the tolerance for the slots in finger shim plates. The width of the slot is
the bolt diameter + the tolerance. For two separate shim plates, also define
the tolerance between the plates.
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Bolt edge distances in shim plate

Define the bolt edge distances for shim plates. When these fields are empty,
shim plates are of the same size as the end plate.

 Description Default
1 Horizontal bolt edge distance in the shim

plate.
30 mm

2 Vertical bolt edge distance in the shim plate. 30 mm

Gap size

Define the limit value for the gap between the end plate and the secondary
beam. Use this when the beam is slightly curved or sloped to decide if the end
angle is so small that the beam end can be straight.

If the actual gap is smaller than this value, the end of the beam is left straight.

If the actual gap is larger than this value, the end of the beam is fitted to the
end plate.

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position, and type.

Stiffener plate dimensions

Option Description
Top NS Top near side stiffener thickness,

width and height.
Top FS Top far side stiffener thickness, width

and height.
Bottom NS Bottom near side stiffener thickness,

width and height.
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Option Description
Bottom FS Bottom far side stiffener thickness,

width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.
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Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.

Stiffeners are created.

Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.

Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding
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Option Description
Line chamfered stiffener plates

Stiffener positions

 Description
1 Size of the gap between the stiffener and the beam web edge.
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
5 Size of the gap between the top far side stiffener and the beam flange

edge.

Chamfer dimensions

 Description Default
1 Vertical dimension of the

chamfer.
10 mm
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 Description Default
2 Horizontal dimension of the

chamfer.
10 mm

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.
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Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.
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Option Description
Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).

Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.
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Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.
The notch size is measured from the edge of the
main beam flange and from the outer edge of the
top flange of the main beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.
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Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.
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Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
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Option Description
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions
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 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

BCSA notch definition

Define whether the notch is created according to British Constructional
Steelwork Association (BCSA) specifications.

Option Description
Default Notch dimensions.
Yes Creates a 50 mm notch for simple beam-to-beam

connections.
No Use the options on this Notch tab to define the notch

dimensions.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the end
plate to the main part.

Bolt group dimensions

Bolt group dimensions affect the size of the end plate.

 Description
1 Dimension for horizontal bolt group position.
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 Description
2 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost
bolt.

• Middle: From the center line of the secondary part to the center
line of the bolts.
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 Description
• Right: From the right edge of the secondary part to the rightmost

bolt.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Dimension for vertical bolt group position.
7 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

8 Distance from the bottom of the beam to the lowest bolt.
9 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from
top to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.
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Option Description Default
Thread in mat Defines whether the

thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.

Bolt comment

You can define a bolt comment.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
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Option Description Default
depend on the component in
question.

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Bolting direction 2

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
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Option Description
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Holes tab
Use the Holes tab to control the galvanizing holes in the end plate.

Option Description
Bolt standard Select the bolt standard.
Bolt type Select the bolt type to define the

location where the bolts should be
attached.

Read data from You can select to use the
sinkholes.dat definition file to
specify the default values for
horizontal and vertical offsets, and
the diameters for upper and lower
holes.

The file is searched in the following
order: Environment common system
steel folder (..\Environments
\common\system\Steel), model
folder, XS_FIRM, XS_PROJECT and 
XS_SYSTEM folder.

You can also select to define the holes
in the component dialog box.

Number of holes

The center of a hole group is the middle point of the beam and the middle
point of the haunch, if the haunch exists. The hole groups are composed of 0,
1, 2 or 4 holes.
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Option Description
Default

No holes

AutoDefaults can change this option.

No holes

1 hole

2 holes
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Option Description
4 holes

Hole positions

 Description
1 Horizontal distance between the secondary beam center and the

upper hole.
2 Horizontal distance between the secondary beam center and the

lower hole.
3 Vertical distance between the secondary beam center and the

upper hole.
4 Vertical distance between the secondary beam center and the

lower hole.
5 Diameter of the lower hole.
6 Diameter of the upper hole.

Angle box tab
Use the Angle box tab to add a seat angle. The purpose of seat angles is to
carry loads from the secondary beam.
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Seat angle

Option Description
Top angle, Bottom angle Seat angle thickness, width and

height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Seat angle position

Seat angles can be located on the top, bottom or both flanges of the
secondary part.

Option Description
Default

No seat angle is created.

AutoDefaults can change this option.

Steel components 863 End plate connections and details



Option Description
No seat angle is created.

A seat angle is created at the top of
the flange of the beam.

A seat angle is created at the bottom
of the flange of the beam.

Seat angles are created on both sides
of the flange of the beam.
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Seat angle orientation

Option Description
Default

The longer leg of the seat angle is
connected to the secondary beam.

AutoDefaults can change this option.

The longer leg of the seat angle is
connected to the secondary beam.

The longer leg of the seat angle is
connected to the main part.

Automatic

The longer leg of the seat angle is
connected to the part where bolts
reach furthest from the angle seat
corner.

General tab
Click the link below to find out more:

General tab
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Design type tab
Click the link below to find out more:

Design type tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:

End plate detail (1002)
End plate detail (1002) creates an end plate that is welded to a beam end.

Objects created

• End plate

Use for

Situation Description
End plate at a beam end.

Selection order

1. Select the main part (beam).
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2. Pick a position.

The detail is created automatically when the point is picked.

Picture tab
Use the Picture tab to control the end plate distances from the beam edges.

Positive values move the end plate closer to the beam axis and thus decrease
the plate size. Negative values increase the plate size.

The default distances from the upper and the lower edge are 10 mm.

The default distances from the right and the left edge are 0mm.

For rectangular tube profiles all the distances are 3 mm by default.

Parts tab
Use the Parts tab to control the end plate properties.

Option Description
End plate Define the end plate thickness, width and height.

By default, the thickness is 1.5*beam web thickness
rounded up to the next plate thickness.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Material Material grade. The default material is

defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Angle cut (1057)
Angle cut (1057) creates fittings at the end of a profile that is of the angle
type. The fittings are created at the end that is closer to the picked point. Two
types of fittings are possible: one that chamfers the angle, or one that creates
a polygon cut. The type is automatically decided according to the properties on
the Parameters tab.

Objects created

• Fittings
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Use for

Situation Description
Fittings at the end of a profile.

Selection order

1. Select the main part (angle profile).

2. Pick a position.

The detail is created automatically when the point is picked.

Picture tab
The Picture tab shows the angle cut.

Parameters tab
Use the Parameters tab to define the fitting properties.
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 Description Default
1 Height of the flange cut.

Defines the height of the cut. If the distance
between the reference point and the profile end
is so short that height of the cut cannot be
achieved, then the profile is chamfered only.

The default
value is half of
the distance of
the shorter
edge.

2 Angle of the flange cut. 0 degrees
3 Offset distance for the flange.

Defines the distance between the reference point
and the start edge of the cut. It can have negative
values as well.

0 mm

Select how the flange is cut. The options are to have a cut on both flanges, or
to select which flange to cut.
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Cast-in plate (1069)
Cast-in plate (1069) creates a cast plate at the selected end of a beam. Studs,
bolts, bent anchor bolts, or nail holes can be added to the plate.

Objects created

• Cast-in plate

• Shear tab

• Clip angle

• Bolts

• Studs

• Anchors

• Washer plates

• Welds
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Use for

Situation Description
Bolted clip angle at the near and far
side of the beam. The clip angle is
anchored to the concrete using bent
anchor bolts.
Anchoring with four studs.

Shear tab is bolted to a skewed beam.

Selection order

1. Select the main part (beam).

2. Pick a position near the end of the beam.

Note that the point you pick determines from which end of the beam the
plate will be positioned, it does not locate the plate itself.

The connection is created automatically when you pick the position.

Part identification key

 Description
1 Cast-in plate
2 Clip angle or shear tab

Picture tab
Use the Picture tab to define the connection type and dimensions.

Beam connection type

Option Description
Clip angle profile is used to connect
the beam and the cast-in plate.
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Option Description
Shear tab is used to connect the
beam and the cast-in plate.

Dimensions

 Description Default
1 Edge distance from the beam end to the shear tab or

clip angle profile end.
1-2"

2 Edge distance from the beam top to the clip angle
profile top.

This option is only valid for clip angle profiles, not for
shear tabs.

1-3/4"

3 Distance between the cast-in plate and the shear tab
or clip angle profile.

0

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.
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Cast-in plate alignment

Option Description
Default

Cast-in plate is aligned and created on
the beam plane.

AutoDefaults can change this option.
Cast-in plate is aligned and created on
the beam plane.
Cast-in plate is created in the global
coordinate system.

Cast-in plate offset

Option Description
Cast-in plate height offset, measured
in the plane of the plate.

Cast-in plate out-of-plane offset,
measured in the plane of the plate.

Cast-in plate rotation

Option Description
Cast-in plate rotation in degrees,
measured in the plane of the plate.

Cast-in plate out-of-plane rotation, in
degrees, measured in the plane of the
plate.

Parts tab
Use the Parts tab to define the part properties.
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Parts

Option Description
Cast-in plate Thickness, width, and height of the

cast-in plate.
Profile NS Select the profile from the profile

catalog.
Profile FS Select the profile from the profile

catalog.
Tab plate Thickness, width, and height of the

shear tab.
Plate washer Thickness, width, and height of the

washer plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Gap between clip angles

 Description
1 Gap between the secondary part web and clip angles.

This only affects connections with two clip angles.
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Clip angle position

Option Description
Default

One near side clip angle or shear tab
is created.

AutoDefaults can change this option.
Automatic

One near side clip angle or shear tab
is created.
Far side

One far side clip angle or shear tab is
created.
Both sides

Two clip angles or shear tabs are
created on the near and far side.
Near side

One near side clip angle or shear tab
is created.

Clip angle leg direction

Far side Near side Description
Default

Not switched

The long leg of the clip
angle is connected to the
secondary part.

AutoDefaults can change
this option.
Not switched

The long leg of the clip
angle is connected to the
secondary part.
Switched

The long leg of the clip
angle is connected to the
cast plate.

Plate washer

Define plate washers for bolts and select the plate washer side.
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Option Description
Default

No plate washer

AutoDefaults can change this option.

No plate washer

One plate washer

Individual square plate washers for
each bolt

Individual round plate washers for
each bolt

Option Description
Select whether the plate washer is
created for one shear tab or both
shear tabs.
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Studs/Anchors tab
Use the Studs/Anchors tab to define whether studs or anchors are created,
and their properties.

Properties

Option Description
Stud size Diameter of the stud.
Stud standard Name of the stud.
Stud length Length of the stud.
Site / Workshop Location where the bolts should be

attached.
Std/Anc Select whether to create studs,

anchors, or none of these.
Stud/Anc profile Select the profile from the profile

catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Bolt group dimensions

 Description
1 Vertical bolt group dimension from the center line of the plate.
2 Horizontal bolt group dimension from the center line of the

plate.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

6 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate
the numbers with a space. Bolt numbers run from left to right
and from top to bottom.

Anchor bend direction

Option Description
Default

Anchors are bent in.

AutoDefaults can change this option.
Anchors are bent in.

Anchors are bent out.

Anchors are not bent. Studs are
created.
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Bent anchor bolt length

 Description Default
1 Radius of the bend. 3/8"
2 Bent anchor bolt length. 4"
3 Hook length. 1-1/2"

Stud length

 Description Default
1 Define the stud length. 4"

Nail holes tab
Use the Nail holes tab to define the nail hole locations and dimensions.

Nail hole locations

Option Description
Default

No nail holes.

AutoDefaults can change this option.
No nail holes.

Creates nail holes in the upper right
and lower left corners of the plate.

Creates nail holes in the upper left
and lower right corners of the plate.

Creates nail holes in all four corners of
the plate.
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Nail hole dimensions

 Description
1 Nail hole edge distance.
2 Nail hole diameter.

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

5 Dimension for vertical bolt group position.
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 Description
6 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line of
the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.
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 Description
7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate
the numbers with a space. Bolt numbers run from left to right
and from top to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered
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Option Description
Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

General tab

Click the link below to find out more:

General tab

Design type tab

Click the link below to find out more:
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

2.5 Splice connections
This section introduces Tekla Structures splice connection components.

• Column splice (42) (page 886)

• Box girder splice (45) (page 897)

• Diagonal splice (53) (page 903)

• Splice connection (77) (page 911)

• Column splice (132) (page 930)

Column splice (42)
Colunm splice (42) connects two columns (or beams) using splice plates
bolted to the flanges and webs of both parts. Shim plates are also created
when the dimensions of the columns differ.

Objects created

• Web plates

• Flange plates

• Shim plates (optional)

• Bolts

Steel components 886 Splice connections



Use for

Situation Description
Splice plates bolted to the flanges and
webs of both parts.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (beam or column).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Web plate
2 Flange plate
3 Shim plate

Picture tab
Use the Picture tab to define the plate positions.
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Dimensions

 Description Default
1 Gap between the main part and the

secondary part.
0 mm

2 Shim plate thickness 10 mm
3 Web plate dimensions on the main part

and the secondary part.
 

Part tab
Use the Parts tab to define the properties of the plates.

Plates

Option Description
Web plates Thickness, width and height of the

web plates.
Flange plates Thickness, width and height of the

flange plates.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Parameters tab
Use the Parameters tab to define the lifting hole creation, dimensions, and
web plate creation.

Lifting hole creation

Option Description
Default

Lifting hole is not created.

AutoDefaults can change this option.

Lifting hole is not created.
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Option Description
Lifting hole is created.

Lifting hole dimensions

 Description
1 Diameter of the lifting hole.
2 Horizontal dimension for the lifting hole offset from the web

plate center line.
3 Vertical dimension from the lifting hole center to the part

edge.

Web plates

Option Description
Default

Both web plates are created.

AutoDefaults can change this option.
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Option Description
Both web plates are created.

Right side web plate is created.

Left side web plate is created.

Web bolts tab
Use the Web bolts tab to define the bolt group dimensions and bolt
properties.

Bolt group dimensions

 Description
1 Number of bolts.
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 Description
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Select the bolt type.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered
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Option Description
Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Flange bolts tab
Use the Flange bolts tab to define the bolt group dimensions and bolt
properties.

Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
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Option Description Default
depend on the component in
question.

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4
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General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Box girder splice (45)
Box girder splice (45) connects two box profiles using fastener plates that are
bolted to the secondary part and welded to the main part.

Objects created

• Fastener plates

• Stiffener

• Bolts

• Welds

Use for

Situation Description
Two box profiles connected with
fastener plates

Selection order

1. Select the main part.

2. Select the secondary part.

The connection is created automatically when you select the secondary
part.
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Part identification key

 Description
1 Fastener plate
2 Stiffener

Picture tab
Use the Picture tab to define the plate positions.

Dimensions

 Description Default
1 Distance between the fastener plates and main part

edge
60 mm

2 Distance between the stiffener and the fastener
plates

100 mm

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
Fastener plates Thickness of the

fastener plates
 

Stiffener Thickness of the
stiffener

5 mm
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Flange blt tab
Use the Flange blt tab to define the bolt group dimensions and flange bolt
properties.

Dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes
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Option Description Default
Site/Workshop Location where the bolts

should be attached.
Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.
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Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Web bolts tab
Use the Web bolts tab to define the bolt group dimensions and web bolt
properties.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
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 Description
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Site/Workshop Location where the bolts
should be attached.

Site

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4
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General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Diagonal splice (53)
Diagonal splice (53) connects two beams to a column using connection plates
bolted to the column and beam flanges.

Objects created

• Connection plates

• Bolts

Use for

Situation Description
Beams are connected to a column
with bolted connection plates.

Selection order

1. Select the main part (column).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.
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Part identification key

 Description
1 Connection plate

Picture tab
Use the Picture tab to define the geometry of the connection.

Dimensions
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 Description Default
1 Define a vertex to the connection plate at the

lowermost and uppermost intersection point of
the column edge and the plate upper or lower
edge.

0
Rectangular plate
is created.

2 Define the distance to the first selected and
second selected secondary part from the
column center line to the secondary part end.

If the beams are
perpendicular to
the column, the
default value for
this distance is
equal to the
column flange
width.

Otherwise, the
default distance
is calculated so
that the beam
does not collide
with the column.

3 Define the plate tolerance.

You can use this dimension to increase the
plate width.

10 mm

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description
Create as Select whether to create a connection

plate or a profile.
Plate Thickness of the connection plate.
Profile Select the profile from the profile

catalog.
Spacer plate Thickness, width, and height of the

spacer plate.

If the main part profile is higher than
the profile of the diagonal parts,
spacer plates can be created between
the connection plate and the diagonal
parts to fill the empty space. To do
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Option Description
this, the diagonal parts should be
centrally connected to the main part.

By default, the thickness of the plate
is equal to the width of the gap
between the connection plate and the
secondary beam. If the thickness is
defined, the component creates as
many plates as can be fitted in the
gap.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the connection plate positions.

Twin profiles

If you are using twin profiles as secondary parts, select Yes in this option.

When selecting the secondary parts to this connection, select the outer part of
the twin profiles.

Plate position

Option Description
Default

Plates are created on both sides.

AutoDefaults can change this option.
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Option Description
Plate is created on the left side.

Plates are created on both sides.

Plate is created on the right side.

Plates are created on both sides.

Long bolts go through the column
and beam flanges.

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.
3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

5 Bolt group offset from the connection plate center line.
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 Description
6 Dimension for vertical bolt group position.

Bolt group alignment

Option Description
Default

Bolts are not staggered.

AutoDefaults can change this option.
Bolts are not staggered.

Bolts are staggered and aligned with
the secondary part.
Bolts are staggered and aligned with
the main part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Bolting direction 2

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab
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Analysis tab

Click the link below to find out more:

Analysis tab

Splice connection (77)
Splice connection (77) creates a splice between two beams or columns. The
splice can be bolted or welded, or bolted and welded. This connection also
works with rotated and skewed beams, but only with I-shaped cross-sections.

Objects created

• Flange plates

• Web plates

• Deck plates

• Bolts

• Welds

Use for

Situation Description
Plates are bolted.

Plates are welded.

Plates are bolted and welded.
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Selection order

1. Select the main part.

2. Select the secondary part.

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Flange plates
2 Web plates

Picture tab
Use the Picture tab to define the gap between the main and secondary beam,
and the gap type.

Gap dimension

 Description Default
1 Gap between the main part and secondary part. 5 mm or ¼”
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Gap type

Option Description
Default

Center fit

By default, both parts are cut equally (1/2 *
entered gap).

AutoDefaults can change this option.
Center fit

The main part and secondary parts are cut
equally (1/2 * entered gap), and placed
centrally.
Offset fit

Only the secondary part is cut.

Offset fit

Only the main part is cut.

Parts tab
Use the Parts tab to define the properties of flange plates and spacers.

Flange plates

Option Description
Top ext flange pl

Top int flange pl

Btm ext flange pl

Top int flange pl

Flange plate thickness, width, and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Create web connection as

Option Description
Plates Plate thickness, width, and height.
Profiles Select the profile from the profile

catalog.

Spacers

The flange and web spacers are used when the main and secondary beam
flange or web thicknesses differ.

Option Description
Flange spacers

Top

Bottom

Flange spacer thickness.

Create external flange spacers Select whether external flange
spacers are created.

Web spacers Web spacer thickness.

Parameters tab
Use the Parameters tab to define the location and diameter of the lifting hole,
the type of bolts, and loose part and splice plate assembly.

Bolts and assemblies

Option Description
Workshop bolts • None - All bolts are attached at

the building site.

• Primary member - The bolts in
the main part are attached at the
workshop, and the bolts in the
secondary part are attached at the
building site.
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Option Description
• Secondary member - The bolts in

the secondary part are attached at
the workshop, and the bolts in the
main part are site bolts.

Loose parts assembly • Primary member - Creates a
loose assembly between the
spacers and the main part.

• Secondary member - Creates a
loose assembly between the
spacers and the secondary part.

• Both - Creates a loose assembly
between the spacers and the main
part as well as between the
spacers and the secondary part.

Splice plate assembly • None - No assembly is created
either between the splice plates or
the main and secondary beams.
This is the default value.

• Primary member - Creates an
assembly between the splice
plates and the main beam.

• Secondary member - Creates an
assembly between the splice
plates and the secondary beam.

• Both - Creates an assembly
between the splice plates and
both the main and secondary
beams.

Note that the assembly is created by
welding the splice plates to the
appropriate beams.

Lifting hole creation

Select to which part the lifting hole is created: plates, beam, or to both the
plates and the beam.

Option Description
Default

Lifting hole is not created.

AutoDefaults can change this option.
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Option Description
Lifting hole is not created.

Lifting hole is created in the secondary part
side.

Lifting hole is created in the main part side.

Lifting hole dimensions

 Option
1 Define the diameter of the lifting hole.
2 Define the vertical location of the lifting hole from the center

line of the web.
3 Define the horizontal location of the lifting hole from the end

of the secondary beam.

Web plate creation

Option Description
Default

Both web plates are created.

AutoDefaults can change this option.
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Option Description
Both web plates are created.

Web plate is created on the front side.

Web plate is created on the back side.

Attach flange plates to main and secondary parts

Option Option Description
Default

Flange plates are bolted
to the main and
secondary parts.

AutoDefaults can change
this option.

Flange plates are bolted
to the main and
secondary parts.

Flange plates are welded
to the main and
secondary parts.
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Option Option Description

Attach web plates to main and secondary parts

Option Option Description
Default

Web plates are bolted to
the main and secondary
parts.

AutoDefaults can change
this option.

Web plates are bolted to
the main and secondary
parts.

Web plates are welded/
bolted to the main and
secondary parts.

Web bolts tab
Use the Web bolts tab to define the web bolt properties.
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Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Use a space to separate bolt spacing values. Enter a value for

each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Staggering of bolts

Option Description
Select the appropriate staggering
option.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
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Option Description Default
depend on the component in
question.

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Bolting direction 2

Top flange bolts / Bottom flange bolts tab
Use the Top flange bolts and Botton flange bolts tabs to define the flange
bolt properties. On the Bottom flange bolts tab, you can select to use the top
flange bolt default settings for the bottom bolts.
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Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt offset

 Description
1 Define the bolt offset from the center line of the flange plate.
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Staggering of bolts

Top flange bolts Bottom flange bolts Description
Select the appropriate
staggering option.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.
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Option Description Default
Tolerance Gap between the bolt

and the hole.
 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Weld prep tab
Use the Weld prep tab to control weld backing bars and weld access holes.
The weld backing bar is used behind the welds connecting the beam flanges.

Before you start

1. Set the thickness of flange plates to zero on the Parts tab. Flange welds
and weld preparations are only created if the flange plates do not exist.

2. Click the Weld button and enter the correct weld size, type, angle, and
other properties. Otherwise weld preparations are not created. Note that
weld preparations are not created for all weld types.

Backing bar

Option Description
Backing bar Backing bar thickness and width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Weld access hole dimension

 Description
1 Define the weld access hole radius in the main part.
2 Define the weld access hole radius in the secondary part.
3 Define the weld backing bar offset in the direction of the

secondary beam.

Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole

 

Round weld access hole
with a radius that you
can define in
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Option Description Default
Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10

Weld preps for flanges

Select whether the main or secondary part flange is beveled.

Weld preps for web

Select whether the main or secondary part web is beveled.

Include backing bar

Select whether the backing plate is welded to the main part, secondary part,
none, or both.

Backing bar location

Select the backing bar location in relation to the flange.

Option Description
Auto Places the backing bars down for beams (In-

Out) and inside (In-In) for columns.
In-In Places both backing bars to the inner side of

flanges.
In-Out Places the top backing bars to the inner side

of the top flange and the bottom back bar to
the outer side of the bottom flange.
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Weld backing bar length

Enter the length of the weld backing bar in the box below the options.

Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange

Deck plates tab
Use the Deck plates tab to define whether deck plates are created.

Part

Option Description
Deck supports Deck plate thickness and width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Deck plate dimensions

  
1 Define the deck plate edge distance from the main part edge.
2 Define the deck plate dimension from the web plate edge.

Deck plate creation

Option Description
Default

Deck plates are not created.

AutoDefaults can change this option.
Deck plates are not created.

Deck plates are created on both sides.

Deck plates are created on the front side.

Deck plates are created on the back side.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Column splice (132)
Column splice (132) creates a splice connection between two columns.

You can create the following splice connection types:

• Two outer flange plates with two web plates

• Four inner flange plates with two web plates

• Division plate with two outer flange plates and four web cleats

• Two outer flange plates, four inner flange plates, and two web plates

Objects created

• Web plate

• Flange plates

• Division plate

• Angle profile

• Web and flange shim plates

• Bolts

• Welds

Use for

Situation Desciption
Two columns connected with web
and flange plates.

Limitations

The columns must have a common center line or coinciding faces.
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Selection order

1. Select the main part.

2. Select the secondary part.

The connection is created automatically when you select the secondary
part.

Part identification key

 Description
1 Web plate
2 Flange plate
3 Shim plate
4 Division plate

Picture tab
Use the Picture tab to define the bolting direction of the flange plates and to
select whether the plates are bolted or welded.

Flange plate bolting

Select the bolting direction, or select to weld the plates to both the main part
and the secondary part.
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Option Option Option Option

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
Web plate Thickness, width and

height of the web plate.
 

Ext flange plates Thickness, width and
height of the outer flange
plates.

 

Int flange plates Thickness, width and
height of the inner flange
plates.
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Option Description Default
Division plate Thickness, width and

height of the division
plate.

The default thickness
is 25 mm.

Angle profile Select the angle profile
from the profile catalog.

 

Flange spacers Thickness of the flange
shim plates.

 

Web spacers Thickness of the web shim
plates.

The default is 2 mm.

If you enter a
thickness, the largest
number of plates of
that thickness which fit
in the gap will be
created.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Parameters tab
Use the Parameters tab to define the flange plate and web plate edge cut
type, tolerance between the columns, and angle profile and web plate
creation.
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Tolerance between columns

Option Description
Default

No gap between the columns.
Division plate is used.

AutoDefaults can change this option.

Automatic

No gap between the columns.
Division plate is used.

Define the gap between the columns.
Outer flange plate is created on one
side.

Define the gap between the columns.
Inner flange plates are created.

No gap between the columns.
Division plate is used.

Define the gap between the columns.
Outer and inner flange plates are
created.

Angle profile attachment

Opton Option Description
Default

Angle profile is bolted.

AutoDefaults can change
this option.

Steel components 934 Splice connections



Opton Option Description
Angle profile is bolted.

Angle profile is bolted
and welded.

Angle profile is bolted
and welded.

Angle profile is welded.

Web plate

Select how the web plate is created. The options depend on whether a division
plate or a gap is created between the columns.
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Option Option

Flange blt tab
Use the Flange blt tab to define the bolt group dimensions and bolt
properties of flange bolts.
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Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Number of bolts.
Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Workshop bolts

Select to which part the workshop bolts are attached.

• None: All bolts are site assembly.

• Primary member: Any bolts going to the main part are workshop bolts.

• Secondary member: Any bolts going to the secondary part are workshop
bolts.

Staggering

Select an appropriate staggering option.

Option
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Option

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Web bolts tab
Use the Web bolts tab to define the bolt group dimensions and bolt
properties of web bolts.

Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Number of bolts.
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 Description
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Workshop bolts

Select to which part the workshop bolts are attached.

• None: All bolts are site assembly.

• Primary member: Any bolts going to the main part are workshop bolts.

• Secondary member: Any bolts going to the secondary part are workshop
bolts.

Angle bolts

Select where the angle bolts are attached: site or workshop.

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

General tab

Click the link below to find out more:

Design tab

Click the link below to find out more:

If a division plate is used, the bearing is always Yes. The bearing is set to No
only if the tolerance between the parts is > 0 mm.
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Analysis tab

Click the link below to find out more:

Welds

Click the link below to find out more:

2.6 Joist connections
This section introduces Tekla Structures joist connection components.

• Joist to beam, type 1 (160) (page 942)

• Joist to column, type 1 (161) (page 951)

• 2-Sided joist to column (162) (page 966)

• Joist to column, type 2 (163) (page 982)

• Joist to beam and column (164) (page 1001)

Joist to beam, type 1 (160)
Joist to beam, type 1 (160) creates a bolted connection between a beam and
a joist. You can define the seat angle size and bolt locations.

Objects created

• Stabilizer plate

• Bearing plate

• Bolts

• Welds

Use for

Situation Description
Joist connected to a beam. Stabilizer
plate is created at the bottom.
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Selection order

1. Select the main part (beam).

2. Select the secondary part (joist).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Stabilizer plate

Picture tab
Use the Picture tab to define the connection dimensions.

Dimensions

 Description Default
1 Top cord offset from the main part center line  
2 Top cord notch dimension to the main part part edge  
3 Main part offset from the top cord inner edge  
4 Cutback distance from the bottom cord edge to the

main part center line
1/2 width
of the
main part
flange +
1"
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Stabilizer tab
Use the Stabilizer tab to define the stabilizer properties and position.

Parts

Option Description
Plate Thickness, width, and height of the

stabilizer plate

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Stabilizer creation

Option Decription
Default

Stabilizer is not created.

AutoDefaults can change this option.

Stabilizer is not created.

Stabilizer is created at the main part
flange.
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Option Decription
Stabilizer is created at the main part
web.

Define the chamfer dimensions of the
stabilizer plate.

Chamfer dimensions

 Description
1 Vertical chamfer dimension
2 Horizontal chamfer dimension
3 Chamfer radius

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer
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Option Description
Concave arc chamfer

Stabilizer notch direction

Option Description
Default

Notch direction upwards

AutoDefaults can change this option.

Notch direction upwards

Notch direction downwards

Dimensions

The stabilizer is created at the main part flange.

 Description Default
1 Vertical dimension to the hole center

The dimension is measured in the plane of the
stabilizer plate.

1.5 x hole
diameter

2 Stabilizer offset from the main part center line

The dimension is measured along the center line of
the stabilizer plate.

½"

3 Overlap length of the bottom cord on the stabilizer
plate

3"
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 Description Default
4 Diameter of the hole for cables 13/16"
5 Vertical offset of the stabilizer plate from the

bottom cord of the joist
3"

6 Horizontal dimension to the hole center

The dimension is measured in the plane of the
stabilizer plate.

1.5 x hole
diameter

Dimensions

The stabilizer is created at the main part web.

 Description
1 Vertical edge dimension from the stabilizer plate to the main

part flange
2 Vertical dimension to the hole center
3 Overlap length of the bottom cord on the stabilizer plate
4 Diameter of the hole for cables
5 Vertical offset of the stabilizer plate from the bottom cord of the

joist
6 Horizontal dimension to the hole center
7 Horizontal edge dimension from the stabilizer notch to the main

part edge

Bearing plate tab
Use the Bearing plate tab to define the bearing plate properties.

Parts

Option Description
Bearing plate Thickness and width of the bearing

plate
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Bolts tab
Use the Bolts tab to define the bolt properties and the position of the bolts.

Dimensions

 Description
1 Distance from the center line of the main part to the center line

of the bolts
2 Bolt spacing
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Bolt orientation

Option Description
Default

Bolts are placed square to the main
part.

AutoDefaults can change this option.
Bolts are placed square to the main
part.

Bolts are placed square to the joist.

Bolt creation

Option Description
Default

Secondary part is bolted to the main
part.

AutoDefaults can change this option.
Secondary part is bolted to the main
part.

Secondary part is welded to the main
part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.
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Option Description Default
Thread in mat Defines whether the

thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Joist to column, type 1 (161)
Joist to column, type 1 (161) creates a bolted connection between a column
and a joist, and includes seat angles, cap plate, and stabilizer, either as bolted
or welded connections.

Steel components 951 Joist connections



Objects created

• Cap plate

• Bearing plate

• Seat angle

• Stabilizer plate

• Bolts

• Welds

Use for

Situation Description
Joist connected to a column. Cap
plate is bolted to the joist. Stabilizer
plate is created and bolted to the
joist.

Selection order

1. Select the main part (column).

2. Select the secondary part (joist).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Cap plate
2 Bearing plate

Picture tab
Use the Picture tab to define the connection dimensions.
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Dimensions

 Description Default
1 Top cord offset from the main part center line 0
2 Vertical dimension from the top of the cap plate to

the top of the joist
2-1/2"

3 Cutback distance of the bottom cord from the main
part flange

1"

Bolts tab
Use the Bolts tab to define the bolt properties and the position of bolts.

Dimensions

 Description Default
1 Distance from the main part center line to

the center line of the bolt
I-profile columns: 1/2
the thickness of the
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 Description Default
main part web + 1-1/2
times the bolt
diameter

Tube steel columns:
1/2 the width or
length of the column
(depending on
orientation) + 1-1/2 "

2 Bolt spacing 4"

Bolt creation

Option Description
Default

Joist is bolted to the main part.

AutoDefaults can change this option.

Joist is bolted to the main part.

Joist is welded to the main part.

Bolt orientation

Option Description
Default

Creates the bolts square to the joist.

AutoDefaults can change this option.
Creates the bolts square to the cap
plate.

Creates the bolts square to the joist.
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Option Description
Default

Bolts are placed square to the main
part.

AutoDefaults can change this option.
Bolts are placed square to the main
part.

Bolts are placed square to the joist.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Plate tab
Use the Plate tab to define the cap plate properties and dimensions.
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Parts

 Description Default
Plate Thickness, width, and height of the cap plate Thickness: ¼”

By default, the
plate is square
and both sides
of the plate
are equal
(plate side =
(largest value
for column
width or
column height)
+ 2 X 3”), so
the default
plate is ¼” X
plate side X
plate side.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Cap plate offset
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 Description
1 Horizontal offset from the main part
2 Vertical offset from the main part

Cap plate dimensions

Define the width and length of the cap plate.

 Description
1 Horizontal offset from the main part edge
2 Vertical offset from the main part edge

Cap plate orientation

Option Description
Default

Cap plate orientation matches the
skewed joist.

AutoDefaults can change this option.
Cap plate orientation matches the
skewed joist.

Cap plate is square to the main part.
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Cap plate slope

Option Description
Default

Cap plate is aligned with the sloping
joist.

AutoDefaults can change this option.
Cap plate is aligned with the sloping
joist.
Cap plate is placed flat at the top of
the main part.

Bearing plate tab
Use the Bearing plate tab to define the bearing plate properties, dimensions,
and the connection method.

Parts

Option Description
Bearing plate Thickness and width of the bearing

plate

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Dimensions

 Description
1 Bearing plate edge dimension from the stabilizer plate edge
2 Bearing plate edge dimension from the main part flange

Stabilizer tab
Use the Stabilizer tab to define the stabilizer creation, properties, and
position.

Parts

Option Description
Plate Thickness, width, and height of the

plate
Angle Select the profile from the profile

catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Stabilizer creation

Option Description
Default

Stabilizer is not created.

AutoDefaults can change this option.
Stabilizer is not created.

Stabilizer is created as a plate.

Stabilizer is created as a seat angle.

Stabilizer plate dimensions

 Description Default
1 Cable hole diameter 13/16"
2 Horizontal dimension from the edge of the

stabilizer plate to the center of the hole
1.5 X hole
diameter

3 Vertical dimension from the edge of the stabilizer
plate to the center of the hole

1.5 X hole
diameter

4 Vertical dimension from the lower chord of the
joist to the bottom of the stabilizer plate

3"

Stabilizer connection type

Option Description
Default

No connection between the stabilizer
plate and the joist

AutoDefaults can change this option.
No connection between the stabilizer
plate and the joist
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Option Description
Stabilizer plate is welded to the joist.

Stabilizer plate is bolted to the joist.

Stablizer plate is bolted and welded to
the joist.

Stabilizer orientation

Option Description
Default

Stabilizer plate is aligned with the
sloping joist.

AutoDefaults can change this option.
Stabilizer plate is aligned with the
sloping joist.
Stabilizer plate is created square to
the main part.

Seat angle dimensions

 Description
1 Horizontal offset of the seat angle
2 Vertical offset of the seat angle

 Description Default
1 Horizontal offset of the seat angle 0
2 Length of the seat angle For stabilizers

bolted to he
column: Bolt
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 Description Default
pitch /slope
specified in the
joints.def
file + 2- ¼" (this
gives a correct
angle length for
¾" diameter
bolts)

For stabilizers
welded to the
column: Width
of the joist

Seat angle orientation

Option Description
Default

Longest leg of the seat angle is
horizontal.

AutoDefaults can change this option.
Longest leg of the seat angle is
horizontal.
Longest leg of the seat angle is
vertical.

Seat to column

Option Description
Default

Seat is welded to the main part.

AutoDefaults can change this option.
Seat is welded to the main part.

Seat is bolted to the main part.

Seat is bolted and welded to the main
part.
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Seat to joist

Option Description
Default

No connection between the seat and
the joist.

AutoDefaults can change this option.
No connection between the seat and
the joist.

Seat is welded to the joist.

Seat is bolted and welded to the joist.

Stabilizer angle bolts tab
Use the Stabilizer angle bolts tab to define the bolt properties and bolt group
dimensions in the stabilizer angle connection.

If you have selected to create the stabilizer as a seat angle, the settings on this
tab control both the stabilizer seat angle bolts and the main part bolts. If you
have selected to create the stabilizer as a plate, only the main part bolts are
affected.

Dimensions

 Description
1 Dimension for vertical bolt group position.
2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
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 Description
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Stabilizer plate bolts tab
Use the Stabilizer plate bolts tab to define the bolt properties and bolt group
dimensions of the stabilizer plate bolts.

Bolt group dimensions

 Description
1 Horizontal bolt edge distance
2 Vertical bolt edge distance
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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2-Sided joist to column (162)
2-Sided joist to column (162) creates a bolted connection between a column
and two joists. You can define a seat angle and bolt locations.

Objects created

• Cap plate

• Moment plate

• Stabilizer plate

• Bolts

• Welds

Use for

Situation Description
Two joists connected to a column with
a bolted connection.

Selection order

1. Select the main part (column).

2. Select the first secondary part (joist).

3. Select the second secondary part (joist).

4. Click the middle mouse button to create the connection.

Part identification key

 Description
1 Cap plate

Picture tab
Use the Picture tab to define the connection dimensions.
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Dimensions

 Description Default
1 Vertical height of the joist from the top of the cap

plate to the top of the joist
2-1/2"

2 Top cord joist offset from the center line of the
main part

0

3 Cutback distance of the secondary part bottom
cord from the main part

Bolts tab
Use the Bolts tab to define the bolt properties and the position of bolts in the
seat angle connection.

Bolt group dimensions
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 Description Default
1 Distance from the main part center line to the

center line of the bolt
For I profile
columns: 1/2
the thickness
of the main
part web +
1-1/2 times
the bolt
diameter

For tube steel
columns: 1/2
the width or
length of the
column
(depending
on
orientation) +
1-1/2 "

2 Bolt spacing  

Joist attachment

Option Description
Default

Joist is bolted to the main part.

AutoDefaults can change this option.

Joist is bolted to the main part.

Joist is welded to the main part.

Bolt orientation

This option controls whether the bolts in the cap plate are square to the
column or the joist.

Option Description
Default

Bolts are placed square to the joist.

AutoDefaults can change this option.
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Option Description
Bolts are placed square to the joist.

Bolts are placed square to the main
part.

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Cap plate tab
Use the Cap plate tab to define the cap plate properties and dimensions.

Parts

Option Description
Cap plate Thickness, width, and height of the

cap plate
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Cap plate offset

 Description
1 Horizontal offset from the main part
2 Vertical offset from the main part

Cap plate dimensions

Define the width and length of the cap plate.
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 Description
1 Horizontal offset from the main part edge
2 Vertical offset from the main part edge

Cap plate orientation

Option Description
Default

Cap plate orientation matches the
skewed joint.

AutoDefaults can change this option.
Cap plate orientation matches the
skewed joint.

Cap plate is square to the main part.

Cap plate slope

Option Description
Default

Cap plate is aligned with the sloping
joist.

AutoDefaults can change this option.
Cap plate is aligned with the sloping
joist.
Cap plate is placed flat at the top of
the main part.
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Moment plate tab
Use the Moment plate tab to define the plate creation, properties, and
offsets.

Parts

Option Description
Moment plate Thickness, width, and height of the

moment plate

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Moment plate creation

Option Description
Default

Moment plate is not created.

AutoDefaults can change this option.
Moment plate is not created.

Moment plate is created.
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Moment plate offset

 Description
1 Horizontal offset from the center line of the main part
2 Vertical offset from the center line of the main part

Stabilizer tab
Use the Stabilizer tab to define the stabilizer creation, properties, and
position.

Parts

Option Description
Plate NS, Plate FS Thickness, width, and height of the

plate
Angle NS, Angle FS Select the profile from the profile

catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Stabilizer creation

Option Description
Default

Stabilizer is not created.

AutoDefaults can change this option.
Stabilizer is not created.

Stabilizer is created as a plate.

Stabilizer is created as a seat angle.

Stabilizer plate dimensions

 Description Default
1 Cable hole diameter 13/16"
2 Horizontal dimension from the edge of the

stabilizer plate to the center of the hole
1.5 X hole
diameter

3 Vertical dimension from the edge of the stabilizer
plate to the center of the hole

3

4 Vertical dimension from the lower chord of the
joist to the bottom of the stabilizer plate

1.5 X hole
diameter

Stabilizer connection type

Define how the stabilizer plate is attached to the bottom cord of the joist.

Option Description
Default

No connection between the stabilizer
plate and the joist

AutoDefaults can change this option.
No connection between the stabilizer
plate and the joist
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Option Description
Stabilizer plate is welded to the joist.

Stabilizer plate is bolted to the joist.

Stabilizer plate is bolted and welded
to the joist.

Stabilizer orientation

Option Description
Default

Stabilizer plate is aligned with the
sloping joist.

AutoDefaults can change this option.
Stabilizer plate is aligned with the
sloping joist.
Stabilizer plate is created square to
the main part.

Seat angle dimensions

 Description
1 Horizontal offset of the seat angle
2 Vertical offset of the seat angle

 Description Default
1 Horizontal offset of the seat angle  
2 Length of the seat angle For stabilizers

bolted to
column: Bolt
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 Description Default
pitch specified in
the joints.def
file + 2- ¼" (this
gives the correct
angle length for
¾" diameter
bolts)

For stabilizers
welded to
column: Width
of the joist

Seat angle orientation

Option Description
Default

Longest leg of the seat angle is
horizontal.

AutoDefaults can change this option.
Longest leg of the seat angle is
horizontal.
Longest leg of the seat angle is
vertical.

Seat to column

Option Description
Default

Seat is welded to the main part.

AutoDefaults can change this option.
Seat is welded to the main part.

Seat is bolted to the main part.

Seat is bolted and welded to the main
part.
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Seat to joist

Option Description
Default

No connection between the seat and
the joist

AutoDefaults can change this option.
No connection between the seat and
the joist

Seat is welded to the joist.

Seat is bolted to the joist.

Seat is bolted and welded to the joist.

Stabilizer angle bolts tab
Use the Stabilizer angle bolts tab to define the bolt group dimensions and
the properties of the stabilizer angle bolts. If you have selected on the
Stabilizer tab that the stabilizer is created as a seat angle, the settings on this
tab affect both angles. If the stabilizer is created as a plate, the settings only
affect the main part clip angle.
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Dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

5 Dimension for vertical bolt group position.

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes
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Option Description Default
Site/Workshop Location where the bolts

should be attached.
Site

Stabilizer plate bolts tab
Use the Stabilizer plate bolts tab to define the position and properties of the
stabilizer plate bolts.

Bolt position

 Description Default
1 Horizontal bolt edge distance 1-1/2"
2 Vertical bolt edge distance Vertical

midpoint of
the plate

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Joist to column, type 2 (163)
Joist to column, type 2 (163) creates a bolted connection between a column
and a joist. You can define a seat angle and bolt locations.

Objects created

• Seat angle

• Horizontal plate

• Vertical plate

• Stiffeners

• Bearing plate

• Stabilizer plate

• Bolts

• Welds
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Use for

Situation Description
Joist is bolted to a column. Seat angle
is created.

Selection order

1. Select the main part (column).

2. Select the secondary part (joist).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Seat angle
2 Bearing plate

Picture tab
Use the Picture tab to define the connection dimensions.

Dimensions
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 Description Default
1 Gap dimension between the main part and the upper

cord of the joist
1"

2 Vertical dimension from the seat angle to the
secondary part top

2-1/2"

3 Cutback distance of the secondary part bottom cord
from the main part flange

1"

Seat tab
Use the Seat tab to define the seat type, attachment, bolt orientation, and
plate dimensions.

Parts

Option Description
Seat profile Select the profile from the profile

catalog.
Horizontal plate Thickness and width of the horizontal

plate
Vertical plate Thickness and height of the vertical

plate

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Seat type

Option Description
Default

Seat angle is created. Longest leg is
aligned with the joist.

AutoDefaults can change this option.
Seat angle is created. Longest leg is
aligned with the joist.
Seat angle is created. Longest leg is
aligned with the main part.

Tee profile is created.

Built-up tee is created.

You can define the dimensions and
properties of horizontal and vertical
plates when you have selected to
create a built-up tee.

Seat attachment

This option only works for angle seats and stabilizers.

Option Description
Default

Seat is attached to the main part web.

AutoDefaults can change this option.
Seat is attached to the main part web.

Seat is attached to the main part
flanges.

Seat bolt orientation

Option Description
Default

Bolts are aligned with the main part.

AutoDefaults can change this option.
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Option Description
Bolts are aligned with the main part.

Bolts are aligned with the joist.

Horizontal plate dimensions

 Description
1 Length of the horizontal plate
2 Offset dimension from the main part

 Description
1 Horizontal offset of the plate

Horizontal plate alignment

Option Description
Default

Horizontal plate is aligned
perdendicular to the main part.

AutoDefaults can change this option.
Horizontal plate is aligned
perpendicular to the main part.

Horizontal plate is aligned
perpendicular to the joist.
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Seat angle dimensions

 Description
1 Horizontal offset of the seat angle from the main part edge

 Description
1 Horizontal offset of the seat angle
2 Length of the seat angle

Seat to column

Option Description
Default

Seat is welded to the main part.

AutoDefaults can change this option.
Seat is welded to the main part.

Seat is bolted to the main part.

Seat is welded and bolted to the main
part.

Seat to beam

Option Description
Default

No connection between the seat and
the joist

AutoDefaults can change this option.
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Option Description
No connection between the seat and
the joist

Seat is welded to the joist.

Seat is bolted to the joist.

Seat is welded and bolted to the joist.

Angle seat stiffeners tab
Use the Angle seat stiffeners tab to define the stiffener properties, and
stiffener position, shape, and chamfering. Stiffeners are created for seat
angles.

Parts

Option Description
Stiffeners Thickness, width, and height of the

stiffeners

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Stiffener position

Option Description
Default

Stiffener is not placed on the seat.

AutoDefaults can change this option.
Stiffener is not placed on the seat.

Stiffener is placed in the middle.

Stiffeners are placed on both sides.

Stiffener is placed on the right side.

Stiffener is placed on the left side.

Stiffeners are placed on the right side
and in the middle.

Stiffeners are placed on the left side
and in the middle.

Stiffeners are placed on the left and
right side, and in the middle.

Stiffener shape

  
Default

Rectangular stiffener

AutoDefaults can change this option.
Rectangular stiffener

Triangular stiffener

Stiffener offset dimension

Define the offset of bevel cuts for triangular stiffeners.
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 Description
1 Horizontal offset dimension
2 Vertical offset dimension

Stiffener offsets

 Description
1 Offset of the end stiffeners from the seat ends
2 Offset of the middle stiffener from the seat center line

Chamfer type

  
Default

Chamfer is not created.

AutoDefaults can change this option.
Chamfer is not created.

Line chamfer

Covex chamfer

Concave chamfer

Chamfer dimensions
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 Description
1 Vertical chamfer dimension
2 Horizontal chamfer dimension

Bearing plate tab
Use the Bearing plate tab to define the bearing plate properties, dimensions,
and connection method.

Parts

Option Description
Bearing plate Thickness and width of the bearing

plate

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Dimensions

 Description
1 Bearing plate dimension from the secondary part edge
2 Bearing plate dimension to the seat angle edge
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Stabilizer tab
Use the Stabilizer tab to define the stabilizer creation, properties, and
position.

Parts

Part Description
Plate Thickness, width, and height of the

stabilizer plate
Angle Select the profile from the profile

catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Stabilizer creation

Option Description
Default

Stabilizer is not created.

AutoDefaults can change this option.
Stabilizer is not created.

Stabilizer is created as a plate.

Stabilizer is created as a seat angle.
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Stabilizer plate dimensions

 Description  
1 Hole diameter 13/16"
2 Horizontal dimension from the edge of the

stabilizer plate to the center of the hole
1.5 X hole
diameter

3 Vertical dimension from the edge of the
stabilizer plate to the center of the hole

3"

4 Vertical dimension from the lower chord of the
joist to the bottom of the stabilizer plate

1.5 X hole
diameter

Stabilizer connection type

Option Description
Default

No connection between the stabilizer
plate and the joist

AutoDefaults can change this option.
No connection between the stabilizer
plate and the joist
Stabilizer plate is welded to the joist.

Stabilizer plate is bolted to the joist.

Stabilizer plate is bolted and welded
to the joist.

Stabilizer orientation

Option Description
Default

Stabilizer plate is aligned with the
sloping joist.

AutoDefaults can change this option.
Stabilizer plate is aligned with the
sloping joist.
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Option Description
Stabilizer plate is created square to
the main part.

Seat angle dimensions

 Description
1 Horizontal offset of the seat angle
2 Vertical offset of the seat angle

 Description Default
1 Horizontal offset of the seat angle  
2 Length of the seat angle For stabilizers

bolted to the
column: Bolt pitch
specified in the
joints.def file +
2- ¼" (this gives a
correct angle
length for
¾"diameter bolts)

For stabilizers
welded to the
column: Width of
the joist
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Seat angle orientation

Option Description
Default

Longest leg of the seat angle is
horizontal.

AutoDefaults can change this option.
Longest leg of the seat angle is
horizontal.
Longest leg of the seat angle is
vertical.

Seat to column

Option Description
Default

Seat is welded to the main part.

AutoDefaults can change this option.
Seat is welded to the main part.

Seat is bolted to the main part.

Seat is bolted and welded to the main
part.

Seat to joist

Option Description
Default

No connection between the seat and
the joist

AutoDefaults can change this option.
No connection between the seat and
the joist

Steel components 995 Joist connections



Option Description
Seat is welded to the joist.

Seat is bolted to the joist.

Seat is bolted and welded to the joist.

Seat bolts tab
Use the Seat bolts tab to define bolt group dimensions and bolt properties of
the seat angle and tee type plate bolts.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
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 Description
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

5 Dimension for vertical bolt group position.

Bolt orientation

Option Description
Default

Bolts are placed square to the main
part.

AutoDefaults can change this option.
Bolts are placed square to the main
part.

Bolts are placed square to the joist.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Stabilizer angle bolts tab
Use the Stabilizer angle bolts tab to define the bolt group dimensions and
the properties of the stabilizer angle bolts. If you have selected on the
Stabilizer tab that the stabilizer is created as a seat angle, the settings on this
tab affect both angles. If the stabilizer is created as a plate, the settings only
affect the main part clip angle.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
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 Description
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

5 Dimension for vertical bolt group position.

Bolt orientation

Option Description
Default

Bolts are placed square to the main
part.

AutoDefaults can change this option.
Bolts are placed square to the main
part.

Bolts are placed square to the joist.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Stabilizer plate bolts tab
Use the Stabilizer plate bolts tab to define the position and properties of the
stabilizer plate bolts.

Bolt position

 Description Default
1 Horizontal bolt edge distance 1-1/2"
2 Vertical bolt edge distance Vertical

midpoint of
the plate

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Joist to beam and column (164)
Joist to beam and column (164) creates a connection between a column,
beam, and joist. You can define a seat angle, cap plate, and bolt locations.

Objects created

• Bearing plate

• Stabilizer plate

• Bolts

• Welds
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Use for

Situation Description
Joist bolted to a column

Selection order

1. Select the main part (column).

2. Select the first secondary part (beam).

3. Select the second scondary part (beam).

4. Click the middle mouse button to create the connection.

Part identification key

 Description
1 Bearing plate

Picture tab
Use the Picture tab to define the connection dimensions.

Dimensions
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 Description
1 Top cord offset from the column center line
2 Cutback distance of the secondary part bottom cord from the

main part

Bearing plate tab
Use the Bearing plate tab to define the bearing plate properties, dimensions,
and the connection method.

Part

Part Description
Bearing plate Thickness and width of the bearing

plate

Dimensions

 Description
1 Bearing plate edge dimension to the main part edge
2 Bearing plate inner edge dimension to the main part edge

Bolts tab
Use the Bolts tab to define bolt properties and the position of bolts in the seat
angle connection.
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Bolt group dimensions

 Description
1 Distance from the main part center line to the center line of the

bolt
2 Bolt spacing

Joist attachment

Option Description
Default

Joist is bolted to the main part.

AutoDefaults can change this option.

Joist is bolted to the main part.

Joist is welded to the main part.

Bolt orientation

Option Description
Default

Bolts are placed square to the main
part.

AutoDefaults can change this option.
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Option Description
Bolts are placed square to the main
part.

Bolts are placed square to the joist.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Stabilizer tab
Use the Stabilizer tab to define the stabilizer creation, properties, and
position.

Parts

Option Description
Plate Thickness, width, and height of the

stabilizer plate
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Option Description
Angle Select the profile from the profile

catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Stabilizer creation

Option Description
Default

Stabilizer is not created.

AutoDefaults can change this option.
Stabilizer is not created.

Stabilizer is created as a plate.

Stabilizer is created as a seat angle.

Stabilizer plate dimensions
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 Description Default
1 Hole diameter 13/16"
2 Horizontal dimension from the edge of the stabilizer

plate to the center of the hole
1.5 X hole
diameter

3 Vertical dimension from the edge of the stabilizer
plate to the center of the hole

3

4 Vertical dimension from the lower chord of the joist
to the bottom of the stabilizer plate

1.5 X hole
diameter

Stabilizer connection type

Option Description
Default

No connection between the stabilizer
plate and the joist

AutoDefaults can change this option.
No connection between the stabilizer
plate and the joist
Stabilizer plate is welded to the joist.

Stabilizer plate is bolted to the joist.

Stabilizer plate is bolted and welded
to the joist.

Stabilizer orientation

Option Description
Default

Stabilizer plate is aligned with the
sloping joist.

AutoDefaults can change this option.
Stabilizer plate is aligned with the
sloping joist.
Stabilizer plate is created square to
the main part.
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Seat angle dimensions

 Description
1 Horizontal offset of the seat angle
2 Vertical offset of the seat angle

 Description  
1 Horizontal offset of the seat angle  
2 Length of the seat angle For stabilizers

bolted to the
column: Bolt
pitch specified
in the
joints.def file
+ 2- ¼" (this
gives the correct
angle length for
¾" diameter
bolts)

For stabilizers
welded to the
column: Width
of the joist

Seat angle orientation

Option Description
Default

Longest leg of the seat angle is
horizontal.

AutoDefaults can change this option.
Longest leg of the seat angle is
horizontal.
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Option Description
Longest leg of the seat angle is
vertical.

Seat to column

Option Description
Default

Seat is welded to the main part.

AutoDefaults can change this option.
Seat is welded to the main part.

Seat is bolted to the main part.

Seat is bolted and welded to the main
part.

Seat to joist

Option Description
Default

No connection between the seat and
the joist

AutoDefaults can change this option.
No connection between the seat and
the joist

Seat is welded to the joist.

Seat is bolted to the joist.
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Option Description
Seat is bolted and welded to the joist.

Stabilizer angle bolts tab
Use the Stabilizer angle bolts tab to define the bolt group dimensions and
the properties of the stabilizer angle bolts. If you have selected on the
Stabilizer tab that the stabilizer is created as a seat angle, the settings on this
tab affect both angles. If the stabilizer is created as a plate, the settings only
affect the main part clip angle.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

5 Dimension for vertical bolt group position.

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.
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Option Description Default
Bolt standard Bolt standard to be used

inside the component.
Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Stabilizer plate bolts tab
Use the Stabilizer plate bolts tab to define the position and properties of the
stabilizer plate bolts.

Bolt position

 Description Default
1 Horizontal bolt edge distance 1-1/2"
2 Vertical bolt edge distance Vertical

midpoint of
the plate

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.
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Option Description Default
Tolerance Gap between the bolt

and the hole.
 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

2.7 Welded connections
This section introduces welded connection components available in Tekla
Structures.

• Cross (4) (page 1014)

• Offshore (9) (page 1018)
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• Fitting (13) (page 1025)

• Round tube (23) (page 1029)

• Welded column (31) (page 1032)

• Welded tee (32) (page 1036)

• Weld preparation (44) (page 1050)

• New notch (49) (page 1054)

• Welded beam to beam (123) (page 1059)

• Welded column with stiffeners (128) (page 1068)

• Beam prep (183) (page 1088)

• Offshore (194) (page 1103)

• Doubler plate (1022) (page 1106)

• Cap plate detail (page 1111)

• Pipe doubler plate (page 1117)

• Ring plate (page 1124)

Cross (4)
Cross (4) connects two beams that cross each other by using a profile welded
to one of the beams. The beams should not collide with each other. Both
horizontal and vertical angles between the profiles can vary.

Objects created

• Profile

• Welds

Use for

Situation Description
Two beams connected with a welded
profile.

Selection order

1. Select the main part (beam).
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2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Profile

Picture tab
Use the Picture tab to define the connection dimensions.

Secondary part cut

Option Description
Define the secondary beam close end
cut from the main beam center line.

By default, the secondary beam is not
cut.

Parts tab
Use the Parts tab to define the part properties.
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Parts

Option Description
Profile Select the profile from the profile

catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the welding location and profile rotation.

Profile welded to

Option Description
Default

Welded to the main part

AutoDefaults can change this option.

Welded to the main part

Welded to the secondary part
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Option Description
Not welded

Profile rotation

Option Description
Default

Front

AutoDefaults can change this option.

Front

Top

Back

Below

Steel components 1017 Welded connections



General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Offshore (9)
Offshore (9) connects a beam to another beam with welds. The component is
designed to be used in offshore industry for creating notches and complex
weld access holes, and to control the notch properties.

Objects created

• Notches

• Welds

Use for

Situation Description
Connection between two beams.
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Profile limitations

You can create three different notch types:

• Free

• Heerema

• HSM

When creating a Free notch type, the main and the secondary beam do not
always have to have the same size. You can set them up according to your
needs and create the connection.

When creating Heerema and HSM notch types, the beam size depends on the
selected Heerema and HSM settings.

For all Free and Heerema types, and most HSM types, skewed secondary
beams are allowed. Sloped secondary beams are only supported by some
specific HSM types. See the table below for examples.

Notch
type

Example

Free

HSM

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Part
1 Beam
2 Beam

Picture 1 tab
Use the Picture 1 tab to create notches in the direction of the web.

Notch type

Select the notch type and enter the notch values, if needed.

Option Description
Free Enter the notch dimensions.
Heerema When you select this option, the predefined Heerema

options are listed below.

The predefined values are entered automatically in the
user-defined attributes of the secondary beam.

HSM When you select this option, the predefined HSM options
are listed below.

The predefined values are entered automatically in the
user-defined attributes of the secondary beam.

No and
clean up
UDA

No notch is created.

The user-defined attributes have no values.
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Notches

 Description
1 Define the top flange notch for the secondary beam.
2 Define the bottom flange notch for the secondary

beam.
3 Define a gap between the main beam web and the

secondary beam end.
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 Description
4 Define the bottom rounding and a possible weld access

hole for the secondary beam.
5 Define the top rounding and a possible weld access

hole for the secondary beam.
6 Create a cut that follows the sloped flange of the

secondary beam.

Fitting

Select the type of the fitting.

Picture 2 tab
Use the Picture 2 tab to create notches in the direction of the flange. The
options on this tab can only be used if the notch type is set to Free on the
Picture 1 tab. If you select a special type of notch (Heerema, HSM) on the
Picture 1 tab, then the predefined values are entered automatically in the
user-defined attributes.
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Notches

 Description
Define the bevel angle for the top flange (optional).

Define the top flange bevel.

Define the bottom flange bevel.

Define the bevel angle for the bottom flange (optional).

Weld description tab
Use the Weld description tab to control weld descriptions for the top, web
and bottom welds.
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 Description
Top weld

Web weld

Bottom weld

Use the boxes on the Weld description tab to define a name for the weld
comment. Enter the text WELD_COMMENT in the UDA field. The descriptions in
the Top, Web and Bottom boxes correspond to each weld.

Double-click a weld in the model and go to the user-defined attributes of the
weld. The text is entered in the Weld Comment box.
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Fitting (13)
Fitting (13) connects a beam to a beam using welds.

Objects created

• Stiffeners (2) (optional)

• Welds
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Use for

Situation Description
Fitting connection without stiffeners.

Fitting connection with upper and
lower stiffener.

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary beam is
selected.
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Part identification key

 Part
1 Upper stiffener
2 Lower stiffener

Picture tab
Use the Picture tab to control the fitting dimensions.

Dimensions

 Description
1 Stiffener horizontal distance from the secondary beam edge.
2 Stiffener vertical distance from the secondary beam edge.
3 Distance between the main beam and the secondary beam.

Option Description
Max gap allowed to end plate Enter the tolerance value for fitting

the secondary part.

Use this option when the secondary
part is skewed. The gap is calculated
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Option Description
using the skew angle and the height
of the secondary profile.

If the gap is within the tolerance
value, the secondary part is fitted in
the main part coordinate system.
When the defined maximum gap is
greater than the actual gap in the
model, the secondary part is fitted in
the secondary part coordinate
system.

Weldings Select whether welds are created.

Welds are created when you select
Yes. The default is that welds are not
created.

Parts tab
Use the Parts tab to control the stiffener properties.

Stiffener

Part Description
Upper stiffeners Thickness, width, and height of the

upper stiffener.
Lower stiffeners Thickness, width, and height of the

lower stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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General tab
Click the link below to find out more:

General tab

Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Round tube (23)
Round tube (23) connects two round tube profiles with a fitting and welds.

Objects created

• Fitting

• Welds

Use for

Situation Description
Connection between two round
tubes.

Fitting and welds are created.
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Selection order

1. Select the main part (first round tube).

2. Select the secondary part (second round tube).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Round tube
2 Round tube

Picture tab
Use the Picture tab to control the dimensions of the secondary round tube
fitting and the gap between the round tubes.

Part dimensions

 Description Default
1 Pop mark offset.

You can define the offset if you have set
the Position of pop mark option to At
minimum angle, At maximum angle, or
Both.

100 mm

2 Pop mark diameter.

You can define the diameter if you have
set the Position of pop mark option to At
minimum angle, At maximum angle, or
Both.

10 mm

Steel components 1030 Welded connections



 Description Default
3 Gap between the main and the secondary

round tube.
 

Secondary part fitting

Option Description
Default

The secondary round tube is cut with
the main round tube.

AutoDefaults can change this option.
The secondary round tube is cut with
the main round tube.

The secondary round tube is fitted to
the center line of the main round
tube and then cut.

Secondary part cut

 Description
1 Define the secondary part cut distance from the main part

center.

Position of pop mark

Select the position of the pop mark.

Parameters tab
Use the Parameters tab to control whether welds are created and to define
the rotation angle and cut tolerance.

Option Description
Weldings Define whether welds are created

between the round tubes.
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Option Description
Rotation angle of cut part Define the rotation angle of the cut in

the main round tube.

In some cases it is necessary to rotate
the cut part in the main round tube to
make sure the cut is shown correctly.
The default is that the cut part is not
rotated.

Cut tolerance of sec Define the cut tolerance of the
secondary round tube.

General tab
Click the link below to find out more:

General tab

Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the links below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Welded column (31)
Welded column (31) connects a beam to a column flange using fittings and
welds. Stiffeners are created between the column flanges.

Objects created

• Stiffeners

• Fittings

• Welds

Steel components 1032 Welded connections



Use for

Situation Description
Beam welded to a column.
Four stiffeners are created.

Sloped beam welded to a
column. Four stiffeners are
created.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Part
Stiffener

Picture tab
Use the Picture tab to control the dimensions and stiffener positions.

Dimensions

 Description
1 Distance between the stiffener and the column flange.
2 Distance between the column flange and the edge of the beam.

You can define the distance if the Fit secondary option is set to
Default or Yes.
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Fit secondary

Define whether the secondary beam can be fitted to the column.

Parts tab
Use the Parts tab to control the stiffener properties.

Stiffeners

Part Description Default
Stiffeners Thickness, width, and

height of the stiffeners.
Thickness = 16 mm
Width = If the width is
not defined, it is based
on the flange width.

Height = Column web
height

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Chamfer dimensions
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Description
1 Vertical chamfer dimension.

You can define the vertical dimension for line chamfers.
2 Horizontal chamfer dimension.

Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Welded tee (32)
Welded tee (32) connects a beam to a column or to another beam using a T-
shaped piece of an I-profile welded to the main part and bolted to the
secondary beam web.

Objects created

• Tee part

• Bolts

• Welds

Use for

Situation Description
Welded tee connected to a column
and bolted to a beam.

Selection order

1. Select the main part.

2. Select the secondary part.

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Tee part

Picture tab
Use the Picture tab to define the connection dimensions.
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Dimensions

 Description Default
1 Tee part edge distance from the secondary part

top.
 

2 Tee part edge distance from the secondary part
bottom.

 

3 Gap between the main part and the secondary
part.

The value you define affects the tee part size.

10 mm

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
Profile Select the profile from

the profile catalog.
The same as the
secondary part profile.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Option Description Default
Finish Describes how the part

surface has been
treated.

 

Parameters tab
Use the Parameters tab to define the tee part position.

Tee part position

Option Description
Default

Tee part is on the left side.

AutoDefaults can change this option.

Tee part is on the left side.

Tee part is on the right side.

Primary bolts tab
Use the Primary bolts tab to define the main part bolt group dimensions and
bolt properties.

Bolt group dimensions
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 Description
1 Select how to measure the dimensions for horizontal bolt

group position.

• Left: From the left edge of the secondary part to the
leftmost bolt.

• Middle: From the center line of the secondary part to the
center line of the bolts.
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 Description
• Right: From the right edge of the secondary part to the

rightmost bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

6 Select how to measure the dimensions for vertical bolt group
position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.
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 Description
• Middle: From the center line of the bolts to the center line

of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

7 Dimension for vertical bolt group position.

Connect to primary

Select how the profile is connected to the main part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within

Yes
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Option Description Default
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Secondary bolts tab
Use the Secondary bolts tab to define the secondary part bolt group
dimensions and bolt properties.
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Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt

group position.

• Left: From the left edge of the secondary part to the
leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the

center line of the bolts.

• Right: From the right edge of the secondary part to the
rightmost bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.
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 Description
6 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line
of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

7 Dimension for vertical bolt group position.

Steel components 1047 Welded connections



Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3
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Option Description
Staggered type 4

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Weld preparation (44)
Connects two beams of I profile with welds. You can shape the secondary
beam end with rat holes and other weld preparations. The only allowed beam
profile is I-profile.

Objects created

• Welds

• Fitting

• Cuts to shape the beam end
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Use for

Situation Description
Beam welded to a beam web.
Rat hole at the bottom.

Before you start

Create two beams.

Selection order

1. Select the main part.

2. Select the secondary part.

The connection is created automatically when the secondary part is
selected.

Picture tab
Use the Picture tab to define the connection geometry.

Dimensions
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 Description Default
1 Vertical tolerance.

Tolerance between the main part web and
the secondary part flange.

0.2*secondary part
flange thickness

2 Flange horizontal tolerance.

Horizontal tolerance between the secondary
part and the main part upper flange.

3 mm

3 Web upper vertical tolerance.

Vertical distance between the secondary part
upper edge and the top of the web.

 

4 Web lower vertical tolerance.

Vertical distance between the secondary part
lower edge and the bottom of the web.

 

5 Flange horizontal tolerance

Horizontal tolerance between the secondary
part and the main part lower flange.

3 mm

6 Web horizontal tolerance.

Tolerance between the webs of the beams.

0 mm
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Parameters tab

Beam end shape

 Description
1 Web chamfer

Dimensions of the top and bottom chamfers in the secondary part web.
2 Top and bottom flange straight distance.
3 Top and bottom weld access hole radius.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

New notch (49)
New notch (49) welds a beam to another beam. You can define how to cut the
beam end. The connection also creates horizontal stiffeners, if needed.

Objects created

• Cuts to shape beam end

• Welds

• Stiffeners (4) optional

Use for

Situation Description
A beam welded to a beam. Bottom of the
secondary beam web notched.

Before you start

Create two beams.

Selection order

1. Select the main part (beam).
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2. Select the secondary part (beam to be cut).

The connection is created automatically when the secondary part is
selected.

Picture tab
Use the Picture tab to define the connection geometry.

Dimensions

 Description Default
1 Horizontal tolerance between the main part

and the secondary part upper flanges.
0 mm

2 Lower flange horizontal tolerance between
the main part and the secondary part lower
flanges.

0 mm

3 Web horizontal tolerance between the main
part web and the secondary part web.

0 mm

4 Web upper vertical tolerance.

Vertical distance between the secondary
part upper edge and the top of the web.

 

5 Web lower vertical tolerance.

Vertical distance between the secondary
part lower edge and the bottom of the web.
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Secondary beam flange notch dimensions

 Description
1 Notch dimension of the secondary beam top or bottom flange, if the

secondary beam is rotated as in the picture below.

2 Notch dimension of the secondary beam top or bottom flange, if the
secondary beam is rotated as in the picture below.

Parts tab

Option Description Default
Upper/lower stiffeners Stiffener thickness,

width and height.
The default thickness is
equal to the beam’s
upper / lower flange
thickness.

The default width is
0.5*(upper / lower

Steel components 1056 Welded connections



Option Description Default
flange width-web
thickness).

The default length
(height) is 300 mm.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab

Stiffener position dimensions
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 Description Default
1 Upper stiffener horizontal distance from the

beam end.
0 mm

2 Lower stiffener horizontal distance from the
beam end.

0 mm

3 Upper stiffener vertical distance from the
upper flange.

Secondary
beam height /
4

4 Lower stiffener vertical distance from the
lower flange.

Secondary
beam height /
4

Secondary beam chamfer dimensions

 Description Default
1 Upper web chamfer dimension. 0 mm
2 Lower web chamfer dimension. 0 mm
3 Upper flange chamfer dimension. 0 mm
4 Lower flange chamfer dimension. 0 mm

General tab
Click the link below to find out more:

General tab

Design tab
Click the link below to find out more:

Design tab
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Analysis tab
Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Welded beam to beam (123)
Welded beam to beam (123) connects two beams using a fully welded
connection. The beams can have welding preparations. Stiffener plates with
welding preparations can also be created.

Limitations

• You can only use I-section beams.

• You cannot use beams that are horizontally skewed or vertically sloped.

Objects created

• Stiffeners

• Cuts

• Welds

Use for

Situation Description
Fully welded beam to beam
connection

Selection order

1. Select the main part (beam).
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2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Front stiffener
2 Back stiffener

Picture tab
Use the Picture tab to define the beam and stiffener offset dimensions.

Dimensions
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 Description
1 Gap dimension between the main part web and the secondary

part edge.
2 Secondary part offset dimension from the main part flange.
3 Secondary part offset dimension from the underside of the

main part flange.
4 Back stiffener offset dimension from the main part web.
5 Front stiffener offset dimension from the main part web.

Parameters tab
Use the Parameters tab to define the stiffener plate properties, and whether
weld preparations are required.

Plates

Option Description
Btm stiff plate Thickness and width of the stiffener

on the main beam side.
Back stiffener Thickness and width of the stiffener

located behind the secondary beam.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Weld preparation creation, beam web and flange thickness

Option Description Default
Are weld preparations
required

Select whether to create
weld preparations.

Weld preparations are
not created.
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Option Description Default
Root face thickness of
web at U/S of flange

Set the minimum
thickness of the main
beam web after the weld
preparation cut.

The minimum value is
2.0 mm. If you do not
enter a value, the
minimum value is used.

Note that if you have
defined a double-sided
weld preparation, the
root face thickness is
centred on the web of
the beam.

 

Root face thickness of
web

Set the minimum
thickness of the
incoming beam web
after the weld
preparation cut.

The minimum value is
2.0 mm.

Note that if you have
defined a double-sided
weld preparation, the
root face thickness is
centred on the web of
the beam.

 

Root face thickness for
front stiffener

Set the minimum
thickness of the front
stiffener after the weld
preparation cut. The
minimum value is 2.0
mm.

Note that if you have
defined a double-sided
weld preparation, the
root face thickness is
centred on the stiffener.

The default value is the
thickness of the flange,
that is, no weld
preparation other than a
gap can be created
unless you define a root
face thickness.

Root face thickness for
rear stiffener

Set the minimum
thickness of the back
stiffener after the weld
preparation cut. The

The default value is the
thickness of the flange,
that is, no weld
preparation other than a
gap can be created
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Option Description Default
minimum value is 2.0
mm.

Note that if you have
defined a double-sided
weld preparation, the
root face thickness is
centred on the stiffener.

unless you define a root
face thickness.

Use flange slope ratio Select whether the
flange slope ratio is used
in notch cuts.

 

Define weld preparations
You can apply various weld preparations to the main beam flanges and web,
and to the stiffener plates.

By default, the connection automatically detects whether the top and bottom
flanges of the main beam clash with the flanges of the secondary beam. This
determines how the weld preparations are handled.

If the main beam does not have the same section size as the secondary beam,
the connection detects which flange is free based on which of the top or the
bottom flanges are still clashing.

The following explains the basic weld preparation situations of each section of
the main beam:

Situation Description
Default The top flange is cut back to avoid the top flange of the

secondary beam. You can define the secondary part

offset from the main part flange in  and

 on the Picture tab.

Set Are weld preparations required on the
Parameters tab to Yes.

Steel components 1063 Welded connections



Situation Description
Weld from the
outside

To create a weld preparation that shapes the top flange
so that it can be welded from the outside, first set Are
weld preparations required on the Parameters tab to
Yes.

Click the Welds button to define the weld settings:

• For top flange: For weld number 1, change the top
half of Type from fillet weld to penetration weld

. You can also define the size and angle of
the weld.

• For the bottom flange: Modify weld number 3.
Weld from the
inside

To create a weld preparation that shapes the top flange
so that it can be welded from the inside, first set Are
weld preparations required on the Parameters tab to
Yes.

Click the Welds button to define the weld settings:

• For weld number 1, change the bottom half of Type

from fillet weld to penetration weld . You
can also define the size and angle of the weld.

• For the bottom flange: Modify weld number 3.

Main beam web

Note that if you define any weld preparation on the beam web, the weld
preparation is created on the vertical face of the web and the horizontal face
of the web at the underside of the secondary beam flange.

Situation Description
Default situation The default weld preparation of the main beam web is

to fit the beam to the side of the secondary beam web.

Set Are weld preparations required on the
Parameters tab to Yes.

If needed, define that a gap is created between the two

webs in  on the Picture tab.
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Situation Description
Weld from the near
side

Set Are weld preparations required on the
Parameters tab to Yes.

Click the Welds button to define the weld settings. For
weld number 2, change the top half of Type from fillet

weld to penetration weld . You can also define
the size and angle of the weld.

Check on the Parameters tab that the root face
thickness values are as needed.

Weld from the far
side

Set Are weld preparations required on the
Parameters tab to Yes.

Click the Welds button to define the weld settings. For
weld number 2, change the bottom half of Type from

fillet weld to penetration weld . You can also
define the size and angle of the weld.

Check on the Parameters tab that the root face
thickness values are as needed.

Weld from both
sides

Set Are weld preparations required on the
Parameters tab to Yes.

Click the Welds button to define the weld settings. For
weld number 2, change both the top and the bottom
halves of Type from fillet weld to penetration weld

. You can also define the size and angle of the
weld.

Check on the Parameters tab that the root face
thickness values are as needed.

Front and back stiffener plates

If you define any weld preparation on the front and back stiffener, it is created
on the three stiffener sides that are welded to the main beam and the
secondary beam.

Situation Description
Default situation For the default situation, see the description of the main

beam web. The welds you need to define are weld
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Situation Description
number 5 for the front stiffener and weld number 6 for
the back stiffener.

Weld from the
near side

See the description of the main beam web. The welds
you need to define are weld number 5 for the front
stiffener and weld number 6 for the back stiffener.

Weld from the far
side

See description of the main beam web. The welds you
need to define are weld number 5 for the front stiffener
and weld number 6 for the back stiffener.

Weld from both
sides

See the description of the main beam web. The welds
you need to define are weld number 5 for the front
stiffener and weld number 6 for the back stiffener.

Chamfers tab
Use the Chamfers tab to define the weld access hole dimensions.

Secondary beam weld access hole dimensions

 Description
1 Vertical flange dimension.
2 Flange cut shape.
3 Weld access hole shape.
4 Radius of the weld access hole.
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Beam end dimensions

 Description
1 Length of the secondary beam web.

This is the flange cut distance from the start of the web.
2 Vertical chamfer dimension.
3 Horizontal chamfer dimension.

Weld access hole offset

 Description
1 Weld access hole offset along the secondary beam axis.

Secondary beam web chamfers

 Description
1 Chamfer shape
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 Description
2 Vertical chamfer dimension
3 Horizontal chamfer dimension

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Welded column with stiffeners (128)
Creates a welded beam to column connection. By default, creates the
necessary notches in the secondary beam flanges and web. The secondary
beam can be level or sloped. Stiffener plates on the opposite side of the
column web are optional.

Objects created

• Stiffeners (optional)

• Weld backing bars (optional)

• Web doubler plate (optional)

• Bolts

• Welds

• Cuts

Steel components 1068 Welded connections



Use for

Situation Description
Welded to the column with
weld prep and stiffener
options.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.
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Picture tab
Use the Picture tab to control the gaps and shape of the secondary beam end
cut.

Dimensions

 Description Default
1 Cutting point of the secondary beam. The

cutting point is defined as a gap between the
main and the secondary part.

General / gap (0.0625”)

2 mm

2 Chamfer type.

Options: No, Line, Cope, or Arc.

No chamfer

3 Width of the secondary flange chamfer. Equal to the fillet radius
of the main part profile.

4 Height of the secondary flange chamfer. Equal to the fillet radius
of the main part profile.

NOTE This information relates only to the U.S. imperial environment. 
GENERAL defaults can be found in the joints.def file in the system
folder and can be modified as required.

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position, and type.

Stiffener plate dimensions

Part Description
Top NS Define the top near side stiffener thickness, width and height.
Top FS Define the top far side stiffener thickness, width and height.
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Part Description
Bottom NS Define the bottom near side stiffener thickness, width and

height.
Bottom FS Define the bottom far side stiffener thickness, width and

height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.
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Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.

Stiffeners are created.

Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.

Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding
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Option Description
Line chamfered stiffener plates

Stiffener positions

 Description
1 Size of the gap between the stiffener and the beam web edge.
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
5 Size of the gap between the top far side stiffener and the beam flange

edge.

Stiffener gap
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Description
1 Distance from the edge of the flange to the edge of the

stiffener.
2 Size of the gap between the flanges and the stiffener.

Chamfer dimensions

 Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer
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Option Description
Concave arc chamfer

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole
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Option Description Default
Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.
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Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.

Weld backing bars

Option for top backing
bar

Option for bottom
backing bar

Description

Default

Backing bars are created
inside the flanges.

AutoDefaults can change
this option.
No backing bars are
created.

Backing bars are created
inside the flanges.

Backing bars are created
outside the flanges.

Weld backing bar length

Enter the length of the weld backing bar in the box below the options.

Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar
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Option Description
Extension beyond the edge of the
flange

Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
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Option Description
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.
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Option Description
Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.
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Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.
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Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.
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Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Doubler plate tab
Use the Doubler plate tab to create doubler plates to strengthen the web of
the main part.

Web plate

Option Description
Web plate Web plate thickness and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in

Steel components 1084 Welded connections



Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Doubler plates

Option Description
Default

Doubler plates are created on both
sides.

AutoDefaults can change this option.

Doubler plates are not created.

Doubler plate is created on the near
side.

Doubler plate is created on the far
side.

Doubler plate edge shape

Option Description
Default

Bevel doubler plates

AutoDefaults can change this option.

Bevel doubler plates

Enter the angle in 
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Option Description
Square doubler plates

Doubler plate cuts

Option Description
Default

Doubler plates are not cut.

AutoDefaults can change this option.

Doubler plates are not cut.

Doubler plates are cut in the area that
connects the main part web and
flange.

General settings
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Description
1 Edge distance from the column flange.
2 Doubler plate edge distance.

Edge distance is the distance from the center of a hole to
the edge of the part.

3 Edge distance of the doubler plate in relation to the bottom
of the secondary part.

4 Number of holes.
5 Hole spacing.

Use a space to separate hole spacing values. Enter a value
for each space between holes. For example, if there are 3
holes, enter 2 values.

6 Hole diameter.

Weld hole size

 
1 Slot length.
2 Slot width.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Beam prep (183)
Creates a welded beam to column connection. The end of the beam can be
prepared. Web doubler plate in the column is optional. Welds are defined in a
separate dialog box that you can access by clicking the Welds button.

Objects created

• Web doubler plate (optional)

• Weld backing bars (optional)

• Welds

• Cuts

Use for

Situation Description
Beam to column web. Web doubler
plate on the opposite side of
column web.

Sloping beam to column flange.
Weld backing bars.
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Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Picture tab
Use the Picture tab to set the gap between the main part and the secondary
part, and select the beam end cut type.

Dimensions

 Description
1 Weld gap

Beam end cut

Define how the beam end is cut. The secondary part is viewed from the side.
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Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary part slopes less than
10 degrees, a square cut is created.
Otherwise, a bevel cut is made to the
end of the secondary part.
Square

Creates a square cut to the end of the
secondary part.
Bevel

Cuts the end of the secondary part
parallel to the edge of the main part.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
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Option Description
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.
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Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.
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Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
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Option Description
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions
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 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole
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Option Description Default
Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.
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Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.

Weld backing bars

Option for top backing
bar

Option for bottom
backing bar

Description

Default

Backing bars are created
inside the flanges.

AutoDefaults can change
this option.
No backing bars are
created.

Backing bars are created
inside the flanges.

Backing bars are created
outside the flanges.

Weld backing bar length

Enter the length of the weld backing bar in the box below the options.

Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar
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Option Description
Extension beyond the edge of the
flange

Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

Doubler plate tab
Use the Doubler plate tab to create doubler plates to strengthen the web of
the main part.

Web plate

Option Description
Web plate Web plate thickness and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Doubler plates

Option Description
Default

Doubler plates are created on both
sides.

AutoDefaults can change this option.

Doubler plates are not created.

Doubler plate is created on the near
side.

Doubler plate is created on the far
side.

Doubler plate edge shape

Option Description
Default

Bevel doubler plates

AutoDefaults can change this option.

Bevel doubler plates

Enter the angle in 
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Option Description
Square doubler plates

Doubler plate cuts

Option Description
Default

Doubler plates are not cut.

AutoDefaults can change this option.

Doubler plates are not cut.

Doubler plates are cut in the area that
connects the main part web and
flange.

General settings

Description
1 Edge distance from the column

flange.
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Description
2 Doubler plate edge distance.

Edge distance is the distance from the
center of a hole to the edge of the
part.

3 Edge distance of the doubler plate in
relation to the bottom of the
secondary part.

4 Number of holes.
5 Hole spacing.

Use a space to separate hole spacing
values. Enter a value for each space
between holes. For example, if there
are 3 holes, enter 2 values.

6 Hole diameter.

Weld hole size

Option Description
1 Slot length.
2 Slot width.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Offshore (194)
Offshore (194) creates a beam-to-beam welded connection, which also
creates a haunch for different depth beams. The haunch is made of the same
size profile as the smaller beam. You can control the length and depth of the
cuts and the required welding.

Objects created

• Haunch plates

• Welds

Use for

Situation Description
Welded offshore connection with
haunch plates.

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key
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 Description
1 Haunch plate

Picture tab
Use the Picture tab to define the connection dimensions and chamfers.

Dimensions

 Description
1 Chamfer size at the top flange.
2 Chamfer radius.
3 Depth of the secondary part cut.
4 Length of the secondary part cut.
5 Chamfer size at the bottom flange for line and convex chamfers.

Gap distance

 Description
1 Gap distance for the haunched beam flange.

Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer
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Option Description
Convex chamfer

Parts tab
Use the Parts tab to define whether the haunch is created as a profile or as a
plate.

Parts

Option Description
Beam, Web plate, Flange plates The haunch profile is the same as that

of the supported secondary beam.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Doubler plate (1022)
Doubler plate (1022) creates a web plate to strengthen the main part web.

Objects created

• Web plate

• Welds

Use for

Situation Description
Web plate to main part

Selection order

1. Select the part.

2. Pick a position for the doubler plate.

The doubler plate is created automatically when you pick the position.
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Part identification key

 Description
1 Doubler plate

Picture tab
Use the Picture tab to define the connection dimensions.

Dimensions

Description
1 Edge distance from the column flange.
2 Doubler plate edge distance.

Edge distance is the distance from the center of a hole to the edge of
the part.
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Description
3 Edge distance of the doubler plate in relation to the bottom of the

secondary part.
4 Number of holes.
5 Hole spacing.

Use a space to separate hole spacing values. Enter a value for each
space between holes. For example, if there are 3 holes, enter 2
values.

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description
Web plate Thickness and height of the web plate

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Doubler plate tab
Use the Doubler plate tab to create doubler plates to strengthen the web of
the main part.
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Doubler plates

Option Description
Default

Doubler plates are created on both
sides.

AutoDefaults can change this option.

Doubler plates are not created.

Doubler plate is created on the near
side.

Doubler plate is created on the far
side.

Doubler plates are created on both
sides.

Weld hole size

 Description
1 Hole diameter.
2 Slot length.
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 Description
3 Slot width.

Doubler plate cuts

Option Description
Default

Doubler plates are not cut.

AutoDefaults can change this option.

Doubler plates are not cut.

Doubler plates are cut in the area that
connects the main part web and
flange.

Doubler plate edge shape

Option Description
Default

Bevel doubler plates

AutoDefaults can change this option.

Bevel doubler plates

Enter the angle in 

Square doubler plates

General tab

Click the link below to find out more:

General tab
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Cap plate detail
Cap plate detail creates a cap plate to a column or a beam, or to a polybeam.

Objects created

• Cap plate

Use for

Situation Description
Cap plate with one chamfered corner
created on an I profile column.
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Situation Description
Cap plate created on a pipe profile
column.

One cap plate created on a pipe
profile column and another cap plate
created on an I profile column.

Selection order

1. Select the main part (beam, column, or polybeam).

2. Pick the position of the cap plate.

You can pick a position on the column center line, side, or anywhere. The
cap plate is always centered.

The cap plate is created automatically when you pick the position.

Part identification key
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 Part
1 Cap plate

Picture tab
Use the Picture tab to control the shape and the dimensions the cap plate.

Cap plate shape

Option Description
Default

Rectangular

AutoDefaults can change this option.

Rectangular

Circular
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Rectangular cap plate dimensions

Description Default
1 Horizontal chamfer dimension.

This option is not available if you have
selected No chamfer in the chamfer options.

20 mm

2 Vertical chamfer dimension.

This option is not available if you have
selected No chamfer in the chamfer options.

20 mm

3 Horizontal edge distance of the cap plate.

This option is used only when the plate width
on the Parts tab is empty.

0 mm

4 Horizontal offset of the cap plate.

This option is used only when the plate
height on the Parts tab has a value.

0 mm

5 Vertical edge distance of the cap plate.

This option is used only when the plate
height on the Parts tab is empty.

10 mm

6 Vertical offset of the cap plate.

This option is used only when the plate
height on the Parts tab has a value.

0 mm
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Rectangular cap plate chamfers

You can define the chamfers for each corner of the cap plate.

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex arc chamfer

The default values of convex arc
chamfers in cap plates with an RHS
and SHS profile are as follows:

• If you define the width and the
height of a cap plate, the chamfer
radius value of the profile is used.

• If the profile chamfer radius is
equal or smaller than 5 mm, then
a 0 mm value is applied.

• If you define the cap plate edge
distances, an absolute value of the
difference between the profile
chamfer radius and the highest
value of all edge distances is used.

Concave arc chamfer

Circular cap plate dimensions
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 Description
1 Cap plate edge distance.

Parts tab
Use the Parts tab to control the properties of the cap plate.

Part

Part Description Default
Cap plate Thickness, width, and

height of the cap plate.
Thickness = 1.5*(profile
web or plate thickness)

Width = profile width or
profile diameter or
height (option 'h'), first
one that is not 0.

Height = profile height or
profile diameter or 200
mm, first one that is not
0.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

General tab

Click the link below to find out more:

General tab

Steel components 1116 Welded connections



Welds

Click the link below to find out more:

Pipe doubler plate
Pipe doubler plate creates a doubler plate between the main part and the
secondary part. The main part has to be a round profile.

Objects created

• Doubler plate

• Welds

Use for

Situation Description
Rectangular doubler plate connecting
a column and a beam.

Circular doubler plate connecting a
column and a beam.

The secondary part is skewed.
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Situation Description
Rectangular doubler plate connecting
a column and a beam.

The secondary part is off-axis.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Doubler plate

Picture tab
Use the Picture tab to control the type, position, and dimensions of the
doubler plate.
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Doubler plate type

Option Description
Select the doubler plate type:

• Rectangular

• Circular

Clearance type

Option Description
Default

Clearance between the doubler plate
and the secondary part.

AutoDefaults can change this option.
Clearance between the doubler plate
and the secondary part.

Clearance between the main part and
the secondary part.
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Clearance dimension

Description
1 Clearance between the doubler plate and the secondary part.
2 Clearance between the main part and the secondary part.

Cut clearance

Description
1 Cut clearance between the doubler plate and the secondary part.

Rectangular doubler plate dimensions
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Description Default
1 Offset between the column and the

doubler plate.
0 mm

2 Measuring type for the doubler plate:

• Angle (degrees)

Define the angle of the doubler plate
in degrees.

• Dimension

Define the arc length of the doubler
plate.

• Edge

Define the arc length of the doubler
plate edge.

Angle

3 Angle of the doubler plate.

The angle can be extended up to 360
degrees to go around the main part.

Angle +10 degrees

4 Dimension value of the doubler plate.

The dimension can be extended up to
360 degrees to go around the main part.

length equivalent
to the formula
angle +10 degrees

5 Edge value of the doubler plate.

The edge value can be extended up to
360 degrees to go around the main part.

length equivalent
to the formula
angle +10 degrees

Corner rounding dimension for rectangular plate
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Description
1 Corner rounding dimension for a rectangular doubler plate.

Corners are not created with value 0.

Doubler plate extension for rectangular plate

Description
1 Vertical dimension from the secondary part top edge to doubler plate

top edge.
2 Vertical dimension from the secondary part bottom edge to the

doubler plate bottom edge.

Circular doubler plate dimensions

Description
1 Offset between the column and the doubler plate.
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Circular doubler plate diameter

Description
1 Diameter of the circular doubler plate.

Parts tab
Use the Parts tab to control the position of the doubler plate.

Part

Part Description
Doubler plate Thickness of the doubler plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Ring plate
Ring plate creates a ring plate. The ring plate can be circular, elliptical, or
angular. Ring plate creates welds between the column and the ring plate.

Objects created

• Ring plate

• Welds

Use for

Situation Description
Circular ring plate on a tube column.

Angular ring plate on a tube column.
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Selection order

1. Select the main part (column).

2. Pick a position for the connection.

The connection is created automatically when the position is picked.

Part identification key

 Part
1 Ring plate

Picture tab
Use the Picture tab to control the shape and the dimensions of the ring plate
in the Ring plate connection.

Ring plate type

Option Description Default
Ring plate Select the ring plate

type:

• Default

• Circular

• Elliptical

• Angular

Circular

Ring plate measuring type

Option Description Default
Ring plate measuring
type

Select how the ring plate
dimension is measured:

• Default

• Plate dimension

Plate dimension
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Option Description Default
• Plate absolute

dimension

Cut direction

Option Description
Default

The cut is created along the main
part.

AutoDefaults can change this option.

The cut is created along the main
part.

The cut is created perpendicular on
the plate.

Ring plate offset dimensions

Description
1 Ring plate offset from the picked point.
2 Ring plate clearance from the outer edge of the main part.
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Ring plate offset measuring

Option Description
Default

The offset dimension is measured
from the center line of the ring plate.

AutoDefaults can change this option.
The offset dimension is measured
from the center line of the ring plate.
The offset dimension is measured
from the bottom edge of the ring
plate.
The dimension is measured from the
top edge of the ring plate.

Create assembly

Option Description Default
Create assembly Define how the parts are

included in an assembly:

• Default

• Yes - All parts are in
one single assembly.

• No - Parts are not
included in one
single assembly.

Yes

Circular ring plate dimensions
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 Description Default
1 Plate dimension

Define the minimum width of the ring
plate.

200mm

Description Default
1 Plate absolute dimension

Define the absolute width of the ring
plate from the center point.

Minimum width +
clearance + part
height/2

Elliptical ring plate dimensions

Description Default
1 Ring plate vertical width. 200mm
2 Ring plate horizontal width. 200mm
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Description Default
1 Absolute vertical width of the ring plate

from the center point.
Vertical width +
clearance + part
height/2

2 Absolute horizontal width of the ring plate
from the center point.

Horizontal width +
clearance + part
height/2

Angular ring plate dimensions

You can define the radius for each corner.
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Description Default
1 Horizontal distance between corner radius

R1 and the picked point.
150mm

2 Horizontal distance between corner radius
R2 and the picked point.

150mm

3 Vertical distance between the plate top
outer edge and the plate inner edge.

200mm

4 Horizontal distance between the plate
right side edge and the plate inner center.

200mm

5 Vertical distance between corner radius R3
and the picked point.

150mm

6 Horizontal distance between corner radius
R4 and the picked point.

150mm

7 Vertical distance between the plate
bottom outer edge and the plate inner
center.

200mm

8 Horizontal distance between corner radius
R5 and the picked point.

150mm

9 Horizontal distance between corner radius
R6 and the picked point.

150mm

10 Horizontal distance between the plate left
side edge and the plate inner edge.

200mm

11 Vertical distance between corner radius R7
and the picked point.

150mm

12 Vertical distance between corner radius R8
and the picked point.

150mm
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Description Default
1 Horizontal distance between corner

radius R1 and the picked point.
150mm

2 Horizontal distance between corner
radius R2 and the picked point.

150mm

3 Absolute vertical distance between the
plate top outer edge and the center point.

Vertical width +
clearance + part
height/2

4 Absolute horizontal distance between the
plate right side edge and the center point.

Horizontal width +
clearance + part
height/2

5 Vertical distance between corner radius
R3 and the picked point.

150mm

6 Horizontal distance between corner
radius R4 and the picked point.

150mm

7 Absolute vertical distance between the
plate bottom outer edge and the center
point.

Vertical width +
clearance + part
height/2

8 Horizontal distance between corner
radius R5 and the picked point.

150mm

9 Horizontal distance between corner
radius R6 and the picked point.

150mm

10 Absolute horizontal distance between the
plate left side edge and the center point.

Horizontal width +
clearance + part
height/2
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Description Default
11 Vertical distance between corner radius

R7 and the picked point.
150mm

12 Vertical distance between corner radius
R8 and the picked point.

150mm

Corner shape

Option Description
Default

Two radius dimensions

AutoDefaults can change this option.

Two radius dimensions

One radius dimension

Ring plate

Option (circular) Option
(elliptical)

Option (angular) Description

Default

One ring plate

AutoDefaults can
change this
option.
One ring plate

Two half ring
plates
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Option (circular) Option
(elliptical)

Option (angular) Description

Four quarter ring
plates

Parts tab
Use the Parts tab to control the properties of the ring plate.

Part

Part Description Default
Ring plate Thickness of the ring

plate.
10mm

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Chamfers tab
Use the Chamfers tab to control the chamfer properties of the ring plate.

Chamfer dimensions

For circular and elliptical ring plates, chamfering is created uniformly around
the outer perimeter of the ring plate. For angular ring plates, chamfers are
created in each corner.
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 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

General tab

Click the link below to find out more:

General tab

Welds

Click the link below to find out more:

2.8 Seated connections
This section introduces components that can be used in seated connections.

• Stiffener seating (12) (page 1134)

• Seating with nail (36) (page 1144)

• Seating (39) (page 1152)

• U.S. Seat connection (72) (page 1165)

• U.S. Seat connection 2 (73) (page 1179)

• U.S. Seat connection 3 (74) (page 1192)

• U.S. Seat connection 4 (75) (page 1207)

• Angle profile box (170) (page 1217)
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Stiffener seating (12)
Stiffener seating (12) connects a beam to a column with a stiffener that is
welded between the column flanges and bolted to the lower flange of the
beam. The beam collides with the column web. The connection also cuts the
beam flanges and optionally creates an end plate to the secondary part and a
seat under the secondary part.

Objects created

• Stiffener

• Seat

• End plate

• Bolts

• Welds

Use for

Situation Description
Beam connected to a column with a
stiffener

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Stiffener
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Picture tab
Use the Picture tab to define the connection dimensions.

Dimensions

 Description Default
1 Clearance distance between the column and beam 5 mm
2 Clearance distance between the column and

stiffener
0

 Description Default
1 Gap between the stiffener and the column flanges 0

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description
Stiffener Thickness of the stiffener
Seat Thickness, width, and height of the

stiffener
End plate Thickness of the stiffener

Steel components 1136 Seated connections



Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the end plate dimensions and stiffener
chamfering.

End plate dimensions

 Description
1 End plate horizontal edge distance from the secondary part
2 End plate vertical edge distance from the secondary part upper

edge
3 End plate vertical edge distance from the secondary part lower

edge
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Chamfer dimensions

 Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer
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Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
2 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.
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 Description
• Middle: From the center line of the bolts to the center line of

the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

3 Select how to measure the dimensions for horizontal bolt group
position.

• Left: From the left edge of the secondary part to the leftmost
bolt.
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 Description
• Middle: From the center line of the secondary part to the

center line of the bolts.

• Right: From the right edge of the secondary part to the
rightmost bolt.

4 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

5 Number of bolts.
6 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Steel components 1142 Seated connections



Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3
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Option Description
Staggered type 4

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Seating with nail (36)
Seating with nail (36) connects two beams that cross, but do not collide with
each other, or have a gap greater than 50 mm. Horizontal angles between the
profiles can vary. The beams are in parallel planes.

Objects created

• Shim plate

• Bolts

Use for

Situation Description
Beams are connected with a bolted
shim plate.
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Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Shim plate

Picture tab
Use the Picture tab to define the shim plate connection length.

Connection length

 Description
1 Shim plate connection length on the secondary part

Width is calculated based on the bolt group edge distances.

Parts tab
Use the Parts tab to define the part properties.
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Parts

Option Description
Spacer plate Thickness of the shim plate

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the secondary part end cut.

Secondary part cut

 Description
1 Secondary beam cut dimension from the main part center line

If the overshoot is initially longer than the entered value,
nothing is done to the secondary beam. If the entered value is
greater than initial overshoot, the secondary beam will be
stretched and fitted.
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Bolts tab
Use the Bolts tab to define the bolt group dimensions and the bolt properties.

Dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Select how to measure the dimensions for horizontal bolt

group position.

• Left: From the left edge of the secondary part to the
leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the

center line of the bolts.

• Right: From the right edge of the secondary part to the
rightmost bolt.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

6 Dimension for vertical bolt group position.

Steel components 1148 Seated connections



 Description
7 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line
of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Steel components 1150 Seated connections



Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3
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Option Description
Staggered type 4

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Seating (39)
Seating (39) connects a column head to one or two beams using an end plate.
The end plate is welded to the column head and bolted to the lower flange of
the secondary part.

Objects created

• End plate

• Stiffeners

• Bolts

• Washer plates (optional)

Steel components 1152 Seated connections



Use for

Situation Description
Seating connection with end plate and
stiffeners.

Selection order

1. Select the main part (column).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.

Picture tab
Use the Picture tab to control the end plate and stiffener size and position.

 Description
1 Distance between the first and the second secondary part.
2 Distance between the end plate the secondary parts.
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 Description
3 End plate distance from the main part edge.

Positive values move end plate edges closer to the column axis and
thus decrease the plate size. Negative values increase the plate size.

The default value is 10 mm.
4 A gap between stiffener plates and secondary beam flange. The default

value is 0 mm.
5 Position of the stiffeners.

By default, stiffeners are placed to the same plane as column flanges.
Positive offset values move stiffeners to the right and negative to the
left.

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Square

AutoDefaults can change this option.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.

Parts tab
Use the Parts tab to control the end plate, stiffener and washer plate
properties.

Define the end plate, stiffener and washer plate thickness, width and height.

Option Description
End plate By default, width is defined by the bolt group horizontal edge

distances, and height is defined by the plate edge distances
from the left and right edge of the column.

The default value for end plate thickness is 0.5*the screw
diameter.
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Option Description
Stiffeners By default, height is equal to the distance between secondary

beam flanges.

If width is not given, stiffener width is defined based on the
flange width. The default value for the stiffener thickness is
1.5*secondary beam web thickness rounded upwards
to: 8, 10, 12, 16, 20, 25, 30, 35, 40, 45, and so on.

Washer
plates

Washer plates are small rectangular plates used as washers
between the bolt head and the secondary beam flange.

If no thickness is defined, plates are not created.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Parameters tab
Use the Parameters tab to control the chamfer dimensions, and type and the
end plate and stiffener orientation.
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 Description
1 Chamfer type and dimensions.

If you select the No chamfer  option, a clash can occur between the
stiffener and the I-profile rounding.

Additionally, you can define the chamfer dimensions vertically and
horizontally. If you select an arc chamfer, the horizontal dimension is the
radius, and the vertical dimension has no effect.

2 Select whether stiffeners are perpendicular or parallel to the secondary
beam flange.

3 Gap size to end plate.

Define the limit value for the gap between the end plate and the
secondary or main part. Use this gap when the beam is slightly curved
or sloped to decide if the end angle is so small that the beam end can be
straight.
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 Description
If the actual gap is smaller than this value, the beam end is left straight.

If the actual gap is larger than this value, the beam end is fitted to the
end plate.

4 Select the end plate orientation.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions

  
1 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

2 Dimension for vertical bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Dimension for horizontal bolt group position.
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7 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.

• Middle: From the center line of the secondary part to the center line
of the bolts.
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• Right: From the right edge of the secondary part to the rightmost

bolt.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Holes tab
Use the Holes tab to control the galvanizing holes in the end plate.

Option Description
Bolt standard Select the bolt standard.
Bolt type Select the bolt type to define the

location where the bolts should be
attached.

Read data from You can select to use the
sinkholes.dat definition file to
specify the default values for
horizontal and vertical offsets, and
the diameters for upper and lower
holes.

The file is searched in the following
order: Environment common system
steel folder (..\Environments
\common\system\Steel), model
folder, XS_FIRM, XS_PROJECT and 
XS_SYSTEM folder.

You can also select to define the holes
in the component dialog box.

Steel components 1162 Seated connections



Number of holes

The center of a hole group is the middle point of the beam and the middle
point of the haunch, if the haunch exists. The hole groups are composed of 0,
1, 2 or 4 holes.

Option Description
Default

No holes

AutoDefaults can change this option.

No holes

1 hole

2 holes

4 holes
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Hole positions

 Description
1 Horizontal distance between the secondary beam center

and the upper hole.
2 Horizontal distance between the secondary beam center

and the lower hole.
3 Vertical distance between the secondary beam center and

the upper hole.
4 Vertical distance between the secondary beam center and

the lower hole.
5 Diameter of the lower hole.
6 Diameter of the upper hole.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab
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Welds

Click the link below to find out more:

U.S. Seat connection (72)
U.S. Seat connection (72) connects a beam to a column with a seat profile.
You can use the connection with rotated and skewed beams and columns. A
stabilizer can be placed as an additional connecting part between the beam
and the column.

Objects created

• Stiffeners

• Seat profile

• Stabilizer

• Bolts

• Welds

Use for

Option Description
Beam connected to a column with a
seat profile

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key
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 Description
1 Seat profile

Picture tab
Use the Picture tab to define the connection dimensions.

Dimensions

 Description
1 Horizontal seat profile offset
2 Length of the seat

 Description
1 Secondary part offset from the main part
2 Seat offset from the main part

Parts tab
Use the Parts tab to define the part properties.
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Parts

Option Description Default
Stiffeners Thickness, width, and

height of the stiffeners
The default values for
the height and width are
based on the seat profile
dimensions.

The default stiffener
thickness is ¼” or 6 mm
depending on whether
metric or imperial units
are used in the model.

Seat profile Select the profile from
the profile catalog.

The default seat profile
for straight beams is a
6”x 4”x ½” angle. For
vertically skewed beams
the default seat profile is
a WT6X15 tee.

With straight beams, the
seat is placed along a
line that is perpendicular
to the beam.

With vertically skewed
beams, the seat is
placed along a line that
is parallel to the beam.

Note that with vertically
skewed beams the seat
is always welded to the
column, as there there is
not enough seat surface
parallel to the column
for bolting.

Stabilizer profile Select the profile from
the profile catalog.

Stabilizer is not created
unless you select a
profile.

 

Steel components 1167 Seated connections



Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the seat fitting, position and orientation,
and stiffener position, shape, and chamfering.

Seat notching and fitting

Option Description
Seat notching and fitting Select how the seat is notched and

fitted to the column.

• Notch and fit: The beam is
notched and fitted to the column.
This is the default value.

• Notch only: The beam is notched
but not fitted.

• Fit only: The beam is fitted to the
column.

• Do not notch or fit: Beam is not
notched or fitted.

Stiffener positions

Option Description
Default

Stiffener is not placed on the seat.

AutoDefaults can change this option.
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Option Description
Stiffener is not placed on the seat.

Stiffener is placed on the right side.

Stiffener is placed in the middle.

Stiffener is placed on the left side.

Stiffener shape

Option Description
Default

Rectangular stiffener

AutoDefaults can change this option.
Rectangular stiffener

Triangular stiffener

Stiffener offsets

 Description
1 Offset of the end stiffeners from the seat ends
2 Offset of the middle stiffener from the seat center line

Stiffener chamfer dimensions

 Description
1 Horizontal chamfer dimension
2 Vertical chamfer dimension
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Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.
Line chamfer

Convex chamfer

Concave chamfer

Beam end cut

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.
Square

Cuts the end of the secondary beam
square.

Beam fitting

Option Description
Default

Beam is notched.

AutoDefaults can change this option.
Beam is notched. Beam end is cut.

Beam is notched. Beam end is not
cut.
Beam is not fitted to the column.

Beam is fitted to the column.
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Seat position

Option Description
Default

Seat is placed at the bottom of the
beam.

AutoDefaults can change this option.
Seat is placed at the bottom of the
beam.

Seat is placed at the top of the beam.

Seat is placed both at the top and at
the bottom of the beam.

Seat orientation

Define the seat orientation. For example, if the seat is an angle with uneven
legs, the default option for non-vertically skewed beams places the longest leg
of the angle parallel with the beam, and the shortest leg parallel with the
column.

Option Description
Default

Standard seat, not rotated

AutoDefaults can change this option.
Standard seat, not rotated

Seat is rotated.
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Seat to beam

Option Description
Default

Seat is bolted to the beam.

Seat is bolted to the beam.

Seat is welded to the beam.

Seat to column

Option Description
Default

Seat is welded to the column.

AutoDefaults can change this option.
Seat is welded to the column.

Seat is bolted to the column.

Bolts tab
Use the Bolts tab to define bolt group dimensions and bolt properties.

Bolt group dimensions
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 Description
1 Dimension for vertical bolt group position.
2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes
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Option Description Default
Site/Workshop Location where the bolts

should be attached.
Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.
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Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Stabilizer tab
Use the Stabilizer tab to define the stabilizer fitting, position, and orientation.

Stabilizer notching and fitting

Option Description
Stabillizer notching and fitting Select how the stabilizer is notched

and fitted to the column:

• Notch and fit: The stabilizer is
notched and fitted to the column.
This is the default value.

• Notch only: The stabilizer is
notched but not fitted to the
column.

• Fit only: The stabilizer is fitted to
the column.

• Do not notch or fit: The stabilizer
is not notched or fitted.

Stabilizer position

Note that the stabilizer cannot be placed in the same position as the seat.

Option Description
Default

Stabilizer is placed on the left side of
the beam.

AutoDefaults can change this option.
Stabilizer is placed on the left side of
the beam.
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Option Description
Stabilizer is placed on the right side of
the beam.

Stabilizer is placed at the top of the
beam.

Stabilizer is placed at the bottom of
the beam.

Stabilizer orientation

Define the orientation of the stabilizer. For example, if the stabilizer is an angle
with uneven legs, the standard option for non-vertically skewed beams places
the longest leg of the angle parallel with the beam, and the shortest leg
parallel with the column. Selecting the rotated option reverses this.

Option Description
Default

Standard

AutoDefaults can change this option.
Standard

Rotated
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Stabilizer dimensions

 Description
1 Stabilizer offset in the direction perpendicular to the beam

By default, there is no offset.
2 Stabilizer offset from the column

By default, there is no offset.
3 Stabilizer length

Stabilizer to beam

Option Description
Default

Stabilizer is welded to the beam.

AutoDefaults can change this option.
Stabilizer is bolted to the beam.

Stabilizer is welded to the beam.

Stabilizer to column

Note that if the column has a tube steel profile, this setting is not taken into
account and the stabilizer will be welded to the column.

Option Description
Default

Stabilizer is welded to the column.

AutoDefaults can change this option.
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Option Description
Stabilizer is welded to the column.

Stabilizer is bolted to the column.

Stabilizer bolts tab
Use the Stabilizer bolts tab to define the bolt group dimensions and the bolt
location and diameter. Define the rest of the bolt properties on the Bolts tab.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
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 Description
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

U.S. Seat connection 2 (73)
U.S. Seat connection 2 (73) connects a beam to a column. The seat profile is
always placed along a line that is parallel to the beam. You can use the
connection with rotated and skewed beams and columns. A stabilizer can be
placed as an additional connecting part between the beam and the column.

Objects created

• Seat profile

• Stiffeners

• Stabilizer

• Bolts

• Welds
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Use for

Situation Description
Beam connected to a column with a
seat profile

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Seat profile

Picture tab
Use the Picture tab to define the offset dimensions of the connection.

Offset dimensions
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 Description
1 Secondary part offset from the main part
2 Length of the seat
3 Seat offset from the main part

 Description
1 Seat offset from the center of the connection

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
Stiffeners Thickness, width, and

height of the stiffeners
The default values for
the height and width are
based on the seat profile
dimensions.

The default stiffener
thickness is ¼” or 6 mm
depending on whether
metric or imperial units
are used in the model.

Stiffeners can only be
placed in the connection
if an angle profile is used
for the seat.

Seat profile Select the profile from
the profile catalog.

 

Stabilizer profile Select the profile from
the profile catalog.

Stabilizer is not created
unless you select a
profile.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the seat fitting, position and orientation,
and stiffener position, shape, and chamfering.

Seat notching and fitting

Option Description
Seat notching and fitting Select how the seat is notched and

fitted to the column.

• Notch and fit: The beam is
notched and fitted to the column.
This is the default value.

• Notch only: The beam is notched
but not fitted.

• Fit only: The beam is fitted to the
column.

• Do not notch or fit: Beam is not
notched or fitted.

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.
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Option Description
Default

Square

AutoDefaults can change this option.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.

Seat position

Option Description
Default

Seat is placed at the bottom of the
beam.

AutoDefaults can change this option.
Seat is placed at the bottom of the
beam.

Seat is placed at the top of the beam.

Seat is placed at both the top and
bottom of the beam.

Beam fitting

Option Description
Default

Beam is notched.

AutoDefaults can change this option.
Beam is notched. Beam end is cut.

Beam is notched. Beam end is not
cut.
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Option Description
Beam is not fitted to the column.

Beam is fitted to the column.

Seat orientation

Option Description
Default

Standard seat, not rotated

AutoDefaults can change this option.
Standard seat, not rotated

Seat is rotated.

Seat to beam

Option Description
Default

Seat is bolted to the beam.

AutoDefaults can change this option.
Seat is bolted to the beam.

Seat is welded to the beam.

Stiffener positions

Option Description
Default

Stiffeners are not placed on the seat.

AutoDefaults can change this option.
Stiffeners are not placed on the seat.

Stiffener is placed on the left side.
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Option Description
Stiffener is placed in the middle.

Stiffener is placed on the right side.

Stiffener shape

Option Description
Default

Rectangular stiffener

AutoDefaults can change this option.
Rectangular stiffener

Triangular stiffener

Stiffener offsets

 Description
1 Offset of the end stiffeners from the seat ends
2 Offset of the middle stiffener from the seat center line

Stiffener chamfer dimensions

 Description
1 Horizontal chamfer dimension
2 Vertical chamfer dimension
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Chamfer type

Option Description
Default

LIne chamfer

AutoDefaults can change this option.
Line chamfer

Convex chamfer

Concave chamfer

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position from the main

part center line
2 Dimension for horizontal bolt group position for the secondary

part
3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

5 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Steel components 1187 Seated connections



Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Stabilizer tab
Use the Stabilizer tab to define the stabilizer fitting, position, and orientation.

Stabilizer notching and fitting

Option Description
Stabilizer notching and fitting Select how the stabilizer is notched

and fitted to the column:

• Notch and fit: The stabilizer is
notched and fitted to the column.
This is the default value.

• Notch only: The stabilizer is
notched but not fitted to the
column.

• Fit only: The stabilizer is fitted to
the column.

Steel components 1188 Seated connections



Option Description
• Do not notch or fit: The stabilizer

is not notched or fitted.

Stabilizer position

Note that the stabilizer cannot be placed in the same position as the seat.

Option Description
Default

Stabilizer is placed on the left side of
the beam.

AutoDefaults can change this option.
Stabilizer is placed on the left side of
the beam.

Stabilizer is placed on the right side of
the beam.

Stabilizer is placed at the top of the
beam.

Stabilizer is placed at the bottom of
the beam.

Stabilizer orientation

Define the orientation of the stabilizer. For example, if the stabilizer is an angle
with uneven legs, the standard option for non-vertically skewed beams places
the longest leg of the angle parallel with the beam, and the shortest leg
parallel with the column. Selecting the rotated option reverses this.
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Option Description
Default

Standard

AutoDefaults can change this option.
Standard

Rotated

Stabilizer dimensions

 Description
1 Stabilizer offset in the direction perpendicular to the beam

By default, there is no offset.
2 Stabilizer offset from the column

By default, there is no offset.
3 Stabilizer length

Stabilizer to beam

Option Description
Default

Stabilizer is welded to the beam.

AutoDefaults can change this option.
Stabilizer is bolted to the beam.

Stabilizer is welded to the beam.
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Stabilizer to column

Note that if the column has a tube steel profile, this setting is not taken into
account and the stabilizer will be welded to the column.

Option Description
Default

Stabilizer is welded to the column.

AutoDefaults can change this option.
Stabilizer is welded to the column.

Stabilizer is bolted to the column.

Stabilizer bolts tab
Use the Stabilizer bolts tab to define the bolt group dimensions and the bolt
location and diameter. Define the rest of the bolt properties on the Bolts tab.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
2 Dimension for horizontal bolt group position.
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 Description
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

U.S. Seat connection 3 (74)
U.S. Seat connection 3 (74) connects two beams to a column when the beams
are offset from the column center line. The seat is always placed perpendicular
to the beams. You can use the connection with rotated and skewed beams and
columns. The seat can be bolted or welded to the beam, but it is always
welded to the column.

Objects created

• Seat profile

• Stiffeners
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• Bolts

• Welds

Use for

Situation Description
Seat profile welded to a column and
bolted to two beams.

Selection order

1. Select the main part (column).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.

Part identification key

 Description
1 Seat profile

Picture tab
Use the Picture tab to define the offset dimensions of the connection.
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Offset dimensions

 Description
1 Offset of the beams from the starting point of the connection
2 Offset of the seat from the beams
3 Offset of the seat from the center of the connection

 Description
1 Length of the seat

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
Stiffeners Thickness, width and height

of the stiffeners.

The stiffener height is in the
same direction as the
column.

The default values for
the height and width
are based on the seat
profile dimensions.
The default stiffener
thickness is ¼” or 6
mm depending on
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Option Description Default
whether metric or
imperial units are
used in the model.

Stiffeners can only be
placed if an angle
profile is used for the
seat.

Seat profile Select the profile from the
profile catalog.

WT6X15 tee

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define seat position and orientation, and stiffener
position, shape, and chamfering.

Option Description
Seat notching and fitting Select how the seat is notched and

fitted to the column.
Cut tolerance of sec Define a cut tolerance of the

secondary part.
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Seat position

Option Description
Default

Seat is placed at the bottom of the
beam.

AutoDefaults can change this option.
Seat is placed at the bottom of the
beam.

Seat is placed at the top of the beam.

Seat is placed at both the top and
bottom of the beam.

Seat to beam

Option Description
Default

Seat is bolted to the beam.

AutoDefaults can change this option.
Seat is bolted to the beam.

Seat is welded to the beam.

Seat orientation

Option Description
Default

Standard seat, not rotated.

AutoDefaults can change this option.
Standard seat, not rotated.
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Option Description
Seat is rotated.

If the seat is an angle with uneven legs, the standard option places the
shortest leg of the angle against the beam. Selecting rotated reverses this.

Beam fitting

Option Description
Default

Beam is not fitted to the column.

AutoDefaults can change this option.
Beam is not fitted to the column.

Beam is fitted to the column.

Stiffener shape

Stiffeners are only created if an angle profile is used for the seat.

Option Description
Default

Rectangular stiffener

AutoDefaults can change this option.
Rectangular stiffener

Triangular stiffener

Stiffener chamfer dimensions
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 Description
1 Horizontal chamfer dimension
2 Vertical chamfer dimension

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.
Line chamfer

Convex chamfer

Concave chamfer

Stiffener positions

Option Description
Default

Stiffeners are not placed on the seat.

AutoDefaults can change this option.
Stiffeners are not placed on the seat.

Stiffener is placed on the right side.

Stiffener is placed in the middle.

Stiffener is placed on the left side.

Stiffener offsets
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 Description
1 Offset of the end stiffeners from the seat ends.
2 Offset of the center stiffener from the center line of the seat.

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt

group position.

• Left: From the left edge of the secondary part to the
leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the

center line of the bolts.

• Right: From the right edge of the secondary part to the
rightmost bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.
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 Description
6 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line
of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

7 Dimension for vertical bolt group position.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
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Option Description
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.
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Option Description
Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
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Option Description
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.

Flange notch depth

Define the flange notch depth.

Steel components 1206 Seated connections



Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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U.S. Seat connection 4 (75)
U.S. Seat connection 4 (75) connects two beams to a column. The seat is
always formed along a line that is parallel to the face of the column nearest to
the first beam selected. You can use the connection with rotated and skewed
beams and columns. The seat can be bolted or welded to the beams and the
column.

Objects created

• Seat profile

• Stiffeners

• Bolts

• Welds

Use for

Option Description
Beams connected to a column

Selection order

1. Select the main part (column).

2. Select the first secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.

Part identification key

 Description
1 Seat profile

Picture tab
Use the Picture tab to define the connection dimensions.
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Dimensions

 Description
1 Seat profile offset from the column
2 Seat profile vertical offset from the beams
3 Beam offset from the connection origin

 Description
1 Horizontal seat profile offset
2 Seat profile length

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
Stiffeners Thickness, width, and

height of the stiffeners

Stiffeners can only be
placed in the connection

The default values for
the height and width are
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Option Description Default
if an angle profile is used
for the seat.

based on the seat profile
dimensions.

The default stiffener
thickness is ¼” or 6 mm
depending on whether
metric or imperial units
are used in the model.

Seat profile Select the profile from
the profile catalog.

You can select any
profile from the catalog.

 

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the seat fitting, position and orientation,
and the stiffener position, shape, and chamfering.

Stiffener positions

Option Description
Default

Stiffeners are not placed on the seat.

AutoDefaults can change this option.
Stiffeners are not placed on the seat.
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Option Description
Stiffener is placed on the right side.

Stiffener is placed in the middle.

Stiffener is placed on the left side.

Stiffener shape

Option Description
Default

Rectangular stiffener

AutoDefaults can change this option.
Rectangular stiffener

Triangular stiffener

Stiffener offsets

 Description
1 Offset of the end stiffeners from the seat ends
2 Offset of the middle stiffener from the seat center line

Stiffener chamfer dimensions

 Description
1 Horizontal chamfer dimension
2 Vertical chamfer dimension
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Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.
Line chamfer

Convex chamfer

Concave chamfer

Seat orientation

Define the seat orientation. For example, if the seat is an angle with uneven
legs, the default option for non-vertically skewed beams places the longest leg
of the angle parallel with the beam, and the shortest leg parallel with the
column.

Option Description
Default

Longer leg is horizontal.

AutoDefaults can change this option.
Longer leg is horizontal.

Longer leg is vertical.

Beam fitting

Option Description
Default

Beam is not fitted to the column.

AutoDefaults can change this option.
Beam is not fitted to the column.

Beam is fitted to the column.
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Seat position

Option Description
Default

Seat is placed at the bottom of the
beam.

AutoDefaults can change this option.
Seat is placed at the bottom of the
beam.

Seat is placed at the top of the beam.

Seat is placed both at the top and at
the bottom of the beam.

Seat to beam

Option Description
Default

Seat is bolted to the beam.

AutoDefaults can change this option.
Seat is bolted to the beam.

Seat is welded to the beam.

Seat to column

Option Description
Default

Seat is welded to the column.

AutoDefaults can change this option.
Seat is welded to the column.
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Option Description
Seat is bolted to the column.

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Steel components 1216 Seated connections



Welds

Click the link below to find out more:

Angle profile box (170)
Angle profile box (170) connects a beam to a column with a seat angle. The
angles can be placed at the top or bottom, or at both top and bottom flange of
the secondary beam. Stiffener plates can be welded to the seat angles. Web
stiffening plates can also be added to the secondary beam.

Objects created

• Clip angles (1 or 2)

• Seat stiffeners (optional)

• Web stiffeners (optional)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Beam seat with
stiffeners.
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Situation Description
Beam seat top and
bottom with stiffeners.
Various bolting options.

Beam seat. Multiple
stiffener options.

Beam seat. Offset
secondary member.
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Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Clip angle
2 Seat stiffener
3 Web stiffener
4 Bottom seat plate

Picture tab
Use the Picture tab to control the clearances between the angles and the
main and secondary part.
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Dimensions

   
1 Gap between the main part and the

secondary part.
GENERAL / beamedge
(0.5”) 
20 mm

2 Gap between angle profile and the main part. 0
3 Gap between angle profile and the secondary

part.
0

4 Distance of the secondary beam web stiffener
from the face of the main part.

 

NOTE This information is relevant only to the imperial environment.
GENERAL defaults can be found in the joints.def file in the system
folder and can be modified as required.
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Parts tab
Use Parts tab to define the stiffeners, clip angle or bottom plate.

Parts

Option Description
Upper stiffener

Lower stiffener

Stiffener thickness, width and height.

The default values for the height and width are
based on the selected profile or bottom plate
dimensions. The default stiffener thickness is 10
mm. The default value in the joints.def file is
GENERAL/shearplatethk (0.375”).

Bottom plate Enter values for thickness and width to create a
seat plate instead of a seat angle.

Profile Select the seat angle profile from the profile
catalog.

The default angle profile is L150*100*10 or
L4X4X3/8. The default value in the joints.def
file is GENERAL / lsize.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the seat angle positions. Seat angles carry
loads from the secondary part. Seat angles can be positioned to top, bottom
or both flanges of the secondary part. The seat angle can be stiffened, and
bolted or welded to the main and secondary parts.
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Notching

When you create the connection to the main part web, the secondary beam
can be fitted to the web and notched by the main part flanges.

Option Description
Default

Fitted and notched

AutoDefaults can change this option.
Fitted and notched

The secondary part is fitted and
notched.
Fitted

The secondary part is fitted, but not
notched.
Notched

The secondary part is notched, but
not fitted.
None

The secondary part is not fitted or
notched.

Seat position

Option Description
Default

Bottom

AutoDefaults can change this option.

Top

Creates a seat at the top of the
secondary part.

Bottom

Creates a seat at the bottom of the
secondary part.

Both

Creates two seats: one at the top and
another at the bottom of the
secondary part.
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Seat angle attachment

Seat angle is positioned at the top or at the bottom of the secondary part.

Option for top seat
angle

Option for bottom seat
angle

Description

Default

Bolted

Seat angle is bolted to
the main part and to the
secondary part.

AutoDefaults can change
this option.
Bolted

Seat angle is bolted to
the main part and to the
secondary part.

Welded-bolted

Seat angle is welded to
the main part and bolted
to the secondary part.

Bolted-welded

Seat angle is bolted to
the main part and
welded to the secondary
part.

Welded

Seat angle is welded to
the main part and to the
secondary part.

Seat angle offset
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 Description
1 Seat angle horizontal offset from the center line of the main

part.

Seat angle rotation

Option Description
Default

Seat angle is not rotated.

AutoDefaults can change this option.
Seat angle is not rotated.

Seat angle is rotated horizontally by
90 degrees.

To stiffen the rotated angle, select the
Middle option in the Middle
stiffener position list.
Uses a bottom plate as the seat
instead of the angle profile.

Seat angle orientation

Option Description
Default

The longer leg of the seat angle is
connected to the secondary part.

AutoDefaults can change this option.
The longer leg of the seat angle is
connected to the secondary part.

The longer leg of the seat angle is
connected to the main part.

Automatic

The longer leg of the seat angle is
connected to the part where bolts
reach furthest from the seat angle
corner.
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Stiffener type

Option Option Description
Default

Rectangular stiffener
plate

AutoDefaults can change
this option.
Rectangular stiffener
plate

Triangular stiffener plate

The line connecting the
ends of the seat angle
legs defines the stiffener
plate shape.

Side stiffener position

Option Description
Default

No side stiffeners are created.

AutoDefaults can change this option.
No side stiffeners are created.

Near side stiffeners are created.

Far side stiffeners are created.

Near side and far side stiffeners are
created.

Middle stiffener position

Option Description
Default

According to bolts

AutoDefaults can change this option.
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Option Description
No middle stiffener plate is created.

Middle stiffeners

The stiffener plate is positioned in the
middle of the seat angle.

Enter the number of middle stiffeners
in the Number of middle stiffeners
box.

Multiple stiffeners are centered and
equally spaced.
According to bolts

The stiffener plate is positioned
between the bolts in the middle of
the bolt spacing.

By default, stiffener is created
between every two bolts.

Enter the number of middle stiffeners
in the box below the According to
bolts option.

Chamfer dimensions
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 Description Default
1 Horizontal dimension of the stiffener plate

chamfer.
Equal to angle profile
rounding.

2 Vertical dimension of the stiffener plate
chamfer.

Equal to angle profile
rounding.

3 Vertical dimension of the stiffener plate
shape cut line.

 

4 Horizontal dimension of the stiffener plate
shape cut line.

 

Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Pbolts tab
Use the Pbolts tab to control the properties of the bolts connecting the clip
angle to the main part.
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 Description
1 Dimension for horizontal bolt group position.

The dimension is defined from the middle line of the
secondary beam.

2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

5 Dimension for vertical bolt group position.

The dimension is defined from the bottom of the secondary
beam.

6 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and
separate the numbers with a space. Bolt numbers run from
left to right and from top to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.
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Option Description Default
Bolt standard Bolt standard to be used

inside the component.
Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.
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Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Sbolts tab
Use the Sbolts tab to control the properties of the bolts connecting the clip
angle to the secondary part.
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 Description
1 Dimension for vertical bolt group position.

The dimension is defined from the middle line of the
secondary beam.

2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

5 Dimension for horizontal bolt group position.

The dimension is defined from the bottom of the
secondary beam.

6 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and
separate the numbers with a space. Bolt numbers run
from left to right and from top to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.
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Option Description Default
Thread in mat Defines whether the

thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

SBoltsDown tab
Use the SBoltsDown tab to control the properties of the bolts connecting the
bottom seat angle to the secondary part.

Secondary bolt group dimensions

 Description
1 Horizontal bolt group position from the end of the secondary beam.
2 Bolt edge distance.
3 Number of bolts.
4 Bolt spacing. Use a space to separate bolt spacing values. Enter a value

for each space between bolts. For example, if there are 3 bolts, enter 2
values.
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 Description
5 Vertical bolt group position. Reference point is from the bottom of the

secondary beam.
6 Deletes bolts from the bolt group. Enter the bolt numbers of the bolts

to delete, separated by a space. Bolt numbers run left to right and top
down.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

joints.def: 
GENERAL / boltdia
16 mm (0.75”)

Bolt standard The bolt standard to be
used inside the
component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance The gap between the
bolt and the hole.

 

Thread in mat Defines whether or not
the thread may be
within the bolted parts
when using bolts with a
shaft. This has no effect
when using full-threaded
bolts.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes with the following options.

Option Description Default
1 Slotted hole X dimension

or allowance for
oversized holes.

0, which results in a
round hole.

2 Slotted hole Y
dimension.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted

holes.

Oversized creates
oversized or tapped
holes.

 

Rotate Slots When the hole type is
Slotted, this option
rotates the slotted holes.

 

Slots in Member(s) in which
slotted holes are
created. The options
depend on the
component.

 

Staggering of bolts

Option Description
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Notch tab
Use the Notch tab to automatically create notches for the secondary beams
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.
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Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.
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Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
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Option Description
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.

Steel components 1238 Seated connections



Option Description
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
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Option Description
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Stiffeners tab
Use the Stiffeners tab to control the properties of the near side and far side
stiffeners created in the secondary part web.

Option Description
Stiffener NS

Stiffener FS

Stiffener thickness, width and height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Chamfer dimensions

 Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.

No chamfer
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Option Description
Line chamfer

Convex arc chamfer

Concave arc chamfer

Stiffener creation

Option Description
Default

Stiffeners are not created.

AutoDefaults can change this option.

Stiffeners are not created.

Stiffeners are created.
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Stiffener position

 Description
1 Stiffener edge distance from the main part flange.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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2.9 Opening connections
This section introduces components that can be used in steel openings.

Click the links below to find out more:

• Create hole around part (92) (page 1244)

• Rebar hole (page 1249)

• Notch (76) (page 1252)

Create hole around part (92)
Create hole around part (92) cuts a hole to a part using another part. The
part that cuts the hole is perpendicular to the part that is cut.

Objects created

• Cuts

Use for

Situation Description
Steel column creates a cut
through a plate.
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Situation Description
Concrete column creates a cut
through a plate.

Concrete column creates a cut
in a plate.

Selection order

1. Select the main part (column).

2. Select the secondary part.

The connection is created automatically when the secondary part is
selected.

Picture tab
Use the Picture tab to control the gap dimensions and whether the
dimensions are the same on both sides of the gap.

Gap side

Define whether the gap dimensions are the same on both sides of the gap.
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Option Description
Gap dimensions are the same on
both sides.

Gap dimensions are different on each
side.

Gap dimensions

 Description
1 Gap between the column and the secondary part in the vertical

direction.
2 Gap between the column and the secondary part in the horizontal

direction.
3 Gap between the column and the secondary part in the horizontal

direction.

To define this dimension, select the option that the gap is different on
each side.
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 Description
4 Gap between the column and the secondary part in the vertical

direction.

To define this dimension, select the option that the gap is different on
each side.

Part cut

Option Description
A cut is always created through the whole main
part.

Define the depth of the cut from the edge of the
secondary part.

Parameters tab
Use the Parameters tab to control the cut properties and type of the cut.

Cut properties

Option Description
Max. rectangle size Define the maximum size of a

rectangle cut.
Cut perpendicular to
main part

Define whether the cut is
perpendicular to the main
part.

This option works for
rectangular cuts.

Cut part name Define a name for the cut part.
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Cut type

Option Description
Default

Creates an exact or a rectangular cut.

AutoDefaults can change this option.

Rectangular

Creates a rectangular cut using the
coordinates of the cutting part edges.

Exact

Creates a cut along the edges of the cutting
part. The cutting part has to be perpendicular
to the part it cuts.

You can use this option for I, round and tube
profiles.

Automatic

This option selects the cut type depending on
the cut size defined in Max. rectangle size.

If the size of the cutting part is larger than the
size defined in Max. rectangle size, an exact
cut is created. Otherwise, a rectangular cut is
created.

General tab

Click the link below to find out more:

General tab
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Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Rebar hole
Rebar hole creates holes for reinforcing bars in a steel column, beam, or
contour plate.

Objects created

• Holes

• Cuts

Use for

Situation Description
Holes created for reinforcing bars in a
steel beam.

Selection order

1. Select the main part (column, beam, or contour plate).

2. Select the secondary part (reinforcing bar group).

3. Click the middle mouse button to create the holes for the reinforcing bars.
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Part identification key

 Part
1 Hole for reinforcing bar

Parameters tab
Use the Parameters tab to control the properties of the reinforcing bar holes.

Reinforcing bar hole properties

Option Description Default
Bolt standard Select the bolt standard:

• 6914

• 7968

• 7990

• ASS 1

• ASS 2

• UNDEFINED_BOLT

6914

Rounding type Select the rounding type:

• None

The rounding value is the
reinforcing bar diameter +
hole tolerance.

• Round off

The rounding value is the
nearest integer number
divisible by the rounding
precision value.

No default value

Example dimensions:

• Reinforcing bar
diameter = 21.6 mm

• Hole tolerance = 3
mm

• Rounding precision =
2 mm

• None, rounding =
24.6 mm
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Option Description Default
• Round up

The rounding value is the next
integer number divisible by
the rounding precision value.

• Round down

The rounding value is the
previous integer number
divisible by the rounding
precision value.

• Round by table

Define the reinforcing bar
diameter, hole diameter, and
the slotted hole extension.

• Round off, rounding
= 24 mm

• Round up, rounding
= 26 mm

• Round by own,
rounding = 24 mm

Hole tolerance Define the hole tolerance.

When you select Round by table
as the rounding type, you cannot
define the hole tolerance.

0 mm

Rounding
precision

Define the rounding precision.

When you select Round by table
as the rounding type, you cannot
define the rounding precision.

1 mm

Dimension table Define the reinforcing bar
diameter, hole diameter, and
slotted hole extension.

To define the dimensions in the
table, select the Round by table
option as the rounding type.

Rebar hole uses an existing bolt
size and adjusts the hole
tolerance value until the desired
Hole diameter is reached.

Use the + and the - buttons to
add and delete rows from the
table.

 

Advanced tab
Use the Advanced tab to control the hole type, vertical offset, and angle range
dimension.

Steel components 1251 Opening connections



Hole type

Option Description Default
Hole type Select the hole type:

• Bolt hole

• Part cut

• Bolt hole + part cut

Bolt hole

Vertical offset

Option Description
Default

The hole is not offset.
The hole is offset upward to directly
support the reinforcing bar to keep
the bar in the correct vertical position.

The hole can be offset if the hole is a
circular hole.

Angle range dimension

 Description Default
1 Angle range dimension.

A round hole is created within the defined
range. Holes that go beyond the range
are transformed into slotted holes.

5 mm

Notch (76)
Notch (76) creates a notch to the secondary beam.

Objects created

• Cuts
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Use for

Situation Description
Secondary beam is notched.

Selection order

1. Select the main part.

2. Select the secondary part.

The connection is created automatically when the secondary part is
selected.

Notch tab
Use the Notch tab to create notches to the secondary beams and to control
the notch properties.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.
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Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.
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Option Description
Creates the cut above the main beam flange.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as
far back as you define.

AutoDefaults can change this option.
Creates cuts to the flange with default values
unless you define other values.
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Option Description
Creates cuts to the flange according to the value
you define to make it flush with the web.

Creates cuts to the flange according to the values
you define.

Creates chamfers in the flange.

If you do not enter a horizontal dimension, a
chamfer of 45 degrees is created.
The flange is not cut.

Cut dimensions

Define the vertical flange cut dimensions.

Parameters tab
Use the Parameters tab to define the notch type and the clearance between
the parts.

Option Description
Fitting type Select the type of notch created

between the main part and the
secondary part.

Clearance Define the clearance value for the gap
created between the parts.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab
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2.10 Bracing
This section introduces components that can be used in steel bracing
structures.

• Tensioner (7) (page 1257)

• Tensioner brace (13) (page 1276)

• Tensioner brace and compression bar (13) (page 1285)

• Tensioner central gusset (18) (page 1298)

• Traction bar (52) (page 1327)

• Turnbuckle bracing (S3) (page 1316)

• Muffe (26) (page 1324)

• Turnbuckle connection (126) (page 1334)

• Generation of purlins (50) (page 1339)

• Gusset+ T (page 1352)

Tensioner (7)
Tensioner (7) connects a column or a beam to a brace with a forked plate or a
flat plate. Optionally, a gusset plate can be created.

Objects created

• Gusset plate (optional)

• Forked or flat plate

• Tensioner (optional)

• End plate (optional)

• Bolts

• Welds
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Use for

Situation Description
Forked plate is welded to a bracing
rod and bolted to a gusset plate.

The gusset plate is welded to the
main part.

Simplified tensioner in the bracing
rod.

Selection order

1. Select the main part (column or beam).

2. Select the secondary part(s) (brace).

3. Click the middle mouse button to create the component.
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Part identification key

 Part
1 Connection plate (forked plate)
2 Bracing rod
3 Gusset plate

Plate tab
Use the Plate tab to control the gusset plate dimensions and shape.

Plate

Part Description Default
Gusset plate Define the gusset plate

thickness, width and
height.

12 mm
100 mm
180 mm
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Gusset plate shape and dimensions
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 Description Default
1 Horizontal top dimension from the column

web.
2 Horizontal bolt edge distance. 50 mm
3 Height of the gusset plate. 80 mm
4 Bottom vertical bolt edge distance. 50 mm
5 Bottom vertical chamfer dimension. 20 mm
6 Bottom horizontal chamfer dimension. 20 mm
7 Bolt edge distance to the bracing rod. 110 mm
8 Bolt edge distance of the chamfer (radius).  
9 Gusset plate shape.

Select the plate shape and define the plate
dimensions.

10 Select the chamfer shape.

Define the horizontal and vertical chamfer
dimensions.

Fork tab
Use the Fork tab to control the size, position, number, orientation and shape
of the forked plate.

Forked plate

Part Description
Forked plate Select the shape for the forked plate:

• Part 1 shape creates a plate with a
circular part.

• Part 2 shape creates a simple
plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part

Steel components 1261 Bracing



Option Description Default
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Forked plate dimensions

 Description
1 Horizontal bolt edge distance.
2 Chamfer radius of the forked plate.
3 Width of the extension part.
4 Width of the forked plate.
5 Width of the forked plate.
6 Length of the circular part of the forked plate.
7 Chamfer width of the forked plate.
8 Finger thickness of the forked plate.
9 Gap between the fingers of the forked plate.
10 Finger length in the forked plate.
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Parameters tab
Use the Parameters tab to control the overlap of the gusset plate and the
size, position, number and shape of the end plate.

Gusset plate overlap

 Description
1 Define how much the gusset plate overlaps with the main part flange.

If you do not enter any value, the gusset plate reaches the main part
web.

End plate

  
1 Define the end plate thickness, width, and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
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Option Description Default
Finish Describes how the part

surface has been
treated.

 

End plate shape

Option Description
Select the end plate shape.

Define the end plate offset from the
bracing rod.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions
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 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

3 Define the bolt offset from the center line of the bracing rod.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Tensioner tab
Use the Tensioner tab to add a tensioner, to control the bracing levels and
bracing offsets.
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Part

Part Description Default
Tensioner T Define the tensioner

profile by selecting it
from the profile catalog.

D40

Part B If you have created a
tensioner, define the
extra windbracing profile
by selecting it from the
profile catalog.

 

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Tensioner

Option Description Example
Tensioner is not created.

Tensioner is created.
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Option Description Example
Tensioner is created.

Stopper part is added to
the bracing. Used for
compression tubes.
Tensioner is created.

Stopper part is placed
inside the compression
tube.

Opening in forked plate

Option Description Example
Select whether an
opening is created in the
forked plate. The
opening is always
square.

You can define the
opening if both the
tensioner and extra
windbracing are created.

 

Define the gap for the
opening.

The default value is 1
mm.
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Gusset plate

Option Description
Select whether a gusset plate is
created.

If you do not select a gusset plate,
only the forked plate will be created.

Bracing dimensions

 Description Example/Default
1 Bolt edge distance from the main part flange

when there is no gusset plate.

The default value is 30 mm .

2 Bracing rod overlap.

3 Length of the extra windbracing between the
forked plate and the tensioner.

The default value is 300
mm.

4 Length of the tensioner. The default value is 40
mm.
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 Description Example/Default
5 Bracing overlap in the tensioner. The default value is 0

mm.
6 Extra windbracing overlap in the tensioner. The default value is 0

mm.

Bracing position

Option Description
Position of the bracing on the main
part flange.

This option is useful especially if there
is no gusset plate.

Plate position

Option Description
Select the position of the forked plate
on the main part web.
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Forked plate position on bracing

Option Descripton Example
Select the position of the
forked plate on the
bracing.

This option is useful
especially with flat
plates.

Cut part B in fork

Define whether the forked part is cut if the bracing rod goes through the
forked part. The forked part cut adapts to the bracing rod size.
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Tensioner T add to secondary

Select whether the tensioner is added to the secondary part or handled as a
loose part and welded to the bracing rod.

• Yes adds the tensioner to the bracing rod.

• No welds the tensioner to the bracing rod as a loose part.

Extra tensioners tab
Use the Extra tensioners tab to add extra tensioners. Two different tensioner
types can be defined.

Extra tensioners

If there is one bracing, define the tensioner on the Tensioner tab. If there are
more bracings, define the tensioners for the second, third, etc. bracing on the
Extra tensioners tab. Define the bracing numbers in the Apply on tensioner
number box.
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The tensioners whose numbers are not entered are created with the
properties defined on the Tensioner tab.
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For instructions on tensioner bracing dimensions, Cut part B in fork and
Tensioner T add to secondary, see the instructions on the Tensioner tab.

Parts

Part Description
Tensioner T Define the tensioner profile by selecting it from the

profile catalog.
Part B If you have created a tensioner, define the extra

windbracing profile by selecting it from the profile
catalog.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

UDA tab
Use the UDA tab to add information in the user-defined attributes (UDAs) of
the parts.

You can define UDAs for the plate and the fork. UDAs can be displayed in
drawings and reports.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Tensioner brace (13)
Tensioner brace (13) creates one or two bracing crosses between two
columns or beams. It is also possible to add connections between columns or
beams and the bracing crosses. You can define which connections are used.

Objects created

• Bracing cross (1 or 2)

• Connections between columns or beams and bracing crosses

• Connections in bracing crosses

Use for

Situation Description
One or two bracing crosses between
two columns.

NOTE To use Tensioner brace (13) you need to set the Up direction on the
General tab to a fixed direction: -x,+x,-y,+y,-z, or +z.

The Auto option does not work.

Selection order

1. Select the first main part (column or beam).

2. Select the second main part (column or beam).

The connection is created automatically when the secondary part is
selected.
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Part identification key

  
1 Diagonal bracing
2 Connection between the main part and the bracing
3 Connection in the bracing cross

Picture tab
Use the Picture tab to control the bracing levels and bracing offsets.

Bracing levels

 Description
1 Bottom level of the lower bracing cross.
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 Description
2 Top level of the lower bracing cross.
3 Bottom level of the upper bracing cross.
4 Top level of the upper bracing cross.

Bracing reference

For both main parts, define the reference side of the bracing levels. The
reference side can be set for both in the horizontal and the vertical direction.

Example:

Bracing offset

Define the offset perpendicular to the bracing. You can move the created plate
or part by entering a value in the x-, y, or z-direction.

Example:
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Levels tab
Use the Levels tab to control the bracing direction when the columns are not
parallel.

Option Description
Direction Select the

direction of the
bracing.

Start point of the main
part as the reference
point.

End point of the main
part as the reference
point.

Calculation
of levels

Select the
reference line
used for
positioning the
bracing when
the main parts
are not parallel.

Offset from the start
point in part 1,
perpendicular to the
line through the start
points.

Offset from the start
point in part 1, in local
x-direction.
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Option Description
Offset from the start
point in part 2, in local
x-direction.

Reference line through
the start and end
points of the main
parts, offset from the
start of the reference
line.

Offset from the start
point in part 1, in z-
direction.

Offset from the start
point in part 2, in z-
direction.
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Parts tab
Use the Parts tab to control the properties, bracing position, and rotation.
Additionally, you can define bracing splitting and shortening values.

Option Description
Windbracing Define the bracing profile by selecting it from the profile

catalog.
Windbracing
rotation

Select the rotation for the first and the second bracing
element.

This option is useful when the bracing elements are
crossing and they are connected in the crossing.

Windbracing
translation

Select the offset of the first and the second bracing
element from the reference points.

This option is useful when the bracing elements are
positioned so that the first bracing is alongside the
second bracing. Typically, the first bracing element is set
to Forwards and the second bracing element to
Backwards.

Splitting the
diagonal bracing

Select whether the
diagonal bracing
elements are split or
connected with a
component.

Define the connecting
component on the
Joints tab by typing
the number of the
component in the
Connect diagonals
with joint number
box.

Bracing is not split.

Possible component
for connecting the
diagonal bracing:
Seating (30).

First diagonal
bracing element is
split.

Possible component
for connecting the
diagonal bracing:
Bolted gusset (11).
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Option Description
Second diagonal
bracing element is
split.

Possible component
for connecting the
diagonal bracing:
Bolted gusset (11).

Both diagonal
bracing elements
are split.

Possible component
for connecting the
diagonal bracing:
Central gusset
(169).

Connecting
bracing crosses

Select whether the
gusset plates of two
bracing crosses above
each other are
connected.

Define the connecting
component on the
Joints tab by typing
the number of the
component in the
Connection number
box.

Bracing crosses are
connected with a
gusset connection.

Possible component
for connecting the
diagonal bracing:
Bolted gusset (11).

Bracing crosses are
not connected.
Separate
connection is
created for each
diagonal bracing.

Possible component
for connecting the
diagonal bracing:
Bolted gusset (11).
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Option Description
Distance
between
windbracings

Define the distance between bracing elements.

If the bracing elements are crossing each other, this value
typically defines the gusset plate thickness.

Shorten
windbracings

Define how much the bracing are shortened.

The entered value is written in the user-defined attributes
of the bracing. The value is used in drawings.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Comment Add a comment about

the part.
 

Joints tab
Use the Joints tab to define the components used for connecting the columns
or beams and the bracing crosses.

Option Description
Creation of joints Select whether connections are created between

the bracing elements.

No: Only the bracing elements are created.

Yes: Components are added between the
bracing elements.

Connection number

Connect diagonals with
joint number

Type the component number that is used for
connecting the bracing or the diagonal bracing
cross, and the component application number.
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Option Description
Userjoint application
number

Joint direction

Select the connection direction for the diagonal
bracing cross.

• Default component for the bracing is Bolted
gusset (11).

• Default component for the diagonal bracing
cross is Seating (30).

Example:

Configuration file Configuration setting for the connection.

For example, if you type CS_M13, it means that a
setting named CS_M13 must be available for the
used connection.

Tensioner position Define the tensioner position if the Tensioner (7)
connection is used.

Example of Tensioner (7) position in both the
Up and the Down position.
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Joints dir tab
Use the Joints dir tab to control the up directions of the connections used
between the main parts and the diagonal bracing.

In the example below, Seating (30) has been defined as the connecting
component on the Joints tab:

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Tensioner brace and compression bar (13)
Tensioner brace and compression bar (13) creates one or two bracing
crosses between two columns or beams. It is possible to add compression
bars between the main parts. You can add connections between the main
parts and the bracing crosses, and between the main parts and the
compression bars.

Because you can use other components inside Tensioner brace and
compression bar (13) to create the connections between parts, the
component has a hierarchical component structure. Tensioner brace and
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compression bar (13) is on the highest level in the component hierarchy (level
0) and the connections are on a lower level (level 1) in the component
hierarchy.

Objects created

• Bracing (1 or 2)

• Compression bars (optional)

• Connections between main parts and bracing

• Connections between main parts and compression bars

• Connections in bracing crosses

Use for

Situation Description
Two bracing crosses and three
compression bars with connections.
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Situation Description
One bracing with connections.

Tapered main parts (mast
construction) and two bracing crosses
with connections.

Selection order

1. Select the first main part (column or beam).

2. Select the second main part (column or beam).

The component is created automatically when the secondary part is
selected.
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Picture tab
Use the Picture tab to control the bracing levels.

Bracing levels

 Description
1 Top level of the upper bracing.

If no value is entered, the top bracing is not created.
2 Bottom level of the upper bracing.

If no value is entered, the top bracing is not created.
3 Top level of the lower bracing.
4 Bottom level of the lower bracing.

Bracing reference

For both main parts, define the reference of the bracing levels. The reference
can be set for both the horizontal and the vertical direction.

For example:
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Bracing offset

Define the offset perpendicular to the bracing. You can move the created plate
or part by entering a value in the x-, y, or z-direction.

In the example below, the main parts have unequal dimensions and the
reference is set to Middle. To create the bracing crosses horizontally, an offset
must be entered for the biggest part. The needed offset is the height
difference between IPE200 and IPE300, divided by 2 = 50mm.

Bracing direction

Option Description
Direction Select the

direction of the
bracing.

Start point of the main
part as the reference
point.
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Option Description
End point of the main
part as the reference
point.

Calculation
of levels

Select the
reference line
used for
positioning the
bracing when
the main parts
are not parallel.

Offset from the start
point in part 1,
perpendicular to the
line through the start
points.

Offset from the start
point in part 1, in local
x-direction.

Offset from the start
point in part 2, in local
x-direction.
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Option Description
Reference line through
the start and end
points of the main
parts, offset from the
start of the reference
line.

Offset from the start
point in part 1, in z-
direction.

Offset from the start
point in part 2, in z-
direction.

Freely defined values.
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Parts tab
Use the Parts tab to control the properties, bracing position, and rotation.
Additionally, you can define bracing splitting and shortening values.

Option Description
Windbracing Define the bracing profile by selecting it from the profile

catalog.

Windbracing
position in plane

Set the position in plane for the first and the second
bracing element.

Windbracing
rotation

Select the rotation for the first and the second bracing
element.

This option is useful when the bracing elements are
crossing and they are connected in the crossing.

Windbracing
translation

Select the offset of the first and the second bracing
element from the reference points.

This option is useful when the bracing elements are
positioned so that the first bracing is alongside the
second bracing. Typically, the first bracing element is set
to Forwards and the second bracing element to
Backwards.

Splitting the
diagonal bracing

Select whether the
diagonal bracing
elements are split or
connected with a
component.

Define the connecting
component on the
Joints tab by typing
the number of the
component in the
Connect diagonals
with joint number
box.

Bracing is not split.

Possible component
for connecting the
diagonal bracing:
Seating (30).
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Option Description
First diagonal
bracing element is
split.

Possible component
for connecting the
diagonal bracing:
Bolted gusset (11).

Second diagonal
bracing element is
split.

Possible component
for connecting the
diagonal bracing:
Bolted gusset (11).

Both diagonal
bracing elements
are split.

Possible component
for connecting the
diagonal bracing:
Central gusset
(169).

Connecting
bracing crosses

Select whether the
gusset plates of two
bracing crosses above
each other are
connected.

Define the connecting
component on the
Joints tab by typing
the number of the
component in the
Connection number
box.

Bracing crosses are
connected with a
gusset connection.

Possible component
for connecting the
diagonal bracing:
Bolted gusset (11).
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Option Description

Bracing crosses are
not connected.
Separate
connection is
created for each
diagonal bracing.

Possible component
for connecting the
diagonal bracing:
Bolted gusset (11).

Distance
between
windbracings

Define the distance between bracing elements.

If the bracing elements are crossing each other, this value
typically defines the gusset plate thickness.

Shorten
windbracings

Define how much the bracing are shortened.

The entered value is written in the user-defined attributes
of the bracing. The value is used in drawings.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.
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Compression bar tab
Use the Compression bar tab to define the compression bar properties.

Option Description
Compression
bar

Define the compression bar thickness, width and height.

Create bar Select whether the compression bar is created.

You can define up to three compression bars.
Y offsets

X offsets

Define the horizontal and vertical offset of the bracing.

Reference is the level defined on the Picture tab.

For example:

Position in
plane

Rotation

Position in
depth

Select the orientation of the compression bars.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Joints tab
Use the Joints tab to define the components used for connecting the main
parts and the diagonal bracing elements and the compression bars.

Option Description
Creation of joints Select whether connections are created between

the bracing elements.

No: Only the bracing elements are created.

Yes: Components are added between the
bracing elements.

Connect to Select whether the bracing elements are
connected to the main parts or the compression
bars.

For example:
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Option Description

Connection number

Connect diagonals with
joint number

Userjoint application
number

Joint direction

Type the component number that is used for
connecting the bracing, the diagonal bracing
cross, or the compression bar, and the
component application number. Select the
connection direction for the diagonal bracing
cross.

• Default component for the bracing is Bolted
gusset (11).

• Default component for the diagonal bracing
cross is Seating (30).

• Default component for the compression bar
is End plate (144).

Configuration file for the
joint

Configuration setting for the connection.

For example, if you type CS_M13, it means that a
setting named CS_M13 must be available for the
used connection.

Tensioner position Define the tensioner position if the Tensioner (7)
connection is used.

Joints dir tab
Use the Joints dir tab to control the up directions of the connections used
between the main parts and the diagonal bracing, and the up direction of the
connections used between the main parts and the compression bars.
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In the example below, Seating (30) has been defined as the connecting
component on the Joints tab:

UDA tab
Use the UDA tab to add information in the user-defined attributes (UDAs) of
the parts.

Option Description
Part Select to which part the related information can be saved.
UDA name Enter the name of the user-defined attribute.
Type Select the UDA type.

Use String for text, Integer for numbers, Float for numbers
with decimals and Option for selecting an item in a list.

Value Enter the value that is saved to the user-defined attribute.
Use text and/or numbers, depending on the defined UDA
type.

Tensioner central gusset (18)
Tensioner central gusset (18) creates a gusset plate to connect bracing bars.

Objects created

• Gusset plate

• Fork or plate

• Tensioners (optional)

• Bolts

• Welds
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Use for

Situation Description
Round gusset plate with a hole.

Square gusset plate.

Round gusset plate. Tensioners are
created.

Before you start

Model at least 3 bracing bars.
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Selection order

1. Select the bracing bars.

2. Click the middle mouse button to create the central gusset plate and the
forks.

Part identification key

 Description
1 Gusset plate
2 Fork
3 Bracing bar
4 Tensioner

Picture tab
Use the Picture tab to define the shape and the dimensions of the central
plate.
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Gusset plate shape

Option Description
Circular gusset plate

Circular gusset plate with a hole

Square gusset plate with a hole

Square gusset plate
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Gusset plate dimensions

 Description
1 Height of the gusset plate.
2 Width of the square gusset plate.
3 Bolt edge distance.

Horizontal bolt edge distance for square gusset plates.
4 Vertical bolt edge distance for square gusset plates.
5 Diameter of the hole in the gusset plate.
6 Fork length, calculated from the center of the hole to the end of

the fork.
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Chamfer shape and dimension

Option Description
No chamfers

Line chamfer

Define the chamfer dimension.

Convex chamfer

Define the chamfer dimension.

Gusset plate position

Select the position of the gusset plate relative to the bracing bars.

Option Descriptioin
Middle of the corner between the first
and the second bar.

Perpendicular to the first bar.

Create plate as

• Contour plate. The profile can be PL12, for example.

• Beam. The profile can be PL300*300, for example.

Enter the prefix of the beam profile. You can only enter the prefix if the
plate is created as a beam profile.

Fork tab
Use the Fork tab to define the fork properties.
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Parts

Option Description
Plate Thickness of the fork.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Part shape and dimensions

Select the shape of the fork: Part 1 or Part 2.

Options Description
Define the dimensions of the reduced
fork.
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Options Description
Define the dimensions of the fork.

Parameters tab
Use the Parameters tab to define the end plate properties, shape, and
dimensions.

Parts

Option Description
End plate Thickness, width, and height of the

end plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
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Option Description Default
Finish Describes how the part

surface has been
treated.

 

End plate shape

Option Description
Default

Square

AutoDefaults can change this option.
Square

Round

End plate offset

Option Description Example
Define the end plate
offset from the bracing
bar.

End plate thickness is set
to 30 and the offset it
set to 5.

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.
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Bolt group dimensions

 Description
1 Number of bolts in the longitudinal direction (axial to the bar).
2 Bolt spacing in the longitudinal direction.
3 Number of bolts in the transverse direction.
4 Bolt spacing in the transverse direction.
5 Bolt group offset in the transverse direction.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. 20 mm
Bolt standard Bolt standard to be used inside

the component.
4014-8.8

Tolerance Gap between the bolt and the
hole.

3 mm

Thread in mat Defines whether the thread may
be within the bolted parts when
bolts are used with a shaft.

This has no effect when full-
threaded bolts are used.

Assembly type Location where the bolts should
be attached.

Site

Slotted holes

You can define the dimensions of the slotted holes in the horizontal and
vertical direction, and a gap for oversized R tapped holes. The default is 0 mm,
which creates a circular hole.
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 Description
1 Vertical dimension of the slotted hole.
2 Horizontal dimension of the slotted hole.

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Tensioner T tab
Use the Tensioner T tab to define the properties and dimensions of the
tensioners.

Parts

Option Description Default
Tensioner T Select the profile from the

profile catalog.
D40
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Option Description Default
Part B Select the profile from the

profile catalog.

This is the bar profile
between the fork and the
tensioner.

 

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Create tensioner

Opion Description Example
Tensioner is not created.

Tensioner is created.

Tensioner is created.

The stopper part is
added to the bracing.
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Opion Description Example
Used for compression
tubes.
Tensioner is created.

The stopper part is
placed inside the
compression tube.

Plate position

Option Descriptino Example
Define the position of
the plate on the fork.

Fork position

Option Description Example
Define the position of
the fork on the bracing
bar.

Opening in fork

Option Description Example
Select whether an
opening is created in
the fork. The opening
is always square.

You can define the
opening if both the
tensioner and an extra
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Option Description Example
bracing bar are
created.
Define the gap for the
opening.

The default value is 1 mm.

Dimensions

 Description Default
1 Define an overlap for the extra bracing bar in the

tensioner.
0 mm

2 Define an overlap for the bracing bar.

3 Define the length of the extra bracing bar between the
fork and the tensioner.

300 mm
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 Description Default
4 Define the length of the tensioner. 40 mm
5 Define an overlap for the bracing bar in the tensioner. 0 mm

Cut part B in fork

Select whether the fork is cut if the bracing bar goes through the fork. The fork
cut adapts to the size of the bracing bar.

Example Description
Part B is cut.

Part B is not cut.

Tensioner T add to secondary

Select whether the tensioner is added to the bracing bar, or handled as a loose
part and welded to the bracing bar.

  
Select Yes to add the tensioner to the
bracing bar.

Select No to weld the tensioner to the
bracing bar.
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Extra tensioners
Use the Extra tensioners tab to define the properties and dimensions of extra
tensioners. You can define two types of tensioners. You can define extra
tensioners if more than one bracing bar is connected. If there is only one
bracing bar, the settings on the Tensioner T tab are used for tensioners.

Parts

Option Description
Tensioner T Select the profile from the profile

catalog.
Part B Select the profile from the profile

catalog.

This is the bar profile between the
fork and the tensioner.

Option Description
Apply on tensioner
number

Define the bars on which the setting for the
extra tensioners is applied. Use a space to define
several bar numbers.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
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Option Description Default
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Create tensioner

Option Description
Tensioner is not created.

Tensioner is created.

Tensioner is created.

The stopper part is added to the
bracing. Used for compression tubes.

Tensioner is created.

The stopper part is placed inside the
compression tube.

Dimensions

 Description
1 Define an overlap for the extra bracing bar in the tensioner.
2 Define an overlap for the bracing bar.
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 Description
3 Define the length of the extra bracing bar between the fork and

the tensioner.
4 Define the length of the tensioner.
5 Define an overlap for the bracing bar in the tensioner.

Cut part B in fork

Select whether the fork is cut if the bracing bar goes through the fork (Yes).
The fork cut adapts to the size of the bracing bar.

Tensioner T add to secondary

Select whether the tensioner is added to the bracing bar (Yes), or handled as a
loose part and welded to the bracing bar.

UDA tab
Use the UDA tab to define user-defined attributes (UDA). The attributes are
written to the central gusset and forks.

Example

Define the needed user-defined attributes.

Steel components 1315 Bracing



General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Turnbuckle bracing (S3)
Turnbuckle bracing (S3) creates a turnbuckle assembly, rods, and end
connections.

Objects created

• Turnbuckle

• Rod

• Fastener plate

• Gusset plate

• Bolts
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Use for

Situation Description
Turnbuckle connection

Selection order

1. Pick the first point.

2. Pick the second point.

3. Select the first part.

4. Select the second part.

The connection is created automatically when the second part is selected.

Part identification key

 Description
1 Turnbuckle
2 Rod
3 Fastener plate/Gusset plate

Picture tab
Use the Picture tab to define the turnbuckle dimensions.
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Dimensions

 Description Default
1 Offset between the first picked position and

the actual generation point.
0 mm

2 Distance from the first bolt to the center line
of the first part.

First part collision
point + 100 mm

3 Distance from the first bolt to the end of the
first rod. Used with battledores or clevises.

100 mm

4 Fixed length of the rod. The length of the
second rod is automatically calculated.

400 mm

5 Distance from the first bolt to the end of the
second rod. Used with battledores or
clevises.

100 mm

6 Distance from the first bolt to the center line
of the second part.

Second part
collision point +
100 mm

7 Offset between the first picked position and
the actual generation point.

0 mm

Rod depth offset

Define the fastener/gusset plate offset from the part center line. By default,
the fastener plate/gusset plate is located in line with the part center line.
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Turnbuckle tab
Use the Turnbuckle tab to define the turnbuckle dimensions, thread type and
cuts, and whether the turnbuckle is created as an assembly or as single parts.

Parts

Option Description
Rod Select the rod profile from the profile

catalog.
Turnbuckle Select whether to create a turnbuckle.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
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Option Description Default
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Dimensions

 Description Default
1 Outer diameter of the turnbuckle Diameter of the rod

+ 2 x turnbuckle
thickness

2 Length of the turnbuckle 50 mm
3 Length of the turnbuckle opening Length of the

turnbuckle – 20 mm
4 Width of the turnbuckle opening Rod thickness – 1
5 Length of the thread cut 100 mm
6 Gap between the rods 100 mm

Thread type

Define the direction of the threads at the turnbuckle.

Option Description
RH – LH (right hand – left hand)

Tekla Structures stores RH as a user-
defined attribute to the first rod and
LH as a user-defined attribute to the
second rod.
LH – RH (left hand – right hand)

Tekla Structures stores LH as a user-
defined attribute to the first rod and
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Option Description
RH as a user-defined attribute to the
second rod.

Create thread cuts

Option Description
Threads are not cut.

Threads are cut.

Assembly / single part turnbuckle

Option Description
Assembly

Single parts

Connection tab
Use the Connection tab to define the plate properties and the connection
type.

Parts

Option Description
Fastener plate Thickness, width and height of the

fastener plate.
Gusset plate Thickness, width and height of the

gusset plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
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Option Description Default
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Connection type

Select the connection type: Battledore, Clevis, Bolted gusset, or Tube
gusset.

Option Description Default
Battledore side Select whether the battledore and

gusset are generated in front of or
behind the rod generation plane.

Front

Battledore
dimensions

1 Distance from the bolt to the
edge of the fastener plate.

2 Distance from the bolt to the
gusset plate edge.

3 Clearance between the gusset
corner and the rod.

1 60 mm
2 2.5 x bolt
diameter

3 (Fastener plate
width – Rod
diameter) / 2

Clevis pin size Clevis pin size is the value stored
as a free attribute to the clevis.
Used only with clevis.

Bolt diameter + 4
mm

Connection setting User-defined attribute file for the
bolted gusset or tube gusset
connection.
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Bolts tab
Use the Bolts tab to define the bolt properties.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Muffe (26)
Muffe (26) connects two beams with a rectangular plate that has a hole in the
middle.

Objects created

• Rectangular plate (muffe)

Use for

Situation Description
Two beams connected with a
rectangular plate that has a hole in
the middle.
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Selection order

1. Select the main part.

2. Select the secondary part.

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Rectangular plate with a hole

Picture tab
Use the Picture tab to define the connection dimensions.

Dimensions

 Description Default
1 Horizontal dimension of the hole. 0.5 * muffe

height
2 Vertical dimension of the hole. Muffe

thickness -
30 mm

3 Distance between the main part and the
secondary part.

0.5 * muffe
height - 50
mm

Parts tab
Use the Parts tab to define the plate properties.
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Muffe

You can use a profile or a custom component to create the plate. If you select
a custom component from the Applications & components catalog, define
the custom settings, up direction, and rotation.

Option Description Default
Muffe Thickness, width, and

height of the plate.
Thickness and width:
100 mm
Height: 200 mm

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the bolt hole tolerance.

Tolerance

Option Description
Tolerance of bolt hole Define the tolerance value. By default,

the tolerance is zero.

General tab

Click the link below to find out more:

General tab
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Analysis tab

Click the link below to find out more:

Analysis tab

Design tab

Click the link below to find out more:

Traction bar (52)
Traction bar (52) connects a tube profile to a plate with two strips.

Objects created

• Strips

• Bolts

• Welds

Use for

Situation Description
Tube profile connected to a plate with
strips

Selection order

1. Select the main part.

2. Select the secondary part.

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Description
1 Strip to the main part
2 Strip to the secondary part

Picture tab
Use the Picture tab to define the connection dimensions.

Dimensions

 Description Default
1 Length of the strip part that is cutting the plate 100 mm
2 Distance between the plate and the beam  
3 Length of the strip part that is cutting the beam 100 mm
4 Vertical position of the strip from the centre line of

the secondary part
0

Parts tab
Use the Parts tab to define the part properties.
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Parts

Option Description
Strip to primary Thickness, width, and height of the

strip
Strip to secondary Thickness, width, and height of the

strip

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
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 Description
2 • Left: From the left edge of the secondary part to the

leftmost bolt.

• Middle: From the center line of the secondary part to the
center line of the bolts.

• Right: From the right edge of the secondary part to the
rightmost bolt.
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 Description
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

6 Dimension for vertical bolt group position.
7 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line of
the secondary part.
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 Description
• Below: From the lower edge of the secondary part to the

lowest bolt.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Turnbuckle connection (126)
Turnbuckle connection (126) creates a turnbuckle assembly. The parts that
are connected must be parallel. Tekla Structures creates the connection
objects symmetrically.

Objects created

• Turnbuckle

Use for

Situation Description
Turnbuckle connection

Selection order

1. Select the main part.

2. Select the secondary part.

Note that the parts must be parallel.

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Turnbuckle

Picture tab
Use the Picture tab to define the dimensions of the turnbuckle.
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Dimensions

 Description Default
1 Length of the turnbuckle 50 mm
2 Length of the turnbuckle opening Length of the

turnbuckle – 20
mm

3 Outer diameter of the turnbuckle Diameter of the
rod + 2 x
turnbuckle
thickness

4 Width of the turnbuckle opening Rod thickness -
1

5 Length of the thread cut 100 mm
6 Distance between the thread cuts Half of the

turnbuckle
length

Parts tab
Use the Parts tab to define whether the turnbuckle is created as a profile or as
a custom component.

Create as

Use this option to select whether to create the turnbuckle as a profile or as a
custom component.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

If you select to create the turnbuckle as a custom component, select the
custom component from the Applications & components catalog and define
the custom settings, up direction, rotation, and length.

Parameters tab
Use the Parameters tab to define the thread type, cuts and size, and whether
the turnbuckle is created as an assembly or as single parts.

Thread type

Define the direction of the threads at the turnbuckle.

Option Description
Default

RH – LH (right hand – left hand)

Tekla Structures stores RH as a user-
defined attribute to the first rod and
LH as a user-defined attribute to the
second rod.

AutoDefaults can change this option.
RH – LH (right hand – left hand)

Tekla Structures stores RH as a user-
defined attribute to the first rod and
LH as a user-defined attribute to the
second rod.
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Option Description
LH – RH (left hand – right hand)

Tekla Structures stores LH as a user-
defined attribute to the first rod and
RH as a user-defined attribute to the
second rod.

Create thread cuts

Option Description
Default

Threads are cut.

AutoDefaults can change this option.
Threads are cut.

Threads are not cut.

Thread size

When you have selected that threads are not cut, you can select the size of the
thread and create the thread 1 mm smaller.

Option Description
Default

Thread size is not changed.

AutoDefaults can change this option.
Thread size is not changed.

Thread is created 1 mm smaller.

Assembly / single part turnbuckle

Option Description
Default

Assembly

AutoDefaults can change this option.
Assembly
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Option Description
Single parts

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Generation of purlins (50)
Generation of purlins (50) creates multiple profiles that can be used as wall
or roof purlins, panels, or timber or concrete parts.

Objects created

• Purlins
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Use for

Situation Description
Purlins

Wall panel

Selection order

1. Pick the start point of the purlins.

2. Select the parts that divide up the purlins.

3. Click the middle mouse button to create the purlins.

NOTE The placement of the purlins is defined by the input parts.
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Part identification key

 Part
1 Purlin

Picture tab
Use the Picture tab to control the number of purlins, distances between the
purlins and purlin overhang lengths.

Purlin dimensions

 Description
1 Define the edge distance from the picked point to the first

purlin.
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 Description
2 Define the number of purlins.
3 Define the distance between the purlins.

The distances are calculated from center-to-center.
4 Define the edge distance from the last purlin to the part

end point.

The distance depends on the option Purlin distance
according to.

5 Define the type and length for purlin overhangs in the
purlin start.

6 Define how the purlins are split and the size of the gap
between the purlins.

7 Define the type and length for purlin overhangs in the
purlin end.

Purlin distances

Define how the distances between purlins are calculated.

Option Description
Exact number of
purlins

Define the purlin start point with an edge distance

.

The remaining length is divided according to the

values in .

For example:

Fill to the end Define the purlin start point with an edge distance in

. The remaining length is divided according to the

values in , considering the edge distance in .
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Option Description
Purlin profile Intermediate distances

Define the distances between the purlins. This is
suitable especially for concrete floors.

For example, define the distances on the Picture tab
and the purlin profile properties on the Parts tab:

Divide equally Purlin distances are equally divided by the length of
profiles.

Purlin type This option is recommended for vertical profiles,
such as concrete walls or panels.

The height of the part that is set in the purlin profile
properties on the Parts tab can be overridden by the
levels defined in the Top level purlin panels option
on the Parts tab.

For example:

The width of the panel that is set in the purlin profile
properties on the Parts tab can be overridden by the
Plate thickness option on the Parts tab. If the Plate
thickness option is empty, then the plate thickness
in the profile properties is used.
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Option Description
For example:

Level

Define the purlin level compared to the main part.

Option Description
Reference point of main part

Centerline of main part
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Option Description
Bottom face of main part

Top face of main part

Purlin direction

Define which direction is used for the new purlins.

Purlin overlap

Select whether purlins can overlap (Yes) or not (No). Setting purlins to overlap
helps in root sheeting, for example.

Note that if you set the overlap to No and the distance between the purlins is
smaller than the width of the purlins, only one of the purlins is created.

Length of purlins

Define how the purlins are split. You can select both a pattern for the purlins
and define how many gaps a purlin will cover.
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Option Description
Select a pattern for the purlins from the list.
The patterns with red purlins control the
first purlin in odd or even purlin rows.

Enter the number of gaps that a purlin
covers in the length boxes.

For example:
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Parts tab
Use the Parts tab to control the purlin properties and purlin positioning.

Purlin profile

Option Description
Purlin Define the purlin thickness, width and

height.

The default value is PL100*100.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Comment Add a comment about

the part.
 

Purlin position

Option Description
Purlins Define the number of purlins per type. Multiple purlin

types can be defined. Separate the numbers with a
space. For example 1*1 4*2 results in 1 purlin of type
#1 and 4 purlins of type #2.

Inverse Invert the local direction of the purlin. This is useful
especially for asymmetrical profiles.

You can define the inversion separately for each purlin
type.

The options are:

0= direction is inverted

1= direction is not inverted
On plane In the first box, define the purlin position in the

horizontal plane.

You can define the position separately for each purlin
type.

The options are:

0 = middle

1 = left

2 = right

In the second box, enter a value to define a horizontal
offset.
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Option Description
Rotation In the first box, enter the rotation of the purlin.

You can define the rotation separately for each purlin
type.

The options are:

0= back

1= below

2= front

3= top

In the second box, enter an angle for other rotation
angles.

At depth In the first box, define the purlin position in the vertical
plane.

You can define the position separately for each purlin
type.

The options are:

0 = middle

1 = front

2 = behind

In the second box, enter a value to define a vertical
offset.

Purlin panel
levels

Enter one or more values to define elevations. This is
useful especially for panels.

Separate the numbers with a space. Use this option
only if you have set the Purlin distance according to
option to Purlin type on the Picture tab.

Elevation

Define the reference for the purlin elevations, for example, for wall panels. The
elevations are set in the Top level purlin panels option.

Option Description
Elevation is in between the parts.
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Option Description
Elevation is on the top side of the bottom part.

Elevation is on the bottom side of the top part.

Panel thickness

Define the thickness of the panels. This works only with parametric profiles,
such as AS_PNL. Use this option only if you have set the Purlin distance
according to option to Purlin type on the Picture tab.

The defined panel thickness overrides the width set in the purlin profile
properties.

 Description Default
Plate
thickn
ess

For example: 100 mm

Use extra purlin positioning

Set the Use extra purlin positioning option to Yes to change the position and
rotation of each even or odd purlin.
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Joints tab
Use the Joints tab to define the components used for connecting the beams
and the purlins.

Option Description
Creation of joints Select whether connections

are created.

No: Only the purlins are
created.

Yes: Components are added
between the purlins and the
beams.

Connection type Select the connection type
from the list. You can select
a suitable custom
component or a connection,
or you can select one of the
predefined connections.

You can define the
connections for the start
connection (1), middle
connection with two parts
(2), middle connection with
one part (3), and the end
connection (4).

Component name / number If you have selected a
custom component or a
connection as the
connection type, select the
custom component or
connection from
theApplications &
components catalog.
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Option Description
Configuration file Select the configuration

settings for the connection.
Direction, Class The values you define are

shown on the General tab
of the selected connection.

UDA tab
Use the UDA tab to add information in the user-defined attributes (UDAs) of
the parts. You can define up to 5 UDA names.

Option Description
UDA name Enter the name of the user-defined attribute.

For example, to add a comment UDA, open the
objects.inp file in a text editor and search for
comment. The following attribute is shown:

attribute("comment", "j_comment", string,
"%s", no, none, "0.0", "0.0")
The first text between the quotation marks is the UDA
name, comment. The entered name is case sensitive.

Type Select the UDA type.

Use String for text, Integer for numbers, Float for
numbers with decimals and Option for selecting an
item in a list. You can find the UDA type in the
objects.inp file.

Value Enter a value for the UDA. Use text and/or numbers,
depending on the defined UDA type.

Gusset+ T
Gusset+T connects a beam or a brace to another beam by welding a T profile
to the end of the beam and bolting this profile to a shear plate gusset on the
main part. The main part is typically an H or I profile, and the secondary part is
typically a square or round hollow profile, though channels and other profiles
can also be used.

Objects created

• Stiffener

• Gusset plate

• Cut T profile (brace connection)

• Built up T profile (brace connection)
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• Welds

• Bolts

Use for

Situation Description
T profile welded to beam and bolted
to gusset plate on main part.

Selection order

1. Select the main part (beam).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Gusset plate
2 Brace connection (T profile)
3 Stiffener
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Picture tab
Use the Picture tab to control the gap and gusset plate dimensions and the
shape of the gusset plate.

Gap dimension

 Description Default
1 Gap dimension. 10 mm

Gap dimension options

Option Description
Default

Gap between the edge of the main
part flange and the nearest corner of
the gusset plate.

AutoDefaults can change this option.

Gap between the edge of the main
part flange and the nearest corner of
the gusset plate.

Gap between the face of the main
part web and the nearest corner of
the gusset plate.
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Option Description
Gap between the edge of the main
part flange and the nearest bolt.

Gap between the face of the main
part web and the nearest bolt.

Gusset plate shape

You can further modify the gusset plate shape by defining the dimensions on
the Picture and the Gusset tab.

Option Description
Default

Regular trapezoidal gusset plate.

AutoDefaults can change this option.
Regular trapezoidal gusset plate.

You can use all the gap and straight portion settings on the
Gusset tab page to modify this gusset plate.

If the gusset plate extends above the upper flange, or below
the lower flange, use the extended gusset plate chamfer
dimensions instead of the straight edge dimensions of the
gusset plate flange.
Square corner on the upper side of the gusset plate.

You can use all the gap options to modify this gusset plate.
The lower flange straight edge can also be used.
Partial depth gusset plate.

Define the height and straight edge explained in Gusset
plate dimensions.

If the gusset plate extends above the upper flange, use the
extended gusset plate chamfer dimensions.
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Gusset plate dimensions

 Description Default
1 Partial gusset plate height on the web.  
2 Partial gusset plate straight edge. 20 mm

Gusset tab
Use the Gusset tab to control the position and dimensions of the gusset plate
and stiffener creation.

Gusset and stiffener

Option Description Default
Gusset Gusset plate thickness 6 mm
Stiffener Stiffener thickness Gusset plate

thickness

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Option Description Default
Finish Describes how the part

surface has been
treated.

 

Gusset and stiffener dimensions

 Description Default
1 Distance of the gusset plate/stiffener from

the edge of the flange.
2 Gap between the upper flange and the

gusset plate/stiffener.
3 Gap between the lower flange and the

gusset plate/stiffener.
4 Gap between the web and the gusset plate/

stiffener.
5 Straight portion of the gusset plate from the

flange before it begins to slope to the brace.
6 Size of the gusset plate/stiffener chamfer.  
7 Chamfer shape for the gusset plate/stiffener

corners.
Line chamfer

Chamfer type and size
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 Description Default
1 Chamfer size for the gusset plate when the

gusset plate extends above or below the
main part flange.

5

2 Chamfer type for the extended gusset
plate.

Concave arc chamfer

 Description Default
1 Chamfer size for the square corner on the

upper side of the gusset plate.
20

2 Chamfer type for the square corner. Concave arc chamfer

Gusset position

Option Description
Default

Gusset plate above the Cut T profile.

AutoDefaults can change this option.
Gusset plate above the Cut T profile.

Gusset plate below the Cut T profile.

Stiffener creation

Option Description
Default

No stiffener.

AutoDefaults can change this option.
Stiffener perpendicular to the main
part.

Stiffener aligned with the gusset.

No stiffener.
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Brace connection tab
Use the Brace connection tab to define how the brace is connected to the
gusset plate.

Profile properties

Option Description Default
Cut T Cut T profile thickness,

width and height by
selecting the profile
from the profile catalog.

Gusset plate
thickness

Flange Flange thickness for the
Built up T profile.

Note that you must first
define the profile type to
be Built up T.

6 mm

Web Web thickness for the
Built up T profile.

Note that you must first
define the profile type to
be Built up T.

6 mm

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Brace connection profile

 Description Default
1 Type of the T profile to be used in the brace

connection.

When you select Built up T, also define the
gap between the gusset plate and the Built
up T profile.

2 Gap between the gusset plate edge and the
flange of the Built up T profile.

10 mm

Bolts tab
Use the Bolts tab to control the properties of bolts that connect the gusset
plate to the T profile.
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Bolt group dimensions

 Description Default
1 Minimum T profile extension for the top

and bottom of the brace connection.
10 mm

2 Bolt edge distance. 40 mm
3 Number of bolts. 2
4 Bolt spacing.

Use a space to separate bolt spacing values.
Enter a value for each space between bolts.
For example, if there are 3 bolts, enter 2
values.

60 mm

5 Bolt edge distance. 40 mm
6 Number of bolts. 1
7 Bolt spacing.

Use a space to separate bolt spacing values.
Enter a value for each space between bolts.
For example, if there are 3 bolts, enter 2
values.

60 mm

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.
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Option Description Default
Bolt standard Bolt standard to be used

inside the component.
Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.
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Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Main part welds / Cut T welds tabs
Use the Main part welds and the Cut T welds tabs to define the weld
properties. You can select whether continuous, chain intermittent, or
staggered intermittent weld shapes are used.

Click the link below to find out more:

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab
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2.11 Tubes
This section introduces components that can be used in steel tube
connections.

Click the links below to find out more:

• Tube splice (6) (page 1364)

• Tube gusset (20) (page 1372)

• Squeezed tube bolted (102) (page 1401)

• Squeezed tube (103) (page 1414)

• Tube-Chamfer (page 1421)

• Tube-CrossingSaddle (page 1423)

• Tube-MitreSaddle+Hole (page 1425)

• Tube-Saddle+Hole (page 1427)

• Tube-SlottedHole (page 1431)

Tube splice (6)
Tube splice (6) connects two rectangular hollow core sections or round tubes
with splice plates. End plates are created at both ends of the connection.
Connection plates create cuts into the connected parts.

Objects created

• Splice plates

• Connection plates

• End plates

• Welds

• Bolts

• Cuts
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Use for

Situation Description
Tube splice connection to rectangular
hollow core sections.

Tube splice connection to round
tubes.

Selection order

1. Select the main part (column or beam).

2. Select the secondary part (column or beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Splice plate
2 Connection plate
3 End plate

Picture tab
Use the Picture tab to control the positions of the plates.
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Plate position

 Description Default
1 Distance between the splice plate and the

end plate.
10 mm

2 Connection plate cut depth.

The cut depth affects the size of the
connection plate.

150 mm

3 Distance between the connection plates. 20 mm

Cut creation

Define whether connection plates create cuts to the parts they connect, and
whether end plates are cut.

Option Description
Default

Connection plate does not create a
cut.

AutoDefaults can change this option.
Connection plate does not create a
cut.

Connection plate creates a
rectangular cut.

Define the horizontal and vertical cut
dimensions.
Connection plate creates a round cut.

Define the horizontal and vertical cut
dimensions, and the radius of the cut.
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Option Description
Default

End plate is not cut.

AutoDefaults can change this option.

End plate is not cut.

End plate is cut.

Parts tab
Use the Parts tab to control the size, position, material, name and finish of the
plates.

Plate

Opttion Description
Splice plate Splice plate thickness.
Connection plate Connection plate thickness.
End plate End plate thickness.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Option Description Default
Finish Describes how the part

surface has been
treated.

 

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the splice
plates and the connection plates.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for the bolt group position from the center line of the
connected parts.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered
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Option Description
Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

End plates tab
Use the End plates tab to control the shape and the dimensions of the end
plate.
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End plate shape

Option Description
Square

Default

Square

Round

End plate chamfer dimensions

 Description
1 Horizontal chamfer dimension.
2 Vertical chamfer dimension.
3 Select the chamfer type.

End plate dimensions

Define the dimensions of the square end plate.

 Description
1 Horizontal dimension from the edge of the end plate to the flange of the

column or the beam.
2 Vertical dimension from the edge of the end plate to the flange of the

column or the beam.

End plate dimensions

Define the dimension of the round end plate.
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 Description
1 Dimension from the edge of the end plate to the outer edge of the

column or the beam.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Tube gusset (20)
Tube gusset (20) connects 1 to 10 hollow braces to a beam or a column using
a gusset plate. The braces need to have a rectangular hollow section (RHS) or a
tube profile. The connection bolts the braces to the gusset plate using a
connection plate and an optional tongue plate. The hollow braces can be
sealed with end plates.

Objects created

• Gusset plate

• Connection plates

• Clip angles

• End plates (seal plates)
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• Tongue plates

• Cover plates

• Stiffeners

• Bolts

• Welds

Use for

Situation Description
Gusset plate is welded to column
flange.

Brace is welded to connection plate.
The end of the brace is notched to
accommodate the bolts in the
connection between the connection
plate and the gusset plate.

Gusset plate is welded to column
flange.

Brace is bolted to gusset plate using a
tongue plate.
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Situation Description
Gusset plate is connected to column
flange with clip angles.

Brace is bolted to gusset plate using a
tongue plate. The braces are sealed
with end plates, and stiffeners are
created.

Gusset plate is connected to column
flange with a connection plate.

Cross plates and cover plates are
created.

Before you start

Create a beam or a column and 1 to 10 braces with RHS or tube profile.

Selection order

1. Select the main part (column or beam).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Click the middle mouse button to create the connection.
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NOTE Tekla Structures uses values in the joints.def file to create this
component.

Part identification key

 Part
1 Gusset
2 Stiffener 1
3 Tongue plate
4 Cover plate

Created on the Brace conn tab.
5 Clip angle
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 Part
6 Connection plate

Created on the Brace conn tab.
7 End plates (seal plates)
8 Stiffener 2
9 Cover plate

Created on the Cross plates tab.
10 Cross plate

Picture tab
Use the Picture tab to control the gusset plate dimensions and positioning.

Dimensions

 Description Default
1 Distance between the clip angle or

connection plate upper edge and the
gusset plate upper edge.

 

2 Corner angle of the gusset plate (in
degrees).

This value affects the gusset plate shape.

 

3 Length of the edge of the gusset plate that
is perpendicular to the uppermost brace.

This value affects the gusset plate shape.
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 Description Default
4 Brace length on the connection plate.

Enter a negative value to prevent the
connection plate from being inside the
brace.

150 mm

5 Distance between the gusset plate and the
brace.

If the braces are sealed with end plates,
the distance is between the gusset plate
and the end plate.

20 mm

6 Length of the edges of the gusset plate
perpendicular to the braces.

This value affects the gusset plate shape.

 

7 Length of the edge of the gusset plate that
is perpendicular to the lowest brace.

This value affects the gusset plate shape.

 

8 Distance between the main part and the
first picked brace.

 

9 Distance between the braces.  
10 Distance between the clip angle or the

connection plate lower edge and the
gusset plate lower edge.

 

NOTE The following examples show only some of the available options. You
will find more options on the Picture tab.

Gusset plate positioning

Define how the gusset plate is positioned when a base plate is used.

Option Description
Default

Gusset plate is parallel to the main
part.

AutoDefaults can change this option.
Gusset plate is parallel to the brace.
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Gusset plate dimensions

Option Description
Default

Gusset plate does not run through
the main part.

Define the gusset plate cut
dimension.

AutoDefaults can change this option.
Gusset plate does not run through
the main part.

Define the gusset plate cut
dimension.

Gusset plate runs through the main
part.

Define the gusset plate extension
dimension.

Gusset tab
Use the Gusset tab to control the gusset plate properties, shape and position,
and clip angle properties and orientation.

Plates

Option Description Default
Gusset Gusset plate thickness,

width and height.
Connection plates Connection plate

thickness and width.
no connection plate
is created

L profile Clip angle profile by
selecting it from the
profile catalog.

L100*100*10

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
where you can enter the
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

NOTE The following examples show only some of the available options. You
will find more options on the Gusset tab.

Gusset plate connection

Define how the gusset plate is connected to the main part.

Option Description
Default

Gusset plate is welded directly to the
main part.

AutoDefaults can change this option.
Gusset plate is connected to the main
part with clip angles.

Select to which side of the gusset
plate the clip angles are created.
Gusset plate is connected to the main
part with a connection plate.

Select to which side of the gusset
plate the connection plate is created.

Clip angle orientation

Define how the clip angle is placed on the connection.
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Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.

Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Brace position

Option Description
Default

The brace position is not affected.

AutoDefaults can change this option.

The first selected brace is placed
closest to the main part.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.
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Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.

Gusset plate chamfer

Define the gusset plate chamfer type and dimensions.

 Description Default
1 Distance between the connection plate and

the inner flange of the main part.
 

2 Horizontal distance between the gusset plate
edge and the flange of the main part.

 

3 Horizontal dimension of the chamfer.

By default, the second chamfer is not
created.

10 mm

4 Vertical dimension of the chamfer.

By default, the second chamfer is not
created.

10 mm
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Define the chamfer type.

Option Description
Default

Line chamfer

AutoDefaults can change this option.
Convex arc chamfer

Concave arc chamfer

Cut size

If the gusset plate runs through the main part, define the size of the cut
created for the gusset plate.

 Description
1 Define the horizontal size of the cut.
2 Define the vertical size of the cut.
3 Define the radius of the round cut.

Cut options

If you use beam-column-beam connections and want the gusset plate to
create a cut, you can define how the cut runs through the main part.
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Option Description
Default

Cut is created according to the gusset
plate orientation.

AutoDefaults can change this option.

Straight cut.

Brace conn tab
Use the Brace conn tab to control connection plate, tongue plate, and end
plate properties .

Brace connection

Option Description Default
Connection plate Thickness, width and

height of the connection
plate.

thickness = 20 mm

End plates Thickness, width and
height of the end plate.

thickness = 5 mm

Middle end plate Thickness and height of
the middle end plate.

no middle end plate
is created

Tongue plate Thickness and height of
the tongue plate.

no tongue plate is
created

Cover plate Thickness, width and
height of the cover plate.

no cover plate is
created

Stiffener Thickness, width and
height of the stiffener.

no stiffener is
created

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Material Material grade. The default material is

defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Brace connection types

Define how the brace is connected to the connection plate.

Option Description
Default

Brace is welded

AutoDefaults can change this option.
Brace is welded.

Brace is bolted.

Brace is welded and notched around
the nuts.

Tongue plate and cover plate are
created.

Cut in bracing

If needed, you can create a cut in the bracing.

Define the width of the cut in the bracing, where t is the thickness of the
connection plate.

Define the length of the cut in the bracing from the edge of the connection
plate.
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Gusset and connection plate distance

Define the distance between the gusset plate and the connection plate.

Round cut in bracing

If needed, you can create a round cut in the bracing. Enter the radius value.

NOTE The following examples show only some of the available options. You
will find more options on the Brace conn tab.

Connection plate

Define whether the brace is notched or the connection plate cut when the
connection plate is connected to the brace.

Option Description
Default

Brace is notched.

AutoDefaults can change this option.
Connection plate is cut.

Connection plate is cut, but the part
of the connection plate created inside
the bracing is not deleted.
If you cut the connection plate, you
can define the size of the gap
between the brace and the
connection plate.

Number of connection plates

Define whether one or two connection plates are used for connecting the
brace to the gusset plate.

Option Description
Default

One connection plate.

AutoDefaults can change this option.
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Option Description
Two connection plates and a middle
end plate at the ends of the
connection plates.
If a middle end plate is created, you
can define the width of the end plate.

Select the middle end plate position.

Connection plate stiffeners

Option Description
To create stiffeners, define the
stiffener thickness.

By default, one stiffener is created.
When you select to create two
connection plates, you can also select
to create one stiffener on the left or
one on the right, or one stiffener on
both the left and the right side.

Define the inner and outer chamfers
of the stiffeners.

Connection plate chamfer

Define whether the connection plate is chamfered.

Option Description
Default

No chamfers are created.

AutoDefaults can change this option.
Chamfers are created.

If you create chamfers, define the
vertical and horizontal chamfer
dimensions.
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End plates

If you use the end plates to seal the braces, define the end plate shape and
dimensions.

Option Description
Default

Square end plate.

AutoDefaults can change this option.
Round end plate.

End plate edge distance from the
brace outer edge.

End plate chamfer

Define the end plate chamfer type and horizontal and vertical dimensions.

Stiffeners tab
Use the Stiffeners tab to control the stiffener properties and dimensions.

Stiffeners

Option Description Default
Stiffener 1

Stiffener 2

Stiffener thickness. no stiffener is
created
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Stiffener length

 Description
1 Distance between the stiffener edge and the gusset plate edge.
2 Length of stiffener.
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You can fit the stiffeners to the main part. By default, the stiffeners are not
fitted.

Stiffener dimensions

 Description
1 Width of the stiffener.
2 Length of the stiffener base.
3 Length of the skew part of the stiffener.
4 Distance from the stiffener center line.
5 Vertical distance between the stiffener base and the skew part.

Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer
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Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

Gusset conn tab
Use the Gusset conn tab to control the bolt group properties for bolts that
connect the gusset plate to the main part, and to control the clip angle
attachment.

Bolt group dimensions on gusset plate

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

2 Number of bolts.
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 Description
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

4 Dimension for vertical bolt group position.
5 Select how to measure the dimensions for vertical bolt group position.
6 Dimension for horizontal bolt group position.
7 Select how to measure the dimensions for horizontal bolt group

position.

 Description
1 Location where the bolts should be attached.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

NOTE The following examples show only some of the available options. You
will find more options on the Gusset conn tab.

Clip angle attachment type

Define how the clip angle is attached to the gusset plate and to the main part.

Option Description
Default

Both parts are bolted.

AutoDefaults can change this option.
Automatic

When the main part is a tube profile,
the clip angles are welded to the main
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Option Description
part and bolted to the secondary part.
Otherwise the clip angles are bolted
to both parts.
Main part is bolted and secondary
part is welded.

Main part is welded and secondary is
part bolted.

Both parts are bolted.

Both parts are welded.

Bolts on gusset plate

Define whether the gusset plate is connected to the main part with bolts when
no clip angles are used.

Option Description
Default

Bolts are not created in the gusset
plate.

AutoDefaults can change this option.
Bolts are created in the gusset plate.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3
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Option Description
Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Steel components 1394 Tubes



Option Description
Bolting direction 2

Brace bolts 1/Brace bolts 2/Brace bolts 3 tab
Use the Brace bolts 1, Brace bolts 2 and Brace bolts 3 tabs to control the
bolts that connect the first, the second, and the subsequent braces to the
gusset plate.

Bolt group dimensions on connection plates

 Description
1 Number of bolts.
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 Description
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each space
between bolts. For example, if there are 3 bolts, enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

4 Distance between the brace and the connection plate edge.
5 Select how to measure the dimensions for vertical bolt group position.
6 Dimension for vertical bolt group position.

Bolt distance

Define the minimum distance from the connection plate bolts to the
intersection point of the main part and brace center lines. If a brace is
perpendicular to the main part, the distance is measured from the main part
center line to the nearest bolts.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3
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Option Description
Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.
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Option Description Default
Rotate Slots When the hole type is Slotted,

this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt type

Select the bolt type to define the location where the bolts should be attached.

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1
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Option Description
Bolting direction 2

Cross plates tab
Use the Cross plates tab to control the cross plate and the cover plate
properties and position.

Cross plates

Option Description Default
Cross plate Thickness, width and

height of the cover plate.
no cross plate is
created

Cover plate Thickness, width and
height of the cover plate.

no cover plate is
created

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

4 Dimension for the horizontal bolt group position.
5 Vertical dimension of the chamfer.
6 Horizontal dimension of the chamfer.
7 Distance between the end of the brace cap plate and the edge of the

splice plate.
8 Clearance of the cross plate edge on the gusset plate from the surface of

the main part.

Cross and cover plate position

Define the position of the cross plate and the cover plate.

Option Description
Default

Cover plate is created on both sides
of the cross plate.

AutoDefaults can change this option.
Cover plate is created on top of the
cross plate.

Cover plate is created on the bottom
of the cross plate.
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Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Bolting direction 2

General tab
Click the link below to find out more:

General tab

Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:

Squeezed tube bolted (102)
Squeezed tube bolted (102) creates a squeezed part between the main part
and a tubular profile. The main part must be an I or H profile. The squeezed
part can either be a tube that is squeezed at one end and then welded to a
plate, or a contour plate.

Objects created

• Squeezed tube, or reducing contour plate

• Stiffeners
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• Bolts

• Welds

Use for

Situation Description
A tubular profile is welded to a bracing which is
bolted to a gusset plate. The gusset plate is
welded to the main part.

A simplified tensioner profile.

Selection order

1. Select the main part (I or H profile).

2. Select the secondary part (tubular profile).

The squeezed part is created automatically.

Part identification key
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 Part
1 Main part (I profile)
2 Tubular profile

Picture tab
Use the Picture tab to control the bracing levels and offsets.

 Description Default
1 Width of the squeezed part extension. Depends on main part:

main part width -
web thickness / 2.

Example:
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 Description Default

2 Width of the squeezed part. 120 mm
3 Select the type of the reducing part.

Plate:

Squeezed tube:

 

4 Horizontal edge offset.

Example:

0 mm
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 Description Default

5 Select how the height of the squeezed part
extension is calculated.

 

Parts tab
Use the Parts tab to control the dimensions of the squeezed part and the
stiffener properties.

Squeezed part

Define the dimensions and properties of the squeezed part extension.

Option Description
Squeezed part Thickness, width and height of the

squeezed part extension.

Example:
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Option Description

Use the second row to define the
width of the squeezed part. The width
defined on the Parts tab overrides
the width defined on the Picture tab.

Parts add Select whether the squeezed parts
are handled as loose parts, meaning
that they are not attached to any
other profile in the component, or
whether they are added to the
secondary part.

• Yes

Squeezed parts are part added to
the tubular profile.

• No

Squeezed parts remain loose
parts.

Stiffeners

Option Description
Stiffeners are Select whether the stiffeners are created as

stiffeners or as plates.

• Stiffeners

Define the stiffener dimensions on the
Stiffeners tab.
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Option Description
• Plate stiffeners

Define the dimensions using the
Stiffener plate boxes.

Stiffener plate Define the thickness and width of the
stiffener plate.

NOTE You cannot define the plate height.
The height is equal to squeezed part
height defined on the Picture tab.

Define the stiffener plate height above and
below the tubular profile center line. These
values only take effect if you have set the
Stiffeners are option to Plate stiffeners.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Stiffeners tab
Use the Stiffeners tab to control the stiffener properties.

Stiffener 1, Stiffener 2

NOTE The options on this tab work only if you have set the Stiffeners are
option to Stiffeners on the Parts tab.

Stiffener 1 is the stiffener on the side of the squeezed tube. Stiffener 2 is the
stiffener on the other side of the web.

Define the thickness, width and height of the stiffeners.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Stiffener gap

Define the size of the gap between the beam flange and the stiffener.

Chamfer dimensions

 Description
1 Vertical dimension of the chamfer.
2 Horizontal dimension of the chamfer.

Chamfer type

Option Description
Default.

Line chamfer

AutoDefaults can change this option.
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Option Description
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Stiffener side

Define the side of the stiffeners.

On the left side of the squeezed part:
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On the right side of the squeezed part:

Bolts tab
Use the Bolts tab to control the bolts.

Bolt group dimensions

 Description Default
1 Bolt vertical offset from the center line. 0 mm
2 Number of bolts in vertical direction. 2
3 Bolt spacing.

Use a space to separate bolt spacing values.
Enter a value for each space between bolts.
For example, if there are 3 bolts, enter 2
values.

 

4 Bolt edge distance.

Edge distance is the distance from the center
of a bolt to the edge of the part.

55 mm

5 Number of bolts in horizontal direction. 1
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Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Squeezed tube (103)
Squeezed tube (103) creates a squeezed part between two tube profiles. The
squeezed part can be either a tube that is squeezed at one end and then
welded to a plate, or a contour plate. It is also possible to define a connection
where no squeezed tubes or contour plates are created, but the profiles are
connected with cuts, fittings, and welds.

Objects created

• Squeezed tube and/or contour plate

Use for

Situation Description
Tube that is squeezed at one
end and welded to a plate.

Tube that is squeezed at one
end and welded to a plate.
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Situation Description
Contour plate.

Selection order

1. Select the main part.

2. Select the secondary part.

The squeezed part is created.

Picture tab
Use the Picture tab to define the shape and dimensions of the squeezed part,
and whether the profiles are connected with a squeezed part or with cuts,
fittings, or welds.

Squeezed part

The first five options create squeezed tubes and contour plates.

The last six options do not create new parts but line cuts, fittings and welds.

Option Description Example
Default

Main and secondary parts are tube
profiles.

A plate is used as a connecting
profile, with one wide end and one
parallel end.
A squeezed part and a contour
plate are created.

The tube profile reduces to a
contour plate. You can define the
length of the squeezed part using
dimension b.

Use dimension t to define the gap
between the plate and the main
part.
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Option Description Example
Same as the Default option.

Use dimensions a and b to define
the length of the wide part and the
parallel part of the plate.

Use dimension t to define the gap
between the plate and the main
part.
Use dimensions a and b to define
the plate length. The plate widens
along its length.

Use dimension t to define the gap
between the plate and the main
part.
Use dimensions a and b to define
the plate length. The widening
starts at the squeezed part and
continues along the contour plate.

Use dimension t to define the gap
between the plate and the main
part.
No new parts are created.

The secondary part is adapted to
the main part using a fitting and a
line cut.

Use dimension c to define an
offset from the centerline of the
main part (default value = 15 mm).

Use dimension t to define the gap
between the plate and the main
part.
No new parts are created.

The secondary part is adapted to
the main part using a fitting and
two line cuts.

Use dimension d to define the
distance to the center of the main
part.

Use dimension t to define the gap
between the plate and the main
part.
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Option Description Example
No new parts are created.

The secondary part is shortened
with a fitting.

Optionally, the secondary part can
be welded to the main part.

Use dimension t to define the gap
between the plate and the main
part.
No new parts are created.

The secondary part is shortened
with a line cut.

Optionally, the secondary part can
be welded to the main part.

Use dimension t to define the gap
between the plate and the main
part.
No new parts are created.

The secondary part is shortened
with a line cut.

Optionally, the secondary part can
be welded to the main part.

Use dimension t to define the gap
between the plate and the main
part.
No new parts are created.

The secondary part is shortened
with a line cut.

Optionally, the secondary part can
be welded to main part.

Use dimension t to define the gap
between the plate and the main
part.

Parts tab
Use the Parts tab to define the thickness and width of the squeezed part end.
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Option Description
Squeezed part Thickness and width of the squeezed

part end.

The front end of the squeezed part
has the same profile as the secondary
part.

The squeezed part end and the
contour plate are of the same size.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Comment Add a comment about

the part.
 

Parameters tab
Use the Parameters tab to define whether the secondary part is welded to
the main part, whether the secondary part, the squeezed part and the contour
plate are handled as a single part, and how the squeezed part is flattened.
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Option Description
B squeezed part Define how the squeezed part is

flattened.

The options are:

• ((De – t) * pi + t ) / 2 (default)

• (De * pi) / 2

De = secondary tube profile

Welding

Define whether the secondary part is welded to the main part.

Option Description
Default

Secondary part is welded to the main
part.

AutoDefaults can change this option.

Secondary part is welded to the main
part.

Secondary part is not welded to the
main part.

Part add

Define whether the secondary part, the squeezed part and the contour plate
are handled as a single part.
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Option Description
Default

Secondary part, the squeezed part
and the contour plate are not
handled as a single part.

AutoDefaults can change this option.

Secondary part, the squeezed part
and the contour plate are not
handled as a single part.

Secondary part, the squeezed part
and the contour plate are handled as
a single part.

The squeezed part gets the profile
properties from the secondary part.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Tube-Chamfer
Tube-Chamfer connects a round tube to a plate or to a round tube. If the
main part is tube, the secondary tube needs to be of equal diameter. The
tubes are chamfered.

Objects created

• Cuts

• Welds

Use for

Situation Description
Tube-to-tube connection.

Tube-to-plate connection.

Limitations

• No support for polybeams or contour plates.

• No support for non-plate profiles on the main part (for example, H/I beam
or square tube)

Selection order

1. Select the main part (round tube or plate).
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2. Select the secondary part (round tube of equal diameter).

The connection is created automatically when the secondary part is
selected.

Parameters tab
Use the Parameters tab to control the chamfers.

Connection options

Option Description
Chamfer

Fits the secondary tube to a plate, or
the main and secondary tubes along
the median angle plane.

Offshore Chamfer

Creates back bevel during the tube
NC file creation. No actual back bevel
is created in the model.

NOTE Offshore Chamfer information is used only in NC data, and no actual
back bevels are created in the model.

Tube NC Parameters

Option Description
Bevel angle The weld preparation angle created

during NC processing of the tube.

For a tube-to-tube chamfer this
option creates a bevel to both tubes,
adding up to the defined angle.

Root opening above The gap between the parts. The gap is
created in the model.

Shrinkage The shrinkage considered during NC
processing of the tube. The shrinkage
value has no effect on the model.

Maximum torch angle Maximum torch angle.

The default is 70.0.
Minimum torch angle Minimum torch angle.

The default is -70.0.

Steel components 1422 Tubes



NOTE Bevel angle information is used only in NC data, and no actual weld
preparations are created in the model.

Welding tab

Click the link below to find out more:

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Tube-CrossingSaddle
Tube-CrossingSaddle connects a round tube to a round tube. The connection
creates a saddle cut to the secondary tube.

Objects created

• Cuts

• Welds

Use for

Situation Description
Crossing saddle connection.
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Limitations

• No support for polybeams or contour plates.

Selection order

1. Select the main part (round tube).

2. Select the secondary part (round tube).

The connection is created automatically when the secondary part is
selected.

Parameters tab
Use the Parameters tab to control the saddle cuts.

Connection options

Option Description
Crossing Saddle

Creates a crossing saddle to the
secondary part.

Tube NC Parameters

Option Description
Bevel angle The weld preparation angle created

during NC processing of the tube.

The bevel is created to the secondary
part.

Root opening above The gap between the parts. The gap is
created in the model.

Shrinkage The shrinkage considered during NC
processing of the tube. The shrinkage
value has no effect on the model.

Maximum torch angle Maximum torch angle.

The default is 70.0.
Minimum torch angle Minimum torch angle.

The default is -70.0.

NOTE Bevel angle information is used only in NC data, and no actual weld
preparations are created in the model.
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Welding tab

Click the link below to find out more:

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Tube-MitreSaddle+Hole
Tube-MitreSaddle+Hole connects a round tube to a round tube of equal
diameter. The connection creates mitre holes to the main part and mitre cuts
to the secondary part.

Objects created

• Cuts

• Welds

Use for

Situation Description
Mitre saddle and hole connection.
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Situation Description

Limitations

• No support for polybeams.

• Parts are only cut, not fitted. Short parts or parts at a steep angle may not
show correct results.

Selection order

1. Select the main part (round tube).

2. Select the secondary part (round tube of equal diameter).

The connection is created automatically when the secondary part is
selected.

Parameters tab
Use the Parameters tab to control the mitre holes and cuts.

Connection options

Option Description
Saddle + Hole

Creates a mitre cut (double mitre) to
the secondary part, and a mitre hole
to the main part.

Saddle Only

Creates a mitre cut to the secondary
part. No mitre hole is created to the
main part.
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Option Description
Hole Only

Creates a mitre hole to the main part.
No mitre saddle is created to the
secondary part.

Tube NC Parameters

Option Description
Bevel angle The weld preparation angle created

during NC processing of the tube.
Root opening above The gap between the parts. The gap is

created in the model.
Shrinkage The shrinkage considered during NC

processing of the tube. The shrinkage
value has no effect on the model.

Maximum torch angle Maximum torch angle.

The default is 70.0.
Minimum torch angle Minimum torch angle.

The default is -70.0.

NOTE Bevel angle information is used only in NC data, and no actual weld
preparations are created in the model.

Weldings tab

Click the link below to find out more:

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab
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Tube-Saddle+Hole
Tube-Saddle+Hole connects a round tube to a round tube of equal or smaller
diameter. The connection creates holes to the main part and saddles to the
secondary part.

Objects created

• Cuts

• Welds

Use for

Situation Description
Saddle connection.

Limitations

• No support for polybeams.

• The parts are only cut, not fitted.

Selection order

1. Select the main part (round tube).

2. Select the secondary part (round tube of equal or smaller diameter).

The connection is created automatically when the secondary part is
selected.
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Parameters tab
Use the Parameters tab to control the saddles and holes.

Connection options

Option Description
Saddle

Creates a standard saddle on the
secondary part, fitting it to the main
part.

Weld preparations are created to the
secondary part during NC processing.
Set-on Saddle+Hole

Creates a standard saddle on the
secondary part, fitting it to the main
part. Creates also a hole in the main
part which matches the inner
diameter of the secondary part.

Weld preparations are created to the
secondary part during NC processing.
Set-in Saddle+ Hole

Creates a saddle on the secondary
part, fitting it to the inner surface of
the main part. Creates also a hole in
the main part which matches the
outer diameter of the secondary part.

Weld preparations are created to the
hole on the main part during NC
processing.
Set-on Hole Only

Creates a hole in the main part which
matches the inner diameter of the
secondary tube. The secondary part is
not modified in any way.

No weld preparations are created
during NC processing.
Set-in Hole Only

Creates a hole in the main part which
matches the outer diameter of the
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Option Description
secondary part. The secondary part is
not modified in any way.

Weld preparations are created to the
hole on the main part during NC
processing.
Edge Saddle

Creates a partial saddle on the
secondary part to a main part which
only partially overlaps with the
secondary part.

Weld preparations are created to the
secondary part during NC processing.
Offshore Saddle

Creates back bevel during the tube
NC file creation. No actual back bevel
is created in the model.

NOTE Offshore Saddle information is used only in NC data, and no actual
back bevels are created in the model.

Tube NC Parameters

Option Description
Bevel angle The weld preparation angle created

during NC processing of the tube.
Root opening above The gap between the parts. The gap is

created in the model.
Shrinkage The shrinkage considered during NC

processing of the tube. The shrinkage
value has no effect on the model.

Maximum torch angle Maximum torch angle.

The default is 70.0.
Minimum torch angle Minimum torch angle.

The default is -70.0.

NOTE Bevel angle information is used only in NC data, and no actual weld
preparations are created in the model.
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Welding tab

Click the link below to find out more:

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Tube-SlottedHole
Tube-SlottedHole connects a plate to a round tube. This connection creates a
slotted hole to the main part.

Objects created

• Cuts

• Welds

Use for

Situation Description
Slotted hole with a plate.

Limitations

• No support for polybeams or contour plates.

• The hole is created only to one side of the main part. Tube-SlottedHole
cannot be used for creating penetrating slots.
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• Connections are not created for plates which are not parallel to the main
axis of the tube.

Selection order

1. Select the main part (round tube).

2. Select the secondary part (plate).

The connection is created automatically when the secondary part is
selected.

Parameters tab
Use the Parameters tab to control the slotted holes.

Connection options

Option Description
Slotted Hole

Creates a slotted hole to the main
part.

Tube NC Parameters

Option Description
Bevel angle The weld preparation angle created

during NC processing of the tube.

The bevel is created to the slotted
hole.

Root opening above The gap between the plate and the
tube. The gap is created in the model.

Maximum torch angle Maximum torch angle.

The default is 70.0.
Minimum torch angle Minimum torch angle.

The default is -70.0.

NOTE Bevel angle information is used only in NC data, and no actual weld
preparations are created in the model.

Weldings tab

Click the link below to find out more:
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

2.12 Platework
This section introduces components that can be used in steel platework.

Click the links below to find out more:

• Rectangle to circle (17) (page 1433)

• Triangles generation (19) (page 1440)

• Unfold surface (21) (page 1449)

Rectangle to circle (17)
Rectangle to circle (17) creates a reducing piece between a rectangular
profile and a circular or an elliptical profile. The reducing piece consists of
several triangular plates.

Objects created

• Reducing piece

Use for

Situation Description
Reducing piece between rectangular
and circular profile.
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Situation Description

Selection order

1. Select the main part (rectangular profile).

2. Select the secondary part (circular or elliptical profile).

3. Click the middle mouse button to create the reducing piece.

Part identification key

 Part
1 Circular profile
2 Reducing piece
3 Rectangular profile

Picture tab
Use the Picture tab to define the number of parts which the reducing piece
consists of, and the offset for the rectangular and circular profile end.
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Option Description
Define the offset for the rectangular
and the circular profile end.

The options are:

• Offset

Fixed distance.

• % x t

Percentage of the plate thickness.

Number of cuts

Define the number of parts which the reducing piece consists of.

By default, there is one cut in the reducing piece.

Option Description
Default

One cut

AutoDefaults can change this option.

No cuts

One cut
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Option Description
Two cuts

Four cuts

Manual creation of reducing piece

You can create the reducing piece without existing profiles by picking three
points at each end of the reducing piece. The picked points define the size of
the reducing piece. You can define the shape of the manually created reducing
piece on the Parameters tab.

Option Description
Picking order of the points:

• center point

• horizontal distance

• vertical distance
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Parts tab
Use the Parts tab to define the thickness of the triangular plates in the
reducing piece and the reducing piece position.

Triangle

Option Description
Triangle Triangular plate thickness.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Comment Add a comment about

the part.
 

Position in depth

Select the position of the plate segments. The default is Middle.

Parameters tab
Use the Parameters tab to define the shape of the reducing piece end, to
increase or decrease the number of triangular plates, and to define whether
the triangular plates are welded.

Secondary segments

Define the number of the triangular plates in the reducing piece.

The more triangular plates are created, the more accurate is the shape of the
reducing piece.
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3 x 4 plates

6 x 4 plates

First/second shape

Define the shape of the reducing piece end if you have manually created the
reducing piece by picking points in the order shown on the Picture tab.

By default, the shape of the reducing piece end is circular.

First shape Second shape Description
Default

Circle

AutoDefaults can change
this option.
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First shape Second shape Description
Circle

Ellipse

This option works only if
the main or secondary
part has a rectangular
profile.

Rectangle

Welding of the plates

Define whether the triangular plates are welded.

Select the Welding option if you later need to show the unfolded assembly of
triangular plates in an assembly drawing.

Option Description
Plates are not welded.

Steel components 1439 Platework



Option Description
Plates are welded.

Welds

Click the link below to find out more:

Triangles generation (19)
Triangles generation (19) creates triangular plates, or profiles, for double-
curved surfaces, for example, for spiral stair stringers. A double-curved surface
is created by placing multiple flat triangular plates side by side. The triangular
plates are welded together to enable unfolding of the plates. If needed, you
can unfold the triangular plates using Unfold surface (21).

Object created

• Triangular plates

Use for

Situation Description
Curved surfaces consisting of
triangular plates.
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Situation Description

Before you start

Create points in the model which define the shape of the curved surface. A
minimum of 8 points are needed.

Alternatively, you can define the coordinates of the points in an ASCII file, and
use the file to create the triangular plates. In ASCII files, the values are
separated by spaces, and the decimals in the values are separated by periods,
for example:

0.0 0.0 0.0 6000.0 0.0 -0.0
1620.7 -2010.1 500.0 6995.1 -3159.4 500.0

ASCII file example

The ASCII file for the coordinates of the points has a specific structure. A pair
of coordinates is defined on each row with x-, y- and z-values.

The coordinates need to be placed at even distances from each other.
Therefore, the first row contains a range of numbers that help to place the
coordinates evenly.

The coordinate pairs are defined on the next rows. The first three values
define the local offset (x-,y-, z-) from the first point, and the last three values
define the offset from the second point.
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Selection order

1. Pick the points in the order shown on the Picture tab.

2. Click the middle mouse button to create the curved surface.

Part identification key

 Part
1 Triangular plate

Picture tab
Use the Picture tab to define whether the plates are created according to the
picked points in the model or according to the coordinates defined in an ASCII
file, and to set the global displacement.

Plate definition

Option Description
With picked points Shape of the triangular plate by picking the points

that you have previously created.
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Option Description
Read points in ASCII file Shape of the triangular plate by giving the

coordinates in an ASCII file.

Offset

Use Global displacement to define an offset for the created plates or profiles
in x, y and/or z direction.

Parameters tab
Use the Parameters tab to define the ASCII file, whether plates or profiles are
created, and how extra points are handled.

Option Description
File name Enter the name of the ASCII file where you have

defined the coordinates for the points.

The file is searched from the model folder.
Create plates profiles Define whether plates or profiles are created.

By default, plates are created.

You can define the plate properties on the Plate tab
and the profile properties on the Profile tab.
Plates are created:
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Option Description
 Profiles are created:

Plates and profiles are created:

Number of extra
points

Define whether extra points are automatically
created between the picked points, or set
coordinates, to smoothen the plates.
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Option Description
Number of extra points: 0

Number of extra points: 3

Method to calculate
extra points

If the curved plates form an arc, define whether the
arc is taken into account for extra point calculation.
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Option Description
The 1st order option does not take the arc into
account for extra point calculation.

The 3rd order option takes the arc into account, and
the extra points are placed in the same arc as the
original points.

The Cardinal spline total length option uses
Cardinal spline interpolation over all points.
The Cardinal spline in middle option uses Cardinal
spline interpolation only for middle points.

Smoothness spline
0-1

Define the smoothing spline.

Coplane distance Define the coplane distance.
Create points Define whether points are placed on every

coordinate.
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Option Description
Points are placed on every coordinate:

No points:

Close curve Define whether the contour is closed.
Contour is closed:

Contour is not closed:

Plate tab
Use the Plate tab to define the plate properties and position.

Option Description
Plate Triangular plate thickness.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.
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Option Description Default
Name Name that is shown in

drawings and reports.
 

Class Part class number.  

Offset

Define the position of the triangular plates relative to the picked points or the
coordinates.

Join plates

Define whether the triangular plates are attached to each other.

Select the Welding option if you later need to unfold the triangular plates. The
triangular plates form an assembly which can be flattened by using Unfold
surface (21).

Profile tab
Use the Profile tab to define the profile properties and position.

Profile

Option Description
Profile Define the profile by selecting it from the profile

catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Profile orientation

Use Position in plane, Rotation and Position in depth options to define the
orientation of the profile.
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Chamfers tab
Use the Chamfers tab to define chamfers for the created triangular plates.

  
Select the chamfer shape.

X, Y Enter the x and y direction
coordinates.

Position Select the relative position for each
vertex.

Picked points are the input points of
the component.

Extra points are points that the
component creates. Enter the
number of extra points on the
Parameters tab to define the
fragmentation of the result surface.

Angle conditions Set the angle interval for each vertex.

For example, if you set > 0 and < 90,
all angles are between 0 and 90.

Unfold surface (21)
Unfold surface (21) unfolds welded plates. The unfolded plates are created to
a location that you have defined. Use Unfold surface (21) to unfold triangular
plates created with, for example, Triangles generation (19). You can also
create assembly drawings from the unfolded plates.

Objects created

• Unfolded plates
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Use for

Situation Description
Unfolded triangular plates

Limitations

• Unfold surface (21) only works with contour plates. Do not use Unfold
surface (21) to unfold beams or polybeams.

• We recommend that you use the same position-in-depth settings for all
plates.

• In some cases, an error can occur when unfolding complex surfaces that
have holes. You can use the Do not refine edges option on the Big plate
tab to prevent this.

• Unfold surface (21) preserves anti-material cuts, line cuts, and bolts. Edge
chamfers are not preserved.

• The plates should be neighbors with no gaps between them.

• The plates must be welded as neighbors. Welds must not have zero size.

NOTE If the weld size between the triangular plates is set to 0.0, Unfold
surface (21) unfolds only one triangular plate, not all the welded
triangular plates.

If needed, you can create breaks in the unfolded shape using the weld sizes.
For example, if the default weld size is 5.0, but one weld gets size 0.0, a break
is created to the unfolded plate.

Option Description
1 Unfolded form
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Option Description
2 Unfolded form

Selection order

1. Select a location for the unfolded plate.

2. Select a triangular plate.

The unfolded plate is created to a location you have defined.

Plates tab
Use the Plates tab to define the thickness of the unfolded plate and whether
the properties of the triangular plates are used in the unfolded plate.

Option Description
Replace Thickness of the unfolded plate.

If you do not enter any value, the
thickness of the triangular plates is
used.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Option Description
Part to unfold Select which part to unfold: the main part or the

selected part of the assembly.
Zero welds Select whether to ignore the plates that are connected

by zero welds or not.
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Option Description
Unfolding by Select how the plates should be unfolded:

• By Geometry - in the order in which the original
plates were created.

• By Welds - in the way the pieces of original plates
were welded together.

Profile Select the second column of the check boxes if you
want to use the properties of the triangular plates in
the unfolded plate.

If you are unfolding a plate created with Rectangle to
circle (17), and want to maintain the assembly
position numbers defined in Rectangle to circle (17),
clear the second check box next to the Profile option.

Name
Material
Class

Big plate tab
Use the Big plate tab to define the type and the accuracy of the unfolded
plate.

Option Description
Merge points Define the accuracy of the unfolded plate by

adding or removing points.

Select whether the points in the resulting unfolded
plate are merged or not.

Merge limit If you want to merge points, define the limit for
the merging. The points that are closer to each
other than the set limit are merged.

• Points are not merged.
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Option Description
• Points are merged, and the merge limit is

15.00.

Attach with Select how the final plates are connected.

Unfolded plate type and offset

Option Description
Type One plate

One plate is created.

Plates

Plates are welded together.
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Option Description

Both

Both one plate and a plate with welds
are created.

If you select Both, you can define the
distance between the plates using the
Offset option.

Offset

Define the distance between the unfolded plates.

Do not refine edges

This option prevents errors that may sometimes occur when unfolding
complex surfaces that have holes.
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Parameters tab
Use the Parameters tab to define the weld reference text in an assembly
drawing.

Text in drawings

Option Description
Prefix First part of the text that is shown in

assembly drawings, for example,
Angle=.

Format Format in which the size of the
unfolding is displayed.

Postfix Last part of the text that is shown in
assembly drawings, for example,
degrees.

UDA tab
Use the UDA tab to copy the original numbering and user-defined attributes
(UDAs) from the original plates to the unfolded plate.

Option Description
Set following
parameters

Copy the properties of the original plates to the UDAs
of the unfolded plate. Enter the name of the UDA for
each property that you want to copy.

Copy following UDAs Define which UDAs are always copied from the
original plates to the unfolded plate.

Surrounding rectangle tab
Use the Surrounding rectangle tab to calculate the length and width of the
smallest rectangle around the unfolded area or the big plate.
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The example image below shows the dimensions with green arrows.

Option Description
Calculate
surrounding
rectangle

Select one of the following:

• No (default).

Surrounding rectangle is not created. You cannot
enter any user-defined attribute (UDA) value or
plate properties.

• Yes

Enter the UDAs for length and width.

The rectangle is created with the dimensions
defined in the UDAs.

• Yes and create construction lines

Enter the UDAs for length and width.

The shape of the surrounding rectangle is shown
with construction lines.

Plates are unfolded by keeping the original
smaller plates (mostly triangles), and with one big
plate. Two rectangles are created: one around the
original plates and one around the big plate.
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Option Description

• Yes and create plate

Enter the UDAs for length and width, and the
plate properties and the offset.

The rectangle is created as a plate. The
rectangular plate has the same thickness as the
unfolded plate (defined on the Plates tab).

Check on the UDA tab that you have entered the
UDAs needed for the rectangular plate.

UDA to put length

UDA to put width

Enter the user-defined attributes (UDA) for length
and width that are used in the surrounding
rectangle.

The calculated length and width cannot be saved if
you do not enter the UDAs. Note that you have to
enter both UDAs to save the calculated dimensions.
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Option Description
Rectangular plate The rectangular plate has the same thickness, part

position number, material, name and class as the
unfolded plate.

Define the UDAs for the plate on the UDA tab.
Offset Define the perpendicular offset to the unfolded

plate. By default, the offset is zero.

Rectangular plate properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

2.13 Frames
This section introduces components that can be used in steel frames.

Click the links below to find out more:

• Truss (S78) (page 1458)

• Opening Frame (page 1468)

Truss (S78)
Truss (S78) creates a truss between selected points. Truss (S78) does not
create any connections to existing parts.

Objects created

• Top chord
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• Bottom chord

• Diagonals

• Verticals between diagonals

• Cap plates

Use for

Situation Description
Truss with top chord, tilted bottom
chord, cap plates, diagonals and
verticals.

Truss with top chord, bottom chord,
cap plates, diagonals and verticals.

Truss with top chord, bottom chord,
cap plates, diagonals and verticals.

Selection order

1. Pick the start point of the truss.
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2. Pick the end point of the truss.

The truss is created automatically when the end point is picked.

Part identification key

 Part
1 Top chord
2 Bottom chord
3 Vertical
4 Diagonal

Picture tab
Use the Picture tab to control the gap created between diagonals, the
eccentricity of the diagonals, and the dimensions of the parts.

Gap dimensions
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 Description Default
1 Gap between the diagonals at the top

chord.
20 mm

2 Gap between the diagonals at the bottom
chord.

20 mm

Eccentricity dimensions

 Description Default
1 Eccentricity of the diagonal intersection at

the top chord.
20 mm

2 Eccentricity of the diagonal intersection at
the bottom chord.

20 mm
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Part dimensions

 Description Default
1 Define how the top and bottom chords are

connected.

• Apex haunch (106)

Use with top and bottom chord I profiles.

• Joining plates (14)

• Welded

• Continuous

Creates a continuous top or bottom
chord.

Welded

2 Select an attribute file for the connection. standard
3 Horizontal distance between the start/end

point of the truss and the first/last diagonal.
200 mm

4 Vertical distance between the start/end
point of the truss and the bottom level of
the bottom chord.

1000 mm

5 Top chord extension from the start/end
point of the truss.

0 mm

6 Bottom chord extension from the first and
the last diagonal/vertical to the chord end.

240 mm
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 Description Default
7 Define how the chords, diagonals and

verticals are connected.

• Gusset plate (11)

• Round tube (23)

Used with round tube profiles.

• Welded

Welded

8 Vertical distance between the truss apex and
the bottom level of the bottom chord.

2000 mm

9 Horizontal distance between the top chord
extension and the truss apex.

entire truss
length/2

Parts tab
Use the Parts tab to control the profiles for chords, diagonals and verticals.

Profiles

You can define the profiles for the top and bottom chords, and up to seven
profile types for the diagonals and verticals.

Use the Diagonals and the Verticals fields to define how the different profiles
are created.

Option Description Default
Top Chord Define the top chord

profile by selecting it
from the profile catalog.

CFRHS100*4

Bottom Chord Define the bottom chord
profile by selecting it
from the profile catalog.

CFRHS100*4

Profile 1 -

Profile 7

Define a profile by
selecting it from the
profile catalog.

CFRHS80*4

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Material Material grade. The default material is

defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Diagonals and verticals creation for left (1) and right (2) side

Opti
ons

Description

Diag
onal
s

Define how the diagonals are created using the above profiles.

• The diagonals are created by multiplying the number of diagonals
with the type of profile, number*profile.

For example, 2*3 creates two diagonals of the type Profile 3.

For example, 1*2 is the same as 2, and creates one diagonal of the
type Profile 2.

• The number of diagonals results from the pattern. For example, 2
2*3 1 creates 4 diagonals.

• The diagonals are created from the start/end point towards the
truss center.

If you have set the Truss type to Single pitch truss on the
Parameters tab, the second Diagonals row is ignored. The
diagonals are created from the start point to the end point of the
truss.

Verti
cals

Define how verticals are created using the above profiles.

The verticals are positioned between the diagonals, and the maximum
number of verticals results from the number of diagonals.

Twin profiles

Define whether the top or the bottom chord is created using twin profiles.
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Top and bottom chord type

Option Description
Short legs up

Default
Short legs down
Long legs up
Long legs down

Diagonal and vertical type

Option Description
Short leg up

Default
Short leg down
Long leg up
Long leg down

Clearance

Define the gap between the twin profiles.

Parameters tab
Use the Parameters tab to control the truss assembly, and the diagonals and
verticals creation.

Assembly main part

Define which part is the main part in the truss assembly.

• Left Top Chord

Additional welds are created between the truss and the left top chord.

• Right Top Chord

Additional welds are created between the truss and the right top chord.

• Left Bottom Chord

Additional welds are created between the truss and the left bottom chord.

• Right Bottom Chord

Additional welds are created between the truss and the right bottom chord.

• None

The assembly main part is controlled by the bolts/welds that the Truss
(S78) creates and the connections used between the parts. If all bolts/welds
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are set to Site, then each part (top/bottom chords, verticals, diagonals)
forms an individual assembly.

Verticals at truss end

Define whether a vertical is created to the truss ends.

Option for start point Option for end point Description
Default

No vertical is created to
the end.

AutoDefaults can change
this option.
No vertical is created to
the end.

Vertical is created to the
end.

Middle verticals

Define whether the verticals are created between diagonals.

Option Description
Default

No middle verticals are created.

AutoDefaults can change this option.
No middle verticals are created.

Verticals are created between the
diagonals.

Verticals are created between the
diagonals. Verticals and diagonals
form an N-type truss.
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Extension for verticals and diagonals

 Description Default
1 Extension for diagonals and verticals in

the top chord.
0 mm

2 Extension for diagonals and verticals in
the bottom chord.

0 mm

Truss type

Option Description
Default

Single pitch truss

AutoDefaults can change this option.
Single pitch truss

Top chord is horizontal. Bottom chord
can be sloped.
Ridge truss

If the apex and the start/end point of
the truss are of equal height, the
chords are horizontal.
Upside-down ridge truss

If the apex and the start/end point of
the truss are of equal height, the
chords are horizontal.

Truss style

Option Description
Default

WWW

AutoDefaults can change this option.
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Option Description
WWW

The first diagonal begins from the top
chord.
AAA

The first diagonal begins from the
bottom chord.

Cap plate tab
Use the Cap Plate tab to control the cap plate creation.

Connection 1002 properties for cap plate

Cap plates are created using the End plate detail (1002) component that has
a given set of properties. You can name the properties sets.

Top and bottom chord cap plates

Define whether a cap plate is created.

Option for left side cap
plates

Option for right side
cap plates

Description

Default

No cap plate is created.

AutoDefaults can change
this option.
No cap plate is created.

Cap plate is created.

Opening Frame
Opening Frame creates an open frame for wall, roof, or floor openings. The
frame is created between beams or columns.

Objects created

• Top frame

• Bottom frame

• Vertical posts

• Additional component (optional)
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Use for

Situation Description
Open frame between two columns
with top frame, bottom frame, and
two pairs of vertical posts.

Open frame between two skew
columns with top frame, bottom
frame, and two pairs of vertical posts.

Before you start

Create two columns or beams.

Selection order

1. Select the main part.

2. Select the secondary part.

3. Pick the start point of the opening frame.

4. Pick the end point of the opening frame.
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Part identification key

 Part
1 Top frame
2 Vertical post
3 Bottom frame

Picture tab
Use the Picture tab to control the frame position, offsets, and spacings.

Frame distance

 Description Default
1 Distance between the top and the bottom

frames.
1200 mm

Frame horizontal offset
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 Description Default
1 Horizontal offset of the frame from the

start/end point.
0 mm

Frame vertical offset

 Description Default
1 Vertical offset of the frame from the

start/end point.
0 mm

Frame position

Option Description
Default

Top

AutoDefaults can change this option.

Top
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Option Description
Bottom

Middle

Frame mirroring

Mirror the frame in relation to the start point and the end point.

When the frame is mirrored, also part rotation and additional connections
follow the mirroring.

Option Description
Default

Frame is not mirrored.

AutoDefaults can change this option.

Frame is not mirrored.

Frame is mirrored.
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Created parts

Option Description Default
Frames to create Define whether top,

bottom, or both frames
are created.

Both

Pairs vertical posts Define how many pairs
of vertical posts are
created.

3

Spacing pairs (S1, S2,
Sn)

Spacing between the
pairs.

The spacing is measured
from the first vertical
post inner side of the
first pair to the first
vertical post inner side
of the second pair.

• If the spacing value
between the posts
exceeds the bottom
frame length, then
only top and bottom
frames are created,
and a warning
message is displayed.

• If the number of
spacings is greater
than the number of
the entered spacing
values, the missing
spacing values are
the same as the last
spacing value.

For example, if Pairs
vertical posts = 4
and Spacing pairs =
100 200, the spacing
values are 100 200
200.

1800 mm

Spacing vertical posts
(W1, W2, Wn)

Spacing between the
vertical posts in the
pairs.

The spacing is measured
from the first vertical
post inner side to the

500 mm
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Option Description Default
second vertical post
inner side.

If the number of
spacings is greater than
the number of the
entered spacing values,
the missing spacing
values are the same as
the last spacing value.

Create welds Define whether welds
are created.

The options are:

• Posts-Frames (5)

Welds are created
only for posts on
frames.

• Columns-Frames
(1-4)

Welds are created
only for frames on
column.

• All

All welds are created.

• No

No welds are created.

Posts-Frames(5)

Parts tab
Use the Parts tab to define the part properties.

Dimensions

Option Description Default
Top Frame Top frame profile by

selecting it from the
profile catalog.

L100*50*5

Bottom Frame Bottom frame profile by
selecting it from the
profile catalog.

L100*50*5

Vertical Posts Vertical post profiles by
selecting them from the
profile catalog.

L100*50*5
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Twin profiles

Option Description Default
Twin profiles • No

Top frame, bottom
frame, or vertical
posts are created
using single profiles.

• Yes

Top frame, bottom
frame, or vertical
posts are created
using twin profiles.
The twin profile is
composed of the
profile that you
selected from the
profile catalog.

No

Type

Define the profile rotation for single profiles or for twin profiles.

Options for single profile:

Option Description
Type 1
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Option Description
Type 2
Type 3

Type 4

Type 5
Type 6
Type 7

Type 8

Options for twin profile:

Option Description
Type 1
Type 2
Type 3

Type 4

Clearance

Option Description Default
Clearance Clearance between the

twin profiles.

You can define the
clearance only if the
Twin Profile field is set
to Yes.

0 mm

Position

Option Description Default
On plane Part position on work

plane.
Middle

Rotation Define how much the
part is rotated around its
axis on the work plane.

You can define the
rotation only for twin
profiles. Define the
rotation for single
profiles in the Type field.

Front
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Option Description Default
At depth Part position, in terms of

depth, perpendicular to
the work plane.

Middle

Connections tab
Use the Connections tab to define the properties of connection components
that are created between the parts.

Connection properties

NOTE With twin profiles the connection is created between only one part of
the twin profile, and thus the connection is not well supported. If you
use connections to connect twin profiles, a warning message is
displayed.

Option Description Default
Connection number Define a connection that

connects the parts by
selecting it from the
component catalog.

If the field is empty or
set to 0, welds are
created instead.

 

Attribute file Select an attribute file
for the connection.

standard

Welds tab

Click the link below to find out more:

2.14 Stairs
This section introduces components that can be used in steel stairs.

• Rail connection (70) (page 1478)

• Stairs (S71) (page 1491)

• Wooden steps pan (S72) (page 1511)

• Polybeam pan (S73) (page 1525)

• Handrail 1 (74) (page 1540)

• Z pan (S74) (page 1545)
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• Kickplate (S75) (page 1581)

• Stanchions (S76) (page 1589)

• Railings (S77) (page 1596)

• Stairs (S82) (page 1628)

• Stanchion side plate (83) (page 1632)

• Multiple beam railing (S84) (page 1642)

• Stringer to channel (127) (page 1647)

• Connection plate (1026) (page 1655)

• Stair base detail (1038) (page 1662)

• Stair base detail (1039) (page 1668)

• Stair base detail (1043) (page 1674)

• Ladder (S35) (page 1686)

• Cage ladder (S60) (page 1695)

• Ship Ladder (page 1710)

• Wall Rails (page 1730)

Rail connection (70)
Rail connection (70) connects an existing handrail and an existing column
with a clip angle with either welded or bolted connections.

Objects created

• Clip angle

• Bolts

• Welds

• Cuts

Use for

Situation Description
Handrail is connected to a column
with bolted clip angle.
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Selection order

1. Select the main part (column).

2. Select the secondary parts (handrail).

• With continuous handrails, select the rail.

• With spliced handrails, select the first rail and then the second rail.

3. Click the middle mouse button to create the connection.

Part identification key

 Description
1 Clip angle

Picture tab
Use the Picture tab to define the connection dimensions.

Dimensions

 Description
1 Rail end cut back dimension.
2 Rail end clearance dimension from the clip angle.
3 Clip angle offset from the center line of the column.
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 Description
1 Length of the outstanding leg of the clip angle.

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description
Connecting profile Select the profile from the profile

catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Parameters tab
Use the Parameters tab to define the clip angle position and attachment type.

Steel components 1480 Stairs



Clip angle location

Option Description
Default

The clip angle is created below the
handrail.

AutoDefaults can change this option.
The clip angle is created above the
handrail.

The clip angle is created below the
handrail.

Clip angle direction

Option Description
Default

The clip angle is created with the
vertical leg toed down.

AutoDefaults can change this option.
The clip angle is created with the
vertical leg toed down.

The clip angle is created with the
vertical leg toed up.

Outstanding leg position

  
Default

The long leg is positioned
horizontally.

AutoDefaults can change this option.
Automatic

Tekla Structures determines which
way the long leg is positioned.
The long leg is positioned
horizontally.
The long leg is positioned vertically.
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Attachment type

Option Description
Default

The clip angle is bolted.

AutoDefaults can change this option.
The clip angle is bolted.

The clip angle is welded to the
handrail and bolted to the column.

The clip angle is bolted to the handrail
and welded to the column.

The clip angle is welded.

Pbolts tab
Use the Pbolts tab to define the properties of the bolts connecting the clip
angle to the main part.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
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 Description
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

5 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate
the numbers with a space. Bolt numbers run from left to right
and from top to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Sbolts tab
Use the Sbolts tab to define the properties of the bolts connecting the clip
angle to the secondary part.
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Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

5 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate
the numbers with a space. Bolt numbers run from left to right
and from top to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
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Option Description
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.
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Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.
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Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.

Flange notch depth

Option Description
Flange notch depth

Steel components 1490 Stairs



Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Stairs (S71)
Stairs (S71) creates straight stairs with optional top and bottom landings. The
stairs consist of stringers, possible landings and the actual steps.

Objects created

• Stringers

• Steps

• Landings (optional)

• Brackets

• Plates (optional)

• Cuts (optional)

• Bolts

• Welds

Use for

Situation Description
Stairs with horizontal top and bottom
landings.

U pan profile steps with brackets.

Brackets are welded to the stringers
and bolted to the steps.
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Situation Description
Stairs with stringers notched to the
supporting beam.

Steps are catalogue steps.

You may also use your own custom
components as steps.

Before you start

If the stringers are notched, create the supporting beams before creating the
stairs.

Selection order

1. Pick a point to indicate the nosing point of the first step.

2. Pick another point to indicate the nosing point of the last step.

Note that the order in which the points are picked has no effect.

3. Click the middle mouse button to create the stairs.

If you have selected the following notched options on the Picture tab,
select the supporting beams and then click the middle mouse button.
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Part identification key

 Part
1 Stringer
2 Step
3 Landings

Picture tab
Use the Picture tab to control the landing types, and the shape and the
location of the stringers in relation to the points you pick when creating the
stairs.

Top landing types

Option Description
Default

Horizontal

AutoDefaults can change this option.
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Option Description
Horizontal

Notched

The stringer top is on the supporting part. Vertical
and horizontal plates are welded at the end of the
stringer.

Bottom landing types

Option Description
Default

Horizontal

AutoDefaults can change this option.

Vertical

Creates a vertical landing where the lower point is
on the top plane of the last step.

Horizontal

Creates a horizontal landing where the lower point
is on the top plane of the last step.

Vertical lowered point

Creates a vertical landing where the lower point is
at the top of steel or on the floor level.

Horizontal lowered point

Creates a horizontal landing where the lower point
is at the top of steel or on the floor level.
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Option Description
Notched

Creates a notch to the bottom of the stringer. A
vertical plate is welded at the end of the stringer.

Stair dimensions

 Description Default
1 Define the distance between the upper

point and the end of the left top landing.

If you set the value to 0 mm, the left top
landing is not created.

If you set the top landing type to notched,
define the cut dimension of the horizontal
plate from the stringer edge.

0 mm
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 Description Default
2 Define the vertical distance from the upper

point to the top of steel of the top landing.

If the top landing is not created, the
stringer top of steel is used.

If you set the top landing type to notched,
define the vertical distance from the upper
point to the stringer top horizontal cut.

200 mm

3 Define the maximum distance allowed
between two consecutive steps.

The spacing between the steps is
calculated using the step spacing type
Exact or Equal, and the number of steps.

For example, if the step height should be
200 mm, the Exact setting creates steps of
exactly this height (enter the number of
steps as an integer). The Equal setting
creates the required number of steps from
the bottom to the top, with the height
calculated as close to 200 mm as possible.

(Z*220)/(Z+220) mm,

where Z is the vertical
distance between the 2
picked points.

4 Select the direction of the nosing
dimension of the steps:

• Vertical

• Horizontal

• Perpendicular

Define the nosing dimension of the steps.
This dimension depends on the direction
you have selected.

Vertical

0 mm

5 Define this dimension based on the
selected bottom landing type:

• Horizontal or horizontal lowered point
bottom landing.

Define the vertical distance from the
lower point to the top of steel of the
bottom landing.

• Vertical or vertical lowered point
bottom landing.

Define the horizontal distance from the
lower picked point to the most distant
face of the bottom landing.

150 mm
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 Description Default
• Notched bottom landing.

Define the horizontal distance from the
lower point to the stringer vertical cut.
By default, the cut is made at the
supporting part edge.

6 Define the vertical dimension from the
lower point to the first step.

You can define this dimension when the
step spacing type is set to Equal and the
bottom landing type is either vertical or
horizontal lowered point.

Equal with vertical spacing
between steps

7 Define the cut dimension of the vertical
plate from the stringer edge.

You can define this dimension when the
bottom landing type is set to notched.

0 mm

8

11

Define this dimension based on the
selected bottom landing type:

• Horizontal or horizontal lowered point
bottom landing.

Define the horizontal edge distance
between the lower point and the
bottom landing.

• Vertical or vertical lowered point
bottom landing.

Define the vertical edge distance
between the lower point and the lowest
point of the bottom landing.

600 mm

9 Define the vertical gap between the lower
supporting part and the stringer cut.

You can define this dimension when you
have set the bottom landing type to
notched.

0 mm

10 Define the horizontal gap between the
lower supporting part and the stringer cut.

You can define this dimension when you
have set the bottom landing type to
notched.

0 mm

12 Define the dimension to shorten the steps
equally on both sides.

0 mm

13 Define the width of the steps. 1000 mm
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 Description Default
14 Define the horizontal gap between the

upper supporting part and the stringer cut.

You can define this dimension when you
have set the top landing type to notched.

0 mm

15 Define the vertical gap between the upper
supporting part and the stringer cut.

You can define this dimension when you
have set the top landing type to notched.

0 mm

16 Define this dimension based on the
selected top landing type:

• Horizontal top landing.

Define the distance between the upper
point and the end of the stringer.

• Notched top landing.

Define the horizontal distance between
the upper point and the stringer
vertical cut. By default the cut is made
at the supporting part edge.

If you set this dimension to 0 mm, the top
landing is not created.

0 mm

17 Select the step spacing type:

• Exact creates the steps of exactly the
defined height. Enter the number of
steps as an integer.

• Equal creates the required number of
steps from the bottom to the top, with
the height calculated as close as
possible to the defined step height.

The spacing type controls how the vertical
spacing between the steps is calculated.

If you select Exact and set the bottom
landing type to horizontal or vertical lower
point, the steps are spaced from the upper
point to the lower point. In all other cases
the steps are spaced from the lower point
to the upper point.

Equal
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 Description Default
18 Enter the number of steps.

This option depends on step spacing type
and step spacing.

If you set the step spacing type to Exact, or
to Equal and the spacing distance is not
defined, Stairs (S71) creates the number of
steps you have defined.

 

Vertical landing offset

Define the vertical offset for the left and right horizontal landing at the top and
bottom of the stringers.

Stair set up tab
Use the Stair setup tab to control the part properties, top and bottom steps,
position of the stairs on the horizontal plane, and rotation of stringers and
steps.

Stair part properties
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 Part Description Default
1 Left stringer Always created

Select a profile from the
profile catalog.

BLU400*2
The default name is
STRINGER.

1 Right stringer Always created

Select a profile from the
profile catalog.

BLU400*2
The default name is
STRINGER.

2 Upper H plate Created only if the top
of the stringer is on the
supporting beam.

6 mm
The default name is PLATE.

3 Upper V plate Created only if the top
of the stringer is on the
supporting beam.

6 mm
The default name is PLATE.

4 Lower V plate Created only if the
bottom of the stringer
is on the supporting
beam.

6 mm
The default name is PLATE.

5 Catalogue step Created only if Step
type is set to
Catalogue step. In this
case, the U-pan steps,
brackets, and bolts
defined on the other
tabs are ignored.

First profile from the
Catalogue step list, defined
in the steps.dat text file in
the system folder. The list
changes according to the
selected environment.

The default name is STEP.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Steel components 1501 Stairs



Option Description Default
Finish Describes how the part

surface has been
treated.

 

Stair setup settings

Option Description
Step type • Steps: The steps are created from the steel pan that is

defined on the Steps tab.

• Catalogue step: The steps are created from the profile
defined in the Catalogue step option. The options on
the Steps and Bracket tabs are not used.

Create
assembly

Select which parts of the stair component form an
assembly. The default is stringers.

Stringer
reference line

• Above: The line positioned on the inside of the stairs on
the top face is used as the reference line.

• Nosing: The nosing line of the steps is used as the
reference line.

The reference line is used for workshop drawings.
Steps rotation Rotation of the step around its axis. The default is Top.
Position in
plane

Position of the stairs. The middle line of steps is used as the
reference line. The default is Right.

Offset Offset of the stairs on the plane from the position that is
set in the Position in plane option.

The default offset is 0 mm.
Bolt Type Select the bolt type for catalogue steps.

If you select the Workshop option, the bolts are shown in
workshop assembly drawings in the list of workshop bolts.

Bolt tolerance Define the bolt hole tolerance for catalogue steps.
Stringer
rotation

Rotation of the stringer around its axis. The default is top

.
Create top step Define whether the first step of the stairs (the highest step)

is created. By default, the first step is created.
Create bottom
step

Define whether the last step of the stairs (the lowest step)
is created. By default, the last step is created.
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Steps tab
Use the Steps tab to control the shape and the size of U pan steps. Instead of
a U pan, you can create the steps by using a catalog profile, or a custom part
or component.

U-pan step dimensions

 Description Default
1, 2,
10,
11

Define the chamfer
values on both sides of
the step.

Select the chamfer type
to set the shape of the
front and back corner of
the step.

15 mm

3 Define the angle of the
step relative to the
horizontal line.

The angle can be positive
or negative.

0 degrees
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 Description Default
4, 12 Define the height of the

step.
100 mm

5, 13 Define the length of the
horizontal portion of the
U pan.

50 mm

6, 7 Define the angle of the
vertical portion of the
step relative to the
vertical line.

The angle can be positive
or negative.

0 degrees

8 Define the thickness of
the U pan step material.

10 mm

9 Define the width of the
step.

Bracket length * 1/0.7

Step type

Option Description
Default

U pan legs up

AutoDefaults can change this option.

U pan legs up

U pan legs down

Custom

Define the custom profile options.
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Custom profile

Option Description Default
Step profile Select a profile from

the profile catalog.

You can select a
step profile when
the Step type is set
to custom and the
Part name/Joint
no. option has not
been set.

PL100*80
The default name is STEP.

Part name/
Joint no.

Select a custom
part or a
connection from
the Applications &
components
catalog.

 

Attribute file Select the attribute
file.

standard

Vertical
position

Select the vertical
depth position of a
step that is created
as a custom part.

If you are using a
custom connection,
this option is not
used.

Middle

Horizontal
position

Select the
horizontal on plane
position of a step
that is created as
custom part.

If you are using a
custom connection,
this option is not
used.

Middle

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Bracket tab
Use the Bracket tab to set up brackets, and the connection between the
brackets and the steps, and the brackets and the stringers. The brackets
support the angle profiles under the steps.

Bracket

Part Description Default
L
profile

To create an L
profile, select a
profile from the
profile catalog.

BLL80*80*10
The default name is L_Profile.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Name Name that is shown in

drawings and reports.
 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Bracket dimensions

 Description
1 Define the length of the bracket.

The default length is calculated according to the bracket-to-step or
bracket-to-stringer bolt dimensions, depending on which are bigger.

2 Define the bracket offset dimension from the center line of the step.

The default is 0 mm.

Bracket-to-step connection

Define the properties of the bolts that connect the bracket to the step.
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 Description
1 Define the basic bolt basic properties:

• Bolt size defines the bolt diameter. Available sizes are defined in the
bolt assembly catalog.

• Bolt standard defines the bolt standard to be used inside the
component. Available standards are defined in the bolt assembly
catalog.

• Tolerance defines the gap between the bolt and the hole.

• Thread in mat defines whether the thread may be within the bolted
parts when bolts are used with a shaft. This has no effect when full-
threaded bolts are used.

2 Select whether brackets are created or not.
3 Define the bolt group dimensions.
4 Select the connection type between the steps and the brackets:

• Bolted

Bolted is the default.

• Welded

• No connection

• Plate bracket
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 Description

Bracket angle leg is not created.

• Holes only

5 Select the bolt direction.
6 Define the slotted hole properties:

• Slotted holes no. defines the number of slotted holes.

• Hole type creates either Slotted holes, or Oversized or tapped holes.

• Rotate slots rotates slots when the hole type is slotted.

• Slots in defines in which parts the slotted holes are created.
7 Define the exact length of the bolts.

You can define the length of the bolts if the Step type is set to on the
Steps tab.

8 Define the slotted hole dimensions.

Bracket-to-stringer connection

Define the properties of the bolts that connect the bracket to the stringer.

 Description
1 Define the basic bolt properties:

• Bolt size defines the bolt diameter. Available sizes are defined in
the bolt assembly catalog.

• Bolt standard defines the bolt standard to be used inside the
component. Available standards are defined in the bolt assembly
catalog.
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 Description
• Tolerance defines the gap between the bolt and the hole.

• Thread in mat defines whether the thread may be within the
bolted parts when bolts are used with a shaft. This has no effect
when full-threaded bolts are used.

2 Define the bolt group dimensions.
3 Define the bolt assembl.

The selected check boxes define which component objects (bolt,
washers, and nuts) are used in the bolt assembly. If you want to
create a hole only, clear all the check boxes. To modify the bolt
assembly in an existing component, select the Effect in modify
check box and click Modify.

4 Define the slotted hole properties.

• Slotted holes no. defines the number of slotted holes.

• Hole type creates either Slotted holes, or Oversized or tapped
holes.

• Rotate slots rotates slots when the hole type is slotted.

• Slots in defines in which parts the slotted holes are created.
5 Define the slotted hole dimensions.
6 Select the connection type between the stringer and the brackets:

• Bolted

Bolted is the default.

• Welded

• No connection

7 Select the bolt direction.
8 Set the bracket position of a plate bracket:

• Below the step
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 Description

Below the step is the default.

• Between the step and the stringer

You can use this option when you have set the connection type
between the steps and the brackets to the plate bracket option

.

Welds

Click the link below to find out more:

Wooden steps pan (S72)
Wooden steps pan (S72) creates straight stairs with optional top and bottom
landings. The stairs consist of stringers, possible landings and the actual steps.

Objects created

• Stringers

• Steps

• Landings (optional)

• Brackets

• Plates to the stringer ends (optional)

• Bolts

• Welds
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Use for

Situation Description
Stairs with wooden steps. Vertical
bottom landing type.

Stairs with C-shaped stringers.
Horizontal bottom landing type.
Wooden steps are bolted to steel
brackets.

Stairs with stringers notched to the
supporting beam.

Before you start

If the stringers are notched to bear on the supporting beams, create the
supporting beams before creating the stairs.

Selection order

1. Pick a point to indicate the nosing point of the first step.
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2. Pick another point to indicate the nosing point of the last step.

The order in which the points are picked has no effect.

3. Click the middle mouse button to create the stairs.

If you have selected the following notched options on the Picture tab,
select the supporting beams and then click the middle mouse button.

Part identification key
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 Part
1 Stringer
2 Step
3 Landings

Picture tab
Use the Picture tab to control the stringer geometry and the nosing points of
the steps.

Top landing type

Option Description
Default

Horizontal landing

Notched

The stringer top is on the supporting
part. Vertical and horizontal plates are
welded at the end of the stringer.

Bottom landing type

Option Description
Default
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Option Description
Vertical

Creates a vertical landing where the
lower picked point is on the top plane
of the last step.

Horizontal

Creates a horizontal landing where
the lower picked point is on the top
plane of the last step.

Vertical lowered point

The picked point is at the top of steel
or finish floor.

Horizontal lowered point

The picked point is at the top of steel
or finish floor.

Notched

Creates a notch to the bottom of the
stringer to bear on the supporting
part. A vertical plate is welded at the
end of the stringer.
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Stair dimensions

Description Default
1 Define the distance between the upper

point and the end of the left top landing.

If you set the value to 0 mm, the left top
landing is not created.

If you set the top landing type to notched,
define the cut dimension of the horizontal
plate from the stringer edge.

0 mm

2 Define the vertical distance from the
upper point to the top of steel of the top
landing.

If the upper landing is not created, the
stringer top of steel is used.

If you set the top landing type to notched,
define the vertical distance from the upper
point to the stringer top horizontal cut.

200 mm
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Description Default
3 Define the maximum distance allowed

between two consecutive steps.

The spacing between the steps is
calculated using the step spacing type
Exact or Equal, and the number of steps.

For example, if the step height should be
200 mm, the Exact setting creates steps of
exactly this height (enter the number of
steps as an integer). The Equal setting
creates the required number of steps from
the bottom to the top, with the height
calculated as close to 200 mm as possible.

(Z*220)/(Z+220) mm,
where Z is the
vertical distance
between the 2
picked points.

4 Define this dimension based on the
selected bottom landing type:

• Horizontal or horizontal lowered point

Define the vertical distance between
the lower picked point and the top of
steel of the bottom landing.

• Vertical or vertical lowered point

Define the horizontal distance between
the lower picked point and the most
distant face of the bottom landing.

• No bottom landing is selected

Define the horizontal distance from the
lower picked point to the stringer
vertical cut. By default, the cut is made
at the supporting part edge.

150 mm

5 Define the vertical dimension from the
lower point to the first step.

You can define this dimension when the
step spacing type is set to Equal and the
bottom landing type is either vertical or
horizontal lowered point.

equal with vertical
spacing between
steps

6 Define the cut dimension of the vertical
plate from the stringer edge.

You can define this dimension when the
bottom landing type is set to notched.

0 mm
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Description Default
7

10

Define this dimension based on the
selected bottom landing type:

• Horizontal or horizontal lowered point
bottom landing.

Define the horizontal edge distance
between the lower point and the
bottom landing.

• Vertical or vertical lowered point
bottom landing.

Define the vertical edge distance
between the lower point and the
lowest point of the bottom landing.

600 mm

8 Define the vertical gap between the lower
supporting part and the stringer cut.

You can define this dimension when you
have set the bottom landing type to
notched.

0 mm

9 Define the horizontal gap between the
lower supporting part and the stringer cut.

You can define this dimension when you
have set the bottom landing type to
notched.

0 mm

11 Define the width of the steps. 0 mm
12 Define the dimension to shorten the steps

equally on both sides.
1000 mm

13 Define the horizontal gap between the
upper supporting part and the stringer
cut.

You can define this dimension when you
have set the top landing type to notched.

0 mm

14 Define the vertical gap between the upper
supporting part and the stringer cut.

You can define this dimension when you
have set the top landing type to notched.

0 mm

15 Define this dimension based on the
selected top landing type:

• Horizontal top landing.

Define the distance between the upper
point and the end of the stringer.

0 mm
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Description Default
• Notched top landing.

Define the horizontal distance between
the upper point and the stringer
vertical cut. By default the cut is made
at the supporting part edge.

If you set this dimension to 0 mm, the top
landing is not created.

16 Select the step spacing type:

• Exact creates the steps of exactly the
defined height. Enter the number of
steps as an integer.

• Equal creates the required number of
steps from the bottom to the top, with
the height calculated as close as
possible to the defined step height.

The spacing type controls how the vertical
spacing between the steps is calculated.

If you select Exact and set the bottom
landing type to horizontal or vertical lower
point, the steps are spaced from the upper
point to the lower point. In all other cases
the steps are spaced from the lower point
to the upper point.

Equal

17 Enter the number of steps.

This option depends on step spacing type
and step spacing.

If you set the step spacing type to Exact,
or to Equal and the spacing distance is not
defined, Wooden steps pan (S72) creates
the number of steps you have defined.

Calculated from the
vertical distance
between the 2
picked points and
the spacing between
steps (3)

Vertical landing offset

Define the vertical offset for the left and right horizontal landing at the top and
bottom of the stringers.

Stair setup tab
Use the Stair setup tab to control the part properties, top and bottom steps,
position of the stairs on the horizontal plane, and rotation of stringers and
steps.
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Stair part properties

 Part Description Default
1 Left stringer Always created

Select a profile from the
profile catalog.

BLU400*2
The default name is
STRINGER.

1 Right stringer Always created

Select a profile from the
profile catalog.

BLU400*2
The default name is
STRINGER.

2 Upper H plate Created only if the top
of the stringer is on the
supporting beam.

6 mm
The default name is PLATE.

3 Upper V plate Created only if the top
of the stringer in on the
supporting beam.

6 mm
The default name is PLATE.

4 Lower V plate Created only if the
bottom of the stringer
in on the supporting
beam.

6 mm
The default name is PLATE.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Stair setup settings

Option Description
Create
assembly

Define which parts of the stair component form an
assembly. The default is stringers.

Stringer
reference line

• Above: The line positioned on the inside of the stairs on
the top face is used as the reference line.

• Nosing: The nosing line of the steps is used as the
reference line.

The reference line is used for workshop drawings.
Steps rotation Rotation of the step around its axis. The default is Top.
Position in
plane

Position of the stairs. The middle line of steps is used as the
reference line. The default is Right.

Offset Offset of the stairs on the plane from the position that is
set in the Position in plane option.

The default offset is 0 mm.
Stringer
rotation

Rotation of the stringer around its axis. The default is top

.
Create top step Define whether the first step of the stairs (the highest step)

is created. By default, the first step is created.
Create bottom
step

Define whether the last step of the stairs (the lowest step)
is created. By default, the last step is created.
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Bolts tab
Use the Bolts tab to control the properties of the bolt group that connects the
wooden steps to the brackets.

Bolt group dimensions

Description Default
1 Bolt edge distance. bolt diameter * 1.5
2 Number of bolts. 2
3 Bolt spacing. Use a

space to separate bolt
spacing values. Enter a
value for each space
between bolts. For
example, if there are 3
bolts, enter 2 values.

100 mm

Bolting direction

Use to change the direction of bolts.

Option Description
Default.

Bolted from the bracket to the step.
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Option Description
Bolted from the step to the bracket.

Bolt basic properties

 Description Default
Bolt size Bolt diameter. 20 mm
Bolt standard The bolt standard to be

used inside the
component.

7990

Tolerance The gap between the
bolt and the hole.

2 mm

Thread in mat Defines whether or not
the thread may be
within the bolted parts
when using bolts with a
shaft. This has no effect
when using full-threaded
bolts.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Wooden pan tab
Use the Wooden pan tab to define the step profile and the properties of the
folded plate brackets.
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Step bracket and profile

Part Description Default
Step
bracket

To create a step
bracket, select a
profile from the
profile catalog.

PL10*150

Step
profile

To create steps,
select a profile from
the profile catalog.

 

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Bracket dimensions
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Description Default
Define the offset dimension that moves the
folded bracket plates relative to the center
line of the stringer.

0 mm

Define the thickness of the steps that will be
placed on the folded brackets. The actual
steps will not be created, only the brackets
height will be resized.

0 mm

Define the angle for the bracket to be folded,
in degrees.

0

Welds

Click the link below to find out more:

Polybeam pan (S73)
Polybeam pan (S73) creates straight stairs with optional top and bottom
landings. The stairs consist of stringers, possible landings, and the actual steps
created with plates.

Objects created

• Stringers

• Steps

• Landings (optional)

• Cuts to notch the stringer (optional)

• Plates (optional)

• Bolts

• Welds
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Use for

Situation Description
Polybeam pan stairs.

Top of the stringer is
created as horizontal
landing.

Bottom of the
stringer is notched
to bear on the
supporting beam.

The same option is
also available for the
top of the stringer.

Before you start

If the stringers are notched to bear on the supporting beams, create the
supporting beams before creating the stairs.

Selection order

1. Pick a point to indicate the nosing point of the first step.
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2. Pick another point to indicate the nosing point of the last step.

Note that the order in which the points are picked has no effect.

3. Click the middle mouse button to create the stairs.

If you have selected the following notched options on the Picture tab,
select the supporting beams and then click the middle mouse button.

Part identification key
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 Part
1 Stringer
2 Step
3 Landings

Picture tab
Use the Picture tab to control the stringer geometry and the nosing points of
the steps.

Top landing type

Option Description
Default

Horizontal landing

Notched

The stringer top is on the supporting
part. Vertical and horizontal plates are
welded at the end of the stringer.

Bottom landing type

Option Description
Default
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Option Description
Vertical

Creates a vertical landing where the
lower picked point is on the top plane
of the last step.

Horizontal

Creates a horizontal landing where
the lower picked point is on the top
plane of the last step.

Vertical lowered point

The picked point is at the top of steel
or finish floor.

Horizontal lowered point

The picked point is at top of steel or
finish floor.

Notched

Created a notch to the bottom of the
stringer to bear on the supporting
part. A vertical plate is welded at the
end of the stringer.
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Stair dimensions

 Description Default
1 Define the distance between the upper

point and the end of the left top landing.

If you set the value to 0 mm, the left top
landing is not created.

If you set the top landing type to notched,
define the cut dimension of the horizontal
plate from the stringer edge.

0 mm

2 Define the vertical distance from the upper
point to the top of steel of the top landing.

If the top landing is not created, the
stringer top of steel is used.

If you set the top landing type to notched,
define the vertical distance from the upper
point to the stringer top horizontal cut.

200 mm
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 Description Default
3 Define the maximum distance allowed

between two consecutive steps.

The spacing between the steps is
calculated using the step spacing type
Exact or Equal, and the number of steps.

For example, if the step height should be
200 mm, the Exact setting creates steps of
exactly this height (enter the number of
steps as an integer). The Equal setting
creates the required number of steps from
the bottom to the top, with the height
calculated as close to 200 mm as possible.

(Z*220)/(Z+220) mm,

where Z is the vertical
distance between the 2
picked points.

4 Select the direction of the nosing
dimension of the steps:

• Vertical

• Horizontal

• Perpendicular

Vertical

5 Define the nosing dimension of the steps.
This dimension depends on the direction
you have selected.

0 mm

6 Define this dimension based on the
selected bottom landing type:

• Horizontal or horizontal lowered point
bottom landing

Define the vertical distance from the
lower point to the top of steel of the
bottom landing.

• Vertical or vertical lowered point
bottom landing

Define the horizontal distance from the
lower picked point to the most distant
face of the bottom landing.

• Notched bottom landing

Define the horizontal distance from the
lower point to the stringer vertical cut.
By default, the cut is made at the
supporting part edge.

150 mm

7 Define the vertical dimension from the
lower point to the first step.

You can define this dimension when the
step spacing type is set to Equal and the

Equal with vertical spacing
between steps
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 Description Default
bottom landing type is either vertical or
horizontal lowered point.

8 Define the cut dimension of the vertical
plate from the stringer edge.

You can define this dimension when the
bottom landing type is set to notched.

0 mm

9

12

Define this dimension based on the
selected bottom landing type:

• Horizontal or horizontal lowered point
bottom landing.

Define the horizontal edge distance
between the lower point and the
bottom landing.

• Vertical or vertical lowered point
bottom landing.

Define the vertical edge distance
between the lower point and the lowest
point of the bottom landing.

600 mm

10 Define the vertical gap between the lower
supporting part and the stringer cut.

You can define this dimension when you
have set the bottom landing type to
notched.

0 mm

11 Define the horizontal gap between the
lower supporting part and the stringer cut.

You can define this dimension when you
have set the bottom landing type to
notched.

0 mm

13 Define the dimension to shorten the steps
equally on both sides.

0 mm

14 Define the width of the steps. 1000 mm
15 Define the horizontal gap between the

upper supporting part and the stringer cut.

You can define this dimension when you
have set the top landing type to notched.

0 mm

16 Define the vertical gap between the upper
supporting part and the stringer cut.

You can define this dimension when you
have set the top landing type to notched.

0 mm
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 Description Default
17 Define this dimension based on the

selected top landing type:

• Horizontal top landing.

Define the distance between the upper
point and the end of the stringer.

• Notched top landing.

Define the horizontal distance between
the upper point and the stringer
vertical cut. By default the cut is made
at the supporting part edge.

If you set this dimension to 0 mm, the top
landing is not created.

0 mm

18 Select the step spacing type:

• Exact creates the steps of exactly the
defined height. Enter the number of
steps as an integer.

• Equal creates the required number of
steps from the bottom to the top, with
the height calculated as close as
possible to the defined step height.

The spacing type controls how the vertical
spacing between the steps is calculated.

If you select Exact and set the bottom
landing type to horizontal or vertical lower
point, the steps are spaced from the upper
point to the lower point. In all other cases
the steps are spaced from the lower point
to the upper point.

Equal

19 Enter the number of steps.

This option depends on step spacing type
and step spacing.

If you set the step spacing type to Exact, or
to Equal and the spacing distance is not
defined, Polybeam pan (S73) creates the
number of steps you have defined.

Calculated from the
vertical distance between
the picked points and the
spacing between the
steps

Vertical landing offset

Define the vertical offset for the left and right horizontal landing at the top and
bottom of the stringers.
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Stair setup tab
Use the Stair setup tab to control the part properties, top and bottom steps,
position of the stairs on the horizontal plane, and rotation of stringers and
steps.

Stair part properties

 Part Description Default
1 Left stringer Always created

Select a profile from the
profile catalog.

BLU400*2
The default name is
STRINGER.

1 Right stringer Always created

Select a profile from the
profile catalog.

BLU400*2
The default name is
STRINGER.

2 Upper H plate Created only if the top
of the stringer is on the
supporting beam.

6 mm
The default name is PLATE.

3 Upper V plate Created only if the top
of the stringer in on the
supporting beam.

6 mm
The default name is PLATE.
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 Part Description Default
4 Lower V plate Created only if the

bottom of the stringer
in on the supporting
beam.

6 mm
The default name is PLATE.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Stair setup settings

Option Description
Create
assembly

Define which parts of the stair component form an
assembly. The default is stringers.

Stringer
reference line

• Above: The line positioned on the inside of the stairs on
the top face is used as the reference line.

• Nosing: The nosing line of the steps is used as the
reference line.

The reference line is used for workshop drawings.
Steps rotation Rotation of the step around its axis. The default is Top.
Position in
plane

Position of the stairs. The middle line of steps is used as the
reference line. The default is Right.

Offset Offset of the stairs on the plane from the position that is
set in the Position in plane option.

The default offset is 0 mm.
Stringer
rotation

Rotation of the stringer around its axis. The default is top

.
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Option Description
Create top step Define whether the first step of the stairs (the highest step)

is created. By default, the first step is created.
Create bottom
step

Define whether the last step of the stairs (the lowest step)
is created. By default, the last step is created.

Bolts tab
Use the Bolts tab to control the properties of the bolt group that connects the
steps to the stringers.

Bolt group dimensions

Note that if you define the vertical dimensions of the step on the Polybeam
pan tab, the dimensions defined on the Polybeam pan tab are used.

Description Default
1 Bolt edge distance. bolt diameter * 1.5
2 Number of bolts. 2
3 Bolt spacing. Use a

space to separate bolt
spacing values. Enter a
value for each space
between bolts. For
example, if there are 3
bolts, enter 2 values.

100 mm
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Bolting direction

Option Description
Default.

Bolted from the step to the bracket.

AutoDefaults can change this option.
Bolted from the step to the bracket.

Bolted from the bracket to the step.

Bolt basic properties

 Description Default
Bolt size Bolt diameter. 20 mm
Bolt standard The bolt standard to be

used inside the
component.

7990

Tolerance The gap between the
bolt and the hole.

2 mm

Thread in mat Defines whether or not
the thread may be
within the bolted parts
when using bolts with a
shaft. This has no effect
when using full-threaded
bolts.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Slotted holes no Define the number of slotted
holes.

 

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Polybeam pan tab
Use the Polybeam pan tab to define the step profile properties and
dimensions.
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Plate

Part Description Default
Plate profile To create a plate

profile, select a profile
from the profile
catalog.

PL10*150

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
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Step profile dimensions

 Description Default
1 Define the height of the

vertical part of the step.
Vertical dimension value defined on
the Bolts tab.

2 Define the symmetrical
chamfer for the back corner of
the all step plates.

0 mm

Welds

Click the link below to find out more:

Handrail 1 (74)
Handrail 1 (74) connects a column to a beam using a cover plate and an end
plate.

Objects created

• Cover plate

• End plate
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• Bolts

• Welds

• Cuts

Use for

Situation Description
Beam to column connection.

Selection order

1. Select the main part (beam).

2. Select the secondary part (column).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Cover plate
2 End plate
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Picture tab
Use the Picture tab to control the plate dimensions.

Plate dimensions

 Description
1 Horizontal dimension of the cover plate.
2 Distance between the upper edge of the cover plate and the beam

flange.
3 Vertical dimension of the cover plate.
4 Bolt edge distance.

Parts tab
Use the Parts tab to control the plate properties.

Plate

Option Description
Cover plate Cover plate thickness.
End plate End plate thickness.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Material Material grade. The default material is

defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

4 Dimension for horizontal bolt group position.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.
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Option Description Default
Tolerance Gap between the bolt

and the hole.
 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.
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If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Z pan (S74)
Z pan (S74) creates straight stairs with optional top and bottom landings. The
stairs consist of stringers, possible landings, and the actual steps. The steps
can be connected to stringers with horizontal brackets, vertical brackets, or
with bent plate brackets.

Objects created

• Stringers

• Steps
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• Landings (optional)

• Brackets

• Bolts

• Welds

Use for

Situation Description
Stairs with Z-pan steps.
Horizontal top and
bottom landings.

Steps are connected to
stringers with bolted
horizontal brackets.

Stairs with bent plate
brackets.

Steps are connected to
stringers with bent plate
brackets.

Stairs with stringers
notched to the supporting
beam.

Steps are connected to
stringers with vertical and
horizontal brackets.
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Situation Description
Stairs with 90 degree
bends at the top and
bottom of the treads.

Steps are connected to
stringers with vertical and
horizontal brackets.

Red nose profile at the
front edge of the steps.

Before you start

If the stringers are notched to bear on the supporting beams, create the
supporting beams before creating the stairs.

Selection order

1. Pick a point to indicate the nosing point of the first step.

2. Pick another point to indicate the nosing point of the last step.

Note that the order in which the points are picked has no effect.

3. Click the middle mouse button to create the stairs.

If you have selected the following notched options on the Picture tab,
select the supporting beams and then click the middle mouse button.
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Part identification key

 Part
1 Stringer
2 Step
3 Landings

Picture tab
Use the Picture tab to control the stringer geometry and the nosing points of
the steps.

Top landing type

Option Description
Default
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Option Description
Horizontal landing

Notched

The stringer top is on the supporting
part. Vertical and horizontal plates are
welded at the end of the stringer.

Bottom landing type

Option Description
Default

Vertical

Creates a vertical landing where the
lower picked point is on the top plane
of the last step.

Horizontal

Creates a horizontal landing where
the lower picked point is on the top
plane of the last step.
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Option Description
Vertical lowered point

The picked point is at the top of steel
or finish floor.

Horizontal lowered point

The picked point is at top of steel or
finish floor.

Notched

Creates a notch to the bottom of the
stringer to bear on the supporting
part. A vertical plate is welded at the
end of the stringer.
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Stair dimensions

 Description Default
1 Define the distance between the upper

point and the end of the left top landing.

If you set the value to 0 mm, the left top
landing is not created.

If you set the top landing type to notched,
define the cut dimension of the horizontal
plate from the stringer edge.

0 mm

2 Define the vertical distance from the upper
point to the top of steel of the top landing.

If the top landing is not created, the
stringer top of steel is used.

If you set the top landing type to notched,
define the vertical distance from the upper
point to the stringer top horizontal cut.

200 mm
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 Description Default
3 Define the maximum distance allowed

between two consecutive steps.

The spacing between the steps is
calculated using the step spacing type
Exact or Equal, and the number of steps.

For example, if the step height should be
200 mm, the Exact setting creates steps of
exactly this height (enter the number of
steps as an integer). The Equal setting
creates the required number of steps from
the bottom to the top, with the height
calculated as close to 200 mm as possible.

(Z*220)/(Z+220) mm,

where Z is the vertical
distance between the 2
picked points.

4 Select the direction of the nosing
dimension of the steps:

• Vertical

• Horizontal

• Perpendicular

Vertical

5 Define the nosing dimension of the steps.
This dimension depends on the direction
you have selected.

0 mm

6 Define this dimension based on the
selected bottom landing type:

• Horizontal or horizontal lowered point
bottom landing

Define the vertical distance from the
lower point to the top of steel of the
bottom landing.

• Vertical or vertical lowered point
bottom landing

Define the horizontal distance from the
lower picked point to the most distant
face of the bottom landing.

• Notched bottom landing

Define the horizontal distance from the
lower point to the stringer vertical cut.
By default, the cut is made at the
supporting part edge.

150 mm

7 Define the vertical dimension from the
lower point to the first step.

You can define this dimension when the
step spacing type is set to Equal and the

Equal with vertical spacing
between steps
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 Description Default
bottom landing type is either vertical or
horizontal lowered point.

8 Define the cut dimension of the vertical
plate from the stringer edge.

You can define this dimension when the
bottom landing type is set to notched.

0 mm

9

12

Define this dimension based on the
selected bottom landing type:

• Horizontal or horizontal lowered point
bottom landing.

Define the horizontal edge distance
between the lower point and the
bottom landing.

• Vertical or vertical lowered point
bottom landing.

Define the vertical edge distance
between the lower point and the lowest
point of the bottom landing.

600 mm

10 Define the vertical gap between the lower
supporting part and the stringer cut.

You can define this dimension when you
have set the bottom landing type to
notched.

0 mm

11 Define the horizontal gap between the
lower supporting part and the stringer cut.

You can define this dimension when you
have set the bottom landing type to
notched.

0 mm

13 Define the dimension to shorten the steps
equally on both sides.

0 mm

14 Define the width of the steps. 1000 mm
15 Define the horizontal gap between the

upper supporting part and the stringer cut.

You can define this dimension when you
have set the top landing type to notched.

0 mm

16 Define the vertical gap between the upper
supporting part and the stringer cut.

You can define this dimension when you
have set the top landing type to notched.

0 mm
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 Description Default
17 Define this dimension based on the

selected top landing type:

• Horizontal top landing.

Define the distance between the upper
point and the end of the stringer.

• Notched top landing.

Define the horizontal distance between
the upper point and the stringer
vertical cut. By default the cut is made
at the supporting part edge.

If you set this dimension to 0 mm, the top
landing is not created.

0 mm

18 Select the step spacing type:

• Exact creates the steps of exactly the
defined height. Enter the number of
steps as an integer.

• Equal creates the required number of
steps from the bottom to the top, with
the height calculated as close as
possible to the defined step height.

The spacing type controls how the vertical
spacing between the steps is calculated.

If you select Exact and set the bottom
landing type to horizontal or vertical lower
point, the steps are spaced from the upper
point to the lower point. In all other cases
the steps are spaced from the lower point
to the upper point.

Equal

19 Enter the number of steps.

This option depends on step spacing type
and step spacing.

If you set the step spacing type to Exact, or
to Equal and the spacing distance is not
defined, Z pan (S74) creates the number of
steps you have defined.

Calculated from the
vertical distance between
the picked points and the
spacing between the
steps

Vertical landing offset

Define the vertical offset for the left and right horizontal landing at the top and
bottom of the stringers.
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Stair setup tab
Use the Stair setup tab to control the part properties, top and bottom steps,
position of the stairs on the horizontal plane, and rotation of stringers and
steps.

Stair part properties

 Part Description Default
1 Left stringer Always created

Select a profile from the
profile catalog.

BLU400*2
The default name is
STRINGER.

1 Right stringer Always created

Select a profile from the
profile catalog.

BLU400*2
The default name is
STRINGER.

2 Upper H plate Created only if the top
of the stringer is on the
supporting beam.

6 mm
The default name is PLATE.

3 Upper V plate Created only if the top
of the stringer in on the
supporting beam.

6 mm
The default name is PLATE.
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 Part Description Default
4 Lower V plate Created only if the

bottom of the stringer
in on the supporting
beam.

6 mm
The default name is PLATE.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Stair setup settings

Option Description
Create
assembly

Define which parts of the stair component form an
assembly. The default is stringers.

Stringer
reference line

• Above: The line positioned on the inside of the stairs on
the top face is used as the reference line.

• Nosing: The nosing line of the steps is used as the
reference line.

The reference line is used for workshop drawings.
Position in
plane

Position of the stairs. The middle line of steps is used as the
reference line. The default is Right.

Offset Offset of the stairs on the plane from the position that is
set in the Position in plane option.

The default offset is 0 mm.
Stringer
rotation

Rotation of the stringer around its axis. The default is top

.
Create top step Define whether the first step of the stairs (the highest step)

is created. By default, the first step is created.
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Option Description
Create bottom
step

Define whether the last step of the stairs (the lowest step)
is created. By default, the last step is created.

Bracket Select how the steps are connected to the stringers:

• Default

• Horizontal bracket

• Horizontal and vertical brackets

• Bent plate bracket

Z pan tab
Use the Z pan tab to control the size and shape of the Z pan steps.

Profiles

Profile Description Default
Step profile Step profile is calculated

from the thickness you
enter for the Z pan plate
when defining the Z pan
dimensions.

Select an appropriate
material for the step
profile. In the US imperial
environment, Tekla
Structures saves the
selected material in the
Gage material user-
defined attribute of the
step profile. You can use
this information in
reports and in the bill of
material of drawings.

 

Nose profile Created only if Nosing
piece is set to Create
nose.

To create the nose profile,
select the profile from the
profile catalog.

PL160*10
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Z pan dimensions
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 Description Default
1

2

Define the chamfer dimensions
for the front edge.

15 mm

3 Define the length of the front
part of the step according to the
selected front edge type.

40 mm

4 Define back wall slope width
between the nosing point
vertical line and the Z pan back
wall (concrete level lip set-off
point).

100 mm

5 Define the height of the inner
step dimension where the
concrete will be poured.

100 mm

6

7

Define the width and height of
the bottom step.

height = 200 mm
width = 0 mm

8 Define the horizontal dimension
for the Z pans that have a
skewed front edge.

60 mm

9 Define the thickness of the Z pan
plate.

10 mm

10

11

Define the lip dimensions of the
back wall of the step.

You can define these dimensions
if Back wall type is set to Lip.

15 mm

12 Define the horizontal length of
the top step.

This is the horizontal distance
between the top nosing point
and the end of the top step
horizontal section.

300 mm

13 Define the height of the top
step.

This is the vertical distance
between the top nosing point
and the end of the top step
horizontal end.

100 mm

14 Define the bottom line clearance
for the steps that prevent the
bottom portion of the Z pan
from overlapping the bottom
end of the stringer.

20 mm
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Chamfer type

Select the shape of the step front edge.

Option Description
None

Line

Rounding

Arc

Back wall type

Select the Z pan back wall type.

Option Description
Default

Lip

Straight

Front edge type

Select how a pan connects to the pan below.

Steel components 1560 Stairs



Option Description Example
Default

Rectangular front edge.

AutoDefaults can change
this option.

Skewed front edge.

Pan overlaps the lower
one and continues in the
same angle as the back
wall.

Rectangular front edge.

Pans do not overlap
each other.

Rectangular front edge.

Pan overlaps the lower
one and continues in the
same angle as the back
wall.

Rectangular front edge.

Pan overlaps the lower
one and continues at a
30-degree angle.

Nosing piece

Select whether the nosing piece is created on top of the step.

Option Description
Default

No nose.

AutoDefaults can change this option.
No nose.

Create nose.
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Horizontal part

Select whether the bottom pan has a horizontal part. Enter the vertical
distance from the bottom of the pan to the top level of the Z pan (concrete
slab thickness) in Z pan dimensions.

Option Description
Default

Create horizontal part.

AutoDefaults can change this option.

Create horizontal part.

No horizontal part.

Horizontal bracket tab
Use the Horizontal bracket tab to control the properties and attachment of
the horizontal brackets. The horizontal brackets are angle profiles underneath
the treads.

Preconditions

Before you can set the properties of the horizontal brackets, set the following
option:

• On the Stair set-up tab, set Bracket to Horizontal bracket or Horizontal
and vertical brackets.

L profile
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Part Description Default
L profile Created only if brackets are

created.

Select the profile from the
profile catalog.

BLL80*80*10

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Bracket dimensions

  
1 Define the length of the bracket.

The default length is calculated according to bracket-to-step or
bracket-to-stringer bolt dimensions, depending on which one is
bigger.

Steel components 1563 Stairs



  
2 Define the dimension to offset the bracket from the center line of

the thread.

The default in 0 mm.

Bracket-to-step connection

Define the properties of the bolts that connect the brackets to the steps.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Slotted holes no Define the number of slotted
holes.

 

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt group dimensions

Description Default
1 Bolt edge distance. bolt diameter * 1.5
2 Number of bolts. 2
3 Bolt spacing. Use a

space to separate bolt
spacing values. Enter a
value for each space
between bolts. For

100 mm
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Description Default
example, if there are 3
bolts, enter 2 values.

Bracket-to-step connection type

Option Description
Default.

Bolted.

Welded.

No connection.

No bracket angle leg.

The bracket is a plate instead of an
angle.

Holes only.

Bolting direction

Option Description
Default.

Bolted from the bracket to the step.
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Option Description
Bolted from the step to the bracket.

Bracket-to-stringer connection

Define the properties of the bolts that connect the brackets to the stringers.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Steel components 1567 Stairs



Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Slotted holes no Define the number of slotted
holes.

 

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt group dimensions

Description Default
1 Bolt edge distance. bolt diameter * 1.5
2 Number of bolts. 2
3 Bolt spacing. Use a

space to separate bolt
spacing values. Enter a
value for each space
between bolts. For

100 mm
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Description Default
example, if there are 3
bolts, enter 2 values.

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bracket-to-stringer connection type

Option Description
Default.

Bolted.

AutoDefaults can change this option.

Bolted.

Welded.

No connection.
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Bolting direction

Option Description
Default.

Bolted from the bracket to the
stringer.

AutoDefaults can change this option.
Bolted from the bracket to the
stringer.

Bolted from the stringer to the
bracket.

Bracket position

Define the position of the plate-type bracket. The bracket can be positioned
below the step, or between the step and the stringer.

You can define the bracket position if the bracket is a created as a plate
instead of an angle.

Option Description
Default

Below the step.

AutoDefaults can change this option.
Below the step.

Between the stringer and step.

Vertical bracket tab
Use the Vertical bracket tab to control the properties and attachment of the
vertical brackets. The vertical brackets are angle profiles underneath the
treads and they support the vertical portion of the stair treads.
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Preconditions

Before you can set the properties of the vertical brackets, set the following
options:

• On the Stair set up tab, set Bracket to Horizontal and vertical brackets.

• On the Z pan tab, set the Back wall type to Straight.

L profile

Part Description Default
L profile Created only if brackets are

created.

Select the profile from the
profile catalog.

BLL80*80*10

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
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Option Description Default
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Bracket dimensions

 Description Default
1 Define the height of the

bracket.
Default height is calculated according
to bracket-to-step or bracket-to-
stringer bolt dimensions, depending
on which one is bigger.

2 Define the dimension to
offset the bracket from
the Z pan edge.

25 mm

Bracket-to-step connection

Define the properties of the bolts that connect the brackets to the steps.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Slotted holes no Define the number of slotted
holes.

 

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt group dimensions

Description Default
1 Bolt edge distance. bolt diameter * 1.5
2 Number of bolts. 2
3 Bolt spacing. Use a

space to separate bolt
spacing values. Enter a
value for each space
between bolts. For
example, if there are 3
bolts, enter 2 values.

100 mm
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Bracket-to-step connection type

Option Description
Default.

Bolted.

Welded.

No connection.

No bracket angle leg.

The bracket is a plate instead of an
angle.

Holes only.

Bolting direction

Option Description
Default.

Bolted from the bracket to the step.

Bolted from the step to the bracket.
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Bracket-to-stringer connection

Define the properties of the bolts that connect the brackets to the stringers.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Slotted holes no Define the number of slotted
holes.

 

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt group dimensions

Description Default
1 Bolt edge distance. bolt diameter * 1.5
2 Number of bolts. 2
3 Bolt spacing. Use a

space to separate bolt
spacing values. Enter a
value for each space
between bolts. For
example, if there are 3
bolts, enter 2 values.

100 mm
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Bracket-to-stringer connection type

Option Description
Default.

Bolted.

AutoDefaults can change this option.

Bolted.

Welded.

No connection.

Bolting direction

Option Description
Default.

Bolted from the bracket to the
stringer.

AutoDefaults can change this option.
Bolted from the bracket to the
stringer.

Bolted from the stringer to the
bracket.

Bracket position

Define the position of the plate-type bracket. The bracket can be positioned
below the step, or between the step and the stringer.

You can define the bracket position if the bracket is a created as a plate
instead of an angle.
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Option Description
Default

Below the step.

AutoDefaults can change this option.
Below the step.

Between the stringer and step.

Bent plate bracket tab
Use the Bent plate bracket tab to control the dimensions and other
properties of the bent plate bracket. You can use the bent plate bracket for
connecting the Z pan steps to the stringers instead of horizontal or vertical
brackets.

Preconditions

To create the bent plate bracket, set the following options:

• On the Stair setup tab, set Bracket to Bent plate bracket.

• On the Z pan tab, set Front edge type to the following option:

Bent plate profile

Part Description Default
Bent plate
profile

Created if Bracket is set to
Bent plate bracket on the
Stair setup tab.

BPL80*10
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Create top step bent plate bracket

Select whether to create the bent bracket for the top step.

Option Description
Default

Bent plate bracket is not created.

AutoDefaults can change this option.
Bent plate bracket is not created.

Bent plate bracket is created.

Create bottom step bent plate bracket

Select whether to create the bent bracket for the bottom step.

Option Description
Default

Bent plate bracket is not created.

AutoDefaults can change this option.

Steel components 1580 Stairs



Option Description
Bent plate bracket is not created.

Bent plate bracket is created.

Bent bracket dimensions

 Description Default
1 Define the horizontal distance

from the step corner to the
bent plate edge.

200 mm

2 Define the vertical distance
from the step corner to the
bent plate edge.

100 mm

3 Define the radius of the round
bending.

1 / 3 * vertical
dimension

Welds

Click the link below to find out more:

Kickplate (S75)
Kickplate (S75) creates one or more kickplates at the bottom of stanchions.

Objects created

• Kickplates
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• Welds

Use for

Situation Description
Kickplates are connected to
stanchions.

Before you start

Create stringers, beams, or slabs, and then stanchions using the Stanchions
(S76) component, for example.

Selection order

1. Select the main parts (stringers/beams/slabs).

2. Select the first stanchion.

3. If Stanchion selection on the Picture tab is set to Default or Use all, and
the stanchions have been created with Stanchions (S76), click the middle
mouse button to create the component.

If the stanchions are modeled separately or Stanchion selection is set to
Use selected, select the second stanchion, then third and so on, and click
the middle mouse button.

Note that if you modify the component, all connected components will be
deleted. For example, modifying stanchions deletes the connected kickplates
and railings.

Part identification key

 Description
1 Kickplate
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Picture tab
Use the Picture tab to define the kickplate dimensions, chamfers, and sides.

Part selection

Option Description Default
Stair parts selection Define how the stringers or

beams are considered:

• Use selected: Only the
selected stringers are
considered for creating
kickplates on.

• Use all: If one or more of
the selected stringers are
part of a stair, then all the
stringers in the same
direction with the selected
one, inside the stair, will be
selected as well.

Use all

Stanchion selection • Use selected: Only the
selected stanchions are
considered for creating
kickplates on.

• Use all: If one or more of
the selected stanchions are
part of a stanchions macro,
then all the stanchions in
the same direction with the
selected one, inside the
stair macro, will be
selected as well.

Use all

Kickplate on skewed stringer

  
Default

Kickplate is created on the skewed
stringer.

AutoDefaults can change this option.
Kickplate is not created on the
skewed stringer.

Kickplate is created on the skewed
stringer.
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Dimensions

 Description Default
1 Horizontal chamfer for the plate corner. 0 mm
2 Vertical chamfer for line chamfers and chamfer

radius for round chamfers.

If a kickplate is split in pieces, only the first and last
piece will be chamfered.

0 mm

3 Kickplate height, referenced to the floor height. 200 mm
4 Kickplate extensions for the left or right sides. 150 mm
5 Floor height 0 mm

 Description Default
1 Gap between the kickplates and the stanchions.

The offset direction of the plates depends on which
side of the stanchions the plates are created.

0 mm
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 Description Default
1 Gap between two consecutive kickplates.

The dimension is considered perpendicular on the
bisecting lines between the two plates and is
calculated from the closest corners between the
points.

10 mm

Chamfer type

Chamfer type for the top vertical corners of the kickplate. If the plate is split in
pieces, only the first and last piece are chamfered.

Option Option Description
Default

Line chamfer

AutoDefaults can change
this option.
Line chamfer

Round chamfer

Kickplate side

Option Description
Default

Kickplates are created on the left side
of the stanchions.

AutoDefaults can change this option.
Kickplates are created on the left side
of the stanchions.

Kickplates are created on the right
side of the stanchions.

Steel components 1585 Stairs



Option Description
Kickplates are centred on the
stanchions line, and they are split in
pieces between the stanchions.

Rotation

Select a suitable kickplate rotation option.

Options

Parameters tab
Use the Parameters tab to define the part properties, and kickplate cut and
connection type.

Parts

Option Description Default
Kickplate Select the profile from

the profile catalog.

The kickplate is created
as a polygon plate if you
do not select a profile.

 

Profile max. length Maximum length of the
kickplate.

5000 mm

Kick plate as contour
plate

Define how the kick
plate is created.

• Select Yes to create it
as a contour plate.

• Select No to create
the kick plate as the
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Option Description Default
selected beam
profile.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Kickplate cut type

Option Description
Default

No cut

AutoDefaults can change this option.
No cut

Cut at maximum length

The kickplate is split in pieces if its
total length is more than defined in
Profile max length.
Cut at every stanchion

The kickplate is split in pieces by cut
planes defined by the stanchion
centre lines.
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Connection type

 Description
1 Connection type between one or two kickplate pieces and a

stanchion (main part).
2 Connection type between two consecutive kickplate pieces.

Option Description
Default

No connection

AutoDefaults can change this option.
No connection

Welding

Connection

When you set the connection type to
connection, a standard Tekla
Structures connection is used as
defined in Connection name and
Attribute file.

Option Description
Default

No connection

AutoDefaults can change this option.
No connection

Welding
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Option Description
Connection

When you set the connection type to
connection, a standard Tekla
Structures connection is used as
defined in Connection name and
Attribute file.

Gap between plates

 Description
1 Gap between two consecutive pieces of the same kickplate.

Welds

Click the link below to find out more:

Stanchions (S76)
Stanchions (S76) creates stanchions on one or more horizontal or skew stair
stringers. Stanchions can also be used on concrete slabs.

Objects created

• First stanchion

• Middle stanchions

• Last stanchion
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Use for

Situation Description
Stanchions bolted on a stringer.

Limitations

NOTE If you modify Stanchions (S76), all connected components are
deleted. For example, modifying the stanchions deletes stairs, railings,
and other components connected to the stanchions.

Before you start

Create stringers, beams, or slabs or other parts to connect the stanchions.

Selection order

1. Pick the start point.

2. Pick the end point.

3. Select the lower landing (optional).

4. Select the stringer.

5. Select the upper landing (optional).

Click the middle mouse button to create the component.
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Part identification key

 Part
1 First stanchion
2 Middle stanchions
3 Last stanchion

Picture tab
Use the Picture tab to control the stanchion creation.

Stair parts selection

By default, the Use all option is used.

• Use selected: the stanchions are created only to the selected parts.

• Use all: if you have created one or more stringers using a stair component,
select this option.

All the stringers which are part of the stair component and have the same
direction are selected.
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Part positions

 Description Default
1 Additional height to the stanchion.  
2 Height of the floor level. 1300 mm
3 Stanchion bottom point vertical offset. 0 mm
4 Stanchion bottom point horizontal offset. 0 mm
5 Distance between the second selected

point and the last stanchion.
300 mm

6 Distance between the last two stanchions. 0 mm
7 Space between the stanchions.

Use the value 8 to define the spacing type.

1000 mm

8 Stanchion spacing type.

• Maximum

The spacing value in the box 7 defines
the maximum space between the
stanchions. As many equally spaced
middle stanchions as needed are
created. The space between the
stanchions is less or equal to the
maximum distance.

• Exact

The space between the middle
stanchions is exactly the spacing value
in the box 7. Enter the spacing values

Maximum
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 Description Default
using the following formats: 6*950 or
1000 800 800 1000 800.

9 Distance between the first two stanchions. 0 mm
10 Distance between the first selected point

and the first stanchion.
300 mm

11 Nosing dimension of the steps.  
12 Stanchion height from the floor level. 1300 mm

Nosing direction

Define the nosing direction.

Option Description
Default

Vertical

AutoDefaults can change this option.

Vertical

Horizontal

Perpendicular

Parts tab
Use the Parts tab to control the stanchion profiles.

Stanchion profile

Option Description
First Stanchion Define the first stanchion profile by

selecting it from the profile catalog.

First stanchion is always created.

The default name is STANCHION.
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Option Description
Middle Stanchion Define the middle stanchion profile by

selecting it from the profile catalog.

Middle stanchion is always created.

The default name is STANCHION.
Last Stanchion Define the last stanchion profile by

selecting it from the profile catalog.

Last stanchion is always created.

The default name is STANCHION.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Stanchion profile rotation

Define the stanchion profile rotation and position.

Option Description Default
Profile rotation Stanchion profile

rotation and position.
Rotation = Front
Position = Middle

Rotation value Stanchion profile
rotation angle (in
degrees) and the plane
offset.

Rotation angle = 0
Offset = 0 mm
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Stanchion profile rotation type

Define the rotation combinations for consecutive stanchions.

Option Description
Default

Type 1

AutoDefaults can change this option.
Type 1

Type 2

Type 3

Type 4

Type 5

Parameters tab
Use the Parameters tab to control how the stanchions are connected to the
stairs.

Connection properties

Option Description
Connection setting type Define whether pre-defined or

custom settings are used for
connecting the stanchions to the
stairs.

By default, the pre-defined settings
are used.

Stanchion connection type Connection type for stanchions.

By default, the weld default
connection type is used.

This field is active only if you have set
the Connection setting type to Pre-
defined settings.

Connection number Define a connection that connects
stanchions to the stairs by selecting it
from the component catalog.

Connection properties Select an attribute file for the
connection.

Direction Connection direction.
Stanchion product name Enter the product name.
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Railings (S77)
Railings (S77) creates railings connected to two or more stanchions. The
railings can be handrails in stairs or guardrails in a horizontal beam or slab.

Objects created

• Top rail

• Middle rails (horizontal or vertical)

• Bottom rail

• Panels

• Bends

Use for

Situation Description
Horizontal railings

Horizontal railings connected to four
stanchions
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Situation Description
Vertical railings connected to four
stanchions

Guardrail with vertical railings

Before you start

Create the stanchions using, for example, Stanchions (S76).

Selection order

1. Select the first stanchion.

2. If the stanchions are created with Stanchions (S76), and on the Picture
tab the Stanchion selection is set to Use all or Default, the railings are
created when you click the middle mouse button.

OR

1. Select the first stanchion.

2. If the stanchions are created separately, or on the Picture tab the
Stanchion selection is set to Use selected, select the second, third, and
so on, stanchion.

The order in which the stanchions are selected defines the positioning of
the railings. The two first selected stanchions define the left and right
directions of the railings.

3. Click the middle mouse button to create the railings.
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Part identification key

 Part
1 Top rail
2 Vertical rails
3 Middle rails
4 Bottom rail

Picture tab
Use the Picture tab to control the railings and the closures.

Stanchion selection

By default, the Use all option is used.

• Use selected: the railings are created only to the selected stanchions.

• Use all: select this option when the stanchions are created with
Stanchions (S76).
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Part positions

 Description Default
1 Horizontal length of the closure in the top rail

and where the bending is created in the
closure.

When you use the closure type 4 and enter a
negative value in this box, the top and
bottom rails are shortened.

150 mm

2 Horizontal length of the closure in the
bottom rail.

When you use the closure type 4 and the
value in the 1 box is 0, you can shorten the
bottom rails by entering a positive value in
this box.

150 mm

3 Vertical length of the closure.

Available for closure types 2 and 3.

half the value of 5

4 Full horizontal length of the closure from the
first or the last stanchion.

300 mm

5 Distance between the top and the bottom
rails.

If the middle rails are positioned evenly
between the top and bottom rails, the
spacing between them is adjusted if the
distance between the top and the bottom
rails is modified.

800 mm
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 Description Default
6 Height of the railing from the floor level.

If you modify the floor level, the height of the
railing is modified as well.

defined by the
height of the
stanchion

7 Length of the stanchion extension over the
railing.

Use this option if the Top rail to stanchion
fitting is set to Stanchion partcut on the
Parameters tab.

0 mm

8 Floor level from the bottom of the stanchion.

If you modify the floor level, the height of the
railing is modified as well.

0 mm

9 Select whether to keep the same distance
between the bottom rail and the bottom of
the stanchions.

No

Railing offset

 Description
1 Vertical distance between the middle rails and the stanchion center.
2 Vertical distance between the top or the bottom rail and the

stanchion center.

Left and right closure

Option Description
Default

Type 1

AutoDefaults can change
this option.
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Option Description
Type 1

Type 2

Type 3

Type 4

Parameters tab
Use the Parameters tab to control the cuts, fitting, and gaps between the
railing parts.

Continuity profile

Option Description
Top Continuity profile Define the continuity profile by

selecting it from the profile catalog.

The top continuity profile is created if
the length of the continuous profile is
more than 0 and Top rail parts gap is
set to Yes.

The default name is RAIL.
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Option Description
Middle Continuity profile Define the continuity profile by

selecting it from the profile catalog.

The middle continuity profile is
created if the length of the
continuous profile is more than 0 and
Midd. rail parts gap is set to Yes.

The default name is RAIL.
Bottom Continuity profile Define the continuity profile by

selecting it from the profile catalog.

The bottom continuity profile is
created if the length of the
continuous profile is more than 0 and
Bott. rail parts gap is set to Yes.

The default name is RAIL.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Rail length

Option Description Default
Top rail max. length Maximum length of the

top rail.
3000 mm
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Option Description Default
Middle rail max. length Maximum length of the

middle rail.
3000 mm

Bottom rail max.
length

Maximum length of the
bottom rail.

3000 mm

Rail fittings

Option Description
Top rail to stanchion fitting Select the fitting type between the top

rail and the stanchions.

Define the cut tolerance and the
fitting distance using the Top
stanchion cut tolerance and Top
rail to stanchion fitting distance
options. The parts are first cut and
then fitted.

By default, no fitting is created.

•

No fitting is created.

•

Stanchions are fitted to rail.

•

Stanchions are cut by a horizontal
plane.

•

Stanchions are cut by the rails.
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Option Description
•

Rails are cut by the stanchions.
Top rail to stanchion fitting
distance

Fitting distance between the top rail
center line and the stanchion.

Top stanchion cut tolerance Cut tolerance between the top rail
and the stanchions.

Option Description
Top rail at end stanchions Select the fitting type between the top

rail and the first or last stanchion if
the start or end closure is not created.

• Corner is not fitted. This is the
default option.

• Corner is fitted on both sides and
a bent part is created.

• Corner is not fitted.

• Corner is fitted in the middle.

Option Description
Other rail to stanchion fitting Select the fitting type between the

middle or bottom rail and the
stanchions.

Define the cut tolerance and the
fitting distance using the Other
stanchion cut tolerance and Other
rail to stanchion fitting distance
options. The parts are first cut and
then fitted.

By default, no cuts are created.
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Option Description
•

No cut is created.

•

Stanchions are cut by the rails.

•

Rails are cut by the stanchions.

•

Stanchions are cut by the rails
through a slotted hole.

•

Rails are fitted to the stanchions.

•

Rails are cut by the stanchions
without any tolerance.

Other rail to stanchion fitting
distance

Fitting distance between the middle
or bottom rail center line and the
stanchion.

Other stanchion cut tolerance Part cut tolerance between the
middle or the bottom rail and the
stanchions.

Steel components 1605 Stairs



Rail cuts

Option Description
Top rail cuts Define how the top rail is cut.

By default, the At max stanchion
option is used.

• At max stanchion

Starting from the first stanchion,
without the closures, the Top rail
max. length is measured along
the rail and the cut is made at the
last stanchion included in the
measured distance.

• At max length

Starting from the first point of the
rail, including the closure, the Top
rail max. length is measured
along the rail and the cut is made
at the maximum length.

• Every stanchion

A cut is made to the rail at each
stanchion.

• At max length no closure

Starting from the first stanchion,
without the closures, the Top rail
max. length is measured along
the rail and the cut is made at the
maximum length.

Middle rail cuts Define how the middle rail is cut.

By default, the At max stanchion
option is used.

Bottom rail cuts Define how the bottom rail is cut.

By default, the At max stanchion
option is used.
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Chamfer dimensions

 Description
1 Horizontal chamfer dimension for the stanchions.
2 Vertical chamfer dimension for the stanchions.

Gap

Option Description
Top rail parts gap

Midd. rail parts gap

Bott. rail parts gap

Select whether a gap is created
between the rail parts.

By default, no gap is created.

Gap between parts

 Description
1 Size of the gap between two consecutive rail parts.
2 Length of the continuous profile.
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Assembly

Option Description
Create assembly Select which part of the railing is the

main part of the assembly.

By default, no assembly is created.

•

No assembly is created. This is
also the default option.

•

The first stanchion is the main part
of the assembly.

•

The last stanchion is the main part
of the assembly.

•

The first rail part after the first
stanchion is the main part of the
assembly.

If you have created continuous
profiles for all the rails, multiple
assemblies are created.

Rails tab
Use the Rails tab to control the profiles, bending cuts, and connections for the
top and the bottom rails.
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Rail and closure profiles

Option Description
Top rail profile Define the top rail profile by selecting

it from the profile catalog.

Top rail is always created.
Bottom rail profile Define the bottom rail profile by

selecting it from the profile catalog.

Bottom rail is always created.
Start closure Define the start closure by selecting it

from the profile catalog.

By default, the Start closure profile is
the same as the Top rail profile.

End closure Define the end closure by selecting it
from the profile catalog.

By default, the End closure profile is
the same as the Top rail profile.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.
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Closure bending cuts

Option Description
Default

No cut

AutoDefaults can change this option.
No cut

No cut is created near the corner.

Both side cuts

The rail corner is cut at the left and
the right side.

The dimensions for the cut are
defined on the Bends tab.
Middle corner cut

The rail corner is cut in the middle.

Mitre corner cut

The rail corner is cut by a plane on the
bisecting line.
Left side cut

The rail corner is cut at the left side.

The dimensions for the cut are
defined on the Bends tab.
Right side cut

The rail corner is cut at the right side.

The dimensions for the cut are
defined on the Bends tab.

Cut position of the rails

Define the cut position for the top and the bottom rails and for the closure
types 1 and 4.

Option Description
Default

Closure near side cut

AutoDefaults can change this option.
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Option Description
Closure near side cut

The rail passes through the first or
the last stanchion and is cut at its
surface.

The closure is cut at the near side
surface of the stanchion, without
intersecting it.
Middle stanchion cut

The rail passes through the first or
the last stanchion and is cut at its
middle line.

The closure is cut at the middle line of
the stanchion, intersecting it.
Closure far side cut

The rail is cut at the surface of the
stanchion, without intersecting it.

The closure is cut at the other far side
surface of the stanchion, intersecting
it.

Cut position for the other bending

Define the cut position for the other bendings than the corners of the
closures.

Option Description
Default

No cut is created.

AutoDefaults can change this option.
No cut is created.

Both side cuts

The rail bending is cut at the left and
the right side.

The dimensions for the cut are
defined on the Bends tab.
Middle corner cut

The rail bending is cut in the middle.
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Option Description
Mitre corner cut

The rail bending is cut by a plane on
the bisecting line.

Top rail position / Bottom rail position

Define the horizontal railing position.

By default, the Middle option is used.

Top rail rotation / Bottom rail rotation

Define the profile rotation for all horizontal rails.

Option Description
Default

Type 1

AutoDefaults can change this option.
Type 1

Type 2

Type 3

Type 4

Type 5

Type 6

Type 7

Type 8

Top rail and bottom rail connection properties

Option Description
Top rail connection, Bottom rail
connection

Select whether to use a system or a
custom component to connect the
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Option Description
top and bottom rails to the
stanchions.

Component Select a system or custom component
from the Applications &
components catalog.

Attribute file Select an attribute file for the
component.

Up direction Select the up direction.
Rotation Select the rotation for the selected

component.
Rotation value Enter the rotation value.

Middle Rails tab
Use the Middle Rails tab to control the horizontal middle rails.

Rail profile

Option Description
1

2

3

4

Define the middle rail profile by
selecting it from the profile catalog.

By default, the size of middle rail
profile is the same as the size of the
top rail profile.

The default name is MIDDLE RAIL.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Option Description Default
Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Middle rail type

Option Description
Middle rail profiles Number of rails and the rail profile

used for middle rails.

For example, 3*2 creates three
horizontal middle rails, with the
profile defined in profile 2.

For example, 2*2 1 creates two
horizontal middle rails, with the
profile defined in profile 2 and one or
more rails (depending of the number
of rails needed), with the profile
defined in profile 1.

For example, 3 creates horizontal
middle rails with the profile defined in
profile 3. The number of rails is
defined by the number set for the
horizontal or vertical middle rails.

By default, only rails with profile from
profile 1 are created.

Option Description
Default

Creates horizontal middle rails.

AutoDefaults can change this option.

Creates horizontal middle rails.

Creates vertical middle rails (pickets)
defined on the Vertical Rails tab.
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Option Description
Creates panels.

Middle rail position

Define the horizontal railing position.

By default, the Middle option is used.

Middle rail rotation

Define the profile rotation for all horizontal rails.

Option Description
Default

Type 1

AutoDefaults can change this option.
Type 1

Type 2

Type 3

Type 4

Type 5

Type 6

Type 7

Type 8
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Cut position for the bending

Option Description
Default

No cut

AutoDefaults can change this option.
No cut

No cut is created.

Both side cuts

The rail bending is cut at the left and
right side.

The dimensions for the cut are
defined on the Bends tab.
Middle corner cut

The rail bending is cut in the middle.

Mitre corner cut

The rail bending is cut by a plane on
the bisecting line.

Horizontal middle rail extension

Option Description
Default

No extension

AutoDefaults can change
this option.
No extension

The middle rail ends at
the inside stanchion
surface, without
intersecting the
stanchion.
Pass through stanchion

The middle rail ends at
the outside stanchion
surface, intersecting the
stanchion.
Horizontal extension

The middle rails are
extended inside the
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Option Description
closure by a horizontal
value. If the railing is
skew, the extension is
bent according to the
closure dimensions.

The rail can be
shortened by entering a
negative value in the box
3.
Horizontal and skew
extension

The middle rails are
extended by two
horizontal dimensions. 3
is for the horizontal rail
length and 4 is for the
skew rail length.

Closure bend cuts

This section is not active if you have set the middle rail type to vertical middle
rails.

 Description
1 Number of horizontal middle rails.
2 Spacing between the horizontal middle rails.
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 Description
3 Length of the middle rail horizontal extension inside the closure.

The rail can be shortened by entering a negative value.

Use this box when the horizontal middle rail extension is set to
horizontal extension.

4 Length of the middle rail horizontal and skew extension.

The middle rails are extended by two horizontal dimensions. 3 is for
the horizontal rail length and 4 is for the skew rail length.

Use this box when the horizontal middle rail extension is set to
horizontal and skew extension.

Middle rail connection properties

Option Description
Middle rail connection Select whether to use a system or

custom component to connect the
middle rails to the stanchions.

Component Select a system or custom component
from the Applications &
components catalog.

Attribute file Select an attribute file for the
component.

Up direction Select the up direction.
Rotation Select the rotation for the selected

component.
Rotation value Enter the rotation value.
Connect to Select whether one rail or two rails

are connected to stanchions.

• One rail: Creates one component
between one stanchion and one
rail.

• Two rails, two connections:
Creates two components, one
between the stanchion and rail,
and one between the same
stanchion and the other rail.

Usually two rails meet the
stanchion.

• Two rails, one connection:
Creates one component between
the stanchion and two rails.
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Grab rail

Grab rail can be a single middle rail that is vertically and horizontally offset
from the top rail. You can use a system or a custom component to connect the
rail to stanchions. You can also select the end of the grab rail. If the grab rail
comes from a skew stringer, you can extend the grab rail with skew and
horizontal dimensions.

To create a grab rail:

1. On the Picture tab, offset the middle rails from the stanchions.

2. On the Rails tab, set the profile for top and bottom rails to 0 so that those
rails are not created.
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3. On the Middle Rails tab, set the number of horizontal rails to 1 and adjust
the spacing for the handrail.

4. If you want to extend the end of the grab rail and have a horizontal part,
select the horizontal and skew extension option on the Middle Rails tab,
and enter the skew and horizontal distances.

5. Create the custom seam.

Pick the points on the outer extension of the main and secondary parts.
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 Description
1 Main part
2 Secondary part
3 First picked point
4 Second picked point

6. Save the standard properties for the custom seam.

7. On the Middle Rails tab, use the custom seam name and properties and
set the component direction.

Vertical Rails tab
Use the Vertical Rails tab to control the vertical rails (pickets). The options on
the Vertical Rails tab are active only if you have set the middle rail type to
vertical middle rails on the Middle Rails tab.

Pickets

Option Description
Default

Pickets are not created
inside the closure.

AutoDefaults can change
this option.
Pickets are not created
inside the closure.

Pickets are created
inside the closure when
you use the closure type
1 or 4.

Connection type between the pickets and the top and bottom rails

Option Description
Default

None

AutoDefaults can change this option.
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Option Description
None

The pickets are created from the top
rail center to the bottom rail center.
Fitted

The pickets are fitted at the creation
points by a plane that follows the
slope of the horizontal rails.
Part cut

The pickets are cut on both sides by
the horizontal rail profiles.
Connection

The pickets are connected to the top
and bottom rail with a system
connection.

Picket spacing

Option Description
1 Picket spacing between two consecutive stanchions.
2 Spacing type.

By default, the equal spacing option is used.

• Exact

The space between two consecutive pickets is exactly the spacing
value 1. As many pickets as possible are positioned between two
consecutive stanchions. The pickets are positioned centered
between the stanchions so that the space between the first
stanchion and the first pickets and the second stanchion and the
last pickets is equal.
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Option Description
• Equal

The spacing value 1 defines the maximum spacing. The pickets
are placed evenly between the stanchions.

Chamfer dimensions

 Description
1 Horizontal chamfer dimension for the pickets.
2 Vertical chamfer dimension for the pickets.

Profile rotation

Define the profile rotation for all vertical rails.

Option Description
Default

Type 1

Type 2

Type 3

Type 4

Type 5

Type 6

Type 7
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Option Description
Type 8

Connection properties

Option Description
Vertical rail top joint Define the number of the component

that connects the pickets to the top
rail by selecting it from the
component catalog.

You cannot use a custom component.

Select also an attribute file for the
component.

Vertical rail bottom joint Define the number of the connection
that connects the pickets to the
bottom rail by selecting it from the
component catalog.

You cannot use a custom component.

Select also an attribute file for the
component.

Panels tab
Use the Panels tab to create panels between the stanchions. No other vertical
or horizontal rails are created when the panels are created. The options on the
Panels tab are active only if you have set the middle rail type to panels on the
Middle Rails tab. You can use custom seams to create the middle panels and
custom details to create the closure panels.

Panel properties

Option Description
Part name/Joint no. Define the number of the custom

component used in panel creation by
selecting it from the component
catalog.

Attribute file Select an attribute file for the custom
component.

Seam dir. Define the seam direction.

Panel type

For custom details the numbers in the images correspond to the following
parts:
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Number Part
1 First stanchion, which is the main part

of the detail.
2 Point at the top of the first stanchion,

which is the first input point of the
detail.

3 Point at the bottom of the first
stanchion, which is the second input
point of the detail.

For custom seams the numbers in the images correspond to the following
parts:

Number Part
1 First stanchion, which is the main part

of the seam.
2 Second stanchion, which is the

secondary part of the seam.
3 Point at the top of the first stanchion,

which is the first input point of the
seam.

4 Point at the bottom of the first
stanchion, which is the second input
point of the seam.

Option Description
Left closure panel

Use a custom detail to create the
panel.

The panel connects to one stanchion
only.

First panel

Use a custom seam to create the
panel.

The panel can be of different size
than the rest of the panels.
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Option Description
Last panel

Use a custom seam to create the
panel.

The panel can be of different size
than the rest of the panels.

Right closure panel

Use a custom detail to create the
panel.

The panel connects to one stanchion
only.

Regular horizontal panel

Use a custom seam to create the
panel.

Regular skew panel

Use a custom seam to create the
panel.

Horizontal panel, skew junction
(bottom)

Use a custom seam to create the
panel.

Horizontal panel, skew junction (top)

Use a custom seam to create the
panel.
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Bends tab
Use the Bends tab to set the bending cut position on the rails and the profiles
for the bent rails parts.

Bend profile

Option Description
Bend Define the bend rail profile by

selecting it from the profile catalog.

Created only if you have set the
closure bend cuts to both side cut, left
side cut, or right side cut on the Rails
tab.

90 degree Define the rail profile by selecting it
from the profile catalog.

Created only if you have set the cut
position for the bending to both side
cut on the Rails or Middle Rails tab.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.
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Bend dimensions

Option Description Default
1 Bending radius for the rail parts. 50 mm
2 Cut distance along the rails on the right

side of the bending.

You can define this distance separately
for both rail ends.

75 mm

3 Cut distance along the rails on the left
side of the bending.

You can define this distance separately
for both rail ends.

75 mm

Welds
Click the link below to find out more:

Stairs (S82)
Stairs (S82) creates straight stairs with optional upper and lower landings. The
stairs consist of stringers, possible landings and the actual steps. The stairs are
created between two picked positions that define the upper and lower
positions of the sloping stringers, taking into account the flooring thickness.
The lower position defines the top level of the lowest step and the upper
position the top level of the topmost step.
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Objects created

• Stringers

• Steps

• Landings (optional)

• Welds

Use for

Situation Description
Stairs created with stringers and steps

Selection order

1. Pick the first position.

2. Pick the second position.

The stairs are created automatically when you pick the second position.

Part identification key

 Description
1 Stringer
2 Step
3 Top landing
4 Bottom landing

Picture tab
Use the Picture tab to define the stair dimensions.
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Stair dimensions

 Description Default
1 Maximum height between the steps. 230 mm

The default value for the
step height is calculated
as follows: (Z*220)/(Z
+220) mm, where Z is the
height of the stairs.

2 Bottom landing length

You need to define the length to create
the landing.

Bottom landing beam is
not created.

3 Bottom flooring thickness.

Vertical distance from the lower picked
point to the stringer top level.

30 mm

4 The distance the steps are inset
between the stringers.

20 mm

5 Top flooring thickness

Vertical distance from the upper picked
point to the stringer top level.

30 mm

6 Vertical distance orientation  
7 Width of the stairs (horizontal length of

the steps)
1000 mm

8 Top landing length

You need to define the length to create
the landing.

Top landing beam is not
created.

Parts tab
Use the Parts tab to define the stringer profile properties.
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Parts

Part Description Default
Stringer profile Select the profile for

stringers and landing beams
from the profile catalog.

U200

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to control the stringer rotation, mirroring, position in
plane, step profile, and top and bottom step creation.

Option Description Default
Stringer rotation Define the stringer rotation

around its axis on the work
plane.

Top

Mirroring Select whether the stringer is
mirrored.

 

Position in plane Define the stair position on the
work plane.

Right

Offset Define the beam offset for the
selected position in plane.

0

Step profile Select the step profile.

The step types are more
precisely defined in the
steps.dat file. The file defines
the form of the step, and the
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Option Description Default
place and size of the holes in
the stringers. Each line in the
file describes one step type.

The actual step is created as a
contour plate.

Create top step Select whether the top step is
created.

Yes, top step is
created.

Create bottom step Select whether the bottom step
is created.

Yes, bottom step
is created.

Create assembly Select whether to create an
assembly that includes all the
parts of the stairs or stringers.

With All, the steps are welded
to the stringers with invisible
weldings and an assembly
drawing of the stairs can be
created.

No

Bolt tolerance Define the bolt hole tolerance
for catalogue steps.

 

Welds

Click the link below to find out more:

Stanchion side plate (83)
Stanchion side plate (83) connects a stanchion to the side of a stringer with a
connection plate.

Objects created

• Connection plate

• Bolts

• Welds
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Use for

Situation Description
Stanchion is connected to the side of
a stringer.

Selection order

1. Select the main part.

2. Select the secondary part.

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Connection plate

Picture tab
Use the Picture tab to control the connection dimensions.

Dimensions
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 Description Default
1 Connection plate distance from the main part

upper edge

Positive values make the plate smaller.

 

2 Vertical position

Define the uppermost bolt position as a distance
from the stanchion top edge to the uppermost
bolt.

76 mm

3 Fit distance

Define the stanchion cut level as a distance from
the uppermost bolt to the stanchion bottom.

Cut at the
bottom level

Plate offset

 Description
1 Horizontal offset of the connection plate

Parts tab
Use the Parts tab to define the part properties.

Part

Optionq Description Default
Connection plate Thickness and width of

the connection plate.
For rectangular plates:
thickness 10 mm and
width 120 mm.

Parameters tab
Use the Parameters tab to define the connection plate orientation and
chamfers.
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Plate type

Option Description
Default

Rectangular

AutoDefaults can change this option.
Rectangular

Diamond

Triangular

Circular

Rectangular by bolts

The plate size is determined by the
values you enter on the Bolts tab.
Circular by bolts

The plate size is determined by the
values you enter on the Bolts tab.

Plate orientation in skewed situations

Option Description
Default

Perpendicular to the secondary part

AutoDefaults can change this option.

Perpendicular to the secondary part
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Option Description
Oriented to the main part

Plate orientation

Option Description
Default

Horizontal

AutoDefaults can change this option.
Perpendicular

Horizontal

Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Define the horizontal and vertical
chamfer dimensions.
Round chamfer

Define the chamfer radius.

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Steel components 1636 Stairs



Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost
bolt.
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 Description
• Middle: From the center line of the secondary part to the

center line of the bolts.

• Right: From the right edge of the secondary part to the
rightmost bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Steel components 1638 Stairs



 Description
6 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line of
the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

7 Dimension for vertical bolt group position.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3
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Option Description
Staggered type 4

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Multiple beam railing (S84)
Multiple beam railing (S84) creates stanchions and railings connected on one
or more beams.

Objects created

• Handrail (top rail)

• Knee rail (bottom rail)

• Stanchions

• Toe plates

• Welds
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Use for

Situation Description
Railing created on multiple beams.

Selection order

1. Pick the first position for the railing.

2. Pick the second position for the railing.

3. Select the first beam.

4. Select the second beam, and the subsequent beams if needed.

5. Click the middle mouse button to create the railing.

Part identification key

 Description
1 Railing

Top rail and bottom rail are created.
2 Toe plate
3 Stanchion

Picture tab
Use the Picture tab define the railing dimensions.
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Railing dimensions

 Description
1 Full horizontal length of the closure from the first or the

last stanchion.
2 Horizontal length of the closure in the top rail and where

the bending is created in the closure.
3 Horizontal distance between the stanchions.
4 Distance between the top rail and the beam.
5 Full horizontal length of the closure from the first or the

last stanchion.
6 Bending angle
7 Toe plate start/end distance from the start/end of the

railing.
8 Horizontal length of the closure in the bottom rail and

where the bending is created in the closure.
9 Horizontal distance to the first stanchion from the first

input point.

This is the position of the first stanchion from the first
input point.

10 Distance between the beam and bottom rail.
11 Vertical distance between the beam center and stanchion

center.
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Parts tab
Use the Parts tab control the railing part properties.

Parts

Option Description
Stanchion profile Select the stanchion profile from the profile

catalog.
Hand rail profile Select the hand rail profile from the profile

catalog.
Knee rail profile Select the knee rail profile from the profile

catalog.
Toe plate Thickness and height of the toe plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define whether stanchions and toe plates are
created, and the positions of stanchions, railings, and railing cuts.

Option Description
Stanchion product name Enter the stanchion name.
Bend product name Enter the bend name.
Toe plate max length Define the maximum length of the

toe plate.
Create assembly Select whether to create an assembly

of the parts.
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Stanchion creation

Option Description
Stanchions are not created.

Stanchions are created.

Railing cut positions

Select the railing cut position and define the cut dimension.

Option Description
Railing is cut at the second stanchion.

Railing is cut at the first stanchion.

Railing is cut at each stanchion.

Stanchion and railing position

Option Description
Stanchions and railings are created on
the left side of the beams.

Stanchions and railings are created on
the right side of the beams.
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Toe plate creation

Option Description
Toe plates are not created.

Toe plates are created.

Welds

Click the link below to find out more:

Stringer to channel (127)
Stringer to channel (127) connects a stringer to a channel with an angle
profile. The angle profile is welded to the stringer and bolted to the channel. A
vertical plate is welded to the end of the stringer.

Objects created

• Angle plate

• Vertical plate (optional)

• Bolts

• Welds

• Cuts to shape the end of the stringer

Use for

Situation Description
The angle profile is bolted to the
channel and welded to the stringer.
The stringer is cut horizontally to the
top level of the channel.
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Situation Description
No horizontal cut in the stringer.

A vertical plate is created to the end
of the stringer.

Limitations

Stringer to channel (127) works only if the connecting profile is an angle.

Before you start

Create a stringer and a channel.

Selection order

1. Select the main part (a channel).

2. Select the secondary part (a stringer).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Part
1 Angle profile
2 Vertical plate

Picture tab
Use the Picture tab to define the position of the angle profile and the vertical
plate, and whether the stringer is cut.

Stringer cut

Option Description
Option 1

Default
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Option Description
Option 2

The stringer is cut horizontally to the
top level of the channel.

Option 3

No horizontal cut in the stringer.

 Description Default
1 Position of the vertical plate.

Define the vertical distance from the
stringer top edge to the vertical plate top.

0

2 Position of the angle profile.

Define the vertical distance from the
channel top to the angle profile top.

Option 1 or 2:

• metric: 65 mm
• imperial: 2"1/2
Option 3:

• 0
3 Location of the stringer cut.

Define the vertical distance from the
channel top edge to the plane where the
stringer is cut horizontally and the bottom
of the vertical plate is positioned.

• metric: 12 mm
• imperial: 1/2"
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 Description Default
4 Location of the stringer cut.

Define the horizontal distance from the
channel web to the stringer.

• metric: 12 mm
• imperial: 1/2"

Parts tab
Use the Parts tab to control the properties of the vertical plate and the angle
profile.

Vertical plate and angle profile

Option Description Default
Vertical plate Vertical plate thickness.

If you set the value to 0,
no vertical plate is
created.

metric: 10 mm
imperial: 3/8"
The default name is
PROFILE.

Angle Define the angle profile
by selecting it from the
profile catalog.

If you do not select an L
profile, the connection
will not be created.

metric: L75*6
imperial: L3X3X1/4
The default name is
ANGLE.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Steel components 1651 Stairs



Parameters tab
Use the Parameters tab to control the leg orientation and the position of the
angle profile.

Angle profile leg orientation

If the legs of the angle profile are of uneven length, you can switch their
position.

Option Description
Default

The longer leg of the angle profile is
connected to the channel.

AutoDefaults can change this option.

The longer leg of the angle profile is
connected to the channel.

The longer leg of the angle profile is
connected to the stringer.

Angle profile position

Option Description
Default

Angle profile is on the outer surface
of the channel.

AutoDefaults can change this option.

Angle profile is on the outer surface
of the channel.

Angle profile is on the inner surface
the channel.
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Bolts tab
Use the Bolts tab to control the bolts that connect the angle profile to the
channel.

Bolt group dimensions

 Description Default
1 Vertical distance from the top of the

channel to the center of the top bolt.
metric: 75 mm
imperial: 3"

2 Number of bolts. 2
3 Bolt spacing.

Use a space to separate bolt spacing
values. Enter a value for each space
between bolts. For example, if there are 3
bolts, enter 2 values.

metric: 75 mm
imperial: 3"

4 Vertical distance from the bottom of the
angle profile to the center of the bottom
bolt.

metric: 40 mm
imperial: 1"1/2

5 Horizontal distance from the stringer edge
to the center line of the bolts.

metric: 40 mm
imperial: 1"1/2

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.
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Option Description Default
Thread in mat Defines whether the

thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Connection plate (1026)
Connection plate (1026) creates a connection plate to a picked position on a
selected part.

Objects created

• Connection plate

• Bolts
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Use for

Situation Description
The connection creates a connection
plate to a picked position. The shape
of the plate can be diamond,
triangular, rectangular, or circular.

Selection order

1. Select the part.

2. Pick a point to indicate the connection plate position.

The connection plate is created automatically when you pick the point.

Part identification key

 Description
1 Connection plate

Picture tab
Use the Picture tab to define the connection position.

Plate position

 Description
1 Vertical position of the connection plate
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 Description
2 Horizontal position of the connection plate

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
Plate Thickness and width of

the connection plate
Thickness = 10 mm
Width = 120 mm for
rectagular and diamond
shaped plates

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the connection plate shape, chamfer shape,
and chamfer dimensions.
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Connection plate shape

Option Description
Default

Rectanglular

AutoDefaults can change this option.

Rectangular

Diamond

Triangular

Circular

Rectangular by bolts

The connection plate size is
determined by the values you define
on the Bolts tab.
Circular by bolts

The connection plate size is
determined by the values you define
on the Bolts tab.
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Chamfer shape

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex chamfer

Chamfer dimensions

 Description Default
1 Define the horizontal and vertical dimension of the line

chamfer.
20 mm

2 Define the chamfer radius of the convex chamfer. 20 mm

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
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 Description
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab
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Analysis tab

Click the link below to find out more:

Analysis tab

Stair base detail (1038)
Stair base detail (1038) creates a bolted horizontal plate and an optional
vertical plate at a picked point on a stringer. The plates are welded to the
stringer.

Objects created

• Horizontal plate

• Vertical plate (optional)

• Bolts

• Welds

• Cuts to shape the end of the stringer

Use for

Situation Description
Stair base detail with horizontal and vertical
plates.

Stair base detail with horizontal and vertical
plates.
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Situation Description
Stair base detail with horizontal plates.

Limitations

Stair base detail (1038) works only if the Up direction is set to +z on the
General tab. It does not work if the Up direction is set to auto.

Before you start

Create a stringer.

Selection order

1. Select the stringer.

2. Pick a point on the stringer.

The detail is created automatically.

Part identification key

 Part
1 Horizontal plate
2 Vertical plate

Picture tab
Use the Picture tab to control the horizontal and vertical plate positions.
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Plate positions

 Description Default
1 Plate position.

Define the horizontal distance from the
picked point to the inner face of the vertical
plate.

metric: 31 mm
imperial: 1"1/4

2 Plate position.

Define the vertical distance from the picked
point to the top face of the horizontal plate.

0 mm

3 Horizontal plate offset relative to the
component’s up direction.

0 mm

Vertical plate creation

Option Description
Default.

Vertical plate is created.
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Option Description
Vertical plate is created.

No vertical plate is created.

Parts tab
Use the Parts tab to control the horizontal and vertical plate properties.

Horizontal plate/Vertical plate

Option Description
Horizontal plate

Vertical plate

Plate thickness, width and height.

The default name is PLATE.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Bolts tab
Use the Bolts tab to control the bolt properties in the horizontal plate. You can
select to create bolts or studs. By default, bolts are created.

Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes
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Option Description Default
Site/Workshop Location where the bolts

should be attached.
Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.
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Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Bolting direction 2

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Stair base detail (1039)
Stair base detail (1039) creates a bolted horizontal plate at the picked point
on the stringer. The plate is welded to the stringer.

Objects created

• Horizontal plate

• Bolts
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• Welds

• Cuts to shape the end of the stringer

Use for

Situation Description
Stair base detail with a horizontal
plate.

Stair base detail with a horizontal
plate.

Before you start

Create a stringer.

Selection order

1. Select the stringer.

2. Pick a point on the stringer.

The detail is created automatically.
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Part identification key

 Part
1 Horizontal plate

Picture tab
Use the Picture tab to control the horizontal plate position.

Horizontal plate position
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 Description
1 Plate position.

Define the vertical distance from the picked point to the top face of
the horizontal plate.

2 Horizontal plate offset in the z direction, relative to the component’s
up-direction.

3 Horizontal plate offset in the y direction, relative to the component’s
up-direction.

Parts tab
Use the Parts tab to control the horizontal plate properties.

Horizontal plate

Option Description
Horizontal plate Plate thickness, width and height.

The default name is PLATE.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Bolts tab
Use the Bolts tab to control the bolt properties in the horizontal plate. You can
select to create bolts or studs. By default, bolts are created.
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Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Stair base detail (1043)
Stair base detail (1043) creates a bolted clip angle and an optional vertical
plate (nose plate) at a picked point on a stringer. The clip angle is bolted and
the vertical plate is welded to the stringer.

Objects created

• Clip angle

• Vertical plate (optional)

• Bolts

• Welds

• Cuts to shape the end of the stringer

Steel components 1674 Stairs



Use for

Situation Description
Stair base detail with a clip angle and a vertical
plate.

Stair base detail with a clip angle and a vertical
plate.

Stair base detail with a clip angle.

Limitations

Stair base detail (1043) works only if the Up direction is set to +z on the
General tab. It does not work if the Up direction is set to auto.

Before you start

Create a stringer.

Selection order

1. Select the stringer.

2. Pick a point on the stringer.

The detail is created automatically.
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Part identification key

 Part
1 Clip angle
2 Vertical plate

Picture tab
Use the Picture tab to control the clip angle and the vertical plate positions.

Clip angle position

 Description Default
1 Plate position.

Define the horizontal distance from the
picked point to the inner face of the vertical
plate.

metric: 31 mm
imperial: 1"1/4

2 Clip angle vertical position.

Define the vertical distance from the picked
point to the bottom of the clip angle.

metric: 170 mm
imperial: 6"11/16

3 Height of the stringer cut. metric: 12 mm
imperial: 1/2"
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 Description Default
4 Clip angle horizontal position.

Define the horizontal distance from the clip
angle center line to the inner face of the
vertical plate.

metric: 73 mm
imperial: 2"7/8

Vertical plate creation

Option Description
Default

Vertical plate is created.

AutoDefaults can change this option.

Vertical plate is created.

No vertical plate is created.

Parts tab
Use the Parts tab to control the vertical plate and the clip angle properties.

Vertical plate and angle cleat profile

Option Description
Vertical plate Plate thickness, width and height.

The default name is PLATE.
Angle cleat profile Clip angle profile by selecting it from

the profile catalog.

The default name is CLEAT.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Parameters tab
Use the Parameters tab to control the vertical plate and the clip angle
positions.

Vertical plate position

 Description
1 Dimension from the top of the vertical plate to the front edge of the

stringer.
2 Dimension from the edges of the vertical plate to the edges of the

stringer.

Clip angle location

Select on which side of the stringer the clip angle is created.
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Option Description
Default

Clip angle is created on the left side of
the stringer.

AutoDefaults can change this option.
Clip angle is created on the right side
of the stringer.

Clip angle is created on the left side of
the stringer.

Clip angle position

If the legs of the clip angle are of uneven length, you can switch their position.

Option Description
Default

The shorter leg of the clip angle is
connected to the stringer.

AutoDefaults can change this option.
The shorter leg of the clip angle is
connected to the stringer.

The longer leg of the clip angle is
connected to the stringer.

PBolts tab
Use the PBolts tab to control how the clip angle is attached to the base.
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Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

Clip angle attachment

Select how the clip angle is attached to the base.

Option Description
Default

Holes are created.

AutoDefaults can change this option.

Holes are created.

Bolts and holes are created.

No holes or bolts are created.

Steel components 1680 Stairs



Create as

Use this option to switch between holes and custom components. Note that
you cannot use this option if you have selected that both bolts and holes are
created, or that no holes or bolts are created.

Select the custom component from the Applications & components catalog
and define the custom settings, up direction, rotation, and anchor length.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

SBolts tab
Use the SBolts tab to control how the clip angle is attached to the stringer.
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Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

Clip angle attachment

Select how the clip angle is attached to the stringer.

Option Description
Default

No bolts are created.

AutoDefaults can change this option.
No bolts are created.

Bolts are created.

Holes are created.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Steel components 1684 Stairs



Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Create as

Use this option to switch between holes and custom components. Note that
you cannot use this option if you have selected that both bolts and holes are
created, or that no holes or bolts are created.

Select the custom component from the Applications & components catalog
and define the custom settings, up direction, rotation, and anchor length.

Steel components 1685 Stairs



General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Ladder (S35)
Ladder (S35) creates a vertical step-through ladder, with an option for a safety
cage.

Objects created

• Stringers

• Hoops

• Rungs

• Vertical bars

Use for

Situation Description
Ladder with safety cage and vertical
step.
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Selection order

1. Pick a point to indicate the top point of the ladder.

2. Pick a point to indicate the elevation of the ladder.

The ladder is created automatically when you pick the second point.

Part identification key

 Description
1 Stringer
2 Rung
3 Cage

Picture tab
Use the Picture tab to define the ladder geometry and dimensions.
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Ladder dimensions

 Description Default
1 Direction from which the ladder is

accessed.

The options are: left, right, or normal
(default).

 

2 Hoop circle offset from the stringer
center line.

760 mm

3 Shape of the cage and how it connects to
the ladder.

The options are: U type 1 (default), U
type 2, and O type.

 

4 Cage connection options

The first option is used only for U type 1.
Both options are used for U type 2.

First option: 75
Second option: 40

5 Maximum spacing of hoops.

The hoops are evenly spaced below the
stringer flare. Only one hoop is placed on
the flared stringer.

900 mm

6 Position (z-coordinate) of the lowest
hoop bottom edge.

If the value is greater than the floor to
floor dimension, only the top hoop is

2500 mm
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 Description Default
placed with no bars. If the value is
greater than the floor to floor dimension
plus stringer projection, then no hoops
are placed.

7 Lowest hoop extra diameter dimension.  
8 Inside diameter of the hoops.

Stringer flare is taken from the diameter
of the hoops.

750 mm

9 Stringer projection

Height from the upper top of steel to the
flared stringer top edge.

1100

10 Kicker height above the upper top of
steel at which the ladder stringer flare.

200

11 Thickness of the top floor above the top
of steel.

The top rung is placed level with the top
of flooring thickness.

0

12 Maximum spacing of rungs.

Rungs are evenly spaced between the
top and bottom floors.

300 mm

13 Distance between the rungs. Select
either equal or exact distance.

Equal

14 Thickness of the bottom floor above the
lower top of steel. Bottom rung spacing
is taken from the lower top of steel plus
bottom floor.

0

15 Width of the ladder. 450 mm

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
Stringers Select the stringer profile from the

profile catalog.
The default value is
flat 10*65
(“PLT10*65”).

Rungs Select the rung profile from the
profile catalog.

The default value is
round bar 20
(“D20”).
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Option Description Default
Top Hoops Select the top hoop profile from

the profile catalog.
The default value is
flat 10*50
(“PLT10*50”).

Middle Hoops Select the middle hoop profile
from the profile catalog.

The default value is
flat 10*50
(“PLT10*50”).

Bottom Hoop Select the bottom hoop profile
from the profile catalog.

The default value is
flat 10*50
(“PLT10*50”).

Vertical Bars Select the vertical bar profile from
the profile catalog.

The default value is
flat 10*50
(“PLT10*50”).

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the ladder properties and position.

Ladder position

Option Description Default
Vertical position Vertical position of the ladder Middle
Vertical offset Vertical offset of the ladder 0.0
Horizontal
position

Horizontal position of the ladder Middle

Horizontal offset Horizontal offset of the ladder 0.0
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Option Description Default
Class Class of the ladder 1
Create assembly Select whether to create an

assembly or not.
Assembly is
created.

Ladder rotation

Define how the ladder is rotated. The default value is front.

Stringer rotation

Define how the stringers are rotated. The default value is top.
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Rung rotation

Option Description
Rungs are rotated by 45 degrees.

This is the default option.

Rungs are not rotated.
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Cage creation

Option Description
Cage is created.

This is the default option.

Cage is not created.

Hoop angle

  
1 Define the hoop angle.

Vertical bar spacing angle

 Description Default
1 Define the angle between the vertical

bars in the round section of the hoop.
30 degrees
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Rung stringer part cut

Select whether stringers are cut to avoid clashing.

Option Description
Stringers are not cut.

This is the default option.

Stringers are cut.

Define the clearance value for the cut.

Stringers are cut.

Rungs are bolted to the stringers.

Define the clearance value for the cut.
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Option Description
Define the depth of the cut into the
stringer.

Rung offset

 Description
1 Define the horizontal offset of rungs from the stringer center

line.

Cage ladder (S60)
Cage ladder (S60) creates a vertical step-through ladder with an option to
create a safety cage.

Objects created

• Rail bars

• Rungs

• Backer channel

• Backer plates

• Supports

• Hoops

• Vertical bars

• Welds

Selection order

1. Pick a point to indicate the top point of the ladder.
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2. Pick a point to indicate the elevation of the ladder.

The second point can be anywhere on the top of the bottom platform. The
second point does not need to be directly below the first point but the two
points should define a line that is nearly parallel to the current Z axis.

The ladder is created automatically when you pick the second point.

If the line between the two points is not nearly parallel to the Z axis, the ladder
is not created. If the two points are suitable for creating the ladder, the second
point is adjusted, if needed, to define a line that is perfectly parallel to the Z
axis. The ladder is positioned relative to this reference line.

Before creating the component, we recommend that you set the user
coordinate system so that the X axis and Y axis lie in a horizontal plane with
the Z axis pointing straight up. The component works with other orientations
as well, but regardless of the orientation, the ladder is always positioned
exactly parallel to the Z axis.

Part identification key

 Description
1 Rail bar
2 Rung
3 Cage

Picture tab
Use the Picture tab to define the ladder geometry and dimensions.
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Dimensions

 Description
1 Step type

Direction from which the ladder is accessed: left side, right
side, or step through (default).

2 Inside width of the ladder from the inner edge of one rail to
the other

The flared width is taken from the inner diameter of the
hoops.

Flared width is always set to more than the ladder width (10 ).
If you set the flared width to less than or equal to the ladder
width, the flared width is automatically reset to the ladder
width plus 4 inches.

If side steps are used, the ladder width is used as the width.
3 Ladder top offset from the upper top of steel to the flared rail

bar top edge
4 Top rung offset

Defines the distance from the first input point to the center
line of the topmost ladder rung.
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 Description
5 Number of rungs

To define the number of rungs, select either Default or
Number of rungs from the list below the box (7).

If side steps are used, four additional rungs are automatically
added above the top platform at a spacing of 12 inches.

6 Distance between the rungs
7 Select to set either the maximum distance between the rungs,

or the exact spacing from the bottom or top rung.
8 Bottom rung offset

Defines the distance from the second input point to the center
line of the lowest ladder rung.

9 Ladder bottom offset

Defines the distance from the bottom platform to the bottom
of the ladder rails. A positive value places the bottom of the
ladder below the bottom platform.

10 Ladder width

Defines the inside width of the ladder from the inner edge of
one rail to the other.

If you select the step through option (1), the portion of the
ladder above the top platform will be flared. If you do not
define the ladder width, the default value in the applicable
jobdefs.lis file is used.

11 Toe offset

Defines the distance from the center line of the ladder rail to
the toe of the top platform.

If you do not define this offset, the default value in the
applicable jobdefs.lis file is used.

Parts tab
Use the Parts tab to define the part profiles and properties.

Parts

Option Description
Rail bars The bar profile used to form the

ladder rails

Select the profile from the profile
catalog.
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Option Description
Rungs The rod profile used to form the

ladder rungs

Select the profile from the profile
catalog.

Backer channel The channel profile used for the
backer support channel

Select the profile from the profile
catalog.

Backer plates The plate profile used for the bent
plates that attach the ladder rails to
the backer support channel

Select the profile from the profile
catalog.

Ladder supports Select the profile from the profile
catalog.

Backside supports Select the profile from the profile
catalog.

Top hoops

Bottom hoop

Middle hoops

The bar profile used to form the
safety cage hoops

Select the profile from the profile
catalog.

Vertical bars The bar profile used to form the
vertical cage bars

Select the profile from the profile
catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Name Name that is shown in

drawings and reports.
 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Parameters tab
Use the Parameters tab to define the ladder properties and position.

Horizontal position and offset

Picture above Description Default
Horizontal position Position of the ladder in

the plane of the ladder

• Middle : the center
line of the ladder
coincides with the
reference line.

• Left and Right: the
outside face of the
corresponding rail
coincides with the
reference line.

Middle

Horizontal offset Lateral offset of the
ladder in the plane of
the ladder

For example, an offset of
6" coupled with
Horizontal position set
to Middle places the
center line of the ladder
6" to the right of the
reference line.

An offset of -8" with
Horizontal position set
to Right, for example,
places the outside face
of the right-hand rail 8"
to the left of the
reference line.

0

Steel components 1700 Stairs



Side rail cuts

  
Stringer cuts Select how the side rails are cut.
Stringer max. length If you have selected to cut the side

rails At max. length, define the
maximun stringer length.

Stringer rotation

Define how the stringers are rotated. The default value is top.

Ladder rotation

Define how the ladder is rotated. The default value is front.
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Rung rotation

Define the rung rotation.

Cage creation

  
Default

Cage is not created.

AutoDefaults can change this option.

Cage is not created.

Cage is created.

Rung stringer part cut

Select whether stringers are cut to avoid clashing.

Option Description
Stringers are not cut.
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Option Description
Stringers are not cut.

Stringers are cut.

Define the clearance value for the cut.

Stringers are cut.

Rungs are bolted to the stringers.

Define the clearance value for the cut.

Define the depth of the cut into the
stringer.

Cage tab
Use the Cage tab to define the size and position of the ladder's safety cage.

Cage dimensions
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 Description
1 Distance from the center of the top flared hoop to the next

higher hoop in the safety cage
2 Distance from the top platform to the center of the top safety

cage hoop
3 Number of hoops (in addition to the required bottom flared

hoop). The default number of hoops is 2.

When you have selected that the ladder is accessed from the
side, three additional hoops above the top platform are added
at a spacing of 1'-10".

When you have selected that the ladder has step-through
access, two additional hoops are added at 12 inches and 3'-6"
above the platform.

4 Hoop radius

Defines the outside radius of each safety cage hoop above the
flared hoop at the bottom of the cage. The hoop radius at the
bottom of the cage is determined by the flared radius. If you
do not define the radius, the applicable jobdefs.lis file
determines the default value.

You can define a combination of dimensions, including the
hoop radius and ladder width, that will make it impossible to
bend and attach the hoops to the outside face of each rail.
This applies especially to the top of a step-through ladder
where the ladder rails are flared out for improved accessiblity.

5 Cage depth

Defines the distance from the center line of the ladder rails to
the curvature point for all safety cage hoops. If you do not
define the depth, the applicable jobdefs.lis file determines
the default value.

6 Side step dimension

Defines the distance from the ladder's center line to the
center line of the outermost vertical cage bar in the side step
portion of the cage.

When the step type is step through, this dimension is not
used.

7 Side step dimension

Defines the distance from the center line of the outermost
vertical cage bar to the end of the modified safety cage hoops.

When the step type is step through, this dimension is not
used.
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 Description
8 Flared hoop space

Defines the distance from the center of the bottom flared
hoop to the next higher hoop in the safety cage.

9 Flared radius

Defines the outside radius of the flared safety cage hoop at
the bottom of the cage. The radius is equal to the hoop radius
plus 1.75 inches. The radius of all other hoops is determined
in the hoop radius (4).

10 Flared hoop offset

Defines the distance from the bottom platform to the center
of the bottom flared safety cage hoop.

If you do not define the offset, the applicable jobdefs.lis
file determines the default value.

Hoop shape

Option Description
U type hoop

U type hoop

O type hoop

Vertical bar spacing

 Description
1 Define the angle between the vertical bars in the round section of

the hoop.
2 Define the distance between the vertical bars in the straight

section of the hoop.
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Bolts tab
Use the Bolts tab to define the bolt properties of the bolts used for backer,
ladder, and backside support plates. If a backer channel is not created, the bolt
settings are not used.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.
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Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Supports tab
Use the Supports tab to define the backer channel settings.
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 Description
1 Top of the channel

Top platform elevation distance from the top of the backer
channel

2 Top support offset

Top platform elevation distance to the center line of the upper
bent plate used to attach the ladder to the backer channel.

If one backer channel support is created, the bottom support
offset is used to control the position of the single bent plate.

3 Bottom support offset

Bottom platform elevation distance to the center line of the
lowest bent plate used to attach the ladder to the backer
support channel.

If one backer channel support is created, this setting is used to
control the position of the single bent plate.

4 Bottom of channel

Bottom platform elevation distance from the bottom of the
backer channel.

5 Backer offset

Distance from the center line of the ladder rail to the nearest
face of the backer channel.

6 Vertical top backer support dimension
7 Horizontal top backer support dimension
8 Bottom offset to the middle backer support
9 Vertical bottom backer support dimension
10 Horizontal bottom backer support dimension
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Backer channel

Option Description
Default

Backer channel is not created.

AutoDefaults can change this option.

Backer channel is not created.

Backer channel is created to stiffen
and support the ladder.

Backer channel supports

Option Description
Default

Two backer channel supports are
created.

The bent plate backer supports attach
the ladder rails to the backer bar
support channel.

AutoDefaults can change this option.
One backer support is created.

Two backer supports are created.
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Top backer support position

Select how the top backer supports are positioned.

Bottom backer supports

Option Description
Bottom backer supports are not
created.
Bottom backer supports are created
at the outer edges.

You can define the vertical and
horizontal offset.
Bottom backer supports are created
at the inner edges.

You can define the vertical and
horizontal offset.

Welds

Click the link below to find out more:

Ship Ladder
Ship Ladder creates stairs for ships and oil platforms.

Objects created

• Stanchions

• Stringers

• Steps

• Handrails and elbows

• Middle rails

• Platform

• Platform support
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• Bolts

• Welds

• Additional component (optional)

Use for

Situation Description
Type 1

Ship ladder with stringers, steps,
stanchions, and handrails.
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Situation Description
Type 2

Ship ladder with stringers, steps,
stanchions, platform, and handrails
with middle rails.
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Situation Description
Type 3

Ship ladder with stringers, steps,
stanchions, platform, handrails with
middle rails.

Type 4

Ship ladder with stringers, steps,
stanchions, and handrails.
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Limitations

Ship Ladder uses catalog step profiles to define the step type on the Parts
tab.

To have an updated step profile list on the Parts tab, you need to run the
Steps.exe program when you use the Ship Ladder modeling tool for the first
time in your environment, or when you change your Tekla Structures
environment.

WARNING With standard settings Tekla Structures overwrites the step
profile settings and replaces them with the default values every
time when Tekla Structures is started. To prevent Tekla Structures
loosing the step profile settings, set
XS_DO_NOT_OVERWRITE_PLUGIN_INP_FILE = TRUE in
teklastructures.ini file.

If you are using catalog step profiles and have set
XS_DO_NOT_OVERWRITE_PLUGIN_INP_FILE = TRUE and you
update Tekla Structures, do the following:

1. Set XS_DO_NOT_OVERWRITE_PLUGIN_INP_FILE = FALSE
in teklastructures.ini file.

2. Update Tekla Structures.

3. Start Tekla Structures.

4. Set XS_DO_NOT_OVERWRITE_PLUGIN_INP_FILE = TRUE in
teklastructures.ini file.

5. Run Steps.exe.

6. Restart Tekla Structures

Selection order

1. Pick a point to indicate the bottom level of the stairs.

2. Pick a point to indicate the top level of the stairs.

3. Click the middle mouse button to create the component.

Points that indicate the bottom level and top level are usually nosing line
start/end points.
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Part identification key

 Part
1 Elbow
2 Handrail
3 Platform support
4 Plate
5 Stringer
6 Stanchion
7 Step
8 Platform
9 Middle rail

Picture tab
Use the Picture tab to control the type of the stairs, the dimensions of the
parts created, horizontal offset, and horizontal distance between stringers.

Steel components 1715 Stairs



Dimensions

 Description Default
1 Vertical distance between up stringer

bottom and handrail bottom.
1000 mm

2 First stanchion offset along handrail,
measured from the handrail bottom.

200 mm

3 Maximum distance between middle
stanchions.

1000 mm

4 Distance between stringer and handrail. 800 mm
5 Last stanchion offset along handrail,

measured from the stringer top.
200 mm

6 • For Type 1, 2 and 4:

Define the distance between up nosing
line top point and horizontal stringer
end.

• For Type 3:

Define the distance between up nosing
line top points.

1000 mm
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 Description Default
7 Horizontal offset for the first stanchion,

measured from horizontal stringer start.

This option is not active for Type 4.

200 mm

8 Distance between the first and the last
horizontal stanchions.

This option is not active for Type 1 or Type
4.

600 mm

9 Number of middle rails.

This option is not active for Type 1 or Type
4.

3

10 Middle rail spacing.

Use a space to separate middle rail spacing
values. Enter a value for each space
between middle rails. For example, if there
are 3 middle rails, enter 2 values.

This option is not active for Type 1 or Type
4.

Value of option 3
divided by number
of spaces.

11 Vertical distance between handrail top and
platform top.

This option is not active if for Type 4.

1000 mm

12 Vertical distance between platform top and
down stringer bottom.

This option is active only for Type 3.

2000 mm

13 Vertical distance between handrail bottom
and down stringer bottom.

This option is active only for Type 3.

1000 mm

14 Horizontal distance between up nosing line
end and down nosing line end.

This option is active only for Type 3.

The up stringer and
down stringers have
the same
inclination.

Step and assembly creation

Option Description
Create top step Define whether the top step is

created.
Create assembly Define which parts form an assembly.

The options are:

• No

No assembly is created.
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Option Description
• All

All parts are included in an
assembly.

• Stingers/Rails

Parts form several assemblies:

• Each of the stringer assemblies
includes up, horizontal and
down stringers.

• Each of the rail assemblies
includes up, horizontal and
down handrails, middle rails,
stanchions and plates.

• The platform, each platform
support and each step form its
own assembly.

Detail A and Detail C

Use Detail A to connect the up stringer end to an end detail.

Use Detail C to connect the down stringer end to an end detail.

 Description Default
1 Define whether the stringers are connected

to an end detail.
None

2 Define the detail by selecting it from the
component catalog.

 

3 Select an attribute file for the detail. standard
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Ship ladder options

 Description Default
1 Handrail elbow radius.

This option is not active for Type 4.

100 mm

2 Define how to measure the dimension for
the horizontal offset of the ship ladder.

The options are:

• Left

To the left from the line defined by the
picked points.

• Middle

The line defined by the picked points is
the center line.

• Right

To the right from the line defined by the
picked points.

Middle
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 Description Default
3 Horizontal offset.

This option is not active for Default or
Middle.

0 mm

4 Horizontal distance between stringers. 1000 mm

Handrail elbow bending cuts

This option is not active for Type 4.

Option Description
Default

Bent elbow

AutoDefaults can change this option.
Bent elbow

Separate elbow part is between rails.

Fitting

Rails are fitted.

Bent rail

Rail is bent.

Separate rails

Rails are not fitted.

Parts tab
Use the Parts tab to control the properties of the created parts.

Part properties

Option Description Default
Elbow

Handrail

Middle rail

Stanchion

Define the elbow profile
by selecting it from the
profile catalog.

PD40*2

Plate in Detail B Thickness of the plate. 5 mm
Support Thickness of the

platform support.
5 mm

Step Select whether to use
catalogue steps or
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Option Description Default
profiles or to create the
steps.

Select the step from the
list of catalogue steps or
from the profile catalog.

If you change your Tekla
Structures environment,
update the step list.

Stringer Define the stringer
profile by selecting it
from the profile catalog.

C200*100*5

Platform Thickness of the
platform.

50 mm

Bracket Define the bracket
profile by selecting it
from the profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Platform tab
Use the Platform tab to control the platform offset and support.

Steel components 1721 Stairs



Platform offset

 Description Default
1 Platform horizontal offset from the top

step.

If the top step is not created, the platform
horizontal offset is defined from the up
nosing line top point.

0 mm
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Platform offset and support

 Description Default
1 Platform support vertical offset from the

platform bottom.
0 mm

2 Platform horizontal offset from the stringer. 0 mm
3 Width of the platform support. 50 mm

Platform support creation

NOTE The top of the platform is always on the same level as the top of the
stringer.

Option Description
Default

Platform support is created.

AutoDefaults can change this option.
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Option Description
Platform support is created.

Platform support is not created.

Steps tab
Use the Steps tab to control the step spacing and offset.

Step spacing
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 Description Default
1 Vertical spacing between the steps.

The spacing depends on the step spacing
type.

300 mm

1 Step spacing type.

The steps are spaced from the second
picked point to the first picked point

Equal represents the maximum distance
between the steps.

Exact represents the exact distance
between the steps.

Equal

Step offset

 Description Default
1 Step offset from the stringers. 0 mm
2 Type of the step offset. Horizontal (H)

Rails tab
Use the Rails tab to control the handrail and middle rail properties.

Middle rail and Handrail

Option Description Default
Middle rail to
stanchion

Handrail to stanchion

Define how the middle
rails or handrails are
connected to the
stanchions.

Middle rails =
Connection
Handrails = Weld

Connection number Define a connection that
connects the rails to
stanchion by selecting it
from the component
catalog.

Round tube (23)

Connection properties Select an attribute file
for the connection.

standard
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Handrail options

Option Description Default
Handrail max. length Maximum length of the

handrail.
3000 mm

Handrail cuts Define how the handrails
are cut.

• At max. stanchion

Starting from the
handrail end, the
Handrail max.
length is measured
along the handrail
and the cut is made
at the last stanchion
included in the
measured distance.

• At max. length

Starting from the
handrail end, the
Handrail max.
length is measured
along the rail and the
cut is made at the
maximum length.

• Every stanchion

A cut is made to the
handrail at each
stanchion.

At max. stanchion

Detail B tab
Use the Detail B tab to control the bolt properties on a plate that connects
stanchions to stringers.
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Vertical offset

 Description
1 Plate vertical offset.
2 Define how to measure the dimension for the plate vertical offset.

• Top

From the top of the plate to the stanchion center.

• Middle

From the horizontal center line of the plate to the stanchion center.

• Below

From the bottom of the plate to the stanchion center.
3 Plate width.
4 Distance between top bolt and plate top.
5 Distance between the bolts.
6 Distance between bottom bolt and plate bottom.

Horizontal offset
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 Description
1 Define how to measure the dimension for the horizontal plate offset.

• Left

• From the left of the plate to the stanchion center.

• Middle

From the horizontal center line of the plate to the stanchion
center.

• Right

• From the right of the plate to the stanchion center.
2 Horizontal plate offset.

Bolting direction

Option Description
Default

From plate to stringer

AutoDefaults can change this option.
From stringer to plate

From plate to stringer

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Welds tab

Click the link below to find out more:

Wall Rails
Wall rails creates a horizontal or a sloped handrail with supporting elements.
The handrail is connected to a wall.

Objects created

• Rail

• Elbows

• Endings

• Bracket arm

• Bracket base

• Bolts

• Welds
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Use for

Situation Description
Rail with elbows, endings, and
brackets.

Rail on one side of a ladder, with
elbows, endings, and brackets.

Straight rail with brackets.

Selection order

1. Pick the start point

2. Pick the end point.

The rail is created automatically.
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Part identification key

 Part
1 Rail
2 Right elbow
3 Left elbow
4 Right ending
5 Left ending
6 Bracket arm
7 Bracket base

General tab
Use the General tab to control the assembly creation, rail dimensions and the
rail offset.

Assembly creation

Option Description Default
Create Assembly Define which parts form

an assembly.

The options are:

• All

All parts are included
in an assembly,
including brackets.

Rail is the assembly
main part.

All
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Option Description Default
• Rail

Rail and elbows form
an assembly.

The sloped part of
the rail is the
assembly main part.

• No

No assembly is
created.

Rail dimensions

 Description Default
1 Vertical distance between the rail and the

start/end point.
0 mm

2 Horizontal distance from the rail’s
rightmost/leftmost edge to the start/end
point.

If you have created endings, the distance is
measured from the endings’ outmost edge.

0 mm

3 Vertical distance between the rail and the
noseline.

0 mm

Rail ending dimensions

Define whether the vertical distance between the start/end point and the rail is
measured from the top or the middle of the rail.
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Option Description
Default

From top

AutoDefaults can change this option.
From top

From middle

Rail offset

 Description Default
1 Rail horizontal offset from the start/end

point.
0 mm

Endings tab
Use the Endings tab to control the rail ending types and dimensions.

Ending types

Option Option Description
Default

No ending

AutoDefaults can change
this option.
No ending
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Option Option Description
Separate bent elbow
part between rails.

Rail is bent.

Rail and ending are
fitted.

End detail

Option Description Default
End detail Define a detail that is

created to the ending by
selecting it from the
component catalog.

None

Attribute Select an attribute file
for the end detail.

standard

NOTE Some details do not work correctly with the bent rail. In that case you
need to

• select another type of detail

• use some other elbow or ending type than bent rail.

• select the Internal bracket type.
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Ending dimensions

 Description Default
1 Length of the straight part of the ending. 100 mm
2 Inner radius of the bent ending. 30 mm
3 Bent angle by entering a value between +90

and +180 degrees or -90 and -180 degrees.
90 degrees

4 Length of the bending.

Rail orientation

Define the orientation of the handrail.
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Bent angle examples
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Elbows tab
Use the Elbows tab to control the elbow types and dimensions.

Elbow types

Option Option Description
Default

No elbow

AutoDefaults can change
this option.
No elbow

Separate bent elbow
part between rails.

Rail is bent.

Rails are fitted.

Rails are not fitted.

NOTE If you select some other option than No elbow, you need to enter a
value for the horizontal distance from the rail’s rightmost/leftmost
edge to the start/end point on the General tab. Otherwise the rail is
not created correctly.

Radius and length of bending
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 Description Default
1 Inner radius of the bent elbow. 30 mm
2 Length of the bending.

Brackets tab
Use the Brackets tab to control the bracket types and dimensions.

Bracket options

Option Description Default
Bracket type Define how brackets are

created.

The options are:

• Internal

Brackets are created
according to the
profile selected on
the Parts tab.

• Detail

Brackets are created
according to the
selected bracket
detail.

• No

No brackets are
created.

Internal

Bracket base Define whether the
bracket base is created
or not.

Yes

Bracket detail Define a system or a
custom detail that is
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Option Description Default
used as a bracket by
selecting it from the
component catalog.

This field is active only if
you have set the
Bracket type to Detail.

Attribute Select an attribute file
for the detail.

standard

Connect bracket detail
to

Define the part to which
the bracket detail is
connected.

Bracket arm

Bracket direction

Option Description
Default

Brackets on the left side

AutoDefaults can change this option.
Brackets on the left side

Brackets on the right side

Bracket positioning

 Description Default
1 Distance between the start/end point of

the rail and the bracket.
100 mm

2 Number of brackets. 0
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 Description Default
3 Bracket spacing.

Use a space to separate bracket spacing
values.

0 mm

4 Distance between the start/end point of
the rail and the bracket.

100 mm

5 Number of brackets. 0
6 Bracket spacing.

Spacing depends on the selected bracket
spacing type.

0 mm

7 Spacing type.

If you select Maximum, the component
creates the mininum amount of brackets
needed without exceeding the entered
spacing value. The amount of brackets is
then equally distributed along the rail.

Exact

Bracket dimensions

 Description Default
1 Bracket arm width.

The dimension is measured from the
bracket base.

120 mm

2 Bracket base thickness. 50 mm
3 Bent inner radius of the bracket arm. 10 mm
4 Bracket arm vertical length.

The dimension is measured from the bent
radius.

5 mm
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Hole placement in bracket base

 Description Default
1 Radius of the circle on which the bracket

holes are placed.
17 mm

Bolts tab
Use the Bolts tab to control the bolts that connect the bracket base to a wall.

Bolting direction

Option Description
Default

From bracket to wall

AutoDefaults can change this option.

From bracket to wall
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Option Description
From wall to bracket

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Parts tab
Use the Parts tab to control dimensions of the created parts.

Part guide

Select a part from the list. The selected part is displayed.
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Part dimensions

Option Description Default
Rail Define a profile by

selecting it from the
profile catalog.

CHS40*3

Right elbow Define a profile by
selecting it from the
profile catalog.

Not created

Left elbow Define a profile by
selecting it from the
profile catalog.

Not created

Right ending Define a profile by
selecting it from the
profile catalog.

Not created

Left ending Define a profile by
selecting it from the
profile catalog.

Not created

Bracket arm Define a profile by
selecting it from the
profile catalog.

D12

Bracket base Define a profile by
selecting it from the
profile catalog.

D60

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
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Welds tab

Click the link below to find out more:

2.15 Stiffeners and gussets
This section introduces components that can be used in steel stiffeners and
gussets.

• Beam with stiffener (129) (page 1747)

• Gusset stiffeners (171) (page 1771)

• Column with stiffeners W (182) (page 1775)

• Column with stiffeners (186) (page 1807)

• Column with stiffeners S (187) (page 1836)

• Column with stiffeners (188) (page 1863)

• Stiffeners (1003) (page 1894)

• Column stiffeners (1030) (page 1898)

• Stiffeners (1041) (page 1902)

• Multiple stiffeners (1064) (page 1905)

• Standard gusset (1065) (page 1911)

Beam with stiffener (129)
Beam with stiffener (129) connects a beam to another beam with a bolted
and welded shear tab. The connection can be used at the back of a U-profile.
The secondary beam can be leveled or sloped and/or skewed.

Objects created

• Shear tabs (1 or 2)

• Stiffener (optional)

• Haunch plates (optional)

• Welds

• Bolts

• Cuts
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Use for

Situation Description
Full depth shear tab.

Full depth shear tab. The secondary part is
sloped and/or skewed.

Shear tab with a beam stiffener.

Selection order

1. Select the main part (beam).
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2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Shear tab

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Picture tab
Use the Picture tab to control the position of the shear tab, and the beam
flange and the web cuts.

Dimensions
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 Description Default
1 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

10 mm

2 Shear tab edge distance from the main part
flange edge.

0

3 Distance from the corner of the shear tab to
the edge of the main part flange.

4 Size of the strip made to the secondary part
flange.

The cut of the flange is defined from the
shear tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

20 mm
5 Distance from the edge of the main part to

the corner of the shear tab.
20 mm

6 Distance from the bottom edge of the main
part to the bottom edge of the shear tab.

10 mm

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.
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Option Description
Square cut closer to the main part
web

Cuts the end of the secondary beam
square and places the beam closer to
the main part web.
Clipped flange

Cuts the corner of the flange at the
end of the secondary beam.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Beam web cut

Define how the secondary beam web end is cut. The beam is viewed from the
top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the web bevel when
the end of the secondary beam is cut
bevel.
Square

Cuts the end of the web square even
if the end of the secondary beam is
cut bevel.
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Beam bottom flange cut

Option Description
Default

Notch

Define the notch dimensions.

AutoDefaults can change this option.
Notch

Define the notch dimensions.

The bottom of the secondary beam is
notched if the shear tab crosses the
flange.
Flange cut

The secondary beam flange is cut on
the same side as the shear tab if the
shear tab crosses the flange.

Plates tab
Use the Plates tab to control the size, position, number, and shape of the
shear tab.

Shear tab

Option Description
Tab plate Shear plate tab thickness and width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.
3 Vertical and the horizontal dimension of the shear tab chamfer.
4 Vertical dimension from the bottom edge of the shear tab to the lower

shear tab corner.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer
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Option Description
Concave arc chamfer

Inner shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.
3 Radius and the vertical dimensions of the shear tab inner chamfer.

Chamfer type

Option Option Description
Default

No chamfer

AutoDefaults can change
this option.
No chamfer

Line chamfer

Convex arc chamfer
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Option Option Description
Concave arc chamfer

Inner chamfer type

Option Description
Default

Concave arc chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab
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Option Description
Near side and far side shear tab

Near side shear tab

Gap between shear tabs

 Description Default
1 Gap between the secondary part web

and shear tab.

This only affects connections with two
shear tabs.

0

Shear tab orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square

Sloped

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Square

Steel components 1756 Stiffeners and gussets



Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position, and type.

Opposite web stiffener plate dimensions

Option Description
Opposite web stiffener Opposite web stiffener plate

thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Stiffener creation

Option Description
Default

No stiffeners are created.

AutoDefaults can change this option.

Full

Creates a full stiffener of the same
height as the web of the main part.

Determined by shear tab

Tekla Structures determines the size
of the stiffener based on the shear
tab size. Tekla Structures attempts to
keep the bottom edges of the
stiffener plate and shear tab level, if
possible.
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Option Description
Partial

Leaves a gap between the stiffener
plate and the bottom flange of the
main part.

No stiffeners are created.

Stiffener gap

 Description
1 Size of the gap between the main part flange and the stiffener.
2 Distance from the edge of the main part flange to the edge of the

stiffener.

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.
Stiffeners are perpendicular to the
main part.

Stiffeners are parallel to the
secondary part.
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Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.
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Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1
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Option Description
Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Notch tab
Use the Notch tab to automatically create notches for the secondary beams
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.
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Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
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Option Description
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.
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Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
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Option Description
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions
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 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.
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Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).
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Option Description
Haunch plates are not created.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Gusset stiffeners (171)
Gusset stiffeners (171) creates 2 or 3 (default) stiffener plates and welds
them to an existing gusset plate and a beam or a column. You can also create
chamfers to the gusset plate and stiffeners.

Objects created

• Stiffener plates

• Welds

• Cuts
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Use for

Situation Description
3 stiffeners welded to column flange and gusset
plate.

Gusset stiffener that is not perpendicular to an I-
beam.

Gusset stiffener for a pipe or bar. Notice that the
stiffener does not have to be located on the
centerline of the pipe or bar.

Chamfered gusset stiffener.

Before you start

Create a gusset plate, and a beam or a column. Use I, C, tube, or RHS profiles.

TIP To create a gusset plate, use the Standard gusset (1065) component or
the plate command that creates a contour plate.

Selection order

1. Select the main part (gusset plate).

2. Select the secondary part (beam or column).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Description
1 Upper stiffener
2 Middle stiffener
3 Lower stiffener

Picture tab
Use the Picture tab to define the location, shape, and dimensions of the
stiffener plates.

Option Description
Define the horizontal and vertical
dimensions of the stiffener plates.

Define the middle stiffener offset
from the gusset center line.

Stiffener shapes Select the stiffener shape.
Flip stiffener directions Select Yes to flip the stiffener

direction.

Parts tab
Use the Parts tab to define the stiffener properties.
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 Description
Upper stiffener, Lower
stiffener, Middle
stiffener

Define the thickness, width and height of the
stiffener.

By default, 3 stiffeners are created. To remove a
stiffener, enter 0 as the thickness for that
stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Chamfer tab
Use the Chamfer tab to define the chamfer shapes and dimensions for the
stiffeners and gusset plate.
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Column with stiffeners W (182)
Column with stiffeners W (182) connects a column to a beam with a shear
tab. The shear tab is welded to the main part and bolted to the secondary part
web. The secondary beam can be leveled or sloped.

Objects created

• Shear tabs (1 or 2)

• Stiffeners (optional)

• Haunch plates (optional)

• Web doubler plate (optional)

• Weld backing bars (optional)

• Bolts

• Welds

• Cuts
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Use for

Situation Description
Shaped shear tab with column stiffeners.

Shaped shear tab with column stiffeners.

The secondary part is sloped.

Shaped shear tab with column stiffeners.

Bolts are aligned with the secondary part.

Steel components 1776 Stiffeners and gussets



Situation Description
Shaped shear tab with column stiffeners.

Bolts can be deleted.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Shear tab
2 Haunch plate
3 Stiffener

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Steel components 1777 Stiffeners and gussets



Picture tab
Use the Picture tab to control the position of the shear tab corner and to
define how the beam end is cut.

Dimensions

 Description Default
1 Shear tab edge distance from the main part

flange edge.
2 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

20 mm

3 Size of the strip made to the secondary part
flange.

The cut of the flange is defined from the
shear tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

20 mm

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
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Option Description
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.

Plates tab
Use the Plates tab to control the size, position, number, orientation and shape
of the shear tab.

Shear tab plate

Option Description
Tab plate Shear tab plate thickness, width and

height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.
3 Vertical and the horizontal dimension of the shear tab chamfer.

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer
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Option Description
Concave arc chamfer

Chamfer type dimensions

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Concave arc chamfer

Shear tab orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square

Sloped

The shear tab is sloped in the
direction of the secondary beam.
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Option Description
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Square

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab

Near side and far side shear tab

Near side shear tab

Gap between shear tabs

Steel components 1782 Stiffeners and gussets



 Description Default
1 Gap between the secondary part web

and shear tab.

This only affects connections with two
shear tabs.

0

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.

Stiffener plate dimensions

Option Description
Top NS Top near side stiffener thickness,

width and height.
Top FS Top far side stiffener thickness, width

and height.
Bottom NS Bottom near side stiffener thickness,

width and height.
Bottom FS Bottom far side stiffener thickness,

width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.

Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.

Stiffeners are created.
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Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.

Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding

Line chamfered stiffener plates

Stiffener gap and chamfer size

 Description
1 Size of the gap between the flanges and the stiffener.
2 Distance from the edge of the flange to the edge of the stiffener.
3 Vertical dimension of the stiffener line chamfer.
4 Horizontal dimension of the stiffener chamfer or radius of arc type

chamfer.

Define the chamfer shape.
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Option Description
Default

No chamfers

AutoDefaults can change this option.
No chamfers

Line chamfer

Convex arc chamfer

Concave arc chamfer

Stiffener positions

 Description
1 Size of the gap between the stiffener and the beam web edge.
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
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 Description
5 Size of the gap between the top far side stiffener and the beam flange

edge.

Chamfer dimensions

 Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer
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Option Description
Line and arc chamfer

Haunch
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.
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Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).
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Option Description
Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
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Option Description
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.
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Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.
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Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.
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Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.
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Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from
top to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1
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Option Description
Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole
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Option Description Default
Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.
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Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.

Weld backing bars

Option Option Description
Default

No backing bars are
created.

AutoDefaults can change
this option.
No backing bars are
created.

Backing bars are created
inside the flanges.

Backing bars are created
outside the flanges.

Weld backing bar length

Enter the length of the weld backing bar in the box below the options.

Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar
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Option Description
Extension beyond the edge of the
flange

Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.

Doubler plate
Use the Doubler plate tab to create doubler plates to strengthen the web of
the main part.

Web plate

Option Description
Web plate Web plate thickness and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Doubler plates

Option Description
Default

Doubler plates are not created.

AutoDefaults can change this option.

Doubler plates are not created.

Doubler plate is created on the far
side.

Doubler plate is created on the near
side.

Doubler plates are created on both
sides.

Doubler plate edge shape

Option Description
Default

Bevel doubler plates

AutoDefaults can change this option.
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Option Description
Bevel doubler plates

Enter the angle in 

Square doubler plates

Doubler plate cuts

Option Description
Default

Doubler plates are not cut.

AutoDefaults can change this option.

Doubler plates are not cut.

Doubler plates are cut in the area that
connects the main part web and
flange.
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General settings

Description
1 Edge distance from the column flange.
2 Doubler plate edge distance.

Edge distance is the distance from the center of a hole to the edge of
the part.

3 Edge distance of the doubler plate in relation to the bottom of the
secondary part.

4 Number of holes.
5 Hole spacing.

Use a space to separate hole spacing values. Enter a value for each
space between holes. For example, if there are 3 holes, enter 2
values.
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Weld hole size

 Description
1 Hole diameter.
2 Slot length.
3 Slot width.

General tab

Click the link below to find out more:

General tab

Design type tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Column with stiffeners (186)
Column with stiffeners (186) connects a beam to a column with a square
shear tab. The shear tab is welded to the main part web and stiffeners, and
bolted to the secondary part web. The secondary beam can be leveled or
sloped.
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Objects created

• Shear tabs (1 or 2)

• Stiffeners (optional)

• Haunch plates (optional)

• Web doubler plate (optional)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Shear tab with column stiffeners.

Shear tab with column stiffeners.

The secondary part is sloped.
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Situation Description
Shear tab with column stiffeners.

The secondary part is skewed.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Part
1 Shear tab
2 Haunch plate
3 Stiffener

NOTE Tekla Structures uses values in the joints.def file to create this
component.
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Example: Add a beam-to-column connection using the Column with
stiffeners (186) connection
In this example, you will connect a beam to a column using a beam-to-column
connection.

1. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

2. Enter 186 in the search box.

3. Select Column with stiffeners (186).

4. Select the main part (column).

5. Select the secondary part (beam). 

Tekla Structures automatically adds the connection when you select the
beam.

Picture tab
Use the Picture tab to control how the secondary beam end is cut.
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Dimensions

Description Default
1 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

20

2 Size of the strip made to the secondary part
flange.

The cut of the flange is defined from the
shear tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

20

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
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Option Description
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Plates tab
Use the Plates tab to control the size, position, number, orientation and shape
of the shear tab.

Shear tab plate

Option Description
Tab plate Shear tab plate thickness, width and

height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Material Material grade. The default material is

defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.

Chamfer type

Option Option Description
Default

Line chamfer

AutoDefaults can change
this option.
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Option Option Description
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab
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Option Description
Near side and far side shear tab

Near side shear tab

Gap between shear tabs

 Description Default
1 Gap between the secondary part web

and shear tab.

This only affects connections with two
shear tabs.

0

Shear tab end cut

Option Description
Default

The shear tab end is not cut.

AutoDefaults can change this option.
Square

The shear tab end is not cut.

Bevel

The shear tab end is cut parallel to
the main part web.

Shear tab orientation

Option Description
Default

Sloped

AutoDefaults can change this option.
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Option Description
Automatic

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Sloped

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Square

Modified sloped

Same as the Sloped option, but the
vertical edge of the shear tab
connected to the secondary beam is
cut perpendicular to the secondary
beam flange.

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.

Stiffener plate dimensions

Option Description
Top NS Top near side stiffener thickness,

width and height.
Top FS Top far side stiffener thickness, width

and height.
Bottom NS Bottom near side stiffener thickness,

width and height.
Bottom FS Bottom far side stiffener thickness,

width and height.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.
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Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.

Stiffeners are created.

Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.

Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding
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Option Description
Line chamfered stiffener plates

Stiffener gap

Description
1 Distance from the edge of the flange to the edge of the

stiffener.
2 Size of the gap between the flanges and the stiffener.

Stiffener positions

 Description
1 Size of the gap between the stiffener and the beam web edge.
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
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 Description
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
5 Size of the gap between the top far side stiffener and the beam flange

edge.

Chamfer dimensions

 Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm

Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer
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Option Description
Line and arc chamfer

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.

Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).
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Option Description
Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
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Option Description
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.

Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.
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Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.

Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.
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Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.
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Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions

 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.
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Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

5 Dimension for vertical bolt group position.
6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

Steel components 1828 Stiffeners and gussets



 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1
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Option Description
Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

Steel components 1831 Stiffeners and gussets



To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Doubler plate tab
Use the Doubler plate tab to create doubler plates to strengthen the web of
the main part.

Web plate

Option Description
Web plate Web plate thickness and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Doubler plates

Option Description
Default

Doubler plates are not created.

AutoDefaults can change this option.

Doubler plates are not created.

Doubler plate is created on the far
side.

Doubler plate is created on the near
side.

Doubler plates are created on both
sides.

Doubler plate edge shape

Option Description
Default

Bevel doubler plates

AutoDefaults can change this option.

Bevel doubler plates

Enter the angle in 
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Option Description
Square doubler plates

Doubler plate cuts

Option Description
Default

Doubler plates are not cut.

AutoDefaults can change this option.

Doubler plates are not cut.

Doubler plates are cut in the area that
connects the main part web and
flange.
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General settings

Description
1 Edge distance from the column flange.
2 Doubler plate edge distance.

Edge distance is the distance from the center of a hole to the edge of
the part.

3 Edge distance of the doubler plate in relation to the bottom of the
secondary part.

4 Number of holes.
5 Hole spacing.

Use a space to separate hole spacing values. Enter a value for each
space between holes. For example, if there are 3 holes, enter 2
values.
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Weld hole size

 Description
1 Hole diameter.
2 Slot length.
3 Slot width.

General tab
Click the link below to find out more:

General tab

Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:

Column with stiffeners S (187)
Column with stiffeners S (187) connects a column to a beam with a shaped
shear tab. The shear tab is welded to the main part web and stiffeners, and
bolted to the secondary part web. The secondary beam can be leveled or
sloped.
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Objects created

• Shear tabs (1 or 2)

• Stiffeners (optional)

• Haunch plates (optional)

• Web doubler plate (optional)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Beam connected to column web.

Shear tab with bottom haunch plate and four
stiffeners.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.

Part identification key
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 Part
1 Shear tab
2 Haunch plate
3 Stiffener

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Picture tab
Use the Picture tab to control the position of the shear tab corner and to
define how the beam end is cut.

Dimensions

 Description Default
1 Shear tab edge distance from the main

part flange edge.
0

2 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

20 mm

3 Size of the strip made to the secondary
part flange.

The cut of the flange is defined from the
shear tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

20 mm
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Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.

Beam flange cut

Define how the secondary beam flange end is cut. The beam is viewed from
the top.

Option Description
Default

Bevel

AutoDefaults can change this option.
Bevel

Cuts the end of the flange bevel.
Square

Cuts a part of the flange square and
leaves a part of it bevel.

Plates tab
Use the Plates tab to control the size, position, number, orientation and shape
of the shear tab.
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Shear tab plate

Option Description
Tab plate Shear tab plate thickness, width and

height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.
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 Description
3 Vertical and the horizontal dimension of the shear tab chamfer.

Chamfer type

Option Option Description
Default

Line chamfer

AutoDefaults can change
this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Chamfer type dimensions

Option Description
Default

Line chamfer

AutoDefaults can change this option.
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Option Description
No chamfer

Line chamfer

Concave arc chamfer

Shear tab orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square

Sloped

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Square

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 

Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Steel components 1842 Stiffeners and gussets



Option Description
Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab

Near side and far side shear tab

Near side shear tab

Gap between shear tabs

 Description Default
1 Gap between the secondary part web

and shear tab.

This only affects connections with two
shear tabs.

0

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.

Stiffener plate dimensions

Option Description
Top NS Top near side stiffener thickness,

width and height.
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Option Description
Top FS Top far side stiffener thickness, width

and height.
Bottom NS Bottom near side stiffener thickness,

width and height.
Bottom FS Bottom far side stiffener thickness,

width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.
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Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.

Stiffeners are created.

Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.

Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding
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Option Description
Line chamfered stiffener plates

Stiffener gap and chamfer size

 Description
1 Size of the gap between the flanges and the stiffener.
2 Distance from the edge of the flange to the edge of the stiffener.
3 Vertical dimension of the stiffener line chamfer.
4 Horizontal dimension of the stiffener chamfer or radius of arc type

chamfer.

Define the chamfer shape.

Option Description
Default

No chamfers

AutoDefaults can change this option.
No chamfers

Line chamfer

Convex arc chamfer
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Option Description
Concave arc chamfer

Stiffener positions

 Description
1 Size of the gap between the stiffener and the beam web edge.
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
5 Size of the gap between the top far side stiffener and the beam flange

edge.

Chamfer dimensions

 Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm
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Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Line and arc chamfer

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start number
is defined in the Components
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Option Description Default
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.
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Option Description
Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).

Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
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Option Description
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.
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Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.
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Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.

Steel components 1853 Stiffeners and gussets



Option Description
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions
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 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.

Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2
values.

5 Dimension for vertical bolt group position.
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 Description
6 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.
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 Description
7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from
top to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Doubler plate tab
Use the Doubler plate tab to create doubler plates to strengthen the web of
the main part.

Web plate

Option Description
Web plate Web plate thickness and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
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Option Description Default
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Doubler plates

Option Description
Default

Doubler plates are not created.

AutoDefaults can change this option.

Doubler plates are not created.

Doubler plate is created on the far
side.

Doubler plate is created on the near
side.

Doubler plates are created on both
sides.

Doubler plate edge shape

Option Description
Default

Bevel doubler plates

AutoDefaults can change this option.
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Option Description
Bevel doubler plates

Enter the angle in 

Square doubler plates

Doubler plate cuts

Option Description
Default

Doubler plates are not cut.

AutoDefaults can change this option.

Doubler plates are not cut.

Doubler plates are cut in the area that
connects the main part web and
flange.
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General settings

Description
1 Edge distance from the column flange.
2 Doubler plate edge distance.

Edge distance is the distance from the center of a hole to the edge of
the part.

3 Edge distance of the doubler plate in relation to the bottom of the
secondary part.

4 Number of holes.
5 Hole spacing.

Use a space to separate hole spacing values. Enter a value for each
space between holes. For example, if there are 3 holes, enter 2
values.
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Weld hole size

 Description
1 Hole diameter.
2 Slot length.
3 Slot width.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Column with stiffeners (188)
Column with stiffeners (188) connects a column to a beam with a square
shear tab. The shear tab is welded to the main part web and stiffeners, and
bolted to the secondary part web. The secondary beam can be level or sloped.
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Objects created

• Shear tabs (1 or 2)

• Stiffeners (optional)

• Haunch plates (optional)

• Weld backing bars (optional)

• Web doubler plate (optional)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Shear tab to column flange with column
stiffeners.

Shear tab to column flange with column
stiffeners.

Weld preparation and weld access holes for
moment connection.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Part
1 Shear tab
2 Haunch plate
3 Stiffener

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Picture tab
Use the Picture tab to control how the beam end is cut.

Dimensions
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 Description Default
1 Cut of the secondary part.

Cutting the secondary part creates a gap
between the main part and the secondary
part.

The cut is defined from the main part web
or the main part flange.

20 mm

2 Size of the strip made to the secondary part
flange.

The cut of the flange is defined from the
shear tab edge.

The flange is
automatically stripped
when the shear tab
crosses the flange.

20 mm

Secondary part cut

Define whether the secondary part cut is calculated from the main part web or
main part flange.

Option Description
Default

From the main part web

AutoDefaults can change this option.

From the main part flange

Beam end cut

Define how the secondary beam end is cut. The beam is viewed from the side.

Option Description
Default

Bevel

AutoDefaults can change this option.
Automatic

If the secondary beam is sloped less
than 10 degrees, the beam end is cut
square. Otherwise, the beam end is
cut bevel.

Steel components 1866 Stiffeners and gussets



Option Description
Square

Cuts the end of the secondary beam
square.
Bevel

Cuts the end of the secondary beam
parallel to the edge of the main part.

Plates tab
Use the Plates tab to control the size, position, number, orientation and shape
of the shear tab.

Shear tab plate

Option Description
Tab plate Shear tab plate thickness, width and

height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Shear tab chamfers

 Description
1 Horizontal dimension of the shear tab chamfer.
2 Vertical dimension of the shear tab chamfer.

Chamfer type

Option Option Description
Default

Line chamfer

AutoDefaults can change
this option.

No chamfer

Line chamfer

Convex arc chamfer
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Option Option Description
Concave arc chamfer

Shear tab orientation

Option Description
Default

Sloped

AutoDefaults can change this option.
Automatic

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Sloped

The shear tab is sloped in the
direction of the secondary beam.
Both vertical edges of the shear tab
are cut parallel to the end of the
secondary beam.
Square

Modified sloped

Same as the Sloped option, but the
vertical edge of the shear tab
connected to the secondary beam is
cut perpendicular to the secondary
beam flange.

Shear tab position

Define the number and the side of shear tabs in single shear tab connections. 
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Option Description
Default

Far side shear tab

AutoDefaults can change this option.

Automatic

The component automatically selects
either the near side or the far side
shear tab. The tab is created to the
side of the secondary part when the
angle between the main part and the
secondary part is less than 90
degrees.
Far side shear tab

Near side and far side shear tab

Near side shear tab

Gap between shear tabs

 Description Default
1 Gap between the secondary part web

and shear tab.

This only affects connections with two
shear tabs.

0

Steel components 1870 Stiffeners and gussets



Shear tab end cut

Option Description
Default

The shear tab end is not cut.

AutoDefaults can change this option.
Square

The shear tab end is not cut.

Bevel

The shear tab end is cut parallel to
the main part web.

Stiffeners tab
Use the Stiffeners tab to control the stiffener plate dimensions, orientation,
position and type.

Stiffener plate dimensions

Option Description
Top NS Top near side stiffener thickness,

width and height.
Top FS Top far side stiffener thickness, width

and height.
Bottom NS Bottom near side stiffener thickness,

width and height.
Bottom FS Bottom far side stiffener thickness,

width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Name Name that is shown in

drawings and reports.

Stiffener orientation

Option Description
Default

Stiffeners are parallel to the
secondary part.

AutoDefaults can change this option.

Stiffeners are parallel to the
secondary part.

Stiffeners are perpendicular to the
main part.

Stiffener creation

Option Description
Default

Stiffeners are created.

AutoDefaults can change this option.

Automatic

Stiffeners are created when
necessary.

No stiffeners are created.
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Option Description
Stiffeners are created.

Stiffener shape

Option Description
Default

Line chamfered stiffener plates

AutoDefaults can change this option.

Automatic

Line chamfered stiffener plates

Square stiffener plates

Stiffener plates with a gap for the
main part web rounding

Line chamfered stiffener plates

Stiffener gap
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Description
1 Distance from the edge of the flange to the edge of the

stiffener.
2 Size of the gap between the flanges and the stiffener.

Stiffener positions

 Description
1 Size of the gap between the stiffener and the beam web edge.
2 Size of the gap between the top near side stiffener and the beam flange

edge.
3 Size of the gap between the bottom near side stiffener and the beam

flange edge.
4 Size of the gap between the bottom far side stiffener and the beam

flange edge.
5 Size of the gap between the top far side stiffener and the beam flange

edge.

Chamfer dimensions

 Description Default
1 Vertical dimension of the

chamfer.
10 mm

2 Horizontal dimension of the
chamfer.

10 mm
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Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Line and arc chamfer

Haunch tab
Use the Haunch tab to control the haunch plate creation and chamfers in the
secondary beam flanges.

Haunch plates

Option Description
Top plate Top haunch plate thickness, width

and height.
Bottom plate Bottom haunch plate thickness, width

and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start number
is defined in the Components
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Option Description Default
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

Haunch plate chamfers

Description
1 Width of the top haunch plate chamfer.
2 Height of the top haunch plate chamfer.
3 Height of the bottom haunch plate chamfer.
4 Width of the bottom haunch plate chamfer.

Haunch plate creation

Option Description
Default

Top and bottom haunch plates are
created, if needed.

AutoDefaults can change this option.
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Option Description
Automatic

Top or bottom haunch plate or both
are created, if needed.

Top and bottom haunch plates are
created.

To create a single plate, enter 0 in the
thickness (t) field for the plate you do
not need (top or bottom plate).

Haunch plates are not created.

Notch tab
Use the Notch tab to automatically create notches for the secondary beam
and to control the notch properties. The Notch tab has two sections:
automatic properties (top section) and manual properties (bottom section).
Automatic and manual notching properties work independently from each
other.

Automatic notching

Automatic notching options affect both the top and the bottom flange.

Notch shape

Automatic notching is switched on when you select a notch shape.

Option Description
Default

Creates notches to the secondary beam.

AutoDefaults can change this option.
Creates notches to the secondary beam. The cuts are
square to the main beam web.

Creates notches to the secondary beam. The cuts are
square to the secondary beam web.

Creates notches to the secondary beam. The vertical
cut is square to the main beam, and the horizontal
cut is square to the secondary beam.
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Option Description
Turns off automatic notching.

Notch size

Option Description
Default

The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.

AutoDefaults can change this option.
The notch size is measured from the edge of the
main beam flange and from underneath the top
flange of the main beam.
The notch size is measured from the center line of
the main beam and from the top flange of the main
beam.

Enter the horizontal and vertical values for the cuts.

Flange cut shape

Option Description
Default

Secondary beam flange is cut parallel to the main
beam.

AutoDefaults can change this option.
Secondary beam flange is cut parallel to the main
beam.

Secondary beam flange is cut square.

Notch dimension rounding

Use the notch dimension rounding options to define whether the notch
dimensions are rounded up. Even if the dimension rounding is set to active,
the dimensions are rounded up only when necessary.
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Option Description
Default

Notch dimensions are not rounded.

AutoDefaults can change this option.
Notch dimensions are not rounded.

Notch dimensions are rounded.

Enter the horizontal and vertical rounding values.

The dimensions are rounded up the nearest multiple of the value you enter.
For example, if the actual dimension is 51 and you enter a round-up value of
10, the dimension is rounded up to 60.

Notch position

Option Description
Default

Creates the cut below the main beam flange.

AutoDefaults can change this option.
Creates the cut below the main beam flange.

Creates the cut above the main beam flange.

Notch chamfer

Option Description
Default

The notch is not chamfered.

AutoDefaults can change this option.
The notch is not chamfered.

Creates the notch with a line chamfer.

The notch is chamfered according to the radius you
enter.
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Enter a radius for the chamfer.

Manual notching

Use manual notching when a part that does not belong to the connection
clashes with the secondary beam. When you use manual notching, the
connection creates cuts using the values you enter in the fields on the Notch
tab. You can use different values for the top and the bottom flange.

Side of flange notch

The side of flange notch defines on which side of the beam the notches are
created.

Option Description
Default

Creates notches on both sides of the flange.

AutoDefaults can change this option.
Automatic

Creates notches on both sides of the flange.
Creates notches on both sides of the flange.

Creates notches on the near side of the flange.

Creates notches on the far side of the flange.

Flange notch shape

The flange notch shape defines the notch shape in the beam flange.

Option Description
Default

The entire flange of the secondary beam is cut as far
back as you define.

AutoDefaults can change this option.
Automatic

The entire flange of the secondary beam is cut as far
back as you define. The default depth for the notch is
twice the thickness of the secondary flange. The cut
always runs the entire width of the secondary flange.
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Option Description
Creates chamfers in the flange.

If you do not enter a horizontal dimension, a chamfer
of 45 degrees is created.
Creates cuts to the flange with default values unless
you enter values in the fields 1and 2.

The flange is not cut.

Creates cuts to the flange according to the value in the
field 1 to make it flush with the web.

Creates cuts to the flange according to the values in the
fields 1 and 2.

Flange notch depth

Option Description
Default

Flange notch depth.

AutoDefaults can change this option.
Flange notch depth.

Flange notch depth with a dimension from the secondary
beam web center line to the edge of the notch.

Enter the value for flange notch depth.

Cut dimensions
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 Description Default
1 Dimensions for the horizontal flange

cuts.
10 mm

2 Dimensions for the vertical flange
cuts.

The gap between the notch
edge and the beam flange is
equal to the main part web
rounding. The notch height is
rounded up to the nearest 5
mm.

Bolts tab
Use the Bolts tab to control the properties of the bolts that connect the shear
tab to the secondary part.

Bolt group dimensions

Bolt group dimensions affect the size and shape of the shear tab.

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge
of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2
values.

5 Dimension for vertical bolt group position.
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 Description
6 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line of
the secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.
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 Description
7 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and
from top to bottom.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt group orientation

Option Description
Default

Square

AutoDefaults can change this option.
Automatic

Square
Staggered

Bolts are staggered in the direction of the secondary
part.
Square

Square bolt group is positioned horizontally.
Sloped

Square bolt group is sloped in the direction of the
secondary part.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Beam cut tab
Use the Beam cut tab to control weld backing bars, weld access holes, beam
end preparations, and flange cuts.

Weld backing bar

Option Description
Weld backing bar Weld backing bar thickness and

width.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Weld access hole dimensions

 Description
1 Gap between the secondary part top flange and the main part.
2 Vertical dimensions for the top and the bottom weld access holes.
3 Horizontal dimensions for the top and the bottom weld access holes.
4 Gap between the secondary part web and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.

5 Gap between the secondary part bottom flange and the main part.

Tekla Structures adds the value you enter here to the gap you enter
on the Picture tab.
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Weld access holes

Option Description Default
Default

Round weld access hole

AutoDefaults can change
this option.

 

Round weld access hole  

Square weld access hole  

Diagonal weld access
hole

 

Round weld access hole
with a radius that you
can define in

 

Extended cone-shaped
weld access hole with a
radius and dimensions
that you can define in

and

 

Cone-shaped weld
access hole with
radiuses that you can

define in 

and 

Capital R defines the
large radius (height).

Small r defines the small
radius.

R = 35
r = 10
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Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.

Weld backing bars

Option for top backing
bar

Option for bottom
backing bar

Description

Default

Backing bars are created
inside the flanges.

AutoDefaults can change
this option.
No backing bars are
created.
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Option for top backing
bar

Option for bottom
backing bar

Description

Backing bars are created
inside the flanges.

Backing bars are created
outside the flanges.

Weld backing bar length

Enter the length of the weld backing bar in the box below the options.

Option Description
Default

Absolute length of the backing bar

AutoDefaults can change this option.
Absolute length of the backing bar

Extension beyond the edge of the
flange

Weld backing bar position

Option Description
Enter a positive or a negative value to
move the front end of the backing bar
relative to the end of the flange.

Assembly type

Define the location where the weld backing bar welds are made. When you
select the Workshop option, Tekla Structures includes the backing bars in the
assembly.
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Doubler plate tab
Use the Doubler plate tab to create doubler plates to strengthen the web of
the main part.

Web plate

Option Description
Web plate Web plate thickness and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Doubler plates

Option Description
Default

Doubler plates are not created.

AutoDefaults can change this option.

Doubler plates are not created.

Doubler plate is created on the far
side.
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Option Description
Doubler plate is created on the near
side.

Doubler plates are created on both
sides.

Doubler plate edge shape

Option Description
Default

Bevel doubler plates

AutoDefaults can change this option.

Bevel doubler plates

Enter the angle in 

Square doubler plates

Doubler plate cuts

Option Description
Default

Doubler plates are not cut.

AutoDefaults can change this option.

Doubler plates are not cut.
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Option Description
Doubler plates are cut in the area that
connects the main part web and
flange.

General settings

Description
1 Edge distance from the column flange.
2 Doubler plate edge distance.

Edge distance is the distance from the center of a hole to the edge of
the part.

3 Edge distance of the doubler plate in relation to the bottom of the
secondary part.

4 Number of holes.
5 Hole spacing.

Use a space to separate hole spacing values. Enter a value for each
space between holes. For example, if there are 3 holes, enter 2
values.
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Weld hole size

 Description
1 Hole diameter.
2 Slot length.
3 Slot width.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Stiffeners (1003)
Stiffeners (1003) creates stiffeners to I-profiles.

Objects created

• Stiffeners
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Use for

Situation Description
Stiffeners at a beam end.

Selection order

1. Select the main part (beam).

2. Pick a position.

The detail is created automatically when the position is picked.

Picture tab
Use the Picture tab to control the stiffener plate position.

 Description
1 Define the gap between the stiffener plates and beam

flanges.

The default size of the gap between the stiffener plates
and beam flanges is 0 mm.
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 Description
2 Define the stiffener plate distance from the beam flange.

Parts tab
Use the Parts tab to control the stiffener properties.

Option Description
Left stiffener

Right stiffener

Define the stiffener thickness, width
and height.

By default, the thickness is 1.5*beam
web thickness rounded up to the
next plate thickness.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Parameters tab
Use the Parameters tab to control the stiffener angle and chamfers.
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Option Description
Position of the stiffeners.

You can enter horizontal angles in
degrees for the right and the left
stiffener.

Chamfer type and dimensions.

If you select the No Chamfer 
option, a clash can occur between the
stiffener and the I-profile rounding.

Additionally, you can define the
chamfer dimensions vertically and
horizontally. If you select an arc
chamfer, the horizontal dimension is
the radius and the vertical dimension
has no effect.
Set the stiffener polygon rotation of
the right and the left stiffener.

The value you enter determines the
number of points by which the start
point of the polygon is moved in the
direction shown by the arrows.
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Chamfer type

Option Description
Default

Line chamfer

AutoDefaults can change this option.

No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

General tab
Click the link below to find out more:

Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:
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Column stiffeners (1030)
Column stiffeners (1030) creates stiffeners to a point you pick on a beam.

Objects created

• Stiffeners

• Welds

Use for

Situation Description
Upper and lower stiffeners created on
a beam

Selection order

1. Select the beam.

2. Pick a point on the beam to indicate the stiffener position.

The stiffeners are created automatically when you pick the point.

Part identification key

 Description
1 Upper stiffener
2 Lower stiffener

Picture tab
Use the Picture tab to define the stiffener chamfer dimensions.
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Dimensions

 Description
1 Horizontal chamfer dimension
2 Vertical chamfer dimension
3 Horizontal chamfer dimension
4 Vertical position of the stiffener

Stiffeners are by default created in the vertical direction in the
middle of the beam.

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description Default
Upper stiffener Thickness, width, and

height of the stiffener
Thickness = 10 mm
Width = 100 mm
Height = 200 mm

Lower stiffener Thickness, width, and
height of the stiffener

Equal to the dimensions
of the upper stiffener

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
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Option Description Default
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the stiffener position and beam fitting.

Stiffener position

 Description
1 Stiffener offset from the beam center line

Beam fitting

Option Description
Default

Beam is not cut.

AutoDefaults can change this option.

Beam is not cut.

Beam is cut at the point where the
stiffeners are created.

General tab

Click the link below to find out more:

General tab
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Stiffeners (1041)
Stiffeners (1041) creates rectangular or triangular stiffener plates on one or
both sides of a beam or a column.

Objects created

• Stiffeners

• Welds

Use for

Situation Description
Rectangular stiffener

Triangular and rectangular stiffeners

Selection order

1. Select the main part (beam or column).
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2. Pick a position for the stiffeners.

The stiffeners are automatically created when you pick the position.

Part identification key

 Description
1 Rectangular stiffeners

Picture tab
Use the Picture tab to define the stiffener shape and chamfer dimension.

Stiffener shape

Option Description
Default

Rectangular stiffeners

AutoDefaults can change this option.

Triangular stiffeners

Rectangular stiffeners
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Stiffener chamfer

 Description
1 Define the chamfer dimension.

Parts tab
Use the Parts tab to define the part properties.

Parts

Part Description
Right stiffener Thickness, width, and height of the

right stiffener
Left stiffener Thickness, width, and height of the

left stiffener

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Multiple stiffeners (1064)
Multiple stiffeners (1064) creates multiple stiffeners to I, C, and U profiles.

Objects created

• Stiffeners

• Welds

Use for

Situation Description
Multiple stiffeners created to an I
beam.

Selection order

1. Select the main part (beam or column).

2. Pick a position for the stiffeners.

The stiffeners are created automatically when you pick the position.
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Part identification key

 Description
1 Stiffener

Picture tab
Use the Picture tab to define the number and spacing of the stiffeners.

Stiffeners

 Description
1 Number of stiffeners.
2 Stiffener spacing.

Use a space to separate stiffener spacing values. Enter a value
for each space between stiffeners. For example, if there are 3
stiffeners, enter 2 values.

Stiffener creation direction

Option Description
Default

Middle

AutoDefaults can change this option.
Middle

Creates stiffeners symmetrically.
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Option Description
Right

Creates stiffeners to the right of the
up direction symbol.
Left

Creates stiffeners to the left of the up
direction symbol.

Stiffener offset location

Option Description
Default

Middle

AutoDefaults can change this option.
Middle

Sets the offset to the middle of the
stiffener.
Left

Sets the offset to the left side of the
stiffener.
Right

Sets the offset to the right side of the
stiffener.

Parts tab
Use the Parts tab to define the part properties.

Parts

Part Description
Left stiffener Thickness and width of the left

stiffener.
Right stiffener Thickness and width of the right

stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
where you can enter the
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Parameters tab
Use the Parameters tab to define the stiffener angles, creation direction, and
offset.

Stiffener angles

 Description Default
1 Angle of the right stiffener. 0 degrees
2 Angle of the left stiffener. 0 degrees
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Rotate stiffener polygon

Set the stiffener polygon rotation of the right and the left stiffener.

The value you enter determines the number of points by which the start point
of the polygon is moved in the direction shown by the arrows.

Fit stiffeners with flanges

Select whether sloped stiffeners are fitted with the main part flanges.

Apply gaps in the coordinate system of

Select whether gaps are applied in the stiffeners or in the main part.

Stiffeners tab
Use the Stiffeners tab to define stiffener creation, dimensions, and chamfers
on both sides of the part.

Stiffener creation

Option Description
Default

Full stiffener

AutoDefaults can change this option.

Full stiffener

Partial stiffener, upper end
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Option Description
Partial stiffener, lower end

Partial stiffener, bevel

No stiffeners are created.

Stiffener dimensions

 Option Default
1 Stiffener edge distance from the beam edge. 0.0 mm
2 Stiffener edge distance from the beam web. Beam

rounding
radius 1

3 Stiffener edge distance from the beam upper
flange.

0 mm

4 Stiffener edge distance from the beam lower
flange.

0 mm

Chamfer type

You can select the chamfer type in each stiffener corner. The default type
depends on the stiffener corner.

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer
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Option Description
Convex chamfer

Concave chamfer

Square chamfer

Chamfer dimensions

 Description
1 Horizontal chamfer dimension.
2 Vertical chamfer dimension.

General tab

Click the link below to find out more:

General tab

Design type tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Standard gusset (1065)
Standard gusset (1065) creates a gusset plate and welds it to the beam or
column web. A stiffener is automatically created on each end of the gusset
plate.
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Objects created

• Gusset plate

• Stiffener plates (2)

• Bolts

To create braces and connect them to the gusset plate, use Gusset tube in
points (S47), Crushed tube in bolts (S48), or Gusset tube in bolts (S49).

Use for

Situation Description
Gusset plate welded to the beam web

Before you start

Create a beam or a column (H, W, or C profile).

Note that the gusset plate is created using the properties you define on the
Parts tab.

Selection order

1. Select the main part (beam or column).

2. Pick a point on the main part to indicate the location of the connection.

The connection is created automatically when the you pick the point.

Part identification key

  
1 Gusset plate
2 Stiffener
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Picture tab
Use the Picture tab to define the gusset plate and stiffener dimensions.

Part dimensions

 Description
1 Define the corner cut size of the gusset plate.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

5 Define the gusset plate offset from the beam or column web.
6 Define the corner cut size of the stiffener.
7 Define the stiffener offset from the beam or column web.
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Parts tab
Use the Parts tab define the gusset plate and stiffener properties.

Part Description
Gusset plate, Front
stiffener, Back
stiffener

Define the thickness, width and height of the gusset
plate and the stiffeners.

This component automatically creates stiffener
plates at each end of the gusset plate. To remove one
or both stiffener plates, delete the values in the
Front stiffener or Back stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parts tab to define the position of the gusset.

Option Description
Define the horizontal gusset location
using a reference point.
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Option Description
Define the vertical gusset location
using a reference point.

Select the gusset location.

Bolts tab
Use the Bolts tab to define the bolt properties.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Bolt group

Select whether several or a single bolt group is created.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

2.16 Base plates
This section introduces base plate components available in Tekla Structures.

Click the links below to find out more:

• U.S. Base plate connection (71) (page 1917)

• Round joining plates (124) (page 1939)

• Base plate (1004) (page 1946)
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• Stiffened base plate (1014) (page 1972)

• Web stiffened base plate (1016) (page 2000)

• Simple base plate 2 (1031) (page 2024)

• Base plate (1042) (page 2039)

• U.S. Bearing plate (1044) (page 2065)

• U.S. Base plate (1047) (page 2075)

• Circular base plates (1052) (page 2105)

• Base plate (1053) (page 2124)

• Box column base plate (1066) (page 2132)

U.S. Base plate connection (71)
U.S. Base plate connection (71) creates a base plate that connects a column
to a beam.

Objects created

• Base plate

• Stiffeners (can only be added if the column has a W, I, or a TS profile)

• Beam stiffener

• Bolts

• Welds

Use for

Situation Description
Base plate is connected to the beam.

Beam and column stiffeners are used.
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Situation Description
Beam cantilever is connected to a
column with a base plate.

Beam cantilever is connected to a
sloped column with a base plate.

Beam cantilever is connected to a
column with a base plate.

Beam stiffeners are used.
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Situation Description
Beam cantilever is connected to the
column with a base plate.

Beam and column stiffener are used.

Before you start

Create a beam and a column.

Selection order

1. Select the main part (beam).

2. Select the secondary part (column).

The connection is created automatically.

Part identification key

 Part
1 Beam stiffener
2 Stiffeners 1, 2, 4, 5
3 Base plate
4 Stiffeners 3, 6, 7, 8
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Picture tab
Use the Picture tab to control the stiffener chamfering and the base plate
chamfers.

Stiffener chamfering

 Description
1 Top chamfer width for stiffeners 1, 2, 4, 5.
2 Top chamfer height for stiffeners 1, 2, 4, 5.
3 Bottom chamfer height for stiffeners 1, 2, 4, 5.
4 Bottom chamfer width for stiffeners 1, 2, 4, 5.
5 Top chamfer width for stiffeners 3, 6, 7, 8.
6 Top chamfer height for stiffeners 3, 6, 7, 8.
7 Bottom chamfer height for stiffeners 3, 6, 7, 8.
8 Bottom chamfer width for stiffeners 3, 6, 7, 8.
9 Weld gap.
10 Gap between the beam stiffeners and the beam top and bottom

flange.

Base plate chamfering

 Description
1 Width of base plate chamfer 1.
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 Description
2 Height of base plate chamfer 1.
3 Height of base plate chamfer 2.
4 Width of base plate chamfer 2.
5 Width of base plate chamfer 3.
6 Height of base plate chamfer 3.
7 Height of base plate chamfer 4.
8 Width of base plate chamfer 4.

Parts tab
Use the Parts tab to control the dimensions of the base plate, stiffeners, and
beam stiffener.

Plate

Option Description Default
Plate Base plate thickness,

width and height.
Thickness = 20 mm
Width depends on the
column profile.

Height depends on the
column profile.

The default name is
BASEPLATE.

Stiffeners 1,2,4,5 Stiffener 1, 2, 4, 5
thickness, width and
height.

Stiffeners 3, 6 Stiffener 3, 6 thickness,
width and height.

Stiffeners 7,8 Stiffener 7, 8 thickness,
width and height.

Beam Stiff Beam stiffener
thickness, width and
height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Parameters tab
Use the Parameters tab to control the square cut corners, plate offset and
bolt properties.

Plate properties

Option Description
Square cut corners (1-4) Cuts made on the corners of the base

plate.

If you enter a number corresponding
to one of the corners of the base
plate, the corner has a square cut
instead of a diagonal chamfer. You
can enter the numbers for one or all
the corners.

Plate aligned with Define whether the plate is aligned
with the column or the connection
symbol.
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Base plate offset

 Description
1 Base plate horizontal offset from the column center.
2 Base plate vertical offset from the column center.

Base plate with holes or bolts

Option Description
Default

Bolts are created.

AutoDefaults can change this option.
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Option Description
Bolts are created.

Holes are created.

Bolt group rotation

You can define the bolt group rotation around its center. To rotate the bolt
group, enter the rotation angle (in degrees).

Positive angle rotates the bolts in a counter-clockwise direction and negative
angle in a clockwise direction.

 Description
1 Bolt group rotation angle.
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Bolt properties

Option Description
Eliminate bolt numbers Define which bolts are deleted from

the bolt group.

Enter the bolt numbers of the bolts to
be deleted and separate the numbers
with a space. Bolt numbers run from
left to right and from top to down.

Eliminate external bolts Define whether external bolts are
deleted.

Using additional components

You can use additional system or custom components to modify the column
end or the base plate. For example, you can create special backing plates, weld
preparations, and weld access holes for the column end.

If you use additional system or custom components, you need to manage the
column end or the base plate properties in the additional component in
question. When using several components, there may be multiple welds and
cuts.

Option Description
Component Select a system or a custom

component from the Applications &
components catalog.

Attributes Select an attribute file for the
component.

Input Define to which parts the selected
component is applied.

• Default is same as Base +
Column.

• Column sets the column as the
main part. Use this option for
details.

• Column + Base sets the column
as the main part and the base
plate as the secondary part.
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Option Description
• Base + Column sets the base

plate as the main part and the
column as the secondary part.

• Base sets the base plate as the
main part.

Stiffeners tab
Use the Stiffeners tab to control stiffener positions and offsets.

Stiffener positions (1-8)

Option Description
Stiffener Positions (1-8) Placement of the stiffeners.

Only the stiffeners whose numbers
are entered in the field are attached
to the column.

Stiffener offset

Stiffener offset allows the stiffeners to be moved. Enter a negative value to
move the stiffener in the opposite direction.

 Description
1 Stiffener 1 offset.
2 Stiffener 2 offset.
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 Description
3 Stiffener 3 offset.
4 Stiffener 4 offset.
5 Stiffener 5 offset.
6 Stiffener 6 offset.
7 Stiffener 7 offset.
8 Stiffener 8 offset.

Beam Stiff tab
Use the Beam Stiff tab to control the beam stiffener alignment, stiffener side,
chamfer dimensions and types.

Left stiffener

Option Description
Default

Left stiffeners are created.

AutoDefaults can change this option.

Left stiffeners are created.

Left stiffeners are not created.
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Center stiffener

Option Description
Default

Center stiffeners are created.

AutoDefaults can change this option.

Center stiffeners are created.

Center stiffeners are not created.

Right stiffener

Option Description
Default

Right stiffeners are created.

AutoDefaults can change this option.
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Option Description
Right stiffeners are created.

Right stiffeners are not created.

Stiffener alignment

Options Description
Default

Stiffeners are aligned with the beam.

AutoDefaults can change this option.

Stiffeners are aligned with the beam.
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Options Description
Stiffeners are aligned with the
column.

Stiffener creation

Option Description
Default

Stiffeners are created on both sides.

AutoDefaults can change this option.

Stiffeners are created on both sides.

Stiffeners are created on far side.
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Option Description
Stiffeners are created on near side.

Stiffeners are not created.

Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.
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Top and bottom chamfer type

Option for top chamfer Option for bottom
chamfer

Description

Default

No chamfer

AutoDefaults can change
this option.
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Stiffener offset

Stiffeners can be moved from the center of the beam horizontally or vertically.
Enter a negative value to move the stiffeners in the opposite direction.
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 Description
1 Left stiffener vertical offset.
2 Center stiffener vertical offset.
3 Right stiffener vertical offset.
4 Left stiffener horizontal offset.
5 Center stiffener horizontal offset.
6 Right stiffener horizontal offset.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions
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 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.

• Middle: From the center line of the secondary part to the center
line of the bolts.
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 Description
• Right: From the right edge of the secondary part to the rightmost

bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Dimension for vertical bolt group position.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

General tab
Click the link below to find out more:

General tab
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Design tab
Click the link below to find out more:

Design tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:

Round joining plates (124)
Round joining plates (124) connects two beams or two columns with bolted
base plates. Stiffeners can also be created.

Objects created

• Base plates

• Stiffeners

• Bolts

• Welds

Use for

Situation Description
Round end plates connecting two
beams. Stiffeners are created.

Selection order

1. Select the main part.

2. Select the secondary part.

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Description
1 Base plate
2 Tube stiffener

Picture tab

Joining plates

Parts tab
Use the Parts tab to control the base plate and stiffener properties.

Parts

Option Description
Base plate Thickness and width of the base

plate.
Tube stiffeners 1, Tube stiffeners 2 Thickness, width and height of the

tube stiffeners.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Parameters tab
Use the Parameters tab to control the shape and position of the base plate,
the number of stiffeners, and the chamfer dimensions.

Stiffeners

Option Description
Quantity of stiffeners Define how many stiffeners are

created.
Define the stiffener chamfer
dimensions:

1. Chamfers the stiffener corner
where it meets only the column.

2. Chamfers the stiffener corner at
the outer edge of the base plate.

3. Chamfers the stiffener corner at
the intersection of the column
and the base plate.

Steel components 1941 Base plates



Option Description
Define the weld gap between the
parts and the base plates.

Base plate shape

Option Description
Round base plate

Square base plate

Plate type

Select the plate type.
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Base plate direction

Option Description
Creates the base plates perpendicular
to the main part.

Creates the base plates perpendicular
to the secondary part.

Creates the base plates at an angle
which bisects the angle of the main
and secondary parts.

Creates the base plates parallel with
the connection symbol.

Overlap

 Description
1 Distance between the part flange and the plate flange.
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Using additional components

You can use additional system or custom components to modify the column
end or the base plate. For example, you can create special backing plates, weld
preparations, and weld access holes for the column end.

If you use additional system or custom components, you need to manage the
column end or the base plate properties in the additional component in
question. When using several components, there may be multiple welds and
cuts.

Option Description
Component Select a system or a custom

component from the Applications &
components catalog.

Attributes Select an attribute file for the
component.

Input Define to which parts the selected
component is applied.

• Default is the same as Base +
Column.

• Column sets the column as the
main part. Use this option for
details.

• Column + Base sets the column
as the main part and the base
plate as the secondary part.

• Base + Column sets the base
plate as the main part and the
column as the secondary part.

• Base sets the base plate as the
main part.

Bolts tab
Use the Bolts tab to control the bolt properties, the diameter of the inner
plate, and the bolt angle.

Steel components 1944 Base plates



 Description Default
1 Diameter of the bolt circle  
2 Base plate 1 inner diameter

Creates a centered hole in base plate 1

Main part
diameter plus
tolerance

3 Base plate 2 inner diameter

Creates a centered hole in base plate 2

Secondary part
diameter plus
tolerance

4 Bolt angle (in degrees)  

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Base plate (1004)
Base plate (1004) creates a base plate that is connected to a column end.
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Objects created

• Base plate

• Shim plates (optional)

• Leveling plate (optional)

• Grout (optional)

• Shear key (optional)

• Extra plates connecting the anchor rods

• Anchor rods

• Bolts

• Additional component (optional)

• Welds

Use for

Situation Description
Simple base plate detail

Base plate detail with a shear key

Base plate detail with

• Straight anchor rods

• Extra plates connecting the
anchors
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Situation Description
Base plate detail with

• Anchor rods with hooks

• Leveling plate below the base
plate

• Grout and hole for grouting

• Cast plate

Before you start

Create a column.

Selection order

1. Select the main part (column).

2. Pick a position.

The detail is created automatically.

Part identification key

 Part
1 Base plate
2 Shim plate
3 Leveling plate
4 Grout
5 Cast plate
6 Shear key
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 Part
7 Anchor rod
8 Extra plate 1
9 Extra plate 2

Example: Add a base plate and anchor rods using Base plate (1004)
In this example, you will add a base plate detail and anchor rods to a column.

1. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

2. Enter base plate in the search box. 

To view the thumbnail images of the components in the search results

click .

3. Select Base plate (1004).

4. Select the column.

5. Pick a position at the base of the column. 

Tekla Structures automatically adds the base plate when you pick the
position.

6. Next, modify the anchor rod dimensions.

a. Switch on the Select components switch  to more easily select
components.

b. Double-click the component symbol in the model to open the Base
plate (1004) component dialog box.

c. Go to the Anchor rods tab.

d. Change the dimensions of the anchor rods.

e. To change only this base plate, select ignore other types from the list
in the top part of the dialog box. 

f. Click Modify. 
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Picture tab
Use the Picture tab to control the position of the base plate and the length
and position of the shear key.

Dimensions

 Description
1 Distance from the flange to the edge of the base plate.

Enter a negative value to make the base plate larger.
2 Weld gap.
3 Height of the shear key.
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Shear key offset

 Description
1 Shear key vertical offset from the column center.
2 Shear key horizontal offset from the column center.

Parts tab
Use the Parts tab to control the dimensions of the base plate, shear key,
leveling plate, and shim plates.

Plate

Option Description Default
Plate Base plate thickness. thickness = 0.5*bolt

diameter rounded up
to the next plate
thickness
The default name is
BASEPLATE.

Leveling Plate Leveling plate thickness,
width and height.

thickness = 1/4

Leveling plate hole
diameter

Leveling plate hole
diameter.

Leveling plate hole
tolerance

Leveling plate hole
tolerance.
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Option Description Default
Fitting plate Shim plate thickness,

width and height.

Define up to three
different shim plates.

 

Number of fitting pl. Number of shim plates
for each thickness.

1

Additional beam Shear key profile by
selecting it from the
profile catalog.

HEA 300 (in Default
environment)

Additional beam
rotation

Select the shear key
rotation type and define
the rotation angle.

 

Additional beam
welded to

Define to which plate
the shear key is welded.

 

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Bolt edge distances in shim plate

Define the bolt edge distances for shim plates. When these fields are empty,
shim plates are of the same size as the base plate.
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 Description Default
1 Horizontal bolt edge distance in the shim

plate.
30 mm

2 Vertical bolt edge distance in the shim
plate.

30 mm

Shim plate shape

Option Description
Default

Holes are based on the bolt group of
the connection.

AutoDefaults can change this option.

Holes are based on the bolt group of
the connection.

Finger shim plate with horizontal
slots.

The plate can be installed from the
right or the left side of the
connection.

Finger shim plate with vertical slots.

The plate can be installed from the
top of the connection.
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Option Description
Two separate finger shim plates with
horizontal slots.

Two separate finger shim plates with
vertical slots.

Tolerance

Define the tolerance for the slots in finger shim plates. The width of the slot is
the bolt diameter + the tolerance.

Parameters tab
Use the Parameters tab to control the component and the grout hole.

Grout hole

Define whether a grout hole is created in the base plate. The hole is also
created in the leveling plate and shim plates, if they exist in the detail.

Option Description
Default

Grout hole is not created.

AutoDefaults can change this option.

Grout hole is not created.
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Option Description
Grout hole is created.

Two grout holes are created.

Grout hole dimensions

If the base plate has two grout holes, define the dimensions for both holes.

 Description
1 Location of the grout hole from the center of the column in the

direction of the web.
2 Grout hole diameter.
3 Location of the grout hole from the center of the column in the

direction of the flange.

Gap size

Define the limit value for the gap between the base plate and the column. Use
this when the column is slightly inclined.

If the actual gap is smaller than this value, the end of the column is left
straight.

If the actual gap is larger than this value, the end of the column is fitted to the
base plate.
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Using additional components

You can use additional system or custom components to modify the column
end or the base plate. For example, you can create special backing plates, weld
preparations, and weld access holes for the column end.

If you use additional system or custom components, you need to manage the
column end or the base plate properties in the additional component in
question. When using several components, there may be multiple welds and
cuts.

Option Description
Component Select a system or a custom

component from the Applications &
components catalog.

Attributes Select an attribute file for the
component.

Input Define to which parts the selected
component is applied.

• Default is same as Base +
Column.

• Column sets the column as the
main part. Use this option for
details.

• Column + Base sets the column
as the main part and the base
plate as the secondary part.

• Base + Column sets the base
plate as the main part and the
column as the secondary part.

• Base sets the base plate as the
main part.
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Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the center

line of the bolts.

• Right: From the right edge of the secondary part to the rightmost
bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Dimension for vertical bolt group position.
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 Description
7 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.
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 Description
8 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from
top to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.

Bolt comment

You can define a bolt comment.

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Anchor rods tab
Use the Anchor rods tab to control the creation of different types of anchor
rods.
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Anchor rod dimensions

Option Description
Rod profile Anchor rod profile.

You can add a comment about the
part.

Nut profile Nut profile.
Washer profile Washer profile.
Plate washer Plate washer thickness, width and

height.
Cast plate Cast plate thickness, width and

height.
Grout Grout thickness.

Grouting helps you to model columns
to the top of concrete parts and place
the base plate correctly. It also makes
it easier to dimension the detail in GA
drawings.

By default, no grouting is created.

Select whether the grouting is created
with or without slopes above or below
the detail creation point. This also
affects the shim plates.

Anchor rod part properties

Option Description Default
Pos_no Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Class Part class number.
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Option Description Default
Finish Describes how the part

surface has been
treated.

Comment Add a comment about
the part.

Base plate with

Select whether to create the base plate with bolts, anchor rods, or a custom
component.

By default, the base plate is created with Bolts.

Anchor rod dimensions

 Description Default
1 Size or the length of the nut. anchor rod diameter
2 Size or the thickness of the washer. half of nut size
3 Length of the anchor rod. 500 mm
4 Length of the anchor rod above the base

plate.
50 mm

5 Distance between the cast plate and the
base plate.

60 mm

6 Length of the upper thread. 0 mm
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Anchor rods types

Option Description
Default

Type 1

AutoDefaults can change
this option.

Type 1

a

Radius of the hook

b

Width of the hook

a = 2*anchor bar
diameter
b = 1/5 of anchor
bar length

a

Radius of the hook

b

Width of the hook

c

Height of the hook

c = same as width of
the hook

d

Length of the anchor rod
below the extra plate

e

Length of the lower
thread

d = 2*nut size
e = 4*nut size plus
thickness of extra
plate

a

U-shape anchor rod

Radius of the hook
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Hook direction

Option Description
Default

Type 1

AutoDefaults can change this option.
Type 1

Type 2

Type 3

Type 4

Bolting direction

NOTE You can define the bolting direction if you have created the base plate
with bolts.

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.

Bolting direction 1

Bolting direction 2
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Cast plate holes tolerance

Option Description Default
Cast plate holes
tolerance

Tolerance of the cast
plate holes.

same as bolt
tolerance

Washer hole tolerance

Option Description
Create hole in washer By default, a hole is not created in the

washer.

Tolerance of the washer hole.

Create

 Description
1 Create the nut profile.
2 Create the washer profile.
3 Create the washer plate.

Anchor rod assembly

Define which parts of the anchor rod are included in the anchor rod assembly.

You can weld the washer plates above and below the base plate.

Extra plates tab
Use the Extra plates tab to control the placement, rotation, and type of the
profiles (extra profile 1) created at the bottom of each anchor bar and the
profiles (extra profile 2) that connect rows of anchor bars.
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Part dimensions

Option Description Default
Extra profile 1 Define the first extra

profile by selecting it
from the profile catalog.

PL10*100

Extra profile 2 Define the second extra
profile by selecting it
from the profile catalog.

Part properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Edge distance of extra profile 1
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 Description Default
1 Edge distance of extra profile 1. 50 mm

Type and direction of extra profile 1

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2

Type 3
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Edge distance of extra profile 2

 Description Default
1 Distance of extra profile 2 from the axis of

the anchor bar.
Half of the nut
size or anchor bar
diameter

Extra profile 2 type

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2
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Option Description
Type 3

Type 4

Type 5

Type 6

Length of extra profile 2
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 Description Default
1 Length of extra profile 2 from the axis of

the anchor bar.
50 mm

Direction of extra profile 2

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2

Extra profile 1 properties

Option Description Default
Hole tolerance Hole tolerance of extra

profile 1.
Same as bolt
tolerance

Circular profile height Enter the height of a
circular extra profile 1.

 

Profile rotation Profile rotation of extra
profile 1.

Front
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Extra profile 2 rotation

Option Description Default
Extra profile 2 rotation Profile rotation of extra

profile 2.
Front

General tab
Click the link below to find out more:

General tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:

Stiffened base plate (1014)
Stiffened base plate (1014) creates a base plate that is connected to a
column end.

Objects created

• Base plate

• Stiffeners

• Shim plates (optional)

• Leveling plate (optional)

• Shear key (optional)

• Extra plates connecting the anchor rods

• Anchor rods

• Bolts

• Welds

• Additional component (optional)
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Use for

Situation Description
Base plate with stiffeners

Base plate with stiffeners on the
flange

Base plate with stiffeners on the
flange

Base plate with stiffeners on the
flange

Base plate with stiffeners on the
flange
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Situation Description
Base plate with stiffeners on the web

Before you start

Create a column.

Selection order

1. Select the main part (column).

2. Pick a position.

The detail is created automatically.

Part identification key

 Part
1 Base plate
2 Shim plate
3 Leveling plate
4 Shear key
5 Stiffener

Picture tab
Use the Picture tab to control the position of the base plate and the length
and position of the shear key.
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Dimensions

 Description Default
1 Distance from the flange to the edge of the

base plate.

Enter a negative value to make the base
plate larger.

2 Weld gap.
3 Height of the shear key. Equal to the column

width

Shear key offset

 Description
1 Distance of the stiffener from the edge of the column flange.
2 Shear key vertical offset from the column center.
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 Description
3 Shear key horizontal offset from the column center.

Parts tab
Use the Parts tab to control the dimensions of the base plate, web plates,
flange plates, shear key, leveling plate, and shim plates.

Plate

Option Description Default
Plate Base plate thickness. BASEPLATE
Web plates Web plate thickness. 10 mm
Flange plate 4 Flange plate thickness. 10 mm
Leveling plate Leveling plate thickness,

width and height.
Leveling plate hole
diameter

Leveling plate hole
diameter.

Fitting plate Shim plate thickness,
width and height.

Define up to three
different shim plates.

Number of fitting pl. Number of shim plates
for each thickness.

1

Additional beam Shear key profile by
selecting it from the
profile catalog.

HEA 300 (in Default
environment)

Additional beam
rotation

Select the shear key
rotation type and define
the rotation angle.

 

Horizontal plates Horizontal plate
thickness.

L profile, flange Profile for L profile,
flange by selecting it
from the profile catalog.

L profile, web Profile for L profile, web
by selecting it from the
profile catalog.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Bolt edge distances in shim plate

Define the bolt edge distances for shim plates. If you do not enter any
distance, the shim plates are of the same size as the base plate.

 Description Default
1 Horizontal bolt edge distance in the shim

plate.
30 mm

2 Vertical bolt edge distance in the shim
plate.

30 mm
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Shim plate shape

Option Description
Default

Holes are based on the bolt group of
the connection.

AutoDefaults can change this option.

Holes are based on the bolt group of
the connection.

Finger shim plate with horizontal
slots.

The plate can be installed from the
right or the left side of the
connection.

Finger shim plate with vertical slots.

The plate can be installed from the
top of the connection.

Two separate finger shim plates with
horizontal slots.

Two separate finger shim plates with
vertical slots.

Tolerance for slots

Define the tolerance for the slots in finger shim plates. The width of the slot is
the bolt diameter + the tolerance.
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Base plate mounting grooves

Option Description
Default

Mounting grooves are not created.

AutoDefaults can change this option.

Mounting grooves are not created.

Mounting grooves are created
horizontally.

Mounting grooves are created
vertically for the first and last row of
the bolts. For other rows of bolts, the
mounting grooves are created
horizontally.

Tolerance for mounting grooves

Define the tolerance for the mounting grooves in the base plates. The width of
the groove is the bolt diameter + the tolerance. If you do not enter a value, the
bolt tolerance value is used.

Parameters tab
Use the Parameters tab to control the component and the grout hole.

Grout hole

Define whether a grout hole is created in the base plate. The hole is also
created in the leveling plate and shim plates, if they exist in the detail.

Option Description
Default

Grout hole is not created.

AutoDefaults can change this option.
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Option Description
Grout hole is not created.

Grout hole is created.

Two grout holes are created.

Grout hole dimensions

 Description
1 Location of the grout hole from the center of the column in the

direction of the web.
2 Grout hole diameter.
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 Description
3 Location of the grout hole from the center of the column in the

direction of the flange.

Using additional components

You can use additional system or custom components to modify the column
end or the base plate. For example, you can create special backing plates, weld
preparations, and weld access holes for the column end.

If you use additional system or custom components, you need to manage the
column end or the base plate properties in the additional component in
question. When using several components, there may be multiple welds and
cuts.

Optioon Description
Component Select a system or a custom

component from the Applications &
components catalog.

Attributes Select an attribute file for the
component.

Input Define to which parts the selected
component is applied.

• Default is same as Base +
Column.

• Column sets the column as the
main part. Use this option for
details.

• Column + Base sets the column
as the main part and the base
plate as the secondary part.

• Base + Column sets the base
plate as the main part and the
column as the secondary part.

• Base sets the base plate as the
main part.

Bolts
Use the Bolts tab to control the bolt properties.
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Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the center line

of the bolts.

• Right: From the right edge of the secondary part to the rightmost
bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Dimension for vertical bolt group position.
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 Description
7 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.

• Middle: From the center line of the bolts to the center line of the
secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

Steel components 1984 Base plates



 Description
8 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Stiffeners
Use the Stiffeners tab to control the web plate stiffeners and the flange plate
stiffeners.
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Web plate stiffener dimensions

 Description Default
1 Height of the web plate stiffener. 200 mm
2 Bottom width of the web plate stiffener. 100 mm

Web plate stiffener chamfer dimensions

 Description
1 Top horizontal chamfer dimension.
2 Top vertical chamfer dimension.
3 Bottom horizontal chamfer dimension.
4 Bottom vertical chamfer dimension.

Web plate stiffener position

You can create stiffeners to different positions using the web plate stiffener
position options.

Option Description
Default

Type 2

AutoDefaults can change this option.
Type 1

Type 2
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Option Description
Type 3

Type 4

Type 5

Type 6

Type 7

Flange plate stiffener dimensions

 Description Default
1 Height of the flange plate stiffener. 200 mm
2 Bottom width of the flange plate stiffener. 100 mm

Flange plate stiffener chamfer dimensions

 Description
1 Top horizontal chamfer dimension.
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 Description
2 The top vertical chamfer dimension.
3 Bottom horizontal chamfer dimension.
4 Bottom vertical chamfer dimension.

Flange plate stiffener position

You can create stiffeners to different positions using the flange plate stiffener
position options.

Option Description
Default

Type 2

AutoDefaults can change this option.
Type 1

Type 2

Type 3

Type 4

Stiffener dimensions

If you have created the stiffeners using other than the default stiffener
position options, you can separately define the plate dimensions for different
positions.

 Description
1 Width of the stiffener.
2 Height of the stiffener.
3 Width of the stiffener.

Steel components 1989 Base plates



Stiffener plate width

If you have selected type 5 as the web plate stiffener position or type 4 as the
flange plate stiffener position, you can define the stiffener width.

 Description Default
1 Width of the stiffener. 200 mm

Stiffener chamfer dimensions

 Description
1 Horizontal chamfer dimension.
2 Vertical chamfer dimension.

Anchor rods tab
Use the Anchor rods tab to control the creation of different types of anchor
rods.

Anchor rod dimensions

Option Description
Rod profile Anchor rod profile.

You can add a comment about the
part.

Nut profile Nut profile.
Washer profile Washer profile.
Plate washer Plate washer thickness, width and

height.
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Option Description
Cast plate Cast plate thickness, width and

height.
Grout Grout thickness.

Grouting helps you to model columns
to the top of concrete parts and place
the base plate correctly. It also makes
it easier to dimension the detail in GA
drawings.

By default, no grouting is created.

Select whether the grouting is created
with or without slopes above or below
the detail creation point. This also
affects the shim plates.

Anchor rod part properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Base plate with

Select whether to create the base plate with bolts, anchor rods, or a custom
component.

By default, the base plate is created with Bolts.
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Anchor rod dimensions

 Description Default
1 Size or the length of the nut. anchor rod diameter
2 Size or the thickness of the washer. half of nut size
3 Length of the anchor rod. 500 mm
4 Length of the anchor rod above the

base plate.
50 mm

5 Distance between the cast plate and
the base plate.

60 mm

6 Length of the upper thread. 0 mm

Anchor rods types

Option Description  
Default

Type 1

AutoDefaults can
change this option.

 

Type 1  

a

Radius of the hook

b

Width of the hook

a = 2*anchor bar
diameter
b = 1/5 of anchor bar
length
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Option Description  
a

Radius of the hook

b

Width of the hook

c

Height of the hook

c = same as width of
the hook

d

Length of the anchor
rod below the extra
plate

e

Length of the lower
thread

d = 2*nut size
e = 4*nut size plus
thickness of extra
plate

Hook direction

Option Description
Default

Type 1

AutoDefaults can change this option.
Type 1

Type 2

Type 3

Type 4

Bolting direction

NOTE You can define the bolting direction if you have created the base plate
with bolts.
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Option Description
Default

Bolting direction 1

AutoDefaults can change this option.

Bolting direction 1

Bolting direction 2

Cast plate holes tolerance

Option Description Default
Cast plate holes
tolerance

Tolerance of the cast
plate holes.

same as bolt
tolerance

Washer hole tolerance

Option Description
Create hole in washer By default, a hole is not created in the

washer.

Tolerance of the washer hole.

Create assembly from all anchors

Define whether anchors are included in an anchor rod assembly. You can also
include leveling plates into the assembly.

Create
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 Description
1 Create the nut profile.

You can select to create two nuts at the top of the anchor
rods.

2 Create the washer profile.
3 Create the washer plate.

Anchor rod assembly

Define which parts of the anchor rod are included in the anchor rod assembly.

You can weld the washer plates above and below the base plate.

Extra plates tab
Use the Extra plates tab to control the placement, rotation, and type of the
profiles (extra profile 1) created at the bottom of each anchor bar and the
profiles (extra profile 2) that connect rows of anchor bars.

Part dimensions

Option Description Default
Extra profile 1 First extra profile by

selecting it from the
profile catalog.

PL10*100

Extra profile 2 Second extra profile by
selecting it from the
profile catalog.

Part properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Name Name that is shown in

drawings and reports.
 

Finish Describes how the part
surface has been
treated.

 

Edge distance of extra profile 1

 Description Default
1 Edge distance of extra profile 1. 50 mm

Type and direction of extra profile 1

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Steel components 1996 Base plates



Option Description
Type 2

Type 3

Edge distance of extra profile 2

 Description Default
1 Distance of extra profile 2 from the axis of

the anchor bar.
Half of the nut
size or anchor bar
diameter

Extra profile 2 type

Option Description
Default

Type 1

AutoDefaults can change this option.
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Option Description
Type 1

Type 2

Type 3

Type 4

Type 5
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Option Description
Type 6

Length of extra profile 2

 Description Default
1 Length of extra profile 2 from the axis of

the anchor bar.
50 mm

Direction of extra profile 2

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1
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Option Description
Type 2

Extra profile 1 properties

Option Description Default
Hole tolerance Hole tolerance of extra

profile 1.
Same as bolt
tolerance

Circular profile height Height of circular extra
profile 1.

 

Profile rotation Profile rotation of extra
profile 1.

Front

Extra profile 2 rotation

Option Description Default
Extra profile 2 rotation Profile rotation of extra

profile 2.
Front

General tab
Click the link below to find out more:

General tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:
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Web stiffened base plate (1016)
Web stiffened base plate (1016) creates a base plate with vertical, horizontal,
and sloping web stiffeners.

Objects created

• Base plate

• Stiffeners

• Shim plates (optional)

• Leveling plate (optional)

• Shear key (optional)

• Extra plates connecting the anchor rods

• Anchor rods

• Bolts

• Welds

• Additional component (optional)

Use for

Situation Description
Web
stiffened
base plate
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Situation Description
Web
stiffened
base plate
with a
leveling
plate, a
shim plate,
horizontal
stiffener
and a shear
key

Before you start

Create a column or a beam.

Selection order

1. Select the main part (column or beam).

2. Pick a position.

The detail is created automatically.

Part identification key
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 Part
1 Base plate
2 Shim plate
3 Leveling plate
4 Shear key
5 Upper horizontal stiffener
6 Upper flange stiffener
7 Lower flange stiffener

Picture tab
Use the Picture tab to control the position of the base plate and the shear key
offset.

Dimensions

 Description
1 Distance from the flange to the edge of the base plate.
2 Weld gap.
3 Height of the shear key.
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Shear key offset

 Description
1 Shear key vertical offset from the main part center.
2 Shear key horizontal offset from the main part center.

Parts tab
Use the Parts tab to control the dimensions of the base plate, upper and
lower flange stiffener, shear key, leveling plate, upper horizontal stiffener, and
shim plates.

Plate

 Description Default
Plate Base plate thickness.

The dimensions on the
Picture and Bolts tab
determine the base
plate width and length.

 

Upper fl. stiffener Upper flange stiffener
thickness, width and
height.

Thickness = thickness
of the main part
flange
Height = determined
by the size of the
main part
Width = inner side
flange distance
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 Description Default
Lower fl. stiffener Lower flange stiffener

thickness, width and
height.

Thickness = thickness
of the main part
flange
Height = determined
by the size of the
main part
Width = inner side
flange distance

Additional beam Select the shear key
profile from the profile
catalog.

 

Additional beam
rotation

Select the shear key
rotation type and define
the rotation angle.

 

Additional beam
welded to

Define to which plate the
shear key is welded.

 

Leveling plate Leveling plate thickness,
width and height.

 

Leveling plate hole
diameter

Leveling plate hole
diameter.

 

Upper horizontal stiff Upper horizontal
stiffener thickness, width
and height.

Thickness = 0 mm

Fitting plate Shim plate thickness,
width and height.

Define up to three
different shim plates.

 

Number of fitting pl. Number of shim plates
for each thickness.

1

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
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Option Description Default
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Parameters tab
Use the Parameters tab to control the component used inside Web stiffened
base plate (1016).

Using additional components

You can use additional system or custom components to modify the column
end or the base plate. For example, you can create special backing plates, weld
preparations, and weld access holes for the column end.

If you use additional system or custom components, you need to manage the
column end or the base plate properties in the additional component in
question. When using several components, there may be multiple welds and
cuts.

Part Description
Component Select a system or a custom

component from the Applications &
components catalog.

Attributes Select an attribute file for the
component.

Input Define to which parts the selected
component is applied.

• Default is same as Base +
Column.

• Column sets the column as the
main part. Use this option for
details.
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Part Description
• Column + Base sets the column

as the main part and the base
plate as the secondary part.

• Base + Column sets the base
plate as the main part and the
column as the secondary part.

• Base set the base plate as the
main part.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions
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 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.

• Middle: From the center line of the secondary part to the center line
of the bolts.
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 Description
• Right: From the right edge of the secondary part to the rightmost

bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Dimension for vertical bolt group position.
7 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest bolt.

8 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from top
to bottom.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.
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If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Stiffeners tab
Use the Stiffeners tab to control the stiffener angle, position and selection.
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Stiffener angle and position

 Description Default
1 Stiffener angle. 60 degrees
2 Height of the stiffener.  
3 Distance of the stiffener from the column

edge.
 

4 Gap between the upper horizontal stiffener
and the main part flange.

Stiffener plate dimension

 Description
1 Size of the chamfer.
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Stiffener selection 1

Option Description
Default

Stiffeners are sloped.

AutoDefaults can change this option.
Stiffeners are sloped.

Stiffeners are vertical.

Stiffener selection 2

Option Description
Default

Stiffeners are sloped.

AutoDefaults can change this option.
Stiffeners are sloped.

Flanges are cut and stiffeners are
created.

If you have selected the vertical
stiffeners, you cannot create sloped
stiffeners or cut flanges.

Anchor rods tab
Use the Anchor rods tab to control the creation of different types of anchor
rods.

Anchor rod dimensions

Option Description
Rod profile Anchor rod profile.
Nut profile Nut profile.
Washer profile Washer profile.
Plate washer Plate washer thickness, width and height.
Cast plate Cast plate thickness, width and height.
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Option Description
Grout Grout thickness.

Grouting helps you to model columns to the
top of concrete parts and place the base plate
correctly. It also makes it easier to dimension
the detail in GA drawings.

By default, no grouting is created.

Select whether the grouting is created with or
without slopes above or below the detail
creation point. This also affects the shim
plates.

Anchor rod part properties

Option Description Default
Pos_no Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Class Part class number.
Finish Describes how the part

surface has been
treated.

Comment Add a comment about
the part.

Base plate with

Select whether to create the base plate with bolts, anchor rods, or a custom
component.

By default, the base plate is created with Bolts.
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Anchor rod dimensions

 Description Default
1 Size or the length of the nut. anchor rod diameter
2 Size or the thickness of the washer. half of nut size
3 Length of the anchor rod. 500 mm
4 Length of the anchor rod above the base

plate.
50 mm

5 Distance between the cast plate and the
base plate.

60 mm

6 Length of the upper thread. 0 mm

Anchor rods types

Option Description
Default

Type 1

AutoDefaults can change
this option.

Type 1

a

Radius of the hook

b

Width of the hook

a = 2*anchor bar
diameter
b = 1/5 of anchor
bar length

Steel components 2016 Base plates



Option Description
a

Radius of the hook

b

Width of the hook

c

Height of the hook

c = same as width of
the hook

d

Length of the anchor rod
below the extra plate

e

Length of the lower
thread

d = 2*nut size
e = 4*nut size plus
thickness of extra
plate

Hook direction

Option Description
Default

Type 1

AutoDefaults can change this option.
Type 1

Type 2

Type 3

Type 4

Bolting direction

NOTE You can define the bolting direction if you have created the base plate
with bolts.

Steel components 2017 Base plates



Option Description
Default

Bolting direction 1

AutoDefaults can change this option.

Bolting direction 1

Bolting direction 2

Cast plate holes tolerance

Option Description Default
Cast plate holes
tolerance

Tolerance of the cast
plate holes.

same as bolt
tolerance

Washer hole tolerance

Option Description
Create hole in washer By default, a hole is not created in the

washer.

Tolerance of the washer hole.

Create assembly from all anchors

Define whether anchors are included in an anchor rod assembly. You can also
include leveling plates into the assembly.

Create

Steel components 2018 Base plates



 Description
1 Create the nut profile.
2 Create the washer profile.
3 Create the washer plate.

Anchor rod assembly

Define which parts of the anchor rod are included in the anchor rod assembly.

You can weld the washer plates above and below the base plate.

Extra plates tab
Use the Extra plates tab to control the placement, rotation, and type of the
profiles (extra profile 1) created at the bottom of each anchor bar and the
profiles (extra profile 2) that connect rows of anchor bars.

Part dimensions

Option Description Default
Extra profile 1 First extra profile by

selecting it from the
profile catalog.

PL10*100

Extra profile 2 Second extra profile by
selecting it from the
profile catalog.

Part properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Option Description Default
Finish Describes how the part

surface has been
treated.

 

Edge distance of extra profile 1

 Description Default
1 Edge distance of extra profile 1. 50 mm

Type and direction of extra profile 1

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1
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Option Description
Type 2

Type 3

Edge distance of extra profile 2

 Description Default
1 Distance of extra profile 2 from the axis of

the anchor bar.
Half of the nut
size or anchor bar
diameter

Extra profile 2 type

Option Description
Default

Type 1

AutoDefaults can change this option.
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Option Description
Type 1

Type 2

Type 3

Type 4

Type 5
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Option Description
Type 6

Length of extra profile 2

 Description Default
1 Length of extra profile 2 from the axis of

the anchor bar.
50 mm

Direction of extra profile2

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1
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Option Description
Type 2

Extra profile 1 properties

Option Description Default
Hole tolerance Hole tolerance of extra

profile 1.
Same as bolt
tolerance

Profile rotation Profile rotation of extra
profile 1.

Front

Extra profile 2 rotation

Option Description Default
Extra profile 2 rotation Profile rotation of extra

profile 2.
Front

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Simple base plate 2 (1031)
Simple base plate 2 (1031) creates a base plate that is connected to a column
or beam end.
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Objects created

• Base plate

• Stiffeners (for W profiles only)

• Shear key

• Leveling plate

• Welds

Use for

Situation Description
• Base plate created at column end

Selection order

1. Select the main part (column or beam).

2. Pick a position.

The detail is created automatically.

Part identification key

 Description
1 Base plate
2 Stiffeners
3 Shear key

Picture tab
Use the Picture tab to define the plate position and corner cuts.
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Dimensions

 Description
1 Base plate offset from the bottom edge of the column.
2 Distance from the component input point to the base plate

bottom.

You can offset the base plate from the point picked for creating
the component.

3 Shear key height

Base plate corner cut

 Description
1 Horizontal corner cut dimension.
2 Vertical corner cut dimension.

Parts tab
Use the Parts tab to define the plate properties.
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Parts

Option Description
Base plate Thickness, width, and height of the

base plate.
Stiffeners Thickness, width, and height of the

stiffeners.
Key profile Select the shear key profile from the

profile catalog.
Leveling plate Thickness of the leveling plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the base plate corner shape, condensation
holes, shear key creation, and leveling plate extra length.

Option Description
Plate wrap around Define whether the base plate is

automatically wrapped around the
column and bolts, bolts, or column.

• Around bolts and column
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Option Description
• Around bolts

• Around column

Condensation holes sides 1-4 Define where the condensation holes
are located by entering the corner
numbers.

Semi-circular holes are placed at the
bottom of columns and some circular
profiles.

Condensation holes diameter Define the diameter of the
condesation holes.

Base plate corner shape

 Description
1 Define which plate corners are reshaped.

You can enter the corner numbers in any order. Corners are not
reshaped if you do not enter any numbers.

2 Define the horizontal offset of the plate from the bolt center
line.

This offset works when Plate wrap around is set to Automatic.
3 Define the vertical offset of the plate from the bolt center line.

This offset works when Plate wrap around is set to Automatic.
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Shear key offset and rotation

 Description
1 Define the horizontal offset of the shear key.
2 Define the vertical offset of the shear key.
3 Define the rotation of the shear key around the column center

line.

Shear key creation

Option Description
Default

Shear key is not created.

AutoDefaults can change this option.

Shear key is created.

Shear key is not created.
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Leveling plate size

 Description
1 Define the leveling plate extra length.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions
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 Description
1 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line
of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

2 Dimension for vertical bolt group position.
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 Description
3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

5 Select how to measure the dimensions for horizontal bolt
group position.

• Left: From the left edge of the secondary part to the
leftmost bolt.

• Middle: From the center line of the secondary part to the
center line of the bolts.
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 Description
• Right: From the right edge of the secondary part to the

rightmost bolt.

6 Dimension for horizontal bolt group position.

Bolt group rotation

 Description
1 Define the bolt group rotation around the column center line,

measured from the column web.

Bolt deletion

Option Description
Edge tolerance for deleting bolts Define the minumum bolt edge

distance for deleting bolts. The
distance is measured from the bolt
center to the edge of the plate.

Eliminate bolts Define which bolts are deleted.

Enter the bolt numbers from the first
bolt in the first row to the last bolt in
the last row, for example, 1 3 10.
Enter A or a to delete all bolts.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Stiffeners tab
Use the Stiffeners tab to define the stiffener dimensions and chamfering.
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Stiffener offset

  
1 Stiffener offset from the base plate.
2 Stiffener offset from the column.

Stiffener positions

 Description
1 Stiffener position on the base plate edge.
2 Define on which sides the stiffeners are created.
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Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.

Line chamfer

Convex chamfer
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Option Description
Concave chamfer

No chamfer

Grouting holes tab
Use the Grouting holes tab to define the grout hole dimensions.

Grout holes

You can define whether to delete some or all of the grout holes in Elim holes.

Grout hole dimensions

 Description
1 Location of the grout hole from the center of the column in the

direction of the web.
2 Grout hole diameter.
3 Location of the grout hole from the center of the column in the

direction of the flange.
4 Number of grout holes
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 Description
5 Grout hole spacing

Use a space to separate the spacing values. Enter a value for
each space between holes. For example, if there are 3 bolts,
enter 2 values.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Base plate (1042)
Base plate (1042) creates a base plate that is connected to a column end.

Objects created

• Base plate

• Bolts

• Extra plates connecting the anchor rods

• Anchor rods

• Bolts

• Welds

• Additional component (optional)
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Use for

Situation Description
Column base detail

Column base plate at the face of the flange

Before you start

Create a column.

Selection order

1. Select the main part (column).

2. Pick a position.

The detail is created automatically.
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Part identification key

 Part
1 Base plate

Picture tab
Use the Picture tab to control the position of the base plate.
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Dimensions

 Description
1 Distance from the flange of the main part to the edge of the base plate.
2 Weld gap.

Parts tab
Use the Parts tab to control the dimensions of the base plate.

Plate

Option Description Default
Plate Thickness, width, and

height of the base plate.
Thickness = 30 mm
Width =500 mm
Heigh t =500 mm

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Parameters tab
Use the Parameters tab to control the weld dimensions, grout hole diameter
and position, plate type, design check and shear force value.

Design check

Option Description
Design Define whether design check is

turned on or off.
Bearing Define whether the detail and its

components bear the entered shear
force.

Factored Axial Dead Load (kN) Define the factored axial dead load, if
design check is turned on.

Minimum Fcu (N/mm^2) Define the minimum Fcu, if design
check is turned on.

Shear force
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 Description
1 Shear force value.

If the design check is turned on, enter a positive value. If there is no
shear force, enter 0.

Weld dimensions

 Description
1 Weld dimension on the column flange.
2 Weld dimension on the column web.

Weld types

Option Description
Default

Fully welded

AutoDefaults can change this option.
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Option Description
Fully welded

Partially welded

Grout hole diameter and offset

 Description
1 Grout hole horizontal offset from the column center.
2 Grout hole diameter.
3 Grout hole vertical offset from the column center.
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Base plate with grout hole

Option Description
Default

Grout hole is not created.

AutoDefaults can change this option.

Grout hole is not created.

Grout hole is created.

Base plate mounting grooves

Option Description
Default

Mounting grooves are not created.

AutoDefaults can change this option.
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Option Description
Mounting grooves are not created.

Mounting grooves are created
horizontally.

Mounting grooves are created
vertically for the first and last row of
the bolts. For other rows of bolts, the
mounting grooves are created
horizontally.

Tolerance for mounting grooves

Define the tolerance for the mounting grooves in the base plates. The width of
the groove is the bolt diameter + the tolerance. If you do not enter a value, the
bolt tolerance value is used.

Base plate with holes or bolts

Option Description
Default

Holes are created.

AutoDefaults can change this option.

Steel components 2047 Base plates



Option Description
Holes are created.

Bolts are created.

Using additional components

You can use additional system or custom components to modify the column
end or the base plate. For example, you can create special backing plates, weld
preparations, and weld access holes for the column end.

If you use additional system or custom components, you need to manage the
column end or the base plate properties in the additional component in
question. When using several components, there may be multiple welds and
cuts.

Option Description
Component Select a system or a custom

component from the Applications &
components catalog.

Steel components 2048 Base plates



Option Description
Attributes Select an attribute file for the

component.
Input Define to which parts the selected

component is applied.

• Default is same as Base +
Column.

• Column sets the column as the
main part. Use this option for
details.

• Column + Base sets the column
as the main part and the base
plate as the secondary part.

• Base + Column sets the base
plate as the main part and the
column as the secondary part.

• Base sets the base plate as the
main part.

Anchor rods tab
Use the Anchor rods tab to control the creation of different types of anchor
rods.

Anchor rod dimensions

Option Description
Rod profile Anchor rod profile.

You can add a comment about the
part.

Nut profile Nut profile.
Washer profile Washer profile.
Plate washer Plate washer thickness, width and

height.
Cast plate Cast plate thickness, width and

height.
Grout Grout thickness.

Grouting helps you to model columns
to the top of concrete parts and place
the base plate correctly. It also makes
it easier to dimension the detail in GA
drawings.
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Option Description
By default, no grouting is created.

Select whether the grouting is created
with or without slopes above or below
the detail creation point. This also
affects the shim plates.

Anchor rod part properties

Option Description Default
Pos_no Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Class Part class number.
Finish Describes how the part

surface has been
treated.

Comment Add a comment about
the part.

Base plate with

Select whether to create the base plate with bolts, anchor rods, or a custom
component.

By default, the base plate is created with Bolts.
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Anchor rod dimensions

 Description Default
1 Size or the length of the nut. anchor rod diameter
2 Size or the thickness of the washer. half of nut size
3 Length of the anchor rod. 500 mm
4 Length of the anchor rod above the base

plate.
50 mm

5 Distance between the cast plate and the
base plate.

60 mm

6 Length of the upper thread. 0 mm

Anchor rod types

Option Description  
Default

Type 1

AutoDefaults can change
this option.

 

Type 1  

a

Radius of the hook

b

Width of the hook

a = 2 x anchorbar
diameter
b = 1/5 of anchorbar
length
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Option Description  
a

Radius of the hook

b

Width of the hook

c

Height of the hook

c = same as width of
the hook

d

Length of the anchor rod
below the extra plate

e

Length of the lower
thread

d = 2 x nut size
e = 4 x nut size
plus thickness of
extra plate

Hook direction

Option Description
Default

Type 1

AutoDefaults can change this option.
Type 1

Type 2

Type 3

Type 4

Bolting direction

NOTE You can define the bolting direction if you have created the base plate
with bolts.
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Option Description
Default

Bolting direction 1

AutoDefaults can change this option.

Bolting direction 1

Bolting direction 2

Cast plate hole tolerance

Option Description Default
Cast plate holes
tolerance

Define the tolerance of
the cast plate holes.

same as bolt
tolerance

Washer hole tolerance

Option Description
Create hole in washer By default, a hole is not created in the

washer.

Tolerance of the washer hole.

Create assembly from all anchors

Define whether anchors are included in an anchor rod assembly. You can also
include leveling plates into the assembly.

Create
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 Description
1 Create the nut profile.

You can select to create two nuts at the top of the anchor rods.
2 Create the washer profile.
3 Create the washer plate.

Anchor rod assembly

Define which parts of the anchor rod are included in the anchor rod assembly.

You can weld the washer plates above and below the base plate.

Extra plates tab
Use the Extra plates tab to control the placement, rotation, and type of the
profiles (extra profile 1) created at the bottom of each anchor bar and the
profiles (extra profile 2) that connect rows of anchor bars.

Part dimensions

Option Description Default
Extra profile 1 First extra profile by

selecting it from the
profile catalog.

PL10 x 100

Extra profile 2 Second extra profile by
selecting it from the
profile catalog.

Part properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Option Description Default
Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Edge distance of extra profile 1

 Description Default
1 Edge distance of extra profile 1. 50 mm

Type and direction of extra profile 1

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1
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Option Description
Type 2

Type 3

Edge distance of extra profile 2

 Description Default
1 Distance of extra profile 2 from the axis of

the anchor bar.
Half of the nut
size or anchorbar
diameter

Extra profile 2 type

Option Description
Default

Type 1

AutoDefaults can change this option.
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Option Description
Type 1

Type 2

Type 3

Type 4

Type 5
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Option Description
Type 6

Length of extra profile 2

 Description Default
1 Length of extra profile 2 from the axis of

the anchor bar.
50 mm

Direction of extra profile 2

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1
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Option Description
Type 2

Extra profile 1 properties

Option Description Default
Hole tolerance Hole tolerance of extra

profile 1.
Same as bolt
tolerance

Circular profile height Enter the height of a
circular extra profile 1.

 

Profile rotation Profile rotation of extra
profile 1.

Front

Extra profile 2 rotation

Option Description Default
Extra profile 2 rotation Profile rotation of extra

profile 2.
Front

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions
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 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.

• Middle: From the center line of the secondary part to the center line
of the bolts.
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 Description
• Right: From the right edge of the secondary part to the rightmost

bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of the
part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each space
between bolts. For example, if there are 3 bolts, enter 2 values.

6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest bolt.

7 Dimension for vertical bolt group position.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.
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If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

General tab
Click the link below to find out more:

General tab
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Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:

U.S. Bearing plate (1044)
U.S. Bearing plate (1044) creates a bearing plate with web stiffeners for a
beam, and either bolts or welded studs.

Objects created

• Bearing plate

• Stiffeners

• Bolts

• Studs

• Anchor rods

• Welds

Use for

Situation Description
Bearing plate is bolted to a beam.
Stiffener is created.

Selection order

1. Select the beam.

2. Pick a position.

The connection is created when you pick the position.
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Part identification key

 Description
1 Bearing plate
2 Web stiffener
3 Bolts or welded studs

Picture tab
The Picture tab shows the bearing plate detail.

Plates tab
Use the Plates tab to define the plate dimensions and properties.

Part

Option Description
Bearing plate Thickness of the bearing plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Material Material grade. The default material is

defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Dimensions

 Description
1 Vertical dimension to shift the bearing plate.
2 Length of the bearing plate.

The length is calculated based on the size of the main part.
3 Horizontal dimension to shift the bearing plate.
4 Width of the bearing plate.

The width is calculated based on the size of the main part.

Bearing plate rotation

 Description
1 Bearing plate rotation in degrees, measured in the plane of the

plate.
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Bearing plate position

Option Description
Default

Sloped bearing plate is created.

AutoDefaults can change this option.
Sloped bearing plate is created.

Horizontal bearing plate is created.

Stiffeners tab
Use the Stiffeners tab to define the beam web stiffener positions and
properties.

Parts

Option Description
Stiffeners Thickness, width and height of the

stiffeners.

Stiffener offsets

 Description
1 Stiffener horizontal offset from the point picked on the bearing

plate.
2 Stiffener vertical offset from the beam web.
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Stiffener location

Option Description
Default

Stiffener is created and welded to
both sides of the beam.

AutoDefaults can change this option.
Stiffener is created and welded to
both sides of the beam.

Stiffener is created and welded to the
far side of the beam web.

Stiffener is created and welded to the
near side of the beam web.

Stiffeners are not created.

Vertical stiffener offset

 Description
1 Stiffener offset from the main part top flange.
2 Stiffener offset from the main part bottom flange.
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Stiffener chamfer dimensions

 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

Chamfer shape

Option Option Description
Default

No chamfer

AutoDefaults can change
this option.
No chamfer

Line chamfer

Convex chamfer

Concave chamfer
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Bolts tab
Use the Bolts tab to define the bolt group dimensions, and the bolt and stud
properties.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Stud basic properties

Option Description
Stud size Select the stud size.
Stud standard Stud standard to be used inside the

component.
Stud length Select the stud length.
Site/Workshop Location where the studs should be

attached.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
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Option Description Default
depend on the component in
question.

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Anchor rods tab
Use the Anchor rods tab to define whether bolts, studs, anchor rods, or
custom components are used, and their properties.

Create as

Select whether to create the bearing plate with bolts, studs, anchor rods, or a
custom component.

Option Description
Bolts Define the bolt group dimensions and

bolt properties on the Bolts tab.
Studs Define the stud properties on the

Bolts tab.
Anchors Select the anchor profile from the

profile catalog.
Custom component Select the component from the

component catalog, and define the
custom settings, up direction, and
rotation.

Steel components 2073 Base plates



Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Anchor bend direction

Option Description
Default

Anchors are bent in.

AutoDefaults can change this option.
Anchors are bent in.

Anchors are bent out.

Anchors are not bent. Studs are
created.

Bent anchor bolt length

 Description
1 Radius of the bend.
2 Bent anchor bolt length.
3 Hook length.
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Stud length

 Description
1 Define the stud length.

General tab

Click the link below to find out more:

General tab

Design type tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

U.S. Base plate (1047)
U.S. Base plate (1047) creates a base plate at the selected point on a column.

Objects created

• Base plate

• Stiffeners (can only be added if the column has a W, I, or a TS profile)

• Shim plates (optional)

• Leveling plate (optional)

• Shear key (optional)

• Extra plates connecting the anchor rods
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• Anchor rods

• Bolts

• Welds

• Additional component (optional)

Use for

Situation Descripti
on

Column
base
plate
with a
grout
hole.

Column
base
plate
with a
grout
hole and
a shear
key.
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Situation Descripti
on

Column
base
plate
with a
grout
hole, a
shear key
and
stiffeners
.

Offset
column
base
plate
with a
shear key
and a
grout
hole.
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Situation Descripti
on

Column
base
plate
with
holes and
chamfer.

Before you start

Create a column.

Selection order

1. Select the main part (column).

2. Pick a position.

The detail is created automatically.

Part identification key

 Part
1 Base plate
2 Stiffeners 1, 2, 4, 5
3 Stiffeners 3, 6, 7, 8

Picture tab
Use the Picture tab to control stiffener chamfering, base plate chamfers, and
the location and size of the grout hole.
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Stiffener chamfering

 Description
1 Top chamfer width for stiffeners 1, 2, 4, 5.
2 Top chamfer height for stiffeners 1, 2, 4, 5.
3 Bottom chamfer height for stiffeners 1, 2, 4, 5
4 Bottom chamfer width for stiffeners 1, 2, 4, 5.
5 Top chamfer width for stiffeners 3, 6, 7, 8.
6 Top chamfer height for stiffeners 3, 6, 7, 8.
7 Bottom chamfer height for stiffeners 3, 6, 7, 8.
8 Bottom chamfer width for stiffeners 3, 6, 7, 8,
9 Weld gap.
10 Select the chamfer type.

Base plate chamfering

 Description
1 Width of base plate chamfer 1.
2 Height of base plate chamfer 1.
3 Height of base plate chamfer 2.
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 Description
4 Width of base plate chamfer 2.
5 Width of base plate chamfer 3.
6 Height of base plate chamfer 3.
7 Height of base plate chamfer 4.
8 Width of base plate chamfer 4.
9 Grout hole horizontal distance from the column center.
10 Grout hole vertical distance from the column center.
11 Diameter of the grout hole.

Parts tab
Use the Parts tab to control the dimensions of the base plate, stiffeners,
leveling plate, and shim plates.

Plate

Option Description Default
Plate Base plate thickness,

width and height.

You can add a comment
about the part.

Thickness = 20 mm
Width depends on the
largest cross-sectional
dimension of the
column.

Height depends on the
largest cross-sectional
dimension of the
column.

Stiffeners 1,2,4,5 Stiffener 1, 2, 4, 5
thickness, width and
height.

Thickness depends on
the column flange
thickness.

Width depends on the
distance between the
edge of the plate and
the edge of the column.

Height = 1.75*width
Stiffeners 3,6,7,8 Stiffener 3, 6, 7, 8

thickness, width and
height.

Thickness depends on
the column flange
thickness.

Width depends on the
distance between the
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Option Description Default
edge of the plate and
the edge of the column.

Height = 1.75*width
Key profile Shear key profile by

selecting it from the
profile catalog.

 

Leveling plate Leveling plate thickness,
width, and height.

You can add a comment
about the part.

 

Fitting plate Shim plate thickness,
width and height.

Define up to three
different shim plates.

 

Number of fitting pl. Number of shim plates
for each thickness.

1

Leveling plate hole
diameter

Leveling plate hole
diameter.

 

Key profile welded to Define to which plate the
shear key is welded.

 

Option Description Default
Pos_no Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Class Part class number.
Finish Describes how the part

surface has been
treated.
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Option Description Default
Comment Add a comment about

the part.

Bolt edge distances in shim plate

Define the bolt edge distances for shim plates. When these fields are empty,
shim plates are of the same size as the base plate.

 Description Default
1 Horizontal bolt edge distance in the shim

plate.
30 mm

2 Vertical bolt edge distance in the shim plate. 30 mm

Shim plate shape

Option Description
Default

Holes are based on the bolt group of
the connection.

AutoDefaults can change this option.

Holes are based on the bolt group of
the connection.

Finger shim plate with horizontal
slots.

The plate can be installed from the
right or the left side of the
connection.
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Option Description
Finger shim plate with vertical slots.

The plate can be installed from the
top of the connection.

Two separate finger shim plates with
horizontal slots.

Two separate finger shim plates with
vertical slots.

Tolerance

Define the tolerance for the slots in finger shim plates. The width of the slot is
the bolt diameter + the tolerance.

Base plate mounting grooves

Option Description
Default

Mounting grooves are not created.

AutoDefaults can change this option.

Mounting grooves are not created.

Mounting grooves are created
horizontally.
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Option Description
Mounting grooves are created
vertically for the first and last row of
the bolts. For other rows of bolts, the
mounting grooves are created
horizontally.

Tolerance for mounting grooves

Define the tolerance for the mounting grooves in the base plates. The width of
the groove is the bolt diameter + the tolerance. If you do not enter a value, the
bolt tolerance value is used.

Parameters tab
Use the Parameters tab to control the plate properties and option, shear key
offset, rotation and length, bolt properties and rotation of the base plate.

Plate properties

Option Description
Square cut corners (1-4) Cuts made on the corners of the base

plate.

If you enter a number corresponding
to one of the corners of the base
plate, the corner has a square cut
instead of a diagonal chamfer. You
can enter the numbers for one or all
the corners.

Cut cast plate Define whether base plate corner
cuts are applied to the cast plate.

Select Yes to apply the cuts.

Bolt properties

Option Description
Eliminate bolt numbers Define which bolts are deleted from

the bolt group.

Enter the bolt numbers of the bolts to
be deleted and separate the numbers
with a space. Bolt numbers run from
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Option Description
left to right and from top to down. If
there are more than 10 bolts, enclose
the bolt numbers in quotes (for
example, to delete bolt numbers 13
and 15, enter "13" "15").

Eliminate external bolts Define whether external bolts are
deleted.

Base plate with holes or bolts

Option Description
Default

Holes are created.

AutoDefaults can change this option.

Holes are created.

Bolts are created.

Base plate offset

 Description
1 Base plate horizontal offset from the column center.

Enter a negative value to move the base plate in the opposite
direction
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 Description
2 Base plate vertical offset from the column center.

Enter a negative value to move the base plate in the opposite
direction

Shear key offset and rotation

 Description
1 Shear key vertical offset.

Enter a negative value to move the shear key in the opposite direction.
2 Shear key rotation angle (in degrees).

Positive angle rotates the shear key in a counter-clockwise direction
and negative angle in a clockwise direction.

3 Shear key horizontal offset.

Enter a negative value to move the shear key in the opposite direction.

Shear key length

 Description
1 Shear key length to attach the shear key to the base plate.

To attach a shear key to the base plate, define the shear key length
and the key profile on the Parts tab.

Steel components 2086 Base plates



Bolt group rotation

You can define the bolt group rotation around its center. To rotate the bolt
group, enter the rotation angle (in degrees).

Positive angle rotates the bolts in a counter-clockwise direction and negative
angle in a clockwise direction.

 Description
1 Bolt group rotation angle.

Using additional components

You can use additional system or custom components to modify the column
end or the base plate. For example, you can create special backing plates, weld
preparations, and weld access holes for the column end.

If you use additional system or custom components, you need to manage the
column end or the base plate properties in the additional component in
question. When using several components, there may be multiple welds and
cuts.

Option Description
Component Define a system or a custom

component by selecting it from the
component catalog.

Attributes Enter the name of the attribute file
for the selected component.

Input Define to which parts the selected
component is applied.

• Default is same as Base +
Column.
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Option Description
• Column sets the column as the

main part. Use this option for
details.

• Column + Base sets the column
as the main part and the base
plate as the secondary part.

• Base + Column sets the base
plate as the main part and the
column as the secondary part.

• Base sets the base plate as the
main part.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt group dimensions
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 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost bolt.

• Middle: From the center line of the secondary part to the center line
of the bolts.
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 Description
• Right: From the right edge of the secondary part to the rightmost

bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

6 Select how to measure the dimensions for vertical bolt group position.

• Top: From the upper edge of the secondary part to the uppermost
bolt.
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 Description
• Middle: From the center line of the bolts to the center line of the

secondary part.

• Below: From the lower edge of the secondary part to the lowest
bolt.

7 Dimension for vertical bolt group position.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.
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If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Stiffeners tab
Use the Stiffeners tab to control stiffener positions and offsets.
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Stiffener positions (1-8)

Option Description
Stiffener Positions (1-8) Placement of the stiffeners.

Only the stiffeners whose numbers
are entered in the field are attached
to the column.

Stiffener offset

Stiffener offset allows the stiffeners to be moved. Enter a negative value to
move the stiffener in the opposite direction.

 Description
1 Stiffener 1 offset.
2 Stiffener 2 offset.
3 Stiffener 3 offset.
4 Stiffener 4 offset.
5 Stiffener 5 offset.
6 Stiffener 6 offset.
7 Stiffener 7 offset.
8 Stiffener 8 offset.
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Anchor rods tab
Use the Anchor rods tab to control the creation of different types of anchor
rods.

Anchor rod dimensions

Option Description
Rod profile Anchor rod profile.

You can add a comment about the
part.

Nut profile Nut profile.
Washer profile Washer profile.
Plate washer Plate washer thickness, width and

height.
Cast plate Cast plate thickness, width and

height.
Grout Grout thickness.

Grouting helps you to model columns
to the top of concrete parts and place
the base plate correctly. It also makes
it easier to dimension the detail in GA
drawings.

By default, no grouting is created.

Select whether the grouting is created
with or without slopes above or below
the detail creation point. This also
affects the shim plates.

Anchor rod part properties

Option Description Default
Pos_no Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Class Part class number.
Finish Describes how the part

surface has been
treated.

Comment Add a comment about
the part.

Base plate with

Select whether to create the base plate with bolts, anchor rods, or a custom
component.

By default, the base plate is created with Bolts.

Anchor rod dimensions

 Description Default
1 Size or the length of the nut. anchor rod diameter
2 Size or the thickness of the washer. half of nut size
3 Length of the anchor rod. 500 mm
4 Length of the anchor rod above the base

plate.
50 mm

5 Distance between the cast plate and the
base plate.

60 mm

6 Length of the upper thread. 0 mm
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Anchor rod types

Option Description  
Default

Type 1

AutoDefaults can change
this option.

 

Type 1  

a

Radius of the hook

b

Width of the hook

a = 2*anchor bar
diameter
b = 1/5 of anchor
bar length

a

Radius of the hook

b

Width of the hook

c

Height of the hook

c = same as width of
the hook

d

Length of the anchor rod
below the extra plate

e

Length of the lower
thread

d = 2*nut size
e = 4*nut size plus
thickness of extra
plate

Hook direction

Option Description
Default

Type 1

AutoDefaults can change this option.
Type 1
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Option Description
Type 2

Type 3

Type 4

Bolting direction

NOTE You can define the bolting direction if you have created the base plate
with bolts.

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.

Bolting direction 1

Bolting direction 2

Cast plate hole tolerance

Option Description Default
Cast plate holes
tolerance

Tolerance of the cast
plate holes.

same as bolt
tolerance

Washer hole tolerance

Field Description
Create hole in washer By default, a hole is not created in the

washer.

Tolerance of the washer hole.
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Create assembly from all anchors

Define whether anchors are included in an anchor rod assembly. You can also
include leveling plates into the assembly.

Create

 Description
1 Create the nut profile.

You can select to create two nuts at the top of the anchor rods.
2 Create the washer profile.
3 Create the washer plate.

Anchor rod assembly

Define which parts of the anchor rod are included in the anchor rod assembly.

You can weld the washer plates above and below the base plate.

Extra plates tab
Use the Extra plates tab to control the placement, rotation, and type of the
profiles (extra profile 1) created at the bottom of each anchor bar and the
profiles (extra profile 2) that connect rows of anchor bars.

Part dimensions

Option Description Default
Extra profile 1 Define the first extra

profile by selecting it
from the profile catalog.

PL10*100

Extra profile 2 Define the second extra
profile by selecting it
from the profile catalog.
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Part properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Edge distance of extra profile 1

 Description Default
1 Edge distance of extra profile 1. 50 mm
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Type and direction of extra profile 1

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2

Type 3
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Edge distance of extra profile 2

 Description Default
1 Distance of extra profile 2 from the axis of

the anchor bar.
Half of the nut
size or anchor bar
diameter

Extra profile 2 type

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2
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Option Description
Type 3

Type 4

Type 5

Type 6

Length of extra profile 2
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 Description Default
1 Length of extra profile 2 from the axis of

the anchor bar.
50 mm

Direction of extra profile2

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2

Extra profile 1 properties

Option Description Default
Hole tolerance Hole tolerance of extra

profile 1.
Same as bolt
tolerance

Circular profile height Enter the height of a
circular extra profile 1.

 

Profile rotation Profile rotation of extra
profile 1.

Front
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Extra profile 2 rotation

Option Description Default
Extra profile 2 rotation Profile rotation of extra

profile 2.
Front

General tab
Click the link below to find out more:

General tab

Analysis tab
Click the link below to find out more:

Analysis tab

Welds
Click the link below to find out more:

Create welds

Circular base plates (1052)
Circular base plates (1052) creates a base plate that is connected to a circular
column.

Objects created

• Circular base plate

• Tube stiffeners

• Extra plates connecting the anchor rods

• Anchor rods

• Bolts

• Welds

• Additional component (optional)
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Use for

Situation Descript
ion

Circular
base
plate

Circular
base
plate

Square
base
plate

Before you start

Create a circular column.

Steel components 2106 Base plates



Selection order

1. Select the main part (column).

2. Pick a position.

The detail is created automatically.

Part identification key

 Part
1 Stiffener
2 Base plate

Picture tab
Use the Picture tab to control the geometry of Circular base plates (1052).

Dimensions
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 Description Default
1 Width of the top part of the tube stiffener. 20 mm
2 Weld gap. 0 mm
3 Height of the end part of the tube stiffener. 30 mm

Parts tab
Use the Parts tab to control the dimensions of the circular base plate and the
tube stiffeners.

Plate

Option Description Default
Circular base plate Circular base plate

thickness and width.
Thickness = 30 mm
Width depends on the
tube diameter.

Tube stiffeners Tube stiffener thickness,
width and height.

Thickness = 10 mm
Height = 200 mm

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Parameters tab
Use the Parameters tab to control the shape of the base plate, diameter of
the inner plate, bolt angle, the overlap, and chamfer dimension.
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Base plate shape

Option Description
Default

Round base plate

AutoDefaults can change this option.

Round base plate

Square base plate
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Inner plate diameter and bolt angle

 Description
1 Base plate inner diameter.
2 Bolt angle (in degrees).

Cast plate shape

Option Description
Default

Square cast plate

AutoDefaults can change this option.

Square cast plate
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Option Description
Round cast plate

Base plate position

Option Description
Default

Base plate is perpendicular to the
column.

AutoDefaults can change this option.

Base plate is perpendicular to the
column.

Base plate is not perpendicular to the
column.
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Overlap

 Description Default
1 Distance between the column flange and

the plate flange.
0 mm

Chamfer dimension

 Description Default
1 Chamfer dimension. 10 mm

Using additional components

You can use additional system or custom components to modify the column
end or the base plate. For example, you can create special backing plates, weld
preparations, and weld access holes for the column end.

If you use additional system or custom components, you need to manage the
column end or the base plate properties in the additional component in
question. When using several components, there may be multiple welds and
cuts.
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Option Description
Component Select a system or a custom

component from the Applications &
components catalog.

Attributes Select an attribute file for the
component.

Input Define to which parts the selected
component is applied.

• Default is same as Base +
Column.

• Column sets the column as the
main part. Use this option for
details.

• Column + Base sets the column
as the main part and the base
plate as the secondary part.

• Base + Column sets the base
plate as the main part and the
column as the secondary part.

• Base sets the base plate as the
main part.

Bolts tab
Use the Bolts tab to control the bolt properties.

Bolt positions

 Description
1 Number of bolts.
2 Spacing between bolts.
3 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate the
numbers with a space. Bolt numbers run from left to right and from
top to down.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Anchor rods tab
Use the Anchor rods tab to control the creation of different types of anchor
rods.
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Anchor rod dimensions

Option Description
Rod profile Anchor rod profile.

You can add a comment about the
part.

Nut profile Nut profile.
Washer profile Washer profile.
Plate washer Plate washer thickness, width and

height.
Cast plate Cast plate thickness, width and

height.
Grout Grout thickness.

Grouting helps you to model columns
to the top of concrete parts and place
the base plate correctly. It also makes
it easier to dimension the detail in GA
drawings.

By default, no grouting is created.

Select whether the grouting is created
with or without slopes above or below
the detail creation point. This also
affects the shim plates.

Anchor rod part properties

Option Description Default
Pos_no Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

Class Part class number.
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Option Description Default
Finish Describes how the part

surface has been
treated.

Comment Add a comment about
the part.

Base plate with

Select whether to create the base plate with bolts, anchor rods, or a custom
component.

By default, the base plate is created with Bolts.

Anchor rod dimensions

 Description Default
1 Size or the length of the nut. anchor rod diameter
2 Size or the thickness of the washer. half of nut size
3 Length of the anchor rod. 500 mm
4 Length of the anchor rod above the

base plate.
50 mm

5 Distance between the cast plate and
the base plate.

60 mm

6 Length of the upper thread. 0 mm
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Anchor rod types

Option Description
Default

Type 1

AutoDefaults can change
this option.

Type 1

a

Radius of the hook

b

Width of the hook

a = 2*anchor bar
diameter
b = 1/5 of anchor
bar length

a

Radius of the hook

b

Width of the hook

c

Height of the hook

c = same as width of
the hook

d

Length of the anchor rod
below the extra plate

e

Length of the lower
thread

d = 2*nut size
e = 4*nut size plus
thickness of extra
plate

Hook direction

Option Description
Default

Type 1

AutoDefaults can change this option.
Type 1
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Option Description
Type 2

Type 3

Type 4

Bolting direction

NOTE You can define the bolting direction when you create the base plate
with bolts.

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.

Bolting direction 1

Bolting direction 2

Cast plate hole tolerance

Option Description Default
Cast plate holes
tolerance

Tolerance of the cast
plate holes.

same as bolt
tolerance

Washer hole tolerance

Option Description
Create hole in washer By default, a hole is not created in the

washer.

Tolerance of the washer hole.
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Plate washer placing

Option Description
Plate washers placed along circle Select whether the plate washers are

placed along the circle.

Placing the washers along the circle
distributes the loads evenly.

Create

 Description
1 Create the nut profile.
2 Create the washer profile.
3 Create the washer plate.

Anchor rod assembly

Define which parts of the anchor rod are included in the anchor rod assembly.

You can weld the washer plates above and below the base plate.

Extra plates tab
Use the Extra plates tab to control the placement, rotation, and type of the
profiles (extra profile 1) created at the bottom of each anchor bar and the
profiles (extra profile 2) that connect rows of anchor bars.

Part dimensions

Option Description Default
Extra profile 1 Select the first extra

profile from the profile
catalog.

PL10*100
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Option Description Default
Extra profile 2 Select the second extra

profile from the profile
catalog.

Part properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.

 

Edge distance of extra profile 1

 Description Default
1 Edge distance of extra profile 1. 50 mm
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Edge distance of extra profile 2

 Description Default
1 Distance of extra profile 2 from the axis of

the anchor bar.
Half of nut size or
anchor bar diameter

Extra profile 2 type

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2
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Option Description
Type 3

Type 4

Type 5

Type 6

Length of extra profile 2
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 Description Default
1 Length of extra profile 2 from the axis of

the anchor bar.
50 mm

Extra profile 1 properties

Option Description Default
Hole tolerance Hole tolerance of extra

profile 1.
Same as bolt
tolerance

Circular profile height Enter the height of a
circular extra profile 1.

 

Profile rotation Profile rotation of extra
profile 1.

Front

Extra profile 2 rotation

Option Description Default
Extra profile 2 rotation Profile rotation of extra

profile 2.
Front

General tab
Click the link below to find out more:

Analysis tab
Click the link below to find out more:

Welds
Click the link below to find out more:

Base plate (1053)
Base plate (1053) creates a base plate for tower legs. The base plate is
horizontal even if the column is sloped.

Objects created

• Base plate

• Bolts

• Welds

• Additional component (optional)
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Use for

Situation Description
Horizontal base plate connected to
sloped tower leg

Before you start

Create a column or a beam.

Selection order

1. Select the main part (column or beam).

2. Pick a position.

The detail is created automatically.

Part identification key

Num
ber

Part

1 Base plate

Picture tab
Use the Picture tab to control the position of the base plate.
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Dimensions

 Description Default
1 Horizontal distance between the reference

point and the bolt.
150 mm

2 Vertical distance between the reference point
and upper edge of the base plate.

300 mm

3 Vertical distance between the reference point
and the lower edge of the base plate.

200 mm

4 Horizontal distance between the reference
point and the left edge of the base plate.

200 mm

5 Horizontal distance between the reference
point and the right edge of the base plate.

300 mm

6 Vertical distance between the reference point
and the bolt.

150 mm

Parts tab
Use the Parts tab to control the dimensions of the base plate.

Plate

Option Description Default
Plate Thickness, width, and

height of the base plate.
Thickness = 10 mm
Width = 250 mm
Height =250 mm
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to control the position of the reference point and the
bolt locations.

Reference point

Define the plate dimensions and bolt locations using a reference point. The
point is located at the column end angle.

The picked point locates either on the top (P2) or the bottom of the base plate
(P1).

Weld gap

 Description
1 Gap between the base plate and the column.
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Using additional components

You can use additional system or custom components to modify the column
end or the base plate. For example, you can create special backing plates, weld
preparations, and weld access holes for the column end.

If you use additional system or custom components, you need to manage the
column end or the base plate properties in the additional component in
question. When using several components, there may be multiple welds and
cuts.

Option Description
Component Select a system or a custom

component from the Applications &
components catalog.

Attributes Select an attribute file for the
component.

Input Define to which parts the selected
component is applied.

• Default is same as Base +
Column.

• Column sets the column as the
main part. Use this option for
details.

• Column + Base sets the column
as the main part and the base
plate as the secondary part.

• Base + Column sets the base
plate as the main part and the
column as the secondary part.

• Base sets the base plate as the
main part.

Bolts tab
Use the Bolts tab to control the bolt properties.
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Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Number of bolts in the horizontal dimension.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

4 Number of bolts in the vertical dimension.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for each
space between bolts. For example, if there are 3 bolts, enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.
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If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Create as

Use this option to switch between bolts and custom components.

Select the custom component from the Applications & components catalog
and define the custom settings, up direction, rotation, and anchor length.
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Box column base plate (1066)
Box column base plate (1066) creates a base plate for a square or a circular
column that is embedded in concrete.

Objects created

• Base plate

• Ribs

• Flow holes

• Bolts

• Welds

Use for

Situation Description
Base plate with a square column
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Situation Description
Base plate with a square column

Base plate with a circular column

Base plate with a circular column

Before you start

Create a column.

Selection order

1. Select the main part (column).

2. Pick a position.

The detail is created automatically.

Steel components 2133 Base plates



Part identification key

Number Part
1 Base plate
2 Rib

Picture tab
Use the Picture tab to control the position of the base plate.

Dimensions

 Description Default
1 Distance from the edge of the column to the

edge of the base plate.
50 mm
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Parts tab
Use the Parts tab to control the dimensions of the base plate, long rib, and
short rib.

Plate

Option Description Default
Base plate Base plate thickness.
Long rib Long rib thickness. 9 mm
Short rib Short rib thickness. 9 mm

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tabs
Use the Parameters tab to control the base plate and rib dimensions.
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Base plate and rib dimensions

 Description
1 Width of base plate.
2 Length of long rib.
3 Length of short ribs.
4 Height of base plate.

Rib creation

Option Description
Default

No ribs are created.

AutoDefaults can change this option.

Steel components 2136 Base plates



Option Description
No ribs are created.

Ribs are created.

Base plate creation

Option Description
Default

Rectangular base plate

AutoDefaults can change this option.

Automatic
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Option Description
Round base plate

Rectangular base plate

Flow holes tab
Use the Flow holes tab to control the distance between the base plate and the
column.

Flow hole properties

 Description
1 Rounding of the column flow hole.
2 Weld gap.
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 Description
3 Width of the column flow hole.
4 Height of the column flow hole.

Flow hole creation

Option Description
Default

Flow holes are created.

AutoDefaults can change this option.

Flow holes are not created.

Flow holes are created.

Bolts tab
Use the Bolts tab to control the bolt properties.
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Bolt positions

 Description
1 Vertical bolt spacing dimension.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the edge of
the part.

3 Horizontal bolt spacing dimension.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.
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Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Create as

Use this option to switch between bolts and custom components.

Select the custom component from the Applications & components catalog
and define the custom settings, up direction, rotation, and anchor length.

Height of ribs tab
Use the Height of ribs tab to control the height of the short and the long ribs.

Height of ribs

 Description Default
1 Height of the long rib. 200 mm
2 Height of the short ribs. 200 mm

Short rib chamfer

Option Description
Default

Line chamfer is created.

AutoDefaults can change this option.
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Option Description
Chamfer is not created.

Line chamfer is created.

Arc chamfer is created.

Chamfer dimensions

 Description Default
1 Chamfer height. 15 mm
2 Chamfer width. 15 mm
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds tab

Click the link below to find out more:

2.17 Built-up Components
This section introduces built-up components available in Tekla Structures.

Click the links below to find out more:

• Beams (page 2144)

• Columns (page 2171)

• Frames (page 2183)

• Connections and details (page 2210)

Beams
Use these components to automatically create built-up beams:

Component Image Description
Box girder (S13)
(page 2145)

Creates a built-up beam
using four plates welded
together.
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Component Image Description
Cross profile
(S32)
(page 2149)

Creates a built-up beam
using an I profile and two
T profiles welded to the I
profile web.

Cross plate
profile (S33)
(page 2154)

Creates a built-up beam
from seven plates
welded together.

Tapered beam
(S98)
(page 2158)

Creates a tapered or
straight built-up beam
with I shape.

Tapered beam 2
(S45)
(page 2163)

Creates a tapered or
straight built-up beam
with I shape. Flange and
web plates can be
spliced.

PEB Tapered
section (S94)
(page 2168)

Creates a simple built-up
beam or column
between two picked
points. The shape can be
straight or tapered.

Box girder (S13)
Box girder (S13) creates a built-up beam with a box cross section.

Objects created

• Built-up beam

• Welds
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Use for

Situation Description
Straight built-up beam with a cross
section.

Do not use for

Tapered built-up beams.

Before you start

Ensure that you have two points to pick.

Selection order

1. Pick the start point for the beam.

2. Pick the end point for the beam.

The beam is created automatically when you pick the end point.

Part identification key

 Description
1 Top flange
2 Bottom flange
3 Left web
4 Right web

Picture tab
Use the Picture tab to define the dimensions.
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Dimensions

 Description
1 Width of the beam
2 Height of the beam
3 Top flange extension dimension
4 Bottom flange extension dimension

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description
Top flange Thickness of the top flange.
Bottom flange Thickness of the bottom flange.
Left web Thickness of the left web.
Right web Thickness of the right web.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the part name, class and finish, and the
position, rotation, and length.

Option Description
Name Define the name, class, and finish of

the beam.Class
Finish

Negative values shorten the beam,
positive values lengthen it.

1. Moves the beam end that you
pick first.

2. Moves the beam end that you
pick second.

Select the position in plane and
define the position in plane offset.

See .
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Option Description
Select a suitable rotation and define
the rotation offset.

See .

Select the position in depth and
define the position in depth offset.

See .

Welds

Click the link below to find out more:
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Cross profile (S32)
Cross profile (S32) creates a built-up beam using an I profile and two T
profiles welded to the I profile web.

Objects created

• I profile

• T profile (2)

• Welds

Use for

Situation Description
Straight built-up beam. Two T profiles
welded to an I profile.

Do not use for

Tapered built-up beams.

Before you start

Check that you have two points to pick.

Selection order

1. Pick the start point for the beam.

2. Pick the end point for the beam.

The beam is created automatically when you pick the end point.

Part identification key
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 Description
1 I profile
2 T profile

Picture tab
Use the Picture tab to define the dimensions of the profiles.

Dimensions

 Description
1 Adjust the location of the horizontal parts relative to the vertical

parts.

By default, the eccentricity is zero. T profiles are connected to
the middle of the I profile web.

2 T profile dimension from the I profile center line.

Parts tab
Use the Parts tab to define the I profile and the T profile properties.

Parts

Option Description
Main prof Select the profile from the profile

catalog.
Sec prof1 Select the profile from the profile

catalog.
Sec prof2 Select the profile from the profile

catalog.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the part name, class and finish, and the
position, rotation, and length.

Option Description
Name Define the name, class, and finish of

the profiles.Class
Finish

Negative values shorten the beam,
positive values lengthen it.

1. Moves the beam end that you
pick first.

2. Moves the beam end that you
pick second.
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Option Description
Select the position in plane and
define the position in plane offset.

See .

Select a suitable rotation and define
the rotation offset.

See .

Steel components 2153 Built-up Components



Option Description
Select the position in depth and
define the position in depth offset.

See .

Welds

Click the link below to find out more:

Cross plate profile (S33)
Cross plate profile (S33) creates a built-up beam using seven plates welded
together.

Objects created

• Plates (7)

Use for

Situation Description
Straight built-up beam, seven plates
welded together.
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Do not use for

Tapered built-up beams.

Before you start

Ensure that you have two points to pick.

Selection order

1. Pick the start point for the beam.

2. Pick the end point for the beam.

The beam is created automatically when you pick the end point.

Part identification key

 Description
1 Cross plate. Seven plates are created.

Picture tab
Use the Picture tab define the dimensions.

Dimensions

 Description
1 Width of the beam
2 Height of the beam
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 Description
3 Height of the plate
4 Adjust the location of the horizontal parts relative to the

vertical parts.

By default, the eccentricity is zero. Plates are connected to the
middle of the vertical plate.

5 Plate edge dimension to the vertical plate center line.

Parts tab
Use the Parts tab to define the plate properties.

Parts

Option Description
Top flange Thickness of the top flange.
Bottom flange Thickness of the bottom flange.
Vertical web Thickness of the vertical web.
Left flange Thickness of the left flange.
Right flange Thickness of the right flange.
Left web Thickness of the left web.
Right web Thickness of the right web.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Parameters tab
Use the Parameters tab to define the part name, class and finish, and the
position, rotation, and length.

Option Description
Name Define the name, class, and finish of

the plates.Class
Finish

Negative values shorten the beam,
positive values lengthen it.

1. Moves the beam end that you
pick first.

2. Moves the beam end that you
pick second.

Select the position in plane and
define the position in plane offset.

See .
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Option Description
Select a suitable rotation and define
the rotation offset.

See .

Select the position in depth and
define the position in depth offset.

See .

Welds

Click the link below to find out more:

Tapered beam (S98)
Tapered beam (S98) creates a tapered or straight built-up beam with I shape.
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Objects created

• Web plate

• Top flange plate

• Bottom flange plate

• Welds

Use for

Situation Description
Creates a simple
built-up beam
between two picked
points.

Before you start

Ensure that you have two points to pick.

Selection order

1. Pick the start point of the beam.

2. Pick the end point of the beam.

The beam is created automatically when you pick the end point.

Part identification key

 Description
1 Web plate
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 Description
2 Top flange plate
3 Bottom flange plate

Picture tab
Use the Picture tab to define the height of the web or the entire beam, sloping
rise, and run values.

Dimensions

Select the beam height type on the Parameters tab.

 Description
1 Length of the slope
2 Height of the slope

Parts tab
Use the Parts tab to define the properties of the plates.

Parts

Option Description
Web plate Thickness and width of the web plate.
Top fl. profile Select the profile from the profile

catalog.
Bottom fl. profile Select the profile from the profile

catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Material Material grade. The default material is

defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the beam end shape, height type, type of
reference point, beam end setback distance, and the position of the web plate.

Type of cut at beam end

Select the shape of the beam end at the beginning and end of the beam.

Option Description
Vertical in global system

Perpendicular to top flange

In Z of current plane Depends on the position of the work
plane.

Beam height type

Affects the height values entered on the Picture tab.

Option Description
Height of the web.

Height of the entire beam.
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Type of reference point

Select the location of the end of the beam, relative to the point you pick.

Option Option Description
Top profile, setback
distance.

Top profile, end of the
web plate.

Top web plate, setback
distance.

Top web plate, end of
the web plate.

Beam end setback distance

 Description
1 Define the the setback distance of beam ends.

Steel components 2162 Built-up Components



Position of web plate

Option Description
Select the location of the web plate.

See also .

Welds

Click the link below to find out more:

Tapered beam 2 (S45)
Tapered beam 2 (S45) creates a built-up beam with I shape. The beam can be
tapered or straight. You can control the size of the spliced material.

Objects created

• Web plates

• Top flange plates

• Bottom flange plates

Use for

Situation Description
A simple, straight beam
built up from two flange
plates and a web plate.
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Situation Description
A tapered beam built-up
from several spliced plates.

The points you pick
determine the beam
length. You can adjust the
length on the Picture tab.

Before you start

Ensure that you have two points to pick.

Selection order

1. Pick the start point for the beam.

2. Pick the end point for the beam.

The beam is created automatically when you pick the end point.

Part identification key

 Description
1 Web plate
2 Top flange plate
3 Bottom flange plate

Picture tab
Use the Picture tab to define the beam dimensions and location, relative to
the points picked.
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Dimensions

 Description
1 Distance from the first point picked to the end of the beam.

A negative value lengthens the beam, a positive value
shortens it.

2 Beam depth at the first end.

This is either the height of the web or the entire beam,
depending on what you select as the depth measure.

3 Length of the top flange plates.

For example, to have four one-meter sections, enter 4*1000.

If you want to create the flange or web from a single plate,
leave the box empty.

4 Length of the web plates.

For example, to have four one-meter sections, enter 4*1000.

If you want to create the flange or web from a single plate,
leave the box empty.

5 Length of the bottom flange plates.

For example, to have four one-meter sections, enter 4*1000.

If you want to create the flange or web from a single plate,
leave the box empty.

6 Gap between the top flange plates.
7 Horizontal sloping of the beam, either as a percentage or in

degrees.
8 Gap between the bottom flange plates.
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 Description
9 Distance from the last point picked to the end of the beam.

A negative value lengthens the beam, a positive value
shortens it.

10 Beam depth at the second end.

This is either the height of the web or the entire beam,
depending on what you select as the depth measure.

Beam position to picked point

Option Option Description
Moves the beam so that
the point is located at
the top of the top flange.
Moves the beam so that
the point is located at
the bottom of the top
flange.
Moves the beam so that
the point is located in
the middle of the beam
cross section.

Web plate orientation

Option Description
Web plates are cut perpendicular to
the top flange.

Web plates are cut vertically.

Beam end alignment

Option Option Description
Cut is vertical or
horizontal.

Cut is perpendicular to
the top flange.
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Option Option Description
Cut is relative to the
current position of the
work plane.

Depth measure

Option Description
Depth is calculated from the outer
surfaces of the top and bottom
flanges.
Depth is the depth of the web.

Parts tab
Use the Parts tab to define the plate properties.

Parts

Option Description
Top fl. profile Select the profile from the profile

catalog.
Bottom fl. profile Select the profile from the profile

catalog.
Web pl. thickness Thickness of the web plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Option Description Default
Finish Describes how the part

surface has been
treated.

 

Welds

Click the link below to find out more:

PEB Tapered section (S94)
PEB Tapered section (S94) creates a simple built-up beam or column between
two picked points. The shape can be straight or tapered.

Objects created

• Web plate

• Flange plates (2)

• Welds

Use for

Situation Description
Tapered built-up column
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Situation Description
Straight built-up beam

Selection order

1. Pick the start point for the beam or column.

2. Pick the end point for the beam or colum.

The beam or column is created automatically when you pick the end
point.

Part identification key

 Description
1 Web plate
2 Outer flange plate
3 Inner flange plate

Picture tab
Use the Picture tab to define the dimensions and the rotation.

Dimensions

Option Description
Default

Define the column web dimensions at
the top and the bottom.

AutoDefaults can change this option.
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Option Description
Define the column web dimensions at
the top and the bottom.

Define the column flange dimensions
at the top and the bottom.

Rotation

Option Description
Default

Column is not rotated.

AutoDefaults can change this option.

Column is rotated.

Column is not rotated.

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description
Web thickness Thickness of the web plate.
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Option Description
Outer flange Thickness and width of the outer

flange plate.
Inner flange Thickness and width of the inner

flange plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Welds

Click the link below to find out more:

Columns
Use these components to automatically create built-up columns:

Component Image Description
Tapered column
(S99)
(page 2172)

Creates a single built-up
column, which can be
straight or tapered.

Tapered column
2 (S44)
(page 2177)

Creates a built-up
column, which can be
straight or tapered.
Flange and web plates
can be spliced.
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Component Image Description
PEB Tapered
section (S94)
(page 2168)

Creates a simple built-up
beam or column
between two picked
points. The shape can be
straight or tapered.

Tapered column (S99)
Tapered column (S99) creates a single built-up column, which can be straight
or tapered.

Objects created

• Vertical web plate

• Vertical outer flange plate

• Inclined inner flange plate

• Top plate

• Flange stiffeners (2)

• Horizontal stiffeners (2)

• Welds

Use for

Situation Description
A tapered built-up column with a stiffened
corner.

Flange stiffeners:
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Situation Description
A straight built-up column.

Before you start

Ensure that you have a point to pick.

Selection order

1. Pick the position of the column:

The column is created automatically when you pick the position.

Part identification key
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 Description
1 Web plate
2 Horizontal stiffener
3 Top plate
4 Inner flange plate
5 Outer flange plate

Picture tab
Use the Picture tab to define the column dimensions.

Dimensions

 Description
1 Dimension from the web plate top corner to the top of the

stiffener
2 Dimension from the top of the stiffener to the inner corner of

the web plate
3 Inner flange plate slope
4 Web plate width at the bottom
5 Web plate vertical offset from the input point
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 Description
6 Web plate dimension from the input point to the top of the

horizontal stiffener
7 Top plate slope as a percentage, for example, 10.
8 Horizontal stiffener length

Parts tab
Use the Parts tab to define the plate properties.

Parts

Option Description
Web Thickness of the web
Outer flange, Inner flange, Top
plate, Horiz stiffener

Select the profiles on the Parameters
tab.

Flange stiffener Thickness of the flange stiffener

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the plate profiles, orientation, and
dimensions.
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Profiles

Option Description
Outer flange profile, Inner flange
profile, Top plate profile, Horizontal
stiffener profile

Profile size of the plates.

The std_flange_plates.dat file
defines the available plate profiles.

Flange splice dimension

If the plate is longer than the maximum plate length defined in the
std_flange_plates.dat file, Tekla Structures creates a splice.

 Description
1 Inner flange splice dimension
2 Outer flange splice dimension

Orientation

Option Description
Select a suitable rotation.

The column web is rotated relative to
the work plane.
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Extra length

 Description
1 Outer flange extra length
2 Top plate extra length

Horizontal stiffener chamfer

 Description
1 Internal chamfer dimension in the horizontal stiffener. The

default value is 15.

Welds

Click the link below to find out more:

Tapered column 2 (S44)
Tapered column 2 (S44) creates a welded built-up column, which can be
tapered or straight. You can control the taper and the size of the spliced
material.

Objects created

• Web plates

• Top flange plates

• Bottom flange plates

• Welds
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Use for

Situation Description
A simple straight column built up
from two flange plates and a web
plate.

A more complex tapered column, with
several plates forming the web, and
top and bottom flanges.

Before you start

Ensure that you have a point to pick.

Selection order

1. Pick the position of the column.

The column is created automatically when you pick the position.
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Part identification key

 Description
1 Web plate
2 Top flange plate
3 Bottom flange plate

Picture tab
Use the Picture tab to define the column dimensions and location relative to
the picked points.
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Dimensions

 Description
1 Distance from the first point picked to the end of the column.
2 Column width at the first end.
3 Gap between the top flange plates.
4 Column width at the second end.
5 Distance from the last point picked to the end of the column.
6 Column height.
7 Column end alignment dimension.
8 Length of the top flange plates.

For example, to have four one-meter sections, enter 4*1000.

If you want to create the flange or web from a single plate,
leave the box empty.

9 Length of the web plates.

For example, to have four one-meter sections, enter 4*1000.

If you want to create the flange or web from a single plate,
leave the box empty.
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 Description
10 Length of the bottom flange plates.

For example, to have four one-meter sections, enter 4*1000.

If you want to create the flange or web from a single plate,
leave the box empty.

11 Gap between the bottom flange plates.
12 Horizontal sloping of the beam, as a percentage.
13 Column rotation dimension.

Column rotation

Option Description
Select how the column is rotated and
define the dimension for the rotation.

Column position to picked point

Option Description
Moves the column so that the point is
located at the column flange.
Moves the column so that the point is
located at the column web.

Moves the column so that the point is
located in the middle of the column
cross section.
Moves the column so that the point is
located at the column web.

Moves the column so that the point is
located at the column flange.

Web plate orientation

Option Description
Web plates are cut perpendicular to
the top flange.
Web plates are cut vertically.
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Column end alignment

Option Description
Cut is vertical or horizontal.

Cut is perpendicular to the top flange.

Cut is relative to the current position
of the work plane.

Depth measure

Option Description
Depth is calculated from the outer
surfaces of the top and bottom
flanges.
Depth is the depth of the web.

Column flange

Option Description
Column flange is perpendicularly
fitted to the web.
Column flange is aligned with the
web.

Parts tab
Use the Parts tab to define the plate properties.

Parts

Option Description
Top fl. profile Select the profile from the profile

catalog.
Bottom fl. profile Select the profile from the profile

catalog.
Web pl. thickness Thickness of the web plate.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Welds

Click the link below to find out more:

Frames
Use the following components to automatically create built-up frames, beams,
and columns:

Component Image Description
Tapered frame
comonor (S53)
(page 2184)

Creates a built-up frame
or parts of it. You can
control the taper and the
size of the spliced
material.

PEB Frame (S92)
(page 2205)

Creates a pre-engineered
building frame to the
selected point. This
component uses existing
components to create
built-up columns and
rafters, base plates, knee
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Component Image Description
connection, splice
connections, and apex
connection.

Tapered frame comonor (S53)
Tapered frame comonor (S53) creates a built-up frame or parts of it. You can
control the taper and the size of the spliced material.

Objects created

• Built-up columns with base plate and end plate

• Built-up beams with end plates

Use for

Situation Description
Built-up frame

1 Beam 1

2 Beam 2

On the Picture tab, use the following options:

• Frame type: Column, first beam, and second
beam are created.

• Symmetry type: Symmetrical frame is created.
Sloped built-up frame

On the Picture tab, use the following options:

• Frame type: Column, first beam, and second
beam are created.

• Symmetry type: Symmetrical frame is created.

Only half of the frame

On the Picture tab, use the following options:

• Frame type: Column and first beam are created.

• Symmetry type: Symmetrical frame is not
created.
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Situation Description
Built-up column with base plate and end plate

On the Picture tab, use the following options:

• Frame type: Column is created.

• Symmetry type: Symmetrical frame is not
created.

Built-up beam (1) with end plates

On the Picture tab, use the following options:

• Frame type: First beam is created.

• Symmetry type: Symmetrical frame is not
created.

Built-up beam (2) with end plates

On the Picture tab, use the following options:

• Frame type: Second beam is created.

• Symmetry type: Symmetrical frame is not
created.

Limitations

Creates a frame only in the global X direction. Y direction is not possible.

Before you start

Ensure that you have a point to pick.

Selection order

1. Pick the position of the column.

The frame is created automatically when you pick the position.
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Part identification key

 Description
1 Column
2 First beam
3 Second beam
4 Base plate
5 End plate

Picture tab
Use the Picture tab to define the frame dimensions and location relative to
the picked points.

Dimensions

 Description
1 Select the height dimension to be defined.
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 Description
2 Define the height.
3 Dimension from the column outer edge to the frame center line.

Frame type

Option Description
Column is created.

First beam is created.

Second beam is created.

Column and first beam are created.

Column, first beam, and second beam
are created.

Symmetry type

Option Description
Symmetrical frame is not created.
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Option Description
Symmetrical frame is created.

Part class

Define the class of the web and flange plates, base plates, and end plates.

Parts tab
Use the Parts tab to define the plate properties.

Parts

Column parts Description
Top fl. profile, Bottom fl. profile Select the profile from the profile

catalog.
Web thickness Thickness of the column web.
Base plate Thickness and width of the base

plate.
Horiz end plate Thickness and width of the horizontal

end plate.

1 Beam parts Description
Top fl. profile, Bottom fl. profile,
Vertical fl. profile

Select the profile from the profile
catalog.

Web thickness Thickness of the first beam web.
Horiz end plate Thickness and width of the horizontal

end plate.
Lateral end plate Thickness and width of the lateral end

plate.

2 Beam parts Description
Top fl. profile, Bottom fl. profile Select the profile from the profile

catalog.
Web thickness Thickness of the second beam web.
Left end plate Thickness and width of the left end

plate.
Right end plate Thickness and width of the right end

plate.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Column tab
Use the Column tab to define the column dimensions.
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Dimensions

 Description
1 Distance from the first point picked to the end of the column.
2 Column depth at the first end.

This is either the height of the web or the entire column,
depending on what you select as the depth measure.

3 Base plate extension dimension at the bottom of the column.
4 Base plate thickness.
5 Gap between the top flange plates.
6 End plate extension dimension at the top of the column.
7 Column depth at the second end.

This is either the height of the web or the entire column,
depending on what you select as the depth measure.

8 End plate thickness.
9 Column end alignment dimension.
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 Description
10 Length of the top flange plates.

For example, to have four one-meter sections, enter 4*1000.

If you want to create the flange from a single plate, leave the
box empty.

11 Length of the web plates.

For example, to have four one-meter sections, enter 4*1000.

If you want to create the web from a single plate, leave the
box empty.

12 Length of the bottom flange plates.

For example, to have four one-meter sections, enter 4*1000.

If you want to create the flange from a single plate, leave the
box empty.

13 Gap between the bottom flange plates.
14 Sloping of the column as a percentage.
15 Column rotation dimension.

Column end alignment

Option Description
Cut is vertical or horizontal.

Cut is perpendicular to the top flange.

Cut is relative to the current position
of the work plane.

Column rotation

Option Description
Select how the column is rotated and
define the dimension for the rotation.
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Column position to picked point

Option Description
Moves the column so that the point is
located at the column flange.
Moves the column so that the point is
located at the column web.

Moves the column so that the point is
located in the middle of the column
cross section.

Web plate orientation

Option Description
Web plates are cut perpendicular to
the top flange.
Web plates are cut vertically.

Depth measure

Option Description
Depth is the depth of the web.

Depth is calculated from the outer
surfaces of the top and bottom
flanges.

Column 2 tab
Use the Column 2 tab to define the base plate bolt group dimensions and
properties.
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Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

4 Dimension for vertical bolt group position.
5 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

Bolt creation

Option Description
Holes are created.

Bolts are created.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Column 3 tab
Use the Column 3 tab to define the end plate bolt group dimensions and
properties between the column and the first beam.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

4 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Beam 1 tab
Use the Beam 1 tab to define the dimensions of the first beam.
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Dimensions

 Description
1 Beam depth at the first end.
2 Distance from the first point picked to the end of the beam.
3 Length of the top flange.
4 Length of the top flange plate to the first flange gap.
5 Length of the top flange plate to the second flange gap.
6 Length the top flange to the slope angle.
7 Beam web height at the slope angle.
8 Beam web height at the column end.
9 Length of the web plate.
10 Length of the bottom flange plate.
11 Horizontal sloping of the beam, either as a percentage or in

degrees.
12 End plate extension dimension.
13 Beam depth at the second end.
14 End plate thickness.
15 End plate extension dimension.
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Web plate orientation

Option Description
Web plates are cut perpendicular to
the top flange.
Web plates are cut vertically.

Beam end alignment

Option Description
Cut is vertical or horizontal.

Cut is perpendicular to the top flange.

Beam length

Option Description
Sloped beam length

Horizontal beam length

Beam height

Option Description
Perpendicular beam height

Vertical beam height

Beam bottom cut

Option Description
Beam bottom web is cut.

Beam bottom is fitted to the end
plate.
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Beam 1_2 tab
Use the Beam 1_2 tab to define the end plate bolt group dimensions and bolt
properties between the first beam and the second beam.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Beam 2 tab
Use the Beam 2 tab to define the dimensions of the second beam.
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Dimensions

 Description
1 Beam depth at the first end.
2 Distance from the first point picked to the end of the beam.
3 End plate extension at the first end.
4 End plate thickness at the first end.
5 Length of the top flange plates.

For example, to have four one-meter sections, enter 4*1000.

Leave blank to create the flange or web from a single plate.
6 Length of the web plates.

For example, to have four one-meter sections, enter 4*1000.

Leave blank to create the flange or web from a single plate.
7 Length of the bottom flange plates.

For example, to have four one-meter sections, enter 4*1000.

Leave blank to create the flange or web from a single plate.
8 Gap between the top flange plates.
9 Gap between the bottom flange plates.
10 Horizontal sloping of the beam, either as a percentage or in

degrees.
11 End plate thickness at the second end.
12 End plate extension at the second end.
13 Beam depth at the second end.

This is the height of the web or the entire beam, depending on
what you select as the depth measure.
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Beam position to picked point

Option Option Description
Moves the beam so that
the point is located at
the beam flange.
Moves the beam so that
the point is located at
the beam web.
Moves the beam so that
the point is located in
the middle of the beam
cross section.

Beam end alignment

Option Option Option
Cut is vertical or
horizontal.
Cut is perpendicular to
the top flange.

Cut is relative to the
current position of the
work plane.

Web plate orientation

Option Description
Web plates are cut perpendicular to
the top flange.
Web plates are cut vertically.

Depth measure

Option Description
Depth is calculated from the outer
surfaces of the top and bottom
flanges.
Depth is the depth of the web.

Beam 2_2 tab
Use the Beam 2_2 tab to define the end plate bolt group dimensions and bolt
properties at the hip between the second beams.
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Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Welds

Click the link below to find out more:

PEB Frame (S92)
PEB Frame (S92) creates a pre-engineered building frame to the selected
point. This component uses existing components to create built-up columns
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and rafters, base plates, knee connection, splice connections, and apex
connection.

Objects created

• Built-up rafter (1 to 4 segments)

• Apex connection

• Splice connections

• Knee connections (2)

• Built-up columns (1 to 4 segments)

• Base plate details (2)

Use for

Situation Description
Frame consisting of spliced columns
and spliced rafters.

Apex connection between two rafters
at the apex of the portal frame.

The first splice between the first and
the second segment of the rafter.
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Situation Description
The second splice between the
second and the third segment of the
rafter.

Knee connection between the second
segment of the column and the first
segment of the rafter.

Column splice between the first and
the second segment of the column.

Column base plate detail.
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Selection order

1. Pick the point in which to insert the frame.

The frame is created automatically when you pick the point.

Part identification key

 Description
1 Column
2 Rafter

Picture tab
Use the Picture tab to define the frame dimensions.
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Dimensions

 Description
1 Column horizontal distance from the input point
2 Column height
3 Rafter offset distance from the input frame
4 Rafter angle
5 Frame width
6 Orientation of the frame

Parameters tab
Use the Parameters tab to define part properties. Select whether the
components are exploded or not.

Parts

Option Description
Column 1, Column 2 Select a component from the

Applications & components catalog.

Define the segments and lengths.
Rafter 1, Rafter 3 Select a component from the

Applications & components catalog.

Define the segments and lengths.
Column 1 base plate, Column 2
base plate

Select a component from the
Applications & components catalog.
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Option Description
Column 1 knee joint, Column 2
knee joint

Select a component from the
Applications & components catalog.

Apex splice joint Select a component from the
Applications & components catalog.

Connections and details
Use the following components to automatically create connections and details
for built-up beams and columns:

• Pipe column and beam panel zone (21) (page 2210)

• Batten plates (S85) (page 2223)

• Tapered column (136) (page 2230)

• Tapered beam to tapered column (197) (page 2239)

• Tapered column to tapered beam (199) (page 2244)

• Tapered beam to beam (200) (page 2250)

• Tapered column base plate (1068) (page 2258)

• PEB Knee joint (S93) (page 2276)

Pipe column and beam panel zone (21)
Pipe column and beam panel zone (21) connects a beam to a column with a
diaphragm that goes through the column at the level of the beam flanges. You
can use Pipe column and beam panel zone (21) both for square and round
steel columns. H profile beams are used as secondary parts. The secondary
part beams can be either horizontal or skewed.

Objects created

• Diaphragm (penetrating, inner)

• Brackets

• Cantilevers

• Welds
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Use for

Situation Description
Beams connected to a column with
brackets and cantilevers.

Selection order

1. Select the main part (lower column).

2. Select the secondary parts (a maximum of 4 beams).

3. Select the upper column as the fifth secondary part, if needed.

4. Click the middle mouse button to create the connection.

Part identification key

 Description
1 Diaphragm
2 Short columm

Short columns are created between penetrating diaphragms.
3 Tapered column-beam stub (150) connection

Design dimensions tab
Use the Design dimensions tab to define the bracket type and length, and
haunch height.
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Bracket and hauch

Option Description Default
Bracket type Select the bracket type.

• If you set the bracket type
to Bracket, the Tapered
column-beam stub (150)
component is used for
connecting the beam to
the column.

• If you set the bracket type
to Cantilever, the beam is
connected directly to the
column.

• If you set the bracket type
to Hypothetical, the beam
connection is created as
diaphragm plates and
short columns according to
the beam size.

Bracket

Bracket length When you have set the
bracket type to Bracket, select
whether the bracket length is
based on Reference point
(L2) (this is the default) or
Center point (L1). The length
is based on the lower column.

1000 mm
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Option Description Default
Haunch Select whether the haunch

height is automatically
determined.

You can use this option when
the bracket type is Bracket.

None

Haunch height Define the haunch height
when the bracket type is not
cantilever and you have set
Haunch to Specified.

Straight bracket of
the same size as
the beam

Fabrication dimensions tab
Use the Fabrication dimensions tab to define the diaphragm dimensions.

Dimensions

 Description Default
1 Gap between the column and the diaphragm 0 mm
2 Maximum diaphragm thickness 40 mm
3 Outer additional diaphragm thickness 0 mm
5 Inner additional diaphragm thickness 0mm

Inner diaphragm dimensions

 Description Default
1 Chamfer shape of the inner diaphragm

corner
Inner diaphragm:
Concave circle

Penetrating
diaphragm: No
chamfer
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 Description Default
2 Corner chamfer dimension  
3 Corner chamfer dimension for the extra arc  
4 Gap between the inner diaphragm and the

inner surface of the column
0 mm

5 Spacing of the four corner holes of the inner
diaphragm

This option is used when the corner hole
diameter defined in 6 is > 0 mm.

100 mm

6 Diameter of the corner hole that goes
through the diaphragm

There are four corner holes. You can define
the diameter when the column is a square
steel pipe.

0 mm

7 Diameter of the center hole that goes
through the diaphragm

30 mm

Penetrating diaphragm dimensions

 Description Description
1 Corner chamfer shape of the penetrating

diaphragm
Inner diaphragm:
Concave circle

Penetrating
diaphragm: No
chamfer

2 Corner chamfer dimension

You can define the dimension when the
chamfer shape is set to something else than
No.

0 mm

3 Diaphragm protrusion dimensions 25 mm
4 Spacing of the four corner holes of the through

diaphragm

This option is used when the corner hole
diameter defined in 5 is > 0 mm.

100 mm
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 Description Description
5 Diameter of the corner hole that goes through

the diaphragm

There are four corner holes. You can define the
diameter when the column is a square steel
pipe.

6 Diameter of the center hole that goes through
the diaphragm

30 mm

7 Top plate is a penetrating diaphragm, called a
top plate if there is no upper column.

Weld access holes

You can define the weld access holes for the diaphragm plates.

Clearance dimensions

 Description Default
1 Clearance between the penetrating diaphragms 150 mm
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 Description Default
2 Clearance between the inner diaphragms 100 mm
3 Clearance between the penetrating diaphragm and

inner diaphragm
100 mm

Panel parts tab
Use the Panel parts tab to define the part properties.

Parts

Option Description
Tapered plates Thickness of the four tapered plates

that build the short column.

You can define the thickness when the
taper type and straight short column
type is Buildup.

Straight plates Thickness of the four straight plates
that build the short column.

You can define the thickness when the
taper type and straight short column
type is Buildup.

Tapered profile Select the profile from the profile
catalog.

Short column profile name can be used
when the taper type and straight short
column type is Rolled.

Straight profile Select the profile from the profile
catalog.

Short column profile name can be used
when the taper type and straight short
column type is Rolled.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
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Option Description Default
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Rotation of rolled steel

Rolled steel is placed at the center axis of the main part. If you use a rolled
tapered profile, the taper may be eccentric. You then need to change the
rotation by using the Taper profile orientation option.

Option Description Default
Panel plate size up Increased panel

thickness
0 increase

Taper panel Select whether to taper
the panel.

You can define an
additional rotation angle
to the main part rotation
angle.

Auto

Taper type Select the tapering type. Buildup
Taper profile
orientation

Select the rotation
direction of the tapered
profile.

The rotation follows the
global coordinate
system.

Front

Straight short column
type

Select the short column
type.

Rolled
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Diaphragm thickness increase

Option Regular plate
size up

Plate size up Size up due to
column

Penetrating
diaphragm

Inner diaphragm

The default values
are:

• Penetrating
diaphragm: 2

• Inner
diaphragm: 1

To increase the
size of a plate, set
the size increase.
You can define
two size up values
for each
diaphragm plate,
for a thin plate
and a thick plate.
For example,

• Size up value
for thin plate =
2

• Size up value
for thick plate
= 1

• The default
border value =
40 mm

If the required
plate thickness is
34 mm, 2 size ups
are applied and
the result will be
45 mm.

If the required
plate thickness is
44 mm, 1 size up is
applied and the
result will be 50
mm.

Increased plate
size

The default values
are:

• Penetrating
diaphragm: 1

• Inner
diaphragm: 0

The table below shows an example of the calculation result.

Normal size up = 2 Specified plate
thickness

Plate size up = 1

t ≦ 6　
→　12

6 ＜ t 
≦ 9　
→　16

＜ 40 ≦  t ＝ 
40　→　
45

40 ＜ 
t ≦ 
45　→　
48
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Normal size up = 2 Specified plate
thickness

Plate size up = 1

9 ＜ t 
≦ 12　
→　19

12 ＜ 
t ≦ 
16　→　
22

16 ＜ 
t ≦ 
19　→　
25

 …

32 ＜ 
t ≦ 
36　→　
45

45 ＜ 
t ≦ 
48　→　
50

48 ＜ 
t ≦ 
50　→　
55

50 ＜ 
t ≦ 
55　→　
60

 … 

Welds

Option Description
Weld prep Select whether to create welding cuts.

The default is No.
Weld prep. preset Select whether to use preset welding

settings.

Custom component to column

You can use custom components for welds, welding cuts, and weld backing
bars.

Option Description
Component Custom component name

You can use seam or connection type
custom components.

Parameters Property file name to be used for the
custom component.

You can define the name if you have
specified a custom component.

Diaphragm tab
Use the Diaphragm tab to define the diaphragm material, thickness, offset,
and type.
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Diaphragm

 Description
1 Diaphragm plate thickness
2 Offset from the automatically determined diaphragm position
3 Diaphragm type

Diaphragm thickness

Apply the highest value of the following options:

• Thickness is determined based on the thickest plate among the beam
flanges that are at the same height.

• Thickness is determined by the thickest beam flange value + the additional
thicknesses defined on the Fabrication dimensions tab.

• Thickness is calculated based on the required diaphragm thickness, which
takes into account each beam flange thickness and height.

Diaphragm offset

The diaphragm offset is based on the automatically determined diaphragm
height. The offset value is the distance from the reference height. Use the
offset when fine-tuning the height of the automatically determined
diaphragm. Enter a positive value for the upward offset and a negative value
for the downward offset.

Diaphragm type

The diaphragm height is automatically determined by the height at which the
beam flanges meet.
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Example Description
The example image shows the most
commonly used diaphragm
arrangement.

The outermost upper and lower
diaphragms are penetrating
diaphragms.

The other diaphragm is an inner
diaphragm.
Even if two or more flanges are on
slightly different levels, one
diaphragm is created if the clearance
is smaller than the minimum
diaphragm clearance set on the
Fabrication dimensions tab.

Cantilevers tab
Use the Cantilevers tab to define the custom components that are used.

Custom components

You can define that a custom component is used for the upper flange, lower
flange, and the web.

  
Component Custom component name

You can use seam or connection type
custom components.

Parameters Property file name to be used for the
custom component.

You can define the name if you have
specified a custom component.

Custom components (upper flange, lower flange)

You can use custom components for welds, welding cuts, and weld backing
bars.

The images below show examples of custom components applied to beam
flanges.
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Custom components (web)

You can use custom components for polygon welds and web cuts.

The beam is the main part and the short column is the secondary part. If the
web welds are separated by a penetrating diaphragm, apply a custom
component to each web edge.

The example image below shows a situation where the penetrating diaphragm
is interrupted and the side of the beam web is divided into two.

The example image below shows the coordinate system, and the first and
second points used to define a seam type custom component.

Bracket tab
Use the Bracket tab to define the bracket properties.
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Properties

Option Description
Parameters Property file name to be used for

Tapered column-beam stub (150).

Define this when you have selected
Bracket as the Bracket type on the
Design dimensions tab.

Profile name Select the profile from the profile
catalog.

The default value is the beam profile
when the beam is rolled.

Size up Plate size increase

If you have selected a profile, the
profile size value is used.

Profile/Flg Select the profile/flange plate
material.

Web Select the web plate material.

This option is not used when the
bracket type is Rolled.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Batten plates (S85)
Batten plates (S85) connects twin profiles with either bolted or welded
connections. Backing plates are also created.

Objects created

• Batten plates

• Backing plates

• Bolts

• Welds

Use for

Situation Description
Twin profile connected with
horizontal and vertical batten plates
and backing plates.

Selection order

1. On the ribbon, click Beam --> Twin profile.

2. Pick a position on the twin profile.

3. Select the first object in the profile.

4. Select the second object in the profile.

5. Click the middle mouse button to create the connection.

Part identification key

 Description
1 Batten plate
2 Backing plate
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Picture tab
Use the Picture tab to define the distance of the batten plates from the input
point, and the spacing and orientation of the plates.

Batten plate distribution

Option Description
The first batten plate is vertically
oriented.

Define the distance of the batten
plates from the start point.

The first batten plate is horizontally
oriented.

Define the distance of the batten
plates from the start point.

The batten plate in the middle is
horizontally oriented.

Define the distance of the batten
plates from the middle point.

The batten plate in the middle is
vertically oriented.

Define the distance of the batten
plates from the middle point.

Batten plate location

 Description
1 Define the distance from the start point.
2 Define the number of batten plate connections.
3 Define the batten plate spacing.
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Parts tab
Use the Parts tab to define the plate properties.

Parts

Option Description Default
Batten plate leg1 Thickness of the batten

plate.
Clearance between the
angles.

Batten plate leg2 Thickness of the batten
plate.

Clearance between the
angles.

Back plates Thickness of the backing
plates.

3/8”

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to select between bolted or welded plates. You can
also define the size of the backing plates for the welded connections.

Plate type

Option Description
Plates are bolted.
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Option Description
Plates are welded.

Define the plate dimensions.

Welded plate dimensions

 Description Default
1 Backing plate width. 3”15/16
2 Backing plate length. 3”15/16

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions

 Description
1 Number of bolts.
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 Description
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Batten plate width.
5 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

6 Batten plate edge distance from the part edge.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Welds

Click the link below to find out more:

Tapered column (136)
Tapered column (136) creates a transition plate between different size
columns. The transition plates can either be tapered or straight.

Objects created

• Diaphragm plates (penetrating and inner)

• Transition plates
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Use for

Situation Description
Penetrating and inner diaphragm
plates, and a tapered section are
created.

Selection order

1. Select the main part (lower part).

2. Select the secondary part (upper part).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Penetrating diaphragm
2 Inner diaphragm
3 Transition plate (tapered)
4 Transition plate (straight)
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Picture tab
The Picture tab illustrates the elevation to which all of the parts created by the
connection are relative to.

Parameters tab
Use the Parameters tab to define the type of transition columns used in the
connection. The short sections of columns can be created of rolled tubes or
built up from plates.

Parts

Option Description
Penetrating diaphragm, Inner
diaphragm

Define the thickness on the
Diaphragm tab.

Tapered section Thickness of the section.
Buildup section Thickness of the section.
Upper rolled col Select the profile from the profile

catalog.
Lower rolled col Select the profile from the profile

catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Tapered section position

Option Description
Default

Tapered section is in the upper
location.

AutoDefaults can change this option.

Tapered section is not created.

Tapered section is in the upper
location.

Tapered section is in the lower
location.

Straight short column type

Option Description
Default

Short straight column is created using
the defined rolled profile.

AutoDefaults can change this option.
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Option Description
Short straight column is created using
the defined rolled profile.

Short straight column is created using
the defined built-up plate.

Solid weld cut

Solid weld cut creates beveled cuts for groove welds in the built-up and
tapered column plate edges.

Option Description
Default

Beveled edge cuts are not created.

AutoDefaults can change this option.

Beveled edge cuts are created.

Beveled edge cuts are not created.

Diaphragm tab
Use the Diaphragm tab to set the number, position and type of the
diaphragm plates created in the connection.

Option Description Default
t Diaphragm plate

thickness.
No default

Enter a plate thickness
to create the diaphragm
plate.
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Option Description Default
Level Relative distance from

the elevation level
shown on the Picture
tab.

Enter a plus or minus
dimension to locate the
desired diaphragm.

Depth Position of the
diaphragm in relation to
the value entered in the
Level box.

 

Offset Diaphragm plate offset
from the value entered
in the Level box.

0"

Diaphragm Diaphragm type.  
Bevel cut Position of the bevel cut

on the diaphragm plate.
 

Penetrating diaphragm
Use the Penetrating diaphragm tab to control the size and shape of the
diaphragm plate. You can also add holes to the plate and set the root distance
from the diaphragm to the column.

Welding gap

 Description Default
1 Welding gap to the upper column.

Distance from the column to the diaphragm
plate.

0"

2 Welding gap to the tower column.

Distance from the column to the diaphragm
plate.

0"
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Dimensions

 Description Default
1 Diaphragm plate edge distance outside of the

face of column.
1"

2 Diameter of the center hole in the diaphragm
plate.

13/16"

3 Diameter of corner holes created in each corner
of the diaphragm plate.

To create corner holes you must enter a value.

 

4 Position of the corner holes in relation to the face
of column.

1"3/16

Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer
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Chamfer dimensions

 Description
1 Vertical chamfer dimension.
2 Horizontal chamfer dimension.

Inner diaphragm
Use the Inner diaphragm tab to control the size of the diaphragm plate. You
can also add holes to the plate and chamfer the corners.

Dimensions

 Description Default
1 Weld gap

Distance from the inside face of the column
to the diaphragm plate.

 

2 Diameter of the center hole in the
diaphragm plate.

13/16"

3 Diameter of the corner holes created in each
corner of the diaphragm plate.

To create corner holes you must enter a
value.

 

4 Position of the corner holes in relation to the
edge of the inner diaphragm plate.

1"3/16

Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.
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Option Description
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Chamfer dimensions

 Description
1 Vertical chamfer dimension.
2 Horizontal chamfer dimension.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Tapered beam to tapered column (197)
Tapered beam to tapered column (197) creates a connection between a
tapered beam and a tapered column.

Objects created

• End plates (column top, beam flange)

• Stiffeners (2 or 4)

• Bolts

• Welds

Use for

Situation Description
Connection is created using two stiffeners, and
flange and column plates. Plates are connected with
four bolts, but you can use any number of bolts.

Connection is created using four stiffeners and a
column end plate. A separate plate for the beam
flange is not created.

Before you start

• Create a tapered beam.

• Create a tapered column.

Selection order

1. Select the flange of the main part (beam).

2. Select the web of the secondary part (column).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Description
1 Column end plate
2 Beam flange end plate
3 Stiffener

Picture tab
Use Picture tab to define the dimensions of end plates and stiffeners, and the
location of stiffeners.

Dimensions

 Description
1 Beam end plate edge distance to the stiffener edge.
2 Distance between the stiffeners.
3 Stiffener dimension from the beam web.
4 Column end plate edge distance to the beam end plate edge.
5 Column end plate edge distance to the column edge.
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Parts tab
Use the Parts tab to define the properties of the column end plate, the beam
end plate, and the stiffeners.

Parts

Option Description
Beam plate Thickness and width of the beam

plate.
Column plate Thickness and width of the column

plate.
Stiffener Thickness and width of the stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the plate and stiffener positions and
orientation.

Plates

Option Description
End plate is created at the column
end.

End plated is created at the column
end and beam flange.
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Stiffeners

Option Description
One stiffener is created.

Two stiffeners are created.

Column flange fit

Option Description
Column flange is fitted to be level with the end plate.

Column flange is perpendicular to the column axis.

Stiffener orientation

Option Description
Stiffener is parallel to the main part.

Stiffener is perpedicular to the beam.

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions
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 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

 Description
1 Vertical dimension of slotted hole.
2 Horizontal dimension of slotted hole.
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Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Tapered column to tapered beam (199)
Tapered column to tapered beam (199) creates a connection between a
tapered column and a tapered beam. All parts are optional.

Objects created

• End plates (column top, beam flange)

• Web stiffeners (8)

• Triangular beam flange stiffener
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• Triangular flange stiffeners (2)

• Beam web stiffeners (2)

• Bolts

• Welds

Use for

Situation Description
Connection is created using all possible parts.

Plates are connected using four bolts, but you can
use any number of bolts.

1 Beam flange stiffener

2 Beam web stiffeners

3 Web stiffeners

4 End plates

5 Flange stiffeners

Before you start

• Create a tapered beam.

• Create a tapered column.

Selection order

1. Select the web of the main part (beam).

2. Select the web of the secondary part (column).

The connection is created automatically when the secondary part is
selected.

Part identification key
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 Description
1 Beam end plate
2 Column end plate
3 Web stiffeners
4 Beam web stiffener
5 Beam flange stiffener
6 Flange stiffener

Picture tab
Use the Picture tab to define the dimensions of end plates and stiffeners, and
the location of stiffeners.

Dimensions

 Description
1 Web stiffener dimension from the end plate.
2 End plate edge dimension from the secondary part edge.
3 Stiffener edge dimension from the secondary part edge.

Parts tab
Use the Parts tab to define the properties of the column plate, beam plate,
and stiffeners. Set the part thickness to 0 to omit a part.

Parts

Option Description
End plate Thickness and width of the end plate.
Web stiffener Thickness and width of the web

stiffener.
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Option Description
Flange stiffener Thickness of the flange stiffener.
Beam flange stiff Thickness of the beam flange

stiffener.
Beam web stiff Thickness and width of the beam web

stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define whether the column flange and the corner
are fitted, and the stiffener chamfer dimensions.

Stiffener chamfer dimensions

 Description
1 Vertical chamfer dimension.
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 Description
2 Horizontal chamfer dimension.

Column flange fit

Option Description
Column flange fitted to be level with the end plate.

Column flange is perpendicular to the column axis.

Corner fitting

Option Description
Corner is fitted.

Corner is not fitted.

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolts group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Number of bolts.
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 Description
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts, enter
2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

 Description
1 Vertical dimension of slotted hole.
2 Horizontal dimension of slotted hole.

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

Steel components 2249 Built-up Components



To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Tapered beam to beam (200)
Tapered beam to beam (200) creates a connection between tapered beams.

Objects created

• End plates (2)

• Flange stiffeners (4) (optional)

• Web stiffeners (8) (optional)

• Bolts

• Welds
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Use for

Situation Description
All stiffeners and end plates
are created.

Plates are connected with
eight bolts, but you can use
any number of bolts.

Before you start

Create two tapered beams.

Selection order

1. Select the web of the main part (first beam).

2. Select the web of the secondary part (second beam).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 End plates
2 Web stiffeners
3 Flange stiffeners
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Picture tab
Use the Picture tab to define the dimensions of the end plates and stiffeners,
the location of the stiffeners, and whether the beam flange is fitted.

Dimensions

 Description
1 Horizontal dimension of the flange stiffener.
2 Vertical dimension of the flange stiffener.
3 Top web stiffener edge distance to the beam flange.
4 Bottom web stiffener edge distance to the beam flange.
5 End plate dimension from the beam edge.
6 Web stiffener dimension from the end plate.

Web stiffeners

Option Description
Default

Top and bottom web stiffeners are
created.

AutoDefaults can change this option.

Top and bottom web stiffeners are
created.
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Option Description
Top web stiffeners are created.

Bottom web stiffeners are created.

Web stiffeners are not created.

Beam flange

Option Description
Default

Beam flanges are perpendicular to the beam axis.

AutoDefaults can change this option.
Beam flanges are fitted to be level with the end plates.

Beam flanges are perpendicular to the beam axis.

Parts tab
Use the Parts tab to define the properties of end plates, web stiffeners, and
flange stiffeners. Set the part thickness to 0 to omit a part.

Parts

Option Description
End plate Thickness and width of the end plate.
Web stiffener Thickness and width of the web

stiffener.
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Option Description
Flange stiffener Thickness of the flange stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Chamfer tab
Use the Chamfer tab to define the flange and web stiffener shape, type, and
dimensions.

Flange stiffener

Option Description
Default

Bevel, chamfered corner

AutoDefaults can change this option.
Bevel, chamfered corner

Square, one chamfered corner

Square, two chamfered corners

Steel components 2254 Built-up Components



Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Chamfer dimensions

You can define the chamfer dimensions for both web and flange stiffeners.

 Description
1 Horizontal chamfer dimension.
2 Vertical chamfer dimension.

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.
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Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Tapered column base plate (1068)
Tapered column base plate (1068) creates a base plate detail to a tapered
column.

Parts created

• End plate

• Web stiffeners (4)

• Flange stiffeners (2) (optional)

• Anchor rods

• Extra plates connecting the anchor rods

• Bolts

• Welds
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Use for

Situation Example
The detail uses four
web stiffeners.
Flange stiffeners are
not created.

The end plate is
connected using
four bolts, but you
can use any number.

The detail uses four
web stiffeners and
two flange stiffeners.

Before you start

Create a tapered column.

Selection order

1. Select the tapered column.

2. Pick a point to indicate the location of base plate.

Part identification key

 Description
1 End plate
2 Web stiffener
3 Flange stiffener

Picture tab
Use the Picture tab to define the dimensions of the base plate and stiffeners,
the location of web stiffeners, and whether the column flange is fitted.
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Dimensions

 Description
1 End plate edge distance to the column flange.
2 Web stiffener edge distance.
3 Flange stiffener height.
4 Flange stiffener width.
5 Web stiffener height.

Flange stiffener shape

Option Description
Default

Line shape

AutoDefaults can change this option.
Line shape

Square shape

No stiffener

Flange cut
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 Description Default
1 Define the flange cut from the base plate

edge.
2 mm

Flange stiffener chamfer dimensions

 Description
1 Horizontal chamfer dimension.
2 Vertical chamfer dimension.

Flange stiffener chamfer type

Option Description
Default

No chamfers

AutoDefaults can change this option.
No chamfers

Line chamfer

Convex arc chamfer

Concave arc chamfer
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Column flange

Option Description
Column flange fitted to be level with the
base plate.

Column flange is perpendicular to
column axis.

End plate offset

 Description
1 End plate offset from the main part bottom edge.

Parts tab
Use the Parts tab to define the properties of the end plate, web stiffeners, and
flange stiffeners.

Parts

Option Description
End plate Thickness and width of the end plate.
Web stiffener Thickness and width of the web

stiffener.
Flange stiffener Thickness of the flange stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
Material Material grade. The default material is

defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Bolts tab
Use the Bolts tab to define the bolt properties, number of bolts, and spacing.

Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.
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Option Description Default
Tolerance Gap between the bolt

and the hole.
 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
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Option Description Default
depend on the component in
question.

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Parameters tab
Use the Parameters tab to define a component.

Using additional components

You can use additional system or custom components to modify the column
end or the base plate. For example, you can create special backing plates, weld
preparations, and weld access holes for the column end.

If you use additional system or custom components, you need to manage the
column end or the base plate properties in the additional component in
question. When using several components, there may be multiple welds and
cuts.
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Option Description
Component Select a system or a custom

component from the Applications &
components catalog.

Attributes Select an attribute file for the
component.

Input Define to which parts the selected
component is applied.

• Default is the same as Base +
Column.

• Column sets the column as the
main part. Use this option for
details.

• Column + Base sets the column
as the main part and the base
plate as the secondary part.

• Base + Column sets the base
plate as the main part and the
column as the secondary part.

• Base sets the base plate as the
main part.

Anchor rods tab
Use the Anchor rods tab to define the properties of the rod, nut, washer, cast
plate, and grout.

Anchor rod dimensions

Option Description
Rod profile Anchor rod profile.

You can add a comment about the
part.

Nut profile Nut profile.
Washer profile Washer profile.
Plate washer Plate washer thickness, width and

height.
Cast plate Cast plate thickness, width and

height.
Grout Grout thickness.

Grouting helps you to model columns
to the top of concrete parts and place
the base plate correctly. It also makes
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Option Description
it easier to dimension the detail in GA
drawings.

By default, no grouting is created.

Select whether the grouting is created
with or without slopes above or below
the detail creation point. This also
affects the shim plates.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Base plate with

Select whether to create the base plate with bolts, anchor rods, or a custom
component.

By default, the base plate is created with Bolts.
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Anchor rod dimensions

 Description
1 Size or the length of the nut.
2 Size or the thickness of the washer.
3 Length of the anchor rod.
4 Length of the anchor rod above the base plate.
5 Distance between the cast plate and the base plate.
6 Length of the upper thread.

Anchor rod types

Option Description  
Default

Type 1

AutoDefaults can change
this option.

Type 1

a

Radius of the hook

b

Width of the hook

a = 2*anchor bar
diameter
b = 1/5 of anchor
bar length
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Option Description  
a

Radius of the hook

b

Width of the hook

c

Height of the hook

c = same as width of
the hook

d

Length of the anchor rod
below the extra plate

e

Length of the lower
thread

d = 2*nut size
e = 4*nut size plus
thickness of extra
plate

Hook direction

Option Description
Default

Type 1

AutoDefaults can change this option.
Type 1

Type 2

Type 3

Type 4

Bolting direction

You can define the bolting direction if you have created the base plate with
bolts.
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Option Description
Default

Bolting direction 1

AutoDefaults can change this option.

Bolting direction 1

Bolting direction 2

Cast plate holes tolerance

Option Description Default
Cast plate holes
tolerance

Tolerance of the cast
plate holes.

same as bolt
tolerance

Washer hole tolerance

Option Description
Create hole in washer By default, a hole is not created in the

washer.

Tolerance of the washer hole.

Create assembly from all anchors

Define whether anchors are included in an anchor rod assembly. You can also
include leveling plates into the assembly.

Create
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1 Create the nut profile.
2 Create the washer profile.
3 Create the washer plate.

Anchor rod assembly

Define which parts of the anchor rod are included in the anchor rod assembly.

You can weld the washer plates above and below the base plate.

Extra plates tab
Use the Extra plates tab to to control the placement, rotation, and type of the
profiles (extra profile 1) created at the bottom of each anchor bar and the
profiles (extra profile 2) that connect rows of anchor bars.

Part dimensions

Option Description
Extra profile 1 First extra profile by selecting it from

the profile catalog.
Extra profile 2 Second extra profile by selecting it

from the profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Finish Describes how the part

surface has been
treated.
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Edge distance of extra profile 1

 Description
1 Edge distance of extra profile 1.

Type and direction of extra profile 1

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2
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Option Description
Type 3

Edge distance of extra profile 2

Option Description Default
1 Distance of extra profile

2 from the axis of the
anchor bar.

Half of the nut
size or anchor bar
diameter

Extra profile 2 type

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1
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Option Description
Type 2

Type 3

Type 4

Type 5

Type 6
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Length of extra profile 2

 Description
1 Length of extra profile 2 from the axis of the anchor bar.

Direction of extra profile 2

Option Description
Default

Type 1

AutoDefaults can change this option.

Type 1

Type 2
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Extra profile 1 properties

Option Description Default
Hole tolerance Hole tolerance of extra

profile 1.
Same as bolt
tolerance

Circular profile height Height of circular extra
profile 1.

Profile rotation Profile rotation of extra
profile 1.

Front

Extra profile 2 rotation

Option Description Default
Extra profile 2 rotation Profile rotation of extra

profile 2.
Front

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

PEB Knee joint (S93)
PEB Knee joint (S93) creates a knee connection between a rafter and a
column. The end plate connection can be located horizontally, vertically, or
perpendicular to the rafter.

Objects created

• End plates

• Web stiffener

• Flange stiffeners (2)

• Inner stiffeners (4)

• Outer stiffeners (4)

• Diagonal stiffeners or web plate
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• Bolts

• Welds

Use for

Situation Description
Vertical knee connection with
triangular flange stiffeners,
and inner and outer stiffeners.
Web is strengthened with
diagonal stiffeners.

Horizontal knee connection
with inner and outer
stiffeners. Web is
strengthened with diagonal
stiffeners.

Selection order

1. Select the column.

2. Select the rafter.

3. Click the middle mouse button to create the connection.

Part identification key
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 Description
1 End plate
2 Diagonal stiffener
3 Web plate
4 Web stiffener
5 External stiffener
6 Inner stiffener
7 Knee stiffener
8 Knee end plate
9 Corner lap stiffener

Picture tab
Use the Picture tab to define the dimensions and the connection type.

Connection type

Select how the connection is created:

• Horizontal

• Perpendicular

• Vertical

Create web plate or diagonal stiffener

Option Description
Default

Web plate is created.

AutoDefaults can change this option.

Diagonal stiffener is created.
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Option Description
Web plate is created.

Dimensions

 Description
1 Vertical distance of the diagonal stiffener upper input point

from the secondary part web.
2 Horizontal distance of the diagonal stiffener upper input point

from the secondary part flange.
3 Horizontal distance of the diagonal stiffener lower input point

from the knee stiffener.
4 Knee stiffener edge distance from the secondary part web.
5 Vertical distance of the diagonal stiffener lower input point

from the secondary part web.
6 Horizontal dimension of the corner lap stiffener.
7 Vertical dimension of the corner lap stiffener.

If the corner lap stiffener is not created, this is the knee end
plate dimension from the secondary part flange.
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 Description
8 Horizontal dimension of the external stiffener.
9 Vertical dimension of the external stiffener.
10 Dimension of the end plate extension from the main part web.
11 Web stiffener edge distance from the main part flange.
12 Web stiffener dimension on the main part side.

Chamfer dimensions

 Description
1 Horizontal chamfer dimension
2 Vertical chamfer dimension

Chamfer shape

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex chamfer

Concave chamfer

Parts tab
Use the Parts tab to define the properties of plates and stiffeners.
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Parts

Option Description
End plate Thickness and width of the end plate
Diagonal stiffener Thickness and width of the diagonal

stiffener
Web plate Thickness of the web plate
Web stiffener Thickness and width of the web stiffeners
External stiffener Thickness of the external stiffener
Internal stiffener Thickness, width and height of the internal

stiffener
Knee stiffener Thickness and width of the knee stiffener
Knee end plate Thickness and width of the knee end plate
Corner lap stiffener Thickness of the corner lap stiffener

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Stiffener creation

Option Description
Select whether bevel, square, or no
flange stiffeners are created.

Bevel is the default. AutoDefaults can
change this option.

Select how many web stiffeners are
created, or whether they are created
at all.

Two stiffeners is the default.
AutoDefaults can change this option.
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Option Description
Select whether bevel, square, or no
inner stiffeners are created.

Bevel is the default. AutoDefaults can
change this option.

Stiffener creation

Select how many stiffeners are created, define the shape of the stiffeners, and
the chamfer dimensions.

 Description
1 Define the external stiffeners.
2 Define the inner stiffeners in the corner between the main and

the secondary part.

Chamfer dimensions

 Description
1 Horizontal chamfer dimension
2 Vertical chamfer dimension

Steel components 2283 Built-up Components



Chamfer shape

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex chamfer

Concave chamfer

Bolts tab
Use the Bolts tab to define the bolt properties, number of bolts, and spacing.
You can select whether outer and inner bolts are created.

Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.
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Option Description Default
Slots in Part(s) in which slotted holes

are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Welds

Click the link below to find out more:

2.18 Bracing components
You can use bracing components to automatically create complete bracing
connections. You can also use bracing elements (such as gusset plates and
stiffeners) that you can combine with other components to create your own
bracing connections

See also

Simple gusset plate connections (page 2289)

Corner bracing connections (page 2423)

Windbracing connections (page 2581)
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Bracing connection elements (page 2637)

Glossary of parts
Bracing components create some or all of the following parts:

Part Image
Gusset plate

Connection plate

Cover plate

Tongue plate

A tongue plate
slots into a hollow
profile brace.
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Part Image
Clip angle

Shear tab

Seal plate

Seal plates seal
the ends of
hollow braces. In
this example they
are used with
chamfered
connection
plates.

Tee

Tees are formed
from T or cut I
profiles, or two
plates. Tees seal
hollow braces and
connect them to
another part (e.g.
a gusset plate)
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Part Image
Stiffener

Simple gusset plate connections
Simple gusset plate connections automatically connect braces to a single main
part, using a gusset plate. Braces either connect directly to the gusset plate, or
use connection material. Tekla Structures includes the following simple gusset
plate connections:

Component Image Description
Simple bolt connection
(5) (page 2290)

Creates a bolted
connection between two
steel profiles.

Welded gusset (10)
(page 2295)

Welds braces to a gusset
plate.

Bolted gusset (11)
(page 2303)

Bolts braces to a gusset
plate. Optional clip
angles or shear tabs.

Bracing cross (19)
(page 2328)

Bolts twin-profile braces
to an existing gusset
plate.
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Component Image Description
Tube gusset (20)
(page 1372)

Bolts braces to a gusset
plate using connection
plates and optional
tongue plates. Seals
braces.

Tube crossing (22)
(page 2336)

Bolts braces to an
existing gusset plate
using connection plates
and optional tongue
plates. Seals braces.

Std bracing connection
(67) (page 2348)

Bolts 1 or 2 braces to a
gusset plate using
connection plates. Seals
hollow braces.

Wrapped cross (61)
(page 2356)

Bolts braces to an
existing gusset plate,
using connection plates
and clip angles.

Gusseted cross (62)
(page 2368)

Bolts braces to a gusset
plate using clip angles
and connection plates.
Welds or bolts the
gusset plate to the beam
or column.

Portal bracing (105)
(page 2391)

Connects up to three
hollow braces to a beam,
using a gusset plate and
tees.

Bolted gusset (196)
(page 2401)

Bolts braces to a gusset
plate. Optional clip
angles or shear tabs.

Steel components 2290 Bracing components



Simple bolt connection (5)
Simple bolt connection (5) creates a bolted connection between two steel
profiles.

Objects created

• Bolts

Use for

Situation Description
Bolted connection

Bolted connection, skewed secondary
part

Before you start

Create two steel profiles.
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Selection order

1. Select the main part (first steel profile).

2. Select the secondary part (second steel profile).

The connection is created automatically when you select the secondary
part.

Part identification key

 Description
1 Bolts

Picture tab
Use the Picture tab to define the dimensions and position of the bolts.

Dimensions
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 Description
1 Bolt edge distance from the main part edge.
2 Horizontal bolt distance from the center of the secondary part.
3 Vertical bolt distance from the center of the secondary part.
4 Bolt offset from the line defined by the horizontal bolt distance

(2).
5 Number of bolts.
6 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

7 Horizontal bolt distance from the edge of the secondary part.

Bolts tab
Use the Bolts tab to define the bolt properties.

Basic bolt properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

20 mm
Bolt standard Bolt standard to be used

inside the component.
Available standards are
defined in the bolt
assembly catalog.

7990
Tolerance Gap between the bolt

and the hole.
3 mm

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Assembly type Location where the bolts
should be attached.

Site

Rotation Defines the bolt rotation. Back
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Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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General tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Welded gusset (10)
Welded gusset (10) connects 1 to 10 braces to a beam or column using a
gusset plate that is welded to the web or flange of the beam or column. Braces
are welded to the gusset plate.

Objects created

• Gusset plate

• Seal plates (hollow braces)

• Stiffeners

• Welds

• Cuts

Use for

Situation Description
Brace profile: T

Gusset plate is welded to the column
flange. Braces are welded to the
gusset plate.
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Situation Description
Brace profile: T

Gusset plate is welded to the column
web. Braces are welded to the gusset
plate.

Before you start

Create a beam or a column, and 1 to 10 braces.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Click the middle mouse button to create the component.

Part identification key

 Description
1 Gusset plate
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NOTE Tekla Structures uses values in the joints.def file to create this
component.

Picture tab
Use the Picture tab to define the dimensions that control the position and
shape of the gusset plate.

Gusset plate dimensions

 Description
1 Define the gap distance between the gusset plate edge

and the main part.
2 Define the gusset plate corner angle (in degrees).

This value affects the gusset plate shape.
3 Define the length of the edge of the gusset plate.

This value affects the gusset plate shape.
4 Define the brace length on the gusset plate.
5 Define the distance between the braces.
6 Define the distance between the main part and the brace.

Gusset tab
Use the Gusset tab to define the gusset plate properties.

Gusset plate

Part Description
Gusset Thickness, width and height of the gusset plate.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

NOTE The following examples show only some of the available options. You
will find more options on the Gusset tab.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.

Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Brace position

Option Description
Default

The brace position is not affected.

AutoDefaults can change this option.
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Option Description
The first selected brace is placed
closest to the main part.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.

Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.

Gusset plate chamfer

Define the gusset plate chamfer type and dimensions.

 Description
1 Distance between the gusset plate and the inner flange

of the main part.
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 Description
2 Horizontal distance between the gusset plate edge and

the flange of the main part.
3 Horizontal dimension of the chamfer.
4 Vertical dimension of the chamfer.

Cut size

If the gusset plate runs through the main part, define the size of the cut
created for the gusset plate.

 Description
1 Define the horizontal size of the cut.
2 Define the vertical size of the cut.

Brace conn tab
Use the Brace conn tab to define the seal plate, brace notch and slot
properties.

Seal plate

Part Description
Seal plate Thickness of the seal plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Brace notch

Option Description
Select whether the brace is notched.

1. Vertical notch dimension.

2. Horizontal notch dimension.

3. Notch angle.

Define the plate distance from the brace
outer edge.

Stiffeners tab
Use the Stiffeners tab to define the stiffener properties and dimensions.

Stiffeners

Part Description
Stiffener 1, Stiffener
2

Define the stiffener thickness.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Stiffener length

  
1 Distance between the stiffener edge and the gusset

plate edge.
2 Length of the stiffener.
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Stiffener dimensions

  
1 Width of the stiffener.
2 Length of the stiffener base.
3 Length of the skew part of the stiffener.
4 Distance from the stiffener center line.
5 Vertical distance between the stiffener base and the skew

part.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Bolted gusset (11)
Bolted gusset (11) connects 1 to 10 braces to a beam or column using a
gusset plate, which is bolted or welded to the beam or column. The braces are
bolted to the gusset plate. Clip angles can be created either at the ends of the
braces, or on each side.
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Objects created

• Gusset plate

• Clip angles or shear tabs (optional) that connect the gusset plate to the
beam or column

• Clip angles (optional) that connect the brace to the gusset plate

• Connection plates

• Seal plates (hollow braces)

• Stiffeners (optional)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Brace profile: RHS

Gusset plate is bolted to the beam flange
using a clip angle. Braces are slotted around
the gusset plate and attached to it using bolts
and clip angles.

Brace profile: Tube

Gusset plate is welded to the beam web.
Brace is notched around the gusset plate and
pinned to it.

Brace profile: T

Gusset plate is welded to the beam flange.
Brace is bolted to the gusset plate.

Steel components 2304 Bracing components



Situation Description
Brace profile: L

Gusset plate is welded to the column flange.
Brace is bolted to the gusset plate.

Before you start

Create a beam or column, and 1 to 10 braces.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Click the middle mouse button to create the component.

Part identification key

 Description
1 Gusset plate
2 Clip angle
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NOTE Tekla Structures uses values in the joints.def file to create this
component.

Picture tab
Use the Picture tab to define the dimensions that control the position and
shape of the gusset plate.

Dimensions

 Description
1 Define the gap distance between the gusset plate edge and

the main part.
2 Define the gusset plate corner angle (in degrees).

This value affects the gusset plate shape.
3 Define the length of the edge of the gusset plate.

This value affects the gusset plate shape.
4 Define the distance between the braces.
5 Define the distance between the main part and the brace.
6 Define the distance between the clip angle or connection

plate edge and the gusset plate edge.

NOTE The following examples show only some of the available options. You
will find more options on the Picture tab.

Gusset plate positioning

Define how the gusset plate is positioned when a base plate is used.
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Option Description
Default

Gusset plate is parallel to the main
part.

AutoDefaults can change this option.
Gusset plate is parallel to the brace.

Gusset plate dimensions

Option Description
Default

Gusset plate does not run through
the main part.

Define the gusset plate cut
dimension.

AutoDefaults can change this option.
Gusset plate does not run through
the main part.

Define the gusset plate cut
dimension.

Gusset plate runs through the main
part.

Define the gusset plate extension
dimension.

Gusset tab
Use the Gusset tab to control the gusset plate properties, shape and position,
and clip angle properties and orientation.

Plates

Option Description
Gusset Thickness, width and height of the gusset plate.
Connection
plates

Thickness and width of the connection plate.

L profile Select the clip angle profile from the profile catalog.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

NOTE The following examples show only some of the available options. You
will find more options on the Gusset tab.

Gusset plate connection

Define how the gusset plate is connected to the main part.

Option Description
Default

Gusset plate is welded directly to the
main part.

AutoDefaults can change this option.
Gusset plate is connected to the main
part with clip angles.

Select to which side of the gusset
plate the clip angles are created.
Gusset plate is connected to the main
part with a connection plate.

Select to which side of the gusset
plate the connection plate is created.

Clip angle orientation

Define how the clip angle is placed on the connection.
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Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.

Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Brace position

Option Description
Default

The brace position is not affected.

AutoDefaults can change this option.

The first selected brace is placed
closest to the main part.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.
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Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.

Gusset plate position on the column or beam

Option Description
Select the gusset position.

The default option is parallel to the
brace.

Gusset plate chamfer

Define the gusset plate chamfer type and dimensions, and the angle limit for
parallel bracing.
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 Description
1 Distance between the connection plate and the inner

flange of the main part.
2 Horizontal distance between the gusset plate edge and

the flange of the main part.
3 Horizontal dimension of the chamfer.

By default, the second chamfer is not created.
4 Vertical dimension of the chamfer.

By default, the second chamfer is not created.

Cut size

If the gusset plate runs through the main part, define the size of the cut
created for the gusset plate.

 Description
1 Define the horizontal size of the cut.
2 Define the vertical size of the cut.
3 Define the radius of the round cut.
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Brace conn
Use the Brace conn tab to define the seal plate, brace notch and slot
properties.

Seal plate

Part Description
Seal plate Thickness of the seal plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Brace notch

Option Description
Select whether the brace is notched.

You may want to notch the brace if
the plate collides with the brace
flange or if you want to create slots in
the hollow braces.

The last option creates a notch and
fastens the plate to the brace by using
a bolt.
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Option Description
1. Vertical notch dimension.

2. Horizontal notch dimension.

3. Notch angle.

Select the brace notch shape.

Define the radius for the round
shape.

Define the plate distance from the
brace outer edge.

Select whether to create bevel cuts at
the brace ends or whether to create a
square brace end.

Stiffeners tab
Use the Stiffeners tab to define the stiffener properties and dimensions.

Parts

Part Description
Stiffener 1, Stiffener 2 Thickness of the stiffener.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Stiffener length

  
1 Define the distance between the stiffener edge and the

gusset plate edge.
2 Define the length of stiffener.
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Stiffener dimensions

  
1 Define the width of the stiffener.
2 Define the length of the stiffener base.
3 Define the length of the skew part of the stiffener.
4 Define the distance from the stiffener center line.
5 Define the vertical distance between the stiffener base

and the skew part.

Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Chamfer dimensions
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 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

Gusset bolts tab
Use the Gusset bolts tab to control the bolt group properties for bolts that
connect the gusset plate to the main part, and to control the clip angle
attachment.

Bolt group dimensions on gusset plate

  
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt
to the edge of the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a
value for each space between bolts. For example, if
there are 3 bolts, enter 2 values.

4 Dimension for vertical bolt group position.
5 Select how to measure the dimensions for vertical bolt

group position.
6 Dimension for horizontal bolt group position.
7 Select how to measure the dimensions for horizontal

bolt group position.
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 Description
1 Location where the bolts should be attached.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

Bolt group position

Gusset horizontal position and offset options only affect the following
situation, where the gusset is connected to the column flange. When the
position is middle, the bolt group offset is calculated from the center line of
the column, for example.

Gusset vertical position and offset options affect the bolt group connecting the
gusset directly to the flange and also the bolt groups connecting the gusset to
the clip angle or connection plate.

NOTE The following examples show only some of the available options. You
will find more options on the Gusset bolts tab.

Clip angle attachment type

Define how the clip angle is attached to the gusset plate and to the main part.
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Option Description
Default

Both parts are bolted.

AutoDefaults can change this option.
Automatic

When the main part is a tube profile, the clip angles
are welded to the main part and bolted to the
secondary part. Otherwise the clip angles are bolted to
both parts.
Main part is bolted and secondary part is welded.

Main part is welded and secondary is part bolted.

Both parts are bolted.

Both parts are welded.

Bolts on gusset plate

Define whether the gusset plate is connected to the main part with bolts when
no clip angles are used.

Option Description
Default

Bolts are not created in the gusset plate.

AutoDefaults can change this option.
Bolts are created in the gusset plate.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered
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Option Description
Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Steel components 2320 Bracing components



Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Bolting direction 2

Brace bolts 1 / Brace bolts 2 / Brace bolts 3 tab
Use the Brace bolts 1, Brace bolts 2 and Brace bolts 3 tabs to control the
bolts that connect the first, the second, and the subsequent braces to the
gusset plate.

Bolt group dimensions
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 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a
value for each space between bolts. For example, if there
are 3 bolts, enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

4 Select how to measure the dimensions for vertical bolt
group position.

5 Dimension for vertical bolt group position.
6 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and
separate the numbers with a space. Bolt numbers run
from left to right and from top to bottom.

Bolt distance

Define the minimum distance from the connection plate bolts to the
intersection point of the main part and brace center lines. If a brace is
perpendicular to the main part, the distance is measured from the main part
center line to the nearest bolts.

Option Option Option
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Bolting direction 2

Angle bolts tab
Use the Angle bolts tab to control the bolts that connect the clip angles.

Part

Option Description
L profile Select the clip angle profile from the profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

Steel components 2326 Bracing components



 Description
4 Define the edge distance between the clip angle and the

brace.
5 Select how to measure the dimensions for vertical bolt group

position.
6 Dimension for vertical bolt group position.

Clip angle position

Option Description
Select the clip angle position.

Bolting direction

Option Description
Default

Bolting direction 1

AutoDefaults can change this option.
Bolting direction 1

Bolting direction 2

General tab

Click the link below to find out more:

General tab
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Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Bracing cross (19)
Bracing cross (19) bolts one or more twin-profile braces to an existing gusset
plate.

TIP To create a gusset plate, use the Standard gusset (1065) (page 1911)
component, or create a countour plate.

Objects created

• Bolts

• Cuts

• Welds

Use for

Situation Description
Brace profile: L

Braces are bolted directly to the
gusset plate.
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Situation Description
Brace profile: W

Braces are notched around the gusset
plate and bolted to the gusset plate.

Before you start

Create a gusset plate, and 1 to 10 braces.

Selection order

1. Select the main part (gusset plate).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Click the middle mouse button to create the component.

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Picture tab
Use the Picture tab define the flange cut dimension.

 Description
1 Define the length of the flange cut.
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Parameters tab
Use the Parameters tab to cut the brace flange.

Option Description
Fit secondary Select whether the secondary part is

fitted.

Selecting Yes fits the secondary part
according to the bolt distances.

Cut other side flanges Select whether to create a triangular
cut on the opposite side of the flange.

1. Vertical cut dimension.

2. Cut angle.

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
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 Description
2 Select how to measure the dimensions for horizontal bolt

group position.

• Left: From the left edge of the secondary part to the
leftmost bolt.

• Middle: From the center line of the secondary part to the
center line of the bolts.
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 Description
• Right: From the right edge of the secondary part to the

rightmost bolt.

3 Bolt edge distance.
4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

6 Dimension for vertical bolt group position.
7 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.
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 Description
• Middle: From the center line of the bolts to the center line

of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

General tab

Click the link below to find out more:

General tab
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Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Tube crossing (22)
Tube crossing (22) bolts one or more braces to an existing gusset plate,
directly, or using connection plates. Seals braces.

To create a gusset plate, use the Standard gusset (1065) (page 1911)
component or the command for creating a contour plate.

Objects created

• Connection plates

• End plates

• Tongue plates

• Cover plates

• Bolts

• Welds

Use for

Situation Description
Brace profile: RHS, W

RHS brace is bolted to the gusset
plate using a tongue plate. W profile
braces are bolted directly to the
gusset plate.
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Before you start

Create a gusset plate, and 1 to 10 braces.

Selection order

1. Select the main part (gusset plate).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Click the middle mouse button to create the connection.

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Part identification key

 Description
1 Connection plate
2 End plate

Picture tab
Use the Picture tab to define the plate and brace dimensions.
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Dimensions

 Description
1 Define the length of the edge of the connection plate.
2 Define the brace length on the connection plate.

To prevent the connection plate from penetrating the hollow
brace, enter a negative value for the dimension.

3 Define the end plate edge distance from the gusset plate.

Brace conn tab
Use the Brace conn tab to control the connection plate, end plate, tongue
plate, and cover plate properties.

Brace connection

Option Description
Connection plate Thickness, width and height of the

connection plate.
End plates Thickness, width and height of the end

plate.
Middle end plate Thickness and height of the middle end

plate.
Tongue plate Thickness of the tongue plate.
Cover plate Thickness, width and height of the cover

plate.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Brace connection types

Define how the brace is connected to the connection plate.

Option Descripion
Default

Brace is welded

AutoDefaults can change this option.
Brace is welded.

Brace is bolted.

Brace is welded and notched around
the nuts.

Tongue plate and cover plate are
created.

Cut in bracing

If needed, you can create a cut in the bracing.
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Define the width of the cut in the bracing, where t is the thickness of the
connection plate.

Define the length of the cut in the bracing from the edge of the connection
plate.

Gusset and connection plate distance

Define the distance between the gusset plate and the connection plate.

Round cut in bracing

If needed, you can create a round cut in the bracing. Enter the radius value.

NOTE The following examples show only some of the available options. You
will find more options on the Brace conn tab.

Connection plate

Define whether the brace is notched or the connection plate cut when the
connection plate is connected to the brace.

Option Description
Default

Brace is notched.

AutoDefaults can change this option.
Connection plate is cut.

Connection plate is cut, but the part
of the connection plate created inside
the bracing is not deleted.
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Option Description
If you cut the connection plate, you
can define the size of the gap
between the brace and the
connection plate.

Number of connection plates

Define whether one or two connection plates are used for connecting the
brace to the gusset plate.

Option Description
Default

One connection plate.

AutoDefaults can change this option.
Two connection plates and a middle
end plate at the ends of the
connection plates.
If a middle end plate is created, you
can define the width of the end plate.

Select the middle end plate position.

Connection plate chamfer

Define whether the connection plate is chamfered.

Option Description
Default

No chamfers are created.

AutoDefaults can change this option.
Chamfers are created.

If you create chamfers, define the
vertical and horizontal chamfer
dimensions.

End plates

If you use the end plates to seal the braces, define the end plate shape and
dimensions.
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Option Description
Default

Square end plate.

AutoDefaults can change this option.
Round end plate.

End plate edge distance from the
brace outer edge.

End plate chamfer

Define the end plate chamfer type and horizontal and vertical dimensions.

Brace bolts 1 tab
Use the Brace bolts 1 tab to control the bolts that connect the braces to the
gusset plate.
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Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

4 Select how to measure the dimensions for vertical bolt
group position.

5 Dimension for vertical bolt group position.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Rib plates tab
Use the Rib plates tab to control the cross plate and the cover plate
properties and position.

Plates

Option Description
Cross plate Thickness, width and height of the

cross plate.
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Option Description
Cover plate Thickness, width and height of the

cover plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Bolt group dimensions

  
1 Number of bolts.
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2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Dimension for the horizontal bolt group position.
5 Vertical dimension of the chamfer.
6 Horizontal dimension of the chamfer.

Cross and cover plate position

Option Description
Default

Cover plate is created on both sides
of the cross plate.

AutoDefaults can change this option.
Cover plate is created on both sides
of the cross plate.

Cover plate is created on the bottom
of the cross plate.

Cover plate is created on top of the
cross plate.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab
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Welds

Click the link below to find out more:

Std bracing connection (67)
Std bracing connection (67) connects 1 or 2 braces to a beam or column
using a gusset plate and connection plates. Seals hollow and tube profile
braces. You can define different properties for the upper and lower brace
connections.

Objects created

• Gusset plate

• Connection plates

• Seal plates

• Bolts

• Welds

Use for

Situation Description
Brace profile: RHS

Gusset plate is welded to the column
web. Brace is bolted to the gusset
plate using chamfered connection
plates.

Before you start

Create a beam or column, and 1 or 2 braces.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Click the middle mouse button to create the component.
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Part identification key

 Description
1 Gusset plate
2 Connection plate
3 Seal plate

Picture tab
Use the Picture tab to define the main part edge dimension to the bolt group.

Dimensions

 Description
1 Define the main part edge dimension to the bolt group.
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Parts tab
Use the Parts tab to define the plate properties. You can define the plate
properties for both braces.

Plates

Option Description
Connection plate Thickness, width and height of the

connection plate.
Seal plate Thickness, width and height of the

seal plate.
Seal plate profile Select the seal plate profile from the

profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the gusset plate chamfer dimensions.
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Chamfer dimensions

 Description
1 Horizontal chamfer dimension.
2 Vertical chamfer dimension.

Brace bolts 1 tab
Use the Brace bolts 1 tab to define the bolt properties for the first brace.

Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.
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 Description
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Steel components 2352 Bracing components



Brace bolts 2 tab
Use the Brace bolts 2 tab to define the bolt properties for the second brace.

Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within

Yes
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Option Description Default
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Gusset tab
Use the Gusset tab to define the gusset plate dimensions and properties.

Plate

Part Description
Gusset Thickness, width and height of the

gusset plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Gusset dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

3 Horizontal chamfer dimension.
4 Vertical chamfer dimension.
5 Upper angle of the slotted hole created in the gusset plate.
6 Lower angle of the slotted hole created in the gusset plate.

Gusset plate position

Select the gusset plate position relative to the beam or column web. The
default location is above the beam or column web.

General tab

Click the link below to find out more:

General tab
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Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Wrapped cross (61)
Wrapped cross (61) bolts one or more braces to an existing gusset plate,
using connection plates and clip angles.

Objects created

• Connection plates

• Clip angles

• Shear tabs

• Shim plates

• Bolts

• Welds

Use for

Situation Description
Brace profile: W

Braces are bolted to the gusset plate
using clip angles and connection
plates.

Before you start

Create a gusset plate, and 1 to 10 braces.
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Selection order

1. Select the main part (gusset).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary part (third brace).

5. Click the middle mouse button to create the component.

Part identification key

 Description
1 Connection plate
2 Clip angle

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Picture tab
Use the Picture tab to define the gap dimension between the gusset plate and
the brace.
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 Description
1 Define the dimension between the gusset plate and the brace.

Brace conn tab
Use the Brace conn tab to define the connection plate, clip angle, and filler
plate properties. Select whether twin profiles are used for the angle
connection.

Parts

 Description
Connection plate Thickness and width of the connection plate.
Conn. plate profile Select the connection plate profile from the profile

catalog.
Upper clip angle Select the clip angle profile from the profile catalog.
Lower clip angle Select the clip angle profile from the profile catalog.
Filler plate Thickness of the filler plate.
Upper shear tab Thickness, width, and height of the upper shear tab.
Lower shear tab Height of the lower shear tab.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Plate creation

Option Description
Select whether one or two connection
plates are created between the brace
web and the gusset plate.

Select whether a filler plate is created
between the connection plate and the
brace web.

The default is that a filler plate is not
created.

Clip angle creation

Define whether the braces are attached to the gusset plate using clip angles or
shear tabs, and specify the number of clip angles to create. The default option
is to create two clip angles below the brace web.
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Clip angle orientation

Define how the clip angle is placed on the connection.

Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.

Connection type

Option Description
Select the connection type (weld or
bolts) between the gusset plate and
the connection plate.
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Option Description
Select the connection type (weld or
bolt) between the gusset plate and
the L profile.

Connection plate gap dimensions

 Description
1 Horizontal gap dimension
2 Vertical gap dimension

Shim plates tab
Use the Shim plates tab to define shim plate properties.

Plates

Option Description
Shim plate 1, Shim plate 2,
Shim plate 3

Thickness, width and height of the shim plates.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shim plate position and number

You can create shim plates when connecting braces to the gusset plate using
clip angles.

 De
1 Define the gap between the brace and connection plate.
2 Define how many shim plates are created at the top and

bottom flanges.

Enter the shim plate profile numbers: 1, 2 or 3. These are the
numbers that are on the upper part on the Shim plates tab.

For example, if you want to create three shim plates at the
top flange, and you want to use Shim plate 1 twice and Shim
plate 2 once, enter 1 1 2. The first number you enter is the
shim plate closest to the brace flange.

Brace bolts tab
Use the Brace bolts tab to control the bolts that connect the braces to the
gusset plate.

Bolt group dimensions
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 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Dimension for vertical bolt group position.
5 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center
line of the secondary part.
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 Description
• Below: From the lower edge of the secondary part to the

lowest bolt.

6 Select the bolt type.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Angle bolts tab
Use the Angle bolts tab to control the bolts that connect the clip angles.

Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Dimension for vertical bolt group position.
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Vertical bolt position

Option Description
Bolt position from the L profile edge.

Bolt position from the secondary part
center line.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Steel components 2367 Bracing components



Welds

Click the link below to find out more:

Create welds

Gusseted cross (62)
Gusseted cross bolts 1 to 10 braces to a beam or column using a gusset plate.
The gusset plate is welded or bolted to the beam or column. Braces are bolted
to the gusset plate using clip angles and connection plates.

Objects created

• Gusset plate

• Clip angles

• Connection plates

• Filler plates

• Shim plates

• Stiffeners

• Bolts

• Cuts

• Welds

Use for

Situation Description
Brace profile: W

Gusset plate is welded to the beam.
Different connection materials are
used for each brace.
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Situation Description
Brace profile: W

Gusset plate is welded to the beam.
Braces are bolted to the gusset plate
using connection plates and clip
angles.

Brace profile: W

Gusset plate is welded to the beam.
Different connection materials are
used for each brace.

Before you start

Create a beam or column, and 1 to 10 braces.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Click the middle mouse button to create the component.
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Part identification key

 Description
1 Gusset plate
2 Connection plate
3 Clip angle

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Picture tab
Use the Picture tab to define the dimensions that control the position and
shape of the gusset plate.
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Dimensions

 Description
1 Define the gap distance between the gusset plate edge and

the main part.
2 Define the gusset plate corner angle (in degrees).

This value affects the gusset plate shape.
3 Define the length of the edge of the gusset plate.

This value affects the gusset plate shape.
4 Define the distance between the braces.
5 Define the distance between the main part and the brace.
6 Define the distance between the clip angle or connection

plate edge and the gusset plate edge.
7 Define the gap distance between the gusset plate edge and

the brace.

NOTE The following examples show only some of the available options. You
will find more options on the Picture tab.

Gusset plate positioning

Define how the gusset plate is positioned when a base plate is used.
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Option Description
Default

Gusset plate is parallel to the main part.

AutoDefaults can change this option.
Gusset plate is parallel to the brace.

Gusset plate is parallel to the brace, without a
base plate.

Gusset plate dimensions

Option Description
Default

Gusset plate does not run through
the main part.

Define the gusset plate cut
dimension.

AutoDefaults can change this option.
Gusset plate does not run through
the main part.

Define the gusset plate cut
dimension.

Gusset plate runs through the main
part.

Define the gusset plate extension
dimension.

Gusset tab
Use the Gusset tab to control the gusset plate properties, shape and position,
connection plate, and clip angle properties and orientation.

Plates

Option Description
Gusset Thickness, width and height of the gusset plate.
Connection plates Thickness and width of the connection plate.
L profile Select the clip angle profile from the profile catalog.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

NOTE The following examples show only some of the available options. You
will find more options on the Gusset tab.

Gusset plate connection

Define how the gusset plate is connected to the main part.

Option Description
Default

Gusset plate is welded directly to the
main part.

AutoDefaults can change this option.
Gusset plate is connected to the main
part with clip angles.

Select to which side of the gusset
plate the clip angles are created.
Gusset plate is connected to the main
part with a connection plate.

Select to which side of the gusset
plate the connection plate is created.

Clip angle orientation

Define how the clip angle is placed on the connection.
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Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.

Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Brace position

Option Description
Default

The brace position is not affected.

AutoDefaults can change this option.

The first selected brace is placed
closest to the main part.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.
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Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.

Gusset plate chamfer

Define the gusset plate chamfer type and dimensions, and the angle limit for
parallel bracing.

  
1 Distance between the connection plate and the inner flange of

the main part.
2 Horizontal distance between the gusset plate edge and the

flange of the main part.
3 Horizontal dimension of the chamfer.

By default, the second chamfer is not created.
4 Vertical dimension of the chamfer.

By default, the second chamfer is not created.
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Cut size

If the gusset plate runs through the main part, define the size of the cut
created for the gusset plate.

 Description
1 Define the horizontal size of the cut.
2 Define the vertical size of the cut.
3 Define the radius of the round cut.

Brace conn tab
Use the Brace conn tab to define the connection plate, clip angle, and filler
plate properties. Select whether twin profiles are used for the angle
connection.

Parts

Part Description
Connect plate Thickness and width of the

connection plate.
Connection profile Select the profile from the profile

catalog.
L prof1 to gus. pl., L prof2 to gus.pl. Select the clip angle profile from the

profile catalog.
Filler plate Thickness and height of the filler

plate.
Plate1 to gus.pl Thickness, width and height of the

plate.
Plate2 to gus.pl Height of the plate.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Plate creation

Option Description
Select whether one or two connection
plates are created between the brace web
and the gusset plate.

Select whether a filler plate is created
between the connection plate and the
brace web.

The default is that a filler plate is not
created.

Steel components 2377 Bracing components



Option Description
Select the filler plate creation side.

You can use this option when you have
selected to create two connection plates.

Clip angle creation

Define whether the braces are attached to the gusset plate using clip angles or
shear tabs, and specify the number of clip angles to create. The default option
is to create two clip angles below the brace web.

Clip angle orientation

Define how the clip angle is placed on the connection.

Steel components 2378 Bracing components



Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.

Connection type

Option Description
Select the connection type (weld or
bolts) between the gusset plate and
the connection plate.

Select the connection type (weld or
bolt) between the gusset plate and
the L profile.

Connection plate gap dimensions

 Description
1 Horizontal gap dimension
2 Vertical gap dimension
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Shim plates tab
Use the Shim plates tab to define shim plate properties.

Plates

Option Description
Shim plate 1, Shim plate 2, Shim
plate 3

Thickness, width and height of the
shim plates.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shim plate position and number

You can create shim plates when connecting braces to the gusset plate using
clip angles.

 Description
1 Define the gap between the brace and connection plate.
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 Description
2 Define how many shim plates are created at the top and

bottom flanges.

Enter the shim plate profile numbers: 1, 2 or 3. These are the
numbers that are on the upper part on the Shim plates tab.

For example, if you want to create three shim plates at the
top flange, and you want to use Shim plate 1 twice and Shim
plate 2 once, enter 1 1 2. The first number you enter is the
shim plate closest to the brace flange.

Gusset conn tab
Use the Gusset conn tab to control the bolt group properties for bolts that
connect the gusset plate to the main part, and to control the clip angle
attachment.

Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

4 Dimension for vertical bolt group position.
5 Select how to measure the dimensions for vertical bolt group

position.
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 Description
6 Dimension for horizontal bolt group position.
7 Select how to measure the dimensions for horizontal bolt

group position.

 Description
1 Location where the bolts should be attached.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

Clip angle attachment type

Define how the clip angle is attached to the gusset plate and to the main part.

Option Description
Default

Main part is bolted and secondary part is
welded.

AutoDefaults can change this option.
Automatic

When the main part is a tube profile, the clip
angles are welded to the main part and bolted
to the secondary part. Otherwise the clip
angles are bolted to both parts.
Main part is bolted and secondary part is
welded.

Main part is welded and secondary is part
bolted.
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Option Description
Both parts are bolted.

Both parts are welded.

Bolts on gusset plate

Define whether the gusset plate is connected to the main part with bolts when
no clip angles are used.

 Description
Default

Bolts are not created in the gusset plate.

AutoDefaults can change this option.
Bolts are created in the gusset plate.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Steel components 2383 Bracing components



Option Description Default
Bolt standard Bolt standard to be used

inside the component.
Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.
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If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Stiffeners tab
Use the Stiffeners tab to define the stiffener properties and dimensions.

Parts

Part Description
Stiffener 1, Stiffener 2 Thickness of the stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Stiffener length

  
1 Define the distance between the stiffener edge and the

gusset plate edge.
2 Define the length of stiffener.

Stiffener dimensions

 Description
1 Define the width of the stiffener.
2 Define the length of the stiffener base.
3 Define the length of the skew part of the stiffener.
4 Define the distance from the stiffener center line.
5 Define the vertical distance between the stiffener base and

the skew part.
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Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

Brace bolts 1 / Brace bolts 2 / Brace bolts 3 tab
Use the Brace bolts 1, Brace bolts 2 and Brace bolts 3 tabs to control the
bolts that connect the first, the second, and the subsequent braces to the
gusset plate.

Bolt group dimensions
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 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Dimension for vertical bolt group position.
5 Select how to measure the dimensions for vertical bolt group

position.
6 Select the bolt type.

Vertical bolt position

Option Description
Bolt position from the L profile edge.

Bolt position from the secondary part
center line.

Bolt distance

Define the minimum distance from the connection plate bolts to the
intersection point of the main part and brace center lines. If a brace is
perpendicular to the main part, the distance is measured from the main part
center line to the nearest bolts.
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Option Option Option

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab
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Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Portal bracing (105)
Portal bracing (105) connects up to 3 hollow braces to a beam or column
using a gusset plate and tees.

Objects created

• Gusset plate

• Tees

• Bolts

• Welds

Use for

Situation Description
Brace profile: Tube

Gusset plate is welded to the beam.
Braces are bolted to the gusset plate
using tees.

Brace profile: RHS

Gusset plate is welded to the column.
Braces are bolted to the gusset plate
using tees.
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Limitations

The braces must be in the same plane.

Before you start

Create a beam, and up to three braces all in the same plane.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary part (third brace).

5. Click the middle mouse button to create the component.

Part identification key

 Description
1 Gusset plate
2 Tee

Picture tab
Use the Picture tab to define the tee dimension from the gusset plate edge.
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 Description
1 Define the tee edge dimension.

Parts tab
Use the Parts tab to define the properties of the gusset plate, and the tees at
the ends of the braces. You can define the tees separately for each brace.

Parts

Option Description
Gusset Thickness, width and height of the gusset plate.
Tee flange To have Tekla Structures use two plates to create

the tee, leave the Tee profile empty. You must
enter the thickness, width, and height dimensions
for the tee flange and web instead.

Define the thickness, width and height of the tee
flange.

Tee web To have Tekla Structures use two plates to create
the tee, leave the Tee profile empty. You must
enter the thickness, width, and height dimensions
for the tee flange and web instead.

Define the thickness, width and height of the tee
web.

Tee profile Select the tee profile from the profile catalog.

You can use a T profile or an I profile.

If you use an I profile, the component creates the
tee by cutting the I profile. You must specify where
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Option Description
to cut the I profile, using the tee depth option on
the Parameters tab.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options.

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings --> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  

Parameters tab
Use the Parameters tab to define the tee dimensions, clearances, gusset plate
position and chamfers.

Option Description
Min. cut angle (0-90 deg) Define the minimum cut angle.
Define welds for each Tee Select whether to use welds for each

tee.
Define bolts for each Tee Select whether to use bolts for each

tee.

Gusset position

Select the gusset position on the brace.
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Tee position

Select the tee position on the gusset.

Gusset chamfer

Option Description
Default

No chamfer

AutoDefaults can change this option.
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Option Description
No chamfer

Chamfers are created.

Tee dimensions

Define the tee dimensions for each brace.

 Description
1 Tee length
2 Tee depth

Bolt group alignment

Select whether bolt groups are aligned.
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Gusset position on the main part

Option Description
Default

Gusset is positioned according to the
defined distances.

AutoDefaults can change this option.

Gusset is positioned according to the
defined distances.

Gusset is centered to the center of
the bolt group.

Gusset is centered to the center of
the connection origin.

Bolts 1 / Bolts 2 / Bolts 3 tabs
Use the Bolts 1, Bolts 2 and Bolts 3 tabs to control the bolts that connect the
first, the second, and the third brace to the gusset plate.
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Bolt group dimensions

 Description
1 Plate edge distance to the main part web.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes
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Option Description Default
Site/Workshop Location where the bolts

should be attached.
Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Steel components 2399 Bracing components



Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Steel components 2400 Bracing components



Welds

Click the link below to find out more:

Bolted gusset (196)
Bolted gusset (196) connects 1 to 10 braces to a beam or column using a
gusset plate, which is bolted or welded to the beam or column. The braces are
bolted to the gusset plate. Clip angles can be created either at the ends of the
braces, or on each side.

Objects created

• Gusset plate

• Clip angles or shear tabs (optional) that connect the gusset plate to the
beam or column

• Clip angles (optional) that connect the brace to the gusset plate

• Connection plates

• Seal plates (hollow braces)

• Stiffeners (optional)

• Bolts

• Welds

• Cuts

Use for

Situation Description
Brace profile: RHS

Gusset plate is bolted to the beam
flange using a clip angle. Braces are
slotted around the gusset plate and
attached to it using bolts and clip
angles.
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Situation Description
Brace profile: Tube

Gusset plate is welded to the beam
web. Brace is notched around the
gusset plate and pinned to it.

Brace profile: T

Gusset plate is welded to the beam
flange. Brace is bolted to the gusset
plate.

Brace profile: L

Gusset plate is welded to the column
flange. Brace is bolted to the gusset
plate.

Before you start

Create a beam or column, and 1 to 10 braces.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Click the middle mouse button to create the component.
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Part identification key

  
1 Gusset plate
2 Clip angle

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Picture tab
Use the Picture tab to define the dimensions that control the position and
shape of the gusset plate.

Dimensions
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 Description
1 Define the gap distance between the gusset plate edge and the

main part.
2 Define the gusset plate corner angle (in degrees).

This value affects the gusset plate shape.
3 Define the length of the edge of the gusset plate.

This value affects the gusset plate shape.
4 Define the distance between the braces.
5 Define the distance between the main part and the brace.
6 Define the distance between the clip angle or connection plate

edge and the gusset plate edge.

NOTE The following examples show only some of the available options. You
will find more options on the Picture tab.

Gusset plate positioning

Define how the gusset plate is positioned when a base plate is used.

Option Desription
Default

Gusset plate is parallel to the main
part.

AutoDefaults can change this option.
Gusset plate is parallel to the brace.

Gusset plate chamfer

Define the gusset plate chamfer type and dimensions, and the angle limit for
parallel bracing.
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 Description
1 Distance between the connection plate and the inner flange

of the main part.
2 Horizontal distance between the gusset plate edge and the

flange of the main part.
3 Horizontal dimension of the chamfer.

By default, the second chamfer is not created.
4 Vertical dimension of the chamfer.

By default, the second chamfer is not created.

Cut size

If the gusset plate runs through the main part, define the size of the cut
created for the gusset plate.

 Description
1 Define the horizontal size of the cut.
2 Define the vertical size of the cut.

Gusset tab
Use the Gusset tab to control the gusset plate properties, shape and position,
clip angle properties and orientation, and angle limit for parallel bracing.

Plates

Option Description
Gusset Thickness, width and height of the

gusset plate.
Connection plates Thickness and width of the

connection plate.
L profile Select the clip angle profile from the

profile catalog.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

NOTE The following examples show only some of the available options. You
will find more options on the Gusset tab.

Gusset plate connection

Define how the gusset plate is connected to the main part.

Option Description
Default

Gusset plate is welded directly to the
main part.

AutoDefaults can change this option.
Gusset plate is connected to the main
part with clip angles.

Select to which side of the gusset
plate the clip angles are created.
Gusset plate is connected to the main
part with a connection plate.

Select to which side of the gusset
plate the connection plate is created.

Clip angle orientation

Define how the clip angle is placed on the connection.
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Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.

Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Brace position

Option Description
Default

The brace position is not affected.

AutoDefaults can change this option.

The first selected brace is placed
closest to the main part.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.
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Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.

Gusset plate position on the column or beam

Option Description
Select the gusset position.

The default option is parallel to the
brace.

Brace conn tab
Use the Brace conn tab to define the seal plate, brace notch and slot
properties.
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Seal plate

Option Description
Seal plate Thickness of the seal plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Brace notch

Option Description
Select whether the brace is notched.

1. Vertical notch dimension.

2. Horizontal notch dimension.

3. Notch angle.
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Option Description
Define the plate distance from the
brace outer edge.

Select whether to create bevel cuts at
the brace ends or whether to create a
square brace end.

Gusset bolts tab
Use the Gusset bolts tab to control the bolt group properties for bolts that
connect the gusset plate to the main part, and to control the clip angle
attachment.

Bolt group dimensions

  
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt
to the edge of the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a
value for each space between bolts. For example, if
there are 3 bolts, enter 2 values.
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4 Dimension for vertical bolt group position.
5 Select how to measure the dimensions for vertical bolt

group position.
6 Dimension for horizontal bolt group position.
7 Select how to measure the dimensions for horizontal

bolt group position.

  
1 Location where the bolts should be attached.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value
for each space between bolts. For example, if there are 3
bolts, enter 2 values.

Clip angle attachment type

Option Description
Default

Both parts are bolted.

AutoDefaults can change this option.
Automatic

When the main part is a tube profile,
the clip angles are welded to the main
part and bolted to the secondary part.
Otherwise the clip angles are bolted
to both parts.
Main part is bolted and secondary
part is welded.
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Option Description
Main part is welded and secondary is
part bolted.

Both parts are bolted.

Both parts are welded.

Bolts on gusset plate

Define whether the gusset plate is connected to the main part with bolts when
no clip angles are used.

Option Description
Default

Bolts are not created in the gusset
plate.

AutoDefaults can change this option.
Bolts are created in the gusset plate.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
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Option Description Default
depend on the component in
question.

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Brace bolts 1 / Brace bolts 2 / Brace bolts 3 tab
Use the Brace bolts 1, Brace bolts 2 and Brace bolts 3 tabs to control the
bolts that connect the first, the second, and the subsequent braces to the
gusset plate.

Bolt group dimensions
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 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a
value for each space between bolts. For example, if there
are 3 bolts, enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to
the edge of the part.

4 Select how to measure the dimensions for vertical bolt
group position.

5 Dimension for vertical bolt group position.

Bolt distance

Define the minimum distance from the connection plate bolts to the
intersection point of the main part and brace center lines. If a brace is
perpendicular to the main part, the distance is measured from the main part
center line to the nearest bolts.
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Attributes for Tube crossing (22)

With hollow secondary parts, Bolted gusset (196) automatically removes
connection objects created between the gusset plate and the hollow
secondary part, and then uses the Tube crossing (22) connection between the
gusset plate and the hollow secondary part.

To define which property file that Tube crossing (22) uses, go to the Brace
bolts 2 tab, and enter the property file name in the Attributes for Tube
crossing (22) box.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.
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Option Description Default
Bolt standard Bolt standard to be used

inside the component.
Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.
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Angle bolts tab
Use the Angle bolts tab to control the bolts that connect the clip angles.

Part

Option Description
L profile Select the clip angle profile from the profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes
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Option Description Default
Site/Workshop Location where the bolts

should be attached.
Site

Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Define the edge distance between the clip angle and the brace.
5 Select how to measure the dimensions for vertical bolt group

position.
6 Dimension for vertical bolt group position.
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Clip angle position

Option Description
Select the clip angle position.

Stiffeners tab
Use the Stiffeners tab to define the stiffener properties and dimensions.

Parts

Part Description
Stiffener 1, Stiffener 2 Thickness of the stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Stiffener length

 Description
1 Define the distance between the stiffener edge and the gusset

plate edge.
2 Define the length of stiffener.

Stiffener dimensions

 Description
1 Define the width of the stiffener.
2 Define the length of the stiffener base.
3 Define the length of the skew part of the stiffener.
4 Define the distance from the stiffener center line.
5 Define the vertical distance between the stiffener base and the

skew part.
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Chamfer type

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex arc chamfer

Concave arc chamfer

Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer.
2 Vertical dimension of the chamfer.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab
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Welds

Click the link below to find out more:

Create welds

Corner bracing connections
Use corner bracing connections to automatically connect bracing where two
parts meet to form a corner, for example:

• Beam and column

• Column and base plate

• Beam and extended end plate

• Two beams and a column

Tekla Structures includes the following corner bracing connections:

Component Image Description
Corner tube
gusset (56)
(page 2424)

Bolts braces to a gusset
plate using connection
plates and optional tongue
plates. Seals hollow braces.

Corner bolted
gusset (57)
(page 2441)

Bolts braces to a gusset
plate. Welds the gusset
plate to one or both of the
parts that form the corner.
Seals hollow braces.

Wraparound
gusset (58)
(page 2457)

Bolts or welds braces to a
gusset plate. Option to
wrap the gusset plate
around a third part, usually
a column. Option to use
connection material to
connect the gusset plate to
the main parts.

Hollow brace
wraparound
gusset (59)
(page 2485)

Bolts or welds hollow
braces to a gusset plate.
Option to wrap the gusset
plate around a third part,
usually a column. Option to
use connection material to
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Component Image Description
connect the gusset plate to
the main parts.

Wraparound
gusset cross
(60) (page 2506)

Bolts or welds braces to a
gusset plate. Option to use
clip angles. Option to wrap
the gusset plate around a
third part, usually a column.
Option to use connection
material to connect the
gusset plate to the main
parts.

Corner wrapped
gusset (63)
(page 2527)

Bolts braces to a gusset
plate using clip angles and
connection plates. Welds
the gusset plate to one of
the main parts.

Bent gusset
(140)
(page 2548)

Connects braces in different
planes to one or more
beams or columns that are
in different planes.Creates a
gusset plate that is bent
along two different bending
lines. Seals hollow braces.

Heavy brace
(165)
(page 2569)

Bolts a single brace to a
gusset plate where two
parts meet to form a
corner. Rib plates
strengthen the connection.

Corner tube gusset (56)
Corner tube gusset (56) connects 1 to 10 hollow braces to the corner where
two parts meet, using a gusset plate. Bolts braces to the gusset plate using a
connection plate or tongue plate slotted into the brace. Option to create extra
connection plates. Seals braces.

Objects created

• Gusset plate

• Connection plates

• Seal plates

• Tongue plates (optional)

• Cover plates (optional)

Steel components 2424 Bracing components



• Stiffeners

• Bolts

• Welds

Use for

Situation Description
Brace profile: RHS

Framing type: Column and extended
end plate

Gusset plate is welded to an extended
end plate. Braces are bolted to the
gusset plate using tongue plates.

Brace profile: RHS

Framing type: Column and beam

Gusset plate is welded to the column
flange. Braces are bolted to the
gusset plate using tongue plates, and
connection and cover plates.

Before you start

Create two parts that form a corner, and 1 to 10 braces.

Selection order

1. Select the main part (the first part that forms the corner).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Select the secondary part that forms the corner (Tekla Structures connects
the gusset plate to this part).

6. Click the middle mouse button to create the connection.
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NOTE Tekla Structures uses values in the joints.def file to create this
component.

Part identification key

 Description
1 Gusset plate
2 Connection plate
3 Seal plate

Picture tab
Use the Picture tab to define the gusset plate position and shape.
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Dimensions

 Description
1 Define the gap distance between the gusset plate edge and

the main part (first part that forms the corner) .
2 Define the edge distance between the connection plate and

the last secondary part.
3 Define the distance between the connection plates.
4 Define the edge distance between the connection plate and

the main part.
5 Define the gap distance between the gusset plate edge and

the secondary part (second part that forms the corner).
6 Define the gusset plate corner angle (in degrees).

This value affects the gusset plate shape.
7 Define the length of the edge of the gusset plate.

This value affects the gusset plate shape.
8 Define the length of the edge of the connection plate.
9 Define the brace length on the connection plate.
10 Define the edge distance between the seal plate and gusset

plate.
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Gusset tab
Use the Gusset tab to control the gusset plate properties.

Gusset plate

Option Description
Gusset Thickness, width and height of the

gusset plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

NOTE The following examples show only some of the available options. You
will find more options on the Gusset tab.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.

Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.

Steel components 2428 Bracing components



Option Description
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.

Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Brace position

Option Description
Default

The brace position is not affected.

AutoDefaults can change this option.

The first selected brace is placed
closest to the main part.

Gusset plate shape

The gusset plate edge can be perpendicular either to the main part or the
secondary part.
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Option Description
Select the gusset plate edge shape
between the last and second last
secondary part.

Select the gusset plate egde shape
between the main part and the first
secondary part.

Gusset plate fitting

Option Description
Select whether the gusset is fitted to
the last selected secondary part.

Gusset welding

Weld 1 is used to weld the gusset part to the main part and weld 4 is used for
welding the gusset to the last secondary part.

Option Description
Default

Gusset plate is welded to the main part.

AutoDefaults can change this option.
Gusset plate is welded to the main part.
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Option Description
Gusset plate is welded to the secondary part.

Gusset plate is welded to the main part and
the secondary part.

Gusset plate inner corner

Define the horizontal and vertical chamfer dimensions.

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex chamfer

Concave chamfer

Bevel

Square

Brace conn tab
Use the Brace conn tab to control connection plate, seal plate, tongue plate,
and cover plate properties.
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Plates

Option Description
Connection plate Thickness, width and height of the

connection plate.
Seal plates Thickness, width and height of the

seal plate.
Tongue plate Thickness of the tongue plate.
Cover plate Thickness, width and height of the

cover plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Brace connection types

Define how the brace is connected to the connection plate.

Option Description
Default

Brace is welded.

AutoDefaults can change this option.
Brace is welded.

Brace is bolted.
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Option Description
Brace is welded and notched around
the nuts.

Tongue plate and cover plate are
created.

Cut in bracing

Define the width of the cut in the bracing, where t is the thickness of the
connection plate.

Define the length of the cut in the bracing from the edge of the connection
plate.

Round cut in bracing

Option Description
Default

Square cut

AutoDefaults can change this option.
Square cut

Round cut

Enter the radius value.

Connection plate

Define whether the brace is notched or the connection plate cut when the
connection plate is connected to the brace.

Option Description
Default

Brace is notched.

AutoDefaults can change this option.
Brace is notched.
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Option Description
Connection plate is cut.

Connection plate is cut, but the part of the
connection plate created inside the
bracing is not deleted.
If you cut the connection plate, you can
define the size of the gap between the
brace and the connection plate.

Number of connection plates

Define whether one or two connection plates are used for connecting the
brace to the gusset plate.

Option Description
Default

One connection plate

AutoDefaults can change this option.
One connection plate

Two connection plates

Connection plate chamfer

Option Description
Default

No chamfers are created.

AutoDefaults can change this option.
No chamfers are created.

Chamfers are created.

If you create chamfers, define the vertical
and horizontal chamfer dimensions.
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End plates

If you use the end plates to seal the braces, define the end plate shape and
dimensions.

Option Description
Default

Square end plate.

AutoDefaults can change this option.
Square end plate.

Round end plate.

End plate edge distance

Option Description
End plate edge distance from the
brace outer edge.

Stiffeners tab
Use the Stiffeners tab to control the stiffener properties and dimensions.

Stiffeners

Option Description
Stiffener 1

Stiffener 2

Thickness of the stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
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Option Description Default
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Stiffener length

 Description
1 Distance between the stiffener edge and the gusset plate

edge.
2 Length of stiffener.
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Stiffener dimensions

 Description
1 Width of the stiffener.
2 Length of the stiffener base.
3 Length of the skew part of the stiffener.
4 Distance from the stiffener center line.
5 Vertical distance between the stiffener base and the skew

part.

Brace bolts 1 / Brace bolts 2 tab
Use the Brace bolts 1 and Brace bolts 2 tabs to control the bolts that connect
the first and second brace to the gusset plate.

Bolt group dimensions on connection plates
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 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Select how to measure the dimensions for vertical bolt group
position.

5 Dimension for vertical bolt group position.

Bolt distance

Define the minimum distance from the connection plate bolts to the
intersection point of the main part and brace center lines. If a brace is
perpendicular to the main part, the distance is measured from the main part
center line to the nearest bolts.

Option Option

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1
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Option Description
Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Gusset side and brace side bolt type

Select the bolt type to define the location where the bolts should be attached.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab
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Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Corner bolted gusset (57)
Corner bolted gusset (57) connects 1 to 10 braces to the corner where two
parts meet, using a gusset plate. Welds the gusset plate to the first selected
part that forms the corner. Creates optional clip angles, either at the ends of
the braces, or on each side. Seals RHS or tube braces.

Objects created

• Gusset plate

• Clip angles (optional)

• Stiffeners

• Brace bolts

• Angle bolts

• Welds
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Use for

Situation Description
Brace profile: RHS

Framing type: Column and extended
end plate

Gusset plate is welded to an extended
end plate. Braces are pinned to the
gusset plate.

Brace profile: T, L

Framing type: Column and extended
end plate

Gusset plate is welded to an extended
end plate. Braces are bolted to the
gusset plate.

Before you start

Create two parts to form a corner, and 1 to 10 braces.

Selection order

1. Select the main part (the first part that forms the corner).

The gusset plate is connected to this part.

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Select the secondary part that forms the corner.

6. Click the middle mouse button to create the connection.
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NOTE Tekla Structures uses values in the joints.def file to create this
component.

Part identification key

 Description
1 Gusset plate

Picture tab
Use the Picture tab to define the gusset plate position and shape.

Dimensions
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 Description
1 Define the gap distance between the gusset plate edge and the

main part (first part that forms the corner).
2 Define the edge distance between the last secondary part and

the last brace.
3 Define the distance between the braces.
4 Define the edge distance between the first brace and the main

part.
5 Define the gap distance between the gusset plate edge and the

secondary part (second part that forms the corner).
6 Define the gusset plate corner angle (in degrees).

This value affects the gusset plate shape.
7 Define the length of the edge of the gusset plate.

This value affects the gusset plate shape.

Gusset tab
Use the Gusset tab to control the gusset plate properties.

Gusset plate

Option Description
Gusset Thickness, width and height of the

gusset plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.
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Option Description Default
Finish Describes how the part

surface has been
treated.

 

NOTE The following examples show only some of the available options. You
will find more options on the Gusset tab.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.

Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.

Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Steel components 2445 Bracing components



Brace position

Option Description
Default

The brace position is not affected.

AutoDefaults can change this option.

The first selected brace is placed
closest to the main part.

Brace notch

Option Description
Select whether the brace is notched.

You may want to notch the brace if
the plate collides with the brace
flange or if you want to create slots in
the hollow braces.

The last option creates a notch and
fastens the plate to the brace by using
a bolt.

1. Vertical notch dimension

2. Horizontal notch dimension.

3. Notch angle.

Round cut in bracing

Option Description
Default

Square cut

AutoDefaults can change this option.
Square cut
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Option Description
Round cut

Enter the radius value.

Gusset plate shape

The gusset plate edge can be perpendicular either to the main part or the
secondary part.

Option Description
Select the gusset plate edge shape
between the last and second last
secondary part.

Select the gusset plate egde shape
between the main part and the first
secondary part.

Gusset plate fitting

Option Description
Select whether the gusset is fitted to
the last selected secondary part.
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Gusset welding

Option Description
Default

Gusset plate is welded to the
secondary part.

AutoDefaults can change this option.
Gusset plate is welded to the
secondary part.
Gusset plate is welded to the main
part.

Gusset plate is welded to the main
part and the secondary part.

Gusset plate inner corner

Define the horizontal and vertical chamfer dimensions.

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex chamfer

Concave chamfer

Bevel
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Option Description
Square

Stiffeners tab
Use the Stiffeners tab to control the stiffener properties and dimensions.

Stiffeners

Option Description
Stiffener 1

Stiffener 2

Thickness of the stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Stiffener length

 Description
1 Distance between the stiffener edge and the gusset plate

edge.
2 Length of stiffener.

Stiffener dimensions

 Description
1 Width of the stiffener.
2 Length of the stiffener base.
3 Length of the skew part of the stiffener.
4 Distance from the stiffener center line.
5 Vertical distance between the stiffener base and the skew

part.
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Brace bolts 1 / Brace bolts 2 tabs
Use the Brace bolts 1 and Brace bolts 2 tabs to control the bolts that connect
the first and subsequent braces to the gusset plate.

Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Select how to measure the dimensions for vertical bolt group
position.

5 Dimension for vertical bolt group position.

Bolt distance

Define the minimum distance from the connection plate bolts to the
intersection point of the main part and brace center lines. If a brace is
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perpendicular to the main part, the distance is measured from the main part
center line to the nearest bolts.

Option Option

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
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Option Description
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Angle bolts tab
Use the Angle bolts tab to define the clip angles and to control the bolts that
connect the clip angle to the gusset plate.

Part

Part Description
L profile Select the clip angle profile from the profile

catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.
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 Description
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Clip angle edge distance to the brace edge.
5 Select how to measure the dimensions for horizontal bolt

group position.
6 Dimension for horizontal bolt group position.

Clip angle position

Option Description
Select the clip angle position.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Wraparound gusset (58)
Wraparound gusset (58) connects 1 to 10 braces to the corner where two or
three parts meet, usually two beams and a column, using a gusset plate. The
gusset plate can be wrapped around the third part, usually a column. Bolts or
welds the brace web to the gusset plate using connection plates, and bolts or
welds the brace flange to the gusset plate using clip angles. Either connects
the gusset plate directly to the two beams, or uses clip angles or shear tabs, or
connection plates. The brace profile can be C or W.

Objects created

• Gusset plate

• Clip angles

• Shear tabs

• Connection plates

• Shim plates

• Bolts

• Cuts

• Welds

Use for

Situation Description
Brace profile: W

Framing type: Beam and column

Gusset plate is bolted to the column
flange using a clip angle. Braces are
bolted to the gusset plate using a
connection plate and clip angles.

Before you start

Create 2 or 3 parts that form a corner, and 1 to 10 braces.

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Selection order

1. Select the main part (the first part that forms the corner).
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2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Select the secondary part that forms the corner.

6. If needed, select the column to wrap the gusset plate around the column
where two beams and the column meet.

7. Click the middle mouse button to create the component.

Part identification key

 Description
1 Gusset plate
2 Connection plate
3 Clip angle

Picture tab
Use the Picture tab to define the shape of the gusset plate, location of the
braces and clip angles, and the work point location.
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Dimensions

 Description
1 Define the gap distance between the gusset plate edge and

the main part.
2 Define the edge distance between the last secondary part and

the last brace.
3 Define the distance between the braces.
4 Define the edge distance between the first brace and the

main part.
5 Define the gap distance between the gusset plate edge and

the secondary part (second part that forms the corner).
6 Define the gusset plate corner angle (in degrees).

This value affects the gusset plate shape.
7 Define the length of the edge of the gusset plate.

This value affects the gusset plate shape.
8 Define the gap distance between the gusset plate edge and

the brace.
9 Define the gusset plate edge distance in relation to the work

point.
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 Description
10 Define the gusset plate edge distance to the flange of the

third part.
11 Define the clip angle edge distance in relation to the work

point.
12 Define the clip angle edge distance to the flange of the third

part.

Work point position

Option Description
Select the work point position. The
default position is the point where the
two main parts intersect.

Tekla Structures uses the work point
of a component to calculate check
dimensions and part position
dimensions in drawings.

Gusset tab
Use the Gusset tab to define gusset plate, connection plate and clip angle
properties.

Parts

Option Description
Gusset Thickness, width and height of the

gusset plate.
Connection plates Thickness and height of the

connection plates.
Upper clip angle

Lower clip angle

Select the clip angle profile from the
profile catalog.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Gusset plate connection

Define how the gusset plate is connected to the main part.

Option Description
Default

Gusset plate is connected to the main
part with a clip angle.

AutoDefaults can change this option.
Gusset plate is connected to the main
part with clip angles.

Select to which side of the gusset
plate the clip angles are created.
Gusset plate is connected to the main
part with a connection plate.

Select to which side of the gusset
plate the connection plate is created.

Erection clearance

You can define the clearance for both the main part and the last secondary
part connection plates or clip angles.
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Gap dimensions

Option Description
Define the gap dimension between
the gusset plate and the connection
plates or the clip angles.

Connection plate cut through dimensions

 Description
1 Connection plate cut through length
2 Chamfer radius
3 Horizontal chamfer dimension
4 Vertical chamfer dimension

Clip angle orientation

Define how the clip angle is placed on the connection.

Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.
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Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.

Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.

Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.

Notch angle

Option Description
Default

Square notch
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Option Description
If the gusset plate clashes with the
column, the gusset plate is notched to
wrap around the column.

AutoDefaults can change this option.
Square notch

Bevel notch

Notch chamfer type

Option Description
Default

Bevel chamfer

AutoDefaults can change this option.
No chamfer

Notched edges are parallel to the
edges of the gusset plate.
Bevel chamfer

Rounded chamfer calculated as a
quarter of a circle.

Enter the diameter of the circle as the
horizontal dimension of the chamfer.
Rounded chamfer calculated as a
three quarters of a circle.

Enter the diameter of the circle as the
horizontal dimension of the chamfer.

The center point of the circle is the
corner of the notch.
Corner of the gusset plate is beveled.

Corner of the gusset plate is not
notched or chamfered.
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Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer
2 Vertical dimension of the chamfer

Gusset plate shape

The gusset plate edge can be perpendicular either to the main part or the
secondary part.

Option Description
Select the gusset plate edge shape
between the last and second last
secondary part.

Select the gusset plate egde shape
between the main part and the first
secondary part.

Brace conn tab
Use the Brace conn tab to control the properties of connection plates, clip
angles, filler plates, and shear tabs, and the angle connection profile.
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Plates

Option Description
Connection plate Thickness and width of the

connection plate.

Select the connection plate profile.
Upper clip angle

Lower clip angle

Select the clip angle profile.

Filler plate Thickness, width and height of the
filler plate.

Upper shear tab Thickness, width and height of the
upper shear tab.

Lower shear tab Height of the lower shear tab.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Plate creation

Option Description
Select whether one or two connection
plates are created between the brace
web and the gusset plate.

Select whether a filler plate is created
between the connection plate and the
brace web.

The default is that a filler plate is not
created.

Select the filler plate creation side.

You can use this option when you
have selected to create two
connection plates.
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Clip angle creation

Option Description
Define whether the braces are
attached to the gusset plate using clip
angles or shear tabs, and specify the
number of clip angles to create.

The default option is to create two
clip angles below the brace web.

Clip angle orientation

Define how the clip angle is placed on the connection.

Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.
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Connection type

Option Description
Select the connection type (weld or
bolts) between the gusset plate and
the connection plate.

Select the connection type (weld or
bolt) between the gusset plate and
the L profile.

Connection plate gap dimensions

 Description
1 Horizontal gap dimension
2 Vertical gap dimension

Shim plates
Use the Shim plates tab tab to define shim plate properties.

Plates

Option Description
Shim plate 1

Shim plate 2

Shim plate 3

Thickness, width and height of the
shim plates.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Shim plate position

You can create shim plates when connecting braces to the gusset plate using
clip angles.

 Description
1 Define the gap between the brace and connection plate.
2 Define how many shim plates are created at the top and bottom

flanges.

Enter the shim plate profile numbers: 1, 2 or 3. These are the
numbers that are on the upper part on the Shim plates tab.

For example, if you want to create three shim plates at the top
flange, and you want to use Shim plate 1 twice and Shim plate
1 once, enter 1 1 2. The first number you enter is the shim plate
closest to the brace flange.
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Gusset bolts 1 / Gusset conn 2 tab
Use the Gusset bolts 1 and Gusset conn 2 tabs to control the bolt group
properties for bolts that connect the gusset plate to the main part and the
secondary part, and to control the clip angle attachment.

Bolt group dimensions

  
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

4 Vertical bolt group dimension in relation to the work point.

Work point is the intersection point between the center lines
of the main part and the last secondary part.
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 Description
1 Location where the bolts should be attached.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the

Yes
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Option Description Default
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Clip angle attachment type

Define how the clip angle is attached to the gusset plate and to the main part.

Option Description
Default

When the main part is a tube profile,
the clip angles are welded to the main
part and bolted to the secondary part.
Otherwise the clip angles are bolted
to both parts.

AutoDefaults can change this option.
Automatic

When the main part is a tube profile,
the clip angles are welded to the main
part and bolted to the secondary part.
Otherwise the clip angles are bolted
to both parts.
Main part is bolted and secondary
part is welded.

Main part is welded and secondary is
part bolted.

Both parts are bolted.

Both parts are welded.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Brace bolts 1 / Brace bolts 2 tab
Use the Brace bolts 1 and Brace bolts 2 tabs to control the bolts that connect
the braces to the gusset plate.

Bolt group dimensions

 Option
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.
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 Option
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Dimension for vertical bolt group position.
5 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line
of the secondary part.
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 Option
• Below: From the lower edge of the secondary part to the

lowest bolt.

6 Select the bolt type.

Angle bolt group dimensions

 Option
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Dimension for vertical bolt group position.

Bolt distance

Define the minimum distance from the connection plate bolts to the
intersection point of the main part and brace center lines. If a brace is
perpendicular to the main part, the distance is measured from the main part
center line to the nearest bolts.
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Option Option

Vertical bolt position

Option Description
Bolt position from the L profile edge.

Bolt position from the secondary part
center line.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Clip angle extra bolts 1 tab
Use the Clip angle extra bolts 1 tab to define the clip angle bolt group
dimensions and bolt properties.

Clip angle extensions

  
Select whether clip angles are
extended, and the extension sides.

Define the bolt group dimensions of the clip angle extensions.
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 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts, enter
2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Bolt spacing to the bolts in the clip angle extension.
5 Location where the bolts should be attached.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes
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Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Beam cut tab
Use the Beam cut tab to control weld access holes, beam end preparations,
and flange cuts.

Weld access hole dimensions

 Option
1 Dimension for the top and the bottom weld access holes.
2 Gap between the secondary part web and the main part.
3 Gap between the secondary part bottom flange and the main

part.

Weld access holes

Option Option Description
Default

Round weld access hole

AutoDefaults can change
this option.
Round weld access hole

Square weld access hole
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Option Option Description
Diagonal weld access
hole

Flange cut

Option for top flange Option for bottom
flange

Description

Default

Flange is not cut.

AutoDefaults can change
this option.
Flange is not cut.

Flange is cut.

Beam end preparation

Option Description
Default

Top and bottom flange are prepared.

AutoDefaults can change this option.
Automatic

Top and bottom flange are prepared.

Beam end is not prepared.

Top and bottom flange are prepared.

Top flange is prepared.

Bottom flange is prepared.
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General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Create welds

Hollow brace wraparound gusset (59)
Hollow brace wraparound gusset (59) connects 1 to 10 braces to the corner
where 2 or 3 parts meet, using a gusset plate. The gusset plate can be
wrapped around the third part, usually a column. Bolts or welds the brace web
to the gusset plate using connection plates, and bolts or welds the brace
flange to the gusset plate using clip angles. Either connects the gusset plate
directly to the existing parts, or uses clip angles or connection plates. Seals
braces.

Objects created

• Gusset plate

• Connection plates (optional)

• Clip angles (optional)

• Seal plates

• Tongue plates

• Cover plate

• Bolts

• Welds
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Use for

Situation Description
Brace profile: RHS

Framing type: Beam and column

Gusset plate is bolted to the column
flange using a clip angle. Braces are
bolted to the gusset plate using a
tongue plate.

Brace profile: RHS

Framing type: Beam and column

Gusset plate is bolted to the column
flange using a clip angle. Braces are
welded to the connection plate. The
end of the brace is notched to
accommodate the bolts in the
connection between the connection
plate and the gusset plate.

Before you start

Create 2 or 3 parts that form a corner, and 1 to 10 braces.

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Selection order

1. Select the main part (the first part that forms the corner).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Select the secondary part that forms the corner (Tekla Structures connects
the gusset plate to this part).

6. If needed, select the column to wrap the gusset plate around the column
where two beams and the column meet.

7. Click the middle mouse button to create the connection.

Steel components 2486 Bracing components



Part identification key

 Description
1 Gusset plate
2 Connection plate
3 Clip angle
4 Seal plate

Picture tab
Use the Picture tab to define the shape of the gusset plate, location of the
braces and clip angles, and the work point location.
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Dimensions

 Description
1 Define the gap distance between the gusset plate edge and the

main part.
2 Define the edge distance between the last secondary part and

the last brace.
3 Define the distance between the braces.
4 Define the edge distance between the first brace and the main

part.
5 Define the gap distance between the gusset plate edge and the

secondary part (second part that forms the corner).
6 Define the gusset plate corner angle (in degrees).

This value affects the gusset plate shape.
7 Define the length of the edge of the gusset plate.

This value affects the gusset plate shape and connection plate
width.

8 Define the gap distance between the gusset plate edge and the
seal plate.

9 Define the length of the edge of the connection plate.
10 Define the brace dimension on the connection plate.

To prevent the connection plate from penetrating the hollow
brace, enter a negative value for the dimension.
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 Description
11 Define the gusset plate edge distance in relation to the work

point.
12 Define the gusset plate edge distance to the flange of the third

part.
13 Define the clip angle edge distance in relation to the work

point.
14 Define the clip angle edge distance to the flange of the third

part.

Work point position

Option Description
Select the work point position. The
default position is the point where the
two main parts intersect.

Tekla Structures uses the work point
of a component to calculate check
dimensions and part position
dimensions in drawings.

Gusset tab
Use the Gusset tab to define the gusset plate, connection plate and clip angle
properties.

Parts

Option Description
Gusset Thickness, width and height of the

gusset plate.
Connection plates Thickness and height of the

connection plates.
Upper clip angle

Lower clip angle

Select the clip angle profile from the
profile catalog.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

NOTE The following examples show only some of the available options. You
will find more options on the Gusset tab.

Gusset plate connection

Define how the gusset plate is connected to the main part.

Option Description
Default

Gusset plate is connected to the main
part with a clip angle.

AutoDefaults can change this option.
Gusset plate is connected to the main
part with clip angles.

Select to which side of the gusset
plate the clip angles are created.
Gusset plate is connected to the main
part with a connection plate.

Select to which side of the gusset
plate the connection plate is created.
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Connection plate cut through dimensions

 Description
1 Connection plate cut through length
2 Chamfer radius
3 Horizontal chamfer dimension
4 Vertical chamfer dimension

Clip angle orientation

Define how the clip angle is placed on the connection.

Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.

Erection clearance

You can define the clearance for both the main part and the last secondary
part connection plates or clip angles.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.
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Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.

Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.

Notch angle

Option Description
Default

Square notch

If the gusset plate clashes with the
column, the gusset plate is notched to
wrap around the column.

AutoDefaults can change this option.
Square notch
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Option Description
Bevel notch

Notch chamfer type

Option Description
Default

Bevel chamfer

AutoDefaults can change this option.
No chamfer

Notched edges are parallel to the
edges of the gusset plate.
Bevel chamfer

Rounded chamfer calculated as a
quarter of a circle.

Enter the diameter of the circle as the
horizontal dimension of the chamfer.
Rounded chamfer calculated as a
three quarters of a circle.

Enter the diameter of the circle as the
horizontal dimension of the chamfer.

The center point of the circle is the
corner of the notch.
Corner of the gusset plate is beveled.

Corner of the gusset plate is not
notched or chamfered.

Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer
2 Vertical dimension of the chamfer
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Gusset plate shape

The gusset plate edge can be perpendicular either to the main part or the
secondary part.

Option Description
Select the gusset plate edge shape
between the last and second last
secondary part.

Select the gusset plate egde shape
between the main part and the first
secondary part.

Brace conn tab
Use the Brace conn tab to control the connection plate, seal plate, tongue
plate, and cover plate properties.

Parts

Option Description
Connection plate Thickness, width and height of the

connection plate.
Seal plates Thickness and height of the seal

plates.
Tongue plate Thickness and height of the tongue

plate.
Cover plate Thickness, width and height of the

cover plate.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Brace connection types

Define how the brace is connected to the connection plate.

Option Description
Default

Brace is welded.

AutoDefaults can change this option.
Brace is welded.

Brace is bolted.

Brace is welded and notched around
the nuts.

Tongue plate and cover plate are
created.

Cut in bracing

Define the width of the cut in the bracing, where t is the thickness of the
connection plate.
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Define the length of the cut in the bracing from the edge of the connection
plate.

Round cut in bracing

Option Description
Default

Square cut

AutoDefaults can change this option.
Square cut

Round cut

Enter the radius value.

Connection plate

Define whether the brace is notched or the connection plate cut when the
connection plate is connected to the brace.

Option Description
Default

Brace is notched.

AutoDefaults can change this option.
Brace is notched.

Connection plate is cut.

If you cut the connection plate, you
can define the size of the gap
between the brace and the
connection plate.

Number of connection plates

Define whether one or two connection plates are used for connecting the
brace to the gusset plate.
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Option Description
Default

One connection plate.

AutoDefaults can change this option.
One connection plate.

Two connection plates

Connection plate chamfer

Option Description
Default

No chamfers are created.

AutoDefaults can change this option.
No chamfers are created.

Chamfers are created.

If you create chamfers, define the vertical
and horizontal chamfer dimensions.

End plates

If you use the end plates to seal the braces, define the end plate shape and
dimensions.

Option Description
Default

Square end plate.

AutoDefaults can change this option.
Square end plate.

Round end plate.
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End plate edge distance

Option Description
End plate edge distance from the
brace outer edge.

Gusset conn 1 / Gusset conn 2 tab
Use the Gusset conn 1 and Gusset conn 2 tabs to control the bolt group
properties for bolts that connect the gusset plate to the main part and
secondary parts, and to control the clip angle attachment.

Bolt group dimensions
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 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

4 Vertical bolt group dimension in relation to the work point.

  
1 Location where the bolts should be attached.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
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Option Description Default
depend on the component in
question.

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Clip angle attachment type

Define how the clip angle is attached to the gusset plate and to the main part.

Option Description
Default

When the main part is a tube profile,
the clip angles are welded to the main
part and bolted to the secondary part.
Otherwise the clip angles are bolted
to both parts.

AutoDefaults can change this option.
Automatic

When the main part is a tube profile,
the clip angles are welded to the main
part and bolted to the secondary part.
Otherwise the clip angles are bolted
to both parts.
Main part is bolted and secondary
part is welded.
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Option Description
Main part is welded and secondary is
part bolted.

Both parts are bolted.

Both parts are welded.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Brace bolts 1 / Brace bolts 2 tab
Use the Brace bolts 1 and Brace bolts 2 tabs to control the bolts that connect
the first and second brace to the gusset plate.

Bolt group dimensions on connection plates
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 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Select how to measure the dimensions for vertical bolt group
position.

5 Dimension for vertical bolt group position.

Bolt distance

Define the minimum distance from the connection plate bolts to the
intersection point of the main part and brace center lines. If a brace is
perpendicular to the main part, the distance is measured from the main part
center line to the nearest bolts.

Option Option
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Gusset side and brace side bolt type

Select the bolt type to define the location where the bolts should be attached.

Slotted holes

You can define slotted, oversized, or tapped holes.
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Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Wraparound gusset cross (60)
Wraparound gusset cross (60) connects 1 to 10 braces to a gusset plate
where 2 or 3 parts meet to form a corner, using clip angles and connection
plates. The gusset plate can be wrapped around the third part, usually a
column. Connects the gusset plate to the parts using clip angles or connection
plates, or welds it directly to the first selected part. Clip angles can be created,
either at the ends of the braces, or on each side. Seals hollow braces. The
braces can have L, W, WT, RHS, and tube profiles.

Objects created

• Gusset plate

• Connection plates

• Clip angles (optional)

• Seal plates (hollow braces)

• Welds
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Use for

Situation Description
Brace profile: W

Framing profile: Column and 2 beams

Gusset plate is bolted to the beams
using clip angles. Braces are notched
and bolted to the gusset plate.

Brace profile: RHS

Framing profile: Column and beam

Gusset plate is bolted to the column
using a clip angle. Brace is pinned to
the gusset plate.

Brace profile: L

Framing profile: Two beams with
different elevations

Gusset plate is notched and bolted to
both beams using clip angles. Brace is
bolted to the gusset plate.

Brace profile: RHS

Framing profile: Column and column
base plate

Gusset plate is bolted to the column
and the base plate using clip angles.
Brace is pinned to the gusset plate.
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Before you start

Create 2 or 3 parts that meet to form a corner, and 1 to 10 braces.

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Selection order

1. Select the main part (the first part that forms the corner).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Select the secondary part that forms the corner.

6. f needed, select the column to wrap the gusset plate around the column
where two beams and the column meet.

7. Click the middle mouse button to create the component.

Part identification key

 Description
1 Gusset plate
2 Clip angle

Picture tab
Use the Picture tab to define the shape of the gusset plate, location of the
braces and clip angles, and the work point location.

Steel components 2508 Bracing components



Dimensions

 Description
1 Define the gap distance between the gusset plate edge and

the main part.
2 Define the edge distance between the last secondary part

and the last brace.
3 Define the distance between the braces.
4 Define the edge distance between the first brace and the

main part.
5 Define the gap distance between the gusset plate edge and

the secondary part (second part that forms the corner).
6 Define the gusset plate corner angle (in degrees).

This value affects the gusset plate shape.
7 Define the length of the edge of the gusset plate.

This value affects the gusset plate shape.
8 Define the gusset plate edge distance in relation to the work

point.
9 Define the gusset plate edge distance to the flange of the

third part.
10 Define the clip angle edge distance in relation to the work

point.
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 Description
11 Define the clip angle edge distance to the flange of the third

part.

Work point position

Option Description
Select the work point position. The
default position is the point where the
two main parts intersect.

Tekla Structures uses the work point
of a component to calculate check
dimensions and part position
dimensions in drawings.

Gusset tab
Use the Gusset tab to define the gusset plate, connection plate and clip angle
properties.

Parts

Option Description
Gusset Thickness, width and height of the

gusset plate.
Connection plates Thickness and width of the

connection plates.
Upper clip angle

Lower clip angle

Select the clip angle profile from the
profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Gusset plate connection

Define how the gusset plate is connected to the main part.

Option Description
Default

Gusset plate is connected to the main
part with a clip angle.

AutoDefaults can change this option.
Gusset plate is connected to the main
part with clip angles.

Select to which side of the gusset
plate the clip angles are created.
Gusset plate is connected to the main
part with a connection plate.

Select to which side of the gusset
plate the connection plate is created.
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Connection plate cut through dimensions

 Description
1 Connection plate cut through length
2 Chamfer radius
3 Horizontal chamfer dimension
4 Vertical chamfer dimension

Clip angle orientation

Define how the clip angle is placed on the connection.

Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.

Erection clearance

You can define the clearance for both the main part and the last secondary
part connection plates or clip angles.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.
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Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.

Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.

Notch angle

Option Description
Default

Square notch

If the gusset plate clashes with the
column, the gusset plate is notched to
wrap around the column.

AutoDefaults can change this option.
Square notch
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Option Description
Bevel notch

Notch chamfer type

Option Description
Default

Bevel chamfer

AutoDefaults can change this option.
No chamfer

Notched edges are parallel to the
edges of the gusset plate.
Bevel chamfer

Rounded chamfer calculated as a
quarter of a circle.

Enter the diameter of the circle as the
horizontal dimension of the chamfer.
Rounded chamfer calculated as a
three quarters of a circle.

Enter the diameter of the circle as the
horizontal dimension of the chamfer.

The center point of the circle is the
corner of the notch.
Corner of the gusset plate is beveled.

Corner of the gusset plate is not
notched or chamfered.

Chamfer dimensions

 Description
1 Horizontal dimension of the chamfer
2 Vertical dimension of the chamfer

Steel components 2514 Bracing components



Gusset plate shape

The gusset plate edge can be perpendicular either to the main part or the
secondary part.

Option Description
Select the gusset plate edge shape
between the last and second last
secondary part.

Select the gusset plate egde shape
between the main part and the first
secondary part.

Brace conn tab
Use the Brace conn tab to define the seal plate, brace notch and slot
properties.

Part

Option Description
Seal plate Thickness of the seal plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

Brace notch

Option Description
Select whether the brace is notched.

You may want to notch the brace if
the plate collides with the brace
flange or if you want to create slots in
the hollow braces.

The last option creates a notch and
fastens the plate to the brace by using
a bolt.

1. Vertical notch dimension.

2. Horizontal notch dimension.

3. Notch angle.

Select whether the secondary parts
(except the last secondary part) are
fitted.
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Option Description
Seal plate edge distance from the
brace outer edge.

Round cut in bracing

Option Description
Default

Square cut

AutoDefaults can change this option.
Square cut

Round cut

Enter the radius value.

Gusset conn 1 / Gusset conn 2 tabs
Use the Gusset conn 1 and Gusset conn 2 tabs to control the bolt group
properties for bolts that connect the gusset plate to the main and secondary
parts, and to control the clip angle attachment.

Bolts group dimensions
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 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

4 Vertical bolt group dimension in relation to the work point.

 Description
1 Location where the bolts should be attached.
2 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

Steel components 2518 Bracing components



 Description
3 Number of bolts.
4 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Clip angle attachment type

Define how the clip angle is attached to the gusset plate and to the main part.

Option Description
Default

When the main part is a tube profile,
the clip angles are welded to the main
part and bolted to the secondary part.
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Option Description
Otherwise the clip angles are bolted
to both parts.

AutoDefaults can change this option.
Automatic

When the main part is a tube profile,
the clip angles are welded to the main
part and bolted to the secondary part.
Otherwise the clip angles are bolted
to both parts.
Main part is bolted and secondary
part is welded.

Main part is welded and secondary is
part bolted.

Both parts are bolted.

Both parts are welded.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Brace bolts 1 / Brace bolts 2 tab
Use the Brace bolts 1 and Brace bolts 2 tabs to control the bolts that connect
the first and second brace to the gusset plate.
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Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Select how to measure the dimensions for vertical bolt group
position.

5 Dimension for vertical bolt group position.

Bolt distance

Define the minimum distance from the connection plate bolts to the
intersection point of the main part and brace center lines. If a brace is
perpendicular to the main part, the distance is measured from the main part
center line to the nearest bolts.
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Option Option

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
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Option Description
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Angle bolts tab
Use the Angle bolts tab to control the bolts that connect the clip angles.

Part

Option Description
L profile Select the clip angle profile from the

profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.
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 Description
4 Define the edge distance between the clip angle and the

brace.
5 Select how to measure the dimensions for vertical bolt group

position.
6 Dimension for vertical bolt group position.

Clip angle position

Option Description
Select the clip angle position.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:
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Corner wrapped gusset (63)
Corner wrapped gusset (63) bolts 1 to 10 braces to a gusset plate where two
parts form a corner, using clip angles and connection plates. Welds the gusset
plate to one of the parts that form the corner.

Objects created

• Gusset plate

• Connection plate between the gusset plate and the brace web

• Shear tab between the gusset plate and the brace flange

• Clip angles

• Shim plates

• Stiffeners

• Bolts

• Welds

Use for

Situation Description
Brace profile: W

Gusset plate is welded to an extended
end plate. Braces are bolted to the
gusset plate using clip angles on the
flanges and connection plates on the
webs.

Brace profile: W

Gusset plate is welded to an extended
end plate. Braces are bolted to the
gusset plate using clip angles on the
flanges.
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Situation Description
Brace profile: W

Gusset plate is welded to an extended
end plate. Braces are bolted to the
gusset plate using connection plates
on the webs.

Before you start

Create two parts that form a corner, and 1 to 10 braces.

NOTE Tekla Structures uses values in the joints.def file to create this
component.

Selection order

1. Select the main part (the first part that forms the corner).

2. Select the secondary part (first brace).

3. Select the second secondary part (second brace).

4. Select the subsequent secondary parts (subsequent braces).

5. Select the secondary part that forms the corner.

6. Click the middle mouse button to create the component.
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Part identification key

 Description
1 Gusset plate
2 Connection plate
3 Clip angle

Picture tab
Use the Picture tab to define the dimensions that control the position and
shape of the gusset plate.
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Dimensions

 Description
1 Define the gap distance between the gusset plate edge and the

main part.
2 Define the edge distance between the main part and the clip

angle.
3 Define the edge distance between the clip angle and the last

secondary part.
4 Define the edge distance between the clip angles.
5 Define the gap distance between the gusset plate edge and the

second part.
6 Define the gusset plate corner angle (in degrees).

This value affects the gusset plate shape.
7 Define the length of the edge of the gusset plate.

This value affects the gusset plate shape.
8 Define the distance between the gusset plate and the brace.

Gusset tab
Use the Gusset tab to control the gusset plate properties.
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Gusset plate

Option Description
Gusset Thickness, width and height of the

gusset plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

NOTE The following examples show only some of the available options. You
will find more options on the Gusset tab.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.

Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.
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Option Description
Define how much the gusset plate is
moved in the y direction.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.

Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Gusset plate shape

The gusset plate edge can be perpendicular either to the main part or the
secondary part.

Option Description
Select the gusset plate edge shape
between the last and second last
secondary part.
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Option Description
Select the gusset plate egde shape
between the main part and the first
secondary part.

Gusset plate fitting

Option Description
Select whether the gusset is fitted to
the last selected secondary part.

Gusset welding

Option Description
Default

Gusset plate is welded to the main part.

AutoDefaults can change this option.
Gusset plate is welded to the main part.

Gusset plate is welded to the secondary
part.

Gusset plate inner corner
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Define the horizontal and vertical chamfer dimensions.

Option Description
Default

No chamfer

AutoDefaults can change this option.
No chamfer

Line chamfer

Convex chamfer

Concave chamfer

Bevel

Square

Brace conn tab
Use the Brace conn tab to control connection plate, clip angle, filler plate, and
shear tab properties.

Plates

Option Description
Connection plate Thickness and width of the connection plate.

Select the connection plate profile.
Upper clip angle

Lower clip angle

Select the clip angle profile.

Filler plate Thickness of the filler plate.
Upper shear tab Thickness, width and height of the upper shear

tab.
Lower shear tab Height of the lower shear tab.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Plate creation

Option Description
Select whether one or two connection
plates are created between the brace
web and the gusset plate.

Select whether a filler plate is created
between the connection plate and the
brace web.

The default is that a filler plate is not
created.
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Option Description
Select the filler plate creation side.

You can use this option when you
have selected to create two
connection plates.

Clip angle creation

Define whether the braces are attached to the gusset plate using clip angles or
shear tabs, and specify the number of clip angles to create. The default option
is to create two clip angles below the brace web.

Clip angle orientation

Define how the clip angle is placed on the connection.
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Option Description
Default

Clip angle is placed on the connection
so that the longer leg is connected to
the gusset plate.

AutoDefaults can change this option.
Clip angle is placed on the connection
so that the longer leg is connected to
the main part.

Connection type

Option Description
Select the connection type (weld or
bolts) between the gusset plate and
the connection plate.

Select the connection type (weld or
bolt) between the gusset plate and
the clip angle.

Connection plate gap dimensions

 Description
1 Horizontal gap dimension
2 Vertical gap dimension
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Shim plates tab
Use the Shim plates tab to define shim plate properties.

Plates

Option Description
Shim plate 1

Shim plate 2

Shim plate 2

Thickness, width and height of the
shim plate.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Shim plate position

You can create shim plates when connecting braces to the gusset plate using
clip angles.

 Description
1 Define the gap between the brace and connection plate.
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 Description
2 Define how many shim plates are created at the top and bottom

flanges.

Enter the shim plate profile numbers: 1, 2 or 3. These are the
numbers that are on the upper part on the Shim plates tab.

For example, if you want to create three shim plates at the top
flange, and you want to use Shim plate 1 twice and Shim plate
1 once, enter 1 1 2. The first number you enter is the shim plate
closest to the brace flange.

Stiffeners tab
Use the Stiffeners tab to control the stiffener properties and dimensions.

Stiffeners

Option Description
Stiffener 1

Stiffener 2

Thickness of the stiffener.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Steel components 2540 Bracing components



Stiffener length

 Description
1 Distance between the stiffener edge and the gusset plate

edge.
2 Length of stiffener.

Stiffener dimensions

 Description
1 Width of the stiffener.
2 Length of the stiffener base.
3 Length of the skew part of the stiffener.
4 Distance from the stiffener center line.
5 Vertical distance between the stiffener base and the skew

part.
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Brace bolts 1 / Brace bolts 2 tab
Use the Brace bolts 1 and Brace bolts 2 tabs to control the bolts that connect
the first and second brace to the gusset plate.

Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Dimension for vertical bolt group position.
5 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.
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 Description
• Middle: From the center line of the bolts to the center line of

the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

6 Select the bolt type.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2
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Option Description
Staggered type 3

Staggered type 4

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Angle bolts 1 / Angle bolts 2 tabs
Use the Angle bolts tabs to control the bolts that connect the clip angles.
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Bolt group dimensions

 Description
1 Number of bolts.
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts, enter
2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Dimension for vertical bolt group position.

Bolt distance

Define the minimum distance from the connection plate bolts to the
intersection point of the main part and brace center lines. If a brace is
perpendicular to the main part, the distance is measured from the main part
center line to the nearest bolts.

Option Option

Vertical bolt position

Option Description
Bolt position from the clip angle edge.
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Option Description
Bolt position from the secondary part
center line.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.
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Option Description Default
Rotate Slots When the hole type is Slotted,

this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Create welds

Bent gusset (140)
Bent gusset (140) connects braces in different planes to one or more beams
or columns that are in different planes. The component creates a gusset plate
that is bent along two bending lines, and seals tube or hollow profile braces.

Objects created

• Gusset plate

• Seal plates

• Bolts

• Welds
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Use for

Situation Description
Gusset plate is connected to L profile
braces.

Do not use for

Beams or columns that are in the same plane.

Before you start

Create one or more beams and columns, and 1 to 10 braces.

Selection order

1. Select the beam or column in the first plane.

2. Select the first brace.

3. Select the second and subsequent braces in the first plane.

4. Select the braces in planes 2 and 3.

5. Select the beam or column in the second plane.

6. Click the middle mouse button to create the component

Part identification key

 Description
1 Gusset plate
2 Seal plate
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Picture tab
Use the Picture tab to define the gusset plate dimensions, clearance between
the braces, and cut options for the brace ends.

Dimensions

 Description
1 Length of the gusset plate edge
2 Gusset plate corner angle (in degrees)
3 Brace edge distance from the main part
4 Bending line offset from the secondary part

Brace end cut

Option Description
Default

Brace ends are cut square.

AutoDefaults can change this option.
Brace ends are cut square.

Brace ends are cut perpendicular.

Gusset tab
Use the Gusset tab to define the gusset plate properties, brace notch
properties, and the weld options.
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Parts

Option Description
Gusset Thickness, width, and height of the

gusset plate

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

NOTE The following examples show only some of the available options. You
will find more options on the Gusset tab.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.

Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.
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Option Description
Define how much the gusset plate is
moved in the y direction.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.

Option Description
Default

AutoDefaults can change this option.

This option optimizes the gusset plate
weight.

Brace position

Option Description
Default

The brace position is not affected.

AutoDefaults can change this option.

The first selected brace is placed
closest to the main part.

Brace notch

Option Description
Select whether the brace is notched.

You may want to notch the brace if
the plate collides with the brace
flange or if you want to create slots in
the hollow braces.

The last option creates a notch and
fastens the plate to the brace by using
a bolt.
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Option Description
1. Vertical notch dimension

2. Horizontal notch dimension

3. Notch angle

Gusset plate shape

Option Description
Select the gusset plate shape.
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Gusset plate cut

Option Description
Select whether the gusset plate is cut
at the top.

Gusset plate hole

You may need to create an orientation hole in the gusset plate to indicate the
position of the plate when the connection is assembled in the shop, or during
erection.

Option Description
Select whether a hole is created in the
gusset plate, and the hole side.

Steel components 2554 Bracing components



Option Description
1. Define the distance from the

center of the hole to the gusset
plate edge.

2. Define the hole diameter.

Gusset plate welding

Option Description
Select whether the gusset plate is
welded to the brace.

Bending line dimensions

Option Description
Enter the bending line dimensions for
the gusset plate in skewed
connections.

The gusset plate is bent by the angles
created by the secondary parts.

Dimensioning holes in drawings

Set Create extra bolt holes for gusset to Yes to create an extra bolt hole that
is perpendicular to the gusset plate. This helps to ensure that the hole
dimensions are correct when the gusset plate is skewed so that the gusset
hole is not perpendicular to the gusset plate.

Gusset bolts tab
Use the Gusset bolts tab to define the bolt group dimensions and the bolt
properties.
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Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Select how to measure the dimensions for horizontal bolt

group position.
3 Dimension for vertical bolt group position.
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 Description
4 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line
of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

5 Number of bolts.

Steel components 2557 Bracing components



 Description
6 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Gusset plate connection type

Option Description
Default

Gusset plate is welded.

AutoDefaults can change this option.
Gusset plate is welded.

Gusset plate is bolted.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Brace bolts 1 tab
Use the Brace bolts 1 tab to define the bolt group dimensions and the bolt
properties.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
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 Description
2 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line
of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.
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 Description
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt distance

Define the minimum distance from the brace bolts to the intersection point of
the main part and brace center lines. If a brace is perpendicular to the main
part, the distance is measured from the main part center line to the nearest
bolts.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Brace bolts 2/Brace bolts 3 tab
Use the Brace bolts 2 and Brace bolts 3 tabs to define the bolt group
dimensions and the bolt properties.
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Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
2 Select how to measure the dimensions for horizontal bolt

group position.

• Left: From the left edge of the secondary part to the
leftmost bolt.
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 Description
• Middle: From the center line of the secondary part to the

center line of the bolts.

• Right: From the right edge of the secondary part to the
rightmost bolt.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt distance

Define the minimum distance from the brace bolts to the intersection point of
the main part and brace center lines. If a brace is perpendicular to the main
part, the distance is measured from the main part center line to the nearest
bolts.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Plates tab
Use the Plates tab to define the shim plate creation, and how the braces are
bolted to the gusset plate and to the first or second beam or column.
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Shim plate

Option Description
Default

Shim plate is created.

AutoDefaults can change this option.
Shim plate is not created.

Shim plate is created.

Double-bolting braces

By default, braces are bolted to the gusset plate. You can also select to bolt
braces to the first or second beam, or to the selected column.

Option Description
Bolts braces to the gusset plate.

This is the default option.

Bolts the first selected brace to both
the gusset plate and the first selected
beam or column.

Bolts the first and subsequently
selected braces to both the gusset
plate and the first selected beam or
column.

Dimensions
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 Description
1 Bolt edge distance
2 Distance to fit the secondary part
3 Distance to fit the secondary part
4 Brace edge dimension

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Create welds

Heavy brace (165)
Heavy brace (165) connects a single brace to a gusset plate where two parts
meet to form a corner.

Objects created

• Gusset plate

• Connection plates (flange and web)

• Rib plates

• Shim plates (flange and web)

• Stiffeners

• Bolts

• Welds
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Use for

Situation Description
Gusset plate is welded to the column.
Brace web is bolted to the gusset
plate with a connection plate. Rib
plates are indicated with 1 in the
image.

Column or beam profile: RHS, tube, I

Brace profile: H

Do not use for

Sloped or skewed beams

Before you start

Create two parts that meet to form a corner, and one brace.

Selection order

1. Select the first part that forms the corner.

2. Select the first brace.

3. Select the second and subsequent braces.

4. Select the second part that forms the corner.

5. Click the middle mouse button to create the component.

Part identification key
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 Description
1 Gusset plate
2 Connection plate
3 Rib plate
4 Stiffener

Picture tab
Use the Picture tab to define the dimensions of the gusset plate and the rib
plate, and the clearance between the plate and the brace.

Dimensions

 Description
1 Vertical dimension of the gusset plate
2 Rib plate edge dimension from the main part
3 Rib plate dimension to the gusset plate edge
4 Connection plate dimension to the gusset plate edge
5 Clearance between the gusset plate and the brace
6 Gusset plate length
7 Horizontal dimension of the gusset plate
8 Gusset plate edge dimension to the reference point
9 Secondary part edge dimension to the shim plate edge

Parts tab
Use the Parts tab to define the part properties.
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Parts

Option Description
Gusset plate Thickness of the gusset plate
Flange plates Thickness of the flange plates
Web plates Thickness of the web plates
Rib plates Thickness of the rib plates
Stiffener 1 Thickness of the stiffener
Stiffener 2 Thickness of the stiffener
Flange filler plates Thickness of the flange shim plates

The thickness of the shim plates
depends on the gap between the
connection plate and the brace flange
or web, as shown in the table below.

Web filler plates Thickness of the web shim plates

The thickness of the shim plates
depends on the gap between the
connection plate and the brace flange
or web, as shown in the table below.

Gap
(mm)

Flange filler
plate

thickness

Web filler
plate

thickness
1 No plate No plate
2 2.3 1.6
3 3.2 1.6
4 4.5 2.3
5 4.5 2.3
6 6.0 3.2
7 6.0 3.2
8 9.0 4.5
9 9.0 4.5
10 9 4.5

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.
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Option Description Default
assembly position
number.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Gusset tab
Use the Gusset tab to define the gusset plate chamfers, and the gap between
the gusset plate and the brace.

Gusset plate chamfers

Option Description
No chamfer

Line chamfer

Define the horizontal and vertical
chamfer dimension.
Concave chamfer

Define the horizontal chamfer.
Concave chamfer

Define the horizontal and vertical
chamfer.

Ribs tab
Use the Ribs tab to define the size and location of the rib plates.

Option Description
Ribs same length Select whether the rib plates have the

same length.
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Option Description
Flange single plate Select whether to create a single

flange plate.

Plate length

 Description
1 Length of the first rib
2 Length of the second rib

Rib plate dimensions

Tekla Structures automatically calculates the following dimensions from the
length of the rib plate and bolt group properties.

Define the following dimensions:
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 Description
1 Horizontal rib dimension
2 Vertical rib dimensions
3 Horizontal rib dimension

Stiffeners tab
Use the Stiffeners tab to define the stiffener dimensions.

Stiffener length

 Description
1 Distance between the stiffener edge and the gusset plate edge
2 Length of the stiffener

Stiffener dimensions

 Description
1 Width of the stiffener.
2 Length of the stiffener base.
3 Length of the skew part of the stiffener.
4 Distance from the stiffener center line.
5 Vertical distance between the stiffener base and the skew

part.
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Web bolts tab
Use the Web bolts tab to define the bolt group dimensions and the properties
of the bolts that fasten the web connection plate to the gusset plate.

Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site
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Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.
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Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Flange bolts tab
Use the Flange bolts tab to define bolt group dimensions and the properties
of the bolts that fasten the flange connection plate to the gusset plate.

Bolt group dimensions

 Description
1 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

2 Number of bolts.
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 Description
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

4 Dimension for vertical bolt group position.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within the
bolted parts when bolts
are used with a shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.
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Option Description Default
Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Defining plate sizes in marketsizes.dat
In the Japanese environment, Heavy brace (165) takes the default thickness
values for several plates from the marketsizes.dat file, located in the
\profil\ folder. This file lists the standard plate thicknesses available in
specific material grades. Edit this file by using any standard text editor, such as
Notepad.

NOTE Enter a thickness value on the Parts tab to override the default value
for any plate.
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Example

In this example, the marketsizes.dat file lists the standard plate thicknesses
available in material grade SS400. The DEFAULT line lists the thicknesses
available in all other material grades.

# Market size (thickness) table 
 # Specify the material as given in Tekla Structures material database 
 # and after that the market sizes separated by commas 
 SS400,1.6,2.3,3.2,4.5,6,9,12,16,19,22,25,28,32,38 
 DEFAULT,6,9,12,16,19,22,25,28,32,38

marketsizes.dat file

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Create welds

Windbracing connections
Use the following components to automatically create windbracing:

Component Image Description
Windbracing (1)
(page 2582)

Connects a single brace to a
beam or column, using a
connection plate, round
plates, a threaded rod, and
nuts.
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Component Image Description
Wind column (5)
(page 2591)

Connects a rafter to a wind
column by using a single L
profile or a twin seat profile.

Windbracing 2
(16) (page 2600)

Connects a single hollow
brace to a beam or a column,
using a connection plate,
threaded rod, and nuts.

Windbrace
connection
(110)
(page 2615)

Bolts braces to a gusset
plate. Welds or bolts the
gusset plate to the main
part. Braces can be:

• Located in the same work
plane as the beam or
column, or skewed

• On the same side of the
beam or column, or on
each side

Windbracing (1)
Windbracing (1) connects a single hollow brace to a beam or a column using a
connection plate, threaded rod, and nuts. Round plates are welded to the
connection plate and the connection plate is bolted to the beam or column.

NOTE Tekla Structures automatically attaches the rod to the brace so that the rod
and the brace are treated as a single part when you use commands like
DeleteMove, or Copy.

Objects created

• Connection plate

• Round plates (2)

• Shim plate

• Threaded rod

• Washer

• Nuts on rod (2)

• Bolts

• Welds
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Use for

Situation Description
The column or beam profile is H, and
the brace profile is RHS.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (brace).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Connection plate
2 Round plate
3 Threaded rod
4 Shim plate

Washer

Nut

Extra nut

Picture tab
Use the Picture tab to define the size and position of the connection and
round plates.
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Dimensions

 Description
1 Round plate vertical dimension
2 Round plate horizontal dimension
3 Connection plate thickness
4 Round plate thickness
5 Connection plate upper dimension from the hole center
6 Connection plate lower dimension from the hole center
7 Hole diameter
8 Connection plate height
9 Connection plate width

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description
Connection plate Thickness, width, and height of the

connection plate
Round plates Thickness, width, and height of the

round plates
Filler plate Select the profile from the profile

catalog.
Washer Select the profile from the profile

catalog.
Nut Select the profile from the profile

catalog.
Extra nut Select the profile from the profile

catalog.
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Thickness dimensions

 Description
1 Thickness of the shim plate
2 Thickness of the washer
3 Thickness of the nut
4 Thickness of the extra nut

Brace conn tab
Use the Brace conn tab to define the properties of the hole in the beam or
column, slot in the connection plate, position of round plates, and rod
dimensions.

Hole type

Option Description
Create hole in primary • Partcut cuts a hole for the rod.

• Bolt creates a bolt hole.

• Partcut+bolthole cuts a hole for
the rod and creates a bolt hole.

Horizontal position of round plate

Define the horizontal offset of the round plate.
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Rod dimensions

 Description
1 Rod thickness
2 Rod length, below the intersection point of the main part and

secondary part
3 Rod length, above the intersection point of the main part and

secondary part

Slot dimensions

 Description
1 Horizontal dimension
2 Vertical dimension

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.
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Bolt group dimensions

 Description
1 Select how to measure the dimensions for horizontal bolt group

position.

• Left: From the left edge of the secondary part to the leftmost
bolt.

• Middle: From the center line of the secondary part to the
center line of the bolts.
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 Description
• Right: From the right edge of the secondary part to the

rightmost bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts, enter
2 values.

6 Select how to measure the dimensions for vertical bolt group
position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.
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 Description
• Middle: From the center line of the bolts to the center line of

the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

7 Dimension for vertical bolt group position.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Wind column (5)
Wind column (5) connects a rafter to a wind column by using a single L profile
or a twin seat profile. A cap plate is added to the wind column, and a vertical
plate on top of the cap plate to be connected to the seat. The seat can be
created above or below the rafter, and the wind column is adjusted
accordingly. The seat can either be bolted or welded to the rafter and the
vertical plate.
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Objects created

• Vertical plate

• Cap plate

• L/T seat profile

• Bolts

• Welds

Use for

Situation Description
Rafter connected to a wind column.

Selection order

1. Select the main part (wind column).

2. Select the secondary part (rafter).

The connection is created automatically when the secondary part is
selected.

Part identification key

 Description
1 Cap plate
2 Vertical plate
3 L/T seat profile

Picture tab
Use the Picture tab to define the connection dimensions.
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Dimensions

 Description
1 Distance between the rafter and the seat.
2 If the seat is bolted, this dimension is the bolt edge distance of

the seat on the rafter side.

If the seat is welded, this dimension is the distance from the
rafter center line to the edge of the seat.

3 Distance from the rafter center to the nearest plate bolt.
4 Bolt edge distance.
5 Cap plate edge extension in the direction parallel to the seat.
6 Distance between the vertical plate and the seat.
7 Distance between the column center line and the vertical plate.
8 Cap plate edge extension in the direction perpendicular to the

seat.

Parts tab
Use the Parts tab to define the part properties.

Parts

Option Description
Vertical plate Thickness of the vertical plate.
Cap plate Thickness of the cap plate.
L/T profile Select the profile from the profile

catalog.
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Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Parameters tab
Use the Parameters tab to define the seat type, orientation, and position.

Seat type

Option Description
Default

Seat at the near side.

AutoDefaults can change this option.

Seat at the near side.

Seat at the far side.

Seat at both sides.
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Seat orientation

Option Description
Default

Longer leg is horizontal.

AutoDefaults can change this option.
Longer leg is horizontal.

Longer leg is vertical.

Seat position

Option Description
Default

Seat is below the rafter.

AutoDefaults can change this option.
Seat is below the rafter.

Seat is above the rafter.

Plate bolts tab
Use the Plate bolts tab to define the bolt group dimensions, bolt properties,
and the vertical plate connection to the seat.

Bolt group dimensions

 Description
1 Number of bolts.
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 Description
2 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Define which bolts are deleted from the bolt group.

Enter the bolt numbers of the bolts to be deleted and separate
the numbers with a space. Bolt numbers run from left to right
and from top to bottom.

Connection type

Select how the vertical plate is connected to the seat.

Option Description
Default

Bolted

AutoDefaults can change this option.

Bolted

Welded

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.
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To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Beam bolts
Use the Beam bolts tab to define the bolt group dimensions, bolt properties,
and the rafter connection to the seat.

Bolt group dimensions

 Description
1 Distance between the rafter center and the bolts.
2 Number of bolts.
3 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

4 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.
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Connection type

Select how the rafter is connected to the seat.

Option Description
Default

Bolted

AutoDefaults can change this option.

Bolted

Welded

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

General tab

Click the link below to find out more:

General tab
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Design tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Analysis tab

Welds

Click the link below to find out more:

Windbracing 2 (16)
Windbracing 2 (16) connects a single hollow brace to a beam or a column,
using a connection plate, threaded rod, and nuts. Round plates are welded to
the connection plate and the connection plate bolted to the beam or column.

Objects created

• Connection plate

• Round plates

• Shim plate

• Threaded rod

• Nuts on rod

• Tube profile

Use for

Situation Description
Windbracing, connection plate is
bolted to the column. Round plates
are welded to the connection plate.
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Situation Description
Windbracing, connection plate is
bolted to the column. Round plates
are welded to the connection plate.

Windbracing, without round plate.

Windbracing, triangular plate.

Before you start

Create a beam or a column and one brace.

Selection order

1. Select the beam or the column (main part).
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2. Select the brace (secondary part).

The connection is created automatically when you select the secondary
part.

Part identification key

 Description
1 Beam - main part
2 Brace - secondary part
3 Windbracing connection with connection plate, round plate, and

bolts

Picture tab
Use the Picture tab to define the size and the position of the connection plate
and the round plate.
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Plate dimensions

 Description
1 Width of the round plate.
2 Height of the round plate.
3 Thickness of the connection plate.
4 Thickness of the round plate.
5 Distance from the top of the connection plate to the center of

the slotted hole.
6 Vertical distance from the center of the slotted hole to the center

of the bolt group.
7 Height of the connection plate.
8 Width of the connection plate.

Round plate or tube

Option Description
Round plates with a threaded rod.

Tapered tube with a threaded rod.

Threaded rod.
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Option Description
Triangular plate on the tie rod side with a
threaded rod.

Triangular plate at the end side with a
threaded rod.

Triangular plates on both sides with a
threaded rod.

No plates or a threaded rod.

Triangular plate on the tie rod side.

Triangular plate at the end side.

Triangular plates on both sides.

No plates or a threaded rod.

Rod welded to an L profile.

Create assembly with connecting parts

Define whether or not the connecting parts (shim plate, washer, nuts) are
welded together.

Weld connecting parts

Define which parts are welded.

Parts tab
Use the Parts tab to define the part properties.
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Parts

Option Description
Connection plate Thickness, width, and height of the

connection plate.
Round plate Thickness, width, and height of the

round plate.
Filler Select the profile from the profile

catalog.

Tekla Structures creates a simplified
shim plate. In reality, the plate is
curved on one side, equal to the
radius of the round plate.

Enter the width and height, for
example PL50*50 or 50*50.

Washer Select the profile from the profile
catalog.

Nut Select the profile from the profile
catalog.

Extra nut Select the profile from the profile
catalog.

Tube Select the profile from the profile
catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Comment Add a comment about

the part.
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Thickness dimensions

 Description
1 Thickness of the shim plate.
2 Thickness of the washer.
3 Thickness of the nut.
4 Thickness of the extra nut.

Parameters tab
Use the Parameters tab to define the rod and hole dimensions.

Hole creation

Define how the hole is created in the main part.

Option Example
Hole by part cut
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Option Example
Hole by bolt

Hole by part cut and bolt

Connection method

Define how the round plates are joined to the connection plate.
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Dimensions

 Description
1 Diameter of the rod end.
2 Offset from the secondary part edges.
3 Length of the connecting piece. You can define this if a tube is

created.

Length is measured along the center line.

4 Slot length in the main part.
5 Rod length to the center of the main part.
6 Rod length to the center of the main part.
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 Description
7 Define how the callote is welded.

When not welded, the calotte is connected to the main part with
a bolted connection.

8 Vertical offset of the round plates. Define a value to offset the
plates in the vertical direction.

9 Slotted hole height.
10 Slotted hole width.
11 Define how the rod connection is welded.
12 Slotted hole height in the main part.
13 Slotted hole width in the main part.

Bolts tab
Use the Bolts tab to define the bolt group dimensions and bolt properties.

Bolt group dimensions
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 Description
1 Select how to measure the dimensions for horizontal bolt

group position.

• Left: From the left edge of the secondary part to the
leftmost bolt.

• Middle: From the center line of the secondary part to the
center line of the bolts.
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 Description
• Right: From the right edge of the secondary part to the

rightmost bolt.

2 Dimension for horizontal bolt group position.
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.
Select how to measure the dimensions for vertical bolt group
position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

Steel components 2611 Bracing components



 Description
• Middle: From the center line of the bolts to the center line

of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

Dimension for vertical bolt group position.

Basic bolt properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

16 mm
Bolt standard Bolt standard to be used

inside the component.
Available standards are
defined in the bolt
assembly catalog.

4014-8.8
Tolerance Gap between the bolt

and the hole.
4 mm

Thread in mat Defines whether the
thread may be within

Yes
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Option Description Default
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Cut length

Defines the depth at which Tekla Structures searches for the sections of the
bolted parts. You can determine whether the bolt will go through one flange or
two.

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.
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Examples of slotted holes

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

UDA tab
Use the UDA tab to define the user-defined attributes for the connection plate.

You can define the fabricator name, type, nomination, article number, product
code, and product description.

General

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Welds

Click the link below to find out more:
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Windbrace connection (110)
Windbrace connection (110) connects 1 to 10 braces to a beam or column by
bolting them to a gusset plate, and welding or bolting the gusset plate to the
beam or column.

The braces can be:

• Located in the same work plane as the beam or column, or they can be
skewed

• On the same side or on each side of the beam or column

Objects created

• Gusset plate

• One gusset plate, if the braces are located on the same side of the
beam or column

• One gusset plate on each side of the beam or column, if the braces are
located on either side of the beam or column. The plates are welded in
the shop to create a folded gusset plate.

• Bolts

• Welds

Use for

Situation Description
Two gusset plates welded in the shop
to form a folded plate. Braces are
bolted directly to the gusset plate.

Brace profile: L
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Situation Description
Gusset plate is welded to the column.
Brace webs are bolted to the gusset
plate. Stiffeners are not created.

Column or beam profile: L

Brace profile: L

Before you start

Create a beam or column, and 1 to 10 braces.

Selection order

1. Select the main part (beam or column).

2. Select the secondary part (first brace).

3. Select the second secondary parts (second brace, up to 10 braces).

4. Click the middle mouse button to create the connection.

Part identification key

 Description
1 Gusset plate

Picture tab
Use the Picture tab to define the gusset plate dimensions, brace clearance,
and cut options for the brace ends on both sides of the main part.

Dimensions
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 Description
1 Length of the edge of the gusset plate

This value affects the gusset plate shape.
2 Gusset plate corner angle (in degrees)

This value affects the gusset plate shape.
3 Brace edge distance from the main part
4 Gusset plate edge distance from the main part

Brace end cut

Option Description
Default

Brace ends are cut square.

AutoDefaults can change this option.
Brace ends are cut square.

Brace ends are cut perpendicular.

Gusset tab
Use the Gusset tab to define the gusset plate properties, brace notch
properties, and welding.

Parts

Option Description
Gusset Thickness, width, and height of the

gusset plate

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
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Option Description Default
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Finish Describes how the part
surface has been
treated.

 

NOTE The following examples show only some of the available options. You
will find more options on the Gusset tab.

Gusset plate position on the brace

Define where to place the gusset plate on the brace. If needed, you can fine-
tune the gusset plate position by moving the gusset plate in the z or in the y
direction.

Option Description
Default

Gusset plate is positioned in the
middle of the brace.

AutoDefaults can change this option.
Gusset plate is positioned on the top
flange of the brace.

Define how much the gusset plate is
moved in the z direction.

Define how much the gusset plate is
moved in the y direction.

Gusset plate shape

When you select the option to optimize the gusset plate weight, you can define
whether the selection order of the braces affects the position of the braces.

Option Description
Default

AutoDefaults can change this option.
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Option Description
This option optimizes the gusset plate
weight.

Brace position

Option Description
Default

The brace position is not affected.

AutoDefaults can change this option.

The first selected brace is placed
closest to the main part.

Brace notch

Option Description
Select whether the brace is notched.

You might want to notch the brace if
the plate collides with the brace
flange or if you want to create slots in
the hollow braces.

The last option creates a notch and
fastens the plate to the brace by using
a bolt.

1. Vertical notch dimension

2. Horizontal notch dimension

3. Notch angle
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Gusset plate shape

Option Description
Select the gusset plate shape.

Gusset plate cut

Option Description
Select whether the gusset plate is cut
at the top.
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Gusset plate hole

You might need to create an orientation hole in the gusset plate to indicate the
position of the plate when the connection is assembled in the shop, or during
erection.

Option Description
Select whether a hole is created in the
gusset plate, and the hole side.

1. Define the distance from the
center of the hole to the gusset
plate edge.

2. Define the hole diameter.

Gusset plate welding

Option Description
Select whether the gusset plate is
welded to the brace.
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Bending dimensions

Option Description
Enter the bending line dimensions for
the gusset plate in skewed
connections.

The gusset plate is bent by the angles
created by the secondary parts.

Dimensioning holes in drawings

Set Create extra bolt holes for gusset to Yes to create an extra bolt hole that
is perpendicular to the gusset plate. This helps to ensure that the hole
dimensions are correct when the gusset plate is skewed so that the gusset
hole is not perpendicular to the gusset plate.

Gusset bolts tab
Use the Gusset bolts tab to define the bolt group dimensions and properties
of bolts that connect the gusset plate to the beam or column.

Bolt group dimensions

 Description
1 Dimension for horizontal bolt group position.
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 Description
2 Select how to measure the dimensions for horizontal bolt

group position.

• Left: From the left edge of the secondary part to the
leftmost bolt.

• Middle: From the center line of the secondary part to the
center line of the bolts.

Steel components 2623 Bracing components



 Description
• Right: From the right edge of the secondary part to the

rightmost bolt.

3 Dimension for vertical bolt group position.
4 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.
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 Description
• Middle: From the center line of the bolts to the center line

of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

5 Number of bolts.
6 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Gusset plate connection type

Option Description
Default

Gusset plate is welded.

AutoDefaults can change this option.
Gusset plate is welded.
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Option Description
Gusset plate is bolted.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3
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Option Description
Staggered type 4

Brace bolts 1 tab
Use the Brace bolts 1 tab to define the bolt group dimensions and properties
of bolts that connect the braces to the upper brace, or to the gusset plate only.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
2 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.
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 Description
• Middle: From the center line of the bolts to the center line

of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.

3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt distance

Define the minimum distance from the brace bolts to the intersection point of
the main part and brace center lines. If a brace is perpendicular to the main
part, the distance is measured from the main part center line to the nearest
bolts.
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Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Yes

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.
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Option Description Default
2 Horizontal dimension of

slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Bolt assembly

The selected check boxes define which component objects (bolt, washers, and
nuts) are used in the bolt assembly.

If you want to create a hole only, clear all the check boxes.

To modify the bolt assembly in an existing component, select the Effect in
modify check box and click Modify.

Bolt length increase

Define how much the bolt length is increased. Use this option when, for
example, painting requires the bolt length to be increased.

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
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Option Description
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Brace bolts 2 tab
Use the Brace bolts 2 tab to define the bolt group dimensions and properties
of bolts that connect the braces to the lower gusset plate.

Bolt group dimensions

 Description
1 Dimension for vertical bolt group position.
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 Description
2 Select how to measure the dimensions for vertical bolt group

position.

• Top: From the upper edge of the secondary part to the
uppermost bolt.

• Middle: From the center line of the bolts to the center line
of the secondary part.

• Below: From the lower edge of the secondary part to the
lowest bolt.
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 Description
3 Bolt edge distance.

Edge distance is the distance from the center of a bolt to the
edge of the part.

4 Number of bolts.
5 Bolt spacing.

Use a space to separate bolt spacing values. Enter a value for
each space between bolts. For example, if there are 3 bolts,
enter 2 values.

Bolt distance

Define the minimum distance from the brace bolts to the intersection point of
the main part and brace center lines. If a brace is perpendicular to the main
part, the distance is measured from the main part center line to the nearest
bolts.

Bolt basic properties

Option Description Default
Bolt size Bolt diameter. Available sizes are

defined in the bolt
assembly catalog.

Bolt standard Bolt standard to be used
inside the component.

Available standards are
defined in the bolt
assembly catalog.

Tolerance Gap between the bolt
and the hole.

 

Thread in mat Defines whether the
thread may be within
the bolted parts when

Yes
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Option Description Default
bolts are used with a
shaft.

This has no effect when
full-threaded bolts are
used.

Site/Workshop Location where the bolts
should be attached.

Site

Slotted holes

You can define slotted, oversized, or tapped holes.

Option Description Default
1 Vertical dimension of slotted

hole.
0, which results in a
round hole.

2 Horizontal dimension of
slotted hole, or allowance for
oversized holes.

0, which results in a
round hole.

Hole type Slotted creates slotted holes.

Oversized creates oversized
or tapped holes.

No hole does not create
holes.

 

Rotate Slots When the hole type is Slotted,
this option rotates the slotted
holes.

 

Slots in Part(s) in which slotted holes
are created. The options
depend on the component in
question.

 

Staggering of bolts

Option Description
Default

Not staggered

AutoDefaults can change this option.
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Option Description
Not staggered

Staggered type 1

Staggered type 2

Staggered type 3

Staggered type 4

Brace conn tab
Use the Brace conn tab to create shim plates between the braces and the
gusset plate, to bolt the braces to the beam or column, or the gusset plate.

Shim plate

Option Description
Default

Shim plate is created.

AutoDefaults can change this option.
Shim plate is not created.

Shim plate is created.

Double-bolting braces

By default, braces are bolted to the gusset plate. You can also select to bolt
braces to the first or second beam, or to the selected column.

Option Description
Bolts braces to the gusset plate.

This is the default option.

Bolts the first selected brace to both
the gusset plate and the first selected
beam or column.
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Option Description
Bolts the first and subsequent
selected braces to both the gusset
plate and the first selected beam or
column.

Dimensions

 Description
1 Bolt edge distance
2 Distance to fit the secondary part
3 Distance to fit the secondary part
4

5

Brace edge dimension

General tab

Click the link below to find out more:

General tab

Design tab

Click the link below to find out more:

Design tab

Analysis

Click the link below to find out more:

Analysis tab
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Welds

Click the link below to find out more:

Bracing connection elements
Use the following components to create individual bracing elements, such as
stiffeners and gusset plates. You can then use these elements to connect
bracing to one or more parts, or in custom components.

Component Image Description
Crushed tube in points
(S46) (page 2637)

Creates a tube brace
between two points
using a tube crushed
between bolts.

Gusset tube in points
(S47) (page 2638)

Creates a tube brace
between two points that
you pick, using a circular
hollow section with 2
Tees at each end.

Crushed tube in bolts
(S48) (page 2639)

Creates a tube brace
using a tube crushed
between two existing
bolts.

Gusset tube in bolts
(S49) (page 2640)

Creates a tube brace
between two bolts, with
tees at both ends.

Crushed tube in points (S46)
Creates a brace between two points that you pick, using a circular hollow
section. Creates bolt groups at each end of the brace.

WARNING You cannot modify the individual objects that this component creates.

Parts created

Tube brace
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Before you start

Create 2 points.

WARNING To adjust the rotation of the tees, change the work plane before
you create the connection.

Defining properties

Use the following tabs in the dialog box to define the properties of the parts
this component creates:

Tab Contents
Picture Dimensions that define the location

of the bolts.
Parts Properties of the tube brace.
Tube pos. Options that affect the position, plane

and class of the tube.
Bolts Bolt group properties.

Selection order

1. Start point of the tube

2. End point of the tube

3. Click the middle mouse button to create the component

Gusset tube in points (S47)
Creates a brace between two points that you pick, using a circular hollow
section with 2 Tees at each end. Seals tube.

WARNING You cannot modify the individual objects that this component creates.

Parts created

• Tube

• Tees (4)

• End plate (2)

Before you start

Create two points. See .

WARNING To adjust the rotation of the tees, change the work plane before
you create the connection.
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Defining properties

Use the following tabs in the dialog box to define the properties of the parts
this component creates:

Tab Contents
Picture  
Parts Properties of the tube, end plate, and

tees
Tube pos. Options that affect the position, plane

and class of the tube.
Bolts Bolt group properties.

Selection order

1. Start point of the tube

2. End point of the tube

3. Click the middle mouse button to create the component

Crushed tube in bolts (S48)
Creates a brace using a crushed tube between two existing bolts.

WARNING You cannot modify the individual objects that this component creates.

Parts created

Tube

Before you start

Create two bolts, either manually or using a detailing component (Standard
gusset (1065) (page 1911)).

Defining properties

Use the following tabs in the dialog box to define the properties of the parts
this component creates:

Tab Contents
Picture Dimensions that define the crushed

end of the tube.
Parts Properties of the tube.
Parameters Options that affect the position, plane

and class of the tube.
Bolts  

Steel components 2639 Bracing components



Selection order

1. First bolt

2. Second bolt

3. Click the middle mouse button to create the component

Gusset tube in bolts (S49)
Creates a brace using a tube between two bolts, with a built-up T profile at
both ends. Seals tube.

WARNING You cannot modify the individual objects that this component creates.

Parts created

• Tube

• Tees (2)

• End plate

Before you start

Create 2 bolts on the plane where you want to create the brace.

Defining properties

Use the following tabs in the dialog box to define the properties of the parts
this component creates:

Tab Contents See also
Picture Dimensions that define

the end of the tube and
the tees.

 

Parts Properties of the tube,
end plate and Tees.

 

Parameters General connection
properties.

Bolts Properties of bolts.  

Selection order

1. First bolt

2. Second bolt

3. Click the middle mouse button to create the component
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2.19 Tower components
You can use tower components to automatically create:

• Complete towers, and tower elements such as legs and bracing

• Brace to tower leg connections

• Brace to brace connections

See also

Tower elements (page 2641)

Brace to tower leg connections (page 2647)

Brace to brace connections (page 2654)

Editing tools (page 2661)

Tower elements
Tekla Structures includes the following components that you can use to
automatically create a complete tower, or structural elements, such as tower
legs or bracing:

Component Icon Description
Tower
generation (S43)
(page 2642)

Creates a complete tower.

Tower member
(S63)
(page 2643)

Creates tower legs.

Transmission
tower cross arm
(S65)
(page 2645)

Creates cross arms using
bent, angle-profile cleats.

Tower diagonal
(S66)
(page 2646)

Creates bracing panels.
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Tower generation (S43)
Creates a complete tower, with a square or rectangular base.

Profiles

Tower legs: L

Bracing: L, flat, U, twin

Parts created

• Tower legs (4)

• Bracing panels (you define the quantity)

Use for

Situation Description
 

Before you start

Check the current work plane, as it affects the position of the tower. For more
information, read Position of the tower (S43, S63) (page 2666)

Defining properties

Use the following tabs in the component dialog box to define the properties of
the parts this component creates:
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Tab Contents See also
Picture Quantity of bracing panels,

dimensions that define the
location of cross braces on
the tower legs.

Defining bracing panels
(S43, S66) (page 2672)

Parts Part properties, profiles for
legs and bracing.

 

Leg Parameters Quantity of profiles in each
leg, lift length, option to tile
profiles

Defining tower legs (S63)
(page 2669)

Tower Parameters Options that define the
type of bracing to create,
class numbers of bracing.

Defining bracing panels
(S43, S66) (page 2672)

Twin Profiles Options to use twin
profiles for bracing.

 

Model Points  Creating construction
points (S43, S66)
(page 2666)

Joints Components that connect
braces to tower legs.

Defining bracing
connections (S43, S66)
(page 2672)

Picking order

Pick a point to indicate the position of the tower leg at the bottom left corner
of the base of the tower.

Tower member (S63)
Creates the 4 legs of a tower, using angle profiles. The legs form a square or
rectangular base.

Parts created

Legs (4)
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Use for

Situation Description
 

Before you start

Check the current work plane, as it affects the position of the tower. For more
information, read Position of the tower (S43, S63) (page 2666)

Defining properties

Use the following tabs in the component dialog box to define the properties of
the parts this component creates:

Tab Contents See also
Picture Properties of angle

profiles, quantity of
profiles in each leg, lift
length, option to tile
profiles.

Defining tower legs
(S63) (page 2669)

Creating sloping
legs (S63)
(page 2670)

Parts  
Parameters Gaps between angle

profiles
Pattern of angle
profiles (S63)
(page 2670)

Picking order

Pick a point to indicate the lower left corner of the tower.
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Transmission tower cross arm (S65)
Creates cross arms using bent, angle-profile cleats.

Parts created

Bent, angle-profile cleats

Use for

Situation

Do not use for

Twin-profile cross arms.

Before you start

Create 5 points. The 5th point must be in the center of the pattern, vertically:

Defining properties

Use the following tabs in the component dialog box to define the properties of
the parts this component creates:

Tab Contents See also
Picture Dimensions that define

the shape and size of the
upper and lower cross
arms.

 

Parts Part properties of the
cross arms.
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Tab Contents See also
Parameters Layout of profiles Layout of profiles (S65)

(page 2671)

Picking order

The picking order depends on the location of the 5th point:

Tower diagonal (S66)
Creates bracing panels between 2 or 4 existing columns.

Profiles

Bracing: L, flat, U, twin

Parts created

• Horizontal braces

• Diagonal braces

Use for

Situation Description
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Before you start

Create 2 or 4 tower legs.

Defining properties

Use the following tabs in the component dialog box to define the properties of
the parts this component creates:

Tab Contents See also
Picture Dimensions that define

the location of diagonal
braces, quantity of
bracing panels.

Defining bracing panels
(S43, S66) (page 2672)

Parts Part properties of the
horizontal and diagonal
braces.

 

Parameters Options that define the
type of bracing to create.

Defining bracing panels
(S43, S66) (page 2672)

Twin Profiles Option to create twin-
profile braces, position
of twin profiles.

 

Model Points Option to create
construction points,
construction point
properties.

Creating construction
points (S43, S66)
(page 2666)

Joints Components to use to
connect braces to tower
legs.

Defining bracing
connections (S43, S66)
(page 2672)

Picking order

1. Pick the tower legs clockwise, starting with the top left leg:

2. Click the middle mouse button to create the component
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Brace to tower leg connections
Tekla Structures includes the following components to connect one or more
braces to tower legs:

Component Icon Description
Tower 1
diagonal (87)
(page 2648)

Bolts 1 diagonal brace to a
tower leg.

Tower 2
diagonal (89)
(page 2650)

Bolts 2 diagonal braces to a
tower leg.

Leg - 2 and 3
diagonals (177)
(page 2651)

Bolts 2 diagonal braces and
1 horizontal brace
(optional) to a tower leg.
No gusset plate.

Leg - 1 diagonal
(178)
(page 2653)

Bolts 1 diagonal brace
directly to the outside or
inside face of a tower leg.
No gusset plate.

Tower 1 diagonal (87)
Bolts 1 diagonal brace to a tower leg.

Profiles

Brace and tower leg: L

Parts created

-
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Use for

Situation

Before you start

Create a tower leg and a brace.

Defining properties

Use the following tabs in the component dialog box to define the properties of
the parts this component creates:

Tab Contents See also
Picture Option to create bolts,

Location of bolts.
About bolt gage lines
(page 2678)

Creating bolts (89)
(page 2681)

Parts Option to cut vertical leg
of brace, dimensions of
cut.

Cutting braces (87, 89)
(page 2673)

Bolts Bolt properties  
General Connection properties,

AutoDefaults and
AutoConnection rule
groups.
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Tab Contents See also
Extra cuts Option to cut horizontal

leg of brace, dimensions
of cut.

 

Check   
Analysis Information used in

structural analysis

Selection order

1. Tower leg

2. Brace

Tower 2 diagonal (89)
Bolts 2 diagonal braces to a tower leg.

Parts created

-

Use for

Situation More information
 

Do not use for

Braces that clash.

Before you start

Create a tower leg and 2 diagonal braces.

Defining properties

Use the following tabs in the component dialog box to define the properties of
this component:
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Tab Contents See also
Picture Bolt gages that define

the location of bolts that
connect all parts.

About bolt gage lines
(page 2678)

Creating bolts (89)
(page 2681)

Picture2 Bolt gages that define
the location of bolts in
the bolt groups that
connect:

• 1st brace to the
tower leg

• 2nd brace to the
tower leg

 

Parts Dimensions that define
the cuts in the vertical
legs of the diagonal
braces.

Cutting braces (87, 89)
(page 2673)

General Connection properties,
AutoDefaults and
AutoConnection rule
groups.

Cuts d.1 Dimensions that define
the cuts in the horizontal
leg of the first brace
picked.

Cutting braces (87, 89)
(page 2673)

Cuts d.2 Dimensions that define
the cuts in the horizontal
leg of the second brace
picked.

 

Bolts Bolt properties.  
Check   
Analysis Information used in

structural analysis

Selection order

1. Tower leg

2. First brace

3. Second brace

4. Click the middle mouse button to create the component
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Leg - 2 and 3 diagonals (177)
Bolts 2 diagonal braces and 1 horizontal brace (optional) to a tower leg. Does
not create a gusset plate.

Profiles

Tower leg and braces: L

Parts created

Filler plates (optional)

Use for

Situation

Before you start

Create the following parts

• Tower leg

• 1 diagonal brace to the outside of the tower leg

• 1 diagonal brace to the inside of the tower leg

• 1 horizontal brace (optional)

Defining properties

Use the following tabs in the component dialog box to define the properties of
the parts this component creates:

Tab Contents See also
Picture Edge distances,

dimensions that define
the cut in the diagonal
brace on the inside of
the tower leg and the
horizontal brace.

Creating your own
defaults (177)
(page 2675)
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Tab Contents See also
Parameters Edge distances that

define the location of
bolt groups.

Creating your own
defaults (177)
(page 2675)

Bolts Bolt properties,
dimensions that define
the location of bolts, and
bolt pattern of bolt
groups.

 

General Connection properties,
AutoDefaults and
AutoConnection rule
groups.

Plates Option to create filler
plates, filler plate
properties.

Defining filler plates
(177) (page 2684)

Design Option to use UDL with
AutoDefaults, reaction
forces.

Analysis Information used in
structural analysis

Selection order

1. Tower leg

2. Diagonal brace on the inside of the tower leg

3. Diagonal brace on the outside of the tower leg

4. Horizontal brace (optional)

5. Click the middle mouse button to create the component

Leg - 1 diagonal (178)
Bolts 1 diagonal brace directly to the outside or inside face of a tower leg.

Profiles

Brace and tower leg: L

Parts created

-
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Use for

Situation More information
 

Before you start

Create a tower leg and a diagonal brace.

Defining properties

Use the following tabs in the component dialog box to define the properties of
the parts this component creates:

Tab Contents See also
Picture Dimensions that define

how the brace is cut.
 

Parameters Bolt gage lines that
define the positions of
bolts.

About bolt gage lines
(page 2678)

Bolts Quantity of bolts, bolt
properties.

 

General Connection properties,
AutoDefaults and
AutoConnection rule
groups.

Design Option to use UDL with
AutoDefaults, reaction
forces.

Analysis Information used in
structural analysis

Selection order

1. Tower leg

2. Diagonal brace
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Brace to brace connections

Component Icon Description
Bolted gusset
brace (167)
(page 2655)

Bolts 2 diagonal braces to 2
horizontal braces, using a
gusset plate.

Bolted bridge
brace (169)
(page 2656)

Bolts 2 horizontal braces
and 1 diagonal brace to a
bridge plate or angle
profile.

Bolted Brace
(181)
(page 2658)

Bolts 1 diagonal brace to 1
or 2 horizontal braces.

Bolted Plate
Brace (182)
(page 2660)

Bolts 1 diagonal brace to 1
or 2 horizontal braces,
using a plate.

Bolted gusset brace (167)
Bolts 2 diagonal braces to 2 horizontal braces, using a gusset plate.

Parts created

Gusset plate

Use for

Situation Description
Rectangular gusset plate.

Steel components 2655 Tower components



Situation Description
Braces connect to different faces of
chamfered gusset plate.

Before you start

Create 2 diagonal braces and 2 horizontal braces.

Defining properties

Use the following tabs in the component dialog box to define the properties of
the parts this component creates:

Tab Contents See also
Picture Dimensions that define

bolt locations.
About bolt gage lines
(page 2678)

Parts Properties of gusset
plate.

 

Parameters Properties of bolts in
horizontal braces, option
to chamfer gusset plate.

 

General Connection properties,
AutoDefaults and
AutoConnection rule
groups.

Analysis Information used in
structural analysis

Selection order

1. First diagonal brace

2. Second diagonal brace

3. First horizontal brace

4. Second horizontal brace

5. Click the middle mouse button to create the component
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Bolted bridge brace (169)
Bolts 2 horizontal braces and 1 diagonal brace to a bridge plate or angle
profile. Cuts the diagonal brace.

Parts created

Bridge plate or angle profile

Use for

Situation More information
 

Twin-profile diagonal braces

Angle profile used as a bridge

Do not use for

Braces on different planes, or braces that clash.

NOTE Bolted bridge brace (69) does not cut the horizontal braces.

Before you start

Create 2 horizontal braces and 1 diagonal brace (single or twin profile).
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Defining properties

Use the following tabs in the component dialog box to define the properties of
the component:

Tab Contents
Picture Dimensions that define bolt locations

and the clearance between the bridge
and horizontal braces.

Parts Part properties of the bridge.
Parameters Properties of bolts in horizontal

braces, bridge cut options.

Picking order

1. First horizontal brace

2. Second horizontal brace

3. Diagonal brace

4. If the diagonal brace is a twin profile, pick the second profile.

5. Click the middle mouse button to create the component.

 Description
1 First horizontal brace
2 Second horizontal brace
3 Diagonal brace

Bolted Brace (181)
Bolts 1 diagonal brace to 1 or 2 horizontal braces.

Parts created

-
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Use for

Situation

Do not use for

Braces that are not in the same plane.

Before you start

Create 1 diagonal brace and 1 or 2 horizontal braces. The braces can be built-
up beams.

Defining properties

Use the following tabs in the component dialog box to define the properties of
this component:

Tab Contents See also
Picture Dimensions that define

the position of bolts.
Clearance between
braces.

Defining bolt gage lines
(87) (page 2679)

Cutting braces (181, 182)
(page 2674)

Parameters Bolt and cut options for
horizontal braces.

Picking order

1. First horizontal brace

2. Diagonal brace

3. Second horizontal brace (optional)
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 Description
1 First horizontal brace
2 Diagonal brace
3 Second horizontal brace (optional)

Bolted Plate Brace (182)
Bolts 1 diagonal brace to 1 or 2 horizontal braces, using a plate. Connects the
diagonal brace to the inside or outside face of the horizontal brace.

Parts created

• Plate

• Filler plate(s)

Use for

Situation

Do not use for

Braces that are not in the same plane.

Before you start

Create 1 diagonal brace, and 1 or 2 horizontal braces.
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Defining properties

Use the following tabs in the component dialog box to define the properties of
the parts this component creates:

Tab Contents See also
Picture Dimensions that define

the location of bolts,
clearance between
horizontal braces.

About bolt gage lines
(page 2678)

Cutting braces (181, 182)
(page 2674)

Parts The properties of the
plate and optional filler
plate.

 

Parameters Shape of cut in braces,
bolt options, plate
options.

Defining filler plates
(182) (page 2685)

Creating bolts (182)
(page 2682)

Picking order

1. Horizontal brace to which to bolt the diagonal brace

2. Diagonal brace

3. Second horizontal brace (optional)

4. Click the middle mouse button to create the component

 Description
1 Horizontal brace to which to bolt the diagonal brace
2 Diagonal brace
3 Second horizontal brace (optional)

Editing tools
Use the following components to modify tower bracing:

Component Icon Description
Open/Close
angle ends

Simulates the opening or
closing of one end of an
angle profile.
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Component Icon Description
(1050)
(page 2662)
Open/Close
angle (1051)
(page 2663)

Simulates the opening or
closing of an inner portion
of an angle profile.

Autoposition
(S67)
(page 2665)

Adjusts the position of
braces connected to a
tower leg. Cuts braces.

Open/Close angle ends (1050)
Simulates the opening or closing of one end of an angle profile by cutting and
bending the profile.

NOTE Use this component to create detail drawings that indicate where to open or
close angle profiles used in tower bracing. In the shop, the angle profile is
machined, not cut.

Parts created

-

Use for

Situation More information
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Do not use for

To open or close the inner portion of an angle profile, use Open/Close angle
(1051) (page 2663).

Before you start

• Create an angle profile

• Create a point to locate the component

• Set the work plane parallel to the outer face of the leg of the angle profile
that you want to bend:

Defining properties

Use the following tab in the Open/Close angle ends (1050) dialog box to
define the properties of the component:

Tab Contents More information
Parameters Which leg to open or

close, location of cut,
bend angle.

Adjusting length of
leg to open or close
(1050, 1051)
(page 2667)

Picking order

1. Angle profile

2. A point on the angle profile

Open/Close angle (1051)
Simulates the opening or closing of an inner portion of an angle profile by
cutting and bending the profile.

NOTE Use this component to create detail drawings that indicate where to open or
close angle profiles used in tower bracing. In the shop, the angle profile is
machined, not cut.
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Parts created

-

Use for

Situation More information
 

 

Do not use for

To open or close one end of an angle profile, use Open/Close angle ends
(1050) (page 2662).

Before you start

• Create a point to locate the component

• Set the work plane parallel to the outer face of the leg of the angle profile
that you want to bend:

Defining properties

Use the following tabs in the component dialog box to define the properties of
the component:
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Tab Contents More information
Parameters Which leg to open or

close, location of cut,
bend angle.

Adjusting length of
leg to open or close
(1050, 1051)
(page 2667)

Picking order

1. Angle profile

2. A point on the angle profile

Autoposition (S67)
Adjusts the position of 1 or 2 braces connected to a tower leg. Cuts braces.

WARNING Use Autoposition (S67) when you have completed all other work on a
model. Changing the model may override the adjustments you make
using this component.

Parts created

-

Before you start

Create 1 or 2 braces and connect them to a tower leg.

Defining properties

Use the following tab in the component dialog box to adjust the braces and
create cuts:

Tab Contents See also
Picture  Moving and cutting

braces (S67)
(page 2676)

Picking order

1. Tower leg

2. First brace

3. Second brace (optional)

4. Click the middle mouse button
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Defining general properties
Click the links below to find out more:

• Position of the tower (S43, S63) (page 2666)

• Creating construction points (S43, S66) (page 2666)

• Adjusting length of leg to open or close (1050, 1051) (page 2667)

Position of the tower (S43, S63)
Tekla Structures creates the tower along the z axis of the current work plane. If
the tower has a rectangular base, the longest side of the base runs parallel to
the x axis:

 Description
1 Base of tower
2 Top of tower

Creating construction points (S43, S66)
Construction points are points that you can pick to attach components to parts.
For example, you might create construction points on tower legs to use to
connect bracing to the legs.

To create construction points on tower legs or braces, go to the Model Points
tab. For each type of brace:

• Select the location of the points (1). For example, select Before to create
points on the outer face of a brace;
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• Enter the distance between the points, followed by the quantity of points
(2). For example, enter 400*4 to create 4 points, 400 mm apart.

Adjusting length of leg to open or close (1050, 1051)
To adjust the length of leg to open or close, go to the Parameters tab and
enter one of the following dimensions:

Field Description
External length of the portion
to be opened/closed

Measured from the point
you pick to create the
component towards the
start of the part reference
line

Internal length of the portion
to be opened/closed

Measured from the point
you pick to create the
component towards the end
of the part reference line

Defining tower leg properties
This section explains how to define the properties of tower legs.

Click the links below to find out more:

• Defining tower legs (S43) (page 2667)

• Defining tower legs (S63) (page 2669)

• Layout of profiles (S65) (page 2671)

Defining tower legs (S43)
Tower legs are constructed using angle profiles.

• Creating sloping legs (S43) (page 2667)

• Type and quantity of angle profiles (S43) (page 2668)
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Creating sloping legs (S43)

To define the slope of the tower legs, go to the Leg Parameters tab and enter
the x and y dimensions of the base and top of the tower:

 Description
1 Base y
2 Top y
3 Top x
4 Base x

Type and quantity of angle profiles (S43)

To specify the angle profiles to use for the tower legs:

1. Go to the Parts tab and enter the profiles you want to use in the Profile 1,
Profile 2, etc. fields. You can specify up to 8 profile types.
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2. Go to the Profiles to be used field on the Leg Parameters tab and enter
the quantity of each profile type to use for the legs. Here we are using 6
lifts of Profile 1 to create the tower leg:

Defining tower legs (S63)
Tower legs are constructed using angle profiles.

• Type and quantity of angle profiles (S63) (page 2669)

• Creating sloping legs (S63) (page 2670)

• Pattern of angle profiles (S63) (page 2670)

• Splicing legs (S63) (page 2671)

Type and quantity of angle profiles (S63)

To define the type and quantity of angle profiles to use:

1. Go to the Picture tab. Use fields 1 to 8 to define the angle profiles you
want to use.

2. In the Profiles for part field, enter the quantity of each profile type to use
for each leg. For example, enter 6*1 to create tower legs each made up of
6 lifts with the profile type you defined in field 1.
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3. On the illustration, enter the quantity and length of the lifts that make up
each leg. Enter 6*6000 to create tower legs using 6 lifts, each 6000 long:

4. To tile specific leg lifts, enter the numbers of the lifts to tile in the Parts to
be tiled field, counting from the bottom of the leg. For example, enter 3 5
to tile lifts 3 and 5.

Creating sloping legs (S63)

To create sloping tower legs, go to the illustration on the Parts tab and enter
the x and y dimensions of the base and top sections of the tower:

 Description
1 Dimensions of top of tower
2 Dimensions of base of tower
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Pattern of angle profiles (S63)

To define the quantity of angle profiles that form each leg, in cross section, use
the graphic option on the Parts tab. The default option is one angle profile:

Splicing legs (S63)

To enable the erector to splice tower legs, go to the Parameters tab and set
the cut back distance between the angle profiles:

Layout of profiles (S65)
The options are:

Option Layout
Inside

Outside

Defining tower bracing properties
This section explains how to define the properties of tower bracing.

Click the links below to find out more:
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• Defining bracing panels (S43, S66) (page 2672)

• Defining bracing connections (S43, S66) (page 2672)

• Cutting braces (87, 89) (page 2673)

• Cutting braces (177) (page 2674)

• Cutting braces (181, 182) (page 2674)

• Creating your own defaults (177) (page 2675)

• Moving and cutting braces (S67) (page 2676)

Defining bracing panels (S43, S66)
To define the quantity of bracing panels to create between each pair of tower
legs, enter a number in the Number of Diagonals field on the Picture tab.

To define the layout of the bracing panels, go to the Tower Parameters tab
and select an option in the Type of Diagonal dropdown list. The default layout
is cross bracing:

You can also create diagonal bracing, in various layouts.

Defining bracing connections (S43, S66)
To specify the components to use to connect braces to the tower legs, go to
the Joints tab. You can use different components to connect the left and right
diagonal braces, and the horizontal braces.

WARNING You cannot use custom components to connect the braces to the tower
legs.

To define each connection, on the Joints tab:

• Select a component from the dropdown list,

or

• To select a component that is not on the dropdown list,, select Custom and
enter the component number.

You can also use a predefined set of properties for the component:

1. Enter the number of the component to use (1). Here we are using Fitting
(13).
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2. Indicate the predefined set of properties to use (2).

Cutting braces (87, 89)
To define the cuts in the legs of the braces, go to:

• Horizontal legs: Parts tab

• Vertical legs: Extra cuts tab (87), Cuts d.1 and Cuts d.2 tab (89)

These tab pages contain options to cut the legs of the braces, and the
dimensions of the cut. This is how they appear on the Parts tab:
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 Description
1 Incremental value for the angle of the cut. If you enter 2, the actual angle

can be 2, 4, 8, etc
2 Cut dimensions
3 Clearance to heel of tower leg
4 Cut options
5 Clearance between main profile leg and diagonal 2

NOTE Use the Always cut option to cut the braces and create the clearance to the
heel of the tower leg. This option overrides the bolt edge distances on the
Picture tab.

Cutting braces (177)
Leg - 2 & 3 diagonals (177) automatically cuts the braces according to the bolt
edge distances specified for each brace on the Picture tab.

Cutting braces (181, 182)
Tekla Structures automatically:

• Miters the end of the horizontal brace, or braces and

• Cuts the end of the diagonal brace, according to the bolt edge distance.

To specify these dimensions, go to the Picture tab:

 Description
1 Clearance between horizontal braces
2 Bolt edge distance

To define the shape of the cut, use the following fields:

• Switch for shape of horiz. braces cut on the Parameters tab (181).
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• Switch to manage brace cut shape on the Parameters tab (182).

Creating your own defaults (177)
Default values for all the properties in the Parameters tab, except clearance,
plus the bolt end distances of the diagonals can be specified in text files called
tower_joint_clearance_N.txt, where N is the bolt diameter. For example,
tower_joint_clearance_16.txt, tower_joint_clearance_24.txt, etc.

This file can be created in the current model folder or system folder.

If the text file for a particular bolt diameter is not found, the connection will
calculate its own default values.

The format of this text file is:

Format 1: <L-profile> <C> <D1> <D2> <D3> <D4> <E> | <C> <D1> <D2> <D3>
<D4> <E>

Format 2: <L-profile> <C> <D1> <D2> <D3> <D4> <E>

Format 3: <L-profile> <H> | <B>

Format 4: <L-profile> <H>

Where

• <L-profile> = L-profile name; eg, L200*200*20, L200/15.

• <C> = distance from the edge of the part to the nearest bolt.

• <D1> = distance from the heel of the part.

• <D2> = distance from the outside-border of the part.

• <D3> = distance from the heel of the part, away from the part.

• <D4> = distance from the cut-end of the part, if any.

• <E> = distance between bolts.

• <H> = see the section below on Format 3 & 4.

• <B> = see the section below on Format 3 & 4.

• The first set of values in Format 1 is for the first flange (h) of the part, and
the second set for the second flange (b).

• In Format 2, h and b have the same values.

• In Format 3, the first set of <C> <D1> ... <D4> <E> values are assigned with
the value of <H>, and the second assigned with <B>.

• In Format 4, both sets of values are assigned with the value of <H>.

Note that

• Lines starting with a ';' or ' ' are skipped.

• <L-profile> must start on the first position of the line.
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• There must be at least one blank space between <L-profile> and the first
value.

• The component finds only the first occurrence of the specified L-profile.

Examples
L40*5 20
L50*50*5 25 | 25
L80*10 30 30 30 30 30 30
L200/15 40 45 40 40 40 35
L200/20 40 45 40 40 40 35
RSA45*45*5 20 25 20 20 20 20
RSA100*100*8 30 45 40 40 40 35
RSA75*150*15 30 35 30 30 30 25 | 35 40 35 35 35 30
RSA150*75*15 35 40 35 35 35 30 | 30 35 30 30 30 25
RSA200*200*20 40 45 40 40 40 35

Moving and cutting braces (S67)
To move the ends of braces:

 Description
1 Define the bolt gage lines for the braces
2 Define the bolt gage line for the tower leg
3 Move points
4 Indicate which brace(s) to move
5 Enter the distance to move the point(s) where the gage lines intersect

To cut the braces:
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 Description
1 Enter the distance from the end of the brace(s) to the edge of the tower

leg
2 Select Yes to cut the brace(s)

To move bolt groups:

 Description
1 Enter the distance from the first bolt in the group to the end of the brace

Defining bolt properties
This section explains how to define the properties of bolts in tower
components.

Click the links below to find out more:

• About bolt gage lines (page 2678)

• Editing default gage lines (page 2680)

• Creating bolts (87) (page 2681)

• Creating bolts (89) (page 2681)

• Creating bolts (178) (page 2682)

• Creating bolts (181) (page 2682)

• Creating bolts (182) (page 2682)

• Bolt location (87, 89) (page 2682)
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About bolt gage lines
Several components use gage lines that you can use to:

• Define the location of bolts on a brace

• Adjust the position of individual bolts

• Remove bolts

For example, Leg 1 - diagonal (178) uses gage lines.

Gage lines specify several dimensions:

 Description
1 Distance between bolts, horizontally
2 Distance from the center of the bolt to the edge of the brace
3 Distance between bolts, vertically

To use a default set of gage lines:

• Ensure that the gauge_lines.dat file is in the profile folder of the
environment your are using,

• Leave all the fields blank on the Parameters tab.

TIP To learn how to change the default gage lines, see Editing default gage lines
(page 2680).
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Components using gauge_lines.dat

The following components use the gauge_lines.dat file:
• Tower Generation Macro (S43)

• Tower diagonal (S66)

• Auto position (S67)

• Batten plates (S85)

• Windbrace connection (110)

• Bent gusset (140)

• L splice (175)

• Parallel L profiles (176)

• Leg - 1 Diagonal (178)

See also

Bolt location (87, 89) (page 2682)

Defining bolt gage lines (87)

To define bolt gage lines for Tower 1 diagonal (87), go to the Picture tab and
enter the following dimensions:

 Description
1 Location of gage lines
2 Location of gage lines

To learn how to create bolts, see Bolt location (87, 89) (page 2682).
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Defining bolt gage lines (89)

To define bolt gage lines for each bolt group in Tower 2 diagonal (89), go to
the following tabs:

Bolt group Tab
Connects all parts Picture
Connects first and second brace
picked to the tower leg

Picture 2

For example, on the Picture tab, enter the following dimensions:

 Description
1 Location of gage lines
2 Gage line 1(second brace picked)
3 Bolt edge distances
4 Gage line 1 (first brace picked)

To learn how to create bolts, see Bolt location (87, 89) (page 2682).
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Editing default gage lines
To change the default gage lines for all components that use them, edit the file
gauge_lines. dat, with any text editor (e.g. Notepad). The file is located in
the system folder.

Creating bolts (87)
This component creates a single bolt group that connects the brace to the
tower leg. To create bolts, you need to:

• Define the bolt gage lines and edge distances. See About bolt gage lines
(page 2678)

• Create bolts, and specify the location of individual bolts. See Bolt location
(87, 89) (page 2682)

WARNING This component does not create any bolts by default. So you must define
the bolts to use.

Creating bolts (89)
This component creates several bolt groups:

 Description
1 Bolt group that connects all parts
2 Bolt group that connects the first brace picked to the tower leg
3 Bolt group that connects the second brace picked to the tower leg.

(component 89 only)
4 Tower leg

For each bolt group, you need to:
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• Define the bolt gage lines and edge distances. See About bolt gage lines
(page 2678)

• Create bolts, and specify the location of individual bolts. See Bolt location
(87, 89) (page 2682)

WARNING This component does not create any bolts by default. So you must define
the bolts to use.

Creating bolts (178)
To create bolts, go to the Parameters tab and define the bolt gage lines. See
About bolt gage lines (page 2678).

WARNING This component does not create any bolts by default, so you must define
the bolts to use.

Creating bolts (181)
By default, this component creates one bolt at the intersection of the main
bolt gages of the horizontal brace and the diagonal brace. To create a second
bolt:

1. Go to the Picture tab and define the main and secondary bolt gages for
the braces:

2. Go to the Parameters tab. Select one of the options in the Switch for
common bolt dropdown list. The default option is None.

Creating bolts (182)
By default, Tekla Structures creates the following bolts:

• One bolt where the main bolt gages of the braces intersect, which connects
all the braces to the plate.

To create a second bolt, go to the Parameters tab. Select one of the
options in the Switch for common bolt dropdown list. The default option
is None.

• A bolt on the main bolt gage line of each brace, which connects the brace
to the plate.
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Bolt location (87, 89)
Use the fields at the bottom of the Picture tab pages to create bolts in each
bolt group, use the fields at the bottom of the Picture tab page(s):

Bolt group Tab
Connects all parts Picture
Connects first and second brace
picked to the tower leg

Picture 2

• Enter 0 to create a bolt on the intersection of gage lines

• Enter 1 or more to move the bolt along the gage line, away from the end of
the brace, on either the first or second diagonal brace picked:

 Description
1 First brace picked
2 Second brace picked (component 89 only)
3 Creates bolt at intersection of gage lines
4 Moves bolt 30 mm along the gage line, away from the end of the brace

TIP To move a bolt towards the edge of the brace, enter a negative number, e.g. -10.

Defining connection material
This section explains how to define the properties of connection material in
tower components.

Click the links below to find out more:

• Defining filler plates (177) (page 2684)
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• Defining filler plates (182) (page 2685)

Defining filler plates (177)
If necessary, Leg - 2 & 3 diagonals (177) automatically creates filler plates in
the gaps between the braces and the tower leg.

 Description
 Plate 1: Between the first diagonal brace picked and the horizontal

brace
 Plate 2: Between the second diagonal brace picked and the tower leg
 Plate 3: Between the horizontal brace and the tower leg
 Plate 4: Between the first horizontal brace picked and the tower leg
1 Horizontal brace
2 First diagonal brace picked
3 Second diagonal brace picked
4 Tower leg
5 Effect in modify

To specify the properties of each filler plate, use the fields on the Plates tab.

To remove a filler plate, go to the illustration and clear the checkbox against it:

Steel components 2684 Tower components



 Description
1 To remove a plate, clear its checkbox. Here we are removing plates 1 and

2

Defining filler plates (182)
If the diagonal brace connects to the inside of the horizontal brace, Tekla
Structures creates one or more filler plates to fill the gap between the diagonal
brace and the plate:

 Description
1 Diagonal brace
2 Filler plate
3 Plate

To replace the filler plate with a ring or square washer, go to the Parameters
tab and select an option in the Switch to manage what kind of filler plate
list box.

2.20 Connection Map
This section introduces example illustrations of different connections, grouped
according to their usage.

Click the links below to find out more:

• Beam to beam framing connections (page 2686)

• Beam to column framing connections (page 2704)

• Splice connections (page 2726)

• Joist connections (page 2733)

• Vertical member to beam (page 2736)
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• Bracing connections (page 2740)

• Welded connections (page 2748)

• Details (page 2752)

Beam to beam framing connections

Shear tabs

Example Description
Full depth shear tab - secondary
beam cut short of main part.

Use Beam with stiffener (129).

Full depth shear tab - secondary part
sloped and/or skewed.

Use Beam with stiffener (129).
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Example Description
Simple shear tab to beam.

Use Shear plate simple (146).

Simple shear tab to beam - bolt
elimination option.

Use Shear plate simple (146).

Simple shear tab to beam - skewed
secondary part.

Use Shear plate simple (146).

Steel components 2687 Connection Map



Example Description
Simple shear tab to beam - sloped
(and skewed) secondary part. Bolts
and plate oriented with secondary
part.

Use Shear plate simple (146).

Simple shear tab to beam - sloped
and skewed secondary part. Valley
condition.

Use Shear plate simple (146).

Simple shear tab to beam - sloped
and skewed secondary part. Valley
condition.

Use Shear plate simple (146).
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Example Description
Partial depth shear tab to top flange
of beam - square or skewed, stiffener
option.

Use Welded to top flange (147).

Partial depth shear tab to top flange
of beam. Sloped/ square or skewed.

Use Welded to top flange (147).

Partial depth shear tab to top flange
of beam, secondary beam cut short of
main part. Square, sloped, skewed.

Use Welded to top flange S (149).
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Example Description
Full depth shear tab. Square, sloped,
skewed.

Use Full depth (184).

Full depth shear tab. Secondary beam
cut short of main part.

Use Full depth S (185).

Full depth shear tab. Secondary beam
cut short of main part. Sloped
secondary.

Use Full depth S (185).
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Example Description
Full depth shear tab. Secondary beam
cut short of main part. Sloped and
skewed secondary (hip & valley).

Use Full depth S (185).

Full depth shear tab. Secondary beam
cut short of main part. Secondary
offset. Bolt elimination option.

Use Full depth S (185).

Steel components 2691 Connection Map



Clip angles

Example Description
Clip angle connection – single-sided
clip/double-sided clip.

Use Clip angle (141).

Clip angle connection – single-sided
clip/double-sided clip. Sloped
secondary part. Various notching
options.

Use Clip angle (141).

Clip angle connection – single-sided
clip/double-sided clip. Weld
preparation option.

Use Clip angle (141).
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Example Description
Clip angle connection – single-sided
clip/double-sided clip. Sloped
secondary part.

Use Clip angle (141).

Clip angle connection – single-sided
clip/double-sided clip. Two secondary
parts. Bolted/bolted, welded/bolted,
welded/welded options.

Use Two sided clip angle (143).

Clip angle connection – single-sided
clip/double-sided clip. Two secondary
parts at differing heights.

Use Two sided clip angle (143).
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Example Description
Clip angle connection – single-sided
clip/double-sided clip. Two secondary
parts. Safety connection.

Use Two sided clip angle (143).

Clip angle connection – single-sided
clip/double-sided clip. Two secondary
parts. One sloped.

Use Two sided clip angle (143).
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End plates

Example Description
End plate connection - level or sloped,
square or skewed secondary part.
Various notching options.

Use End plate (144).

End plate connection – extended
plate with or without haunches.

Use End plate (144).

End plate connection – two secondary
parts. Automatic notch for bolt
clearance.

Use Two sided end plate (142).
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Example Description
End plate connection – two secondary
parts at differing heights.

Use Two sided end plate (142).

End plate connection – two secondary
parts. Square and /or skewed.

Use Two sided end plate (142).

End plate connection – two secondary
parts. Safety connection.

Use Two sided end plate (142).
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Example Description
End plate connection – two secondary
parts. Level and/or sloped.

Use Two sided end plate (142).

Bent plate

Example Description
Bent plate connection – skewed or
square secondary part, plate near
side and far side.

Use Bent plate (190).
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Example Description
Bent plate connection – skewed or
square secondary part, plate one
side.

Use Bent plate (190).

Bent plate connection – skewed or
square secondary part, plate one
side. Various plate placing options.

Use Bent plate (190).

Bent plate connection – skewed and
sloped (hip & valley).

Use Bent plate (190).
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Bearing type

Example Description
Beam to beam bearing connection.
Options for 1,2,3, or 4 bolts.

Use Seating (30).

Beam to beam bearing connection.
Spacer option.

Use Seating (30).

Beam to beam bearing connection.
Brace support.

Use Seating (30).
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Example Description
Beam to beam bearing connection
with stub column. Square, sloped and
skewed conditions.

Use Cross (4).

Beam to beam bearing clamp type
connection.

Use Seating with nail (36).

Beam to beam bearing purlin
connection to single purlin.

Use Purlin connections (93).
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Example Description
Beam to beam bearing purlin
connection to two purlins.

Use Purlin connections (93).

Beam to beam bearing notched
seating connection. Square and
skewed conditions.

Use Notched seating (9).

Beam to beam bearing tube steel rails
to main part. Cope or hole bolt access
options.

Use Tube rail (113).
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Example Description
Beam to beam bearing notched seat
with angle.

Use Rail joint (70).

Beam to beam bearing rafter
connection to two secondary parts.
Notching required.

Use Rail joint (70).

Beam to beam bearing rafter
connection to two secondary parts.
Plate. Notching required.

Use Rail joint (70).
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Example Description
Beam to beam bearing rafter
connection to two secondary parts.
Sloped/level notching required.

Use Rail joint (70).

Beam to beam full bearing rafter
connection to two secondary parts.
Plate.

Use Cold rolled overlap (1).

Beam to beam full bearing rafter
connection to two secondary parts.
Angle.

Use Cold rolled overlap (1).
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Example Description
Beam to beam full bearing rafter
connection to two secondary parts.
Knee brace option.

Use Cold rolled overlap (1).

Beam to column framing connections

Shear tabs

Example Description
Simple shear tab to column flange.

Use Shear plate simple (146).
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Example Description
Simple shear tab to edge/column
flange.

Use Shear plate simple (146).

Simple shear tab to column flange
with seat angle options.

Use Shear plate simple (146).

Simple shear tab to column flange.
Bolt elimination options.

Use Shear plate simple (146).
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Example Description
Shaped shear tab with column
stiffeners.

Use Column with stiffeners W (182).

Shaped shear tab with column
stiffeners. Sloped secondary.

Use Column with stiffeners W (182).

Shaped shear tab with column
stiffeners. Bolts aligned with
secondary part.

Use Column with stiffeners W (182).
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Example Description
Shaped shear tab with column
stiffeners. Bolt elimination option.

Use Column with stiffeners W (182).

Shear tab with column stiffeners.

Use Column with stiffeners (186).

Shear tab with column stiffeners.
Sloped secondary.

Use Column with stiffeners (186).
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Example Description
Shear tab with column stiffeners.
Skewed secondary.

Use Column with stiffeners (186).

Shear tab to column flange with
column stiffeners.

Use Column with stiffeners (188).

Shear tab to column flange with
column stiffeners. Weld preparation
and weld access holes for moment
connection option.

Use Column with stiffeners (188).
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Example Description
Bolted moment connection to column
flange with column stiffeners.

Use Bolted moment connection
(134).

Bolted moment connection to column
web.

Use Bolted moment connection
(134).

Bolted moment connection to column
web. Sloped secondary part.

Use Bolted moment connection
(134).
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Example Description
Welded moment connection to
column flange. Beam weld
preparation and weld access hole
options.

Use Moment connection (181).

Welded moment connection to
column flange. Sloped.

Use Moment connection (181).

Shear tab through tube column.

Use Shear plate tube column (189).
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Example Description
Shear tab through tube column. Two
secondary parts.

Use Shear plate tube column (189).

Shear tab through tube column. Two
secondary parts. Plate extended to
top of column option.

Use Shear plate tube column (189).

Shear tab through tube column. Two
secondary parts, level and/or sloped.
Bolt alignment options.

Use Shear plate tube column (189).
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Example Description
Shear tab through tube column. Third
secondary part after connection
applied to original two secondary
parts.

Use Shear plate tube column (189).

Clip angles

Example Description
Clip angle connection to column
flange or web. Single-sided /double-
sided clip. Welded/bolted, bolted/
bolted, welded/welded options.

Use Clip angle (141).
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Example Description
Clip angle connection to column
flange or web. Single-sided /double-
sided clip. Sloped secondary part.
Square or bevel cut secondary
options.

Use Clip angle (141).

Clip angle connection to column
flange or web. Single-sided /double-
sided clip. Weld preparation and weld
access holes for moment connection.

Use Clip angle (141).

Clip angle connection to column knife
connection. Bottom flange blocked or
stripped for erection.

Use Clip angle (141).
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Example Description
Clip angle connection to column. Seat
angle option. Top/Bottom/Both.

Use Clip angle (141).

Clip angle connection to column
flange or web. Single-sided /double-
sided clip. Haunch extension option.
Top/Bottom/Both.

Use Clip angle (141).

Clip angle connection to column
flange or web. Single-sided /double-
sided clip. Rotated secondary part.

Use Clip angle (141).
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Example Description
Clip angle connection. Single-sided /
double-sided clip. Two secondary
parts. Bolted/bolted, welded/bolted,
welded/welded options.

Use Two sided clip angle (143).

Clip angle connection. Single-sided /
double-sided clip. Two secondary
parts. Haunch extension option. Top/
Bottom/Both.

Use Two sided clip angle (143).

Clip angle connection. Single-sided /
double-sided clip. Two secondary
parts. Weld preparation and weld
access holes for moment connection.

Use Two sided clip angle (143).
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Example Description
Clip angle connection. Automatic
notching of secondary part to provide
bolt clearance.

Use Two sided clip angle (143).

Clip angle connection. Single-sided /
double-sided clip. Two secondary
parts rotated.

Use Two sided clip angle (143).
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End plates

Example Description
End plate connection to column
flange or web. Level or sloped, square
or skewed secondary part.

Use End plate (144).

Full depth end plate connection to
column flange or web. Level or
sloped, square or skewed secondary
part.

Use End plate (144).

End plate connection to column web.
Extended plate with haunches option.

Use End plate (144).
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Example Description
End plate connection to column
flange. Column stiffener option.

Use End plate (144).

End plate connection to column.
Secondary part rotated.

Use End plate (144).

End plate connection. Two secondary
parts. Automatic notching for bolt
clearance. Haunch option.

Use Two sided end plate (142).
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Bent plate

Example Description
Bent plate connection to column
flange. Skewed or square secondary
part. Plate near side\far side\both
sides.

Use Bent plate (190).

Bent plate connection to column web.
Skewed or square secondary part.
Plate near side\far side\both sides.

Use Bent plate (190).
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Welded tee

Example Description
Welded tee to column.

Use Welded tee (32).

Seated connection

Example Description
Beam seat with stiffeners.

Use Rail joint (170).
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Example Description
Beam seat top and bottom with
stiffeners. Various bolting options.

Use Rail joint (170).

Beam seat. Multiple stiffener options.

Use Rail joint (170).

Beam seat. Offset secondary part.

Use Rail joint (170).
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Bearing type cap plate

Example Description
Beam cantilever over column with cap
plate.

Use U.S. Base plate joint (71).

Beam cantilever over column with cap
plate. Sloped secondary part.

Use U.S. Base plate joint (71).

Beam cantilever over column with cap
plate. Beam stiffener option.

Use U.S. Base plate joint (71).
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Example Description
Beam cantilever over column with cap
plate. Column stiffener option.

Use U.S. Base plate joint (71).

Two beams to column cap plate.
Beam stiffener options.

Use Seating (39).

Beam column cap plate. Tube steel
rails to main part. Cope or hole bolt
access options.

Use Column tube seating (100).
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Example Description
Wind column to beam connection.

Use Wind column (5).

Wind column to beam connection.
Plate offset option.

Use Wind column (5).
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Girt to column

Example Description
Single girt to column. Angle
connection.

Use Rail joint (70).

Two girts to column. Angle
connection.

Use Rail joint (70).

Beam to column outrigger
connection. Main and secondary part
stiffener options.

Use Stub (28).
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Example Description
Two girts to column. WT connection.

Use U.S. seat joint 3 (74).

Splice connections

Beam to beam

Example Description
Clip angle splice connection. Bolted/
bolted, welded/bolted, welded/
welded options.

Use Two sided clip angle (143).
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Example Description
Clip angle splice connection. One
sided. Bolted/bolted, welded/bolted,
welded/welded options.

Use Two sided clip angle (143).

Clip angle splice connection. Beams in
differing planes.

Use Two sided clip angle (143).

NOTE To make a clip angle type splice connection, it is necessary to create a dummy
main part to bolt through. The secondary parts are spliced.

Make the dummy plate 1/8" thick with special properties so that it can be
filtered out when making drawings. Use the settings shown below on the
Picture tab.
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Example Description
Beam to beam web splice plate
welded to main part/ bolted to
secondary part.

Use Tab plate (33).

Beam to beam web splice plate
welded to main part/ bolted to
secondary part. Beams in differing
planes.

Use Tab plate (33).

Beam to beam web splice plate
welded to main part/ bolted to
secondary part. Parts rotated.

Use Tab plate (33).
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Example Description
Beam to beam web splice plate
bolted to both parts. Both parts in the
same plane.

Use Column splice (42).

Beam to beam end plate splice.

Use Joining plates (14).

Beam to beam end plate splice. Parts
of different depths.

Use Joining plates (14).
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Example Description
Beam to beam welded splice. Stair
stringer to landing.

Use Cranked beam (41).

Note: Does not work on very shallow
slopes, or beams in the same plane.

Beam to beam bolted end plate
splice.

Use Cranked beam (41).

Note: Does not work on very shallow
slopes, or beams in the same plane.

Beam to beam bolted end plate splice
with haunch.

Use Cranked beam (41).

Note: Does not work on very shallow
slopes, or beams in the same plane.

Steel components 2730 Connection Map



Example Description
Beam to beam bolted end plate splice
with haunch stiffener plate option.

Use Cranked beam (41).

Note: Does not work on very shallow
slopes, or beams in the same plane.

Beam to beam welded splice, "Z" cut.

Use Offshore Z (192).

Beam to beam welded splice, "Z"
square cut.

Use Offshore Z (192).
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Column splice

Example Description
Column splice. Bolted to both parts.
Both parts in the same plane.

Use Column splice (42).

Column splice. Bolted to both parts.
Shim plates for differing profiles.

Use Column splice (42).

Column splice. Bolted to both parts.
Lifting hole option.

Use Column splice (42).
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Example Description
Column splice with division plate and
connection angles.

Use Column splice (132).

Joist connections

Joist to beam

Example Description
Joist bearing on beam.

Use Joist to beam, type 1 (160).
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Example Description
Joist bearing on beam. Top chord
extension option.

Use Joist to beam, type 1 (160).

Joist to column

Example Description
Joist bearing to column. Cap plate,
stabilizer bar or angle option. Top
chord extension option also available.

Use Joist to column, type 1 (161).
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Example Description
Two joists bearing to column. Cap
plate, stabilizer bar or angle option.

Use 2 sided joist to column (162).

Two joists bearing to column. Cap
plate, cap plate level or on slope of
joists.

Use 2 sided joist to column (162).

Joist framing to side of column.
Stabilizer bar or angle option.

Use Joist to column, type 2 (163).

Steel components 2735 Connection Map



Example Description
Joist framing to side of column. Seat
angle across toes of flanges.

Use Joist to column, type 2 (163).

Joist framing to joist girders at
column.

Use Joist to beam and column (164).

Vertical member to beam
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Post and door jamb to top of beam

Example Description
Post base plate to top of beam. Main
and secondary stiffener options.

Use U.S. base plate connection (71).

Simple shear tab to post or channel
jamb.

Use Shear plate simple (146).

Clip angle to channel jamb.

Use Clip angle (141).
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Example Description
Clip angle to railing post.

Use Stringer stanchion L profile
(68).

Railing post connection plate to beam
stiffener.

Use Stringer stanchion st (69).

Railing post elbow to connection
plate.

Use Stanchion curved (84).
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Example Description
Shear tab to railing post.

Use Stanchion side profile (86).

Built–up plate railing post connection.

Use Stanchion double plate (87).
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Hangers from underside of beam

Example Description
Clip angle hanger connection.

Use Clip angle (141).

Simple shear tab hanger connection.

Use Shear plate simple (146).

Bracing connections

Steel components 2740 Connection Map



Simple gusset plate connections

Example Description
Gusset plate to single brace.
Horizontal and vertical bracing.
Various bracing profiles.

Use Bolted gusset (11).

Load connection attribute < Defaults
> and select Defaults for Rule group
for best results.

Gusset plate to single brace.
Horizontal and vertical bracing.
Hollow round brace with pin bolt
option.

Use Bolted gusset (11).

Load connection attribute < Defaults
> and select Defaults for Rule group
for best results.

Gusset plate to single brace. Brace
and main part at the same elevation.

Use Bolted gusset (11).
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Example Description
Gusset plate to single brace at base
plate of column.

Use Bolted gusset (11).

Gusset plate hollow section "Birds
mouth" connection to secondary
parts.

Use Tube gusset (20).

Gusset plate hollow section tongue
plate connection to secondary parts.

Use Tube gusset (20).

Steel components 2742 Connection Map



Example Description
Gusset plate to twin profile brace.
Vertical or horizontal brace. Multiple
bracing members.

Use Bolted gusset (11).

Gusset plate to twin profile brace.
Twin profile main part. Welded or
bolted to main part.

Use Bolted gusset (11).

Gusset plate with connection plate.
Bolted to main part.

Use Bolted gusset (11).
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Example Description
Gusset plate with connection plate.
Bolted to main part. Various gusset
plate shaping options.

Use Bolted gusset (11).

Gusset plate to hollow section brace.
Pin bolt and tension angle option.

Use Bolted gusset (11).

Gusset plate to hollow section brace.
Pin bolt and tension angle option.

Use Bolted gusset (11).
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Example Description
Gusset plate to WT section brace.
Notching option.

Use Bolted gusset (11).

Load connection attribute < Defaults
> and select Defaults for Rule group
for best results.

Gusset plate through hollow section
column to hollow section bracing at
base plate.

Use Bolted gusset (11).

Select column, then brace and brace.

Gusset plate through hollow section
column to WT bracing at base plate.

Use Bolted gusset (11).

Select column, then brace and brace.
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Example Description
Gusset plate through hollow section
column to angle bracing at base plate.
Single or twin profile.

Use Bolted gusset (11).

Select column, then brace and brace.

Wrapped gusset plate W section
bracing. Various bracing connection
options. Welded/bolted, bolted/
bolted.

Use Gusset wrapped cross (62).

Wrapped gusset plate W section
bracing. Various bracing connection
options. Welded/bolted, bolted/
bolted.

Use Gusset wrapped cross (62).

Steel components 2746 Connection Map



Example Description
Wrapped gusset plate W section
bracing. Various bracing connection
options for each brace.

Use Gusset wrapped cross (62).

Wrapped gusset plate W section
bracing. Various gusset plate
connection options.

Use Gusset wrapped cross (62).

Hollow section bracing tongue plate
connection to existing gusset plate.

Use Tube crossing (22).
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Example Description
Wrapped gusset W section bracing
connection to existing gusset plate.

Use Wrapped cross (61).

Hollow section bracing WT end
connection to existing gusset plate.

Use Portal bracing (105).

Bolted brace connection to existing
gusset plate.

Use Bracing cross (19).
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Welded connections

Beam to beam

Example Description
Welded beam to beam.

Use Fitting (13).

Welded beam to beam with
horizontal stiffeners.

Use Fitting (13).
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Example Description
Welded beam to beam with primary.
Vertical stiffeners.

Use Welded beam to beam (123).

Welded beam to beam with haunch.

Use Offshore (194).

Welded beam to beam with haunch.
Various haunch options.

Use Offshore (194).

Steel components 2750 Connection Map



Example Description
Welded beam to beam with haunch.
Various haunch options.

Use Offshore (194).

Welded round profile to round profile.

Use Round tube (23).

Welded round profile to round profile.
Differing profile size and skewed
secondary part.

Use Round tube (23).
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Beam column

Example Description
Welded to column with weld
preparation and stiffener options.

Use Welded column with stiffeners
(128).

Welded to column.

Use Welded column (31).

Details
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Base plates

Example Description
Column base plate with grout hole
option.

Use U.S. base plate (1047).

Column base plate with shear key
option.

Use U.S. base plate (1047).

Column base plate with stiffener
option.

Use U.S. base plate (1047).
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Example Description
Offset column base plate (shear key
and grout hole optional).

Use U.S. base plate (1047).

Column base plate bolt elimination
and interior corner chamfer option.

Use U.S. base plate (1047).

Column base plate located from face
of flange.

Use Base plate (1042).
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Example Description
Circular column base plate with
stiffener option.

Use Circular base plates (1052).

Horizontal base plate to sloped post.

Use Base plate (1053).
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Stiffeners

Example Description
Stiffener plate detail to column.

Use Stiffeners (1003).

Stiffener plate detail to beam.

Use Stiffeners (1003).

Partial depth stiffener plate detail to
beam.

Use Stiffeners (1041).
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Example Description
Partial depth stiffener plate detail to
column.

Use Stiffeners (1041).

Parallel stiffener plates.

Use Horizontal stiffener (1017).

Flange stiffener plates.

Use Stiffeners (1030).
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Example Description
Stiffened notch.

Use Stiffened notch (1006).

Stiffened notch. Notch cut bevel to
part.

Use Stiffened notch (1006).
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Manlock holes and lifting lugs

Example  
Manlock holes in column.

Use Manlock column (1032).

Manlock holes in beam.

Use Manlock beam (1033).
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Example  
Lifting lug to beam.

Use Lifting/alignment pieces (1031).

Lifting lug to beam chamfered plate.

Use Lifting/alignment pieces (1031).
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Seat details

Example Description
Plate seat with stiffeners.

Use Stub plate (1013).

Angle seat with stiffener.

Use Angle profile box (1040).

Angle seat with stiffener. Bolt to main
part and through seat options.

Use U.S. seat detail (1048).
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Example Description
Angle seat with stiffener. Bolt to main
part placed at a given distance apart.

Use U.S. seat detail (1048).

WT seat detail.

Use U.S. seat detail 2 (1049).

Rotated angle seat. Stiffener plate
option available.

Use U.S. seat detail 2 (1049).
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Cap plate and bearing plate

Example Description
Bearing plate at end of beam.

Use U.S. bearing plate (1044).

Cap plate.

Use End plate detail (1002).
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Miscellaneous

Example Description
Spacer plate between twin profiles.
Welded or bolted.

Use Twin profile connection plate
(1046).
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3 Concrete components

This section contains information on the use of concrete components that ship
with Tekla Structures.

If you know which component you need, you can press F1 in the component
dialog box to quickly access the correct help page. Some components use
locally installed help files in a legacy format, which you can only access by
pressing F1 in the component dialog box.

More components are available in Tekla Warehouse for you to download and
install.

You can also modify many of the existing components and create your own
custom components, see .

3.1 Concrete detailing
This section introduces the concrete detailing tools available in Tekla
Structures.

Click the links below to find out more:

• Seating connections (page 2766)

• Beam and column connections (page 2793)

• Panels and walls (page 2882)

• Formwork placing tools (page 3033)

• Openings (page 3142)

• Flooring (page 3154)

• Concrete stairs (page 3215)

• Foundations (page 3267)

Concrete components 2765 Concrete detailing

https://warehouse.tekla.com/


NOTE Precast components can only be applied to precast cast units. They
cannot be applied to cast-in-place cast units.

Seating connections
Tekla Structures includes several seating connections that you can use to
connect concrete columns and beams using anchor bolts. The seating
connection tools are:

• Seating with dowel (75) (page 2766)

• Two-sided seating with dowel (76) (page 2773)

• Seating with dowel to flange (77) (page 2781)

• Two-sided seating with dowel to flange (78) (page 2787)

Seating with dowel (75)
Seating with dowel (75) connects a column and a beam using an anchor bolt.

Parts created

• Anchor bolt

• Nut

• Washer plate

• Bearing plate

• Fittings for beam and column

• Hole for bolt

• Corbel (optional)

• Recess for nut and washer plate (optional)
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Use for

Situation Description
Connects a beam and a column using an anchor bolt.
Washer plate and nut protrude from the beam.

Connects a beam and a column using an anchor bolt
and a beveled corbel. Washer plate and nut recessed
into the beam.

Before you start

Create the following parts:

• Concrete column (round or rectangular profile)

• Concrete beam (rectangular, HI, I, L, or inverted T profile)

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the second part is selected.

Picture tab
Use the Picture tab to define position of anchor bolt and bearing plate, bolt
hole dimensions, grout type, and beam clearance.

Bolt hole

Enter the following bolt hole dimensions:
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 Description
1 Hole dimension in the direction of the beam.
2 The distance from beam center line to hole center

and bolt.
3 Hole dimension in the direction perpendicular to

the beam.

Select the shape of the bolt hole:

Option Description
Rectangular

Default

Round

Beam and column

Select one of the following options to have Tekla Structures fit the column or
the beam:

Option Description
Fits the column.

Default

Fits the beam.

The beam must be sloped.
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Bearing plate

Select one of the following options to define the position of the bearing plate:

Option Description
Square with beam.

Default

Square with column.

Square with column.

Enter the distances from column
edges.

Dowel tab
Use the Dowel tab to define dowel and grout properties.

Dowel

Option Description
Profile Select the dowel profile from the

profile catalog.
Prefix, Start number Prefix and start number for the part

position number.
Material Material grade.

The default material is defined in the
Part material box in the
Components settings in File menu --
> Settings --> Options .

Name Name that is shown in drawings and
reports.

Finish Describes how the part surface has
been treated.

Class Enter a number to group the parts
that the component creates. By
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Option Description
default, the class number affects the
color in which the part is shown in
model views.

Size Diameter of the bars.
Grade Strength of the steel used in the bars.
Number of bars Select 1 Dowel to create one

reinforcing bar.

Select 2 Dowels to create two
reinforcing bars. Then define the
distance between the bars in the Bar
distance field.

Grout

Select one of the following options to include and define grout:

Option Description
No grout.

Default

Bolt hole grouted. No nut or washer plate.

Bolt hole grouted. Bolt, washer plate, and
anchor bolt protruding.

Nut and washer plate

Select one of the following options to define if the nut and washer plate are
recessed into the beam:

Option Description
Nut and washer plate on the surface of
the beam.

Default

Nut and bolt plate recessed into the
beam.
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If you choose to recess the nut and washer plate into the beam, enter the
following dimensions to define the recess:

Parts tab
Use the Parts tab to define bearing pad, drainage hole, grout, bolt plate, nut,
and tube properties.

Option Description
t, b, h Define the part thickness, width and height.
Pos_No Define a prefix and a start number for the part

position number.
Material Define the material grade.
Name Define a name for the part.
Class Use Class to group the parts.
Cast unit Select to add the parts to the cast unit.

Nut and bolt plate

Field Description
1 Nut width.
2 Bolt plate width.

Corbel tab
Use the Corbel tab to create a corbel and define its properties.
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Select to create a corbel from the Create corbel list.

The options for chamfering corbels are:

Option Description
Beveled

Default

Straight

Rounded

Define the placement of the corbel rebar.

Option Description
t, b, h Define the thickness, width, and

height of the part.
Pos_No Prefix and start number for the part

position number.

The default part start number is
defined in the Components settings
in File menu --> Settings -->
Options .
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Option Description
Name Name that is shown in drawings and

reports.
Class Part class number.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Two-sided seating with dowel (76)
Two-sided seating with dowel (76) connects a column and two beams using
anchor bolts.

Parts created

• Anchor bolts (2)

• Nuts (2)

• Washer plates (2)

• Bearing plates (2)

• Fittings for beam and column (2)

• Holes for bolts (2)

• Corbels (optional) (2)

• Recesses for washer plate and nut (optional) (2)

Use for

Option Description
Connects two beams to a column using anchor bolts
and creates corbels. Nuts and washer plates on the
surface of the beams.
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Option Description
Connects two beams to a column using anchor bolts.
Nuts and washer plates recessed into the beams.
Second beam is sloped, and is cut to create a gap
between the beam and the column.

Before you start

Create the following parts:

• Concrete column (round or rectangular profile)

• Two concrete beams (rectangular, HI, I, L, or inverted T profile)

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.

Picture tab
Use the Picture tab to define dimensions and the position of the anchor bolts
relative to the beams and bearing plates.

Beam and column

Select one of the following options to define how the end of the beams are cut
and shaped:

Key Options
1 = column

2 = first beam picked

3 = second beam
picked
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Key Options

Select one of the following options to fit the beams or the column:

Option Description
Fits column.

Default

Fits beam.

Bearing plate

Select one of the following options to define the position of the bearing plate:

Option Description
Square with beam.

Default

Square with column.
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Option Description
Square with column.

Enter the distances from column
edges.

Dowel tab
Use the Dowel tab to define dowel properties.

Option Description
Profile Select the dowel profile from the

profile catalog.
Prefix, Start number Prefix and start number for the part

position number.
Material Material grade.

The default material is defined in the
Part material box in the
Components settings in File menu --
> Settings --> Options .

Name Name that is shown in drawings and
reports.

Finish Describes how the part surface has
been treated.

Class Enter a number to group the parts
that the component creates. By
default, the class number affects the
color in which the part is shown in
model views.

Size Diameter of the bars.
Grade Strength of the steel used in the bars.
Number of bars Select 1 Dowel to create one

reinforcing bar.

Select 2 Dowels to create two
reinforcing bars. Then define the
distance between the bars in the Bar
distance field.

Parts tab
Use the Parts tab to define bearing pad, drainage hole, grout, bolt plate, nut,
and tube properties.
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Option Description
t, b, h Define the part thickness, width and height.
Pos_No Define a prefix and a start number for the part

position number.
Material Define the material grade.
Name Define a name for the part.
Class Use Class to group the parts.

Left beam/Right beam tab
Use the Left beam/Right beam tab to define anchor bolt, bolt hole and recess
properties.

Left beam is the first beam selected and right is the second.

You can create a clearance between beam and column if beam is sloped.

Nut and bolt plate

Field Description
1 Nut width.
2 Bolt plate width.

Nut and washer plate

Select one of the following options to define if the nut and washer plate are
recessed into the beam:

Option Description
Nut and washer plate on the surface of
the beam.

Default
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Option Description
Nut and bolt plate recessed into the
beam.

If you choose to recess the nut and washer plate into the beam, enter the
following dimensions to define the recess:

Grout

Select one of the following options to include and define grout:

Option Description
No grout.

Default

Bolt hole grouted. No nut or washer plate.

Bolt hole grouted. Bolt, washer plate, and
anchor bolt protruding.

Bolt hole

Enter the following bolt hole dimensions:

Field Description
1 Hole dimension in the direction of the beam.
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Field Description
2 The distance from beam center line to hole center

and bolt.
3 Hole dimension in the direction perpendicular to

the beam.

Select the shape of the bolt hole:

Option Description
Rectangular

Default

Round

Bearing plate

Select one of the following options to define the position of the bearing plate:

Option Description
Square with beam.

Default

Square with column.

Square with column.

Enter the distances from column
edges.

Left corbel/Right corbel tab
Use the Left corbel/Right corbel tab to create a corbel and define its
properties.
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Select to create a corbel from the Create corbel list.

The options for chamfering corbels are:

Option Description
Beveled

Default

Straight

Rounded

Define the placement of the corbel rebar.

Option Description
t, b, h Define the thickness, width, and

height of the part.
Pos_No Prefix and start number for the part

position number.

The default part start number is
defined in the Components settings
in File menu --> Settings -->
Options .
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Option Description
Name Name that is shown in drawings and

reports.
Class Part class number.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Seating with dowel to flange (77)
Seating with dowel to flange (77) connects the flanges of a beam to a
column using anchor bolts and an optional corbel.

Parts created

• Anchor bolts (2)

• Nuts (2)

• Washer plates (2)

• Bearing plate (1)

• Fittings for beam and column

• Holes for bolts (2)

• Corbel (optional)

• Recess for nut and washer plates
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Use for

Situation More information
Connects the flanges of a beam to
a column using anchor bolts and
a beveled corbel. Nuts and
washer plates recessed.

Before you start

Create the following parts:

• Concrete column (Round or rectangular profile)

• Concrete beam with flange (rectangular, HI, I, L, or inverted T profile)

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the second part is selected.

Picture tab
Use the Picture tab to define position and length of anchor bolt, and bolt hole
dimensions and position.

Bolt hole

Enter the following bolt hole dimensions:
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 Description
1 Hole dimension in the direction of the beam.
2 The distance from beam center line to hole center

and bolt.
3 Hole dimension in the direction perpendicular to

the beam.

Select the shape of the bolt hole:

Option Description
Rectangular

Default

Round

Bearing plate

Select one of the following options to define the position of the bearing plate:

Option Description
Square with beam.

Default

Square with column.

Square with column.

Enter the distances from column
edges.

Dowel tab
Use the Dowel tab to define dowel properties.
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Select to create the dowel as a reinforcement bar, poly-profile, or custom
component part from the Type list.

Option Description
Profile Select the dowel profile from the

profile catalog.
Prefix, Start number Prefix and start number for the part

position number.
Material Material grade.

The default material is defined in the
Part material box in the
Components settings in File menu --
> Settings --> Options .

Name Name that is shown in drawings and
reports.

Finish Describes how the part surface has
been treated.

Class Enter a number to group the parts
that the component creates. By
default, the class number affects the
color in which the part is shown in
model views.

Size Diameter of the bars.
Grade Strength of the steel used in the bars.

Parts tab
Use the Parts tab to define bearing pad, drainage hole, bolt plate, nut and
recess properties.

Part properties

Option Description
t, b, h Define the part thickness, width and height.
Pos_No Define a prefix and a start number for the part

position number.
Material Define the material grade.
Name Define a name for the part.
Class Use Class to group the parts.
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Nut and bolt plate

Field Description
1 Nut width.
2 Bolt plate width.

Recess

To cut a recess in the beam web, select the Yes option in the Create recess
list. Enter the following dimensions to define the recess:

Corbel tab
Use the Corbel tab to create a corbel and define its properties.

Select to create a corbel from the Create corbel list.

The options for chamfering corbels are:
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Option Description
Beveled

Default

Straight

Rounded

Define the placement of the corbel rebar.

Option Description
t, b, h Define the thickness, width, and

height of the part.
Pos_No Prefix and start number for the part

position number.

The default part start number is
defined in the Components settings
in File menu --> Settings -->
Options .

Name Name that is shown in drawings and
reports.

Class Part class number.
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Two-sided seating with dowel to flange (78)
Two-sided seating with dowel to flange (78) connects the flanges of two
beams to a column using anchor bolts and optional corbels.

Parts created

• Anchor bolts (4)

• Nuts (4)

• Washer plates (4)

• Bearing plate (2)

• Fittings for beam and column

• Holes for bolts (4)

• Corbels (2) optional

• Recesses for nut and washer plate (4)

Use for

Situation Description
Connects the flanges of two beams to a column using
anchor bolts.
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Situation Description
Connects the flanges of two beams to a column using
anchor bolts and beveled corbels.

Before you start

Create the following parts:

• Concrete column (Round or rectangular profile)

• Concrete beam with flange (rectangular, HI, I, L, or inverted T profile)

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

3. Select the second secondary part (beam).

4. Click the middle mouse button to create the connection.

Picture tab
Use the Picture tab to define dimensions and the position of the anchor bolts
relative to the beam and bearing plate, length of anchor bolts, and beam ends.

Beam and column

Select one of the following options to define how the end of the beams are cut
and shaped:

Key Options
1 = column

2 = first beam picked

3 = second beam
picked
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Key Options

Bearing plate

Select one of the following options to define the position of the bearing plate:

Option Description
Square with beam.

Default

Square with column.

Square with column.

Enter the distances from column
edges.

Dowel tab
Use the Dowel tab to define dowel properties.

Select to create the dowel as a reinforcement bar, poly-profile, or custom
component part from the Type list.

Option Description
Profile Select the dowel profile from the

profile catalog.
Prefix, Start number Prefix and start number for the part

position number.
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Option Description
Material Material grade.

The default material is defined in the
Part material box in the
Components settings in File menu --
> Settings --> Options .

Name Name that is shown in drawings and
reports.

Finish Describes how the part surface has
been treated.

Class Enter a number to group the parts
that the component creates. By
default, the class number affects the
color in which the part is shown in
model views.

Size Diameter of the bars.
Grade Strength of the steel used in the bars.

Parts tab
Use the Parts tab to define bearing pad, drainage hole, bolt plate, and nut
properties.

Option Description
t, b, h Define the part thickness, width and height.
Pos_No Define a prefix and a start number for the part

position number.
Material Define the material grade.
Name Define a name for the part.
Class Use Class to group the parts.

Left beam/Right beam tab
Use the Left beam/Right beam tab to define anchor bolt, bolt hole and recess
properties.

Left beam is the first beam picked and right is the second.

Bolt hole

Enter the following bolt hole dimensions:
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Field Description
1 Hole dimension in the direction of the beam.
2 The distance from beam center line to hole center

and bolt.
3 Hole dimension in the direction perpendicular to

the beam.

Select the shape of the bolt hole:

Option Description
Rectangular

Default

Round

Nut and bolt plate

Field Description
1 Nut width.
2 Bolt plate width.
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Recess

To cut a recess in the beam web, select the Yes option in the Create recess
list. Enter the following dimensions to define the recess:

Left corbel/Right corbel tab
Use the Left corbel/Right corbel tab to create a corbel and define its
properties.

Select to create a corbel from the Create corbel list.

The options for chamfering corbels are:

Option Description
Beveled

Default

Straight

Rounded

Define the placement of the corbel rebar.
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Option Description
t, b, h Define the thickness, width, and

height of the part.
Pos_No Prefix and start number for the part

position number.

The default part start number is
defined in the Components settings
in File menu --> Settings -->
Options .

Name Name that is shown in drawings and
reports.

Class Part class number.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Beam and column connections
This section introduces components that can be used in concrete connections.

Click the links below to find out more:

• Battering connection (13) (page 2794)

• Corbel connection (14) (page 2795)

• Column - beam (14) (page 2807)

• Tapered I beam (81) (page 2813)

• Corbels and recesses (82) (page 2821)
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• Concrete console (110) (page 2827)

• Concrete console (111) (page 2841)

• Concrete beam-beam (112) (page 2851)

Battering connection (13)
Battering connection (13) fits the secondary part, for example, in a custom
component either square to the main part, or at an angle.

Use for

Situation Description
Secondary is fit square to the
main part.

Secondary is fit to the main
part at an angle.
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Before you start

Create two parts.

Selection order

1. Select the main part

2. Select the secondary part.

Picture tab
Use the Picture tab to define the angle and the distance between the parts.

 Description
1 Define the angle between the parts.

If the part angle makes the gap larger than the value A, then
the part is cut at the end.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Corbel connection (14)
Corbel connection (14) connects a beam to a column using a straight,
beveled, or rounded corbel and reinforcing bars or fastening plates.

Objects created

• Corbel
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• Bearing plate

• Drainage holes in bearing plate (1 or 2) (optional)

• Reinforcing bars (1 or 2) (optional)

• Bolt plates for reinforcing bars

• Nuts for reinforcing bars

• Recesses for bolt plates and nuts

• Fastening plates (2) (optional)

• Recesses for fastening plates

Use for

Situation Description
Connects a beam to a column using a reinforcing bar
and a beveled corbel.

Connects a beam to a column using fastening plates
and a rounded corbel.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.
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Part identification key

 Part
1 Bolt plate
2 Nut
3 Bearing plate
4 Corbel
5 Reinforcing bar

Example: Add a corbel connection using Corbel connection (14)
In this example, you will add a corbel connection between a column and a
beam.

1. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

2. Enter corbel in the search box.

3. Select Corbel connection (14).

4. Select the main part (column).

5. Select the secondary part (beam). 
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Tekla Structures automatically adds the corbel connection between the
column and the beam when you select the beam.

Picture tab
Use the Picture tab to control the corbel shape and dimensions, beam end
shape and dimensions, and corbel side chamfers in Corbel connection (14).

When beam sloped, adjust

If the beam in the connection is sloped, define whether the beam or the corbel
is cut.

When the beam end is cut, the corbel top stays horizontal. When the corbel is
cut, the corbel top has the same slope as the beam.

Corbel dimensions and shape
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 Description
1 Gap between the column and the beam.
2 Gap between the corbel and the beam.
3 Vertical corbel dimension.
4 Beveled corbel dimension.
5 Corbel width.

Option Description
Default

Beveled corbel

AutoDefaults can change this option.

Beveled corbel

Square corbel

Rounded corbel

Concrete components 2799 Concrete detailing



Corbel position

 Description
1 Horizontal corbel offset.
2 Height of the beam cut.
3 Gap between the corbel and extended beam.

Beam end shape

You can fit the beam end to the column, or you can create a straight beam
end.

Option Description Example
Default

Straight beam end

AutoDefaults can change
this option.

 

Straight beam end
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Option Description Example
Beam end is fit to the
column based on the
dimensions you define.

Beam can extend
symmetrically on both
sides of the column, or
with different
dimensions.

Corbel thickness

Define the distances from column edges to set the corbel thickness.

Corbel side chamfers

Define whether the corbel sides are chamfered. By default, no chamfers are
created.
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Parts tab
Use the Parts tab to control the corbel part properties and dimensions in
Corbel connection (14).

Corbel parts

Part Description
Bearing plate Bearing plate thickness.
Cast unit Select whether cast unit is formed.
Drainage hole Select whether drainage holes for

each reinforcing bar are created in
the bearing plate.

Bolt plate Bolt plate thickness.
Nut Nut thickness.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined on
the Components tab in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box on the
Components tab in File
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Option Description Default
menu --> Settings -->
Options.

Name Name that is shown in
drawings and reports.

 

Bearing plate dimensions

 Description
1 Bearing plate distance from the column edge.
2 Bearing plate distance from the corbel edges.

Nut and bolt plate dimensions

 Description
1 Nut width.
2 Bolt plate width.

Reinforcing bar tab
Use the Reinforcing bartab to control the reinforcing bar and fastening plate
properties, and the bolt plate and fastening plate recesses in Corbel
connection (14).
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Reinforcing bar properties

Option Description
Grade Strength of the steel used in the

reinforcing bars.
Size Diameter of the reinforcing bar.
Bending radius Internal radius of the bends in the

bar.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcements.

For example, you can display different
reinforcement classes in different
colors.

Number of bars Select 1 Dowel to create one
reinforcing bar.

Select 2 Dowels to create two
reinforcing bars. Then define the
distance between the bars in the Bar
distance field.

Reinforcing bar length

 Description
1 Distance between reinforcing bar center line and the column edge.
2 Vertical length of the reinforcing bar inside the corbel.
3 Length of the reinforcing bar inside the column.
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Recess for bolt plate and nut

 Description
1

5

Size of the bolt plate recess in the x direction.

Size of the bolt plate recess in the y direction.
2

4

Size of the nut recess in the y direction.

Size of the nut recess in the x direction.
3 Reinforcing bar offset.

Reinforcing bar extra length

 Description
1 Extra length of the reinforcing bar.
2 Length of the reinforcing bar inside the recess.

Connecting devices

Define the connecting devices that connect the beam and the column.

Option Description
Default

One or two reinforcing bars bent to
the same angle as the corbel bevel

Available for bevel corbels.

AutoDefaults can change this option.
One or two reinforcing bars bent to
the same angle as the corbel bevel

Available for bevel corbels.
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Option Description
One or two reinforcing bars

Default for straight and rounded
corbels.
Two fastening plates

Use custom components as fastening
plates.

Recess for fastening plate

 Description
1

2

Depth of column recess.

Depth of beam recess.
3

4

Offset of column recess.

Offset of beam recess.
Column recess

Beam recess

Height and width of column and beam recess.

Using custom components as fastening plates

You can use custom components as fastening plates. Use the Column
component and Beam component sections to define the fastening plates in
the column and beam.

1. Select the following option in the Connecting devices list:
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2. In the Custom list, select Yes.

3. Click the ... button next to the Component field to open the Select
component dialog box.

4. Browse for the custom component you want to use as fastening plate.

The component you select must be a custom part and have two or more
input points.

5. Select the component and click OK.

6. To use saved custom component properties, select the saved properties
file in Custom settings.

7. If the direction or rotation of the fastening plate is not correct, select
another option in the Up direction or Rotation list.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Column - beam (14)
Column - beam (14) creates a connection between a concrete column and a
concrete beam or wall/panel. The orientation of the beam can be horizontal or
sloped. Note that the connection works only with precast parts.

Objects created

• Cuts

• Fittings
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Use for

Option Description
Beam end rests on the column.

Beam end rests on the column.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam/wall/panel).

Picture tab
Use the Picture tab to define cut-out shapes and cut-out dimensions of the
column and the beam.

Cut-out dimensions

Option Description
Cut-outs of the main part and the
secondary part in the horizontal
direction.

The space between the column
and the beam can be defined at
both sides. For tapered openings
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Option Description
you can define how much the
opening is reduced.

Example:

Cut-outs of the main part and the
secondary part in the vertical
direction.

The space between the column
and the beam can be defined at
both sides. For tapered openings
you can define how much the
opening is reduced.

Example:
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Option Description
Select the how the opening is
reduced.

The options are:

• From beam centerline

• From beam edges

Cut-out shape

Option Description
Cut around the secondary part

Cut-out to the top of the column
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Option Description
Cut-out to the bottom of the column

Full vertical cut-out

No cut-out

Column tab
Use the Column tab to define how the top of the column is modified.

Column extension

Define the column extension. If you do not enter any values, the column is
extended to its original top level.
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 Description
1 Column extension in the vertical direction from the beam top.

This dimesion has the highest priority among the three dimensions
(1, 3, 4) for defining the column extension.

2 Select wether the top of the column is perpendicular or parallel to
the beam.

Perpendicular:

Parallel with top of beam:

3 Column extension in the vertical direction.
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 Description
4 Column extension in the vertical direction from the beam bottom.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Tapered I beam (81)
Tapered I beam (81) creates beams with multiple types of cross-sections and
height variations. Cross-section types include I, T, inverted T, and rectangular.
The beam height can be tapered, tapered ridge, or constant. The component
can also be used to create columns.

Objects created

• Beam, one part or multiple parts

• Stiffeners

• End blocks

Use for

Example Example Example

Before you start

Ensure that you have two points to pick.

Selection order

1. Pick the beam start point.

2. Pick the beam end point.

The beam is created automatically when you pick the end point.
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Part identification key

 Description
1 Tapered beam
2 Stiffener

Parameters tab
Use the Parameters tab to define the beam type and the dimensions.

Beam type

Option Description
Select the beam shape type.

Select whether the beam is created as
one part or as separate parts. The
available options depend on the
beam shape type you have selected.

The magenta color indicates the main
part of the cast unit and the cyan
color indicates the secondary part.

Beam dimensions

The available dimensions depend on the option you select. The example
images below show the dimensions you can define.
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Option Description
1 Height of the beam on the start
point side

2 Width of the chamfer on the start
point side

3 Location of the ridge. If left empty,
the ridge is in the middle.

4 Width of the chamfer on the end
point side

5 Angle of the start point edge of the
beam, either as percentage or in
degrees

6 Angle of the end point edge of the
beam, either as a percentage or in
degrees

7 Dimension of the beam from the
bottom to the highest edge

8 Height of the beam on the end
point side
1 You can use an external
configuration file for defining the
dimensions. Define the path to the
external file.

End block dimensions

You can define the end block dimensions with certain beam shape types.

Option Description
1 Length of the start point end block

2 Length of the end point end block

1 Dimension between the start point
end block and the middle of the beam

2 Dimension between the end point
end block and the middle of the beam
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Option Description
Position h middle Select the middle height position:

• The height is in the middle of the
picked points. Offsets are not
taken into account.

• The height is in the middle of the
actual beam, including the offsets.

Flange and chamfer dimensions

 Description
1 Height of the top flange
2 Height of the top chamfer
3 Height of the bottom chamfer
4 Height of the bottom flange

Profile cross section dimensions

The available dimension options depend on the selected beam shape type.

 Description
1 Width of the first top chamfer
2 Height of the first top chamfer
3 Height of the first bottom chamfer
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 Description
4 Width of the first bottom chamfer
5 Width of the end detail
6 Width of the bottom flange
7 Width of the top flange
8 Width of the web
9 Width of the second top chamfer
10 Height of the second top chamfer
11 Height of the second bottom chamfer
12 Width of the second bottom chamfer

Properties tab
Use the Properties tab to define the part properties. These settings affect all
parts created by the component: beam parts, stiffeners, and end detail parts.

Properties

Option Description
Name Part name
Material Material grade
Finish Part finish
Class Part class number
Position on plane Horizontal position of the beam in

relation to the input points. You can
define an additional offset, if needed.

Position at depth Depth position of the beam in
relation to the input points. You can
define an additional offset, if needed.

End offset End offsets of the part
Cast unit numbering Numbering prefix and start number

for the cast unit
Global displacement Offset for the part in the x, y, and z

direction
Method Method to connect the created parts

together

Stiffeners tab
Use the Stiffeners tab to define the stiffener creation.
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Stiffener type

Option Description
Stiffeners are not created.

Stiffeners are created. The middle
stiffener is created.

Stiffeners are created. The middle
stiffener is not created.

Asymmetrical stiffeners are created.

Stiffener dimensions

 Description
1 Dimension from the edge of the beam to the first stiffener
2 Dimension from the first stiffener to the second stiffener
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 Description
3 Dimension from the second stiffener to the central stiffener

If the central stiffener is not created, this is the dimension from
the second stiffener to the center of the beam.

Note that if all three values are defined, only values 1 and 2 will
be used.

 Description
1 Thickess of the stiffener
2 Width of the stiffener
3 Width of the top part of the stiffener

Connection method

Select how the stiffeners are connected to the main part.

End details tab
Use the End details tab to define the end detail creation.

End detail shape and dimensions

Select the top and bottom end detail on both sides of the beam.

Option Description
No end detail at the top

Horizontal dimension of the added
block
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Option Description
Vertical dimension of the added block

1 Vertical dimension of the cut

2 Horizontal dimension of the cut

No end detail at the bottom

1 Vertical dimension of the cut

2 Horizontal dimension of the cut

1 Vertical dimension of the cut

2 Horizontal dimension of the cut

3 Horizontal dimension of the first
chamfer

End block shape

Option Description
End blocks are not created.

End blocks without chamfers are
created.

End blocks with one chamfer are
created.

End blocks with two chamfers are
created.
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Option Description
End blocks with three chamfers are
created.

End block dimensions

 Description
1 Length of the first chamfer
2 Width of the end blocks
3 Width of the end blocks at the end of the second chamfers
4 Width of the third chamfers

If there are two chamfers, this is the width of the second
chamfer.

UDA tab
Use the UDA tab to define the user-defined attributes.

• String for text

• Integer for integers

• Float for values with decimals after a comma

• Option for predefined values

Corbels and recesses (82)
Corbels and recesses (82) adds concrete parts or cuts to a concrete part. You
can define the position, offsets and rotation of the added parts or cuts in
several ways.

Objects created

The component can add a maximum of four parts or cuts to a concrete part.
The added parts can be welded to the main part, added as parts and cast
units, or as sub-assemblies.
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Use for

• Cut-out seams from concrete walls

• Adding concrete support blocks to concrete columns or walls

Selection order

1. Select the main part.

The part or cut is created automatically.

Part 1 / Part 2 / Part 3 / Part 4 tab
Use the Part 1, Part 2, Part 3 or Part 4 tab to create one additional part or cut
to the concrete part.

Profile

Select the profile to be added to the concrete part or used for the cut.

Select how the added part is connected to the main part.

Option Example
No part created.

Concrete components 2822 Concrete detailing



Option Example
Part is created.

Part is created and added to the main part.

Part is created and the main part is cut.
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Option Example
Main part is cut.

Part is created and cast unit is created.

Part is created and welded to the main part.
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Option Example
Part is created and welded to the main part, and
the main part is cut.

Part is created and added as sub-assembly.

Part is created and added as sub-assembly, and the
main part is cut.

Offset

Define the offset of the added part from the main part. You can set the offset
also for openings.

By default, the added parts or cuts are created between the end points of the
concrete part.
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Coordinate system

On the Part 1 tab, select Use global xy-plane to place the corbels on the
global XY plane or Use local to place the corbels on the local XY plane of the
part.

Note that setting the coordinate system on the Part 1 tab also affects the
corbels that are created on the Part 2 - 4 tabs.

Create diamond corbel around column

Select whether a diamond corbel is created around the column.

If you create the corbel, you cannot enter any values on the Part 2, Part 3 or
Part 4 tabs.

Chamfers

You can chamfer the added parts. You can define the chamfers either as
angles or as dimensions.

Positioning of the parts

Option Description
Select the side where the added parts or cuts
are created.

Select the alignment of the added parts or cuts.

You can swap the end points of the added parts
or cuts.
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Option Description
Select whether the existing cuts should be
taken into account when the added parts are
created.

Part 2 / Part 3 / Part 4 tab

You can add or cut more than one part at the same time. To do this, use the
tabs Part 2, Part 3 and Part 4.

Configuration tab
Use the Configuration tab to define the distance in material and whether
information needs to be printed.

UDA tab
Use the UDA tab to define user-defined attributes for the parts.

Use the Fabricator name, Name, Type, Nomination, Article number and
Comment user-defined attributes (UDAs) to add information for the added
parts or cuts.
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Concrete console (110)
Concrete console (110) creates a connection between a concrete column and
a concrete beam. The beam rests on a console which is attached to the
column.

Objects created

• Console

• Neoprene strip

• Steel plate between console and beam

• Anchor rods

• Tubes

• Sockets

Use for

Situation Description
Console connection between a
concrete column and a concrete
beam.

Selection order

1. Select the main part (column).

2. Select the secondary part (beam).

The connection is created automatically when the secondary part is
selected.
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Picture tab
Use the Picture tab to define the shape and the dimensions of the console,
and the steel support plates and the neoprene layer.

 Description
1 Shape and dimensions of the concrete console and the steel and

neoprene parts.
2 Select how the shape of the

secondary beam is modified if
the secondary beam is sloping.
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 Description
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 Description
 

3 Console offset.

You can set the reference to be
the main part or the secondary
part. Additionally, the offset
distance can be defined.

Reference =
column centerline

If no offset value is
applied, the
console is placed
symmetrically
compared to the
column.

Reference =
column left side

Reference =
column right side

Reference = beam
centerline

Reference = beam
left side

Reference = beam
right side
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 Description
4 Vertical plate offset.

You can set the reference to be
the main part or the secondary
part. Additionally, the offset
distance can be defined.

Reference =
column centerline

Reference =
column left side

Reference =
column right side

Reference = beam
centerline

Reference = beam
left side

Reference = beam
right side

5 Define the console thickness.

Select whether the console thickness is taken from the secondary part or
the main part. The default option is that the console thickness is taken
from the secondary part.

6 Console tapering.
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 Description
7 Select whether to create a cut around the console in the secondary part.

Define the cut dimension from the edge of the cut to the edge of the
console.

Parts tab
Use the Parts tab to define properties for the console, the neoprene layer and
the optional steel plates.

Option Description
Concrete console Prefix and start number for the part position

number, material, name, class and comment for the
console.

Console to column Select how the console is attached to the concrete
column.

Default is Part Add.

The No action option means that the console is a
loose part and not attached to any other part in the
component.

Create console like Select how the console is created.

Default is Contour plate.

Contour plate = the console is created using the
Contour plate command.

Beam = the console is created using the Beam
command.

Neoprene Neoprene layer properties.

A neoprene plate for shock absorbing and sound-
damping can be created between the beam and the
console.

If a trapezium shaped neoprene block is used, the
defined thickness will be the thickness on the
column side.

Neoprene to Select to which part the neoprene layer is attached,
and how the neoprene is attached.

Default is Beam and Weld.
Holes in neoprene Select how the holes in the neoprene part are

created.

Default is By bolt.
Diameter of holes in
neoprene

Diameter of the holes in the neoprene part.
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Option Description
By default, the hole size in the neoprene part is
equal to the holes in the console.

Enter a value to overwrite this default hole size.
Steel plate horizontal Horizontal steel plate size and properties.

The plate is placed under the neoprene part.
Steel plate vertical Vertical steel plate size and properties.

The plate is placed at the console side.
Add steel plate to the
column by

Select how the steel plate is attached to the column.

Default is Weld.
Rotate console
polygon

Define the rotation start point of the console
polygon. By default, the rotation starts from point 1.
Enter 2, 3, 4, or 5 to change the start point.

Console polygon
direction

Select the direction of the console polygon.

Connection tab
Use the Connection tab to define the properties of the anchor rods, nuts and
washers and injection tubes and to select how these parts are connected to
the console or the main part.

Option Description
Anchor rods Anchor rod profile.

Define the length and number of rods on the Anchor
rods tab.

Type of reinforcing
bars

Select the reinforcing bar type.

Anchors to Select to which part the anchor rods are attached, and
how the anchors are attached.

Default is Column and Weld.
Anchors all the
same L

Select whether the anchor rods have the same length.

Bottom section Select the profile from profile catalog.
Nut Nut profile.

Define the height of the nut on the Anchor rods tab.
Washer Washer profile.
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Option Description
You can define the direction and the rotation for each
washer.

Define the thickness of the washer on the Anchor
rods tab.

Weld washer and
nut to anchor

Select whether washers and nuts are welded to the
anchors.

Tube top Tubular embed for creating a round hole for the
anchors.

The tube top starts at the bottom level of the nut.
Tube bottom Tubular embed for creating a round hole for the

anchors.

The height of the tubular profile can be modified on
the Anchor rods tab.

Tubes around
anchors to beam

Select how the tubes around the anchors are attached
to the beam.

Default is Weld.
Tubes all the same L Select whether the tubes have the same length.
Tubes aligned with Select whether the tubes are aligned with the column,

top of the beam, or bottom of the beam.
Create cuts around
tubes

Select whether cuts are created around the tubes.

Parameters tab
Use the Parameters tab to define how the column and the beam are cut
(skew/square).

Option Description
Fitting to column Select how the top of the column is fitted.

Default is Perpendicular.
Column cut-out Default.

A full-width cut-out is
created.
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Option Description
Column left side cut-out.
Clearance between the
column and the beam can be
set.

Column right side cut-out.
Clearance between the
column and the beam can be
set.

Both sides cut-out. Clearance
between the column and the
beam can be set on both
sides.

Beam end cut-out

Use this option when
the beam and the
column are not
aligned.

Square beam end
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Option Description
Skewed beam end (according
to main part)

Beam bottom cut-out

Use this option when
the beam and the
column are not
aligned.

Square beam bottom

Skewed beam bottom
(according to main part)

Column cut-out for T-
shaped secondary part

In Beam type, select the
shape of the secondary part.

• Rectangular - always
creates a rectangular
column cut-out.

• T-beam - Tekla Structures
checks the shape of the
beam and creates a T-
shaped column cut-out.

• Automatic - Tekla
Structures automatically
checks the shape of the
secondary part, and
creates either a
rectangular or a T-shaped
column cut-out.

Automatic is the default
value.

For T-shaped cut-outs, define
the cut-out dimension
between the column and the
beam.

Secondary part width Define the maximum width
of the secondary part and
cut it to this width.
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Option Description
Cut extra secondary
parts

You can find and cut extra secondary parts by using
classes or name search.

Anchor rods tab
Use the Anchor rods tab to define dimensions and position of the anchor
rods.

 Description
1 Anchor rod length, hole diameter and top offset.
2 Number of anchor rods, distances and edge distances.
3 Anchor rod distribution options.

Useful when the beam is not aligned with the column.
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 Description
4 Select the type of the hole in the beam.

Default is Circular.

If you set the type to Circular, use the two boxes on
the left to define the hole diameter.

If you set the type to Square, use the four boxes on
the left to define the dimensions of the square cut.

5 Height of the tubular profile, nut and washer.
6 Anchor rods and cuts Default.

Anchor rods are
created. Holes for
the anchors are
created.

Anchor rods are
created. No holes
are created.

Only holes are
created. No
anchors are
created.
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 Description
Only anchor rods
are created. No
holes are created.

Cut-out in the
concrete beam.
Anchor rods are
created. No holes
are created.

Cut-out in the
concrete beam
(parallel to beam).
Anchor rods are
created. No holes
are created.

Tube offset

Define the offsets for the tube profiles in both the X and Y directions.

Socket tab
Use the Socket tab to define whether socket anchors are created, how they
are connected and the dimensions and position of the socket anchors.

If you create the sockets on the Socket tab, the anchor rods on the
Connection tab are automatically considered as sockets.

Option Description
Create socket Select whether sockets are created

and which parts are included.
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Option Description
Connect socket to prim by Select how the sockets are connected

to the main part.
Connection rod-connector Select the connection method

between the rod and the connecting
profile.

Type of reinforcing bars Select the rod type.
Leg rotation Select the direction of the rod. You

can enter an angle in the box on the
right.

Legs symmetrically Select whether custom part sockets
are created symmetrically.

Connector

Dowel

Properties for the connecting profile
and the rod.

Partname component If you want to use a custom part to
create the socket, select the Custom
part option in the Create socket list.
Then browse for the component, and
use the list of options to position the
custom part.

To use saved custom component
properties, select the saved
properties file.

General tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Concrete console (111)
Concrete console (111) creates a connection between a concrete column and
two secondary concrete beams. The beams rest on a console which is attached
to the column.

Objects created

• Console

• Neoprene strip

• Steel plates
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• Anchor rods

• Tubes

• Sockets

Use for

Situation Description
Console connection between a
concrete column and two concrete
beams.

Console connection between a
concrete column and one concrete
beam.

Selection order

1. Select the main part (column).

2. Select the first secondary part (beam).

3. Select the secondary part (beam).

4. Click the middle mouse button to create the connection.

Picture tab
Use the Picture tab to define the shape and the dimensions of the console,
and the steel support plates and the neoprene layer.
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Parts tab
Use the Parts tab to define properties for the console, the neoprene layer and
the optional steel plates.

Option Description
Console width Define the prefix and a start number for the part

position number, material, name, class and
comment for the console.

Define the width on the Picture tab.

If no value is entered, the width is the same as the
width of the beam.

Console to column Select how the console is attached to the column.
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Option Description
Default is Part Add.

The No action option means that the console is a
loose part and not attached to any other part in the
component.

Create console like Select the profile type of the console.

Default is Contour plate.

Contour plate = the console is created using the
Contour plate command.

Beam = the console is created using the Beam
command.

Neoprene Neoprene layer properties.

A neoprene plate for shock absorbing and sound-
damping can be created between the beam and the
console.

If a trapezium shaped neoprene block is used, the
defined thickness will be the thickness on the
column side.

Neoprene to Select to which part the neoprene layer is attached,
and how the neoprene is attached.

Default is Beam and Weld.
Holes in neoprene Select how the holes in the neoprene part are

created.

Default is By bolt.
Diameter of holes in
neoprene

Diameter of the holes in the neoprene part.

By default, the hole size in the neoprene part is
equal to the holes in the console.

Enter a value to overwrite this default hole size.
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Option Description
Select if the neoprene layer is split for each beam
separately.

Steel plate horizontal Horizontal steel plate size and properties.

The plate is placed under the neoprene part.
Steel plate vertical Vertical steel plate size and properties.

The plate is placed at the console side.

Add steel plate to the
column by

Select how the steel plate is attached to the column.

Default is Weld.
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Option Description
Rotate console
polygon

Define the rotation start point of the console
polygon. By default, the rotation starts from point 1.
Enter 2, 3, 4, or 5 to change the start point.

Console polygon
direction

Select the direction of the console polygon.

Anchor tab
Use the Anchor tab to define the properties of the anchor rods, nuts and
washers and injection tubes, and select how these parts are connected to the
console or the main part.

Option Description
Anchor rods Anchor rod profile.

Define the length and number of rods on the Anchor
rods tab.

Type of reinforcing
bars

Select the reinforcing bar type.

Anchors to Select to which part the anchor rods are attached, and
how the anchors are attached.

Default is Column and Weld.
Anchors all the
same L

Select whether the anchor rods have the same length.

Bottom section Select the profile from profile catalog.
Washer Washer profile.

Define the thickness of the washer on the Anchor
rods tab.

Nut Nut profile.

Define the height of the nut on the Anchor rods tab.
Weld washer and
nut to anchor

Select whether washers and nuts are welded to the
anchors.

Tube top Tubular embed for creating a round hole for the
anchors.

The tube top starts at the bottom level of the nut.
Tube bottom Tubular embed for creating a round hole for the

anchors.

The height of the tubular profile can be modified on
the Anchor rods tab.
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Option Description
Tubes around
anchors to beam

Select how the tubes around the anchors are attached
to the beam.

Default is Weld.
Tubes all the same L Select whether the tubes have the same length.
Tubes aligned with Select whether the tubes are aligned with the column,

top of the beam, or bottom of the beam.
Create cuts around
tubes

Select whether cuts are created around the tubes.

Anchor rods tab
Use the Anchor rods tab to define dimensions and position of the anchor
rods.

 Description
1 Anchor rod length, hole diameter and top offset.
2 Number of anchor rods, distances and edge distances.
3 Anchor rod distribution options.
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 Description
Useful when the beam is not aligned with the column.

4 Select the type of the hole in the beam.

Default is Circular.

If you set the type to Circular, use the two boxes on
the left to define the hole diameter.

If you set the type to Square, use the four boxes on
the left to define the dimensions of the square cut.

5 Height of the tubular profile, nut and washer.
6 Anchor rods and cuts Default.

Anchor rods are
created. Holes for
the anchors are
created.

Anchor rods are
created. No holes
are created.
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 Description
Only holes are
created. No
anchors are
created.

Only anchor rods
are created. No
holes are created.

Cut-out in the
concrete beam.
Anchor rods are
created. No holes
are created.

Anchor rods beam 2 tab
Use the Anchor rods beam 2 tab to define the properties of the anchor rods,
nuts and washers and injection tubes for the second secondary beam. The
default profile for the anchor rods created for the second secondary beam is
the same as for the anchors created on the Anchor tab.

Option Description
Anchor rods Anchor rod profile.

Define the length and number of rods on the Anchor
rods tab.

Type of reinforcing
bar

Select the reinforcing bar type.

Bottom section Select the profile from the profile catalog.
Nut Nut profile.

Define the height of the nut on the Anchor rods tab.
Washer Washer profile.

Define the thickness of the washer on the Anchor
rods tab.
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Option Description
Tube top Tube profile.

Tubular embed for creating a round hole for the
anchors.

The tube top starts at the bottom level of the nut.
Tube bottom Tube profile.

Tubular embed for creating a round hole for the
anchors.

The height of the tubular profile can be modified on
the Anchor rods tab.

 Description
1 Anchor rod length, hole diameter and top offset.
2 Select the type of the hole in the beam.

If you set the type to Circular (neg.vol.), use the two boxes on
the left to define the hole diameter. Circular (neg.vol.) is the
default value.

If you set the type to Circular (drilling), use the two boxes on
the left to define the hole diameter.

If you set the type to Square, use the four boxes on the left to
define the dimensions of the square cut.

Socket tab
Use the Socket tab to define whether socket anchors are created, how they
are connected and the dimensions and position of the socket anchors.
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If you create the sockets on the Socket tab, the anchor rods on the Anchor
tab are automatically considered as sockets.

Option Description
Create socket Select whether sockets are created

and which parts are included.
Connect socket to prim by Select how the sockets are connected

to the main part.
Connection rod-connector Select the connection method

between the rod and the connecting
profile.

Type of reinforcing bars Select the rod type.
Leg rotation Select the direction of the sockets.

You can enter an angle in the box on
the right.

Connecting profile

Rod

Properties for the connecting profile
and the rod.

Partname component If you want to use a custom part to
create the socket, select the Custom
part option in the Create socket list.
Then browse for the component, and
use the list of options to position the
custom part.

To use saved custom component
properties, select the saved
properties file.

General tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:

Concrete beam-beam (112)
Concrete beam - beam (112) creates a connection between a concrete beam
and one or two secondary concrete beams.

Objects created

• Neoprene

• Steel plates
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• Anchor rods

• Tubes

• Sockets

Use for

Situation Description
Connection between two concrete
beams.

Connection between three concrete
beams.

Selection order

1. Select the main part (beam).

2. Select one or two secondary parts (beam).

3. Click the middle mouse button to create the connection.
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Part identification key

 Part
1 Beam
2 Beam

Picture tab
Use the Picture tab to control the part dimensions and the shapes of the
parts, and the recesses.

Dimensions
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 Description Example
1 Define the gap between the main

part and the secondary part on the
left and the right side.

2 Define the vertical gap between the
main part and the secondary part.

3 Define the length of the neoprene.
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 Description Example
4 Define the gap between the

neoprene and the secondary part on
the left and the right side.

5 Define the length of the steel plate.

6 Define the gap between the steel
plate and the secondary part on the
left and the right side.
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 Description Example
1 Define the distance from the

centerline of the secondary parts
to the outer contour of the main
part on the left side.
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 Description Example
2 Define the distance from the

centerline of the secondary parts
to the outer contour of the main
part on the right side.

3 Define the distance from the
edge of the first secondary part
to the centerline.
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 Description Example
4 Define the distance from the

edge of the second secondary
part to the centerline.

5 Define the depth of the recess in
the main part.
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 Description Example
6 Define the depth of the recess in

the secondary part.

7 Define the width of the recess in
the first secondary part.
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 Description Example
8 Define the width of the recess in

the second secondary part.

9 Define the width of the
neoprene.

10 Define the distance from the
edge of the neoprene to the edge
of the main part.
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 Description Example
11 Define the distance from the

edge of the neoprene to the edge
of the main part.

12 Define the width of the steel
plate.

13 Define the distance from the
edge of the steel plate to the
edge of the main part.
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 Description Example
14 Define the distance from the

edge of the neoprene to the edge
of the main part.

15 Define the distance from the
edge of the recess in the main
part to the edge of the secondary
part.

Fit secondaries perpendicular to

Option Description
Default

Secondary parts are fitted perpendicular to the main
part.

AutoDefaults can change this option.
Secondary parts are fitted perpendicular to the main
part.
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Option Description
The top side of secondary parts is fitted perpendicular
to secondary parts while the bottom side of secondary
parts is fitted perpendicular to the main part.

Both the top side and the bottom side secondary parts
are fitted perpendicular to secondary parts.

Parts tab
Use the Parts tab to control the neoprene and steel plate properties and how
these parts are connected.

Neoprene and steel plate

Option Description
Neoprene Define the neoprene thickness, width and height.
Steel plate Define the steel plate thickness, width and height.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Comment Add a comment about

the part.
 

Neoprene properties

A neoprene plate for absorbing shock and for damping sound can be used
between the main and the secondary parts.

Concrete components 2863 Concrete detailing



Option Description
Neoprene to Define to which part the neoprene is

connected. The neoprene can also be a loose
part.

In the second list, define how the neoprene is
connected to the part.

Holes in Neoprene Define how the holes in the neoprene are
created.

Diameter of Holes in
Neoprene

Define the diameter of the holes in the
neoprene.
Define whether the neoprene is fitted to fill
the cut space between the main part and the
secondary part, or whether it is created in a
rectangular shape.

Define whether the neoprene is created as
one single plate or as two plates, and the
edge distance from the neoprene to the
secondary parts.

Steel plate properties

One or two additional steel plates can be used between the main and the
secondary parts.

Option Description
Add steel plate to
the primary by

Define how the steel plate is connected to
the main part.

Negative volume
around steel plate

Define whether there is a negative volume
around the steel plate.
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Anchors tab
Use the Anchors tab to control the properties of anchor rods, nuts, washers
and the top and bottom tubes.

Option Description
Anchor rods Anchor rods can be used between the main and the

secondary parts.

Select the anchor rod profile from the profile catalog. If
you set the Type of reinforcing bars option to
Reinforcing bar, select the reinforcing bar from the
catalog.

Nut Select the nut profile from the profile catalog.
Washer Select the washer profile from the profile catalog.
Tube top, Tube
bottom

Tubes can be used between the main and the
secondary parts.

Select the profile from the profile catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Comment Add a comment about

the part.
 

Anchor rods

Type of reinforcing bars Define the type of reinforcing bars.
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Anchors to Define to which part the anchor rods
are connected. The anchor rods can
also be loose parts.

In the second list, define how the
anchor rods are connected to the
part.

Anchors all the same L Define whether the anchor rods have
the same length.

Bottom section Define the type of profile in the
bottom section.

Anchors only in secondary Select whether anchor rods are
included only in the secondary parts.

Washer

Define the position of the washer handles.

Washer plate

Define the position of the plate handles.
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Option Description
Create washers symmetrically Define whether the washers on the

anchors are created symmetrically
(mirrored) to the washers on the
anchors at the opposite beam side.

Weld washer and nut to anchor Define whether the washers and nuts
are welded to the plates.

Tube top and tube bottom

You can add a tubular embed for creating a round hole for the anchors. The
tube top starts at the bottom level of the nut.

Option Description
Tubes around
anchors to beam

Define how to connect the tubes to the beam.

Tubes all the same
L

Define whether the tubes have the same length.

Tubes aligned with Select whether the tubes are aligned with the main
part, or with the top or bottom of the secondary part.

Create cuts around
tubes

Select whether cuts are created around the tubes.

Anchor rods tab
Use the Anchor rods tab to control the number, dimensions and position of
the anchor rods and the dimensions of the recesses in the main and
secondary parts.
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Dimensions

 Description Example
1 Define the size of

the holes in the
beam.
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 Description Example
2 Define the size of

the recesses in the
beam in both
directions.

3 Define the type of
the holes in the
beam.
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 Description Example
4 Define the distance

between the top of
the anchor rod and
the top of the beam.

5 Define the distance
between the bottom
of the recess and the
top of the anchor
rod.
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 Description Example
6 Define the distance

between the bottom
of the recess in the
main part and the
bottom of the recess
in the secondary
part.

7 Define the distance
from the centerline
of the secondary
parts to the outer
contour of the main
part.
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 Description Example
8 Define the width of

the anchor rod
hook.
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 Description Example
9 Define the height of

the anchor.

10 Define the angle of
the anchor rod
hook.
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 Description Example
11 Define the radius of

the anchor rod hook
in the main part in
the vertical
direction.
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 Description Example
12 Define the anchor

rod edge distances
from the main part.

13 Define the number
of anchor rods.

14 Define the anchor
rod spacing.

Use a space to
separate anchor rod
spacing values. Enter
a value for each
space between
anchor rods. For
example, if there are
3 anchor rod rows,
enter 2 values.
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 Description Example
15 Define the anchor

rod edge distances
from the secondary
parts.

16 Define the number
of anchors rods.

17 Define the anchor
rod spacing.

Use a space to
separate anchor rod
spacing values. Enter
a value for each
space between
anchor rods. For
example, if there are
3 anchor rod rows,
enter 2 values.
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 Description Example
1 Define the distance

between the top side of
the top tube and the top
of the part.

2 Define the height of the
nut.

Concrete components 2877 Concrete detailing



 Description Example
3 Define the height of the

washer.

4 Define the distance
between the bottom side
of the top tube and the
bottom side of the recess.

5 Define the distance
between the top side of
the bottom tube and the
bottom side of the recess.
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 Description Example
6 Define the distance

between the bottom side
of the bottom tube and
the bottom side of the
part.

Recesses

Define whether anchors and recesses are created.

Option Description
Anchors and recesses

Anchors

Recesses

In the list below the options, select whether the position of anchor rods is
calculated in the coordinate system of the main part or the secondary part.

Socket tab
Use the Socket tab to control the socket properties and how the sockets are
connected. If you create the sockets on the Socket tab, the anchors on the
Anchors rods tab are automatically considered as sockets.
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Sockets

Option Description
Create socket Select whether sockets are created

and which parts are included.
Connect socket to prim by Select how the sockets are connected

to the main part.
Connection rod-connector Select how to connect the rod

connector.
Type of reinforcing bars Select the rod type.
Leg rotation Select the direction of the sockets.

In the second list, define the angle of
the sockets.

Connecting profile, Rod

Option Description
Connecting
profile

Select the profile from the profile catalog.

Rod Select the rod profile from the profile catalog.

If you set the Type of reinforcing bars option to
Reinforcing bar, select the reinforcing bar from the
catalog.

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options.

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options.

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
Comment Add a comment about

the part.
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Partname component

Option Description
Partname
component

If you use a custom component to create the socket,
browse for the component and use the list of options
to position the custom component.

To use saved custom component properties, select the
saved properties file.

Rebars in primary tab / Rebars in secondary tab
Use the Rebars in primary tab and Rebars in secondary tab to create
reinforcing bars and stirrups at the connection position. On the Rebars in
primary tab you can create longitudinal reinforcing bars and stirrups for the
main part, and on the Rebars in secondary tab you can define stirrups for the
secondary part.

Rebars in primary

Create the rebars for the main part either by defining the number of rebars, or
by setting the spacing or the exact space.

Set the rebar properties, and define the cover thickness and leg length from
the edge of the opening.
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Rebars in secondary

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Panels and walls
This section introduces components that can be used in concrete panels and
walls.

Click the links below to find out more:

• Wall to wall connection (page 2883)

• Wall groove seam detail (page 2889)

• Anchor (10) (page 2895)
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• Wall wall teeth (12) (page 2909)

• Electric box in wall (84) (page 2917)

• Sandwich and double wall (page 2932)

• Sandwich wall horizontal seam (page 2960)

• Sandwich wall vertical seam (page 2968)

• Sandwich wall window (page 2975)

• Wall layout tools (page 2997)

• Geometry detailing strip (page 3030)

Wall to wall connection
Wall to wall connection creates a connection between two precast walls. The
connection can contain a groove with or without additional shear teeth.
Additionally, the connection can create reinforcing bar loops or embeds that
work as connectors in the walls.

Objects created

• Groove

• Shear teeth or shear cups

• U bars

• Embeds

• Long bar
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Use for

Situation Description
Wall to wall connection with groove,
shear teeth, U bars and a loose bar.

Selection order

1. Select the first wall.

2. Select the second wall.

The connection is created automatically when the second wall is selected.

Edge shape tab
Use the Edge shape tab to select the wall framing type

Option Description
Wall framing type selection.

Wall framing type selection affects the wall edge
shape options.

You can use the connection in three different
modeling situations:

• end-to-end

• corner

With this option the first selected wall is fitted to
align with the exterior face of the second
selected wall.

• tee
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Option Description
Wall edge shape.

Select the edge shape of each wall.

Adjust the free space between two walls.

Wall edge dimensions.

To set the edge shape and dimensions
independently for both walls, use the Use given
dimensions option.

To make the edge shape similar in both walls, use
the Same to right side option.
Groove start and end point.

You can define the start point and the end point of
the groove. If you do not enter a value, or enter 0,
the groove is applied at full height of the wall.

Select to create part cuts or only extra part cuts,
and define the name of the cut. You can set this
separately for both walls. For part properties of
extra part cuts, select a saved settings file.

Extra teeth tab
Use the Extra teeth tab to define the properties for additional shear teeth.

Option Description
Select whether additional shear teeth or shear
cups are created.

Teeth or cups can also be created when there
is no groove.
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Option Description
Dimensions of a single tooth or cup.

Location of the first tooth or cup in the first
wall and in the second wall, and the spacing
between the teeth or cups.

You can enter a list of spaces, for example
10*400, or just a single value. When you enter
a single value, the number of teeth or cups is
calculated automatically based on the height of
the connection.
Select to create part cuts or only extra part
cuts, and define the name of the cut.

Connectors tab
Use the Connectors tab to select the type of connectors created.

Connector type

The content of the Connectors tab varies depending on the type of the
selected connectors.

Option Description
Connector type.

• No connectors. Only groove with or without shear
teeth is created.

• Connectors are created by using the selected
embed (custom part).

• Connectors are created by adding reinforcing bar
loops. Reinforcing bar loop is formed depending
on the wall framing type.

In addition, the connector can optionally create one
or more long reinforcing bars along the connection.
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Embeds and loose rebar

Option Description
Location of the first connector (embed) in
the first wall and in the second wall,
location of the last rebar/embed in the
wall top edge, and the spacing between
the connectors.

You can enter a list of spaces, for
example 10*400, or just a single value,
for example 300. When you enter a
single value, the number of connectors is
calculated automatically based on the
height of the connection.

You can also define the extended length
of the loose long bar.
Select which embeds (custom parts) are
created in each wall.

If the embed has any saved attributes,
select which attributes are used.
Offset of the embed.

By default, the embed input points are in
the center of the wall.

To add multiple connector embeds in the
same height section, you can add
additional offsets in the box. For
example, -75 75 will create 2 connector
embeds both located 75 mm from the
panel's centerline.

U bars and loose rebar

Option Description
Location of the first connector
(reinforcing bar loop) in the first wall and
in the second wall, and the spacing
between the connectors.

You can enter a list of spaces, for
example 10*400, or just a single value,
for example 300. When you enter a single
value, the number of connectors is
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Option Description
calculated automatically based on the
height of the connection.

You can also define the extended length
of the loose long bar.
Reinforcing bar loop dimensions.

The available dimension options depend
on the wall framing type selected on the
Edge shape tab.

Many of the dimensions have counter
parts in the first wall and in the second
wall. It is enough to enter one dimension
and by default the counter part
dimension gets the same value.

Number of bars Number of long loose bars.

If you do not want to create a loose long
bar, enter 0 as the Number of bars.

Reinforcing bar properties

Enter the properties for reinforcing bar Grade, Size, Name, Class, Prefix and
Start Number.

Customization

If needed, you can create your own embed (custom part) and use it as a
connector.

When creating the embed, ensure that the input points are defined so that
they are compatible with Wall to wall connection. The image below shows
examples of the input points.
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Thickening tab
Use the Thickening tab to create an extra thicknening to one or both walls.

Option Description
Select to which side of the wall the
thickening will be created. The final
location of the extra thickening
depends on the actual framing case
(end to end, L corner, T corner).

Enter the name and class for the extra
thickening. Leave the input box empty
to use the wall name and/or class.

Wall groove seam detail
Wall groove seam detail creates a groove with optional shear teeth to a
precast wall, a slab or a similar part. Additionally the connection can create
reinforcing bar loops or embeds that work as connectors in the walls.

Objects created

• Groove
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• Shear teeth or shear cups

• U bars

• Embeds

• Long bar

Use for

Situation Description
Groove with shear teeth and U bars.

Selection order

1. Select the wall or slab.

2. Pick the start point of the groove.

3. Pick the end point of the groove.

Edge shape tab
Use the Edge shape tab to select the orientation of the groove.

Option Description
Groove orientation selection.

Define the orientation of the groove in relation to
the input points.

Create fitting Select whether the part end fitting is created.
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Option Description
Groove edge shape.

Groove start and end point in relation to input
points.

You can define the start point and the end point of
the groove. If you do not enter a value, or enter 0,
the groove is applied at full height of the wall.

Select to create part cuts or only extra part cuts,
and define the name of the cut. For part properties
of extra part cuts, select a saved settings file.

Extra teeth tab
Use the Extra teeth tab to define the properties for additional shear teeth.

Option Description
Select whether additional shear teeth or shear
cups are created.

Teeth or cups can also be created when there
is no groove.
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Option Description
Dimensions of a single tooth or cup.

Location of the first tooth or cup in the groove,
and the spacing between the teeth or cups.

You can enter a list of spaces, for example
10*400, or just a single value. When you enter
a single value, the number of teeth or cups is
calculated automatically based on the height of
the detail.
Select to create part cuts or only extra part
cuts, and define the name of the cut.

Connectors tab
Use the Connectors tab to select the type of connectors.

Connector type

The content of the Connectors tab varies depending on the type of the
selected connectors.

Option Description
Connector type.

• No connectors. Only groove with or without
shear teeth is created.

• Connectors are created by using the
selected embed (custom part).

• Connectors are created by adding
reinforcing bar loops. Reinforcing bar loop
is formed depending on the framing type.

In addition, the connector can optionally create
one or more long reinforcing bars along the
connection.
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Embeds and loose rebar

Option Description
Location of the first connector (embed) in
the groove, location of the last rebar/
embed in the wall top edge, and the
spacing between the connectors.

You can enter a list of spaces, for
example 10*400, or just a single value,
for example 300. When you enter a
single value, the number of connectors is
calculated automatically based on the
height of the detail.

You can also define the extended length
of the loose long bar.
Select which embeds (custom parts) are
created in each groove.

If the embed has any saved attributes,
select which attributes are used.
Offset of the embed.

By default, the embed input points are in
the center of the groove.

U bars and loose rebar

Option Description
Location of the first connector
(reinforcing bar loop) in the groove,
and the spacing between the
connectors.

You can enter a list of spaces, for
example 10*400, or just a single
value, for example 300. When you
enter a single value, the number of
connectors is calculated automatically
based on the height of the detail.

You can also define the extended
length of the loose long bar.

Concrete components 2893 Concrete detailing



Option Description
Reinforcing bar loop dimensions.

The available dimension options
depend on the orientation of the
groove selected on the Edge shape
tab.

Number of bars Number of long loose bars

If you do not want to create a loose
long bar, enter 0 as the Number of
bars.

Reinforcing bar properties

Enter the properties for reinforcing bar Grade, Size, Name, Class, Prefix and
Start Number.

Customization

If needed, you can create your own custom part (embed) and use it as a
connector.

When creating the embed, ensure that the input points are defined so that
they are compatible with Wall groove seam detail. The image below shows
examples of the input points.

Concrete components 2894 Concrete detailing



Thickening tab
Use the Thickening tab to create an extra thicknening to the wall.

Option Description
Select to which side of the wall the
thickening will be created. The final
location of the extra thickening
depends on the actual framing case
(end to end, L corner, T corner).

Enter the name and class for the extra
thickening. Leave the input box empty
to use the wall name and/or class.

Anchor (10)
Anchor (10) connects two precast concrete parts, for example, two panels or a
column to a panel. The precast concrete parts are connected with L profiles
and with embedded connection profiles that act as anchors, for example,
custom component bolt anchors or cast-in channels. The bolt anchors and the
cast-in channels can be single-sided or double-sided. Additionally, seams can
be defined between the main part and the secondary parts.
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Objects created

• Anchors (bolt anchors or cast-in channels)

• L profiles

• Bolts

Use for

Situation Description
Connection with L profiles and bolt
anchors.

Connection with L profile and cast-in
channel.

Selection order

1. Select the main part (precast concrete panel or a column).

2. Select the secondary part (precast concrete panel).

The connection is created automatically when the secondary part is
selected.

Concrete components 2896 Concrete detailing



Picture tab
Use the Picture tab to define the number of anchors (bolt anchors or cast-in
channel profiles), edge distances and plate embed offset.

 Description Example
1 Horizontal offset of the anchors.

The offset can be defined for both
concrete parts separately.

2 Vertical offset of the anchors.

The offset can be defined for the top
and bottom side.

 

3 Select how the anchors are
distributed.
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 Description Example
4 Select which of the anchors are

omitted.

5 Connection plate horizontal offset
from the centerline of an anchor.

This option is available only if you
have set the orientation of the
connection plate as follows on the
Conn profile tab:
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Anchors tab
Use the Anchors tab to define the properties, position and orientation of the
anchors (bolt anchors or cast-in channel profiles).

 Description Example
1 Anchor properties in the main part.

2 Select on which side the anchors are
created in the main part.

3 Select whether a profile from the profile
catalog is used as an anchor, or a custom
part from the Applications &
components catalog.
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 Description Example
4 Anchor properties in the secondary part.

5 Select on which side the anchors are
created in the secondary part.

 

6 Select whether a profile from the profile
catalog is used as an anchor, or a custom
part from the Applications &
components catalog.

To use saved custom component
properties, select the saved properties
file.

 

7 Select the connection method of the
anchor.

• Default (same as Weld to element)

• Weld to element

• Cast unit to element

• Not add to element (bolt anchors or
cast-in channels are loose parts)

• Sub-assembly

 

8 Position and rotation of the anchors in the
main concrete part.

For the Position in plane and Position in
depth options, an offset can be defined.

 

9 Orientation of the anchors in the main
part.
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 Description Example
10 Position and rotation of the anchors in the

secondary concrete part.

For Position in plane and Position in
depth options, an offset can be defined.

 

11 Orientation of the anchors in the
secondary part.

12 Select the cut-out method of the anchors.

Default, no cut

No cut

Cut-out shape is the exact
profile contour of the bolt
anchor or the cast-in channel

Box shape cut-out
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Conn profile tab
Use the Conn profile tab to define the properties and position of the
connection L profile.

 Description Example
1 Connection profile properties.

2 Select on which side the connection
profiles are created.

3 Select whether a profile from the
profile catalog is used as a
connection profile, or a custom part
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 Description Example
from the Applications &
components catalog.

4 Position and rotation of the
connection profiles.

For the Position in plane and
Position in depth options, an offset
can be defined.

 

5 Orientation of the connection profile.

6 Connection profile cuts.

These options are available only if
you have set the orientation of the
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 Description Example
connection profile as follows on the
Conn profile tab:

7 Select the connection method of the
connection profile.

 

8 Select the connection profile type.

• Library profile (define the profile
using the L profile options).

• Folded plate (define the
dimensions using the options
below).

Bolts tab
Use the Bolts tab to define the bolt properties and offsets.
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 Description
1 Horizontal bolt distances from the L profile edges.

Default value is half of L profile flange width.
2 Vertical bolt offsets.

Reference is the L profile centerline. Default value is 0 mm.
3 Select how the bolts are added in the main part.
4 Select how the bolts are added in the secondary part.
5 Bolting direction.

Cuts tab
Use the Cuts tab to define the cuts and the seams in the main and secondary
parts.

Additionally, the main part can be extended, or the secondary part thickness
can be increased or decreased.

You can create a seam by defining a cut between the main part and the
secondary part.
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 Description Example
1 Extension of the main part.

If you need to extend the part,
enter a value. Ensure that you have
also selected a cut method from
the cut type list. If you select the
No cut option, the part is not
extended.

 

2 Seam width.

Reference is the L profile
centerline. Default value is 0 mm.

 

3 Left side cut along the secondary
part.

Reference is the part centerline.

Part thickness is decreased.

 

4 Right side cut along the secondary
part.

Reference is the part centerline.

Part thickness is decreased.
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 Description Example
5 Cut reference for the main and

secondary parts.

Main part near side

Main part centerline

Main part far side

6 Select the cut type.

Default, no cut
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 Description Example

Reference is the main part.
Secondary part will be adjusted to
the main part using a fitting.

Reference is the main part.
Secondary part will be adjusted to
the main part using a line cut.

Reference is main part. Just like
previous options, but the longest
part of the panel will be removed
using a line cut.

No cut

Default tab
Use Default tab to define part distances.
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Wall wall teeth (12)
Wall wall teeth (12) connects two perpendicular concrete panels with a tooth-
shaped connection. The number of teeth can be set. Injection tubes and
connection bars can be added to the connection. The connection is created
with or without seams.

Objects created

• Tooth connection (2 or 3 teeth) between two panels

• Injection tubes

• Connection bars

Use for

Situation Description
2-teeth connection between two panels.

The height of the teeth can be modified and the
clearance between the teeth can be set.
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Situation Description
3-teeth connection between two panels with
connection bar.

Tooth connection between two panels with
connection bar and socket.

Selection order

1. Select the main part (concrete panel).

2. Select the secondary part (concrete panel).

The connection is created automatically when the secondary part is
selected.

Picture tab
Use the Picture tab to define the number of teeth, the height of teeth, and
seam widths. Wall wall teeth (12) has two main connection types: A (two
teeth) and B (three teeth).
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 Description
1 Select the number and position of teeth.

Standard is A 2 teeth bottom up.

2 Horizontal seam width in the main part. For type A (2-teeth connection).
3 Secondary part tooth height.

Reference is center of the seam. For type A (2-teeth connection).
4 Main part tooth height.

Reference is center of the seam. For type A (2-teeth connection).

This value has an effect only if the secondary part tooth height (3) has no
value.

5 Vertical seam width between the teeth. For type A (2-teeth connection).
6 Horizontal seam width in the main part. For type A (2-teeth connection).
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 Description
7 Top tooth height. For type B (3 teeth connection).

Reference is center of the seam.

If there is no value, and the middle tooth height and the bottom tooth
height are defined, then the top tooth gets the residual height distance.

If none of the tooth heights are defined, then all three teeth get an equal
height: (wall height - seam width) / 3
This value has lowest priority from the three tooth height-defining
values.

Example:

Panel height is 1500mm. All three tooth heights are defined:

• Top: 400mm

• Middle: 700mm

• Bottom: 600mm

Total defined height of teeth = 1800mm. Result: top tooth gets height
1500-700-600=200mm

8 Vertical seam width between the teeth. For type B (3-teeth connection).
9 Bottom tooth height.

Reference is center of the seam. For type B (3-teeth connection).

If there is no value, and the top tooth and the middle tooth height are
defined, then the bottom tooth gets the residual height distance.

Parts tab
Use the Parts tab to define the properties and dimensions of injection tubes
and connection bars.
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Option Description
Injection tubes Injection tube properties.

You can define the placing of the injection tubes
separately for the top tooth, middle tooth and
bottom tooth.

1 Select whether an injection tube is created.

Example:

Default is No action.
Top tooth

Middle tooth

Bottom tooth

Select whether an injection tube is created in the
teeth and select the connection method.

Default is Part cut.
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Option Description
Connection bar Connection bar properties.

One connection bar can be created through the
teeth.

2 Select whether a connection bar is created and the
connection method.

Default is Yes + weld 1.
3 Depth of a connection bar from the top of the top

tooth.

Default is 0.
4 Depth of an injection tube from the top of the top

tooth.

Default is 0.
5 Depth of a connection bar from the top of the

bottom tooth.

Default is top tooth height + seam width. If both
values 5 and 7 are defined, then the value in the box
7 overwrites the value in the box 5.

6 Depth of an injection tube from the bottom of the
bottom tooth.

Default is 0.
7 Depth of a connection bar from the bottom of the

bottom tooth.

If both values 5 and 7 are defined, then the value in
the box 7 overwrites the value in the box 5.

Cut sec tab
Use the Cut sec tab to define the way the secondary concrete panel is cut.

By default the component creates a 2-teeth connection.

You can also define a fixed offset value for the cut.

If the concrete panels are not perpendicularly orientated, you can define how
the secondary part is fitted to the main part.
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Cut prim tab
Use the Cut prim tab to define the way the main concrete panel is cut.

You can also define a fixed offset value for the cut.

If the concrete panels are not perpendicularly orientated, you can define how
the main part is fitted to the secondary part.
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Socket tab
Use the Socket tab to define whether socket anchors are created, how they
are connected and the dimensions and position of the socket anchors. Sockets
are created only if you have created connection bars.

Option Description
Dimensions for socket anchor, rod profile
and connecting profile.

Create socket Select whether sockets are created and
which parts are included.

Note that a socket is created only if a
connection bar has been created on the
Parts tab.

In the examples the red profile is the
connection bar:

Connect socket Select how the sockets are connected to
the main part.

Default is By cast unit.
Connection rod-connector Select the connection method between

the rod and the connecting profile.

Default is Part add conn to rod.
Rod type Select the rod type.

Default is Poly-profile.
Leg rotation Select the direction of the rod. You can

enter an angle in the box on the right.
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Option Description
Default is Front.

Connecting profile

Rod

Bottom section

Properties for the connecting profile, rod
and bottom section.

Note that the bottom section is part-
added to the rod automatically.

Example:

Partname component If you want to use a custom part to create
the socket, select the Custom part
option in the Create socket list.

Then browse for the component, and use
the list of options to position the custom
part. To use saved custom component
properties, select the saved properties
file.

General tab

Click the link below to find out more:

Analysis tab

Click the link below to find out more:
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Electric box in wall (84)
Electric box in wall (84) creates electric boxes in walls.

Objects created

• Electric boxes

• Tubes

Use for

Situation Description
Electric box in a wall with
top connection.

Electric box in a wall with
bottom connection.
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Situation Description
Electric box in a wall with
top and bottom
connections.

Selection order

1. Select a concrete panel.

2. Pick a position for the electric box.

3. Pick a position for the top connection.

4. Pick a position for the bottom connection.

The electric box and connections are created automatically.

Concrete components 2919 Concrete detailing



Part identification key

 Part
Electric box

Panel

Picture tab
Use the Picture tab to control the shape, number and position of the tubes
and the position of the electric boxes.

Tube direction

Option Description
Select the tube shape in the
up direction.

Concrete components 2920 Concrete detailing



Option Description
Select the tube shape in the
down direction.

Select the tube direction in
relation to the start point
(yellow) and end point
(magenta) of the wall.

Select the number of tubes
in the up direction.

Select the number of tubes
in the down direction.

Tubes to concrete / Electric parts to concrete

Select how the tubes and the electric parts are connected to the concrete part.

Option Description
As
subassembly

Add as a subassembly to the
concrete part.

By cast unit Add to the concrete part.
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Option Description
Welds Weld to the concrete part.
Not Do not connect to the concrete part.

Tube and electric box positions

Option Description
Select the position of the up
connection in the concrete part.
Select the position of the electric box
in the concrete part.
Select the position of the down
connection in the concrete part.

Parts tab
Use the Parts tab to control the tube properties at the top and bottom of the
concrete part and the position of the tube reference points.

Tube top / Tube bottom

Option Description Default
t, b, h Define the tube thickness,

width and height.
D19

Pos_No Define a prefix and a start
number for the part
position number.

ET 1

Material Define the material grade. PVC
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Option Description Default
Name Define a name for the

tube.
E-tube

Class Define the part class
number for the tube.

2

Comment Add a comment for the
tube.

1st reference point

Define a reference point for the tube. The reference point determines the
position of the part mark in a drawing.

Option Description Example
At top Start point is positioned

at the top of the tube.

At bottom Start point is positioned
at the bottom of the
tube.
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Option Description Example
At longest
segment

Start point is positioned
at the longest segment
of the tube.

At smallest
segment

Start point is positioned
at the smallest segment
of the tube.

Electric box tab
Use the Electric box tab to control the shape, number and dimensions of the
electric boxes and to define a possible connection piece (Tube a).

Electric box / Tube a

Option Description Default
t, b, h Electric box and the

connection piece (Tube
a) thickness, width and
height.

D19

Pos_No Prefix and a start
number for the part
position number.

ET 1

Material Material grade. PVC
Name Name for the electric

box and the connection
piece.

E-tube
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Option Description Default
Class Part class number for

the electric box and the
connection piece.

2

Comment Add a comment for the
electric box and the
connection piece.

Rotation

Control the rotation of the electric box and the connection piece.

Option Example
Front

Top

Back

Below
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Electric box shape

Option Description
Profiles / Custom part

Example custom part:

You can use a profile from the profile
catalog or select a custom component
from the Applications &
components catalog.

If you use a custom component,
browse for the component and use
the list of options to position the
custom component.

To use saved custom component
properties, select the saved
properties file.
Select the shape of the electric box
and define the dimensions for the
electric box.

Select an extra shape for creating
several different types of electric
boxes.

This shape is visible in drawings and it
indicates the front and back side of
the electric box.

Number = Number of electric boxes in
horizontal or vertical direction.

1 Select the top connection pieces for
the electric box.

2 Select the left side connection pieces
for the electric box.

Concrete components 2926 Concrete detailing



Option Description
3 Select the right side connection pieces

for the electric box.
4 Select the bottom connection pieces

for the electric box.
Dimensions of the connection pieces.

Positions of the connection pieces.

Options to add the electric box to the
part.

• Create electric box

• Create electric box + cut electric
box

• Create electric box + cut bounding
box

Top conn / Bottom conn tab
Use the Top conn and Bottom conn tabs to control the shape and dimensions
of the top and bottom connection boxes, and to define a possible connection
piece (Tube a).
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Top box / Bottom box / Tube a

Option Description
t, b, h Top and bottom connection box and the connection

piece (Tube a) thickness, width and height.
Pos_No Prefix and a start number for the part position number.
Material Material grade.
Name Name for the connection box and the connection piece.
Class Part class number for the connection box and the

connection piece.
Comment Add a comment for the connection box and the

connection piece.

Rotation

Control the rotation of the connection piece (Tube a).

Connection box shape

Top conn Bottom conn Description
Profiles / Custom part You can use a profile from

the profile catalog or select
a custom component from
the Applications &
components catalog.

If you use a custom
component, browse for
the component and use
the list of options to
position the custom
component.
Select the shape of the
connection box and define
the dimensions for the
box.
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Top conn Bottom conn Description
Dimensions of the
connection box.

Position of the connection
piece.

Options to add the
connection box to the part.

• Create connection box

• Create connection box
+ cut connection box

• Create connection box
+ cut bounding box

Select the connection
pieces for the connection
box.
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Top conn Bottom conn Description
Select the number of
connection boxes.

Connect

Define how to the connection box is connected.

UDA tab
Use the UDA tab to add information in the parts’ user-defined attributes
(UDAs).

Option Description
Part Select to which part the related information can be saved:

Nothing

Tube top

Tube bottom

Tubes

Electric box

Top connection

Bottom connection

All
UDA
name

Enter the name of the
user-defined attribute.

For example, to add a
comment UDA, open the
objects.inp file in a
text editor and search for 
comment. The following
attribute is shown:

attribute("comment",
"j_comment", string,

UDA name:

• comment

• fabricator

• art_number

• type

UDA:

• Comment

• Fabricator
name

• Article
number

• Type
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Option Description
"%s", no, none,
"0.0", "0.0")
The first text between the
quotation marks is the
UDA name, comment. The
entered name is case
sensitive.

Type Type of the user-defined
attribute.

Use String for text, Integer for
numbers, Float for numbers with
decimals and Option for
selecting an item in a list. You can
find the UDA type in the
objects.inp file

Value Enter the value that is saved to the user-defined attribute.

Example
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Sandwich and double wall
Sandwich and double wall creates a precast concrete wall. The wall consists
of an inner shell, foil, insulation, and outer shell.

Objects created

• Inner shell

• Foil (optional)

• Insulation (optional)

• Outer shell (optional)
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Use for

Situation Description
Sandwich wall, split shells.

Sandwich wall, brick wall on outer
shell as surface treatment.

Selection order

1. Pick the first point.

2. Pick the second point.

The wall is created automatically when the second point is picked.
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Part identification key

 Part
1 Inner shell
2 Foil
3 Insulation
4 Outer shell

Parts tab
Use the Parts tab to control the dimensions and positioning of the sandwich
wall inner shell, foil, insulation, and outer shell. The inner shell is always
created.

Numbering settings

Set Numbering settings to Enabled to show Prefix and Start number for all
parts.

Inner shell

Option Description Default
Thickness Define the thickness of

the inner shell.
150 mm
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Foil

Option Description Default
Thickness Define the thickness of

the foil.
1 mm

Create foil Define whether the foil
is created.

Yes and subassembly

Insulation

Option Description Default
Thickness Define the thickness of

the insulation.
50 mm

Create insulation Define whether the
insulation is created.

Yes and subassembly

Edge strips in split case Define different material
and class properties for
parts on the edge of the
wall.

 

Outer shell

Option Description Default
Thickness Define the thickness of

the outer shell.
1 mm

Create outer shell Define whether the
outer shell is created.

Yes + cast unit

Properties

Option Description Default
Pos_No Prefix and start number

for the part position
number.

Some components have
a second row of fields
where you can enter the
assembly position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options .

Material Material grade. The default material is
defined in the Part
material box in the
Components settings in
File menu --> Settings --
> Options .
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Option Description Default
Name Name that is shown in

drawings and reports.
 

Class Part class number.  
Cast unit type Defines if the structure

type of the part is
Precast or Cast in
place.

Set Cast unit type to
Enabled to show Cast
unit type for parts.

Precast

Positioning

You can use Standard or Advanced positioning. With advanced positioning,
there are more options for sandwich wall width and foil position.

Sandwich wall width

Option: Standard Description
No gaps between the parts. Sandwich
wall thickness is the sum of all
created parts.

Define the total wall width.

A gap is created between the outer
shell and the insulation.

Option: Advanced Description
Define the total wall width and the
gap between the inner shell and the
insulation.

Another gap is created between the
outer shell and the insulation.
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Option: Advanced Description
Define the total wall width and the
gap between the outer shell and the
insulation.

Another gap is created between the
inner shell and the insulation.

Define the total wall width and the
gap between the inner shell and the
insulation.

No gap is created between the outer
shell and the insulation.

Foil position

Option Description
By default, the foil is placed on the
outer side of the inner shell.
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Option Description
Define another foil position. Set
Positioning to Advanced.

Point offset

Option Description
Define the offset from the outer face
of the inner shell.

Define the offset from the inner face
of the inner shell.

Define the offset from the center of
the sandwich wall.
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Option Description
Define the offset from the inner face
of outer shell.

Define the offset from the outer face
of outer shell.

Parametric profile

Option Description
Parametric section Set to Enabled to define the prefix for

the parametric profiles of the
sandwich parts.

Prefix for the parametric profile Select the prefix for the parametric
profile:

• Position h*b and Position
b*h to create plate profiles
without a prefix.

If Parametric section is set to
Disabled, the parts have an h*b
prefix, for example, 2000*100.

• Position PLh*b and Position
PLb*h to create plate profiles
whose prefix starts with PL.

• Par. section h*b and Par.
section b*h require you to enter
a parametric plate profile prefix.

Par.section prefix Define the prefix of the parametric
profile.
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Vertical section tab
Use the Vertical section tab to control the vertical level part properties. You
can define both the top and the bottom level. The levels can be set as absolute
levels, or vertically relative (displaced) to the points.

Top level

Option Description
n1, n2, n3, n4 Define the absolute top level height.
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Option Description
h1, h2, h3, h4 Define the part height from the

bottom face.
d2, d3, d4 Define the vertical displacement from

the adjacent part.

When you use relative levels, the levels of all other parts depend on the inner
shell level.

Bottom level

Option Description
m1, m2, m3, m4 Define the absolute bottom level

height.
a1, a2, a3, a4 Define the bottom offset from the

point.
b2, b3, b4 Define the vertical displacement from

the adjacent part.

When you use relative levels, the levels of all other parts depend on the inner
shell level.
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Thicken innershell

You can define a thickening for both the top and the bottom side of the inner
shell.

Option Description Example
Inner shell is not
thickened.
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Option Description Example
Inner shell is thickened
towards the outer face of
the insulation.

Define the insulation
height to prevent
collisions.

Inner shell is thickened to
the inner face of the
outer shell.

Inner shell is thickened to
the outer face of the
outer shell.

Define the outer shell
height to prevent
collisions.

Inner shell covers the
insulation and outer
shell.
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Option Description Example
Thickness Define the inner shell

thickness.

If you do not enter a value, the
inner shell thickness defined
on the Parts tab is used.

Thickening parts Select how the top and
bottom thickening parts are
added to the inner shell.

 

Gap in inner shell Enter a value to create a gap
between the inside and the
front of the inner shell at the
bottom and the top.

The gap is filled with
insulation.

 

Offset options Select the offset options for
the thickening parts. Offset
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Option Description Example
can be defined for both wall
ends.

Horizontal section tab
Use the Horizontal section tab to define the wall ends and to control how the
wall parts are split in the horizontal direction.

Wall end

The wall end options are the same for both ends.

First wall end Second wall end
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Wall end offset

Option Description Example
Inner shell end is fixed.

Define the offset for the
ends of the foil,
insulation, and outer
shell.

Insulation end is fixed.

Define the offset for the
ends of the inner shell,
foil, and outer shell.

Outer shell end is fixed.

Define the offset for the
ends of the inner shell,
foil, and insulation.

Corner shape to the
inside direction.

For the outer shell angle,
define the offset from
the inner face of the
inner shell. Insulation is
along the inner shell.

Corner shape to the
inside direction.

Define the length of the
outer shell angle.
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Option Description Example
Corner shape to the
inside direction.

For the outer shell angle,
define the offset from
the inner face of the
inner shell. Insulation is
along the outer shell.

Corner shape to the
outside direction.

Define the horizontal
offset for the outer shell.
There is no gap between
the insulation and the
inner shell angle.

The empty void between
the front of the created
corner part and the front
of the insulation is by
default filled with
insulation.
Corner shape to the
outside direction.

Define the horizontal
offset for the outer shell.
For the inner shell angle,
define the offset from
the outer face of the
inner shell.
Corner shape to the
outside direction.

Define the horizontal
offset for the outer shell.
For the inner shell angle,
define the length.

Angled shells are not
created.

Define horizontal offset
for the inner shell,
insulation, and outer
shell.
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Corner shape

Option Description
Select the inner shell corner shape.

Select the outer shell corner shape.

Select the insulation corner shape.

Add corner to main shell Add the corner to the shell. The options are:

• Add to 4 Cast Unit (4 = outer shell)

• Add to 4 Sub assembly
• Add to 1 Cast Unit (1 = inner shell)

• Add to 1 Sub assembly
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Vertical chamfer

Option Description
Define whether a vertical chamfer is created.

Define the horizontal and vertical chamfer
dimensions, and the part prefix and the start
number.

Horizontal offset

To use the options, set the Split Front view option to Enabled.

Option Description
Define the horizontal offset for the foil,
insulation, and outer shell. The main gap
between the inner shells is defined in the Split
Front view section of the tab.

Define the horizontal offset for the inner shell,
foil, and outer shell. The main gap between the
insulation parts is defined in the Split Front
view section of the tab.

Define the horizontal offset for the inner shell,
foil, and insulation. The main gap between outer
shells is defined in the Split Front view section
of the tab.

Define a 90-degree angle for the inner shell and
the vertical offset towards the angled shell from
the inner face of the outer shell. The main gap
between the inner shells is defined in the Split
Front view section of the tab.

Additional options for the 90-degree angle:
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Option Description
• Define the corner shapes for the inner shell.

• Define how the corner is added to the inner
shell.

• Define the part prefix and the start number.

Mirroring

Option Description
Define whether the sandwich wall is
mirrored.

Splitting parts

To split wall parts, set the Split Front view option to Enabled.

Option Description
Parts are not split. Define the
horizontal offset for both wall ends
using the points as reference points.
Parts are split. Define the section
width and the number of sections.

First end offset is the reference for
the first section width at the first wall
end.

Second end offset is the reference for
the last section width at the second
wall end.
Parts are split. Define the section
width and the number of sections.

First end offset is the reference for
the first section width at the first wall
end.

Point (2) is the reference of the last
section width at the second wall end.
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Option Description
Parts are split. Define the section
width and enter the number of
sections.

Point (1) is the reference of the start
section at the first wall end.

Second end offset is the reference for
the last section width at the second
wall end.
Parts are split. Define the section
width and enter the number of
sections.

Points (1, 2) are the references for the
section width at both wall ends.

Option Description
Define the horizontal direction.

Foil tab
Use the Foil tab to control the vertical and/or horizontal splitting of the foil.

Dimensions
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Option Description
1 Define whether the foil is split:

• Foil is not split.

• Foil is split in the horizontal
direction.

• Foil is split in the vertical direction.

• Foil is split in the horizontal and
vertical direction.

2 Define the number and width of the
middle sections.

3 Define the gap between the sections.
4 Define the width of the first and last

section in the horizontal direction.
5 Define the height of the top and

bottom section in the vertical
direction.

6 Define which wall end is used for
distributing the insulation sections.
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Option Description
Point direction Define the direction of the points. The

options are horizontal or vertical.

This option affects the representation
of workshop drawings.

Insulation tab
Use the Insulation tab to control the vertical and/or horizontal splitting of the
insulation.

Dimensions

Option Description
1 Define whether the insulation is split:

• Insulation is not split.
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Option Description
• Insulation is split in the horizontal

direction.

• Insulation is split in the vertical
direction.

• Insulation is split in the horizontal
and vertical direction.

2 Define the number and width of the
middle sections.

3 Define the gap between the sections.
4 Define the width of the first and last

section in the horizontal direction.
5 Define the height of the top and

bottom section in the vertical
direction.

6 Define which wall end is used for
distributing the insulation sections.
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Option Description
Point direction Define the direction of the points. The

options are horizontal or vertical.

This option affects the representation
of workshop drawings.

Outside Shell tab
Use the Outside shell tab to control the vertical and/or horizontal splitting of
the outer shell. You can also define chamfers and add a brick wall surface.

Dimensions

Option Description
Define the direction for the splitting.

 Description
1 Define whether the outer shell is split:

• Outer shell is not split.
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 Description
• Outer shell is split in the

horizontal direction.

• Outer shell is split in the vertical
direction.

• Outer shell is split in the
horizontal and vertical direction.

2 Define the number and width of the
middle sections.

3 Define the gap between the sections.
4 Define the width of the first and last

section in the horizontal direction.
5 Define the height of the top and

bottom section in the vertical
direction.

Chamfering

Option Description
Vertical chamfers Define the vertical chamfers. Select a

chamfer shape from the list and
define the chamfer dimensions.
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Option Description
Horizontal chamfers Define the horizontal chamfers. Select

a chamfer shape from the list and
define the chamfer dimensions.

Chamfer side Define the sides where the chamfers
are created.

For example:

Brick wall properties

Set the Brick wall option to Enabled to create a brick wall.
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Option Description Example
Select the brick wall type
for the outer shell and
define the brick
dimensions, mortar
height and width.

Wall edges Define whether the wall
edges are created as
loose parts or whether
they are added into an
assembly.

 

UDA tab
Use the UDA tab to define user-defined attributes for the inner shell, foil,
insulation, and outer shell. You can define multiple UDAs for each part. UDAs
can be used as filters, and they can be displayed in drawings and reports.

Option Description
Shell Select the shell for the user-defined attribute (UDA) that you

are defining.

You can set more than one UDA for a certain shell, if needed.
UDA
name

Enter the name of the
user-defined attribute.

For example, to add a
comment UDA, open the
objects.inp file in a
text editor and search for 
comment. The following
attribute is shown:

attribute("comment",
"j_comment", string,
"%s", no, none,
"0.0", "0.0")
The first text between the
quotation marks is the
UDA name, comment. The
entered name is case
sensitive.

UDA name:

• comment

• fabricator

• art_number

• type

UDA:

• Comment

• Fabricator
name

• Article
number

• Type
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Option Description
Type Type of the user-defined

attribute.
Use String for text, Integer for
numbers, Float for numbers with
decimals and Option for
selecting an item in a list. You can
find the UDA type in the
objects.inp file

Value Enter the value that is saved to the user-defined attribute.

For example:
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Sandwich wall horizontal seam
Sandwich wall horizontal seam creates a horizontal seam between two
sandwich walls. Seam dimensions and rabbets can be defined for all layers:
inner shell, foil, insulation, and outer shell. In addition, you can define an extra
foil layer.
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Objects created

• Seams

• Rabbets

• Foil

• Insulation

• Extra foil layer

Use for

Situation Description
Seams between sandwich wall shells.

Seams with additional rabbets.

Before you start

To be able to select the needed parts, activate the Select objects in

components switch.

Selection order

1. Select the inner shell of the first sandwich wall.

2. Select the inner shell of the second sandwich wall.

The seam is created automatically when the secondary part is selected.

Concrete components 2961 Concrete detailing



Part identification key

 Part
1 Concrete part (wall, column, beam, slab)
2 Point

Multiple points can be picked.

Picture tab
Use the Picture tab to control the horizontal seam properties.

Seam position

Seams can be defined for inner shells, insulation and outer shells. Draft angles
can be defined for the outer shells.

Define the seam position between the sandwich wall shells. The middle line
between the walls is used as a reference when the seam position is calculated.

Example:
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Shell classes

Define the part classes to be applied to the seams. By default, the Sandwich
Wall Horizontal Seam component creates inner shells with class 1, foil with
class 2, insulation with class 3, and outer shells with class 4. Use these classes
to apply seams.

To prevent the creation of seams between foils, insulation shells and outer
shells, leave the Insulation classes box empty.

Rabbets in insulation

You can create rabbets in the insulation layer.

Option Description
No rabbet for the insulation layer.
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Option Description
One side rabbet for the top and
bottom of the insulation layer.

Rabbet depth and width can be
defined.

Mirrored one side rabbet for the top
and bottom of the insulation layer.

Rabbet depth and width can be
defined.

Two sided rabbets for the top and
bottom of the insulation layer.

Rabbet depth and width can be
defined.

Offset

You can define offset for the seam.
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Rabbets tab
Use the Rabbets tab to define rabbets in inner shells, insulation layers and
outer shells.

Rabbet side

Select to which side of the sandwich wall the rabbets are applied. You can
define the rabbets separately for both sides.

The options are:

• Top side

• Bottom side

• Both sides

Connection type

You can select a tongue or groove joint connection for both sides.

Option Option Description
Tongue joint connection,
based on the outer
geometry

Groove joint connection,
based on the center line

Tongue joint connection,
based on the center line
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Option Option Description
Groove joint connection,
based on the outer
geometry

If you create one tongue and one groove joint, it is possible to overlap the
parts. This is defined on the Picture tab with seam position values. Enter
negative values to move the parts closer together.

Extra Foils tab
Use the Extra foils tab to define an extra foil layer in the seam.

Foil

Option Description Default
t Define the extra foil

thickness.
1 mm

Pos_No Prefix and start number
for the part position
number.

The default part start
number is defined in the
Components settings in
File menu --> Settings --
> Options .

Material Material grade. The default material is
defined in the Part
material box in the
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Option Description Default
Components settings in
File menu --> Settings --
> Options .

Name Name for the extra foil. FOIL
Class Part class number for

the extra foil layer.
 

Comment Add a comment for the
extra foil layer.

 

Connection method

Option Description
No connection Select how the extra foil is attached to the sandwich

wall.

• No connection (foil is a loose part)

• Weld

• Cast unit

• As subassembly
At Inside shell Select the profile to which the extra foil is connected.

• At inside shell

• At outside shell
Position h*b Select a prefix for the foil layer.

• Position h*b and Position b*h create a profile
without a prefix.

• Position PLh*b and Position PLb*H create a
profile which start with PL prefix.

• Par. section h*b and Par. section b*h: enter a
prefix in the box below.

Auto Select the rotation of the foil layer.

• Auto

• Below

• Front

• Top

• Back
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Option Description
Foil shape Define shape of the extra foil.

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Sandwich wall vertical seam
Sandwich wall vertical seam creates a vertical seam between two sandwich
walls. Seam dimensions and rabbets can be defined for all layers: inner shell,
foil, insulation, and outer shell.

Objects created

• Seam

• Rabbets

• Foil
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• Insulation

Use for

Situation Description
Seams between sandwich wall shells.

Seams with additional rabbets.

Limitations

The component works only if the sandwich walls are parallel.

Before you start

To be able to select the needed parts, activate the Select objects in

components switch.

Selection order

1. Select the inner shell of the first sandwich wall.

2. Select the inner shell of the second sandwich wall.

The seam is created automatically when the secondary part is selected.

Part identification key
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 Part
1 Inner shell of the first sandwich wall
2 Inner shell of the second sandwich wall

Picture tab
Use the Picture tab to control the vertical seam properties.

Seam position

Seams can be defined for inner shells, insulation and outer shells. Draft angles
can be defined for the outer shells.

Define the seam position between the sandwich wall shells. The middle line
between the walls is used as a reference when the seam position is calculated.

Example:
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Shell classes

Define the part classes to be applied to the seams. By default, the Sandwich
Wall Vertical Seam component creates inner shells with class 1, foil with class
2, insulation with class 3 and outer shells with class 4. Use these classes to
apply seams.

For example, to prevent the creation of seams between foils, insulation shells
and outer shells, leave the Insulation classes box empty.

Asymmetrical seams

You can create asymmetrical seams and/or rabbets in the insulation layer.

Option Description
Symmetrical seams.

No rabbet for the insulation layer.

Symmetrical seams.

Rabbet depth can be defined for the
insulation layer.

Asymmetrical seams for the
insulation layer and outer shell.

No rabbet for the insulation layer.

Asymmetrical seams for the
insulation layer and outer shell.

Rabbet depth can be defined for the
insulation layer.
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Offset / Mirror

You can define offset for the seam.

Rabbets tab
Use the Rabbets tab to define rabbets in inner shells, insulation layers and
outer shells.

Rabbet side

Select to which side of the sandwich wall the rabbets are applied.

• Right side

Rabbets are equal on both sides, but the rabbet dimensions on the right
side are applied to both sides.

• Left side

Rabbets are equal on both sides, but the rabbet dimensions on the left side
are applied to both sides.
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• Both sides

Rabbet dimensions can be defined separately for both sides.

• Both sides mirrored

Rabbet dimensions can be defined separately for both sides, but sides are
mirrored.

Connection type

You can select a tongue or groove joint connection for both sides.
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Option Option Description
Tongue joint connection,
based on the outer
geometry

Groove joint connection,
based on the center line

Tongue joint connection,
based on the center line

Groove joint connection,
based on the outer
geometry

Rabbet position

Typically the vertical seams go from the top to the bottom of the sandwich
wall. Define the seam offsets for the top and bottom sides. Offsets are applied
only to the inner and outer shells.
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Sandwich wall window
Sandwich wall window creates a rectangular window opening in a sandwich
wall, or alternatively, a window and a door opening. The opening is created
through up to four parts (inner shell, foil, insulation, and outer shell). You can
select whether the foil is created. A frame can be created, as well as extra foils
and additional parts. The frame can be a wooden frame or a concrete border,
added to the inner shell.

Objects created

• Rectangular opening

• Wooden frame or concrete border

• Extra foils
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• Additional parts

Use for

Situation Description
Opening in a sandwich
wall, with a wooden
frame and foil layers.

Opening in a sandwich
wall, with a concrete
border in the inner
shell.
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Situation Description
Opening in a sandwich
wall, with a door
opening.

Selection order

1. Select the inner shell of the sandwich wall.

2. Pick the first position.

3. Pick the second position.

The second position point is needed to complete the input also if you
have selected an option for only one input point in the component dialog
box. In this case, the second point location does not matter.

The opening is created automatically when the second position is picked.

Part identification key

 Part
1 Sandwich wall element
2 First picked position
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 Part
3 Second picked position

Picture tab
Use the Picture tab to control the dimensions and parts of the opening.

Dimensions

Option Dimensions
Create Window

Create Window +
Door

Set the Door
location to Right
side or Left side.

The options on the
Door side detail tab
and Door bottom
detail tab are
available when you
set the Create
option to Window +
Door.

Option Description
1 Set the points for the opening:

• Bottom and top corner points

Pick two points to create the opening (points 2 and 3 in the
image).

• Bottom corner point, and width and height

Pick two points to create the opening. With this option, point 2
shown in the image is the reference point. Point 3 is only
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Option Description
needed to complete the input. Define the width and height of
the opening.

• Top corner point, and width and height

Pick two points to create the opening. With this option, point 3
shown in the image is the reference point. Define the width and
height of the opening.

• Bottom and top corner points, and height

Pick two points to create the opening (points 2 and 3 in the
image). Define the height of the opening.

2 Vertical offset from the insertion point.

When you create Window + Door, this is the vertical offset for the
window.

3 Horizontal offset from the insertion point.
4 Width of the opening.

When you create Window + Door, this is the width of the window.
5 Height of the window.
6 Width of the door.
7 Vertical offset for the door.

Select other layers

Option Description
Insulation, Wall Parts where the opening is created.

To create the opening to the insulation and the external
layer parts, enter the class numbers.

If you do not enter any numbers, the opening is only
created to the part you selected when applying the
component.

Parts not in
cast unit

Select Yes to create the opening to the parts that do not
belong to the cast unit.

Foil You can use Sandwich wall window both for sandwich
panels with a foil and for sandwich panels without a foil
(default). If you have a sandwich panel with a foil, select Yes
and enter the class number of the foil.

The frame shape options shown on the Bottom detail,
Left detail, Right detail, and Top detail tabs depend on
whether the foil is created or not.

Swap sides
when only one
layer

You can enable that the side of the window frame is
swapped when the input cast unit contains only one single
panel. The default value is No.
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Bottom detail tab / Left detail tab / Right detail tab
Use the Bottom detail tab, Left detail tab, and Right detail tab to control the
size, position and shape of the opening bottom, left side, and right side, and
the frame size and properties. On the Right detail tab, you can select that the
right detail is created the same as the left detail.

Frame

Part Description Default
Frame Define the frame profile

by selecting the profile
from the profile catalog.

50*50

Option Description
Pos_No Prefix and start number for the part position number.

You can enter the assembly position number on the
second row.

Material Material grade.
Name Name that is shown in drawings and reports.
Class Part class number.

Frame shape

The options for inner and outer frame are the same regardless of whether the
foil is created or not.

Inner Outer Description
Default

Cut or extension is not
created.

AutoDefaults can change
this option. Any of the
three options is used
depending on the frame
size.

Cut or extension is not
created.
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Inner Outer Description
Extension is created.

If the frame is narrower
than the insulation, the
concrete part is
extended to fill the gap.

Cut is created.

If the frame is wider
than the insulation, the
concrete part is cut so
that the frame fits.

Middle Description
This option is available when the Foil
option is set to Do not create on the
Picture tab.

Frame is created.

This option is available when the Foil
option is set to Do not create on the
Picture tab.

Frame is not created.
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Middle Description
This option is available when you
select Yes in the Foil option on the
Picture tab.

Frame is created.

This option is available when you
select Yes in the Foil option on the
Picture tab.

Frame is created.

This option is available when you
select Yes in the Foil option on the
Picture tab.

Frame is not created.

Additional recess

Define the vertical and horizontal dimensions for the additional recess. By
default, the recess is not created.

Frame corner cuts

Option Description
Frame corners are not cut.
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Option Description
Define the horizontal and vertical
dimensions of the frame corner cuts.

Create filler parts as insulation

Select whether filler parts are created as shells or as insulation.

Continuous slope

Select whether frame edges are sloped.

Option Description
By length

By angle

You can set the length or the angle for both sides separately.

The default is that frame edges are not sloped.

Top detail tab
Use the Top detail tab to control the size, position, number, and shape of the
opening top side.

Part

Part Description Default
Frame Define the frame profile

by selecting the profile
from the profile catalog.

50*50
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Part Description Default
Foil2 Foil2 is the additional

foil created only on the
top side.

Define the thickness.

Option Description
Pos_No Prefix and start number for the part position number.

You can enter the assembly position number on the
second row.

Material Material grade.
Name Name that is shown in drawings and reports.
Class Part class number.

Top frame shape

The options for inner and outer frame are the same regardless of whether the
foil is created or not.

Inner Outer Description
Default

Cut or extension is not
created.

AutoDefaults can change
this option. Any of the
three options is used
depending on the frame
size.
Cut or extension is not
created.
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Inner Outer Description
Extension is created.

If the frame is narrower
than the insulation, the
concrete part is
extended to fill the gap.

Cut is created.

If the frame is wider
than the insulation, the
concrete part is cut so
that the frame fits.

Middle Description
This option is available when the Foil
option is set to Do not create on the
Picture tab.

Frame is created.

This option is available when the Foil
option is set to Do not create on the
Picture tab.

Frame is not created.
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Middle Description
This option is available when you
select Yes in the Foil option on the
Picture tab.

Frame is created.

This option is available when you
select Yes in the Foil option on the
Picture tab.

Frame is not created.

Additional recess

Define the vertical and horizontal dimensions for the additional recess. By
default, the recess is not created.

Frame corner cuts

Option Description
Frame corners are not cut.

Horizontal and vertical dimensions of
the frame corner cuts.
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Drip mold

Option Description
Drip mold is not created.

Drip mold is created. Define the mold
dimensions.

Drip mold is created. Define the mold
dimensions.

The drip mold can be created to any
of the shape options. For example, if
the shape has a bevel, the drip mold
is created at the same angle as the
bevel.

Create filler parts as insulation

Select whether filler parts are created as shells or as insulation.

Continuous slope

Select whether frame edges are sloped.

Option Description
By length

By angle

You can set the length or the angle for both sides separately.

The default is that frame edges are not sloped.
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Extra foils tab
Use the Extra foils tab to control the creation of extra foils on the top, bottom,
right side, and left side of the opening.

Part

Part Description Default
Extra foil Thickness of the foil. 50*50

Option Description
Pos_No Prefix and start number for the part position number.

You can enter the assembly position number on the
second row.

Material Material grade.
Name Name that is shown in drawings and reports.
Class Part class number.

Extra foil dimensions

Description
1 Define whether extra foils are created.
2 Define the inside offset.
3 Define the foil width.

Shells to cut

Option Description
All shells are cut.
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Option Description
The inner shell is not cut.

The inner shell and the foil are not cut.

The inner shell and the foil are not cut. An insulation
extension is created.

Define the width and the material grade of the
insulation extension.
The outer shell is cut.

Additional parts tab
Use the Additional parts tab to control the size, position, number, and
alignment of additional parts.

Parts

Select whether additional parts, custom component parts, or no additional
parts are created.

Part Description Default
Parts Define the profile of the

additional parts by
selecting the profile
from the profile catalog.

D5

Custom component
parts

Define the custom
component parts by
selecting the component
from the Applications &
components catalog.

You can also use a
configuration file to
define the properties.

 

Option Description
Pos_No Prefix and start number for the part position number.

You can enter the assembly position number on the
second row.

Material Material grade.
Name Name that is shown in drawings and reports.
Class Part class number.
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Define distances

Select whether to define the distances between the parts by entering the
distance dimensions on this tab or by using an external text file. You can use
an external file to automate the creation of additional parts when window
sizes differ.

The name of the external file is
SandwichPanelWindowAdditionalParts.dat. The file is located in
the ..\Environments\Common\system folder.

The image below shows an example of a local standard for creating additional
parts. M is a module that is 100 mm.

The SandwichPanelWindowAdditionalParts.dat configuration file that
contains the needed specifications for the example above is as follows:

BOTTOM;
0;599;1;1
600;1200;1;2;145
1201;1800;1;3;145
TOP;
1201;1800;1;1
LEFT;
0;599;1;1
600;1200;1;2;145
1201;2100;1;3;145
RIGHT;
0;599;1;1
600;1200;1;2;145
1201;2100;1;3;145

The keywords BOTTOM, TOP, LEFT and RIGHT define the side of the window the
settings are applied to.

The syntax in the file is as follows: bmin;bmax;cm;nd;dmax;d1;d2;d3.

bmin Smallest window dimension to apply the setting.
bmax Biggest window dimension to apply the setting.
cm Creation method:

• 1 means use the number of parts for nd.
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• 2 means use maximum spacing for nd.
nd Depending on the creation method (cm):

• Number of parts, when cm is 1.

• Maximum allowed distance between parts, when cm is 2.
d1 Distance from the start point to the first additional part (optional).
d2 Distance from the first additional part to the second (optional).
d3 Distance from the second additional part to the third (optional).

The additional parts are placed symmetrically, so distances d1, d2 and d3 are
also used from the end point. If the optional distances d1, d2 and d3 are not
defined, the parts are placed at equal distances.

In the image above 0;599;1;1 means that when the window width is equal or
bigger than 0, but equal or less than 599, the creation method is by number of
parts and 1 part should be created.

600;1200;2;300;145 would mean that when the window width is equal or
bigger than 600, but equal or less than 1200, the creation method is use
maximum spacing. The maximum allowed spacing between additional parts is
300 mm. The first part (and last part) distance is 145 mm. If the window width
is 1200, three more parts are needed (1200 - 2x145)/300=3.03. The spacing
between the additional parts will then be (1200 - 2x145)/4 = 227.5 mm.

Placement

Select whether additional part placement is the same or different on each
side.

Option Description
Placement dimensions for the
bottom, left side, and right side.

If additional part placement is the
same on each side, define the bottom
dimensions only.

Placement dimensions for the top
side.

Door edge options

The options for controlling door edges are available when you set the Create
option to Window + Door on the Picture tab, and the Placement option to
Different each side on the Additional parts tab.
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Option Description
Create on door side No, Same as window side, Same as door side
Create in bottom
detail

No, Same as bottom

Connections tab
Use the Connections tab to control how the wooden frame, additional parts,
extra foil, and extensions are connected to the shells.

Add

Option Description
Wooden frame to, Additional parts,
Extra foil to

Select to which part the wooden
frame, additional parts, and extra foil
are connected.

You can create the frame as an
assembly. To add window and door
frames to a shell as one subassembly,
select Subassembly for Wooden
frame to.

The Extra foil to option is shown if
you have selected to create the foil on
the Picture tab.

Connect extensions to their shells

Option Description
Inside shell extension, Outside
shell extension, Insulation shell
extension, Foil extension

Select how the extension parts are
connected to their main parts.

The Foil extension option is shown if
you have selected to create the foil on
the Picture tab.

Edge connection

Define the corner connection type for wooden frames.

Option Description
Cut both frames in a 45-degree angle.

Extend horizontal frames.
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Option Description
Extend vertical frames.

Door side detail tab / Door bottom detail tab
Use the Door side detail tab and Door bottom detail tab to control the size,
position, and shape of the door side and bottom, and the frame size and
properties.

Create door

The options on the Door side detail tab and Door bottom detail tab are
available when you set the Create option to Window + Door on the Picture
tab.

Same as options

• Same as on the Door side detail tab:

Select the door short side detail.

• None

• Same as window side follows the side setting of the window side.

• Same as door side follows the door side setting.

The door long side detail follows the setting of the corresponding window
side.

• Same as bottom on the Door bottom detail tab:

Yes follows the setting of the bottom window.

Frame

Part Description Default
Frame Define the frame profile

by selecting the profile
from the profile catalog.

50*50

Option Description
Pos_No Prefix and start number for the part position number.

You can enter the assembly position number on the
second row.

Material Material grade.
Name Name that is shown in drawings and reports.
Class Part class number.
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Frame shape

The options for inner and outer frame are the same regardless of whether the
foil is created or not.

Inner Outer Description
Default

Cut or extension is not
created.

AutoDefaults can change
this option. Any of the
three options is used
depending on the frame
size.

Cut or extension is not
created.

Extension is created.

If the frame is narrower
than the insulation, the
concrete part is
extended to fill the gap.

Cut is created.

If the frame is wider
than the insulation, the
concrete part is cut so
that the frame fits.
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Middle Description
This option is available when the Foil
option is set to Do not create on the
Picture tab.

Frame is created.

This option is available when the Foil
option is set to Do not create on the
Picture tab.

Frame is not created.

This option is available when you
select Yes in the Foil option on the
Picture tab.

Frame is created.

This option is available when you
select Yes in the Foil option on the
Picture tab.

Frame is created.

This option is available when you
select Yes in the Foil option on the
Picture tab.

Frame is not created.
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Additional recess

Define the vertical and horizontal dimensions for the additional recess. By
default, the recess is not created.

Frame corner cuts

Option Description
Frame corners are not cut.

Define the horizontal and vertical
dimensions of the frame corner cuts.

Door side frame extension

Option Description
Frame on the door side is created only to the
bottom level of the window.

Frame on the door side is extended to the top level
of the window.

Enter the extension distance in the box.

Create filler parts as insulation

Select whether filler parts are created as shells or as insulation.

Continuous slope

Select whether frame edges are sloped.
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Option Description
By length

By angle

You can set the length or the angle for both sides separately.

The default is that frame edges are not sloped.

Wall layout tools
Wall Layout tools is a set of components that you can use for creating and
modifying all common types of concrete walls, such as solid precast panels
from single layers to double walls and sandwich walls, and different wall
structures that are cast on the site. The wall structure may contain several
layers, for example, structural layers, insulation, void, and surface treatments.
You can use direct modification to flexibly change the wall geometry, layer
offsets, openings, and seam lines.

Wall layout is the main component in the set and it is used for defining the
wall layout. Wall layout is available on the Concrete tab, click Panel --> Wall
layout, and in the Applications & components catalog.

The other Wall Layout tools are available in the Applications & components
catalog:

• Wall layout connector connects the walls to each other.

• Wall layout T connector connects walls to each other with T connections.
Wall layout T connector can also create a seam at the connection
location.

• Wall layout opening sets the default values for openings. Use direct
modification to create and modify openings.

• Wall layout seam divides the wall segment into two or more cast units by
adding seams. Use direct modification to create seams.

• Wall layout elementation divides the wall into elements according to
length, height, number, weight, or crane lifting capacity.

• Wall layout layer swapper is intended for swapping the casting order of
layers in a double wall. Only certain properties of the two layers are
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swapped, such as name, class, numbering settings, and all UDAs. The
geometry of the layers is not swapped. If one layer is created using the
layer creation option Add as sub-assembly (shell 2), and the other layer is
defined as Add to cast unit (shell 1), these properties are also swapped.

Convert a wall panel to wall layout

You can use the Convert to layout component tool to convert wall panels to
Wall layout components, see Convert to layout component (page 3029) for
instructions.

Wall layout
Wall layout creates a single wall or multiple straight wall segments. The wall
can be a single-layer solid wall, a double wall, or a sandwich wall that has any
number of layers.

Design workflow with Wall layout tools

1. You can build a shape.

2. You can build a shape and create openings.

3. You can create wall type definitions.

4. You can create wall elementation and define detailed wall geometry.

5. You can define detailed connections, openings, embeds, and
reinforcement.

Selection order

1. Ensure that the Direct modification  switch is active.

2. On the Concrete tab, click Panel --> Wall layout.

3. Select the appropriate command on the contextual toolbar:

• To create one or more straight wall segments, click , and then pick
two or more points.

Note that you can finish the creation to the first picked point to create
a closed wall structure.
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• To create the wall layout as a closed wall, click , and then pick two
or more points.

Wall layout will automatically connect the first and the last point that
you have picked.

4. Click the middle mouse button to create the wall.

Depending on how many points you pick and how you pick the points, one or
more straight wall segments or a closed wall is created in the model. Each
created straight segment is a separate instance of the Wall layout component
that you can modify separately. When you create two or more wall segments,
an instance of the Wall layout connector component is added between each
wall segment.

In the image below, there are four wall segments in an open shape between
the picked points, 1 - 5, and three wall layout connectors at points 2, 3 and 4. If
you had created a closed wall, there would be a fifth wall segment between
points 5 and 1.
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The modeling direction of the wall layout determines which face of the wall
layout is shown in the front view of a cast unit drawing when the cast unit
drawing coordinate system is set to Fixed.

In the image below, the top-in-form face is not set by Wall layout. The image
shows an example of sandwich wall settings that you should use when the
outside shell is cast against the pallet, and the inside shell is the uppermost
shell in the casting.

Alternatively, you can set the top-in-form face with Wall layout. Set
Walllayout.Udas.dat to have the top-in-form face property by adding the
following row:

option FixedMainView j_FixedDrawingMainView
The Walllayout.Udas.dat file can be located in the model folder or any of
the system folders.

General tab

Use the General tab to define the basic properties for the whole Wall layout
component. The properties on all other tabs are layer-specific, and apply to
the layer that you have currently selected in the layer list.
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Option Description
H, Z1, Z0 You have four options for defining the height and the

global Z coordinates:

• Define the wall bottom level according to the creation
points, and the Position in depth option and value.
Define the height with the H option.

• Define the wall bottom level with the Z0 option (global
Z coordinate), and the height with the H option.

• Define the wall top level with the Z1 option (global Z
coordinate), and the height with the H option.

• Define the wall bottom level with the Z0 option (global
Z coordinate), and the wall top level with the Z1 option
(global Z coordinate).

You can use the H option to modify the height of
rectangular walls. If you change the wall shape so that it is
not rectangular, you cannot define height with this
option. Use direct modification instead.

Total thickness Enter the total thickness of the wall layout. Layer
thickness is calculated based on the total thickness.

Use the total thickness for double walls where the
thickness of the void layer or the CIP layer is often
flexible. This means that Wall layout can adjust the
thickness so that the total thickness is as defined.

• If there are no flexible layers in the wall layout, you
can leave the total thickness option empty. Total
thickness is not used if there are no flexible layers.

• If there is more than one flexible layer, the thickness is
divided equally between those layers.

Cast unit name Enter a name for the cast unit.
Prefix Enter a prefix for the cast unit.
Start number Enter a start number for the cast unit.
Main part layer Select which layer part is set as the main part of the cast

unit. The Default option sets the structural part with the
greatest volume as the main part.

Position in plane Define the wall layout location in relation to the line
between the input points.

Enter the offset distance, if needed.
Position in depth Define the wall layout vertical location in relation to the

line between the input points.

Enter the offset distance, if needed.

Concrete components 3001 Concrete detailing



Layer tab

Use the Layer tab to define the properties of a single layer. Select the layer in
the layer list, or in the preview image.

Layer list

Layers Description Example
The layer list shows the
layers of the wall.

Use the buttons to control
the number and the order
of the layers:

•

Click  to add a new
layer.

•

Click  to remove
the selected layer.

•

Click  to
change the order of the
layers by moving the
selected layer up or
down in the list.

Use the check box in front
of the layer name to control
whether the properties of
the selected layer are
modified.

Use the leftmost check box
to control whether the
number of layers and the
order of the layers are
modified when you modify
the Wall layout
component.

The example image
below shows a preview
of the wall layers. The
image is automatically
updated when you
change the layer type.
The selected layer is
highlighted with a
magenta frame.

Layer properties
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Option Description
Layer name Enter a name for the layer. This name is shown in the

layer list.

Layer names are also shown on the contextual toolbar
when you modify wall boundary offsets. You can select
which layer to modify.

Layer names are not visible in reports or drawings.
Layer type • Structure: Typically used for solid walls, double

walls, and the concrete layers of sandwich walls. Use
this type if you want to create a cast-in-place layer
between double wall layers instead of a void.

• Insulation: Insulation layer in a sandwich wall.
Insulation gets a different density in Wall layout
elementation (100 kg/m³).

• Void: Void between double wall layers. Use this type
if you do not want to create any parts for the layer.

• Foil: Typically a very thin layer which is not detailed
in the corners.

• Surface: Surface treatment on top of a structural
layer. Typically, a surface layer is the first and/or the
last layer.

• Component: Layer is not created as a part. Instead,
an instance of the component selected in the Layer
component option is added.

Layer
elementation

Select whether the layer is split into two pieces using
seams.

Layer creation Select how the layer is created to the precast cast unit:

• Add to cast unit: All layer parts are added to a
single main cast unit.

• Add as sub-assembly: The layer part is added as a
sub-assembly to the main cast unit.

• Do not add to cast unit: The layer part is not added
to the main cast unit. It will be its own assembly or
cast unit. This option changes the concrete type
from precast to cast in place.

Layer component Select a component when you have set the layer type to
Component. Instead of creating the layer as a part, an
instance of the component is created.

You can control some of the component properties
from Wall layout properties.

Define the property names in the component
accordingly:
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Option Description
• P_Height - Layer height (maximum height of the

layer part)

• P_Thickness - Layer thickness

• P_Name - Layer part name

• P_Class - Layer part class

• P_Material - Layer material

• P_Prefix - Layer part prefix

• P_StartNo - Layer part start number

The creation points of the component are in the same
locations as when creating the layer as a part.

If the custom part or component property names are
not the same as the default names, you can define the
parameters in the xxxxx.LayerComponentInfo.xml
file where xxxx is the component name.

In this file you can also specify the mapping for other
layer properties so that the values given in the attribute
file will be overridden with the layer properties defined
in the Wall layout dialog box. For an example of the
file, see the Customize the wall layout section.

Attribute settings Select an attribute file for the layer component.

If you need specific component properties for the layer
component, you can define the properties in the
component dialog box and save them as an attribute
file.

Layer thickness Enter the layer thickness.

You can leave the layer thickness empty to let Wall
layout set the layer thickness so that the total
thickness is correct as defined on the General tab. The
void layer or the CIP layer in a double wall can often
have a flexible thickness.

Part name, Class,
Material, Pour

Define the name, class, material, part prefix and start
number of the layer part. Define the pour phase for CIP
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Option Description
phase, Surface
treatment, Prefix,
Start number

layers. Select the surface treatment when you have set
the layer type to Surface.

Vertical offset tab

Use the Vertical offset tab to define the vertical offsets of each layer at the
top and bottom horizontal edges of the wall layout.

Note that you can define the offsets at any other edge by using direct
modification and seams.

Option Description
Offset Define the vertical offset at each layer.
Component name Select a component for detailing the offsets.

For example, you can use the Geometry detailing
strip component to create thickenings for sandwich
walls. You can create different settings for Geometry
detailing strip and select the appropriate settings for
each situation.

Component
attributes

Select the appropriate component settings.

You can also add detailing to an edge of a wall layout. Select the wall layout
and activate the editing by selecting Modify wall boundary offsets on the
contextual toolbar. Select the wall layout edge to which you want to add the
component. Select the detailing component and the settings that you want to

use, and click  to confirm.
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Properties tab

Use the Properties tab to define the IFC4 export entities and concrete cover
thickness for rebar sets. You can define these properties for each layer
separately.

Option Description
IFC export You can define IFC4 entities for parts

and cast units. The cast unit values
are used for main part layers, cast-in-
place layers, and sub-assembly layers.
The values for each layer are taken
from the main part of the cast unit to
which the layer belongs.

Select an IFC entity and a Subtype
(IFC4). If you select USERDEFINED as
the IFC4 subtype, you can define the
User-defined type (IFC4).

Concrete covers for rebar sets You can define the concrete cover
thickness on the part level.

Select whether to use the global or
local coordinate system, and define
the coordinates according to your
selection.

UDA tab

Use the UDA tab to define the user-defined attributes of each layer part in the
wall layout.

Note that the content of the UDA tab may vary depending on your Tekla
Structures environment. You can customize the content of the UDA tab.

Modify the wall layout

Modify the geometry of the wall layout

You can use direct modification to modify the wall layout. Before you start,

ensure that the Direct modification  switch is active. Select the wall
layout to display the contextual toolbar. To modify the wall layout, select the
appropriate command from the toolbar.
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You can modify the outer edges of the wall layout by dragging the edges and
corner handles. You can also insert vertices by dragging the edge midpoint
handles, and delete vertices by selecting a corner handle or edge, and pressing
the Delete key.

In addition to the standard polygon modification, you can drag the special line
handles at the ends of the wall layout to make the wall layout shorter or
longer. You can also drag the line handle perpendicular to the wall layout by
holding down the Alt key while dragging.

As an alternative to dragging the line handle, you can drag the dimension
arrowhead. If you know how much you want to shorten or lengthen the wall
layout, select the dimension arrowhead and enter the value by which you want
the dimension to change. Note that you can use the dimension arrowheads
and line handles in a plan view whereas polygon modification is possible only
in 3D or section views.
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Modify the offset at layer edges

Use the Modify wall boundary offsets command on the contextual toolbar to
modify the offsets of the layers at the outer edges of the wall layout, or at the
edges of the openings or seams. Select the layer that you are going to modify
from the list on the toolbar.

You have three options for modifying the offset at a particular edge:

• Drag the line handle at the edge. You can only drag the line handle
perpendicular to the edge.

• Drag the dimension arrowhead and enter the measurement value.

• Select the line handle and enter a new offset value.

You can select two or more line handles by holding down the Shift key
when selecting the handles.

You can modify the top and bottom offsets at the outer edges in the Wall
layout dialog box, and the seam offsets in the Wall layout seam dialog box.
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You can define that a certain layer is not cut with the opening. First select the
opening. On the contextual toolbar, select the layer and then Do not create.
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Wall layout opening
Use direct modification to add openings to wall layouts. Before you start,

ensure that the Direct modification  switch is active.

To add an opening, select the wall layout and then select the appropriate
direct modification command. You can create rectangular, polygonal and
circular openings.

NOTE You can use the Wall layout opening tool from the Applications &
components catalog to define the settings applied to the openings.
You can define the opening dimensions and select to apply detailing
by using an opening component.

Add an opening to a wall layout

Option Description
Add an opening by picking the opening length in
the wall. There are five different dimension
options to define the opening bottom and top
level. To cycle through the options, click the
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Option Description

opening dimension button  until it shows
the wanted option.

The five options are:

• Enter the distance between the bottom of
the wall and the bottom of the opening,
800.00 in this example, and the height of
the opening, 2400.00. If Position in depth
values are used, the bottom distance is
measured from the creation points.

• Enter the distance between the bottom of
the wall and the bottom of the opening, and
the distance between the bottom of the wall
and the top of the opening. If Position in
depth values are used, the bottom distance
is measured from the creation points.

• Enter the global Z coordinate of the opening
bottom level, and the height of the opening.

• Enter the height of the opening, and the
global Z coordinate of the opening top level.

• Enter the global Z coordinate of the opening
bottom level, and the global Z coordinate of
the opening top level.

You can use an architectural drawing as a
reference model where you can pick the
opening width and the location.

You can select the layer to be cut on the
contextual toolbar. This makes it easier to
model different layer geometries to walls with
multiple layers. The default option All layers
creates the opening to all layers. To change the
opening creation for a layer, click the Modify
wall boundary offsets command. Select the
layer and either Create or Do not create.

Concrete components 3011 Concrete detailing



Option Description
Add a rectangular opening by picking two
points.

Add a polygonal opening by picking three or
more points.

Add a circular opening by picking the center
point and the radius point for the opening.

When you change the layer and edge specific
offsets, you can set a single offset for the
circular opening. Circular openings enable fast
creation of HVAC reservations.

Modify an opening in a wall layout

Modify the geometry of an opening
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You can modify an opening in the same way as the outer edges of the wall
layout by using the appropriate direct modification command. You can:

• Drag the edges.

• Drag the corner handles.

• Insert vertices by dragging the edge midpoint handles.

• Delete vertices by selecting the corner handle or edge, and pressing the
Delete key.

In addition, you can modify the start or the end of the opening by dragging the
line handles, or by using the dimension arrowheads.

Move and copy an opening
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1. Select an opening by selecting a face inside the opening.

2. Start dragging the selected face.

3. To create a copy of the opening, hold down the Ctrl key.

To move an opening without changing the shape of the opening, drag the
face handle to the desired location.

Delete an opening

Select a face inside the opening and press the Delete key.

Modify the opening detailing
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You can create an opening with or without details. To detail an opening, select
the window and select the predefined detailing component from the list. Note
that you can use the Sandwich wall window component for rectangular
openings, and for openings that connect a window and a door with the same
top edge line.

To define new detailing components to the list, select the opening and double-
click to open the Wall layout opening dialog box or click the button with the
three dots in the contextual toolbar.

1. In Apply detailing, select Yes.

2. In Component name, do one of the following:

• Select a component from the list. Click Edit if you want to modify some
of the opening properties.

If you edit the properties and give a new name to a component, the
edited component is added to the Component name list.

• If you want to use a component that is not in the list, click New to
select a component from the Applications & components catalog and
define the opening component properties. You can use a custom
component that you have created, for example.

In the Opening component info dialog box, define the following:

  
Component name Select the sub-component for the

opening detailing.
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Height property name Name of the property that defines the

height in the component (for custom
components, P1, for example).

Width property name Name of the property that defines the
width in the component (for custom
components, P2, for example).

Depth property name Name of the property that defines the
depth in the component (for custom
components, P3, for example).

Note that all of the dimensions may not be needed in the property name.

If you use a custom seam type custom component, we recommend that you
have two input points to define the width of the opening. When you bind the
opening details to the component input points in the custom component
editor, you do not need to define the Width property name.

In the example image below, the bottom corner points are mapped to the
opening corners, setting the values 1 3 to map the location.

Is cutting input parts Controls the input parts of the seam.

• No: The detailing component does
not create the cut, instead, Wall
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layout will create a rectangular
opening cut.

• Yes: Wall layout does not create a
rectangular opening cut.

Cut other parts Use for other layer parts (if any) which
are not input parts for the seam
component. This property is used
when the wall has more than one
layer.

• Yes: Wall layout creates the cut.

• No: Wall layout does not create a
separate cut for other than input
parts (if any).

Input parts Input parts expected by the sub-
component.

If the sub-component is built to create
details for a sandwich wall, for
example, and it expects three parts as
input, type 1 2 3. Those are the
layers and order defined for the wall
type in Wall layout.

Input points If the sub-component has two input
points for defining the size of the
opening, those points are mapped
here to the opening corners.

See the example image above for how
to map the bottom corner points.

On plane

Rotation

In depth

On plane, rotation and depth
properties only apply to components
that have position parameters
(custom part).

You can also add filler parts to the openings on the Filler parts tab. Select a
layer in the example image in the dialog box. Then select whether the layer is
cut and a filler part created to the layer. Select the appropriate filler part
attributes. Note that the filler parts use contour plate properties in Filler part
attributes.

You can also activate detailing on the contextual toolbar by selecting the
detailing component that you want to use.

Wall layout seam
When you create a wall layout, it is at first a single precast wall. Wall layout
seam divides the wall layout into two or more precast wall pieces. In the wall
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layout, the wall layout layers that have the Layer elementation option set to
Yes in the Wall layout dialog box are divided.

Add and modify wall layout seams

Use the Modify seams  command on the contextual toolbar to add and
modify seams. Modify seams opens the Wall layout seam dialog box where
you can define the seam properties for each wall layer separately.

Select the layer in the preview image and define the properties.

Option Description
1. Define the gap dimension at the

seam.

2. Define the gap offset from the
seam input position.

Create a connection component Select Yes to create a connection
between the two layer parts at the
seam.

When you select Yes, you can define
the other component options.

Component name Select a connection component from
the Applications & components
catalog.

Component attributes Select the attribute file for the
connection.

Component primary input Select which wall piece is the first
input part for the connection, seam,
or other components created at the
seam.
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Option Description
Add a vertical seam

Use the New seam  command
to add a vertical seam. Pick a
point to create the seam.

Note that New seam is selected
automatically when you use the
Modify seams command and the
wall layout does not have any
seams yet.

Add a polyseam
Use the New polyseam 
command to add a polyseam. Pick
two or more points to create the
seam.

Polyseams can contain vertical,
horizontal, and sloping segments.
Extend the start and the end of
the polyseam to make it clearly
cross the edges of the wall it is
dividing.

Move a seam Move a vertical seam by dragging
the seam.

You can also move vertical seams
by dragging the horizontal line
handle or the dimension
arrowhead.

Move and modify a polyseam like
any other polygonal object.

Copy a seam Copy a vertical seam or a
polyseam by holding down the
Ctrl key and dragging the seam.

Delete a seam Delete a vertical seam by selecting
the seam handle and pressing the
Delete key.

Delete a polyseam by deleting all
segments of the polyseam.
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Option Description
Modify the seam properties 1. Select a vertical seam or a

segment of a polyseam.
When you select the first
seam, the current properties
of the seam are loaded into
the Wall layout seam dialog
box.

2. Select two or more seams.
Hold down the Shift key and
then select the vertical seams,
or the segments of a
polyseam.

3. When you have selected the
seams, modify the properties
in the dialog box and click
Modify.

Split the wall layout at selected seam Use the Split the wall layout at

selected seam command  to
split the wall layout into separate
components.

Wall layout connector
Use Wall layout connector to apply a connection between two wall layouts.
Wall layout connector fits the layer parts at the corners. You can control the
corner gaps by extending or shortening the layers of the walls, and by adding
connections between the connected layer parts. Wall layout connector can
also add connections between the layer parts when you are using a
connection component at the corners.

Note that if you have created several wall layouts at one go using the Wall
layout tool, wall layout connectors are automatically added between the wall
layouts. Wall layout connector is updated automatically when you change the
wall type.

If you create a wall layout and later add another next to it, you can add a
connection between them using the Wall layout connector component in the
Applications & components catalog. Select the two wall layouts to create the
connection. Ensure that you select the wall layout component instance, not a
single object created by the wall layout. The connector is created when you
select the second wall layout.
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Wall layout connector properties

Option Description
Define how the layer parts are fitted.

Click the button three times to cycle through the
three different corner set-up options.

Define whether the panel ends are square or
sloped.

You can use this option to set a typical corner
detail for double walls.

This option is also applied in a connection
component used between the layer parts.
Define how the parts forming the turning corner
are modeled.

You can select this option separately at each
layer.

When you select this option, Wall layout
connector creates an additional part that is
added to the cast unit.

The turning corner part is created with the first
name given in the system file
SandwichWallCornerPartNames.dat. If the
file does not exist or if it is empty, the main part
name is used. This way the turning corner area
gets automatically calculated into the custom
quantity CUSTOM.WALL_CORNER_AREA.

Click the button three times to cycle through the
three different corner set-up options.

Free space A Define the gap between the two layer parts.

The preview image shows where the gap is
located. The gap location depends on the corner
set-up.

TIP If you are using a connection component,
use property name FreeSpace in the
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Option Description

custom connection to control that value
from Wall layout connector directly.

End offset B Define the end offset of the longer part.

The preview image shows where the offset is
located. The offset depends on the corner set-up.

TIP If you are using a connection component,
use property name EndOffset in the
custom connection to control that value
from Wall layout connector directly.

Connection Select a connection component that is created
between the two layer parts.

If you do not select a connection, only fittings are
added according to the gap and the end offsets.
If you want to view the current connector
properties, select the wall layout connector or
double-click the fitting created by the connector.

Attributes If you have added a connection, select an
attribute file for it.

Connection main part If you have added a connection, set the
connection main part.

Wall layout T connector
Use Wall layout T connector to apply a T connection between two wall
layouts. Wall layout T connector can create a seam at the connection
location. Note that if you remove the connection, the seam is not automatically
removed. Modify the main part to remove the seam.

Wall layout T connector properties

Option Description
Define how the wall layout parts are fitted.

Click the button three times to cycle through the
three different corner set-up options.

Select the wall layout in the preview image and
define the connection properties.
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Option Description
Define whether the panel ends are square or
sloped.

This option is applied in a connection component
used between the wall layout parts.

Add seam Select whether to add a seam. You can also select
to only split the first layer into two parts.

No does not split the first layer part but creates a
cut that breaks the part into two solid objects.

Seam offset Enter the seam offset.
Free space Define the gap between the wall layouts.

The preview image shows where the gap is
located. The gap location depends on the corner
set-up.

Create component Select whether to use a component to connect
the wall layouts.

Component name Select a connection component that is created
between the wall layouts.

Component attributes If you have added a connection, select an
attribute file for it.

Component primary
input

If you have added a connection, set the
connection main part.

Wall layout elementation
Wall layout elementation automatically adds new seams to divide the wall
layout into two or more precast wall pieces.

Openings are taken into account when adding the seams. Openings may affect
the final seam position so that the final length or weight of the precast wall is
less than the target value.

NOTE Weight calculations are based on the wall layout geometry. Any other
additional parts in the walls are not taken into account in the
calculation. The density in weight calculation is 2500 kg/m³ for the
structural layer type and 100 kg/m³ for the insulation layer.

Option Description
Create seams • By length: Enter one or more desired lengths. If it

is not possible divide the wall using the first
length, Wall layout elementation tries to use
the next length you have entered, and so on.
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Option Description
• By number: Enter the number of walls you want

to create.

• By weight: Enter the desired weight of a wall
piece. The wall layout is divided so that the weight
of the precast walls is as close to the desired
weight as possible.

• By crane lifting weight: Divides the wall layout
so that the weight of the precast walls is as close
to the maximum lifting capacity as possible.

Max height Enter the maximum height of a wall piece.

If the value you enter is smaller than the height of
the wall, Wall layout elementation will first create
the horizontal seams with the given height and
settings. After that it creates the vertical seams using
the vertical seam settings and all other settings in the
dialog box.

Min length Enter the minimum length of a wall piece.
Max length Enter the maximum length of a wall piece.

This value is used with all creation methods.
Max weight Enter the maximum weight of a wall piece.

This value is used with all creation methods.
Max crane lifting
weight

Select the crane used for erection.

When the crane is selected, the maximum weight of
the walls is always less than the lifting capacity of the
crane.

To define a crane set-up, open the Crane properties
dialog box by clicking the  button on the right:

1. Pick the crane location in the model, or enter the
X and Y values.

2. Enter the crane lifting capacity data in the table.
Enter the distance in the from-near-to-far order.

3. Save the crane set-up.

You can use the crane name when saving the
set-up.

To modify and review the existing crane set-up, select
the crane set-up from the list in the Crane
properties dialog box. Click Preview to see the
crane location on the lifting graph visualized in the
model view.
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Option Description

Avoid openings Select whether the seams may cross the opening.

If the seams may not cross the opening, enter the
minimum distance from the opening.

Distribution
direction

Select the direction of the seams, and the start end
at the wall layout.

You can add both vertical and horizontal seams.

Vertical seam
settings

Horizontal seam
settings

Select the seam attributes used for new seams.

Ensure that the layer offsets are set properly as they
may affect the weight and length of the wall.

Create to selected
walls

Select the wall layout and click the Create to
selected walls button to insert the seams. You can
select one or multiple wall layouts.

Wall layout layer swapper
Use Wall layout layer swapper to swap the structural precast layers of one
single wall in a wall layout, typically a double wall. You can swap the order of
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some individual walls in the same wall line if they need to be cast in a different
order.

To swap layers, select Wall layout layer swapper in the Applications &
components catalog, then select a wall layout and the wall part that you want
to swap.

When you use the swapper tool, a triangular handle  is shown at each
location of the tool . You can drag these handles to modify the wall to be
swapped. To swap another wall in the layout, you can copy the swapper to
another location by holding down the Ctrl key while dragging.

You can delete the swapper instances by selecting the swapper handles and
pressing the Delete key.

Customize the wall layout

UDA tab content

You can customize the content of the UDA tab by using the
WallLayout.Udas.dat file. The WallLayout.Udas.dat file can be located
in any of the folders set in the XS_FIRM, XS_PROJECT or XS_SYSTEM advanced
options, or in the model folder.

You can use the file to control which user-defined properties of the created
layer parts can be used in the wall layout. We recommend that you only use
UDAs that are typically common for all precast walls in one wall layout.

You can add the tab, label, and endlabel data types in the file to organize
the content of the UDA tab according to specific workflows.

You can define that layer UDA values are not swapped when the Wall layout
layer swapper tool is used. Add NoSwap at the end of the line (fourth field): 
string comment j_comment NoSwap.

The sample file shown below contains a full description of all the settings and
the format of the file. The lines starting with '//' are comment lines.

// Customized user defined attributes (UDA) for layer parts created by 
wall layout component
//
// Each row shall contain 2 or 3 fields separated by tab(s) or semicolon.
// Please note that all uda names shall be unique
//
// Field 1: The data type of the attribute. Valid values are 'distance', 
'float', 'option', 'integer', 'string', 'tab'*, and 'label'*
//          'integer' and 'string' compatible with the actual user 
defined attributes as
//          specified in objects.inp
// Field 2: UDA name. This is the name of the user defined attribute set 
for the layer part.
// Field 3: Label. This text is shown in the attributes dialog. It can be 
a translatable label (albl_) or any text. 
//        leaving this field empty will use the orignal translation 
strings.
// Field 4: 'NoSwap' if you do not want the 'Wall layout layer swapper' 
to swap the values.
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//
// *Attribute 'tab' will place all the UDAs below to a new tab. In field 
2 the name of the tab can be set.
// *Attribute 'label' will create a valueless label and will indent the 
UDAs below. In field 2 the name of the label can be set. 
//             Optional: to close the label use 'endlabel' to return to 
unindented UDAS.              
string        comment            j_comment
string        USER_FIELD_1        
string        USER_FIELD_2
string        USER_FIELD_3        
string        USER_FIELD_4
label        Ifc
string        IFC_BUILDING        j_IFC_building
string        IFC_BUILDING_STOREY    j_IFC_building_storey
endlabel
option        FixedMainView        j_FixedDrawingMainView
// new tab
tab        Exports
label        Eliplan
option        EP_TYPE            j_Product_type
string        EP_CODE            j_Product_code
label        Unitechnik
option        UT_product_type        j_UT_product_type
integer        UT_UD_product_type    j_user_defined_product_type

The images below show how the settings defined in the example file are
created in the Wall layout dialog box.
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Layer component

If the custom part or component property names are not the same as the
default names, you can define the parameters in the
xxxxx.LayerComponentInfo.xml file where xxxx is the component name.

In this file you can also specify the mapping for other layer properties so that
the values given in the attribute file will be overridden with the layer
properties defined in the Wall layout dialog box.

An example of the file is shown below.

<?xml version="1.0" encoding="utf-8"?>
<LayerComponentInfo xmlns:xsd="http://www.w3.org/2001/XMLSchema" 
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
  <ComponentName>CMUWall</ComponentName>
  <!--Leave the property name empty if you don't want anything to be set 
by Wall layout -->
  <HeightMaxProperty>WallHeight</HeightMaxProperty>
  <Height1Property></Height1Property>
  <Height2Property></Height2Property>
  <ThicknessProperty></ThicknessProperty>
  <NameProperty>Name</NameProperty>
  <ClassProperty></ClassProperty>
  <MaterialProperty>Material</MaterialProperty>
  <PrefixProperty>AsmPfx</PrefixProperty>
  <StartNoProperty>AsmStNo</StartNoProperty>
  <!--Do not specify anything for custom part position if you want to 
control these with saved settings only.-->
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  <CustomPartPosition>
    <PlaneOffset>0</PlaneOffset>
    <DepthOffset>0</DepthOffset>
    <RotationOffset>0</RotationOffset>
    <Plane>LEFT</Plane>
    <Depth>BEHIND</Depth>
    <Rotation>FRONT</Rotation>
  </CustomPartPosition>
</LayerComponentInfo>

Convert to layout component
Use Convert to layout component to convert slabs, wall panels, and IFC
objects into Wall layout or Floor layout components.

You can find the Convert to layout component tool in the Applications &
components catalog.

Conversion settings

Option Description
Layout component Select the type of layout that you

want to convert to. The options are:

• Wall layout

• Floor layout
Attribute settings Select the desired saved settings for

the layout component. The layout
component is first created using
these saved settings.

You can modify the settings
afterwards by modifying the layout
directly.

Direction You can control the layout direction.

• For a Wall layout, you can switch
the depth direction of the layers in
a multi layer wall layout.
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Option Description
• For a Floor layout, you can

control the direction of the floor
slabs.

Convert selected Select the model objects that you
want to convert and click the Convert
selected button to convert the
selected objects. The objects can be
slabs, wall panels, IFC slabs, or IFC
walls.

When the object selection contains
native Tekla Structures slabs or wall
panels that were converted
succesfully, Tekla Structures shows a
message about whether to delete the
original objects or not. Note that IFC
objects are never deleted.

Convert to layout component uses
the Conversion as extrusion
functionality when converting the IFC
objects. This means the IFC has to be
of type Coordination view 2.0. Surface
geometry is not supported.

Geometry detailing strip
Geometry detailing strip allows modeling of wall edge thickenings, recess
patterns, wall corbels, mock joints, and facade protrusions. Note that this
component is for precast use only.

Geometry detailing strip can be used for adding detailed geometry to any
object. You can create different settings for Geometry detailing strip and
select the appropriate settings for each situation.

The tool uses irregular concrete profile catalog profiles. If these profiles are
not found in your Tekla Structures environment, download them to your
model from the Tekla Warehouse local content.
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Use for

  
Sandwich wall thickening

Recess patterns in a wall
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Selection order

1. Select the part face.

2. Pick two or more points to indicate the location.

3. Click the middle mouse button to create the geometry strip.

Geometry detailing strip properties

Option Description
Select the geometry. You can create
thickenings, recesses, and
protrusions.

Define the A, B, C and D dimensions
for the selected option.

Add to cast unit, Attach to part Select how to add the geometry to the
selected part: Attach to part or Add
objects to cast unit.

Cut only, Cut and part, Part only Select how the cut is modeled.
Use main part properties You can control the properties of the

created part. With the Use main part
properties option, the added part
gets the properties of the main part.
Otherwise, you can select the saved
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Option Description
standard attributes for the concrete
beam.

Note that if you change the saved
properties afterwards, you need to
modify the geometry detailing strip to
get the properties of the added part
updated.

Middle. Left, Right Select a position for the geometry.
Define the strip offset from the input
line.

Define the spacing of recesses and
protrusions. For example, enter
40*400 to create 40 recesses with a
spacing of 400, measured from the
center of the recess.

Extend detailing strip Define whether the detailing strip is
extended over the whole part face
when the geometry detail strip is
created as a single line.

Set to Yes to extend and fit the detail
in both directions of the input line to
the edge of the appied face.

Formwork placing tools
This section introduces formwork placing tools.

Click the links below to find out more:

• Formwork placing tools - Walls

• Formwork placing tools - Walls: configuration

• Formwork placing tools - Slabs (page 3091)

• Formwork placing tools - Slabs: configuration (page 3099)

Formwork placing tools - Walls
Formwork placing tools - Walls is a set of components that helps in detailed
modeling of different wall panel formwork systems. These components are
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placing tools, and therefore you need to have all relevant formwork products
such as wall panels, corner conditions, clamps, and pouring platforms
available in the Applications & components catalog.

You can get the formwork products provided by formwork suppliers from
Tekla Warehouse, for example. In addition, Formwork placing tools - Walls
requires additional configuration files that contain the necessary information
about the formwork product components. These configuration files may come
with the formwork product catalogs provided by formwork suppliers, but you
can create the configuration files yourself as well.

Formwork placing tools - Walls contains tools to place and modify the
following formwork elements:

• formwork wall panels typically appearing as two-dimensional arrays
covering a certain area

• different kinds of corner conditions

• an array of ties between two formwork panels

• an array of clamps, locks, or brackets at the joining edge between two
formwork panels to keep the formwork together

• supporting braces for a single formwork panel

• an array of pouring platforms at the top edge of formwork panels

• fillers to fill the gaps between two formwork panels

Because Formwork placing tools - Walls consists of a set of sub-tools which
are combined in one dialog box, each tab is an individual sub-tool. Both the
Formwork placing tools - Walls and the sub-tools are available in
Applications and components catalog.

Most of the settings in the components are preset. You can control the
different settings by selecting a suitable options in the dialog box. These preset
settings are organized according to the formwork supplier and the product
families.

However, if you create your own configuration files, you can use the values in
the configuration files instead of the preset values.

You can access the Formwork placing tools - Walls in the Concrete
Contractor, General Contractor and Rebar Detailer roles in the Default
environment.
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Panel tab

Use the Panel tab to model an array of formwork panels on one side or on
two sides of a cast-in-place wall.

The actual formwork panels are custom parts. In addition to the custom parts,
some additional data of the products is needed from the configuration files.

1. On the Panel tab, in the Formwork supplier and Product family list,
select the suitable options.

The options vary depending on which catalogs and tool configurations you
have in use.

2. Select the panel size in the Formwork panel list, and set the other panel
properties such as the layout, height, and fill location.

3. Click Apply and Insert new to start placing the wall panels.

Move the mouse pointer over pour objects or concrete parts to select a
suitable location.

4. Pick the start point and the end point of the formwork wall panel.

A preview of what the panels would look like after being placed is shown
and you can decide which panels should be created. You can also change
the panel layout afterwards by using direct modification.
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Option Description
Formwork supplier

Product family

Select the formwork supplier and the
product family.

Formwork panel Select the panel size.

If the total length of the panel array
does not match with the panel width,
smaller panels with the same height
are automatically placed in the array
near the fill location (start/middle/end
of the array).

Avoid panels Define which panels are avoided
during the automatic insertion.

Panel layout Override the default panel widths.

When you insert the array for the first
time, leave the value empty and
modify the panel widths by using
direct modification.
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Option Description
Select the layout of the panel array.

Enter the offset from the wall bottom
and the total height of the panel
array.

One side

Two sides

Select whether the panels are created
on one side or on both sides of the
wall.

You can modify the wall thickness.
When the walls are inserted, the
applied wall thickness is overridden
with the actual wall thickness.

Fill location Use the Fill location option to control
where the empty space for the filler is
located.

Add to pour unit Select whether the panels and all
accessories related to the panels are
added to the pour or not.

Select new pour... The initial pour is identified
automatically when the panels are
inserted. To change the selected pour,
click the Select new pour... button
and select a new pour.

Note that there is no automatic
recognition of a new pour if you
decide to move the formwork panels,
or if you add pour breaks which
change the pours.

Insert new Click the Insert new button to start
inserting new formwork panel arrays.
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Option Description
Add accessories to selected Add various accessories automatically

to the selected panels.

Select the check boxes for the
accessories you want to add. Note
that for clamps and walers you can
control separately the creation at
horizontal and/or vertical edges.

Conditions tab

A condition is a set of formwork components, such as custom parts, parts or
other items, designed for special geometries in the wall. Conditions create the
formwork at special locations in the walls, such as L, T, and X corners,
bulkhead at the end of a wall, or pilasters at pour ends or at the middle of the
wall. Each different type of a special geometry is its own condition type.

Each condition consists of two or more sub-assemblies of the formwork
components, depending on the condition type. For example, the L corner
contains the inner corner assembly (1) and the external corner assembly (2).
When inserted in the model, the location of these assemblies is controlled with
the main insertion points and the two wall thickness parameters.

Use the Conditions tab to create a condition that consists of two or more sub-
assemblies of formwork components.

Concrete components 3038 Concrete detailing



1. On the Conditions tab, select what type of condition to use by clicking the
condition icon, and set the values to be applied for the selected condition.

2. Click Apply and Insert new to start placing the conditions.

3. Move the mouse pointer on the corner edges, pilaster edges, or ends of
the pours or parts.

Formwork placing tools - Walls automatically recognizes the condition
type and wall thickness properties.

Two arrows and a preview of the condition parts to be created is shown.
The red arrow indicates the first direction and the green arrow indicates
the second direction.

In the example below, the longer panel becomes parallel to the red arrow,
and the shorter panel will be parallel to the green arrow. Depending on
the case, you may switch the arrows by moving the mouse on the other
side of the edge.
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4. Click to place the conditions.

In some cases the condition tool may not recognize the condition type
correctly. For example, if you want to insert an L corner to a location where the
other side of the wall is very short it may happen that the condition tool is
trying to insert a corner pilaster.

Option Description
Select the condition to be created.
The selection is specific for each type
of condition.

Click the condition icon to select the
condition type to be used.

Concrete components 3040 Concrete detailing



Option Description
Modify the dimensions that control
the location of condition sub-items in
relation to the insertion point.

When you insert a new condition,
these dimensions are overridden by
the calculated values based on the
actual insertion location and
condition type.

Offset from bottom Define the vertical offset for the
condition from the bottom of the wall.

Number of stacked conditions To insert two or more vertically
stacked conditions, enter the number
of stacked conditions.

Height Height of one stack when the
conditions are stacked.

Left/right corner Select how the conditions are inserted
if you use the left-hand side
placement.

If you select Rotate, the condition
always switches the red/green axis to
a right-hand side placement.

If you select Mirror, the left-hand side
placement is allowed.

Right-hand side placement:

Left-hand side placement:
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Option Description

Filler configuration Define which filler type is used when
you place a condition which includes
a filler.

Configure Open the Condition setup dialog box
to modify the existing conditions or to
define new conditions.

Define a new condition

Defining a new condition has two phases. First, you need create the needed
sub-assemblies. Once you have all the needed sub-assemblies available, you
can define a new condition by giving it a name and defining which sub-
assemblies are used in the new condition.

To define a new condition or to modify existing condition definitions, click the
Configure button. The Condition setup dialog box opens where you can do
the needed modifications.

Option Description
Condition setup file Conditions are saved in external data

files
(xxxx.FormworkTools.Conditions
.csv).

Select the file to add, modify or delete
the defined conditions.

Save

Save as

New

Click Save or Save as to save any
changes.

Click New to create a new empty file.

Condition type In the list, select the condition type to
be modified.

The list shows the existing conditions
if there are any. If you have one or
more existing conditions of the
selected type, you can select the
current condition in the list. When the
condition is selected, the current
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Option Description
definition values are shown and can
be set or modified on the right-hand
side of the dialog box.

Click  to create a new condition.

Click  to copy the selected
condition.

Click  to delete the condition.
Formwork supplier

Product family

Condition

The condition has the supplier and
the family properties. The conditions
are available only when the supplier
and the family are matching.

The condition names need to be
unique. Decide about naming
conventions so that the names are as
descriptive as possible.
The condition can have 2-5 sub-
conditions, depending on the
condition type. One condition must
have at least one sub-condition
defined as otherwise it does not
create anything.

Click  to open a sub-assembly
wizard dialog box to create a new
sub-assembly.

Click the Test button to verify the
output of the selected sub-assembly.

To test the sub-assembly, pick a point
in the model. The tool creates a
sample wall and the sub-conditions
with right side and left side
placement.

After you have done the testing, you
can delete model objects that were
created for testing purposes.

Total height for stacking The total height of the condition can
be calculated automatically based on
the selected sub-conditions, or you
can give the height.

The total height is used as the spacing
value when two or more conditions
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Option Description
are stacked vertically. If the condition
contains some parts sticking out and
this part is overlapping in the stack,
you may need to enter the total
height manually.

Left/right corner Test and verify how the Mirror and
Rotate options affect the output of
the condition.

Test condition Test and verify the output of the
whole condition, including all sub-
conditions.

To test the condition, pick a point in
the model. The tool creates a sample
wall and two conditions with right
side and left side placement.

After you have done the testing, you
can delete the model objects that
were created for testing purposes.

Create a new corner sub-assembly

The corner sub-assemblies are created using Formwork corner sub-
assembly wizard.

Typically, the corner sub-assembly contains formwork products at one side
(inner or external) of the corner, or at some corner in a pilaster.

The outcome of the wizard is stored in an external file with a name.

To open the dialog box, click  in the Condition setup dialog box on a
condition that requires a corner sub-assembly. Alternatively, you can search
for the Formwork corner sub-assembly wizard in the Applications and
components catalog.

Before you can start creating the corner sub-assemblies, you need to have an
external or inner corner formwork in the model. When you have created the
corner formwork, you can start the wizard.
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1. Pick the first corner point.

This point will be placed exactly to the external or to the internal corner of
the concrete in the wall in the final condition placement. Note that after
you have picked the point, the wizard steps forward automatically. You
can step back to re-pick a new point.

2. Pick a point showing the direction of the first wall.

This is typically the red arrow in condition placing.

3. Select all formwork items belonging to the first wall.

In practice, these formwork items will be parallel to the first wall when
placing the sub-assembly of the condition.
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4. Pick a point showing the direction of the second wall.

This is typically the green arrow in condition placing, and perpendicular to
the first wall.

5. Select all formwork items belonging to the second wall.

Typically, these formwork items will be parallel to the second wall when
placing the sub-assembly of the condition.

6. Enter a file name to save the corner sub-assembly. Click Finish to close
the wizard.
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All corner sub-assemblies are saved in the Formwork tools folder in the
model folder.

If you want to use the conditions in other models, you can copy or move the
files and the condition setup files to any of the system folders. To ensure that
the conditions work in other models, all custom components that the
conditions use must exist in the Applications and components catalog.

Create a new panel sub-assembly

The panel sub-assemblies are created using Formwork panel sub-assembly
wizard.

The outcome of the wizard is stored in an external file with a name.

To open the dialog box, click  in the Condition setup dialog box on a
condition that requires a panel sub-assembly. Alternatively, you can search for
the Formwork panel sub-assembly wizard in the Applications and
components catalog.

Before you can start creating the panel sub-assemblies, you need to have a
formwork panel and all necessary accessories in the model. When you have
created the formwork structure, you can start the wizard.

1. Pick the center point of the panel sub-assembly.

This point will be placed exactly to the center of the concrete wall in the
final condition placement. Note that after you have picked the point, the
wizard steps forward automatically. You can step back to re-pick a new
point.
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2. Pick a point showing the direction of the wall.

3. Select all formwork items belonging to the panel sub-assembly, and click
Next.

4. Enter a file name to save the panel sub-assembly. Click Finish to close the
wizard.

All panel sub-assemblies are saved in the Formwork tools folder in the
model folder.

If you want to use the conditions in other models, you can copy or move the
files and the condition setup files to any of the system folders. To ensure that
the conditions work in other models, all custom components that the
conditions use must exist in the Applications and components catalog.
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Fillers tab

Use the Fillers tab to create filler items to fill the gaps between two formwork
panels.

Note that this functionality does not work between condition and a panel,
meaning that the gap at the end of the wall cannot be filled with this setup.

1. On the Fillers tab, select the filler in the Filler configuration list, and set
the other filler properties.

2. Click Apply and either Select single panel or Select two panels,
depending on how you want to insert the fillers.

• To insert the filler by selecting a single panel, select the formwork
panel and a point to indicate the location (left, right, top, bottom of the
panel) and the width of the filler.

• To insert the filler by selecting two adjacent panels, select the first
formwork panel, and then select the second formwork panel.
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Ties tab

Use the Ties tab to insert an array of ties between two formwork panels on
the opposite sides of the wall.

1. On the Ties tab, select the tie in the Tie type list, and set the other tie
properties.

2. To add ties manually, set Tie layout to Single tie, Left side, or Right side.

3. Click Apply and Insert new to start placing ties.

4. In the model, hover your mouse pointer over the panel and pick the
points where you want to add ties.

5. Alternatively, to add ties automatically, set Tie layout to Preset array.
Select the panel, click Apply and Add to selected. The ties are placed
automatically.

6. If you want modify ties:

a. To adjust tie position, select a tie array, and drag the handle to move
the tie to the position you want.

b. To add new ties, duplicate the existing ones. Hold down the Ctrl key,
and drag a tie to a new position.

c. To delete individual ties, select a tie and press the Delete key.

d. To change the properties, spacing and/or start distances, modify the
properties in the dialog box and click Modify.

Clamps tab

Use the Clamps tab to insert a linear array of clamps, locks, or brackets at the
joining edges between two formwork panels to keep the formwork together.
Clamp placing works in the same way as the tie placing.

1. On the Clamps tab, select the clamp in the Clamp type list, and set the
other clamp properties.

2. To add clamps manually, set Clamp layout to Single clamp. With the
Custom array option you can set the offset and spacing.

3. Click Apply and Insert new to start placing clamps.

4. In the model, hover your mouse pointer over the panel, and pick the
points where you want to add clamps.

5. Alternatively, to add clamps automatically, set Clamp layout to Preset
array. Select the panel, click Apply and Add to selected.

The Add accessories dialog box opens where you can select which
accessories are added with the clamps. Click Add accessories to
selected. The clamps and other accessories are placed automatically to
the selected panels.
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6. If you want modify clamps:

a. To adjust a clamp position, select a clamp, and drag the handle to
move the clamp to the position you want.

b. To add new clamps, duplicate the existing ones. Hold down the Ctrl
key, and drag a clamp to a new position.

c. To delete individual clamps, select a clamp and press the Delete key.

d. To change the properties, spacing and/or start distances, modify the
properties in the dialog box and click Modify.

Walers tab

Use the Walers tab to insert walers to formwork panels. Typically, a waler is
used to connect two panels on top of each other but it can also be placed in
one single panel. The waler typically consists of the waler beam and two lock
devices fixing the waler to the panel.

1. On the Walers tab, select the waler in the Waler type list, and set the
other waler properties.

2. Enter the longitudinal offset. Leave the value empty to get the waler beam
centered between the input points.

3. Click Apply and Insert new to start placing walers.

4. In the model, hover your mouse pointer over the panel and pick the first
preset point. This is the first input point of the waler beam and the
location for the first lock device.

5. Move the mouse pointer on the next panel and pick the second preset
point. This is the end point of the waler beam and the location for the
second lock device.

If you did not enter the longitudinal offset value, the waler beam is
centered between the picked points. Otherwise, the waler beam starts at
the given offset from the first picked point.

Alternatively, to add walers automatically, click Apply and Add to
selected. The Add accessories dialog box opens where you can select
which accessories are added with the walers. Click Add accessories to
selected. The walers and other accessories are placed automatically to
the selected panels.

6. If you want modify walers:

a. To adjust a waler position, select a waler, and drag the point handle to
move the waler to the position you want.

By holding down the Alt key, you can drag the point anywhere, even
to a different panel.

b. To change the longitudinal offset, drag the point handle between the
picked points.
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c. To add new walers, hold down the Ctrl key, and drag a main handle of
a waler to a new position.

Braces tab

Use the Braces tab to insert supporting braces for a single formwork panel.

1. On the Braces tab, select the brace layout in the Brace layout list, and set
the other brace properties.

To add braces manually, set Braces layout to Single brace. With the
Custom array option you can set the offset and spacing.

2. Click Apply and Insert new to start placing braces.

3. In the model, hover your mouse pointer over the panel and pick the
points where you want to add braces.

4. Alternatively, to add braces automatically, set Brace layout to Preset
array. Select the panel, click Apply and Add to selected. The Add
accessories dialog box opens where you can select which accessories are
added with the braces. Click Add accessories to selected and the braces
and other accessories are placed automatically to the selected panels.

Platforms tab

Use the Platforms tab to insert an array of pour platforms at the top edge of
formwork panels.

1. On the Platforms tab, select the platform type in the Platform type list,
and set the platform spacing and vertical and horizontal offset.

2. Click Apply and Insert new to start placing platforms.

3. In the model, hover your mouse pointer over the panel and pick the start
and end points to create a linear array of platforms along the top edge of
the panel.

4. Alternatively, to add platforms automatically, select the panel and click
Add to selected. Platforms are added automatically to the selected
panels.

Formwork placing tools - Walls: configuration
You can set up your own configuration files for Formwork placings tools -
Walls.

The configuration is done by using comma separated files (.csv), which can be
edited with Microsoft Excel or any standard text editor. Each separate
formwork sub-tool component has its own configuration file.

The configuration files can be located in any of the system folders, or in the
sub-folder called Formwork tools in the current model folder.
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Example configuration files are located in the ...\Trimble\Tekla
Structures\<version>\Environments\common\system\CIP\Formwork
folder.

The configuration files are typically named by the formwork supplier and/or
the product families. There can be any number of files, and the files are
identified with a specific suffix. Each of the files controls one of the sub-tools in
the component. The files contain varying number of columns.

Use the following configuration files for Formwork placings tools - Walls to
set up

• panels: xxxx.FormworkTools.Panels.csv
• ties for the tie placing tool: xxxx.FormworkTools.Ties.csv
• tie spacers placed by the tie placing tool:

xxxx.FormworkTools.TieSpacers.csv
• clamps: xxxx.FormworkTools.Clamps.csv
• braces: xxxx.FormworkTools.Braces.csv
• pouring platforms: xxxx.FormworkTools.Platforms.csv
• walers: xxxx.FormworkTools.Walers.csv
• conditions (corners, pilasters and bulkheads):

xxxx.FormworkTools.Conditions.csv
• fillers: xxxx.FormworkTools.Fillers.csv

Accessories in formwork placing tools

You can set up any formwork accessory to be created as a beam, an item, or as
a custom part. For beams and items you can additionally set up any of the
beam or items properties or UDAs either in the configuration file by adding
new columns, or as property files.

Each configuration file contains a header row and data rows. The header row is
the first row that is not a comment row, and it gives the configuration
parameter names (column name). Each data row gives one product and
defines the parameters used when placing the beam, item or custom part.

In addition to header row and data rows the file can contain comment rows. A
comment row is any row starting with text //.

You can define the distance unit by adding a row:

DISTANCE_UNIT=MM
When the distance unit is defined using the above setting, all distance values
can be given as decimal values in the specified units. The supported units are:
MM, DN, CM, M, INCH, FEET.
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The following accessories are available for different Formwork placings tools
- Walls product types. For example, for a brace you can specify Brace,
Bracket1 and Bracket2 accessories.

Product type Accessory
Panel Panel
Tie Part1, the actual tie rod

Part2, the front lock

Part3, the back lock
Tie spacer SpacerTube

StartCone
EndCone

Clamp Part1
Brace Brace

Bracket1
Bracket2

Platform Part1
Part2

Waler Beam
Clamp1
Clamp2

Filler Timber
Stud
Plywood
Part1
Part2 - Part10

Common configuration parameter fields

To configure the accessories in any of the formwork product types, define the
following fields in the .csv configuration file.

The text [Accessory] in the following table denotes the accessory in
question.

Column name in the .csv file Description
[Accessory].Profile
[Accessory].Item
[Accessory].CustomPart

Formwork placing tools can place
either beams, items, or custom parts
to the model.

If all products are of the same model
object type you can use one of the

Concrete components 3054 Concrete detailing



Column name in the .csv file Description
three field names and give the
corresponding data value.

The field name specifies the model
object default type but you can also
override the model object type by
adding the prefix BEAM:, ITEM: or
CUSTOMPART: for the actual value.

The actual value for BEAM: is a valid
profile string, for ITEM: a valid item
shape name, and for CUSTOMPART: a
valid custom part name.

[Accessory].Attributes Saved property file used to set either
part, item or custom part properties.

[Accessory].Name Name of the part or the item, or the
Name property of the custom part.

[Accessory].Class Class of the part or the item, or the
Class property of the custom part.

[Accessory].Material Material of the part or the item, or the
Material property of the custom part.

[Accessory].AssPrefix Part or item numbering assembly
prefix, or the AssPrefix property of
the custom part.

[Accessory].AssStartNo Part or item assembly start number,
or the AssStartNo property of the
custom part.

[Accessory].PartPrefix Part or item numbering part prefix, or
the PartPrefix property of the
custom part.

[Accessory].PartStartNo Part or item part start number, or the
PartStartNo property of the custom
part.

[Accessory].Finish Finish of the part or the item, or the
Finish property of the custom part.

[Accessory].InputOrder Set the final locations of the input
points in relation to the default
generic start and end points.

The possible values are:

• StartEnd: default if no other
value is specified.

• EndStart: reverses the default
start/end points.
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Column name in the .csv file Description
• CenterStart: the first input point

is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.

• CenterLeft: the first input point
is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.
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Column name in the .csv file Description
[Accessory].PlanePosition This is Position in plane when the

beam, item, or custom part is inserted
in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

[Accessory].PlaneOffset Offset on plane. The default value is
0.

[Accessory].Rotation This is Rotation when the custom
part is inserted in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

[Accessory].RotationOffset Rotation offset in degrees. The
default value is 0.

[Accessory].DepthPosition This is Position at depth when the
beam, item, or custom part is inserted
in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

[Accessory].DepthOffset Offset at depth. The default value is 0.
[Accessory].StartOffset Offset of the actual start point from

the generic start point in the local
coordinate system.

Give the offset as x, y and z values
that are separated by a space or a
colon, and enclosed in parentheses (0
100 0). If no value is given, a zero
offset (0 0 0) is used.

[Accessory].EndOffset Offset of the actual end point from
the generic end point in the local
coordinate system.

Give the offset as x, y and z values
that are separated by a space or a
colon, and enclosed in parentheses (0
100 0). If no value is given, a zero
offset (0 0 0) is used.

[Accessory].UDA.XXXXXX Define additional UDA values applied
to the model objects. You can
introduce as many UDA values as
needed.

Note that the UDA name (XXXXX)
must be the internal name, not the
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Column name in the .csv file Description
localized name shown in the user
interface.

Configure the panel placing tool

.FormworkTools.Panels.csv
Add or modify one row for each panel.

The configuration of all accessories that can be added to panels is done in the
local coordinate system of the panel. The origin of the panel is located at the
center point of the panel.

Definition Description
Supplier Supplier name, this is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Unique panel name, which is shown
in the Formwork panel list.

PanelName Name of the custom part that will be
inserted in the model.
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Definition Description
PanelAttributes Property file saved in the component

dialog box to be used when the
custom part will be inserted in the
model.

PanelInputOrder Define the orientation of the custom
part panels by specifying where the
start and end handles of the custom
part will go.

Set the final locations of the input
points in relation to the default
generic start and end points.

The possible values are:

• StartEnd: default if no other
value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.

• CenterLeft: the first input point
is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
point and the second point is
down from the center point.
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Definition Description
Note that if the .csv file does not
contain any value, the default value
StartEnd is used.

PanelPlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in plane view.

The options are MIDDLE, LEFT, and
RIGHT.

PanelPlaneOffset Offset on plane. The default value is
0.

PanelRotation Use Rotation to insert the custom
part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

PanelRotationOffset Rotation offset in degrees. The
default value is 0.

PanelDepthPosition Use Position at depth to insert the
custom part in plane view.

The options are MIDDLE, FRONT, and
BEHIND.

PanelDepthOffset Offset at depth. The default value is 0.
PanelStartOffset PanelStartOffset and

PanelEndOffset change the
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Definition Description
location of the actual start and end
handles of the custom part.

PanelStartOffset is the offset of
the actual start point from the generic
start point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

PanelEndOffset PanelEndOffset is the offset of the
actual end point from the generic end
point in the local coordinate system.
Give the offset as x, y and z values
that are separated by a space or a
colon, and enclosed in parentheses (0
100 0). If no value is given, a zero
offset (0 0 0) is used.

HeightProperty Name of the height property in the
custom part. If the height is fixed, this
is empty.

HeightValue Height of the panel.

Note that the height value is read
from the .csv file.

WidthProperty Name of the width property in the
custom part. If the width is fixed, this
is empty.

WidthValue Width of the panel.

Note that the width value is read from
the .csv file.

ThicknessProperty Name of the thickness property in the
custom part. If the thickness is fixed,
this is empty.

ThicknessValue Thickness of the panel.

Note that the thickness value is read
from the .csv file.

TieX TieX specifies the x locations of the
ties. Values must be enclosed in
parentheses () and separated by
spaces.

TieY TieY specifies the y locations of the
ties. Values must be enclosed in
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Definition Description
parentheses () and separated by
spaces.

TiePickX
TiePickY
or

TiePickXY

Define the possible x and y locations
of the ties when placing and picking a
single tie. You can either specify the x
and y values separately in two value
fields to define a regular grid of
locations, or if your panels require an
irregular pattern, you can specify a list
of x and y value pairs.

Always define the x and y values in
two separate fields (TiePickX and
TiePickY), or x and y value pairs in
one field (TiePickXY).

Values must be enclosed in
parentheses () and separated by
spaces.

ClampX ClampX specifies the x locations of
the clamps at the horizontal top/
bottom edges. Values must be
enclosed in parentheses () and
separated by spaces.

ClampY ClampY specifies the y locations of
the clamps at the vertical left/right
edges. Values must be enclosed in
parentheses () and separated by
spaces.

ClampPickX
ClampPickY
or

ClampPickXY

Define the possible x and y locations
of the clamps when placing and
picking a single clamp. You can either
specify the x and y values separately
in two value fields to define a regular
grid of locations, or if your panels
require an irregular pattern, you can
specify a list of x and y value pairs.

Always define the x and y values in
two separate fields (ClampPickX and
ClampPickY), or x and y value pairs
in one field (ClampPickXY).

Values must be enclosed in
parentheses () and separated by
spaces.
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Definition Description
BraceX
BraceY
or

BraceXY

Define the preset pattern for the
braces. You can either specify the x
and y values separately in two value
fields to define a regular grid of
locations, or if your panels require an
irregular pattern, you can specify a list
of x and y value pairs.

Always define the x and y values in
two separate fields (BraceX and
BraceY), or x and y value pairs in one
field (BraceXY).

Values must be enclosed in
parentheses () and separated by
spaces.

BraceTiltedX
BraceTiltedY
or

BraceTiltedXY

Define the preset pattern for the
braces when the panel is tilted. You
can either specify the x and y values
separately in two value fields to
define a regular grid of locations, or if
your panels require an irregular
pattern, you can specify a list of x and
y value pairs.

Always define the x and y values in
two separate fields (BraceTiltedX
and BraceTiltedY), or x and y value
pairs in one field (BraceTiltedXY).

Values must be enclosed in
parentheses () and separated by
spaces.

BracePickX
BracePickY
or

BracePickXY

Define the possible x and y locations
of the braces when placing and
picking a single brace in a panel. You
can either specify the x and y values
separately in two value fields to
define a regular grid of locations, or if
your panels require an irregular
pattern, you can specify a list of x and
y value pairs.

Always define the x and y values in
two separate fields (BracePickX and
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Definition Description
BracePickY), or x and y value pairs
in one field (BracePickXY).

Values must be enclosed in
parentheses () and separated by
spaces.

BraceTiltedPickX
BraceTiltedPickY
or

BraceTiltedPickXY

Define the possible x and y locations
of the braces when placing and
picking a single brace in a tilted panel.
You can either specify the x and y
values separately in two value fields
to define a regular grid of locations,
or if your panels require an irregular
pattern, you can specify a list of x and
y value pairs.

Always define the x and y values in
two separate fields
(BraceTiltedPickX and
BraceTiltedPickY), or x and y value
pairs in one field
(BraceTiltedPickXY).

Values must be enclosed in
parentheses () and separated by
spaces.

WalerEdgeOffset Offset of the waler input point
(=location of the clamp 1 and/or
clamp 2) from the panel edge when
the walers are placed automatically.
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Definition Description
WalerX X locations used for placing walers

automatically at horizontal top/
bottom edges. The vertical (y) location
is defined by WalerEdgeOffset from
the top/bottom edge. Values must be
enclosed in parentheses () and
separated by commas or spaces.

WalerY Y locations used for placing walers
automatically at vertical left/right
edges. The horizontal (x) location is
defined by WalerEdgeOffset from
left/right edge. Values must be
enclosed in parentheses () and
separated by commas or spaces.

WalerPickX Define the possible x locations of the
walers when placing and picking a
single waler. Values must be enclosed
in parentheses () and separated by
commas or spaces.

WalerPickY Define the possible y locations of the
walers when placing and picking a
single waler. Values must be enclosed
in parentheses () and separated by
commas or spaces.

Configure the tie placing tool

xxxx.FormworkTools.Ties.csv
A generic tie consists of three custom components: a bolt that usually goes
through the wall, and two locks on both sides of the formwork.
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Add or modify one row for each tie.

Definition Description
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Tie name, which is shown in the Tie
type list.

This name can be unique, or multiple
tie configurations may have the same
name. When multiple tie
configurations have the same name,
the tool automatically selects the first
suitable tie based on the wall
thickness.

MaxLength Maximum length of the tie, measured
from outer faces of the two formwork
panels on opposite sides.

LengthProperty If the tie custom part is parametric
and has a parameter controlling the
effective length, this is the name of
the Length property.
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Definition Description
Part1Name Name of the custom part 1 that will

be inserted in the model (=bolt).
Part1Attributes Property file saved in the component

dialog box to be used when the
custom part is inserted in the model.

Part1PlanePosition This is Position in plane when the
custom part is inserted in the face
view of the main formwork panel.

Part1PlaneOffset This is Offset on plane value when
the custom part is inserted in the face
view of the main formwork panel.

Part1Rotation This is Rotation when the custom
part is inserted in the face view of the
main formwork panel.

Part1RotationOffset This is Rotation offset when the
custom part is inserted in the face
view of the main formwork panel.

Part1DepthPosition This is Position at depth when the
custom part is inserted in the face
view of the main formwork panel.

Part1DepthOffset This is Offset at depth when the
custom part is inserted in the face
view of the main formwork panel.

Part1StartOffset Offset of the first insertion point in
relation to Input point 1.

Part1EndOffset Offset of the first insertion point in
relation to Input point 2.

Part2Name Name of the custom part 2, which
typically is the lock on the front side
of the main formwork panel.

Part2Attributes Property file saved in the component
dialog box to be used when the
custom part will be inserted in the
model.

Part2StartOffset Offset of the second insertion point in
relation to Input point 1.

Part2EndOffset Location of the second insertion point
in relation to the Input point 1.

Part2... For custom part 2, you can specify the
same fields as for custom part 1.

Part3Name Name of the custom part 3, which
typically is the lock on the back side of
the main formwork panel.
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Definition Description
Part3Attributes Property file saved in the component

dialog box to be used when the
custom part will be inserted in the
model.

Part3StartOffset Offset of the first insertion point in
relation to Input point 2.

Part3EndOffset Location of the second insertion point
in relation to the Input point 2.

Part3... For custom part 3, you can specify the
same fields as for custom part 1.

Configure the spacers for the tie placing tool

xxxx.FormworkTools.TieSpacers.csv
A generic tie spacer consists of three custom components: a tube that usually
goes through the wall, and two optional cones at each side of the wall.

Add or modify one row for each tie spacer.

Definition Description
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.
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Definition Description
Name Spacer name, which is shown in the

Spacer name list.

This name can be unique, or multiple
tie spacer configurations may have
the same name. When multiple tie
spacer configurations have the same
name, the tool automatically selects
the first suitable tie spacer based on
the wall thickness.

MinLength Minimum possible length of the tube,
measured from the inner faces of the
two formwork panels on the opposite
sides.

MaxLength Maximum possible length of the tube,
measured from the inner faces of the
two formwork panels on the opposite
sides.

LengthProperty If the tie spacer custom part is
parametric and has a parameter
controlling the effective length, this is
the name of the Length property.

SpacerTubeName Name of the custom part (=tube).
SpacerTubeAttributes Property file saved in the component

dialog box to be used when the
custom part will be inserted in the
model.

SpacerTubePlanePosition This is Position in plane when the
custom part is inserted in the face
view of the main formwork panel.

SpacerTubePlaneOffset This is Offset in plane when the
custom part is inserted in the face
view of the main formwork panel.

SpacerTubeRotation This is Rotation when the custom
part is inserted in the face view of the
main formwork panel.

SpacerTubeRotationOffset This is Rotation offset when the
custom part is inserted in the face
view of the main formwork panel.

SpacerTubeDepthPosition This is Position in depth when the
custom part is inserted in the face
view of the main formwork panel.
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Definition Description
SpacerTubeDepthOffset This is Offset in depth when the

custom part is inserted in the face
view of the main formwork panel.

SpacerTubeStartOffset Offset of the first insertion point in
relation to Input point 1.

SpacerTubeEndOffset Offset of the first insertion point in
relation to Input point 2.

StartConeName Name of the custom part, which
typically is the cone on the front side
of the main formwork panel.

StartConeAttributes Property file saved in the component
dialog box to be used when the
custom part is inserted in the modell.

StartConeStartOffset Offset of the first insertion point in
relation to Input point 1.

StartConeEndOffset Location of the second insertion point
in relation to the Input point 1.

StartCone... For custom part 2, you can specify the
same fields as for custom part 1.

EndConeName Name of the custom part which
typically is the cone on the back side
of the main formwork panel.

EndConeAttributes Property file saved in the component
dialog box to be used when the
custom is be inserted in the model.

EndConeStartOffset Offset of the first insertion point in
relation to Input point 2.

EndConeEndOffset Location of the second insertion point
in relation to the Input point 2.

EndCone... For custom part 3, you can specify the
same fields as for custom part 1.

Configure the clamp placing tool

xxxx.FormworkTools.Clamps.csv
The generic clamp contains one custom part. The input points are at the edges
of the two panels and thus the clamp can be parametric in terms of the filler
space, if needed.
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Note that to create the brackets with some additional bolts or locks, you need
to make a new custom part containing both the bracket and all necessary
fittings:

Definition Description
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Unique clamp name.
CenterInput When YES, the first insertion point is

in the middle of the seam of the two
panels. If the value is NO, the insertion
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Definition Description
points are offset from the edge of the
panels.

FillerGapProperty If the clamp custom part is
parametric, and the parameter can
adjust the gap between two panels,
this is the name of that parameter.
This field is empty if the clamp is not
parametric.

MaxFillerGap This value is used when clamps or
walers are added automatically along
with a formwork filler. If the free
space (=width of the filler) is less or
equal to the given MaxFillerGap,
clamps will be inserted. If the free
space is greater than the given
MaxFillerGap, walers will be
inserted.

Part1Name Name of the clamp custom part 1.
Part1Attributes Property file saved in the component

dialog box to be used when the
custom part is inserted in the model.

Part1PlanePosition This is Position in plane when the
custom part is inserted in the face
view of the main formwork panel.

Part1PlaneOffset This is Offset in plane when the
custom part is inserted in the face
view of the main formwork panel.

Part1Rotation This is Rotation when the custom
part is inserted in the face view of the
main formwork panel.

Part1RotationOffset This is Rotation offset when the
custom part is inserted in the face
view of the main formwork panel.

Part1DepthPosition This is Position in depth when the
custom part is inserted in the face
view of the main formwork panel.

Part1DepthOffset This is Offset in depth when the
custom part is inserted in the face
view of the main formwork panel.

Part1StartOffset Offset of the first insertion point in
relation to Input point 1.

Part1EndOffset Location of the second insertion point
in relation to the Input point 1.
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Configure the brace placing tool

xxxx.FormworkTools.Braces.csv
A generic brace may consists of five custom parts, which are inserted in the
model by using three input points. You can select the upper and lower braces
separately. In the brace configuration file, the upper and lower braces are
defined separately; they both have own rows.

Definition Description
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.
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Definition Description
Name Brace name which is shown in the list.

If you have several rows with the
same name, the tool automatically
selects the suitable brace based on
the minimum and maximum length.

Type Type of the brace. The options are
Upper or Lower.

MinLength Minimum possible length of the main
brace measured from Input point 1
to Input point 2.

MaxLength Maximum possible length of the main
brace measured from Input point 1
to Input point 2.

LengthProperty If the brace custom part is parametric
and has a parameter controlling the
effective length, this is the name of
the Length property. At insertion it
will get the actual length value
between Input point 1 and Input
point 2.

BraceName Name of the custom part for the
upper or lower brace which will be
inserted into the model.

BraceAttributes Property file saved in the component
dialog box to be used when the
custom part is inserted in the model.

BracePlanePosition This is Position in plane when the
custom part is inserted in plane view.

BracePlaneOffset This is Offset in plane when the
custom part is inserted in plane view.

BraceRotation This is Rotation when the custom
part is inserted in plane view.

BraceRotationOffset This is Rotation offset when the
custom part is inserted in plane view.

BraceDepthPosition This is Position in depth when the
custom part is inserted in plane view.

BraceDepthOffset This is Offset in depth when the
custom part is inserted in plane view.

BraceStartOffset Offset of the first insertion point in
relation to Input point 1.

BraceEndOffset Offset of the first insertion point in
relation to Input point 2.
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Definition Description
Bracket1Name Name of the custom part for the top

bracket (upper brace) or bottom
bracket (lower brace) which will be
inserted into the model.

Bracket1Attributes Property file saved in the component
dialog box to be used when the
custom part is inserted in the model.

Bracket1StartOffset Offset of the first insertion point in
relation to Input point 1.

Bracket1EndOffset Location of the second insertion point
in relation to the Input point 3.

Bracket1... For custom part 2, you can specify the
same fields as for custom part 1.

Bracket2Name Name of the custom part for the floor
bracket which will be inserted into the
model.

If both upper and lower brace have a
definition for the bracket, the bracket
defined for the lower brace will be
created.

Bracket2Attributes Property file saved in the component
dialog box to be used when the
custom part will be inserted in the
model.

Bracket2StartOffset Offset of the first insertion point in
relation to Input point 2.

Bracket2EndOffset Location of the second insertion point
in relation to the Input point 2.

Bracket2... For custom part 3, you can specify the
same fields as for custom part 1.

Configure the pouring platform placing tool

xxxx.FormworkTools.Platforms.csv
A generic pouring platform contains two custom parts, which are inserted in
the model as a linear array of custom parts.
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Definition Description
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Unique pouring platform name.
Type The type of the platform (A or B).

The length of the array is defined with
start and end points of the platform.
The custom part placing has two
methods:

• Type A: the length of one platform
custom part is fixed, and the
custom parts are inserted
sequentially.
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Definition Description
• Type B: the first custom part is a

support, which is placed at start,
intermediate and end points of
the array. The second custom part
is placed between the main
support parts.

Length Effective length of one platform
element.

Width Width of the platform.
Spacing Spacing between the custom parts in

the array.
Part1Name Name of the custom part 1.
Part1Attributes Property file saved in the component

dialog box to be used when the
custom part is inserted in the model.

Part1PlanePosition This is Position in plane when the
custom part is inserted in the face
view of the main formwork panel.

Part1PlaneOffset This is Offset in plane when the
custom part is inserted in the face
view of the main formwork panel.

Part1Rotation This is Rotation when the custom
part is inserted in the face view of the
main formwork panel.

Part1RotationOffset This is Rotation offset when the
custom part is inserted in the face
view of the main formwork panel.

Part1DepthPosition This is Position in depth when the
custom part is inserted in the face
view of the main formwork panel.

Part1DepthOffset This is Offset in depth when the
custom part is inserted in the face
view of the main formwork panel.

Part1StartOffset Offset of the first insertion point in
relation to Input point 1.

Part1EndOffset Offset of the first insertion point in
relation to Input point 1.

Part2Name Name of the custom part 2.
Part2Attributes Property file saved in the component

dialog box to be used when the
custom part is inserted in the model.
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Definition Description
Part2StartOffset Offset of the first insertion point in

relation to Input point 1.
Part2EndOffset Location of the second insertion point

in relation to the Input point 1.
Part2... For custom part 2, you can specify the

same fields as for custom part 1.

Configure the waler placing tool

xxxx.FormworkTools.Walers.csv
A generic waler consists of three custom parts, the waler beam and two clamp
devices. The generic input points are located in the outer face of the panel.

Definition Description
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Waler name, which is shown in the
Waler type list.

This name can be unique, or multiple
tie waler configurations may have the
same name. When multiple waler
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Definition Description
configurations have the same name,
the tool automatically selects the
shortest waler based on the actual
length measured between the input
points.

Typically, you can specify the same
waler with a unique name and a
common name. This way you can
select the common name and let the
system select the waler based on the
input length. By selecting the unique
name you can force the usage of a
certain waler configuration.

MaxLength Maximum possible effective length of
the waler, measured from the first
input point to the second input points
(=clamp locations), typically little less
than the physical length.

MinLength Minimum length of a waler with
variable length. For fixed length
walers, leave the value empty or give
same value as for the maximum
length.

BeamName Name of the clamp custom part 1.
BeamAttributes Property file saved in the component

dialog box to be used when the
custom part is inserted in the model.

BeamPlanePosition This is Position in plane when the
custom part is inserted in the face
view of the main formwork panel.

BeamPlaneOffset This is Offset in plane when the
custom part is inserted in the face
view of the main formwork panel.

BeamRotation This is Rotation when the custom
part is inserted in the face view of the
main formwork panel.

BeamRotationOffset This is Rotation offset when the
custom part is inserted in the face
view of the main formwork panel.

BeamDepthPosition This is Position in depth when the
custom part is inserted in the face
view of the main formwork panel.
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Definition Description
BeamDepthOffset This is Offset in depth when the

custom part is inserted in the face
view of the main formwork panel.

BeamStartOffset Offset of the first insertion point in
relation to Input point 1.

BeamEndOffset Location of the second insertion point
in relation to the Input point 1.

Clamp1Name Name of the clamp 1 custom part.
Clamp1Attributes Property file saved in the component

dialog box to be used when the
custom part will be inserted in the
model.

Clamp1StartOffset Offset of the first insertion point in
relation to Input point 1.

Clamp1EndOffset Location of the second insertion point
in relation to the Input point 1.

Clamp1... For custom clamp 1, you can specify
the same fields as for waler beam
custom part.

Clamp2Name Name of the clamp 2 custom part.
Clamp2Attributes Property file saved in the component

dialog box to be used when the
custom part is inserted in the model.

Clamp2StartOffset Offset of the first insertion point in
relation to Input point 1.

Clamp2EndOffset Location of the second insertion point
in relation to the Input point 1.

Clamp2... For custom clamp 2, you can specify
the same fields as for waler beam and
clamp 1 custom parts.

Configure the conditions for condition placing tool

xxxx.FormworkTools.Conditions.csv
A condition in the context of the formwork tools covers the L, T and X corners,
pilasters, pour stops and columns. The final condition formwork is divided into
two or more sub-assemblies depending on the condition type.

If you define condition configurations manually:

1. Model the full condition assembly using the custom parts, beams and/or
filler tools.

2. Create the necessary sub-assemblies using the two wizards. Split the
content of the complete condition to named sub-assemblies. When these
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sub-assemblies are inserted in the model, the final location is parametric
in the sense that the location depends on the actual geometry of the
concrete structure.

3. Insert a new condition specification in the condition configuration file.

The formwork condition placing tool supports the following condition types:

Definition Description
L corner (L) For L corner, you can specify the inner

corner sub-assembly (1) and the
exterior corner sub-assembly (2).

The corner sub-assembly is defined
with the Corner sub-assembly
wizard.

With the wizard you can specify two
sets of formwork items, which will be
rotated according to the joining walls
when the corner is placed in the
model. The two corner sub-
assemblies 1 and 2 are inserted
according to the thickness of the
joining walls.

T corner (T) For T corner, you can specify two
inner corners (1+2) and the back
panel (3).
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Definition Description
The corner sub-assembly is defined
with the Formwork corner sub-
assembly wizard.

The back panel sub-assembly is
defined with the Formwork sub-
assembly wizard, and it contains a
single insertion point + direction.

When the T corner is placed in the
model, the insertion point of the
panel sub-assembly is located at the
intersection of the joining wall center
line and the exterior face of the
horizontal wall.

X corner (X) For X corner, you can specify the four
inner corners (1-4).

Corner pilaster (CP) For corner pilaster, you can specify
one inner corner sub-assembly (1)
and three external corner sub-
assemblies (2-4).

Pilaster (P) For pilaster, you can specify two inner
corners (1 and 4), two external
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Definition Description
corners (2 and 3), and the back panel
(5).

Pilaster inside corner (IP) For inner pilaster, you can specify one
external corner (1) and three inner
corners (2-3).

Bulkhead (B) For bulkhead, you can specify two
external corners (1 and 2) and two
middle panels (3 and 4). Panel 4 will
be located at end of pour and all
other sub-items will be offset by the
given dimension.
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Definition Description
Column (COL) For column, you can specify four

panel assemblies and/or four corner
assemblies.

Create a corner sub-assembly

Corner sub-assembly is the building block for one side of the L corner or any
of the inner corners in the T and X corners.

1. First model all the needed formwork objects. Only beams and/or custom
parts can be used for modeling, so if you have other components, you
need to explode them.

2. Decide which object should rotate with the first direction, and which
objects should rotate with the second edge at the corner if/when the
corner angle varies.

3. Start the Formwork corner sub-assembly wizard tool.

4. Pick the corner point as shown below.

5. Pick a point to identify the first direction.
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6. Select the corner parts (custom parts and/or beams) at the first side of the
corner.

7. Pick a point to identify the second direction.

8. Select the corner parts (custom parts and/or beams) at the second side of
the corner.

9. Enter a name and click Finish to save the detailed half of the corner into
an external file.

Note that the wizard should be run separately for the inner corner (red dots)
and external corner (blue dots). Ensure that you do not include same objects
twice as that would lead to duplicate objects in the model.

Create a panel sub-assembly

The panel sub-assembly is the building block of the formwork at the back side
of the T corner and at pilasters.

1. First model all the needed formwork objects (custom parts and/or
beams).

2. Start the Formwork sub-assembly wizard tool.

3. Pick the center point of the object at the back of the wall as shown below.
This will be used as the insertion point when this panel sub-assembly is
inserted in an actual T corner.

4. Pick a point to identify the direction.

5. Select the formwork parts (custom parts and/or beams) forming the panel
sub-assembly.

6. Enter a name and click Finish to save the detailed panel and accessories
into an external file.

Control the behavior of conditions with mirroring

When you define the corner sub-assemblies, it can be that the left-hand side
corner needs to be placed in a right-hand side location. When this happens,
the corner sub-assembly needs to be mirrored. Mirroring custom parts or
formwork items is not always possible, especially when the part is not
symmetric in any direction. The condition placing tool can use four different
methods for mirroring. With the configuration file
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xxxxx.SubAssemblyItems.ini you can control which method will be used
for a certain corner sub-assembly case. The file contains the mirroring method
keyword, and after the keyword you can introduce the names of the items or
partial name tags to identify multiple matching items.

Mirroring method Description
Move Default method.

The custom part or formwork item is
moved by an offset measured from
the mirroring line to the center of the
custom part or formwork item.

RotateAroundZ Input points are rotated 180 degrees
around the center point at the
mirroring line.

RotateAroundAxis Input points are first rotated 180
degrees around the mirroring line
and then the custom part is rotated
180 degrees around the input axis.

Mirror Input point locations are mirrored
and then the start and end points are
swapped.

FlipLocalXY Custom part or formwork item is
moved and the local x and y axis at
center are flipped (=rotated around
local z 180 degrees).
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Mirroring method Description
FlipLocalXZ Item or custom part is moved and

local x and z axis at center are flipped
(=rotated around local y 180 degrees).

FlipLocalYX Item or custom part is moved and
local y and z axis at center are flipped
(=rotated around local x 180 degrees).

TurnUpSideDown Item or custom part is moved and the
mirroring is done by turning the
component upside down in the global
vertical direction.

An example of the content in a configuration xxxxx.SubAssemblyItems.ini
file.

// This file allows you to define how items and custom parts in corner 
sub assemblies
// are handled when placing the right handed corner into left handed 
situation or vice versa.
//
// By default items are just moved and no true mirroring happens. In 
following lines you can specify
// the mirroring methods used for certain items or custom parts. You can 
introduce full names or partial names.
//
// The possible methods are:
//  #Mirror - input points are mirrored 
//  #RotateAroundAxis - input points are mirrored and the item/custom 
part is rotated 180 degrees around the axis:
//  #RotateAroundZ - input points are rotated 180 degrees around the 
center point
//  #FlipLocalXY - the item/custom part is moved and local X and Y axis's 
at center are flipped (=rotated around local Z 180 degrees)
//  #FlipLocalXZ - the item/custom part is moved and local X and Z axis's 
at center are flipped (=rotated around local Y 180 degrees)
//  #FlipLocalYZ - the item/custom part is moved and local Y and Z axis's 
at center are flipped (=rotated around local X 180 degrees)
//  #TurnUpSideDown - the item/custom part is moved and "mirroring" is 
done by turning the component up-side.down
//
// Just list the names or partial names following the method keyword. Do 
not change the key words.
//

#Mirror
_FIXING_BOLT

#RotateAroundAxis
DOKA-3D-583002000

#RotateAroundZ
_INSIDE
_OUTSIDE
_CORNER
_LEFT
_RIGHT

#FlipLocalXY

#FlipLocalXZ
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#FlipLocalYX

#TurnUpSideDown

Configure the fillers for the filler placing tool

xxxx.FormworkTools.Fillers.csv
With the filler placing tool you can create a filler by inserting timber beams or
plywood and timber studs, and/or specific custom parts in the model. The
creation of these model objects depends on the actual space to be filled. The
basic principle of the creation of the various filler items is the following:

• If the space to be filled is larger than the given minimum plywood width,
the filler tool will create the plywood (=contour plate) and the timber studs.

• If the space to be filled is smaller than the minimum plywood width, or
plywood is not specified, the actual space is filled by one or more timber
beams or custom parts. The target is to fill the actual space as completely
as possible. The largest beams and/or custom parts are preferred and
smaller pieces are created only when the space is smaller than the size of
the larger pieces.

Filler built with
plywood and studs

Filler built with timber
beams

Filler built with custom
part

To configure the filler tool, you can specify the properties for timber beam,
plywood, and settings for one to ten alternatives of custom parts.
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Definition Description
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Unique filler name.
TimberWidths List of available timber beam widths

(10 20 50 100).
TimberDepth Depth of the timber beam.
TimberAssPrefix Assembly prefix.
TimberAssStartNo Assembly start number.
TimberPartPrefix Part prefix.
TimberPartStartNo Part start number.
TimberName Name of the timber beam.
TimberClass Class of the timber beam.
TimberFinish Finish of the timber beam.
TimberMaterial Material of the timber beam.
StudWidth Width of the timber stud.
StudDepth Depth of the timber stud.
StudAssPrefix Assembly prefix.
StudAssStartNo Assembly start number.
StudPartPrefix Part prefix.
StudPartStartNo Part start number.
StudName Name of the timber stud.
StudClass Class of the stud.
StudFinish Finish of the stud.
StudMaterial Material of the stud.
PlywoodWidth Minimum width of the plywood. The

actual width depends on the actual
space to be filled.

PlywoodThickness Thickness of the plywood.
PlywoodAssPrefix Assembly prefix.
PlywoodAssStartNo Assembly start number.
PlywoodPartPrefix Part prefix.
PlywoodPartStartNo Part start number.
PlywoodName Name of the plywood part.
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Definition Description
PlywoodClass Class of the plywood part.
PlywoodFinish Finish of the plywood part.
PlywoodMaterial Material of the plywood part.
Part1Name Name of the custom part 1.
Part1Attributes Property file saved in the component

dialog box to be used when the
custom part is inserted in the model.

Part1PlanePosition This is Position in plane when the
custom part is inserted in the face
view of the main formwork panel.

Part1PlaneOffset This is Offset in plane when the
custom part is inserted in the face
view of the main formwork panel.

Part1Rotation This is Rotation when the custom
part is inserted in the face view of the
main formwork panel.

Part1RotationOffset This is Rotation offset when the
custom part is inserted in the face
view of the main formwork panel.

Part1DepthPosition This is Position in depth when the
custom part is inserted in the face
view of the main formwork panel.

Part1DepthOffset This is Offset in depth when the
custom part is inserted in the face
view of the main formwork panel.

Part1StartOffset Offset of the first insertion point in
relation to Input point 1.

Part1EndOffset Offset of the first insertion point in
relation to Input point 2.

Part1Length Length of the custom part which is
also the space to fill if/when this
custom part is added to the model.

Part1Height Height of the custom part.
Part1LengthProperty Name of the length property of the

custom part, if you are using a
custom part whose length/width can
be can be varying and/or parametric.

The fields can be set also for Part2,
Part3, and so on. You can configure
multiple parts with separate
additional rows. You need to keep the
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Definition Description
Supplier, Family, and Name the
same as on the first row.

Part1LengthMin Minimum length/width (the free gap
to fill) the product can fill, if you are
using a custom part whose length/
width can be can be varying and/or
parametric.

The fields can be set also for Part2,
Part3, and so on. You can configure
multiple parts with separate
additional rows. You need to keep the
Supplier, Family, and Name the
same as on the first row.

Part1LengthMax Maximum length/width the product
can fill, if you are using a custom part
whose length/width can be can be
varying and/or parametric.

The fields can be set also for Part2,
Part3, and so on. You can configure
multiple parts with separate
additional rows. You need to keep the
Supplier, Family, and Name the
same as on the first row.

Part1HeightProperty Name of the height property of the
custom part, if you are using a
custom part whose length/width can
be can be varying and/or parametric.

The fields can be set also for Part2,
Part3, and so on. You can configure
multiple parts with separate
additional rows. You need to keep the
Supplier, Family, and Name the
same as on the first row.

Part2... Part3... Part10... In addition to the custom part 1, you
can specify up to nine other custom
parts. In practice, at least the
PartXLength needs to be different
for all specified custom parts. The
tool selects the part with the most
suitable length depending on the
actual space to be filled.
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Formwork placing tools - Slabs
Formwork placing tools - Slabs is a set of components that helps in detailed
modeling of typical slab formwork. These components are placing tools, and
therefore you need to have all relevant formwork products such as panels,
girders, and shuttering props available in the Applications & components
catalog.

You can get the formwork products provided by formwork suppliers from
Tekla Warehouse, for example. In addition, Formwork placing tools - Slabs
requires additional configuration files that contain the necessary information
about the formwork product components. These configuration files may come
with the formwork product catalogs provided by formwork suppliers, but you
can create the configuration files yourself as well.

Formwork placing tools - Slabs contains tools to place and modify the
following formwork elements:

• formwork slab panels typically appearing as two-dimensional arrays
covering a certain area

• cross and main girders supporting the slab panels

• shuttering props supporting the girders or slab panels directly depending
on the formwork system

• stop ends on top of slab panels

• safety railings in the outer edges of the slab panel area

Because Formwork placing tools - Slabs consists of a set of sub-tools which
are combined in one dialog box, each tab is an individual sub-tool. Both the
Formwork placing tools - Slabs and the sub-tools are available in
Applications and components catalog.

Most of the settings in the components are preset. You can control the
different settings by selecting a suitable options in the dialog box. These preset
settings are organized according to the formwork supplier and the product
families.

However, if you create your own configuration files, you can use the values in
the configuration files instead of the preset values.

You can access the Formwork placing tools - Slabs in the Concrete
Contractor, General Contractor and Rebar Detailer roles in the Default
environment.

Panel tab

Use the Panel tab to model an area of formwork panels for slabs.

1. On the Panel tab, in the Formwork supplier and Product family list,
select the suitable options.

The options vary depending on which catalogs and tool configurations you
have in use.
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2. Select the panel size in the Formwork panel list, and set the other panel
properties.

3. Click Apply and Insert new to start placing the slab panels.

4. Hover the mouse pointer on top of the slab to identify the bottom surface.

5. Select the slab and pick three or more points to identify the area on the
surface. A preview of the panels is shown while you pick the points.

Alternatively, hold down the Alt key and select the surface to create
panels on the whole surface.

6. To finish, click the middle mouse button.

7. If you need to modify the panel, drag the corner points.

Cross girders and Main girders tabs

Use the Cross girders and Main girders tabs to create cross and main girders
in two directions, or only main girders, or no girders at all.

1. On the Cross girders or on the Main girders tab, select the girder in the
Girder name list.

2. Enter an Overlap value. If you leave the value empty, the tool sets it
automatically.

3. Enter the girder Length, if the girder length is not fixed. Use space as a
separator if you need to have girders with different lengths.

a. To create girders at once, select the panel area, and click Apply and
Add to selected.

The Add shoring dialog box opens.
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b. Set the girder offset and spacing.

You can also select the option whether to create girders at the panel
area edges, and the girder layout at the panel seam.

c. Click Create.

a. To create a single line of girders, click Apply and Insert new.

b. Pick the girder points.

c. To finish, click the middle mouse button.

Shuttering tab

Use the Shuttering tab to create shuttering props, shuttering bases, and
shuttering heads.

1. On the Shuttering tab, select the prop name in the Girder name list, the
prop head name in the Head name list, and the prop base name in the
Base name list.

2. Enter the total height for the prop.

• To create multiple shuttering props, select the panel area and click
Apply and Add to selected.

The shuttering props are created.

• To create a single shuttering prop, click Apply and Insert new. Pick the
shuttering prop location.
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Stop ends tab

Use the Stop ends tab to create stop ends around the slab panel.

1. On the Stop ends tab, select the stop end name in the Stop end name
list.

2. Enter the offset and spacing for the stop ends.

3. Click Apply and Insert new to start inserting the stop ends.

• If no panel is selected, first select the slab panel.

• If you have already selected the slab panel, you do not need to do it
again.

4. Pick the start point and the end point for the stop end.

5. To finish, click the middle mouse button.
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Railings tab

Use the Railings tab to create railings around the slab.

1. On the Railings tab, select the railing name in the Railing name list.

2. Enter the offset and spacing for the railings.

3. Click Apply and Insert new to start inserting the railings.

4. • If the panel is selected, first select the slab panel.

Depending on the railing type, you may need to select the top face of
the slab, side face of the wall, or the slab panels.

• If you have already selected the slab panel, you do not need to do it
again.

5. Pick the start point and the end point for the railing.

6. To finish picking, click the middle mouse button.
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Contextual toolbar for formwork slab panel

When you select a slab panel, the following contextual toolbar appears and
you can modify the parts:

Option Description
Modify the boundary of the panel
area and openings. Move edges or
points by dragging, or insert new
points by dragging the insertion
points at the middle of the edges.

In addition, you can move the start
point, which is the corner of the
panel, and direction of the panel by
dragging the handles.
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Option Description
Modify the panel width and length in
the panel array.
Add new rectangular openings in the
panel area. After adding a rectangular
opening, you can edit the opening to
any shape.

Typically, the openings are larger
areas where the panels are not
needed. To replace the regular panel
with some special infill parts, use the
single panel removal tool .

Remove or restore single panels in
the area. Select the panels to be

removed and click .

Select multiple panels by holding
down the Shift key when clicking the
panels. Hold down the Ctrl key to
unselect the panels.

Modify cross girders.

To modify a single girder line, select
the line to modify it.
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Option Description
Modify main girders.

To modify a single girder line, select
the line to modify it.
Modify shuttering props in the panel
area.

You can

• move the individual props by
dragging the handles. Hold down
the Ctrl key to create a copy of the
prop.

• move a whole line of props by
dragging the line handles. Hold
down the Ctrl key to create a copy
of all the props in the line.

• change the shuttering prop head
or base for shuttering props on all
selected points and/or lines.

Note that props created for the girder
lines can only be moved/copied along
the girder line.

Formwork placing tools - Slabs: configuration
You can set up your own configuration files for Formwork placings tools -
Slabs.

The configuration is done by using comma separated files (.csv), which can be
edited with Microsoft Excel or any standard text editor. Each separate
formwork sub-tool component has its own configuration file.

The configuration files can be located in any of the system folders, or in the
sub-folder called Formwork tools in the current model folder.
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Example configuration files are located in the ...\ProgramData\Trimble
\Tekla Structures\<version>\Environments\common\system\CIP
\Formwork folder.

The configuration files are typically named by the formwork supplier and/or
the product families. There can be any number of files, and the files are
identified with a specific suffix. Each of the files controls one of the sub-tools in
the component. The files contain a varying number of columns.

Use the following configuration files for Formwork placings tools - Slabs to
set up

• panels: xxxx.FormworkTools.SlabPanels.csv
• girders: xxxx.FormworkTools.Girders.csv
• prop parts of shuttering props: xxxx.FormworkTools.Props.csv
• prop bases of shuttering props: xxxx.FormworkTools.PropBases.csv
• prop heads of shuttering props: xxxx.FormworkTools.PropHeads.csv
• stop ends: xxxx.FormworkTools.StopEnds.csv
• safety railings: xxxx.FormworkTools.Railings.csv

Accessories in formwork placing tools

You can set up any formwork accessory to be created as a beam, an item, or as
a custom part. For beams and items you can additionally set up any of the
beam or items properties or UDAs either in the configuration file by adding
new columns, or as property files.

Each configuration file contains a header row and data rows. The header row is
the first row that is not a comment row, and it gives the configuration
parameter names (column name). Each data row gives one product and
defines the parameters used when placing the beam, item or custom part.

In addition to header row and data rows the file can contain comment rows. A
comment row is any row starting with text //.

You can define the distance unit by adding a row:

DISTANCE_UNIT=MM
When the distance unit is defined using the above setting, all distance values
can be given as decimal values in the specified units. The supported units are:
MM, DN, CM, M, INCH, FEET.

The following accessories are available for different Formwork placings tools
- Slabs product types.

Product type Accessory
Panel Panel

Part

Concrete components 3100 Concrete detailing



Product type Accessory
Girder Girder

Beam
Prop Prop
Base Base
Head Head
Stop end Sheet

Angle
Railing Post

Shoe
ToeBoard
GuardRail

Common configuration parameter fields

To configure the accessories in any of the formwork product types, define the
following fields in the .csv configuration file.

The text [Accessory] in the following table denotes the accessory in
question.

Column name in the .csv file Description
[Accessory].Profile
[Accessory].Item
[Accessory].CustomPart

Formwork placing tools can place
either beams, items, or custom parts
to the model.

If all products are of the same model
object type you can use one of the
three field names and give the
corresponding data value.

The field name specifies the model
object default type but you can also
override the model object type by
adding the prefix BEAM:, ITEM: or
CUSTOMPART: for the actual value.

The actual value for BEAM: is a valid
profile string, for ITEM: a valid item
shape name, and for CUSTOMPART: a
valid custom part name.

[Accessory].Attributes Saved property file used to set either
part, item or custom part properties.

[Accessory].Name Name of the part or the item, or the
Name property of the custom part.
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Column name in the .csv file Description
[Accessory].Class Class of the part or the item, or the

Class property of the custom part.
[Accessory].Material Material of the part or the item, or the

Material property of the custom part.
[Accessory].AssPrefix Part or item numbering assembly

prefix, or the AssPrefix property of
the custom part.

[Accessory].AssStartNo Part or item assembly start number,
or the AssStartNo property of the
custom part.

[Accessory].PartPrefix Part or item numbering part prefix, or
the PartPrefix property of the
custom part.

[Accessory].PartStartNo Part or item part start number, or the
PartStartNo property of the custom
part.

[Accessory].Finish Finish of the part or the item, or the
Finish property of the custom part.

[Accessory].InputOrder Set the final locations of the input
points in relation to the default
generic start and end points.

The possible values are:

• StartEnd: default if no other
value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.

• CenterLeft: the first input point
is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
point and the second point is at
the right point.
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Column name in the .csv file Description
• CenterUp: the first input point is

at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.

[Accessory].PlanePosition This is Position in plane when the
beam, item, or custom part is inserted
in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

[Accessory].PlaneOffset Offset on plane. The default value is
0.

[Accessory].Rotation This is Rotation when the custom
part is inserted in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

[Accessory].RotationOffset Rotation offset in degrees. The
default value is 0.
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Column name in the .csv file Description
[Accessory].DepthPosition This is Position at depth when the

beam, item, or custom part is inserted
in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

[Accessory].DepthOffset Offset at depth. The default value is 0.
[Accessory].StartOffset Offset of the actual start point from

the generic start point in the local
coordinate system.

Give the offset as x, y and z values
that are separated by a space or a
colon, and enclosed in parentheses (0
100 0). If no value is given, a zero
offset (0 0 0) is used.

[Accessory].EndOffset Offset of the actual end point from
the generic end point in the local
coordinate system.

Give the offset as x, y and z values
that are separated by a space or a
colon, and enclosed in parentheses (0
100 0). If no value is given, a zero
offset (0 0 0) is used.

[Accessory].UDA.XXXXXX Define additional UDA values applied
to the model objects. You can
introduce as many UDA values as
needed.

Note that the UDA name (XXXXX)
must be the internal name, not the
localized name shown in the user
interface.

Configure the slab panel placing tool

.FormworkTools.SlabPanels.csv
Add one row for each panel. Specify columns as follows. For a slab panel, you
can specify one custom part that is placed if the panel is a full panel, and part
properties used for placing a filler part at locations where the panel is not a full
panel.

The configuration is done in the local coordinate system of the panel. The
origin of the panel is located at the center point of the top of the panel.
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Row Definition
Supplier Supplier name, this is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Unique panel name, which is shown
in the Formwork panel list.

PanelName Name of the custom part that will be
inserted in the model.

This is the custom part that the panel
configuration will use.

PanelAttributes Property file saved in the component
dialog box to be used when the
custom part is inserted into model.

PanelInputOrder Define the orientation of the custom
part panels by specifying where the
start and end handles of the custom
part will go.

Set the final locations of the input
points in relation to the default
generic start and end points.

The possible values are:
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Row Definition
• StartEnd: default if no other

value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.

• CenterLeft: the first input point
is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.
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Row Definition

PanelPlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT and
RIGHT.

PanelPlaneOffset Offset on plane. The default value is
0.

PanelRotation Use Rotation to insert the custom
part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

PanelRotationOffset Rotation offset in degrees. The
default value is 0.

PanelDepthPosition Use Position at depth to insert the
custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

PanelDepthOffset Offset at depth. The default value is 0.
PanelStartOffset PanelStartOffset and

PanelEndOffset change the
location of the actual start and end
handles of the custom part.

PanelStartOffset is the offset of
the actual start point from the generic
start point in the local coordinate
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Row Definition
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

PanelEndOffset PanelEndOffset is the offset of the
actual end point from the generic end
point in the local coordinate system.
Give the offset as x, y and z values
that are separated by a space or a
colon, and enclosed in parentheses (0
100 0). If no value is given, a zero
offset (0 0 0) is used.

LengthProperty The name of the length property in
the custom part. If the length is fixed,
this is empty.

LengthValue Length of the panel.

Note that the length value is read
from the .csv file.

WidthProperty The name of the width property in the
custom part. If the width is fixed, this
is empty.

WidthValue Width of the panel.

Note that the width value is read from
the .csv file.

ThicknessProperty The name of the thickness property in
the custom part. If the thickness is
fixed, this is empty.

ThicknessValue Thickness of the panel.

Note that the thickness value is read
from the .csv file.

CrossGirderX The girder values control the default
spacing of the girders visible in the
Add shoring dialog box. The values in
the .csv file are taken from the
center of the panel.

CrossGirderX specifies the default x
locations of the cross girders. Values
must be enclosed in parentheses ()
and separated by spaces.

MainGirderY MainGirderY specifies the default y
locations of the main girders. Values
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must be enclosed in parentheses ()
and separated by spaces.

PartName The following part properties refer to
the properties of the defined filler
parts used when the custom parts
cannot fill the whole slab area.

Name of the panel part (contour
plate).

PartClass Class of the part.
PartFinish Finish of the part.
PartMaterial Material of the part.
PartThickness Thickness of the part.
PartAssPrefix Assembly prefix.
PartAssStartNo Assembly start number.
PartPartPrefix Part prefix.
PartPartStartNo Part start number.

Configure the girder line tool

.xxxx.FormworkTools.Girders.csv
For a girder, you can specify either a custom part or a beam which is placed in
the model.

The position settings are given in the local coordinate system of the girder.
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Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Girder name, which is shown in the
Girder name list.

This name can be unique, or you can
specify two or more girders with the
same name. If one girder name has
two or more specifications, the
placing tool may create a line
containing girders with variable
lengths.

Type The type of the girder. The type
defines the list in which the girder is
shown. The options are: CROSS, MAIN
and ANY.

Length Length (x) of the girder.

Note that the length value is read
from the .csv file.

Width Width (y) of the girder.

Note that the value is read from
the .csv file.

Depth Depth (z) of the girder.

Note that the depth value is read
from the .csv file.

MinLength If the length varies, this is the
minimum length of the girder.

MaxLength If the length varies, this is the
maximum length of the girder.

MinOverlap When two or more girders are placed
in one girder line, the girders can
overlap to achieve the exact start and
end for the line. The MinOverlap
value controls the minimum overlap.

MaxOverlap When two or more girders are placed
in one girder line, the girders can
overlap to achieve the exact start and
end for the line. The MaxOverlap
value controls the maximum overlap.
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If the girders should not overlap,
enter 0 as the value.

InputPointLocation The depth location of girder input
points. The options are:

• CrossGirderBottom (only for
main girders)

• SlabBottom
• SlabTop

GirderName Name of the custom part that will be
inserted in the model.

This is the custom part that the girder
configuration will use.

GirderAttributes Property file saved in the component
dialog box to be used when the
custom part is inserted into model.

GirderInputOrder Define the orientation of the custom
part girders by specifying where the
start and end handles of the custom
part will go.

Set the final locations of the input
points in relation to the default
generic start and end points.

The possible values are:

• StartEnd: default if no other
value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.

• CenterLeft: the first input point
is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
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point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.

GirderPlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

GirderPlaneOffset Offset on plane. The default value is
0.

GirderRotation Use Rotation to insert the custom
part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.
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GirderRotationOffset Rotation offset in degrees. The

default value is 0.
GirderDepthPosition Use Position at depth to insert the

custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

GirderDepthOffset Offset at depth. The default value is 0.
GirderStartOffset GirderStartOffset and

GirderEndOffset change the
location of the actual start and end
handle points of the custom part.

GirderStartOffset is the offset of
the actual start point from the generic
start point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

GirderEndOffset GirderEndOffset is the offset of the
actual end point from the generic end
point in the local coordinate system.
Give the offset as x, y and z values
that are separated by a space or a
colon, and enclosed in parentheses (0
100 0). If no value is given, a zero
offset (0 0 0) is used.

GirderLengthProperty The name of the length property in
the custom part. If the length is fixed,
this is empty.

GirderWidthProperty The name of the width property in the
custom part. If the width is fixed, this
is empty.

GirderDepthProperty The name of the depth property in
the custom part. If the width is fixed,
this is empty.

BeamName Name of the girder part (beam).
BeamProfile Profile of the beam. If this is empty,

the beam is not created.
BeamClass Class of the girder part.
BeamFinish Finish of the girder part.
BeamMaterial Material of the girder part.

Concrete components 3113 Concrete detailing



Row Definition
BeamThickness Thickness of the girder part.
BeamAssPrefix Assembly prefix.
BeamAssStartNo Assembly start number.
BeamPartPrefix Part prefix.
BeamPartStartNo Part start number.

Configure the shuttering prop placing tool

xxxx.FormworkTools.Props.csv
For a prop, you can specify a custom part that is placed in the model. In
addition, a shuttering prop may contain the base and head parts, but these
are configured in separate files (xxxx.FormworkTools.PropBases.csv and
xxxx.FormworkTools.PropHeads.csv).

The position settings are given in the local coordinate system of the prop.

Row Definition
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.
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Name Prop name, which is shown in the

Prop name list. This name can be
unique, or you can specify two or
more props with the same name. If
one prop name has two or more
specifications, the placing tool can
select the suitable prop based on the
effective height of the shuttering.

MinHeight The height of the prop from the
bottom of the base prop to the
bottom of the concrete slab.

If the length varies, this is the
minimum length. For a prop with
fixed height the MinHeightand
MaxHeight are same.

MaxHeight If the length varies, this is the
maximum length.

PropInputPoint The location of the first input point of
the custom part. The options are:

• BaseBottom
• BaseTop
• HeadBottom
• GirderBottom
• GirderTop
• SlabBottom
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PropInputPoint2 The location of the second input point
of the custom part.

If you use value None, the second
input point is calculated as an offset
PropEndOffset from the first input
point.

PropHeightProperty The name of the prop height property
in the custom part. This is empty if
the height is not parametric.

PropName The name of the custom part that will
be inserted in the model.

This is the custom part that the prop
configuration will use.

PropAttributes Property file saved in the component
dialog box to be used when the
custom part is inserted into model.
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PropInputOrder Define the orientation of the custom

part prop by specifying where the
start and end handles of the custom
part will go.

Set the final locations of the input
points in relation to the default
generic start and end points.

The possible values are:

• StartEnd: default if no other
value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.

• CenterLeft: the first input point
is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.
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PropPlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

PropPlaneOffset Offset on plane. The default value is
0.

PropRotation Use Rotation to insert the custom
part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

PropRotationOffset Rotation offset in degrees. The
default value is 0.

PropDepthPosition Use Position at depth to insert the
custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

PropDepthOffset Offset at depth. The default value is 0.
PropStartOffset PropStartOffset and

PropEndOffset change the location
of the actual start and end handle
points of the custom part.

PropStartOffset is the offset of the
actual start point from the generic
start point in the local coordinate
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system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

PropEndOffset PanelEndOffset is the offset of the
actual end point from the generic end
point in the local coordinate system.
Give the offset as x, y and z values
that are separated by a space or a
colon, and enclosed in parentheses (0
100 0). If no value is given, a zero
offset (0 0 0) is used.

If the PropEndOffset value is not
given, or the value None is used,
PropEndOffset is an offset from the
first input point to the second input
point.

Configure the base parts of the shuttering prop placing tool

xxxx.FormworkTools.PropBases.csv
For a shuttering prop, you can specify an additional custom part that is placed
in the model at the bottom end of the prop.

The position settings are given in the local coordinate system of the prop.

Row Definition
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Unique prop base name, which is
shown in the Base name list.

PropInputPoint The location of the first input point of
the custom part. The options are:

• BaseBottom
• BaseTop
• HeadBottom
• GirderBottom
• GirderTop
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• SlabBottom

PropOffset Automatic offset (shortening) of the
prop if the base part is created.

BaseName Name of the custom part that will be
inserted in the model.

BaseAttributes Property file saved in the component
dialog box to be used when the
custom part is inserted into model.

BaseInputPoint The location of the first input point of
the custom part. The options are:

• BaseBottom
• BaseTop
• HeadBottom
• GirderBottom
• GirderTop
• SlabBottom
The second input point of the custom
part is calculated as an offset
BaseEndOffset from the first input
point.
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PropInputOrder Set the final locations of the input
points in relation to the default
generic start and end points.

The possible values are:

• StartEnd: default if no other
value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.
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• CenterLeft: the first input point

is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.

BasePlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

BasePlaneOffset Offset on plane. The default value is
0.
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BaseRotation Use Rotation to insert the custom

part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

BaseRotationOffset Rotation offset in degrees. The
default value is 0.

BaseDepthPosition Use Position at depth to insert the
custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

BaseDepthOffset Offset at depth. The default value is 0.
BaseStartOffset BaseStartOffset is the offset of the

actual start point from the generic
start point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

BaseEndOffset BaseEndOffset specifies the
location of the second input point of
the custom part in relation to the first
input point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, zero offset (100 0 0) is used.

Configure the head parts of the shuttering prop placing tool

xxxx.FormworkTools.PropHeads.csv
For a shuttering prop, you can specify an additional custom part that is placed
in the model at the top end of the prop.

The position settings are given in the local coordinate system of the prop.

Row Definition
Supplier Supplier name, which is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.
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Name Unique prop head name, which is

shown in the Head name list.
PropOffset Automatic offset (shortening) of the

prop if the head part is created.
AutoRotate Control whether the head part is

rotated automatically 90 degrees
around the prop axis when the head
is located at the overlap of two
girders.

Set this value to YES to get the head
rotated 90 degrees. Note that this
only controls the rotation when you
have not given any specific value for
the rotation in the dialog box.

HeadName Name of the custom part that will be
inserted in the model.

HeadAttributes Property file saved in the component
dialog box to be used when the
custom part is inserted into model.

HeadInputPoint The location of the first input point of
the custom part. The options are:

• HeadBottom
• HeadTop
• HeadBottom
• GirderBottom
• GirderTop
• SlabBottom
The second input point of the custom
part is calculated as an offset
HeadEndOffset from the first input
point.
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HeadInputOrder Set the final locations of the input
points in relation to the default
generic start and end points.

The possible values are:

• StartEnd: default if no other
value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.
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• CenterLeft: the first input point

is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.

HeadPlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

HeadPlaneOffset Offset on plane. The default value is
0.
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HeadRotation Use Rotation to insert the custom

part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

HeadRotationOffset Rotation offset in degrees. The
default value is 0.

HeadDepthPosition Use Position at depth to insert the
custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

HeadDepthOffset Offset at depth. The default value is 0.
HeadStartOffset HeadStartOffset is the offset of the

actual start point from the generic
start point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

HeadEndOffset HeadEndOffset specifies the
location of the second input point of
the custom part in relation to the first
input point in the local coordinate
system. The offset is given as x, y and
z values separated by a space or a
colon, and enclosed in parentheses (0
100 0). If no value is given, zero offset
(100 0 0) is used.

Configure the stop end custom parts for the stop end placing tool

xxxx.FormworkTools.StopEnds.csv
For a stop end, you can specify two custom parts: a sheet and an angle. The
sheet is typically the actual form piece, and the angles are placed with a
spacing to support the sheet.

The position settings are given in the local coordinate system of the stop end.
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Supplier Supplier name, this is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Unique stop end name, which is
shown in the Stop end name list.

MinLength Minimum length of the stop end
sheet part.

MaxLength Maximum length of the stop end
sheet part.

Width Total width of the stop end including
the angles.

Depth Total depth of the stop end.
AngleSpacing Default spacing of the angle parts.

This will be used if you do not specify
any value for the spacing.

SheetName Name of the custom part that will be
inserted in the model.

SheetAttributes Property file saved in the component
dialog box to be used when the
custom part is inserted into model.
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SheetInputOrder Set the final locations of the input

points in relation to the default
generic start and end points.

The possible values are:

• StartEnd: default if no other
value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.

• CenterLeft: the first input point
is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.
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SheetPlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

SheetPlaneOffset Offset on plane. The default value is
0.

SheetRotation Use Rotation to insert the custom
part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

SheetRotationOffset Rotation offset in degrees. The
default value is 0.

SheetDepthPosition Use Position at depth to insert the
custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

SheetDepthOffset Offset at depth. The default value is 0.
SheetStartOffset SheetStartOffset is the offset of

the actual start point from the generic
start point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

Concrete components 3130 Concrete detailing



Row Definition
SheetEndOffset SheetEndOffset specifies the

location of the second input point of
the custom part in relation to the first
input point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, zero offset (100 0 0) is used.

AngleName Name of the custom part that will be
inserted in the model.

AngleInputOrder Set the final locations of the input
points in relation to the default
generic start and end points.

The possible values are:

• StartEnd: default if no other
value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.

• CenterLeft: the first input point
is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
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point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.

AnglePlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

AnglePlaneOffset Offset on plane. The default value is
0.

AngleRotation Use Rotation to insert the custom
part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

AngleRotationOffset Rotation offset in degrees. The
default value is 0.

AngleDepthPosition Use Position at depth to insert the
custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

AngleDepthOffset Offset at depth. The default value is 0.
AngleStartOffset AngleStartOffset is the offset of

the actual start point from the generic
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start point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

AngleEndOffset This offset specifies the location of
the second input point (of the custom
part) in relation to the first input point
in the local coordinate system. The
offset is given as x, y and z values
separated by a space or a colon, and
enclosed in parentheses (0 100 0). If
no value is given, zero offset (100 0 0)
is used.

AngleEndOffset specifies the
location of the second input point of
the custom part in relation to the first
input point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, zero offset (100 0 0) is used.

Configure the railing custom parts for the railing placing tool

xxxx.FormworkTools.Railings.csv
For a railing, you can specify four custom parts. The post and the shoe parts
are placed along the input line with the defined start distance and spacing. The
toe board and one or more guard rail parts are placed between two posts. If
the toe board and/or the guard rail part is long enough compared to the post
spacing, they can span over three or more posts.

The position settings are given in the local coordinate system of the railing.
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Supplier Supplier name, this is typically the

same for all rows.

The name is shown in the Formwork
supplier list.

Family Family name, which is shown in the
Product family list.

Name Railing type name, which is shown in
the Railing name list.

You can specify multiple railings with
the same name when you have two
or more alternatives with different
lengths for the toe board and/or
guard rail.

When you have alternative lengths for
the toe board and/or guard rail, the
placing tool selects the part
automatically based on the post
spacing.
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MasterInput The location of the first input point

when placing the railing. The options
are:

• PanelTop: the first input is the
slab panel component, and the
railing is fitted on top of the
panels.

• SlabTop: the first input is the slab
or pour top face.

• SlabEdge: the first input is the
slab or pour top face, and the
railing location is the nearest edge.

• WallSide: the first input is the
wall side face. The railing is fitted
on the wall side face.

Note that if the .csv file does not
contain any value, the default value
PanelTop is used.

MainOffset The common offset of all parts (post,
shoe, and so on). The offset is a
vector with components x, y, z given
in the local coordinate system of the
railing.

PostSpacing Default spacing of the posts if no
spacing is specified.

PostSpacing Height of the post.
ToeBoardOverlap Minimum overlap of toe boards.
ToeBoardOverlapOffset Offset (x, y, z) of the toe boards when

they are overlapping.
GuardOverlap Minimum overlap of guard rails.
GuardOverlapOffset Offset (x, y, z) of the guard rails when

they are overlapping.
GuardPositions The railing can include one or more

rows of guard rails. This setting
specifies the height (z) positions of
the guard rail parts measured from
the input line. Multiple values must
be separated by a space or a colon,
and enclosed in parentheses (450 650
850).

PostName Name of the custom part that will be
inserted in the model.
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PostAttributes Property file saved in the component

dialog box to be used when the
custom part is inserted in the model.

PostPlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

PostPlaneOffset Offset on plane. The default value is
0.

PostRotation Use Rotation to insert the custom
part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

PostRotationOffset Rotation offset in degrees. The
default value is 0.

PostDepthPosition Use Position at depth to insert the
custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

PostDepthOffset Offset at depth. The default value is 0.
PostStartOffset PostStartOffset is the offset of the

actual start point from the generic
start point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

PostEndOffset PostEndOffset specifies the
location of the second input point of
the custom part in relation to the first
input point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, zero offset (100 0 0) is used.

ShoeName Name of the custom part that will be
inserted in the model.
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Row Definition
ShoeAttributes Property file saved in the component

dialog box to be used when the
custom part is inserted in the model.

ShoePlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

ShoePlaneOffset Offset on plane. The default value is
0.

ShoeRotation Use Rotation to insert the custom
part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

ShoeRotationOffset Rotation offset in degrees. The
default value is 0.

ShoeDepthPosition Use Position at depth to insert the
custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

ShoeDepthOffset Offset at depth. The default value is 0.
ShoeStartOffset ShoeStartOffset is the offset of the

actual start point from the generic
start point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

ShoeEndOffset ShoeEndOffset specifies the
location of the second input point of
the custom part in relation to the first
input point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, zero offset (100 0 0) is used.

ToeBoardName Name of the custom part that will be
inserted in the model.
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Row Definition
ToeBoardAttributes Property file saved in the component

dialog box to be used when the
custom part is inserted in the model.

ToeBoardLength The effective length of the toe board
part.

ToeBoardInputOrder Set the final locations of the input
points in relation to the default
generic start and end points.

The possible values are:

• StartEnd: default if no other
value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.

• CenterLeft: the first input point
is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.
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Row Definition

ToeBoardPlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

ToeBoardPlaneOffset Offset on plane. The default value is
0.

ToeBoardRotation Use Rotation to insert the custom
part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.

ToeBoardRotationOffset Rotation offset in degrees. The
default value is 0.

ToeBoardDepthPosition Use Position at depth to insert the
custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

ToeBoardDepthOffset Offset at depth. The default value is 0.
ToeBoardStartOffset ToeBoardStartOffset is the offset

of the actual start point from the
generic start point in the local
coordinate system. Give the offset as
x, y and z values that are separated by
a space or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.
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Row Definition
ToeBoardEndOffset ToeBoardEndOffset specifies the

location of the second input point of
the custom part in relation to the first
input point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, zero offset (100 0 0) is used.

GuardRailName Name of the custom part that will be
inserted in the model.

GuardRailAttributes Property file saved in the component
dialog box to be used when the
custom part is inserted into model.

GuardRailLength The effective length of the guard rail
part.

GuardRailInputOrder Set the final locations of the input
points in relation to the default
generic start and end points.

Note that the generic start and end
points are located in the local z
direction based on the setting.

The possible values are:

• StartEnd: default if no other
value is specified.

• EndStart: reverses the default
start/end points.

• CenterStart: the first input point
is at the center of the start/end
point and the second point is at
the start point.

• CenterEnd: the first input point is
at the center of the start/end point
and the second point is at the end
point.

• CenterLeft: the first input point
is at the center of the start/end
point and the second point is at
the left point.

• CenterRight: the first input point
is at the center of the start/end
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Row Definition
point and the second point is at
the right point.

• CenterUp: the first input point is
at the center of start/end point
and the second point is up from
the center point.

• CenterDown: the first input point
is at the center of the start/end
point and the second point is
down from the center point.

Note that if the .csv file does not
contain any value, the default value
StartEnd is used.

GuardRailPlanePosition Use the following position values to
define the custom part's position,
offset and rotation in relation to the
custom part start and end points.

Use Position in plane to insert the
custom part in the plane view.

The options are MIDDLE, LEFT, and
RIGHT.

GuardRailPlaneOffset Offset on plane. The default value is
0.

GuardRailRotation Use Rotation to insert the custom
part in the plane view.

The options are FRONT, TOP, BACK,
and BELOW.
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Row Definition
GuardRailRotationOffset Rotation offset in degrees. The

default value is 0.
GuardRailDepthPosition Use Position at depth to insert the

custom part in the plane view.

The options are MIDDLE, FRONT, and
BEHIND.

GuardRailDepthOffset Offset at depth. The default value is 0.
GuardRailStartOffset GuardRailStartOffset is the offset

of the actual start point from the
generic start point in the local
coordinate system. Give the offset as
x, y and z values that are separated by
a space or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, a zero offset (0 0 0) is used.

GuardRailEndOffset GuardRailEndOffset specifies the
location of the second input point of
the custom part in relation to the first
input point in the local coordinate
system. Give the offset as x, y and z
values that are separated by a space
or a colon, and enclosed in
parentheses (0 100 0). If no value is
given, zero offset (100 0 0) is used.

Openings
This section introduces components that can be used in concrete openings.

Click the links below to find out more:

• 3D cut (10) (page 3142)

• Opening in wall (40) (page 3144)

• Hole Generation (32) (page 3151)

• Polygon Hole Generation (33) (page 3153)

Concrete components 3142 Concrete detailing



3D cut (10)
The 3D cut (10) component creates a 3D cut to a concrete part. The cutplane is
determined by picking three points on the (concrete) part edges. The cut
direction can be set. Also an cut offset can be set.

Use for

Situation More information
This component creates a cut through
three points.

The side to be removed can be
defined.

Before you start

Before applying the macro, create the following part:

• Concrete part (panel, column, strip footing)

Defining properties

The component contains only one tab, named Picture.

Tab Content
Picture Defining the cut direction. Possibly set

an cutplane offset.

Picking order

1. Concrete part.

2. Three points to determine the cut plane.
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Picture tab

You can define the following settings on the Picture tab.

Cut type

Option Description
Cut right The parts’ right side from the cut plane will be

removed.
Cut left The parts’ left side from the cut plane will be

removed.
Fit plane The removed part is the shortest part (from fit plane

to part’s end).
No cut No cut is applied.

Offset

You can define the offset for the cut plane. The offset distance is always
perpendicular to the cut plane.

Explode component

You can select to explode the component if you do not need to modify the
component after applying it. If you plan to modify the component later, select
not to explode it.

Opening in wall (40)
Opening in wall (40) creates an opening in a concrete wall of adjustable size,
shape and position. Can also add an insulation panel to the wall.

Objects created

• Opening

• Insulation (optional).

Use for

Square or circular opening in a wall and adding insulation to the wall.
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define rabbet several openings

adding insulation braced girders

TIP You can use Hole Generation (32) (page 3151) to create an opening with
an irregular shape.

Before you start

Create the wall for example as a concrete panel or column.

Opening tab
Use the Opening tab to define the shape and size of the opening.

Type

First you can define the type of the opening. The options are:

• Opening

• Opening no rabbet

• Opening with rabbet

• Opening only outside

• Opening only inside
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Opening Opening with rabbet Opening only
outside

Horizontal position

The horizontal reference point for creating the opening can be selected from a
picklist. In the table below are the available options.

Option Description Example
Point is left side
opening

The opening is
created on the left
side from the
component insertion
point.

Point is middle
side opening

The middle of the
opening is created
from the component
insertion point.

Point is right side
opening

The opening is
created on the right
side from the
component insertion
point.

Start panel The opening is
created from the
startpoint of the wall.
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Option Description Example
End panel The opening is

created from the
endpoint of the wall.

Middle panel =
left opening

The center of the wall
is referencepoint. The
opening is created to
the left side.

Middle panel =
middle opening

The center of the wall
is referencepoint. The
opening is also
created from the
middle.

Middle panel =
right opening

The center of the wall
is referencepoint. The
opening is created to
the right side.

Vertical position

The horizontal reference point for creating the opening can be selected from a
picklist. In the table below are the available options.

Option Description Example
Pos point bottom
opening

The opening is
created on the left
side from the
component insertion
point.
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Option Description Example
Point is middle
opening

The middle of the
opening is created
from the component
insertion point.

Pos point top
opening

The opening is
created on the right
side from the
component insertion
point.

Bottom panel The opening is
created from the
startpoint of the wall.

Top panel The opening is
created from the
endpoint of the wall.

Middle panel =
bottom opening

The center of the wall
is referencepoint. The
opening is created to
the left side.
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Option Description Example
Middle panel =
middle opening

The center of the wall
is referencepoint. The
opening is also
created from the
middle.

Middle panel =
top opening

The center of the wall
is referencepoint. The
opening is created to
the right side.

Horizontal/Vertical offset

The opening can be moved vertically and horizontally by using these two offset
value fields.

Rabbet - side

With this picture picklist you can define the side where the rabbet is created.

Cut - rotation

With this picture-picklist you can define the rotation of the cut.
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Shape of the opening

With the picklist you can choose the general shape of the opening in the wall.

The default shape is a rectangular opening. The other shape is the circular
shape.
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Insulation tab
Use the Insulation tab to define insulation thickness, offset and creation of
partcut.

The option ’Cut opening size’ can be used to define if the insulation should be
cut at the opening in the wall.

Option Description
t b h Define the thickness, width, and

height of the part.
Pos_No Define a prefix and a starting number

for the part position number.

Enter the assembly position number
on the second row.

The default part start number is
defined in the Components settings
in File menu --> Settings -->
Options .

Material Define the material grade.

The default material is defined in the
Part material box in the
Components settings in File menu --
> Settings --> Options .

Name Define a name that is shown in
drawings and reports.

Class Enter a number to group the parts
that the component creates. By
default, the class number affects the
color in which the part is shown in
model views.

Parameters tab
Use the Parameters tab to create assembly panel insulation.

Possiblilty to weld the insulation to the panel to get an assembly.

Three options available: Default, Yes and No. Default option is same as Yes.

Hole Generation (32)
Hole Generation (32) creates a hole in the object, or splits the object in two if
the hole cuts the whole object. Use this component, for example, in welded
profiles, slabs, or panels generated with a component.
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Objects created

• Cuts

Use for

Situation Description
A hole is created when a point is picked.

Selection order

1. Select the part or object created by a component to be cut.

2. Click the middle mouse button.

3. Pick the position relative to the hole being generated.

Parameters tab
Use the Parameters tab to control the hole properties.

Option Description
Define the hole dimensions and the
location of the picked point.

The selected Partcut option affects
which of these dimensions are
available.
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Option Description
To rotate the hole, define the rotation
angle.

Define the recess depth.

Partcut Select the hole type.

The options are:

• Rectangular creates a rectangular
hole using width and height.

• Circular creates a round hole
using height as a diameter.

• Profile creates a cut using the
selected profile. You can use this
option to create a hole with an
irregular shape.

Profile If you selected Profile as the hole
type, select a suitable profile from the
Profile Catalog.

Coordination system Select the coordination system.

The options are:

• Use global xy-plane creates the
hole according to the global
coordinate system.

• Use local creates the hole
according to the work plane.

If the part is sloped or skewed, the
Use local option is used
automatically.

Cutpart name Define a name for the cut part.
Rotated Select whether the cut is rotated 90

degrees in the XY plane.

Polygon Hole Generation (33)
Polygon Hole Generation (33) creates a polygon-shaped hole in the object.
Use this component, for example, in welded profiles, slabs, or panels
generated with a component.
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Objects created

• Cut

Use for

Situation Description
A polygon-shaped hole in
concrete slabs, created by
picking five points.

Selection order

To create a polygon-shaped hole:

1. Select the part or object (component) to be cut.

TIP You can cut other components, such as Modeling of floor bay (66)
with this component.

2. Click the middle mouse button to end selecting.

3. Pick the corner points of the polygon-shaped hole.

4. Click the middle mouse button to end picking.

Parameters tab
Use the Parameters tab to control the cuts created.

Field Description
Cutting depth

Flooring
This section introduces components that can be used in concrete floors.

Click the links below to find out more:

• Automatic seam recognition (30) (page 3155)

• Seam Applicator (page 3156)

• Modeling of floor bay (66) (page 3158)
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• Sloping slab drainage (page 3166)

• Hollow Core Opening Tool (page 3170)

• Hollow Core Lifting Loops (page 3174)

• Floor layout (page 3177) (recommended for floor modeling)

• Floor Tool (page 3210)

Automatic seam recognition (30)
Automatic seam recognition (30) is used to add predefined custom seams
between parallel parts, such as slabs or wall elements. This tool is useful when
you add seams for warped floors.

Use for

Situation More information
Use to connect parts with predefined
custom seams.

Before you start

Create parallel parts, for example, concrete slabs or walls.

Create custom seam.

Selection order

1. Select the main part.

2. Select secondary parts. Click the middle mouse button to create the
seams between the parts.

Parameters tab
Use the Parameters tab to define seam properties.
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Property Description
Seam name Enter the seam name, or use the

browse button (...) to locate the seam
in the Select component dialog box.

Seam property file Enter the name, or use the browse
button (...) to locate the name of the
seam attribute file (optional).

Seam direction Select to change the direction.
Seam input part order Select to reverse the main and

secondary part. You may need to
change the Seam up direction too.

Seam up direction Define the direction of the seam.
Re-calculate seam points for Use to re-calculate the seam points

for all parts or only for warped parts.

• All parts: use for fully or partially
warped decks or floors. This
option creates all seam points in
the same way, no matter, if the
slab is warped or not.

• Warped parts: use for wall panels
and other situations, where
warping is not used, or the All
parts option does not give desired
result.

Position of re-calculated points Control the location of the re-
calculated seam points. The options
in the list box are same as the circles
in the following image.

Seam Applicator
Seam Applicator creates a seam between two double tee slabs, or between a
double tee slab and a wall or a spandrel. The double tees can also be warped
and/or cambered. To be able to use Seam Applicator you need to have a
custom seam. The custom seam can be created in the model, or it can be
imported to the model.
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Objects created

• Seams

Use for

Situation Description
Two double tee slabs with seams

Double tee slab and wall with seams

Before you start

Create a custom seam.

NOTE When you define the custom seam in Custom Component Wizard,
make sure that you select the Allow multiple instances of
connection between same parts checkbox on the Advanced tab.

Selection order

1. Select the main part.

2. Select the secondary part.

The seam is created automatically when the secondary part is selected.

One of the selected parts must be a double tee slab and the other part
can be a double tee slab, a wall, or a spandrel.
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NOTE If the seam cannot be created between the selected parts for
some reason, a dummy beam is created instead. The beam
indicates that the seam creation did not succeed.

Parameters tab
Use the Parameters tab to control the properties of the seam.

Option Description
Seam name Define the custom seam that connects the

parts by selecting it from the Applications
& components catalog.

Seam property file Select the attribute file for the custom
seam.

Seam direction Seam direction in relation to the main and
the secondary part.

Seam up direction Seam rotation.
Offset start point Seam start point offset from the edge of

the double tee slab start point.
Offset end point Seam end point offset from the edge of the

double tee slab end point.
Number of copies Number of seams.
Distance to first seam Distance between the double tee slab edge

and the first seam start point.
Spacing values Space between the seams.
Copy at equal distances
(Ignore spacing values)

Define whether seams are created at equal
distances.

If you select Yes, the values in Spacing
values field are ignored.

Modeling of floor bay (66)
Modeling of floor bay creates an area of concrete slabs between two support
lines that you define, for example, between two main frames. Support lines
can be polylines or sloped.

Parts created

Concrete slabs.
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Where to use

Situation More information
Slab area created
between two support
lines.

Before you start

Create two support lines with two or more points.

Picking order

1. Pick points to define the first support line. To finish, middle-click away
from the last point picked.

2. Pick points to define the second support line. To finish, middle-click away
from the last point picked.

3. Pick a point to indicate the origin of the slabs.

4. Pick a point to indicate the direction of the slabs.

Parameters tab
Use the Parameters tab to define the position of the slab.

Property Description
The position of the slab relative to the
origin line picked when creating the
slab.

The options are center of profile
(default) or center of seam.
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Property Description
Select the slab spacing and enter the
appropriate dimension. The options are
seam (default) or center to center.

If you select the seam option, the
bottom dimension is enabled. If you
select the center-to-center otion, the
upper dimension is enabled.
Slab offsets from support lines 1 and 2.

Vertical position of the slab.

The options are Top (default), Center
or Bottom.

Enter an optional offset value.

Projection type Defines how the slabs are spaced on a
sloping floor bay.

Projection type

Use the Projection type field to define how to handle slab spacing or seams
on a sloping floor bay. The options are Global (default), Support line 1,
Support line 2, or Both support lines.

• Global: the centers of the slabs remain constant, seam spacing adjusts.
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• Support line 1: Seam spacing on support line 1 does not adjust (effect
exaggerated here):

• Support line 2: Seam spacing on support line 2 does not adjust (effect
exaggerated here):

• Both support lines: Seam spacing is calculated at the average plane
position between both support lines

Along this line, center to center and seam width are
exactly as entered in the dialog box.

Support line 2

Plane between support lines 1 and 2

Support line 1
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Profiles tab
Use the Profiles tab to define the properties of the slab profiles.

Index list

Use the Index list to specify different profiles, seam width, and various cutting
options for specific slabs or seams.

Input the values individually, or in a list:

Examples for slabs

If the origin point is the center of slab:

If the origin point is the center of seam:

Examples for seams

If the origin point is the center of slab:

If the origin point is the center of seam:

Concrete components 3162 Concrete detailing



Adjustment type

Use the Adjustment type to define the type of adjustment for the selected
slab. The options are:

• Default - Use the default slab profile.

• Profile - Use the specific slab profile.

• Cut left side - Cut the left side of the profile. If no profile is defined, uses
the default slab profile.

• Cut right side - Cut the right side of the profile. If no profile is defined, uses
the default slab profile.

• Cut both sides - Cut both sides of the profile. If no profile is defined, uses
the default slab profile.

• Seam width - Adjust the seam width.

Profile/Seam Width

Depending on which adjustment type option you choose, defines:

• The width of the default slab profile.

• The width of the specified profile.

• Seam width.

Examples
These examples show how to use the Modeling of floor bay (66) component.

Example 1:

1. Pick 2 points (1, 2) to define support line 1.
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2. To finish, middle-click.

3. Pick 2 points to define support line 2.

4. To finish, middle-click.

5. Pick a point to indicate the origin of the slab.

6. Pick a point to indicate the direction of the slab.

Tekla Structures creates the floor bay.
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Example 2:

1. Pick 2 points to define support line 1.

2. To finish, middle-click.

3. Pick 4 points to define support line 2.

4. To finish, middle-click.

5. Pick a point to indicate the origin of the slab.
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6. Pick a point to indicate the direction of the slab.

Tekla Structures creates the floor bay.

Sloping slab drainage
Sloping slab drainage creates a concrete slab topping and a drainage hole.

Objects created

• Drainage hole
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Use for

Situation Description
Drainage holes with valley 1 and hip 2
created.

Limitations

Slab topping does not adapt to slab chamfers. You need to define the slab
chamfers and topping chamfers separately.

Before you start

Create or split the slabs so that there is one drainage point in each slab.

Selection order

1. Select the main part (slab).

2. Pick a point to create the drainage hole.

The drainage hole is created automatically when the point is picked.
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Part identification key

 Part
1 Drainage hole

Parameters tab
Use the Parameters tab to control the type, dimensions and properties of the
drainage hole.

Drainage hole type

Option Description
A drainage hole is not created.

A rectangular drainage hole is
created.

A round drainage hole is created.
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Drainage hole dimensions

Option Description
Define the side dimensions of the
rectangular drainage hole.

Define the diameter of the round
drainage hole.

Drainage hole properties

Option Description
Define slab inclination by Select how the slab is inclined, by a

combination of slope (S) or slope
percentage (S%), and topping
thicknesses (d1, d2).

The Slope, d1, and d2 options are
available accordingly.

Slope Slope of the topping, for example,
0.01 (S) or 2 (S%).

d1 Thickness of the topping at the
drainage point or at the hole.

d2 Thickness of the topping at the edge
of the slab or at the hip.

Create cast unit Select how the cast unit is created:

• Yes

Topping is part of the slab cast
unit.

• No

Each part of the topping forms a
cast unit.
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Option Description
• Topping

Topping is a separate cast unit.
Material Define the material of the topping by

selecting it from the material catalog.
Type Select whether a valley or a hip is

created. If you select Hip, you can
only pick slab corners.

Cast unit type Select the cast unit type.
Pour phase Enter the pour phase.
Class Define the class of the slab.

Hollow Core Opening Tool
Hollow Core Opening Tool creates holes and recesses to hollow core slabs.
Hollow Core Opening Tool works with single hollow core slabs, or with floors
that are created with the Modeling of floor bay (66) modeling tool.

Objects created

• Holes and recesses

Use for

Situation Description
Hollow core slab with small and large
openings

Limitations

Hollow Core Opening Tool calculates the location for the openings based on
the given values and the slab profile data. If needed, you can use an external
configuration file in XML format to provide different rules for the openings and
the slab profile data.

You can define small and large openings. Small openings are placed in the
middle of the hollow cores so that no webs are broken. Large openings break
webs.
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Before you start

Create a hollow core slab.

Selection order

1. Select the main part (slab).

2. Pick a position for the opening.

Hollow Core Opening Tool properties
Use the Hollow Core Opening Tool properties to control the properties of
the openings and recesses.

Option Description
Select the shape of the openings and recesses.

• Square - in the middle of the slab

• Round - in the middle of the slab

• At one end of the slab

• At both ends of the slab
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Option Description
Hollow positions If you select to add openings or recesses at

one end or at both ends of a slab, enter the
positions of the hollows that are cut.

The positions are numbered from left to right
at the start of the part. The part is viewed from
the top in the start-to-end direction. The
openings and recesses are created in the same
voids at the end of the part.

Size Define the size of the opening in longitudinal
and cross direction, or the diameter for a
round opening.

Opening width defines whether the opening is
small or large.

Opening Type Select the type of the opening.
Place exactly by point Select whether the opening is created exactly

to the picked position.
Centralize in zone Select how the center of an opening is

centered

• By hollow:

The opening is centered to the hollow core.

• By web:

The opening is centered to the web.
Cut full width of hollow Select whether the opening is cut based on the

minimum width of hollows or the number of
hollows.

To use this option, center the opening By
hollow in the Centralize in zone option.

Rules file (XML) Select the external XML file where you have
defined the opening and slab profiles.

Cutpart name Define a name for the cut part.
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Option Description
Define the recess depth.

Define the alignment for the opening.

Select whether the thick side part of the
opening is removed.

Configuration file example
Use an external .xml file to define the openings and the slab profiles.

Example

An example Zones.xml file is located in ..\ProgramData\Trimble\Tekla
Structures\<version>\environments\common\system.
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Hollow Core Lifting Loops
Hollow Core Lifting Loops creates lifters for hollow core slabs. Hollow Core
Lifting Loops works with single hollow core slabs, or with floors that are
created with Modeling of floor bay (66) modeling tool.

Objects created

• Lifters

Use for

Situation Description
Hollow core slab with recesses, hollow
core fillings and lifting devices.

Limitations

You also need a lifting device. The lifting device can be created as a custom
part, or it can be imported to the model. Alternatively, you can use an external
configuration file in XML format to define the properties for the recess, the
lifting device and the slab.
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Before you start

Create a hollow core slab and a lifting device.

Selection order

1. Select the main part (slab).

The recess and hollow core fillings are created.

Basic settings tab
Use the Basic settings tab to control the properties of the lifters and hollow
core fillings.

Configuration file

Option Description
Configuration file Select the external XML file where you have defined the

recess, the lifting device, channel and grouting profiles,
and the slab profile properties.

Override Define whether the values on the Basic settings and
Lifting device settings tabs override the properties
defined in the external XML file.

Dimensions

Option Description
1 Define the minimum distance from the lifter insertion point to the

end of the slab.
2 Define the maximum distance from the lifter insertion point to the

end of the slab.
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Option Description
3 Define the minimum distance from the lifter insertion point to the

edge of an opening.
4 Define the minimum distance between two lifter insertion points.
5 Define the length of the hollow core filling.
6 Define the profile of the recess.
7 Define the depth of the recess.

Channel numbers

Select the channel numbers:

Option Description
At the first channel

Default

At the second channel

At all channels

Hollow core filling

Option Description
Use automatic fill
profile

Define whether the automatic hollow core filling
profile is used.

Profile Define the hollow core filling profile.
Prefix Prefix for the part position number.
Start Number Start number for the part position number.
Name Define a name for the lifter.

Tekla Structures uses the name in drawings and
reports.

Class Use Class to group the lifters.

For example, you can display lifters of different classes
in different colors.
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Lifting device settings tab
Use the Lifting device settings tab to control the properties of the lifting
device.

Move individual lifters in the x and y direction with direct modification.

Change the lifter type from the contextual toolbar.

Properties

Option Description
Lifter component Define the custom part that represents the actual lifting

device.
Saved properties
to use

Select which saved properties to use for the lifting
device custom part.

Lifter max load Define the maximum load for the lifting device.
Rotation Select the rotation of the lifting device custom part

around its axis.
Angle Define the rotation angle of the lifting device custom

part.
Up Direction Select the lifting device up direction in relation to the

local coordinate system.
Offset Define the offset of the lifting device in relation to the

local coordinate system in the corresponding
directions.

Configuration file example
Use an external XML file to define the lifting device, the lifter, and the slab
properties.

Example
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Floor layout
Floor Layout creates floors built of precast filigree, double-tee, and hollow
core and solid slabs. The floors may contain several layers, such as precast
slabs, insulation and a cast-in-place topping. Floor Layout is most useful for
non-rectangular floors that contain one or more openings that split slabs into
many pieces, and when slab widths are not constant on the whole floor area.
You can modify the floors using direct modification.

Objects created

• Slabs

• Insulation

• Cast-in-place topping

Use for

Situation Description
Create floor structures that have
layers, for example, hollow core slabs
at the bottom, insulation as the
middle layer, and cast-in-place
topping.

Selection order

1. On the Concrete tab, click Slab --> Floor layout .

2. Pick the corner points of the floor.

You can pick the points at grid lines or the reference points of supporting
parts. You can change the offsets later.

The default slab direction is from the first (P1) point to the second (P2)
point. You can change this later if needed.
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3. Click the middle mouse button to create the floor.
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Convert a slab to floor layout

You can use the Convert to layout component tool to convert slabs to Floor
layout components, see Convert to layout component (page 3029) for
instructions.

Layer tab
Use the Layer tab to control the layer type, profile, and how the layer is
created.

Layer list

Layers Description
The layer list shows the current layers of the floor. The
first layer in the list is the top layer and the last layer is
the bottom layer. In the example image on the left, the 
FILIGREE layer is the top layer and the CIP layer is the
bottom layer.

Use the buttons to do the following:

•

Click  to add a new layer.

•

Click  to remove the selected layer.

•

Click  to change the order of the layers by
moving the selected layer up or down in the list.

Use the check box in front of the layer name to control
whether the properties of the selected layer are modified.

Use the leftmost check box to control if the number of the
layers and the order of the layers are modified when you
modify the Floor layout component.

Layer properties

Select a layer in the layer list to define the layer properties.

Option Description
Layer name Enter a name for the layer. This is the layer name shown

in the layer list. The name is also shown in the direct

modification toolbar when you are modifying offsets .

This name is not visible in the model so you can enter
any suitable name.

Layer type Select the layer type. The Precast layer is the primary
layer and any insulation parts are added to precast units.
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Option Description
The parts created for a Cast in place layer are not added
to any other cast unit.

Create layer as Select how the layer parts are created: as beam parts,
custom parts, or a single part.

Layer
component

Component
attributes

When the layer parts are created as custom parts, you
can select a component and the component attributes.

Layer thickness
or profile

When the layer parts are created as beam parts or as a
single part, you can select the profile or thickness of the
layer parts.

With parametric profiles, you can replace the width of the
profile with the text [W]. When you do this, the beam is
never cut but the desired width is achieved by setting the
profile name based on the slab width.

For example, the profile could be BL80*[W].
Rotation Select the rotation of the layer parts.
Part name

Class

Material

Pour phase

Part prefix, Start
no

Cast unit prefix,
Start no

Define the name, class, material, part prefix and start
number of the layer parts. Define the pour phase for CIP
layers.

General tab
Use the General tab to control the default part and gap width, depth position
of the layers, and the direction for lining up the slabs.

Select to create slabs and parts by width or number of them from the Default
part width dropdown list. The options are:

Option Description
Default part width Enter the default width for the slabs

in the primary layer.

If you define the width of an
individual slab in the slab part
properties, the Default part width
value is not used.
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Option Description
Max part width Enter the maximum part width.

Floor layout calculates the slab width
by dividing the entire floor width by
the maximum width.

Floor layout then gets the number of
slabs that are used to divide the
entire floor width to get the optimal
slab width taking the seam gap values
into account in the calculation.

Note that this setting is only
recommended for profiles with
parametric width (See also Layer
thickness or profile in Layer
properties), or for slab objects.

Number of parts Enter the number of parts to be
created.

Floor layout calculates the slab width
automatically by dividing the entire
floor width by the number of parts.

Note that this setting is only
recommended for profiles with
parametric width (See also Layer
thickness or profile in Layer
properties), or for slab objects.

Option Description
Default gap width Enter the default seam gap width in the primary layer.

If you define the width of an individual gap, the Default
gap width value is not used.

Same gap for all Set the gap width at first and last edges.

Same gap for allcreates gaps that are half of the default
gap width.

No gap at first and last does not create gaps.
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Option Description
Depth position Select how the layers are positioned in relation to the

plane of input points.

Line up direction Select the direction for the slabs. By default, the width of
the last slab may differ from the width of the other slabs.

Advanced tab
Use the Advanced tab to control the minimum angles, and the width and
length of the slabs.

Option Description
Minimum end
angle

Minimum start
angle

Controls how the slab ends are modeled.

When the angle of the floor edge is smaller than the
minimum angle, you can select a suitable option from
the list to make the slab end straight.
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Option Description

Slab width and
cut zone settings

Use this setting to select the FloorLayout.ini file that
the component is using. The Default option is the file
named as FloorLayout.ini.

You can customize the allowed slab width, and the
allowed locations of cuts and lengths in the
FloorLayout.ini file. You can create multiple settings
and save these settings in your own
xxx_FloorLayout.ini file, for example,
MyOtherSetting_Floorlayout.ini.
Minimum slab width. Slabs narrower than the minimum
width are not created.

Minimum slab length. Slabs shorter than the minimum
length are not created.

Maximum slab length. Slabs longer than the maximum
length are not created.

Minimum required width of a single neck on either side
of the slab when there is a large opening in the slab.

If either of the necks on the sides of the opening is
smaller than the defined neck width, the neck is cut off
completely. In addition, the total width of the necks must
be bigger than the minimum slab middle zone neck
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Option Description
width, otherwise the slab is split into two separate slabs
(the width of the actual opening is the same as the width
of the slab).
Minimum end nose width and length.

If there are noses on both sides of the slab, these two
end noses are checked separately and cut off if the width
of the single nose gets smaller than the given minimum
required nose width.

Align openings by
allowed widths

Select Yes to re-align the opening/cut longitudinal edges
to match the allowed width zones.

The default value is No.
Create cut-outs Select to create cut-outs for notches or openings.

Selecting to create cut-outs does not affect whether the
slab is split.

Extra narrowing Define the gap increase between the slabs when the
other slab is cut inside the layout. The default value is 0.

Classes or names
of parts to cut
out

Creates automatic cut-outs for parts going through the
floor layout.

Enter the names or classes for parts that need cut-outs.

Customize allowed slab width and length
You can customize the allowed slab width, and the allowed locations of cuts
and lengths in the FloorLayout.ini file. This file can be located under the
model folder, or in any of the folders defined in the XS_FIRM, XS_PROJECT, or 
XS_SYSTEM advanced options.

If the file contains any values for a profile, these values are used and they
override the minimum and maximum values entered in the Floor layout
dialog box. In the Floor layout dialog box, you can define the slab width on
the General tab and the slab length on the Advanced tab.

The images below show examples of the FloorLayout.ini file and allowed
zones:

//
// configuration file for "Floor Layout" component
// 
// Slab not listed below can have any width. Slab listed below can only 
have width inside the given range. 
// User input values will be rounded down to the nearest allowed value.
//
//                    Zone 1     Zone 2         Zone 3     Zone 4     
Zone 5    
// Slab widths    Profile    min. max.    min. max.     min. max.    min. 
max.    min. max.
SLAB_WIDTH     P15(150X1200)   345-435     485-575     625-715        
765-855      905-995      1045-1135
SLAB_WIDTH     P18(175X1200)   392-492     549-649        706-806     
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863-963      1020-1120
SLAB_WIDTH     P20(200X1200)   270-370     450-560     640-750        
830-930      1020-1120
SLAB_WIDTH     P27(265X1200)   320-440     540-660     760-880        
980-1110
SLAB_WIDTH     P32(320X1200)   380-560     660-830        930-1110
SLAB_WIDTH     P32R(320X1200)  380-560     660-830        930-1110
SLAB_WIDTH     P37(370X1200)   320-440     540-660        760-880     
980-1120
SLAB_WIDTH     P40(400X1200)   400-530     670-800        950-1080
SLAB_WIDTH     P50(500X1200)   390-530     670-810        950-1080

//Allowed zones to place a cut
//                      Zone 1      Zone 2      Zone 3      Zone 4       
Zone 5    
// Cut zones    Profile     min. max.     min. max.     min. max.    min. 
max.    min. max.
CUT_ZONES     P15(150X1200)   325-455     465-595     605-735        
745-875    885-1015    1025-1155
CUT_ZONES     P18(175X1200)   372-512     529-669        686-826        
843-983    1000-1140
CUT_ZONES     P20(200X1200)   250-390     430-580     620-770        
810-950    1000-1140
CUT_ZONES     P27(265X1200)   300-460     520-680     740-900        
960-1130
CUT_ZONES     P32(320X1200)   360-580     620-850        910-1130
CUT_ZONES     P32R(320X1200)  360-580     620-850        910-1130
CUT_ZONES     P37(370X1200)   300-460     520-680        740-900        
960-1140
CUT_ZONES     P40(400X1200)   380-550     650-820        930-1100
CUT_ZONES     P50(500X1200)   370-550     650-830        930-1100
/
// Min/max lengths by slab profile & width min/max
//
//         Profile     Width min/max     Length min/max
SLAB_LENGTH     P15(150X1200)     0-1200     1000-8000
SLAB_LENGTH     P18(175X1200)     0-1200     1000-9000
SLAB_LENGTH     P27(265X1200)     0-1200     1000-12000
SLAB_LENGTH     P32(320X1200)     0-830      1000-13000
SLAB_LENGTH     P32(320X1200)     830-1200      1000-14000
SLAB_LENGTH     P32R(320X1200)       0-1200       1000-14500
SLAB_LENGTH     P37(370X1200)     0-660      1000-14000
SLAB_LENGTH     P37(370X1200)     660-1200      1000-15000
SLAB_LENGTH     P40(400X1200)     0-800      1000-16000
SLAB_LENGTH     P40(400X1200)     800-1200      1000-17000
SLAB_LENGTH     P50(500X1200)     0-810       1000-19000
SLAB_LENGTH     P50(500X1200)     810-1200    1000-20000

For example, in the following image, zone 1 is: 523-673 (77+150+73+150+73
- (+150)).
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You can create multiple settings and save these setting in your own
xxx_FloorLayout.ini file, for example,
MyOtherSetting_Floorlayout.ini.

Default offsets
Use the Default offsets tab to set the default offsets for each layer. These
default offsets will be used whenever a specific value is not given for the edge.

 Description
1 Default offset for the side offset.

Offset that is parallel to the bearing direction.
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 Description
2 Default offset for the end offset.

All other offsets that are not side offsets.
3 Default offset for the break line.

The default value is 10. If the break line value is 0, the objects are
not split.

A

B

Define offsets for the automatically created cut-outs.

You can define separate offsets for every layer.
Cutting
around

Define how the automatic cut-outs are made in the selected layer:
By rectangle or By shape.

With By shape, the cut shape is the same as the shape of the part.
For example, when the column is round, a round cut is created.

You can also select not to create the cut. When you select Do not
create, automatic cut-outs are not created in the layer.

Detailing tab
Use the Detailing tab to select the components that are applied to all slabs in
the floor.

Option Description
Component
name

Select a component that is applied to the slabs in the
floor.

Component attr
file name

Select the settings that are used with the component you
have selected.

The list contains all the files that are available for the
selected component.

Adding a component to the component name list

The component name list is empty by default. You can add components to the
list:

1. Select Add new from the list.

The Detailing component data dialog box is displayed.

2. Enter a suitable name in the Name in dropdown box.

3. Click  to open the Applications & components catalog.

4. Select a component and click OK.

The component name or number is added to the Component name box.

5. Click OK.
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When you have added the needed components, the names of the components
are shown in the component name list as shown in the example image below.
Select a component from the list:

The list is stored in the \attributes folder under the model folder.

If you want to predefine the list to contain your favorite components in any
new models, you can copy the LayoutConfiguration.datx file from the
\attributes folder under the model folder to any of the folders defined in
the XS_FIRM, XS_PROJECT or XS_SYSTEM.

CIP filler part tab
Use the CIP filler part tab to create CIP filler parts into the empty areas in
floors created with Floor layout. The empty areas are spaces created by
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offsets around the exterior and interior boundaries. There may also be empty
areas when the slab is too narrow to be created with Floor layout.

CIP filler parts can also be created when:

• The allowed slab width is smaller than the needed width.

• The opening is larger than needed because of allowed width zones.

• The slab is split into two because of a large opening.

• The slab nose is not created because it is too narrow.

CIP filler part properties

Option Description
Create filler parts Select whether CIP filler parts are

created, or whether the filler parts are
created using the same material as
the layer.

Minimum width Minimum width of the part.

If the empty space is smaller than this
width, the part is not created in this
location.
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Option Description
Cast unit prefix

Start no

Cast unit prefix of the CIP filler part

Cast unit start number of the CIP filler
part

Name

Class

Material

Finish

Pour phase

Define the name, class, material,
finish and pour phase of the CIP filler
parts.

Fill seam gaps Select whether seam gaps are filled.

Properties tab
Use the Properties tab to define the IFC4 export entities and concrete cover
thickness for rebar sets. You can define these properties for each layer
separately.

Properties

Option Description
IFC export You can define IFC4 entities for parts

and cast units. The cast unit values
are used for main part layers, cast-in-
place layers, and sub-assembly layers.
The values for each layer are taken
from the main part of the cast unit to
which the layer belongs.

Select an IFC entity and a Subtype
(IFC4). If you select USERDEFINED as
the IFC4 subtype, you can define the
User-defined type (IFC4).

Concrete covers for rebar sets You can define the concrete cover
thickness on the part level.

Select whether to use the global or
local coordinate system, and define
the coordinates according to your
selection.

User defined tab
Use the User defined tab to set the user-defined attribute values for the slabs.
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If you have defined the user-defined attributes in the part properties dialog
box and want to use those values, leave the User defined tab empty.

The content of the tab may vary depending on your environment, see below
how to customize the content.

Customizing the User defined tab

You can customize the content of the User defined tab using the
floorlayout.objects.inp file. Note that you cannot create new user-
defined attributes with the file. The user-defined attributes on the tab are
existing user-defined attributes that have been defined in the objects.inp
file. The floorlayout.objects.inp file has the same format as the
objects.inp file.

The floorlayout.objects.inp file can be located in any of the folders set
in the XS_FIRM, XS_PROJECT or XS_SYSTEM advanced options, or in the
model folder.

Below is an example of the floorlayout.objects.inp file:
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Modifying a floor
You can use direct modification to modify the floor. Before you start, ensure

that the Direct modification  switch is active. Select the floor to display
the direct modification toolbar.

To modify the floor, select the appropriate command from the toolbar.

Button Description
Add a polygonal opening.

Add a rectangular opening.

Add a circular opening.

Add a break line to split the slab into two slabs.

Modify the openings or exterior boundary of the floor. This
command is active by default.

Make the floor warped by offsetting one or more vertices of the
exterior boundary polygon from the plane.
Modify the offsets at floor boundaries.

Modify the layout of the floor:

• Modify the width or profile of any of the slabs in the floor.

• Modify the side of the cut when the slab is cut to a smaller
width.

• Modify the gaps between the slabs.

• Modify the direction of the slabs.

• Modify the order of slabs when the slabs do not have the same
width or profiles.

You can click the  button to reset all seam gaps and slab
distribution to the initial default values that were used when the
floor layout was created.
Add or modify the detailing components that are only applied to
certain slabs in the floor layout. The detailing components are listed
on the Detailing tab.

You can apply the same detailing component settings to all slabs in
the floor layout using the floor layout attributes.
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Button Description
Click the refresh command to rerun the component. For example, if
you have new parts that should cut holes around them, the refresh
command ensures that the cuts are shown correctly.

Known limitations

Floor layout is not designed to work with floors where the layout is not in one
plane. Egdes can be offset from the plane only to warp the floor, not to make
floors that have several planes.

The image below shows an example where Floor layout has been used to
create several planes. If precast slabs are used in this way, the outcome is not
correct. Use multiple Floor layout components to create precast floors with
several planes.

Add a polygonal opening

1. Click .

2. Pick the corner points of the opening.

You can pick the points at grid lines or you can pick the reference points of
supporting parts. You can change the offsets later.
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Add a rectangular opening

1. Click .

2. Pick the corner points of the opening.

You can pick the points at grid lines or you can pick the reference points of
supporting parts. You can change the offsets later.
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Add a circular opening

1. Click .

2. Pick the center point of the opening.

3. Pick the radius of the opening.

Add a break line to split the slab into two slabs

1. Click .
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2. Pick the end points of the break line.

Split the floor layout to two separate floor layouts

1. Select either a seam or a break line.

2. Click  on the contextual toolbar.

Concrete components 3197 Concrete detailing



After the splitting, you can modify both layouts independently. Note that
splitting cannot be reverted, and you cannot combine the two layouts again.

Modify the openings and exterior boundary of the floor

1. The  button is active by default.

The handles are shown for the exterior boundary and for all openings in
the floor.
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2. Do any of the following:

• To move an edge, drag any of the edge lines. Hold down the left mouse
button when dragging.

• To move a corner point, drag the handle in the corner.
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• To add new points to the edge, drag the handle in the middle of the
edge.

• To delete any of the points, select the handle in the corner and press
the Delete key.

• To make the floor warped, offset the vertices of the exterior boundary
so that all vertices are not in the same plane.

Drag a handle normally to move the vertices in the original floor plane.

Hold down the Alt key while dragging to move the vertex
perpendicular to the floor plane.
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Hold down the Alt and Shift keys to move the vertex both in the plane
and off from the plane by snapping to any point in the model.

Modify the offset at floor boundaries

1. Click .

The handles for modifying the offset are shown. If there are offsets, the
offset dimensions are also shown.
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2. To adjust the offset, do one of the following:

• Drag the edge offset lines.

• Select one or more offset lines by holding down the Shift key.

When you have the offset lines selected, right-click on any of the
selected lines. Enter the offset value to the toolbar that is displayed

and click .

Note that when you use the offset command, the direct modification toolbar
shows the floor layout layers. Each layer may have different offsets. You can
select which layers to modify. The simplest way is to select all layers and have
the offsets equal in each layer.
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Modify the layout of the floor

1. Click .

The following direct modification elements are shown:

2. To modify the layout of the floor, do any of the following:

• To modify slab width, do one of the following:

• To move all seams, select one seam and start dragging.

• To add a new seam, select a seam, hold down the Ctrl key and start
dragging. When you stop dragging and release the mouse key, a
new seam is added to that location.

• To make one slab smaller, select a seam, hold down the Alt key and
start dragging. The slab on the left or right side is made smaller and
all slabs on the other side will move with the seam.

• To modify the profile, width, and cut side of a slab, right-click the slab
handle.
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When the profile of the slab is fixed (not parametric), the slab is cut on
either side when the width is smaller than the original width. The
Default cut side is leading edge for the first slab and trailing edge for
all others in relation to the layout direction.

You can modify the properties of multiple slabs at the same time by
holding down the Shift key when selecting slabs.

• To modify the gap width between the slabs, do one of the following:

• Drag the end of the gap dimension.

• Right-click a seam line handle, enter the width and click .

You can modify multiple gaps at same time by holding down the
Shift key when selecting seam line handles.
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• To move a slab or change the order of slabs, drag the slab handles.

• To change the direction of slabs, drag the slab direction handle.
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• To remove a slab from the layout, create a rectangular opening to the
layout by picking the corner points for the opening.

Lock and unlock seams

You can lock and unlock seams on the contextual toolbar.

1. Select a seam.

2. Click  to lock the seam.

The button changes to  when the seam is locked. Click the button
again to unlock.

When a seam is locked and you are dragging the seams (with or without the
Alt/Ctrl key pressed), only the seams in the range between the locked seams
are changed. The first and last seams in the layout are always locked.

Locked seams keep their location, and new slabs are created or removed
inside the locked range if you change the slab width, seam gap or seam center
measures, or remove any of the slabs with narrowed width.
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Add and modify property strips
You can use property strips to control the properties and detailing
components of indivual slabs in the floor layout.

Property strips

You can define property strips that have certain properties and detailing
components, and use the property strips according to your needs in the floor
layout. For example, you can change the profile and class of the individual
hollow core slabs. Note that property strips only affect the main layer parts.

Property strips are added as lines in the floor layout plane. Property strips
affect the parts that they are touching. You can also set property strips so that
they affect through the slab line.

The image below shows an example of a property strip. The two slabs in the
floor layout have a different class and profile because of the property strip.

To create a property strip in the floor layout:

1. On the contextual toolbar of Floor layout, click  to open a dialog box
for defining the property strip.

2. On the Properties tab, define the individual slab properties.

Option Description
Effect in layout Select how the parts in the floor

layout are affected:

• Hit slabs only: The property strip
only affects the parts it is
touching.

• All slabs in line: All slab parts in
the line are affected if one slab
line is split to two or more
individual parts.
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Option Description
Layer thickness or profile Change the thickness or profile of the

layer.
Depth position If the profile height is different, you

can adjust the alignment according to:

• Bottom face aligned with other
slabs.

• Top face aligned with other slabs.
Part name

Class

Material

Pour phase

Part prefix

Cast unit prefix

Start no

Define the name, class, material, part
prefix and start number of the layer
parts. Define the pour phase for CIP
layers.

3. On the Detailing tab, select the detailing component that you want to
use.

Option Description
Component name Select the detailing component from

the list.

The list of detailing components
shows the components that you have
added on the Detailing tab in the
Floor layout dialog box.

The content of the list may vary
depending on your environment.

You can also add new components to
the list by selecting the Add new
option. Note that you can only add
detailing components that use one
input part.

Component attr file name Select the detailing component
attributes that are used for the slab.

Note that the content of the list varies
depending on the component that
you have selected.
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4. On the User defined tab, set the user-defined attribute values for the
slabs.

If you have defined the user-defined attributes in the part properties
dialog box and want to use those values, leave the User defined tab
empty.

5. Pick the start and end points for the property strip in the floor layout.

Modify the property strip

You can also use saved attribute settings from the contextual toolbar.

Use the  and  buttons on the toolbar as follows:

  
Modify the detailing component
and/or attribute file of the property
strip.

Select the property strip and select
the component name and/or
attribute file from the list. Click the
button to modify the selected
property strips.

You can select multiple strips by
holding down the Shift key.
Delete a property strip. Select the
strip that you want to delete.

You can select multiple strips by
holding down the Shift key.

You can also add new property strips by dragging an existing strip and holding
down the Ctrl key.

Floor Tool
Floor Tool creates a floor bay with optional insulation.
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Objects created

• Hollow core slabs

Use for

Situation Description
Floor bay with insulation

Selection order

Make sure that you have defined the slab properties.

1. Pick the contour points of the floor bay.

The floor bay is automatically created when you close the polygon.

NOTE The list of picked contour points on the Bay contour tab and the list
of slabs on the Slab list tab are created when the slabs are created.

Slab properties tab
Use the Slab properties tab to control the profile, material and location of the
hollow core slabs.

Slab attributes

Option Description
Profile Define the profile by selecting it from the profile

catalog.
Name Define a name for the slab.
Material Define the material grade by selecting it from the

material catalog.
Class Define the part class number.
Prefix Define the part prefix.
Start number Define the start number for the cast unit.
Cut slab ends Define whether the slab ends are cut or not.

If you select Yes, define the minimum end angle
for the slabs.

Rotation Select an option to rotate the slab.
Vertical location Define the offset location in the vertical direction.
Offset Define the offset in the vertical direction.
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Option Description
Minimum end angle Define the minimum end angle for the slabs.

If the line to which the slab ends has a bigger
angle than the defined minimum end angle, the
part will be aligned to the line.

Additional attributes

Option Description
Exposure Class Define the exposure class for the hollow core

slab.

The exposure class will be saved as a user-
defined attribute.

Relative strength Define the relative strength of the hollow core
slab.

The relative strength will be saved as a user-
defined attribute.

Fire rating Define the fire rating for the hollow core slab.

The fire rating will be saved as a user-defined
attribute.

User-defined attributes User-defined attributes are located in the
FloorTool.ini file.

Slab direction

Option Description
Slab direction Define the direction of the slab.

If you select Angle, you need to pick points in
the model to define the new direction. The
angle you have picked is shown in the Angle
field. You can also define the angle directly in
the field to rotate the slabs.

Note that picking two points does not change
the local +X direction.
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Insulation tab
Use the Insulation tab to control the insulation properties of the hollow core
slabs.

First define whether to create insulation or not. Insulation is created
separately for each slab.

Insulation

Option Description
Name Define a name for the insulation.
Material Define a material grade by selecting it from

the material catalog.
Thickness Define the thickness of the insulation.
Class Define the part class number.
Offset at slab start/end Define the offset between the slab start/end

positions and the corresponding positions
in the insulation parts.

Left/Right offset Define the offset between the slab and the
insulation for the rightmost and leftmost
slab.

Bay contour tab
Use the Bay contour tab to control the coordinates of the picked contour
points and the horizontal offset of the lines connecting the contour points. If
the coordinates are not visible on the tab, click the Get button.

You need to create the hollow core slabs before using the Bay contour tab.

Bay contour properties

Option Description
XY-constant Z Define the Z coordinate for all contour points at

the same specific height.
XYZ (sloping floor) Define the Z constant for each contour point

separately. The floor may be sloped.
Offset method Define the offset method.
Default end offset Define the default end offset.
Default side offset Define the default side offset.

Concrete components 3213 Concrete detailing



Bay contour table

The table lists the contour points showing their X, Y, and Z coordinates. You
can modify the Z coordinate in the table only if you have selected XYZ (sloping
floor). You can modify the Horizontal offset on all rows of the table.

The table also shows the lines connecting the points. You can only modify the
Horizontal offset. Entering a positive value enlarges the slab area and
entering a negative value shrinks the slab area.

Slab list tab
Use the Slab list tab to list all the hollow core slabs created. If the slab list is
not visible on the tab, click the Get button.

Slab properties

Option Description
Slab number Shows the order of the hollow core slabs starting

from the first picked point.
Width Shows the width of a narrowed slab.
Narrowed from Define whether the slab is narrowed. The

options are:

• not narrowed (default)

• Right side

• Left side
Type Define the slab type.

• Use Slab for normal hollow core slabs.

• Use PIP for a precast infill piece.

• Use GAP for an empty space between the
slabs. You do not need to define a profile
when you select this option.

• Use CIP to create a concrete part using the
width defined in the Width column. The
width range that you can use is defined in the
FloorTool.ini file.

The slabs listed in the FloorTool.ini file
can only have a width that is inside the
defined range. The slabs that are not listed
can have any width. The value you give is
rounded down to the nearest allowed value.
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Option Description
Profile Define the profile by selecting it from the profile

catalog.

You can Add and Delete slabs, and move them Up and Down in the list by
using the buttons on the left. To restore the default values, click Restore
defaults.

Concrete stairs
Tekla Structures includes the following tools you can use to create concrete
stairs and stairwells:

• Concrete stairs (65) (page 3215)

• Stairwells and elevator shafts (90) (page 3230)

• Reinforced concrete stair (95) (page 3233)

Concrete stairs (65)
Concrete stairs (65) creates precast stairs with optional landings, ridges,
stringers, and anti-skid and kick plate profiles. It contains five different step
shapes and options to create round or chamfered step edges.

Objects created

• Stairs

• Landings

• Ridges

• Stringers

• Anti-skid

• Kick plate
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Use for

Situation Description
Staircase with

• square step shape

• stringers on both sides

• top and bottom landings

Staircase with

• chamfered step corners

• ridges on both sides

Staircase with

• rounded step corners

• anti-skid profile

• bottom landing

Staircase with

• square step shape

• rounded step corners

• ridges on both sides

• anti-skid and kick plate profiles
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Selection order

Selection order depends on the selected Creation method option on the
Stairs tab.

When Creation method is set to Default:

1. Pick the first point to indicate the start point of stairs.

2. Pick the second point to indicate the direction of stairs.

The stairs are created automatically.

Part identification key

 Part
1 Landings
2 Stringers
3 Ridges
4 Kick plates
5 Steps
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 Part
6 Anti-skids

Stairs tab
Use the Stairs tab to define how the stairs are created and what are the
dimensions of the stairs.

Creation method

Option Description
Creation method Select the creation method of the

stairs. Creation method defines how
many and which points you need to
pick when you create the stairs.

• Default

Number of steps is calculated
automatically using the vertical
distance between the two input
points.

• One point - N & L & H: define N, L,
and H (number, length, and height
of the steps).

• Two points - N & L: define N and
L.

Height of the steps is calculated
automatically using the vertical
distance between the two input
points.

• Two points - N & H: define N and
H.

Length of the steps is calculated
automatically using the horizontal
distance between the two input
points.

• Two points - L & H: define L and
H.

Number of steps is calculated
automatically using the vertical
distance between the two input
points.

• Two points - N: define N.

Height and length of steps is
calculated automatically using the
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Option Description
horizontal and vertical distance
between the two input points. You
can define the length of the top
step.

No of steps, N Define the number of steps, if the
Two points - L & H option is not
selected.

Position Define the horizontal position of the
staircase, relative to the line joining
the picked points.

Distance Enter a distance to move the stairs in
the horizontal direction from the line
joining the picked points. The selected
Position option has an effect on this
dimension.

Rotation Define the angle between the line
joining the steps and the line joining
the selected points.

Cast unit type Select the cast unit type:

• Precast

• Cast in place

Concrete components 3219 Concrete detailing



Stair dimensions

 Description
1

2

Height of the step.
Length of the step.

3

4

Length of the top step.
Height of the top step.

5 Width of the top corbel.
6 Slope from the corbel to the underside of the stairs.
7 Thickness of the slab.
8 Chamfering for the underside of stairs.
9

10

Chamfer or radius values.

11 Height of the bottom step.
12 Height of the stair foot.
13 Chamfering for the bottom of stairs.
14 Slope from the foot nose to the foot base.
15 Length of the bottom cut.
16 Length of the stair foot.
17 Width of the staircase, including stringers.

Create foot

Define whether a foot is created at the bottom of the stairs.
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Step shapes tab
Use the Step shapes tab to define the shape of steps.

All other steps/Last step at foot

Select the step shape. You can define the shape of the last step at the bottom
if you set Last step same as other step to No.

Option Description
Default

Beveled

From the list below the step shape
options, select whether you want to
enter a dimension or an angle.

AutoDefaults can change this option.

Straight step

Top straight, bottom beveled

Enter two dimensions.

Top beveled, bottom straight

Enter the vertical dimension and then
select whether you want to enter an
angle or a horizontal dimension.
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Option Description
Top and bottom staight

Enter vertical dimensions and then
select whether you want to enter an
angle or a horizontal dimension.

out

Select the shape of the step front edge and enter the required dimensions.

• Default

• Radius: Creates rounded edge.

• Chamfer: Creates chamfered edge.

• No: Creates square edge.

in

Select the shape of the step inner corner and enter the required dimensions.

• Default

• Radius: Creates rounded inner corner.

• Chamfer: Creates chamfered inner corner.

• No: Creates square inner corner.

Landings tab
Use the Landings tab to create top and/or bottom landings.
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Create landings

Define whether one or two landings are created, or whether there are no
landings.

Landing dimensions and extensions

 Description
1

2

Thickness of the bottom landing.
Length of the bottom landing.

3

4

Length of the top landing.
Thickness of the top landing.

5

7

Left and right extensions of the bottom landing.

6

8

Left and right extensions of the top landing.

Ridges tab
Use the Ridges tab to create horizontal and/or vertical ridges on both sides or
only on the other side of the stairs.
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Dimensions

 Description
1

2

Thickness of the vertical ridge.
Width of the vertical ridge.

3

4

Width of the horizontal ridge.
Thickness/height of the horizontal ridge.

Horizontal ridges

Part Description
Create Define whether horizontal ridges are

created.
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Part Description
Create at foot Define whether horizontal ridges are

created at the foot of the stairs.

This option works in the same way as
the Create option.

Inside chamfer

1

Select the type of the inside chamfer
and enter the required dimensions.

Corner chamfer

2

Select the type of the corner chamfer
and enter the required dimensions.

Slope

3

Set the slope as an angle or a
dimension. The slope makes the ridge
inclined.

Foot corner chamfer Define whether corner chamfers are
created at the stair foot.

Top and foot ridges

Define the horizontal ridge length at the stair top step and at the stair foot.
When no foot is created, vertical ridges continue to the bottom level of the
stairs.
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Vertical ridges

Part Description
Create Define whether vertical ridges are

created.

Slope Set the slope as an angle or a
dimension. The slope makes the ridge
inclined.

Stringers tab
Use the Stringers tab to create stringers and ridges on the left, right, or both
sides of the stairs.

Parts

Part Description
Create stringers Define whether stringers are created.
Create top ridge Select an option to create top ridges.

Create bottom ridge Select an option to create bottom
ridges.
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Part Description
Slope Use to incline the inner surface of the

stringers.

You can define the slope using an
angle or a dimension.

Inside chamfer Define whether the inside edge of
stringer is chamfered or not.

Outside chamfer Define whether the outside edge of
stringer is chamfered or not.

Stringer height Define how the stringer height is
determined.

Dimensions

 Description
1 Height of the stringer bottom ridge.
2 Horizontal offset of the bottom ridge from the bottom step.
3 Height of the stringer top ridge.
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 Description
4 Width of the stringer.
5 Difference in height that is the perpendicular distance between the step

edge and stringer edge.

You can enter this dimension if Stringer height is Diff in height.
6 Total height of the stringer.

You can enter this dimension if Stringer height is Default or Total
height.

Anti-skid/Kick plate tab
Use the Anti-skid and Kick plate tabs to create slip resistant surfaces.

Parts

Part Description
Creation anti-skid

Creation kick plate

Define whether anti-skids or kick
plates are created.

Create anti-skid on foot Define whether anti-skids are created
at the stair foot.

Create cutout Define whether you want to create
cutouts with the anti-skid profile.

By default, the cutouts are not
created.

Include in cast unit Define whether anti-skids or kick
plates are included in cast unit.

Profile Define the anti-skid or kick plate
profile by selecting it from the profile
catalog.

Rotation Select an option to rotate the anti-
skid or kick plate profile.

Anti-skid/kick plate position
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 Description
1

2

Anti-skid or kick plate distance from the left edge of the step.
Anti-skid or kick plate distance from the right edge of the step.

 Description
1 Distance from the step front edge.
2 Depth for the anti-skid or kick plate.

Attributes tab
Use the Attributes tab to control the properties of different stair parts.

Part attributes

Option Description Default
Pos_No Prefix and Start number

for the part position
number.

Some components have a
second row of fields
where you can enter the
assembly position
number.

The default part start number
is defined in the Components
settings in File menu -->
Settings --> Options .

Material Material grade. The default material is defined
in the Part material box in the
Components settings in File
menu --> Settings -->
Options .

Name Name that is shown in
drawings and reports.

 

Class Part class number.  
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UDA tab
Use the UDA tab to provide additional information about the parts created.

TIP The user-defined attributes are case sensitive. Check the correct spelling
of an attribute from the objects.inp file.

Stairwells and elevator shafts (90)
Stairwells and elevator shafts (90) creates a rectangular stairwell or elevator
shaft to represent the structure in the design stage.

When you detail the structure, you can apply seams, connections, and
reinforcement to complete the details of a stairwell or elevator shaft. This
component uses the Concrete stairs (65) (page 3215) component for creating
stairs.

Parts created

• Wall panels

• Landings (optional)

• Flights of stairs (optional)

• Roof slab (optional)

• Openings (optional)

Where to use

Situation More information
A stairwell over four floors created
using the default options.

As shown, the points picked and the
dimensions on the Stairs and
landings tab determine the length of
the stairwell.

Walls consist of one or more precast
concrete panels.

1 First point picked

2 Second point picked
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Situation More information
Stairwells always contain a first floor
and a top floor. Indicate the number
of additional floors on the Plan view
tab, Levels field. This stairwell has 2
additional floors, for a total of 4
floors.

1 Top floor

2 Additional floor

3 Additional floor

4 1st or ground floor

Elevator shaft created by selecting the
Elevator shaft option on the Stairs
and landings tab, Type field, for all
floors.

Limitations

The minimum floor height between floors is 200 mm.

Picking order

1. On the Plan view tab, check the Position option. The default is in the
middle of walls 3 and 4.

2. Pick a point to indicate the position of wall 3.

3. Pick a point to indicate the position of wall 4.

Plan view tab
Use the Plan view tab to define the properties of the stairwell or elevator
shaft.
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To define the number of levels and floor heights, enter a height for each floor
level in the Levels field, for example:

You can also define negative floor levels, for example:

You can also use multiplier to define many floors, as in the following US
imperial example:

Tekla Structures also uses these values to calculate the total height of the
stairwell.

To create the stairwell or elevator shaft, you pick two points in the model. Use
the Position field to define the location of the stairwell or elevator shaft
relative to these points. The options are:

• Middle (default)

• Left

• Right

Enter the offset distance from the selected position. Here, the offset is from
the middle of wall.

To manually define the total length and total width of the stairwell or elevator
shaft, enter the following values:

L - total length

W - total width

Leave both fields blank to have Tekla Structures automatically calculate these
dimensions from the the points picked:
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 Description
1 First point picked.
2 Second point picked.
3 Total width, W
4 Total length, L

NOTE The dimensions defined on the Stairs and landings tab may override
the total length or width that is automatically calculated or that you
manually enter.

Openings tab
Use the Openings tab to define opening dimensions for each wall panel and
for the first, additional, and top floors.

Each wall may have a single opening, or no opening.

Stairs and landings tab
Use the Stairs and landings tab to define the stair and landing properties and
dimensions.

Select to create an elevator shaft from the Type list.

Attributes tab
Use the Attributes tab to define basic part properties for walls, stairs, and
landings.

You can also use the save properties from the Concrete stairs (65) (page 3215)
component for the first, additional, and top stairs.

Option Description
Pos_No To ensure correct numbering, define a

Prefix and a Start number for the
part position number of stair parts.

Enter the assembly position number
of the stair parts on the second row.

Material Define the material grade.
Name Define a name that is shown in

drawings and reports.
Class Define the part class number.

Reinforced concrete stair (95)
Reinforced Concrete Stair (95) creates reinforced concrete stairs.
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Objects created

• Stairs

• Landings (optional)

• Ridges (optional)

• Stringers (optional)

• Anti-skid (optional)

• Main bars and stirrups of stair reinforcement (Bar A - Bar L tabs) (optional)

• Meshes in stairs and landings (optional)

• Mesh bars (optional)

• Anchor bars (optional)

• Landing end bars (optional)

Use for

Situation Description
Reinforced concrete
stairs.

Reinforced concrete stairs
with chamfered steps,
ridges and stringers.
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Situation Description
Reinforced concrete stairs
with reinforced landings.

Selection order

1. Pick the first point to indicate the start point of the stairs.

2. Pick the second point to indicate the direction of the stairs.

3. Select any number of parts to be cut by the stairs (optional).

4. Click the middle mouse button to create the stairs.
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Parameters tab
Use the Parameters tab to control the shape of the stairs, number of steps,
stair creation method and the stairs width.

Stair dimensions

  Description
1 Horizontal dimension of the

steps area
2 Vertical dimension of the steps

area
3 Step length
4 Step height
5 Shape options for stair bottom
6 Shape options for stair top
7 Stair width

Start point position

Select the start point position of the polygon shape.

NOTE Start point position affects the bounding box of the cast-unit.
Therefore it will affect drawing view orientation and numbering.

Stair creation method

Option Description
P1 P2 step length Create stairs between points P1 and P2.

Stair dimension are defined by the distance between P1
and P2 and step length.

P1 P2 step height Create stairs between points P1 and P2.

Stair dimension are defined by the distance between P1
and P2 and step height.

P1 step length
step height N
steps

Create stairs from point P1 to point P2.

Stair dimensions are defined by P1 and step height,
length and number of steps.
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Option Description
P2 step length
step height N
steps

Create stairs from point P1 to point P2.

Stair dimensions are defined by P2 and step height,
length and number of steps.

P1 horizontal and
vertical step
distance

Create stairs from point P1 to point P2.

Stair dimensions are defined by P1 and horizontal and
vertical step distance.

P2 horizontal and
vertical step
distance

Create stairs from point P1 to point P2.

Stair dimensions are defined by P2 and horizontal and
vertical step distance.

Parts tab
Use the Parts tab to control the material, name, class, positioning, cast unit
type and step chamfering.

Step chamfer settings

Option Description
Middle for all All steps are chamfered according to the Middle

steps settings.
Bottom different Bottom step is chamfered according to the 1st step

at bottom settings.

All other steps are chamfered according to the
Middle steps settings.

Top different Top step is chamfered according to the Last top
step settings.

All other steps are chamfered according to the
Middle steps settings.

Bottom and top
different

Bottom step is chamfered according to the 1st step
at bottom settings.

Top step chamfered are according to the Last top
step settings. All other steps are chamfered
according to the Middle steps settings.

Step chamfer settings are set in the same way for 1st step at bottom, Middle
steps and Last top step.
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Option Description
Size of step cut is defined by the distance.

Size of step cut is defined by the angle.

Corner chamfer types

Corner chamfers 1. and 2. can be defined by the Radius x or by the sides of
the Chamfer x, y.

Create finished floor level

Select whether to create finished floor level. The finished floor level is defined
by a polygon created from an offset stairs polygon and it is used for drawings.

Define the profile, properties and offsets of the dummy part that is created at
each polygon vertex, and the position in depth. You can define different offsets
for floor level profiles for the steps, and the top and bottom landing, and the
vertical cover thickness.

Stairs and landings tab
Use the Stairs and landings tab to control the size and type of the bottom
landing and the top landing.
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Bottom landing cut option

Option Description
Bottom landing with no cut.

Bottom landing with cut defined by its length and
distance from the top side of landing.

Bottom landing with cut defined by its length and
distance from the bottom side of landing.

Bottom landing with L shape cut defined by its three
dimensions and distance from the top side of
landing.

Bottom landing cut defined by a profile and its
position in landing.

Top landing cut option

Option Description
Top landing with no cut.

Top landing with cut defined by its length and distance
from the top side of landing.

Top landing with cut defined by its length and distance
from the bottom side of landing.
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Option Description
Top landing with L shape cut defined by its three
dimensions and distance from the top side of landing.

Top landing cut defined by a profile and its position in
landing.

Landing dimensioning and openings

 Description
Use the top view setting to define the dimensions
of the bottom landing and the top landing.

Use the top view setting to define two openings
for the bottom and the top landing.

The following rebars avoid the created openings:
anchor and Z anchor bars, mesh bars, landing end
bars, and A, B, C, E, G, K bars.

Extra landings Define an individual name and class for the extra
landing parts.
Define the gaps on the sides of the landings.

Recesses and holes

Option Description
No hole or recess

Hole

Recess at the top face

Recess at the bottom face
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Ridges tab
Use the Ridges tab to create horizontal and/or vertical ridges on both sides or
only on one side of the stairs.

Dimensions

  Description
1 Thickness of the vertical ridge.
2 Width of the vertical ridge.
3 Width of the horizontal ridge.
4 Thickness/height of the horizontal ridge.

Horizontal ridges

Option Description
Create Define whether horizontal ridges are created.

Create at foot Define whether horizontal ridges are created at the foot
of the stairs.

This option works in the same way as the Create option.
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Option Description
Chamfering 1 Inside chamfer: Select the type of the inside chamfer

and enter the required dimensions.

2 Corner chamfer: Select the type of the corner chamfer
and enter the required dimensions.

3 Slope: Set the slope as an angle or a dimension. The
slope makes the ridge inclined.

Foot corner
chamfer

Define whether corner chamfers are created at the stair
foot.

Vertical ridges

Option Description
Create Define whether vertical ridges are created.

Slope Set the slope as an angle or a dimension. The slope
makes the ridge inclined.
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Stringers tab
Use the Stringers tab to create the stringers and ridges on the left, right, or
both sides of the stairs.

  Description
1 Height of the stringer bottom ridge.
2 Horizontal offset of the bottom ridge from the

bottom step.
3 Height of the stringer top ridge.
4 Width of the stringer.

Slope Use to incline the inner surface of the
stringers.

You can define the slope using an angle or a
dimension.

Inside chamfer Define whether the inside edge of stringer is
chamfered or not.

Outside chamfer Define whether the outside edge of stringer is
chamfered or not.

Stringer height

Stringer height based on the total height or distance from inner/outer step
corner.
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Stringer bars tab
Use the Stringer bars tab to create reinforcements in the stringers.

Option Description
Define the spacing of bars and the
concrete cover thicknesses.

Create Select to create the group of bars.
Grade Strength of the steel used in the

reinforcing bars.
Size Diameter of the reinforcing bar.
Radius Internal radius of the bends in the

bar.
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Class Use Class to group reinforcement.
Name Tekla Structures uses the name in

drawings and reports.

Anti-skid tab
Use the Anti-skid tab to create slip resistant surfaces.
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Option Description
Creation anti-skid Define whether anti-skids are created.
First bottom anti-
skid

Define the material, name and class of the anti-skid
profile at the bottom.

Last top anti-skid Define the material, name and class of the anti-skid
profile at the top.

Create anti-skid
on foot/top

Define whether anti-skids are created at the stair foot/
top.

Create cutout Define whether you want to create cutouts with the
anti-skid profile. By default, the cutouts are not created.

Include in cast
unit

Define whether anti-skids are included in the cast unit.

Profile Define the anti-skid profile by selecting it from the
profile catalog.

Rotation Select an option to rotate the anti-skid profile.
Offsets Define the anti-skid profile offsets on the steps.

Bar A tab
Use the Bar A tab to define the geometry, concrete cover thickness, reinforcing
bar spacing and reinforcing bar properties of a stair reinforcing bar group.
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Option Description
Geometry and concrete cover thickness.

Spacing, number of bars and concrete cover
thickness of the reinforcing bar group.

Bar B tab
Use the Bar B tab to define the geometry, concrete cover thickness, reinforcing
bar spacing and reinforcing bar properties of a stair reinforcing bar group.

Bar B bottom ending options

Define geometry and concrete cover thickness of the bar B bottom ending.

Option Description
Bar B simple bottom ending.

Bar B bottom ending bent once to fit the
bottom footing of the stairs.
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Option Description
Bar B bottom ending bent twice to fit the
bottom footing of the stairs.

Bar B bottom ending bent up to three times
to fit the bottom footing of the stairs.

Bar B top ending options

Define geometry and concrete cover thickness of the bar B top ending.

Option Description
Bar B simple top ending.

Bar B top ending bent once to fit the top
geometry of the stairs.

Bar B top ending bent twice to fit the top
geometry of the stairs. Last leg length is
defined by the cover thickness.

Bar B top ending bent twice to fit the top
geometry of the stairs.
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Reinforcing bar spacing

Option Description
Spacing, number of bars and concrete
cover thickness of the reinforcing bar
group.

Bar C tab
Use the Bar C tab to define the geometry, concrete cover thickness, reinforcing
bar spacing and reinforcing bar properties of a stair reinforcing bar group.

Option Description
Geometry and concrete cover thickness.

Define which extra side bars are created, their end
conditions, and the concrete cover.

Spacing, number of bars and concrete cover
thickness of the reinforcing bar group.

Extra I bars

Option Description
The purple color in the dialog box represents the
extra I bars.
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Option Description
Define whether to create the extra I bars. Select
the check boxes next to the purple points.

Select the nose shape adaptation. The first check
box (the dot on the left) creates the extra I bar
and the second creates a hook on it.

Cover thickness of the reinforcing bars.

Bar D tab
Use the Bar D tab to define the geometry, concrete cover thickness,
reinforcing bar spacing and reinforcing bar properties of a stair reinforcing bar
group.
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Option Description
Geometry and concrete cover thickness.

Spacing, number of bars and concrete cover
thickness of the reinforcing bar group.

Extra I bars

Extra I bars are straight bars crossing bar D. You can create up to four extra I
bars.

Option Description
The purple color in the dialog box represents
the extra I bars.

Define whether to create the extra I bars.
Select the check boxes next to the purple
points.

Cover thickness of the reinforcing bars.
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Bar E tab
Use the Bar E tab to define the geometry, concrete cover thickness, reinforcing
bar spacing and reinforcing bar properties of a stair reinforcing bar group.

Create options

Option Description
No Bar is not created.

Stirrup Bar is created as stirrup.
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Option Description
Pin Bar is created as pin.

Option Description
Geometry and concrete cover thickness.

Spacing, number of bars and concrete cover
thickness of the reinforcing bar group.
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Option Description
Shape of the stirrups.

Parallel with step slope Yes

Create parallel with sloped step shape.
No

Create as a rectangle.

Extra I bars

Extra I bars are straight bars crossing bar D. You can create up to four extra I
bars.

Option Description
The purple color in the dialog box represents
the extra I bars.

Define whether to create the extra I bars.
Select the check boxes next to the purple
points.

Cover thickness of the reinforcing bars.
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Bar F tab
Use the Bar F tab to define the geometry, concrete cover thickness, reinforcing
bar spacing and reinforcing bar properties of a stair reinforcing bar group.

Option Description
Geometry and concrete cover thickness.

Spacing, number of bars and concrete cover
thickness of the reinforcing bar group.

Bar G tab
Use the Bar G tab to define the geometry, concrete cover thickness,
reinforcing bar spacing and reinforcing bar properties of a stair reinforcing bar
group.
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Option Description
Geometry and concrete cover thickness.

Spacing, number of bars and concrete cover
thickness of the reinforcing bar group.

Extra I bars

Extra I bars are straight bars crossing bar G. You can create up to four extra I
bars.

Option Description
The purple color in the dialog box
represents the extra I bars.

Define whether to create extra I bars.
Select the check boxes next to the purple
points.

Cover thickness of the reinforcing bars.

Bar H tab
Use the Bar H tab to define the geometry, concrete cover thickness,
reinforcing bar spacing and reinforcing bar properties of a stair reinforcing bar
group.
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Create option

Option Description
• Do not create bar H

• Create bar H

• Create only bottom bar H reinforcing bar
group

Bar H geometry option

Option Description
Two bent reinforcing bar groups. Define
geometry and concrete cover thickness.

Top reinforcing bar group is straight, bottom
reinforcing bar group is bent on both sides.
Define geometry and concrete cover
thickness.

Two straight reinforcing bar groups. Define
geometry and concrete cover thickness.

Two reinforcing bar groups. Define geometry
and concrete cover thickness.

Reinforcing bar group that is bent on one
side. Define the concrete cover thickness
and whether to create hooks.

You can create multiple overlapping stirrups
in a row. Define the overlap dimension and
the number of stirrups.

Properties

You can define separate properties for bottom and top rebars.
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Option Description
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.
Prefix Prefix for the part position number.
Start number Start number for the part position

number.

Bar I tab
Use the Bar I tab to define the geometry, concrete cover thickness, reinforcing
bar spacing and reinforcing bar properties of a stair reinforcing bar group.

Option Description
Positioning, spacing and concrete cover
thickness.

Concrete cover thickness of the reinforcing
bar groups.

Bar J tab
Use the Bar J tab to define the geometry, concrete cover thickness, reinforcing
bar spacing and reinforcing bar properties of a stair reinforcing bar group. You
can create several bar J reinforcing bar groups. Each group has its own color
representation on the Bar J tab.
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Color group options

Option Description
Use the color group option to define which
combination of bar J reinforcing bar groups
(blue, green, brown) is created.

Option Description
Positioning and concrete cover thickness for
reinforcing bar groups based on the color
representation.

Concrete cover thickness for all reinforcing bar
groups.

Bar K tab
Use the Bar K tab to define the geometry, concrete cover thickness, reinforcing
bar spacing and reinforcing bar properties of a stair reinforcing bar group.
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Option Description
Select the geometry and define the concrete
cover thickness.

Spacing, number of bars and concrete cover
thickness of the reinforcing bar group.

Extra I bars

Extra I bars are straight bars crossing bar K. You can create up to three extra I
bars.

Option Description
The purple color in the dialog box
represents the extra I bars.

Define whether to create extra I bars
by selecting the check boxes next to
the purple points.

Cover thickness of the reinforcing
bars.

Bar L tab
Use the Bar L tab to define the geometry, concrete cover thickness, reinforcing
bar spacing and reinforcing bar properties of a stair reinforcing bar group.
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Option Description
Define whether an L shaped reinforcing bar group
is created at the stair footing.

Define whether an L shaped reinforcing bar group
is created at the stair top or whether all bars are
created with the same geometry.

Define offsets for the reinforcing bar groups in the
two top steps.

Define whether reinforcing bars are created
between the top and bottom step.

Define geometry for reinforcing bar groups in all
steps, except for the two top steps.

Spacing, number of bars and concrete cover
thickness of the reinforcing bar group.

Bar L geometry options

The geometry options affect the middle and the bottom steps.

Option Description
L shape reinforcing bar groups.
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Option Description
L shape reinforcing bar groups with hooks.

Mesh picture tab
Use the Mesh picture tab to define bottom landing meshes, stair meshes and
top landing meshes.

Side view

  Description
1 Bottom landing mesh (top).

Define offsets and cover thickness
of the mesh.

2 Bottom landing mesh (bottom).
Define offsets and cover thickness
of the mesh.

3 Stair mesh (top). Define offsets
and cover thickness of the mesh.

4 Stair mesh (bottom). Define
offsets and cover thickness of the
mesh.

5 Top landing mesh (top). Define
offsets and cover thickness of the
mesh.

6 Top landing mesh (bottom).
Define offsets and cover thickness
of the mesh.

Top view

  Description
1 Cover thickness of bottom landing

mesh (top).
2 Cover thickness of bottom landing

mesh (bottom).
3 Cover thickness of stair mesh (top).
4 Cover thickness of stair mesh (bottom).
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  Description
5 Cover thickness of top landing mesh

(top).
6 Cover thickness of top landing mesh

(bottom).

Mesh attributes tab
Use the Mesh attributes tab with the Mesh picture tab to define the
properties, positioning and creation type of bottom landing meshes, stair
meshes and top landing meshes.

Cross bar location

 Description
Cross bar above.

Cross bar below.

Creation type

 Description
Create mesh as reinforcement mesh.

Create mesh as two independent reinforcing
groups.
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Mesh bars tab
Use the Mesh bars tab to define the geometry, concrete cover thickness,
reinforcing bar spacing, and reinforcing bar properties of the mesh bars in the
top and bottom landing. You can create up to three reinforcing bar groups.

  Description
1 Cover thicknesses of all mesh bar

groups in the stair bottom landing.

Use the color representation in the
dialog box.

2 Vertical cover thicknesses of all mesh
bar groups in the stair bottom landing.

Use the color representation in the
dialog box.

3 Cover thicknesses of all mesh bar
groups in the stair top landing.

Use the color representation in the
dialog box.

4 Vertical cover thicknesses of all mesh
bar groups in the stair top landing.

Use the color representation in the
dialog box.

Bottom anchor bars tab
Use the Bottom anchor bars tab to define the geometry, concrete cover
thickness, reinforcing bar spacing, and reinforcing bar properties of the
bottom anchor bars. You can create up to three reinforcing bar groups.

Creation type

Option Description
No No reinforcing bar group created.
Type1 L shape anchor reinforcing bar group.
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Option Description
Type2 Simple straight anchor reinforcing bar group.

Top anchor bars tab
Use the Top anchor bars tab to define the geometry, concrete cover thickness,
reinforcing bar spacing, and reinforcing bar properties of the top anchor bars.
You can create up to three reinforcing bar groups.

Creation type

Option Description
No No reinforcing bar group created.
Type1 L shape anchor reinforcing bar group.

Type2 Simple straight anchor reinforcing bar group.

Z anchor bars tab
Use the Z anchor bars tab to define the geometry, concrete cover thickness,
reinforcing bar spacing, and reinforcing bar properties of the Z anchor bars.
You can create up to three reinforcing bar groups.
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  Description
1 Cover thicknesses of all Z

anchor bar groups in the
stair bottom landing.

Use the color
representation in the
dialog box.

2 Vertical cover thicknesses
of all Z anchor bar groups
in the stair main part.

Use the color
representation in the
dialog box.

3 Cover thicknesses of all Z
anchor bar groups in the
stair top landing.

Use the color
representation in the
dialog box.

Bot
L

Length of the Z anchor
bars that extend from the
stair bottom landing.

Top
L

Length of the Z anchor
bars that extend from the
stair top landing.

Landing end bars tab
Use the Landing end bars tab to reinforce the stair landings and to define the
geometry, concrete cover thickness, reinforcing bar spacing, and bar
properties of the landing end bars.

Bottom end

Reinforcement of bottom landing.

  Description
1 Landing end bars. U-shape geometry follows

the shape of the landing based on the
defined cover thicknesses.

Color representation in the picture: blue,
green.

2 Define whether to create extra cross bars.
Select the check boxes next to the purple
points.
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  Description
3 Define whether to create extra cross bars.

Select the check boxes next to the red
points.

Top end

Reinforcement of top landing.

  Description
1 Landing end bars. U-shape geometry follows

the shape of the landing based on defined
cover thicknesses.

Color representation in the picture: blue,
green.

2 Define whether to create extra cross bars.
Select the check boxes next to purple points.

3 Define whether to create extra cross bars.
Select the check boxes next to red points.

Side cover thickness

Option Description
Side cover thickness of all reinforcing bar groups
defined on the Landing end bars tab.

UDA tab
Use the UDA tab to define user-defined attributes for the stairs. You can
define multiple UDAs. UDAs can be used as filters, and they can be displayed
in drawings and reports.

Configuration tab
Use the Configuration tab to define the default cover thicknesses and
bending radiuses of all reinforcing bars created by Reinforced Concrete Stair
(95).

Cover thickness for reinforcing bar groups A - C

Define the default cover thickness for reinforcing bar groups A - C.

Option Description
Value Default cover thickness defined by a value.
Rebar diameter Default cover thickness multiplied by reinforcing

bar diameter.
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General cover thickness bars D - L

Define the default cover thickness for reinforcing bar groups D - L and all
reinforcing bars except the reinforcing bar groups A - C and meshes.

Option Description
Value Default cover thickness defined by a value.
Rebar diameter Default cover thickness multiplied by reinforcing

bar diameter.

Bending radius

Define the default bending radius of all reinforcing bars.

Option Description
Rebar_database.inp Default bending radius defined by

rebar_database.inp file.
Relative to diameter Default bending radius according to the

reinforcing bar diameter.
Bending radius Default bending radius defined by value.

Mesh cover thickness

Define the default cover thickness for the meshes created by Reinforced
Concrete Stair (95).

Foundations
This section introduces components that can be used in concrete foundations.

Click the links below to find out more:

• Precast foundation block (1028) (page 3267)

• Concrete foundation (1030) (page 3274)

Precast foundation block (1028)
Precast foundation block (1028) creates a concrete foundation block. The
block can be divided in three sections. All three sections can be dimensioned
separately.

Parts created

• Foundation block

• Embed

• Regulator
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Use for

Situation Description
Precast foundation block with three
sections.
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Situation Description
Precast foundation block with one
section.

Selection order

1. Select the main part (concrete column).

2. Pick a position.

The detail is created automatically.

Picture tab
Use the Picture tab to dimension the foundation block.
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The foundation block can be dimensioned in both the front view and in the
side view.

 Description
1 Width of the top chord in section 1 (in front view).
2 Width of the inclined column cut-out.
3 Height of the column cut-out.
4 Offset of the plate that is under the block.

The offset is relative to the foundation block.
5 Thickness of the plate under the block.
6 Width of the bottom chord in section 1 (in front view).

Width of section 2 and section 3 (in front view).
7 Distance between the foundation block and the sides of the column.
8 Select how the sections in the foundation block are connected.
9 Select the reference point of the

foundation block.
Component
insertion point is
at the bottom side
of the foundation
block.
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 Description
Additionally, you can set the
vertical offset:

Note that the red
part (additional
plate under the
block) is not taken
into account.

Component
insertion point is
at the bottom side
of the cut-out of
the column.

Component
insertion point is
at the bottom side
of the column.

Component
insertion point is
at the top of the
foundation block.

10 Width of the top chord in section 1 (in side view).
11 Distance from the bottom of the column to the foundation block.
12 Width of the bottom chord in section 1 (in side view).

Width of section 2 and section 3 (in side view).
13 Select the cast unit type.
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Parts tab
Use the Parts tab to define the profiles for the foundation block, embed and
regulator, and the embed dimensions.

Opti
on

Description

1 Foundation block profiles, regulator and embed properties.

If you do not select any material, Precast foundation block (1028)
uses the same material as the column.

Select Yes in Create filling to create a filling between the column and
the first created block.

2 Select whether the regulator and the embed is created, and how they
are connected to the foundation block.

3 Dimensions of the three sections of the foundation block.

Additionally, you can define the column cut-out in the upper section.

For sections 2 and 3 you can define the height of the inclined plane.
4 Dimensions of the embed.

Grooves tab
Use the Grooves tab to define the grooves.
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Example:

 Description
1 Height of the groove.
2 Distance between the grooves.
3 First distance related to the bottom of the column.
4 Depth for the grooves.
5 Number for the grooves.
6 Select whether to define a slope angle or dimension for the grooves.
7 Define the slope angle or dimension value.

General tab

Click the link below to find out more:
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Analysis tab

Click the link below to find out more:

Analysis tab

Concrete foundation (1030)
Concrete foundation (1030) creates a concrete foundation plate at the
bottom of a selected concrete column.

Objects created

• Concrete foundation plate

• Injection tubes and injection hoses in concrete column

• Up to 4 concrete piles under the foundation plate (optional)

• Stirrups for the reinforcing bars

Use for

Situation Description
Concrete foundation plate with
chamfers, piles, injection tubes with
curved injection hoses, reinforcing
bars and stirrups.
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Situation Description
Concrete foundation plate with more
than 4 edges, recesses in the
foundation plate, and multiple
reinforcing bars.

Concrete foundation plate with
multiple reinforcing bars.

Selection order

1. Select a concrete column.
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2. Pick a point.

The concrete foundation plate is created automatically when the point is
picked.

Part identification key

 Part
1 Concrete column
2 Point

The point defines the new bottom level of the column.

Picture tab
Use the Picture tab to control the dimensions of the reinforcing bars and
injection tubes.
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Dimensions

 Description Default
1 Length of the injection tube extension

from the top of the reinforcing bar.
180 mm

2 Reinforcing bar height in the column. 400 mm
3 Offset of the injection tube from the

bottom of the column.
 

4

5

Reinforcing bar top and bottom cover
thickness.

The bottom cover thickness is used only
if you do not define the top cover
thickness.

0,5 * foundation
plate thickness

6 Pile thickness.

The pile thickness value on the Parts tab
overrides this value.

300 mm

7 Distance from the bottom of the
foundation plate to the bottom of the
pile.

5000 mm

8 Pile depth in the foundation plate. 50 mm
9 Foundation plate thickness. 800 mm
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 Description Default
10 Distance between the column and the

foundation plate.
0 mm

11 Vertical offset from the picked point. 0 mm

12 Reinforcing bar height. 800 mm 400 mm + 50%
of height of concrete
footing

13 Injection tube elevation 1. 500 mm
14, 15 Injection tube elevations 2 and 3.

Vertical offset for the injection tubes if
the tubes are pointing to the same
direction.

Define the level to use on the Inj. Tube
and rebar tab.

 

Injection tube

Select the shape and dimensions of the injection tubes. Sloping injection hoses
are fitted to the column edge.

Concrete components 3278 Concrete detailing



Option Description
Injection tube in one piece, 90 degree angle.

Injection tube in one piece.

Use value a to define the slope of the tube.

Injection tube and a 90 degree injection hose.

Injection tube and a sloped injection hose.

Use value a to define the slope of the hose.
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Option Description
Straight injection tube. No injection tube opening is
created.

 Description Default
1 Define the height of a sloped injection

tube or hose angle.
30 mm

2 Define the height of a curved injection
hose.

0 mm

Reinforcing bar hook length

Define the reinforcing bar hook length. You can define also the end angle of
the reinforcing bar.

The default value is 10 * reinforcing bar diameter.
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Parts tab
Use the Parts tab to control the profile properties of the foundation plate,
foundation piles, stirrups and injection tubes.

Part properties

Define the part profile properties.

If you leave the pile thickness value empty on the Parts tab, the pile thickness
value defined on the Picture tab is used instead together with the Pile profile
type prefix (e.g. D).

Option Description
t, b, h Define the thickness, width, and height of the

foundation plate and piles, or select the
profile from the profile catalog.

Pos_No Prefix and a start number for the part
position number.

Material Material grade.
Name Name that is shown in drawings and reports.
Class Part class number.
Comment Add a comment for the part.
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Reinforcing bars

Option Description
Type of reinforcing bars Select the profile type for the reinforcing bars.

• Default: the same as Reinforcing bar

• Poly-profile: profile catalog

• Reinforcing bar: reinforcing bar catalog

• Polyprofile (as sub-assembly): profile
catalog. Create the polyprofile as a sub-
assembly to the foundation part.

Reinforcement bars Size of the reinforcing bars.
Radius Radius of the reinforcing bar hook.
Reinf. bars belong to Define to which part the reinforcing bars belong.

• Default: the same as Columns

• Concrete massive: reinforcing bars belong to
the concrete foundation plate.

• Column: reinforcing bars belong to the
column.

• Loose part: reinforcing bars are not
connected to any part.

• Neighbor: reinforcing bars belong to the
neighbor part. Use the name or class to find
the part.

Injection tubes and curve

Option Description
Injection tubes

Curve

Size of the injection tubes.

Size of the injection hoses.
Article number Article number for the injection hose

and the injection tube.

The entered values are saved to the
user-defined attribute of the part.

 Define how the injection hoses are
connected to the injection tubes.

• Default: injection hoses are loose
parts.

• Part-add gain: injection hoses are
added to the injection tubes.
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Option Description
• Weld gain: injection hoses are

welded to the injection tubes.

• Cast unit column: injection hoses
are added to the column.

• Weld to column: injection hoses
are welded to the column.

Option Description
Pile profile type prefix (e.g. D) Default parametric profile prefix for

the piles.

This value works only if you have set
the pile thickness on the Picture tab.

You can override this value by setting
the pile thickness on the Parts tab.

Reinf. bar profile type prefix (e.g.D) Default parametric profile prefix for
the reinforcing bar profiles.

Massive tab
Use the Massive tab to control the shape and the dimensions of the concrete
foundation plate and the recesses.

Concrete foundation plate type

Option Description
Type of massive Select the plate type for the rectangular

foundation plate.
Massive direction Select the direction of the foundation plate.

Concrete foundation plate dimensions

Concrete components 3283 Concrete detailing



 Description
1

2

Offset from the concrete column in the x direction.
Offset from the concrete column in the y direction.

3 Select the shape of the foundation plate.
4 Width of the foundation plate.
5

6

Length of the straight part of the foundation plate.

7 Offset from the foundation plate center line.
8 Width of the straight part of the foundation plate.
9 Length of the foundation plate.

Recess dimensions
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 Description
1 Select the type of the recess.
2 Width of the recesses.
3 Depth of the recesses.
4 Distance between the bottom of the reinforcing bar and

the bottom of the recess.
5

6

Distance between the center line of the reinforcing bar
and the left side of the recess.
Distance between the center line of the reinforcing bar
and the right side of the recess.

Option Description
Chamfer type for
rectangular massive

Chamfer type for the rectangular foundation
plate.

Chamfer X Chamfer size in the x direction.
Chamfer Y Chamfer size in the y direction.

Piles tab
Use the Piles tab to control the position of the foundation piles.

Pile positions

Description
1 Select the position and the offset of the piles.
2

4

6

8

Distance between the first pile and the column in the x
direction.
Distance between the second pile and the column in the x
direction.
Distance between the third pile and the column in the x
direction.
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Description
Distance between the fourth pile and the column in the x
direction.

3

5

7

9

Distance between the first pile and the column in y direction.
Distance between the second pile and the column in y
direction.
Distance between the third pile and the column in y direction.
Distance between the fourth pile and the column in y direction.

10

11

Pile offset from the concrete column in the x direction.
Pile offset from the concrete column in the y direction.

Option Description
Piles direction Define the direction of the piles.
Join piles to massive Define how the piles are connected to the

foundation plate.

Inj. tube and rebar tab
Use the Inj. tube and rebar tab to control the creation, number and position
of the reinforcing bars and injection tubes.

Option Description
Create Select which parts are created.
Injection tubes bend
radius

Radius of the injection tubes.
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Injection tube properties

Description
1 Select the direction of the bent bars.
2 Select the direction of the injection hoses.
3 Number of injection tubes.
4 Center-to-center distance between the injection tubes.
5 Define the level of the curved injection parts.

This is useful if the curved parts are pointing to the same
direction.

You can define the levels on the Picture tab.
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Description

Example:

6 Define the distance from the center of the injection tube to the
outer contour of the concrete foundation.
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Example

Column tab
Use the Column tab to control the dimensions of the column cut-out.
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Column dimensions

 Description
1 Size of the column cut-out.
2 Height of the column cut-out.

Stirrups tab
Use the Stirrups tab to control the stirrup properties.

Stirrup properties

Option Description
Select whether the stirrups are created.

Define the length of the laps.

Grade Grade of the stirrups.
Size Size of the stirrups.
End conditions left Hook for the start point of the stirrups.
End conditions
right

Hook for the end point of the stirrups.

Bend lengths left Hook length for the start point of the stirrup.
Bend lengths right Hook length for the end point of the stirrup.
Creation method Creation method of the stirrups.

Number of bars: Enter the number of the stirrups.
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Option Description

By spacing: Enter a spacing value.

 Define the comment, name, class, serie and start
number for the stirrups.
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 Description
1 Select the start point of stirrups, either from the bottom of the

column to the first stirrup or from the top of the reinforcing bar to
first stirrup.

2 Define the distance from the bottom of the reinforcing bar to the
last stirrup.

Example

General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

3.2 Reinforcement
This section introduces components that can be used in reinforcement.
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See also

Reinforcement for foundations (page 3293)

Beam, column, and slab reinforcement (page 3316)

Lifting (page 3570)

Reinforcement for foundations
Tekla Structures includes the following components that you can use to
automatically create reinforcement for foundations:

• Strip footing reinforcement (75) (page 3293)

• Pile cap reinforcement (76) (page 3297)

• Pad footing reinforcement (77) (page 3303)

• Starter bars for pillar (86) (page 3310)

• Starter bars for footing (87) (page 3312)

Strip footing reinforcement (75)
Strip footing reinforcement (75) creates reinforcement for a concrete strip
footing.

Bars created

• Longitudinal bars for the top and bottom surfaces and sides of the footing

• Stirrups

Use for

Situation More
information

Straight strip footings that have
rectangular cross sections

 

Main bars entirely
inside the footing,
no side bars,
stirrup laps at
stirrup corners.
Main bars
protruding from
the footing, two
bars on both
sides, stirrup laps
in the middle of
the top surface.
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Do not use for

Footings that have:

• Irregular cross sections

• Skew or cut corners

Before you start

• Create the concrete strip footing.

• Calculate the required area of reinforcement.

Selection order

1. Select the concrete strip footing.

Picture tab
Use the Picture tab to define the concrete cover thickness and stirrup offset.

Cover thickness

 Description
1 Cover thickness (strip ends)
2 Stirrup offset
3 Cover thickness (top and bottom)

Main bars tab
Use the Main bars tab to define the properties of top, bottom, left and right
bars.

Bond length of main bars

Bond lengths define how far main bars extend into adjacent structures at the
ends of strip footings. Use the Bond length 1 boxes for the first end of the
footing (with the yellow handle), and the Bond length 2 boxes for the second
end of the footing (with the magenta handle).

You can define bond lengths separately for:

• Top bars

• Bottom bars
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• Bars on the left side of the footing

• Bars on the right side of the footing

Stirrups tab
Use the Stirrups tab to define stirrup properties and spacing type.

Bend type

Select the location of the stirrup laps in the strip footing.

Option
At mid

At corner

U-shaped

U-shaped

Enter the overlap length in
the Transverse picture for
the first two options.
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Option

Double stirrup bars

Straight transverse bar

Stirrup dimensions

 Description
1 Cover thickness (sides)
2 Outer distance between the main bars and outer side bars
3 Overlap length of the double stirrup
4 Overlap length of the double U-bars

Bending direction

 Option
1

2

3
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 Option
4

End shape of double stirrup bars

If you selected double stirrup bars, you can select the end shapes for bars
from the list.

Option Examples
135-degree

Default

90-degree

Overlapped

If you select overlapped, you
can enter the overlap length.

Attributes tab
Use the Attributes tab to define the numbering properties of bars and
stirrups.

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Pile cap reinforcement (76)
Pile cap reinforcement (76) creates reinforcement for a concrete pile cap.

Bars created

• Bars in two directions for the top and bottom surfaces of the pile cap
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• Lacer bars

Use for

Situation More information
Bottom bars concentrated
over the piles, top bars
under the column. Two lacer
bars.

Bars evenly distributed on
the bottom and top
surfaces. No lacer bars.

Rectangular footings with or
without cut corners, footings
that are skewed on one or both
sides

Pad footing and pile cap
shapes

Bars on the top, bottom, or
both surfaces of the footing

 

Straight or bent bar ends  

Pad footing and pile cap shapes

Use the Pile cap reinforcement (76) to create reinforcement for the following
shapes of foundations:

Shape Description
Rectangular

Skewed on two sides
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Shape Description
Skewed on one side

Rectangular with cut corners

Before you start

• Create the concrete pile cap.

• Calculate the required area of reinforcement.

Selection order

1. Select the concrete pile cap.

2. Select the piles and/or columns.

3. Click the middle mouse button to finish.

Picture tab
Use the Picture tab to define the concrete cover thickness and primary bar
direction.
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Enter the concrete cover thicknesses:

Select the primary bar direction to either Parallel with longer dimension or
Parallel with shorter dimension.

Primary/Secondary top bars and Primary/Secondary bottom bars tabs
Use the Primary/Secondary top bars and Primary/Secondary bottom bars
tabs to define the bar properties.

Bar properties

Option Description
Grade Strength of the steel used in the

reinforcing bar. This field cooperates
with the Size field.

Size Diameter of the reinforcing bar.
Pressing the ... button right of the
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Option Description
field will open the Select rebar dialog
box.

In the dialog box you can select the
grade and the accompanying
diameter.

NOTE Selecting a size will override
the value in the Grade field.

End conditions left/right Defines the shape of the rebar end.

Default value is Straight.
Bend lengths left/right Defines the length of the left/right

end-extension.
Creation method Number of bars

A fixed number of bars is created. The
spacing between the bars is
automatically calculated.
By spacing

A accompanying field becomes active.
The entered value is the fixed spacing
for the rebars. The number of rebars
is calculated automatically.

Pile caps

Define the pile cap reinforcement using the following properties:

Field Description
To suit pile/column Select Yes to concentrate main

bars over piles and under columns.
% of pile/column
width

The area where the bars are
concentrated, as a percentage of
the width of the pile or column.

For example, if the pile diameter or
width is 500 mm, enter 120 in the
% of pile width field to
concentrate bars in a 600 mm-wide
area over the pile.

Bar portioning (%) The proportion of bars
concentrated over a pile or under a
column.
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Field Description
Bar portioning
(number of bars)

The number of bars concentrated
over a pile or under a column.

Lacer bars tab
Use the Lacer bars tab to create and define lacer bars.

Lacer bars are reinforcing bars that loop around the sides of a concrete
footing.

You can create up to six different groups of lacer bars in a footing. Each group
can contain different values for:

• Grade

• Bar size

• Number of bars

• Spacing

• Shape

• Dimensions

To create lacer bars for a footing:

1. In the Lacer bar option list box, select Yes to create lacer bars.

2. Enter properties for each lacer bar group:

Property Description
Quantity, spacing, and location of
lacer bar groups.

Tekla Structures only uses
information from some of the fields,
in this order of priority:

1. Number of bars and Spacing

2. Number of bars, Start, and End

3. Spacing, Start, and End

Type The number and location of laps. The
options are:
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Property Description
Orientation The options are Default, Front, and

Back.
p1...p4

L1...L4

The exact locations and lengths of
lacer bar laps. Locations are
measured from the corner of the bar
to the midpoints of laps.

The location of the topmost lacer bar,
measured from the end of main bars.

Entering a value here overrides the
location defined in the End field.

Attributes tab
Use the Attributes tab to define numbering properties of bars.

Option Description
Prefix Prefix for the bar position number.
Start number Start number for the bar position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Pad footing reinforcement (77)
Pad footing reinforcement (77) creates reinforcement for a concrete pad
footing.

Bars created

• Bars in two directions for the bottom surface of the pad footing

• Lacer bars
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Use for

Situation More information
Rectangular footing, 90-degree hooks
at the primary bar ends, 180-degree
hooks at the secondary bar ends, no
lacer bars.

Rectangular footing, three zones of
primary bars with different spacing,
straight bar ends, three lacer bars.

Footing skewed on two sides, two
groups of lacer bars with different
spacing.

Rectangular footings with or without
cut corners, footings that are skewed
on one or both sides

Pad footing and pile cap shapes

Pad footing and pile cap shapes

Use the Pad footing (77) to create reinforcement for the following shapes of
foundations:

Shape Description
Rectangular
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Shape Description
Skewed on two sides

Skewed on one side

Rectangular with cut corners

Before you start

• Create the concrete pad footing.

• Calculate the required area of reinforcement.

Selection order

1. Select the concrete pad footing.

Add a pad footing reinforcement using Pad footing reinforcement (77)

1. Create a pad footing.

2. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

3. Enter pad footing in the search box.

4. Select Pad footing reinforcement (77).

5. Select the pad footing.
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Tekla Structures inserts the lacer bar and bottom reinforcement in the pad
footing.

Picture tab
Use the Picture tab to define the conrete cover thickness.

Enter the concrete cover thicknesses on the plane and from the plane.
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Mesh alignment

Option Description
Square mesh Set the alignment of the secondary

bars of the created mesh
perpendicular to the primary bars.

Mesh aligned to both sides Align the primary and secondary bars
to the skewed edges.

Primary/Secondary bar tab
Use Primary/Secondary bar tabs to define the bar properties.

Pad footings

In pad footings, you can arrange the main reinforcing bars into:

• One zone of bars that have the same bar properties
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• Three zones of bars that have different bar properties

You set the options separately for primary and secondary bars. Select an
option from the Arrangement list box.

Hooks

Select to create hooks from Left end hook and Right end hook.

You can create the hooks as custom hooks from dropdown list.

Lacer bar tab
Use the Lacer bar tab to define the lacer bar properties.

Lacer bars are reinforcing bars that loop around the sides of a concrete
footing.

You can create up to six different groups of lacer bars in a footing. Each group
can contain different values for:

• Grade

• Bar size

• Number of bars

• Spacing

• Shape

• Dimensions

To create lacer bars for a footing:

1. Open the footing reinforcement properties dialog box and click the Lacer
bars tab.

2. In the Lacer bar option list box, select Yes to create lacer bars.

3. Enter properties for each lacer bar group:

Property Description
Quantity, spacing, and location of
lacer bar groups.

Tekla Structures only uses
information from some of the fields,
in this order of priority:

1. Number of bars and Spacing

2. Number of bars, Start, and End

3. Spacing, Start, and End
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Property Description
Type The number and location of laps. The

options are:

Orientation The options are Default, Front, and
Back.

p1...p4

L1...L4

The exact locations and lengths of
lacer bar laps. Locations are
measured from the corner of the bar
to the midpoints of laps.

The location of the topmost lacer bar,
measured from the end of main bars.

Entering a value here overrides the
location defined in the End field.

Attributes tab
Use the Attributes tab to define numbering properties.

Field Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use the Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.
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Starter bars for pillar (86)
Starter bars for pillar (86) creates starter bars in a footing and a pedestal for
a column. Starter bars may go through a pedestal or straight to the column.
Starter bars can be in a rectangular or circular form.

Bars created

• Starter bars (straight or L-shaped)

• Stirrups (optional)

Use for

Situation More information
Starter bars for pillar (86)
creates straight or L-shaped
starter bars that go through
a rectangular or circular
pedestal. Starter bars can
have stirrups.

Before you start

• Create the footing.

• Calculate the required area of reinforcement.

Selection order

1. Footing

2. Pedestal

Picture tab
Use the Picture tab to define bar dimensions and locations, spacing of bars,
stirrup type, and concrete cover thickness.

Select the shape of the starter bars:

Option Description
L-shaped starter bars.

Define the length of the bar.
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Option Description
Straight starter bars.

L-shaped starter bars.

Define concrete cover thickness.

Select the shape for the top of the starter bars:

Option Description
The top of the starter bars is straight.

Default

The top of the starter bars is bent.

Define the length of the bent part.

Option Description
Number of stirrups/Spacing Define the number of stirrups and

their spacing.

Use a space to separate spacing
values. Enter a value for each space
between the reinforcing bars. For
example, if there are 3 reinforcing
bars, enter 2 values.

Create corner bars Select to create corner bars.

Default value is Yes.
Select the placement of the corner
bars.

Grade Define the grade of the reinforcing
bar.

Size Define the size of the reinforcing bar.
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Option Description
Bending radius Define the bending radius of the

reinforcing bar.

Stirrups

Use these options to define stirrup laps in footings:

Option Description
Laps on the side of the stirrups

45-degree hooks at bar ends

Laps at stirrup corners

135-degree hooks at bar ends

Laps at stirrup corners

90-degree hooks at bar ends

If the starter bars are in a
circular form, you must define
the angle of stirrup overlap.

Parameters tab
Use the Parameters tab to define numbering properties of bars.

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Starter bars for footing (87)
Starter bars for footing (87) creates starter bars in a footing for a column.
Starter bars may go through a pedestal or straight to the column. Starter bars
can be in a rectangular or circular form.
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Bars created

• Starter bars (straight or L-shaped)

• Stirrups (optional)

Use for

Situation More information
Starter bars for footing
(87) places starter bars in a
footing in rectangular or
circular form. Starter bars
can be straight or L-shaped,
and can have stirrups.

Before you start

• Create the footing.

• Calculate the required area of reinforcement.

Selection order

1. Footing

Picture tab
Use the Picture tab to define bar dimensions and locations, number and
spacing of bars, and concrete cover thickness.

Select the shape of the starter bars:

Option Description
L-shaped starter bars.

Define the length of the bar.

Straight starter bars.

L-shaped starter bars.

Define concrete cover thickness.
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Option Description
Number of stirrups/Spacing Define the number of stirrups and

their spacing.

Use a space to separate spacing
values. Enter a value for each space
between the reinforcing bars. For
example, if there are 3 reinforcing
bars, enter 2 values.

Create corner bars Select to create corner bars.

Default value is Yes.
Select the placement of the corner
bars.

Grade Define the grade of the reinforcing
bar.

Size Define the size of the reinforcing bar.
Bending radius Define the bending radius of the

reinforcing bar.

Bottom cover tab
Use the Bottom cover tab to define bottom cover thickness for bar groups.

Select to set bottom cover thickness from the Same for all list:

Option Discription
Yes Sets the same bottom cover thickness

for all corner and side bars.
No Enter the separate bottom cover

thickness for each bar group.
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Location tab
Use the Location tab to define starter bar location and stirrup type.

Starter bar location

Enter the distance from the center of the bar group to the center of the
footing, in two directions:

Stirrups

Use these options to define stirrup laps in footings:

Option Description
Laps on the side of the stirrups

45-degree hooks at bar ends

Default
Laps at stirrup corners

135-degree hooks at bar ends

Laps at stirrup corners

90-degree hooks at bar ends
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Option Description
If the starter bars are in a
circular form, you must define
the angle of stirrup overlap.

Parameters tab
Use the Parameters tab to define numbering properties of bars.

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Beam, column, and slab reinforcement
Tekla Structures includes the following components that you can use to
automatically create reinforcement for beams, columns, and slabs:

• Detailing manager (page 3317)

• Mesh Bars / Mesh Bars by Area (page 3319)

• Rebar coupler and anchor tools (page 3331)

• Beam reinforcement (63) (page 3347)

• Stirrup reinforcement (67) (page 3353)

• Longitudinal reinforcement (70) (page 3359)

• Beam end reinforcement (79) (page 3362)

• Corbel reinforcement (81) (page 3367)

• Round column reinforcement (82) (page 3374)

• Rectangular column reinforcement (83) (page 3384)

• Hole reinforcement for slabs and walls (84) (page 3398)

• Hole creation and reinforcement (85) (page 3404)

• Braced girder (88) (page 3408)
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• Braced girder (89) (page 3429)

• Reinforcement mesh array in area (89) / Reinforcement mesh array (91)
(page 3450)

• Rebar in beam (90) (page 3455)

• Border rebar for single edge (93) (page 3471)

• Rectangular area reinforcement (94) (page 3488)

• Wall panel reinforcement / Double wall edge and opening reinforcement
(page 3503)

• Multiple Wire Size Mesh (page 3514)

• Embedded anchors (8) (page 3518)

• Embed (1008) (page 3558)

• Continuous Beam Reinforcement (page 3568)

Detailing manager
Detailing manager is used to apply detailing components into any structure.
With Detailing manager you can define rules to apply multiple components
at one go to detail the structure of a cast unit or the entire model.

You can use selection filters to define detailing rules for automating repetitive
detailing tasks. You can add custom details, extensions or system components
with Detailing manager.

You have three options:

• Use Detailing manager to have a part as input. All parts in the cast unit
are examined and detailed by the set rules.

• Use Detailing manager to have a cast unit as input. All parts in the cast
unit are examined and detailed by the set rules.

• Use Detailing manager to have a component as input, for example, tools
such as Floor layout or Wall layout where the same tool creates multiple
parts. All parts in the component are examined and detailed by the set
rules.

The image below shows an example of Detailing manager. In the example,
the Mesh bars component is created to the outside shell of the cast unit
because it has the class 4 filter selected and there is a selection filter for
objects with class 4.
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Properties

Option Description
Rule Use the rules to define detailing settings.

The maximum number of rules is 25. Click  to
add a new rule. You can rename a rule by double-
clicking the rule tab.

You can remove the content from a rule tab by double-
clicking the rule tab and selecting Clear.

You can remove rule tabs by double-clicking the rule
tab and selecting:

• Close to remove the selected tab.

• Close other tabs to remove other tabs than the
selected tab.

• Close all tabs to remove all tabs. Detailing
manager adds a new empty rule tab.

You can also remove rules by clicking  on a rule tab.
Component Click  to select the component that you want to use

to detail a structure.

Double-click the component in the Applications &
components catalog to add it to the Component box.

Attribute Select the attribute file for the component. If you do
not select a file, the standard file is used.

Component input Define the creation method of the selected
component:

• Part: Select the part to which you are creating the
component.
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Option Description
• Part + one point: Select the part and one

additional point on the part. With this option,
Detailing manager places the center of the object
boundary box to that point.

Use this setting with custom component details.

• Part + two points: Select the part and two
additional points on the part. With this option,
Detailing manager uses the start and the end
point of the part as insertion points.

Filter Select which parts inside the selected cast unit or
component get the selected component. The available
selection filters are listed in the filter list.

You can also create new selection filters. You can use
five selection filters if you want to create an
intersection of the filters.

Create on selected
objects

Detailing manager is created to selected parts, cast
units or components. The rule settings that are
currently set in the Detailing manager dialog box are
used.

Create as • Detailing manager plug-in: Components are
inserted as Detailing manager plug-ins and not as
separate components.

Select this option if you use a component as input.

• Separate components: With this setting, the
inserted components do not have any connection
to Detailing manager.

Mesh Bars / Mesh Bars by Area
Mesh Bars and Mesh bars by area create reinforcement for concrete slabs or
walls.

Objects created

• Primary bars

• Crossing bars
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Use for

Situation Description
Reinforcement for the bottom or the
top surface of the concrete element,
or for both.

Selection order

Component To create mesh bars
Mesh Bars 1. Select a concrete slab.

The reinforcement is created automatically.
Mesh bars by area 1. Select a concrete slab.

2. Select a group of points to define a working
polygon.

The reinforcement is created automatically.

Picture tab
Use the Picture tab to define how the top and bottom bars are created.

Option Description
Create bars Top bars with primary bars

above secondary bars
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Option Description
Top bars with secondary bars
above primary bars

No bars

The same options are available for the bottom bars as well.

The value defined in the box is the cover thickness for the top/
bottom layer.

If you only want to create bars in the middle of the slab, select
the No bars option either for the top or bottom bars, and then
select Yes in the Place central list that appears.

Mesh area
perimeter

This option is only available for Mesh bars by area.

Select the outline that the mesh follows.

The meshes in the examples are created by picking the same
points but with different mesh area perimeters.

Part

Part, for example:

Polygon

Polygon, for example:
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Option Description

Polygon + part

Part + polygon, for example:

Same as
bottom

Select whether the top bars are created using the same
properties as the bottom bars.

If you select No, enter the top bar properties.
Bar type Select whether the bars are created as a bar group or as a

mesh.

Depending on the option you select, some other settings and
options are available. For example:

• If you select the Bar group option:

• You can move, copy, and delete bars using direct
modification.

To move a bar, drag it to a new location.

To copy a bar, hold down Ctrl and drag the bar.

To delete a bar, select it and press Delete.

• You can use the grid, minimum length, Bar grouping,
and Bar behavior at cuts settings on the Detailing tab.

• If you select the Mesh option, bars are always cut by the
cuts in the concrete part.

Size Select the diameter of a bar.

You can set the size separately for the top primary and
secondary bars, and for the bottom primary and secondary
bars.

Grade Define the strength of the steel used in the bars.

You can set the grade separately for the top primary and
secondary bars, and for the bottom primary and secondary
bars.

Concrete components 3322 Reinforcement



Option Description
Spacing
type

Select whether the spacing is based on the number of bars or
on the spacing values.

• By spacings: enter the distance between the bars in the
Spacing box.

• Number of bars: enter the number of bars in the Number
of bars box.

• By exact spacings: list the distances between the bars in
the Spacing box. For example:

200, 200, 50, 50, 50, 100 or

2*200, 3*50, 100
Spacing Distances between the bars.

Tekla Structures calculates the number of bars.

You can set the spacing separately for the top primary and
secondary bars, and for the bottom primary and secondary
bars.

Number of
bars

Number of bars.

Tekla Structures calculates the distance between bars.

You can set the number of bars separately for the top primary
and secondary bars, and for the bottom primary and
secondary bars.

Primary
bars
direction

The direction of the primary bars. Use to change the bar
direction.

If the Auto option is selected, the primary bars are created
along the two longest parallel sides of a slab. If there are no
parallel sides, you can select to create the bars along the slab x
direction instead.

To rotate the bars, select one of the direct modification
options. For non-perpendicular meshes, use the flexible angle
option to individually rotate both arrow sides around their axis.

Up
direction

Select which sides are regarded as the top and bottom sides of
the slab.

If the Auto option is selected, then the bars are created on the
side with the greatest area.

Detailing tab
Use the Detailing tab to control how the bars are distributed.
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Bars that are created as bar groups can be distributed By grid or Without
grid.

Using a grid makes it easier to accurately place bars only at set intervals. When
direct modification is switched on and you move or copy bar group bars, they
snap to the grid.

Detailing without grid

Option Description
Bar distances Select how the distances between the bars are measured.

• From center of bar

• From edge of bar

Select whether the distances are the same or different for
the top and bottom bars. Using different distances helps in
placing top and bottom bars so that their hooks do not
collide, for example.

Adjustment Select how the bars are distributed.

The same options are available for both the primary and the
secondary bars.

Equal distribution by target
spacing value.

By exact spacing value with
flexible first space without
first bar.

By exact spacing value with
flexible last space without last
bar.

By exact spacing value with
flexible first and last space
without first and last bars.

By exact spacing value with
flexible first space.
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Option Description
By exact spacing value with
flexible last space.

By exact spacing value with
flexible first and last space.

Detailing by grid

The same options are available for both the longitudinal and the crossing bars.

Option Description
Min overhang Minimum extension of the longitudinal or crossing

bars over the outermost bars of the other
direction.

You can set the minimum overhang separately for
the start and end of the bars.

Min spacing Minimum distance between the bars.
Longitudinal grid size

Crossing grid size

Defines the location intervals to which the bar
group bars snap when they are moved or copied
using direct modification.

Other detailing options

Option Description
Minimum
length of
primary bar
to be created

Minimum
length of
secondary bar
to be created

In bar groups, bars that are shorter than this value are not
created.

Bar grouping For bar groups, select whether tapered bars are grouped or
not.

If you group the tapered bars, select how the bars along the
tapered edge are handled.

Tapered bars are handled
normally.
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Option Description
Creates as many bars as
possible with same length at
the tapered edge.

The value you enter is the
maximum allowed shortening
of a bar.

Bar behavior
at cuts

Select how bars next to openings are handled.

• Cut bars: Select whether the bars are cut and which cuts
are ignored.

In bar groups, you can ignore cuts by part name, part
class, or selection filter.

With the Yes, but ignore cuts by filter option, the
Selection filter list only shows the selection filters where
one rule has the object type 11 (polygon cut) and the
other rules have been defined by using the Template
category.

• Ignore openings smaller than: The minimum length of
a cut (in the direction of the bars) that will cut the bars.
Lower values are ignored.

This setting only affects bars that are created as bar
groups. Bars that are created as a mesh are always cut by
the cuts in the concrete part.

• Cover thickness: Distance between the bar end/start
point to the edge of the opening.

You can use this option to define the cover thickness for

both windows  and doors .

This option is useful if window and door openings need
to have different cover thicknesses.

• Create cuts around selected parts: Select whether the
bars are cut by the parts that clash with the reinforced
part. The cutting parts are defined by a selection filter.

• Create support bars for loose bars: Select whether
additional support bars are created for the loose bars in
the mesh.

• Yes, without extended support bar creates support
bars for loose bars only within the range of the loose
bars.
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Option Description
• Yes, with extended support bar extends support

bars to the whole mesh area.

You can define the overlap length for the support
bars. The length defines how much the additional
bars overlap with the existing mesh.

Bar end conditions tab
Use the Bar end conditions tab to control the cover thickness and bar hooks.

Option Description
Cover
thickness
on sides

• Different each side: Each end of a bar group can have
different distances from part edges.

• Same all sides: All ends of the bar groups have the same
distance from part edge.

Use bar end
conditions
around
holes

Select whether the same bar end conditions are used around
the openings as at part edges.

End
conditions

Creates a straight bar without
a hook at the given end of a
bar.

Creates a 90° hook at a given
end of bar.

Creates a 135° hook at a
given end of bar.

Creates a 180° hook at a
given end of bar.

Creates a hook with a free
angle at the given end of a
bar.

Creates a double bent hook
at the given end of a bar.

Creates an inward bent hook
in a 135-degree angle. You
can define the hook height.

Concrete components 3327 Reinforcement



Option Description
Cut bars by
negative
neighbor
parts

Select whether the bars that protrude from the selected
concrete parts are cut at the openings of neighbor parts. To cut
the bars at the openings, select Yes, and then enter the cover
thickness.

Bending
radius

Bending radius at bar ends

Bending
length

Bending length at bar ends

Splicing tab
Use the Splicing tab to control the splicing of the reinforcing bars.

Option Description
Splice bars Select whether the reinforcing bars are spliced or

not.
Manufacturer Select the manufacturer of the reinforcement.

The maximum bar lengths and lap lengths are then
listed by the grade and size of the bar.

If needed, you can modify these splicing definitions
in the MeshBarsSplicing_Manufacturers.dat
file. You can also copy the default file
from ..\ProgramData\Trimble\Tekla
Structures\<version>\environments
\common\system, edit it, and save it to your
project or firm folder.

Maximum length of
bars

Maximum reinforcing bar length after which the
bars are spliced.

Lapping length Length of the lapping connection.
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Option Description
Splicing in same cross
section

Select how many reinforcing bars can be spliced in
the same location.

• 1/1 = all reinforcing bars are spliced in the same
cross section.

• 1/2 = every second reinforcing bar is spliced in
the same cross section.

• 1/3 = every third reinforcing bar is spliced in the
same cross section.

• 1/4 = every fourth reinforcing bar is spliced in
the same cross section.

Splicing symmetry Select the symmetry that is applied when the
reinforcing bars are spliced.

• Not Symmetrical: The splice pattern of the
reinforcing bar is not symmetrical and the
uneven length is only at one side.

• Symmetrical with different lengths at sides:
The splice pattern of the reinforcing bar is
symmetrical with uneven lengths at the sides.

• Symmetrical with different length at center:
The splice pattern of the reinforcing bar is
symmetrical with uneven length in the center.

Splicing offset Offset of the splice center point from the point
where the reinforcing bars originally met.

Minimum splitting
distance

Minimum longitudinal distance between two
splices in consecutive bars.

Splicing type Select the type of the splice.
Bar position Select whether the lapping bars are on top of each

other or parallel to each other.

Attributes tab
Use the Attributes tab to control the bar group or mesh properties, and user-
defined attributes.

Properties

Option Description
Name Name of the bar group or mesh.
Prefix Prefix for the position number of the bar group or

mesh.
Start number Start number for the position number of the bar

group or mesh.
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Option Description
Class Class of the bar group or mesh.

If you create a mesh, only the class of primary bars is
taken into account.

User-defined attributes (UDAs) for reinforcing bars

The UDAs are predefined in the MeshBars.Udas.dat file.

Option Description
Same for all Select Yes to use the UDA for all reinforcing bars.

Select No to define the UDA separately for all
reinforcing bars.

Top bars

Bottom bars

Enter a UDA value for the top and bottom
reinforcing bars.

Rebar assembly tab
Use the Rebar assembly tab to add the created reinforcement as a rebar
assembly to the cast units.

Create as rebar assembly

You can add the created reinforcement as a rebar assembly to the cast units
with a predefined assembly type, name, prefix, and start number.

Option Description
Create as rebar assembly Select Yes to create all reinforcement

as one rebar assembly, and to include
it to the cast unit of the input part.

Rebar assembly type Select the rebar assembly type.

If you do not select the type, the
default value of the rebar assembly is
used.

Name, Profile, Start number Define the name, profile, and start
number.

If you do not define these, the default
values of the rebar assembly are
used.

Customize the Attributes tab

You can customize the content of the user-defined attributes section on the
Attributes tab by using the MeshBars.Udas.dat file. The file can be located
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in any of the folders set in the XS_FIRM , XS_PROJECT or XS_SYSTEM
advanced options, and in the model folder.

You can use the file to control which user-defined properties of the created
reinforcement can be used in Mesh Bars and Mesh Bars by Area. We
recommend that you only use UDAs that are typically common for all
reinforcement.

The sample file shown below contains a full description of all the settings and
the format of the file. The lines starting with '//' are comment lines.

//
// Customized user defined attributes (UDA) for layer parts created by 
Mesh Bars component
// 
// Each row shall contain 2 or 3 fields separated by tab(s) or semicolon. 
// Please note that all uda names shall be unique
//
// Field 1: The data type of the attribute. Valid values are 'distance', 
'float', 'option', 'integer' and 'string'
//          compatible with the actual user defined attributes as 
specified in objects.inp
// Field 2: UDA name. This is the name of the user defined attribute.
// Field 3: Label. This text is shown in the attributes dialog. It can be 
a translatable label (albl_) or any text.
//        
string        comment            j_comment
string        USER_FIELD_1        j_user_field_1
string        USER_FIELD_2        j_user_field_2
string        USER_FIELD_3        j_user_field_3
string        USER_FIELD_4        j_user_field_4

Rebar coupler and anchor tools
Rebar coupler and anchor tools is a set of four components that help to
model and manage

• reinforcing bar couplers that connect two bars

• end anchors that are devices at the unreserved end of the bar.

The following components are part of Rebar coupler and anchor tools:

• Rebar coupler

• Rebar end anchor

• Split rebar and add coupler

• Rebar end trimming

In addition, you can manage the user-defined attributes (UDAs) of the Rebar
coupler and anchor tools with the Update rebar attributes component.

All couplers and end anchors are automatically added to the parent part of the
reinforcing bar. This allows them to be shown in reports and drawings because
they are added to the sub-assembly of the cast unit.

In some cases the reinforcing bars can move outside of the concrete. This may
happen with reinforcing bars that are modeled with two points (straight bars
and straight bars with hooks). If the reinforcing bars move outside of the
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concrete, change the cover thickness to either a negative or a positive value
depending on what is required.

Two report templates Rebar Extra Fabrication Length.rpt and Rebar
Thread Length.rpt can be used to inquire Threaded Length and Extra
Fab. Length of the reinforcing bars in the BOMs or BOQs.

Rebar coupler
Rebar coupler creates couplers to connect reinforcing bars, or reinforcement
meshes, whose bar ends are in contact and parallel.

Objects created

• Round parts

The parts are created between two reinforcement objects.

Use for

Situation Description
Couplers with split reinforcing bars.

Before you start

Couplers can be created between reinforcing bars or reinforcement meshes.
The selected reinforcement objects can be of different type and they can even
have different number of bars. The only requirement is that one or more bar
ends are in contact and parallel. With rebar sets, the couplers can only be
created between spliced bars in that particular rebar set.

Selection order

Reinforcing bars or
reinforcement meshes

1. Select the primary reinforcing bar(s).

2. Select the secondary reinforcing bar(s).
Rebar sets 1. Select a rebar set.

2. Define a location for a splitter by picking two
points.

This splitter will become an input object for
the couplers.
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3. Pick a point.

This point defines the side of the primary
reinforcing bar(s). This is needed if you have
applied different properties for the primary
and secondary bar(s).

or

1. Select an existing splitter in a rebar set.

2. Pick a point.

This point defines the side of the primary
reinforcing bar(s). This is needed if you have
applied different properties for the primary
and secondary bar(s).

Couplers are created at each location where

• the bar ends are parallel enough (angle < 5 degree) and

• the gap along the bar end is less than the length of the coupler and

• the offset perpendicular to the bar end legs is less than the diameter of the
bars

When there is no valid and no parallel end-to-end location between the
selected bars, the component creates a dummy part that identifies the
unsuccessful coupler insertion.

Parameters tab

Use the Parameters tab to define the coupler properties.

Option Description
Use manually entered
values

Enter values for the coupler properties.

Use auto attribute file The values in the auto attribute file override the
coupler component values.

Typically the auto attributes file contains one or
more attribute values to be used with certain bar
sizes.

Go to Tekla Warehouse to get auto attribute files
for your project.

For more information on the structure of the auto
attribute files, see Customize attribute files,
part mapping and user-defined attributes
(UDAs).
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Option Description
Use custom component Select Yes to create the coupler as a custom part.

Select No to create the coupler as a normal part.
Name Type the name of the custom component, or select

it from the Applications & components catalog.

Ensure that the selected component is a custom
part.

Attribute Type the name of the attribute file of the custom
component.

The coupler custom part is created using the saved
attributes given here.

Input points The order of the start and the end points of the
custom component.

Add to rebar assembly To add the coupler as a sub-assembly to the rebar
assembly, select either Yes, to primary bar or
Yes, to secondary bar.

Note that you must first create the rebar assembly,
otherwise adding is not possible.

The default value is No.

Option Description
Numbering series Prefix and a start number for the coupler part

position number.

In the Inherit from list, select which numbering
settings are used for couplers.

• With None, enter the part and assembly prefix
and start numbers.

• With Rebar, the numbering settings of the
primary bars are used.

• With Cast unit, the cast unit numbering
settings are used.

Attributes Name, diameter, material, finish and class of the
coupler parts.
1 The overall end-to-end length of the coupler

If you use a custom part, this is the length
between the start point and the end point of the
custom part.

2 Coupler profile width
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Option Description
3 Coupler offset in relation to the free gap center
line. Positive values move the coupler to the right
and negative to the left.

You can also control this offset in the auto
attribute file by using the attribute 
CouplerOffset.

When you create the couplers as custom parts, the properties in the
Numbering series and Attributes sections can be filled from the custom part
settings if you have named the properties in a certain way.

Rebar attributes tab

Use the Rebar attributes tab to define user-defined attributes (UDAs) for
rebars.

Option Description
Threaded length The value is written to the reinforcing bar UDA.

The fields are used for checking which bars have
threads and what are the thread values so that they
can be shown in drawings and reports.

Extra fabrication
length

This value is written to the reinforcing bar UDA.

This value does not affect the length of the
reinforcing bar. You need to add this value in your
drawings and reports to get the correct length if
required.

Method

Type

Product

Code

UDAs written to the reinforcing bars.

You can set the reinforcing bar end method and the
coupler type, and add a product name and a code for
reporting purposes.

The used attribute name depends on which end of
the reinforcing bar the coupler was created.

NOTE The above user-defined attributes affect numbering. Reinforcing bars
with different attribute values get different part marks.

Coupler attributes tab

Use the Coupler attributes tab to define user-defined attributes (UDAs) for
couplers or end anchor parts. For each UDA, you can select to inherit the value
from the rebar or the cast unit. To enter a value, select the inherit option
None.

Note that if the cast unit does not have any value for that particular UDA, the
value is taken from the main part of the cast unit. By default, you can enter a
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Comment and values for User field 1 … 4 UDAs. You can customize the set of
UDAs by modifying the UDA fields in the RebarCouplers.Udas.dat file,
located in the ..\Environments\common\system folder.

Rebar end anchor
Rebar end anchor creates end anchors at the ends of reinforcing bars or
reinforcement meshes.

Objects created

• Round parts

The parts are created at reinforcing bar ends.

Use for

Situation Description
Reinforcing bars with end anchors.

Selection order

Reinforcing bars or
reinforcement meshes

1. Select the reinforcing bar(s).

2. Pick any point close to the bar end where you
want to create the end anchors.

Rebar set bars 1. Select a rebar set.

2. Define a location where to add an end detail
modifier by picking two points.

This end detail modifier will become an input
object for the end anchors.

or

1. Select an existing end detail modifier in a rebar
set.

Parameters tab

Use the Parameters tab to define the end anchor properties.

Option Description
Use manually entered
values

Enter values for the end anchor properties.
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Option Description
Use auto attribute file The values in the auto attribute file override the

end anchor component values.

Typically the auto attributes file contains one or
more attribute values to be used with certain bar
sizes.

Go to Tekla Warehouse to get auto attribute files
for your project.

For more information on the structure of the auto
attribute files, see Customize attribute files,
part mapping and user-defined attributes
(UDAs).

Option Description
Use custom component Select Yes to create the end anchor as a

custom part.

Select No to create the end anchor as a normal
part.

Name Type the name of the custom component, or
select it from the Applications & components
catalog.

Ensure that the selected component is a
custom part.

Attribute Type the name of the attribute file of the
custom component.

The end anchor custom part is created using
the saved attributes given here.

Input points The order of the start and the end points of the
custom component.

Add to rebar assembly To add the coupler as a sub-assembly to the
rebar assembly, select either Yes, to primary
bar or Yes, to secondary bar.

Note that you must first create the rebar
assembly, otherwise adding is not possible.

The default value is No.

Option Description
Numbering series Prefix and a start number for the end anchor

part position number.
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Option Description
In the Inherit from list, select which
numbering settings are used for couplers.

• With None, enter the part and assembly
prefix and start numbers.

• With Rebar, the numbering settings of the
primary bars are used.

• With Cast unit, the cast unit numbering
settings are used.

Attributes Name, diameter, material, finish and class of
the end anchor parts.
The dimensions of the end anchor.

If you use a custom part, define the length
between the start point and the end point of
the custom part using these values.

The offset of the far most point of the coupler
measured from the physical end of the
reinforcing bar.

Note that you cannot control the end of the
reinforcing bar with this component. You need
to make sure the end concrete cover of the
reinforcing bar is greater or equal to this
offset plus the minimum concrete cover.

When you create the end anchors as custom parts, the properties in the
Numbering series and Attributes sections can be filled from the custom part
settings if you have named the properties in a certain way. For an example,
see Customize attribute files, part mapping and user-defined attributes
(UDAs).

Rebar attributes tab

Use the Rebar attributes tab to define the user-defined attributes (UDAs) for
rebars.

Option Description
Threaded length The value is written to the reinforcing bar UDA.

The fields are used for checking which bars have
threads and what are the thread values so that they
can be shown in drawings and reports.

Extra fabrication
length

This value is written to the reinforcing bar UDA.

This value does not affect the length of the
reinforcing bar. You need to add this value in your
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Option Description
drawings and reports to get the correct length if
required.

Method

Type

Product

Code

Thread type

Free distance 1

Free text 2

UDAs written to the reinforcing bars.

You can set the reinforcing bar end method and the
coupler type, and add a product name and a code for
reporting purposes.

The used attribute name depends on which end of
the reinforcing bar the coupler was created.

NOTE The above user-defined attributes affect numbering. Reinforcing bars
with different attribute values get different part marks.

Coupler attributes tab

Use the Coupler attributes tab to define user-defined attributes (UDAs) for
couplers or end anchor parts. For each UDA, you can select to inherit the value
from the rebar or the cast unit. To enter a value, select the inherit option
None.

Note that if the cast unit does not have any value for that particular UDA, the
value is taken from the main part of the cast unit. By default, you can enter a
Comment and values for User field 1 … 4 UDAs. You can customize the set of
UDAs by modifying the UDA fields in the RebarCouplers.Udas.dat file,
located in the ..\Environments\common\system folder.

Split rebar and add coupler
Split rebar and add coupler splits a reinforcing bar group or rebar set, and
adds couplers in relation to the direction of the picked points.

Objects created

• Circular hollow parts

The parts connect the two reinforcing bar groups or rebar sets.
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Use for

Situation Description
Staggered couplers with split
reinforcing bars.

Selection order

1. Double-click Split rebar and add coupler to open the component
properties.

2. Click Split rebar with coupler.

3. Select the reinforcing bar, bar group, or rebar set to be split.

4. Pick the first split point.

5. Pick the second split point.

This point defines the line at which the bars are split and couplers are
inserted.

6. Pick the third point.

This point defines the side of the primary bars. This is needed if the
primary and secondary bars have different properties.

7. Repeat the steps 3 - 6, or press Esc to cancel picking.

Parameters tab

Use the Parameters tab to define the coupler properties.

Option Description
Use manually entered
values

Enter values for the coupler properties.

Use auto attribute file The values in the auto attribute file override the
coupler component values.

Typically the auto attributes file contains one or
more attribute values to be used with certain bar
sizes.

Go to Tekla Warehouse to get auto attribute files
for your project.

For more information on the structure of the auto
attribute files, see Customize attribute files,
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Option Description
part mapping and user-defined attributes
(UDAs).

Option Description
Use custom component Select Yes to create the coupler as a custom

part.

Select No to create the coupler as a normal
part.

Name Type the name of the custom component, or
select it from the Applications & components
catalog.

Ensure that the selected component is a
custom part.

Attribute Type the name of the attribute file of the
custom component.

The coupler custom part is created using the
saved attributes given here.

Input points The order of the start and the end points of the
custom component.

Add to rebar assembly To add the coupler as a sub-assembly to the
rebar assembly, select either Yes, to primary
bar or Yes, to secondary bar. These options
will create new rebar assemblies for the new
bars created by the split command.

The default value is No.

Option Description
Numbering series Prefix and a start number for the coupler part

position number.

In the Inherit from list, select which
numbering settings are used for couplers.

• With None, enter the part and assembly
prefix and start numbers.

• With Rebar, the numbering settings of the
primary bars are used.

• With Cast unit, the cast unit numbering
settings are used.

Attributes Name, diameter, material, finish and class of
the coupler parts.
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Option Description
Staggered type • None

Couplers are placed along the two picked
points.

• Left

Couplers are placed to the left side of the
two picked points.

• Right

Couplers are placed to the right side of the
two picked points.

• Middle

Couplers are placed on both sides of the
two picked points.

The overall end-to-end length of the coupler.

If you use a custom part, this is the length
between the start point and end the point of
the custom part.

Coupler position Location of the couplers in relation to the
selected split line.

If you select the Left or the Right option, the
actual left or right depends on the third input
point which defines the side of the first bar.

This option is available only when there is no
staggering.

Example:

When you create the couplers as custom parts, the properties in the
Numbering series and Attributes sections can be filled from the custom part
settings if you have named the properties in a certain way. For an example,
see Customize attribute files, part mapping and user-defined attributes
(UDAs).
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Rebar attributes tab

Use the Rebar attributes tab to define the user-defined attributes (UDAs) for
rebars.

Option Description
Threaded length The value is written to the reinforcing bar UDA.

The fields are used for checking which bars have
threads and what are the thread values so that they
can be shown in drawings and reports.

Extra fabrication
length

This value is written to the reinforcing bar UDA.

This value does not affect the length of the
reinforcing bar. You need to add this value in your
drawings and reports to get the correct length if
required.

Method

Type

Product

Code

Thread type

Free distance 1

Free text 2

UDAs written to the reinforcing bars.

You can set the reinforcing bar end method and the
coupler type, and add a product name and a code for
reporting purposes.

The used attribute name depends on which end of
the reinforcing bar the coupler was created.

NOTE The above user-defined attributes affect numbering. Reinforcing bars
with different attribute values get different part marks.

Coupler attributes tab

Use the Coupler attributes tab to define user-defined attributes (UDAs) for
couplers or end anchor parts. For each UDA, you can select to inherit the value
from the rebar or the cast unit. To enter a value, select the inherit option
None.

Note that if the cast unit does not have any value for that particular UDA, the
value is taken from the main part of the cast unit. By default, you can enter a
Comment and values for User field 1 … 4 UDAs and Layer. You can customize
the set of UDAs by modifying the UDA fields in the
RebarCouplers.Udas.dat file, located in the ..\Environments\common
\system folder.

Rebar end trimming
Rebar end trimming adjusts the space between two reinforcing bar ends.
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Use for

Situation Description
Space between reinforcing bar
ends.

Selection order

1. Select the couplers you want to modify.

2. Modify the properties.

3. Click Apply to selected couplers.

OR

1. Modify the properties.

2. Click Select rebars.

3. Select the reinforcing bars whose ends are adjusted according to the value
set for the gap.

Rebar coupler/Rebar end anchor tab

Option Description
Get free gap from auto
attributes file

Select Yes if you want to use the gap defined in
the Auto attribute file for the couplers. When
you select Yes, only the coupler components that
have the Use auto attribute file in use are
adjusted.

See Customize attribute files, part mapping
and user-defined attributes (UDAs).

Select No if you want to manually enter the free
gap.
The gap when Get free gap from auto
attributes file is set to No.

Trim both bars Select which of the reinforcing bars is modified.
Apply to selected
couplers

Select the couplers you want to modify and click
the Apply to selected couplers button to adjust
the bars according to the value set for the gap.
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Option Description
Select rebars Click the Select rebars button and select the

reinforcing bars whose ends you want to adjust
according to the value set for the gap.

The reinforcing bar ends need to be close to each
other.

Update rebar attributes
Use Update rebar attributes to manage the user-defined attributes (UDAs) of
the couplers and the end anchor parts created by the Rebar Coupler and
Anchor Tools. With Update rebar attributes you can check the current
values of the selected reinforcing bars or all reinforcing bars.

If you have added coupler or end anchor components to reinforcing bars, the
UDA values are controlled by the coupler or the end anchor components and
their properties. If you delete the coupler or the end anchor component, the
UDAs defined by those components are not cleared automatically. Use Update
rebar attributes to clear the obsolete attribute values.

Option Description
Selected The values of all coupler and end anchor UDAs of the

selected reinforcing bars in the model.
All The values of all coupler and end anchor UDAs of all

reinforcing bars in the model.
Update Deletes the values of all coupler and end anchor UDAs

of all reinforcing bars on the selected rows.

Only the obsolete coupler UDAs of the reinforcing bar
are deleted.

You can select multiple rows by holding down Ctrl or
Shift.

Update (phase only) Updates the phase values of the coupler and end
anchor parts so that the phase values are the same as
the phase values of the related reinforcing bars.

Show only rebar
with attributes

Select this check box if you want to show only
reinforcing bars that have values in their coupler or
end anchor UDAs.

After you have selected the check box, click Selected
or All to refresh the table.
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Customize attribute files, part mapping and user-defined attributes (UDAs)

Auto attribute files

The attribute table files are text files that can locate in any of the system
folders, or in a model folder. You can have as many attribute table files as you
need. There are different attribute tables for end anchors (one input
reinforcing bar) and coupler components (two input reinforcing bars). The
extensions for attribute table files are

• .couplers.csv for Rebar coupler and Split rebar and add coupler
components

• .anchors.csv for Rebar end anchor component.

The attribute table contains a header line, including the column names and
one or more table rows containing the attribute values. Columns are either
selector columns or attribute columns.

The selector column names are Primary.Size, Primary.Grade, 
Secondary.Size, and Secondary.Grade.

The attribute columns contain the attribute value that is the name given in the
header row. The component attribute values given in the table row are used
whenever the component input (primary + secondary for Rebar coupler and
secondary for Rebar end anchor) matches with the selector values.

Go to Tekla Warehouse to get auto attribute files for your project.

Custom part mapping

When you create the coupler or the end anchors as custom parts, the
properties in the Numbering series and Attributes sections can be filled
from the custom part settings if you have named the properties in a certain
way. The following example shows the mapping between the Numbering
series and Attributes properties and the custom part properties.

User-defined attributes (UDAs)

You can customize the content of the Attributes tab and the UDAs in the
Rebar Coupler and Anchor Tools components.
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The UDAs are defined in a text file named RebarCoupler.Udas.dat, located
in the ...\ProgramData\Trimble\Tekla Structures\<version>
\Environments\Common\system folder. The file can also be placed in some
other system folder or in a firm folder. Note that the file is not read from the
model folder.

The RebarCoupler.Udas.dat file only defines which UDAs are shown on the
Attributes tab. If you modify the file, include only existing UDAs to the file. If
you want to create new UDAs, ensure that you define them properly.

NOTE The UDAs affect numbering if the UDAs' special numbering flag
(special_flag) is set to yes in the objects_couplers.inp file.
Reinforcing bars with different UDA values will then get different part
marks.

Beam reinforcement (63)
Beam reinforcement (63) creates reinforcement for a concrete beam.

Bars created

• Longitudinal main bars

• Corner and side bars

• Main stirrups

• Stirrups for one or two ledges

Use for

Situation More information
Rectangular beams

L-shaped beams (RCL profiles)
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Situation More information
RCX profiles

Inverted T-beams (RCDL profiles)

Before you start

• Create the concrete beam.

• Calculate the required area of reinforcement.

Selection order

1. Select the concrete beam.

The reinforcement is created automatically when you select the beam.

Parameters tab
Use the Parameters tab to define the concrete cover thickness, number, size,
and location of the bars, and stirrup size.
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 Description
1 Cover thickness
2 Distance between bars
3 Main stirrup size
4 Corner and side bar size
5 Ledge stirrup size
6 Main bars number and sizes
7 Sidebar spacing, based on maximum target spacing

Bottom main bars

Select how the bottom main bars are positioned: inside the main stirrups or
distributed to the ledges. You can select the position when the bottom main
bars have the same height as at least one of the ledges.

Placing of top and bottom bars

Select the horizontal placing for the top and bottom bars. Select whether the
bars are placed starting from the corner or at equal spaces.
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Option Description
At equal spaces

From the corner

Bending direction

Option Description
Type 1

Type 2

Type 3

Type 4

Stirrup shape

Option Description
90-degree

135-degree

Overlapped

Additional links

Option Description
No additional links.
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Option Description
Create additional internal links.

Create additional links.

Select whether links are created always or depending on the profile size from
the Create links list.

If you select If profile size >, enter the minimum profile length.

Side bars

Select whether the side bars are created as one group or as separate rebar
groups.

Hooks tab
Use the Hooks tab to create hooks and define their properties.

Define the hook type and bar end cover separately for the start and end of the
rows.

Option Description
No hook

Standard 90-degree hook

Standard 135-degree hook

Standard 180-degree hook

Custom hook

If you select a standard hook, the Angle, Radius, and Length use predefined
dimensions.

Option Description
Angle Enter a value between -180 and +180

degrees.
Radius Enter the internal bending radius of

the hook.
Length Enter the length of the straight part.
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Stirrup spacing tab
Use the Stirrup spacing tab to define whether stirrups are created as one
group or as separate groups, and to define stirrup spacing.

Stirrup spacing

Define the distances from the part ends to the first stirrups.

Option Description
N Number of stirrups.
Space Define the spacing of stirrups.

Use a space to separate spacing
values. Enter a value for each space
between the stirrups. For example, if
there are 3 stirrups, enter 2 values.

Main stirrup spacing type and Ledge Stirrup Spacing Type

Define how the main stirrups and ledge stirrups are distributed along the
length of the beam.

Option Description
Target Tekla Structures creates equal spaces

between the bars, aiming the spacing
value as closely as possible to the
value you specify. This is the default
option.

Exact The first and last space of a zone
adjust themselves to even out bar
distribution. The spaces in the middle
of each zone are exactly the size you
specify.

Advanced tab
Use the Advanced tab to define the naming and numbering properties of bars
and stirrups.
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Option Description
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Prefix Prefix for the bar position number.
Start number Start number for the bar position

number.

Stirrup reinforcement (67)
Stirrup reinforcement (67) creates stirrup reinforcement for a beam, a panel,
or a rectangular slab.

Reinforcement created

• Main stirrups

• Hooks (Optional)
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Use for

Situation More information
A concrete beam with
main stirrups.

Before you start

• Create the concrete part.

• Calculate the required area of reinforcement.

Parameters tab
Use the Parameters tab to define stirrup properties.

Reinforcing bar

Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Size Diameter of the reinforcing bar.
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Option Description
Grade Strength of the steel used in the

reinforcing bars.
Bending radius Internal radius of the bends in the

bar.

You can enter a separate value for
each bar bend. Separate the values
with spaces.

Bending radius complies with the
design code you are using. Main bars,
stirrups, ties, and hooks usually have
their own minimum internal bending
radii, which are proportional to the
diameter of the reinforcing bar. The
actual bending radius is normally
chosen to suit the size of the
mandrels on the bar-bending
machine.

Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Hook type

Define the hook type separately for the start and end of the part. The options
are:

Option Description
No hook

Standard 90-degree hook

Standard 135-degree hook

Standard 180-degree hook

Custom hook

If you select a standard hook, the Angle, Radius, and Length use predefined
dimensions.

Option Description
Angle Enter a value between -180 and +180

degrees.
Radius Enter the internal bending radius of

the hook.
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Option Description
Length Enter the length of the straight part.
Stirrup shape Select the shape of the stirrups. The

options are Open, Closed, and Spiral.
Number of rounds, N* If you select the stirrup shape Spiral,

enter the number of rounds the
spiraled stirrup has.

Cover thickness

Define whether the concrete cover thickness is same or different on each side
from Concrete cover dropdown list.

If you select a different concrete cover for each side, enter the separate cover
thicknesses.

Rotation

Rotate the polygon of the rebar shape from the First stirrup and the Second
stirrup. You can rotate the polygon either at each even or odd position.

Stirrup spacing tab
Use the Stirrup spacing tab to define the spacing of stirrups.

You can define six zones for the distribution.

Option Description
Symmetric Define whether the same spacing and

bundling properties are used at the
start and end of the part.

N Number of stirrups.
Space Define the spacing of stirrups.

Use a space to separate spacing
values. Enter a value for each space
between the stirrups. For example, if
there are 3 stirrups, enter 2 values.
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Option Description
Bundling Select whether to have single or

double main stirrups.

Single stirrups: 

Bundled stirrups: 
Min hole size Define a size limit for the holes.
Stirrup spacing type Target

Tekla Structures creates equal spaces
between the bars, aiming the spacing
value as closely as possible to the
value you specify. This is the default
option.
Exact

The first and last space of a zone
adjust themselves to even out bar
distribution. The spaces in the middle
of each zone are exactly the size you
specify.

Holes and recesses tab
Use the Holes and recesses tab to define how reinforcement is created
around openings.

Bar behavior at holes and recesses

Select how the bars next to holes and recesses are handled.

Option Description
Cut bars Select whether the bars are cut and which

cuts are ignored.

You can select to ignore cuts by part name
or class. If you ignore cuts by name, define
the name. If you ignore cuts by class, define
the class.
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Cover thickness

 Description
1 Define the cover thickness of the opening to control where the

first full height stirrup is placed.
2 Define the minimum hole size.

Reinforcement around opening

Option Description
No reinforcement around the
opening.

Reinforcement is created around the
opening.

Reinforcement position

If you create reinforcement around the opening, select how the reinforcement
is positioned.
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Longitudinal reinforcement (70)
Longitudinal reinforcement (70) creates longitudinal reinforcing bars to
concrete parts.

Objects created

• Main bars

• Hooks (Optional)

Use for

Situation Description
Concrete slab
with
longitudinal
main bars and
standard
hooks.

Before you start

• Create the concrete part.

• Calculate the required area of reinforcement.

Selection order

1. Select the concrete part.
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Parameters tab
Use the Parameters tab to define the longitudinal bars properties and
spacing.

Properties

Option Description
Prefix Prefix for the part position number.
Start No Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Size Diameter of the reinforcing bar.
Grade Strength of the steel used in the

reinforcing bars.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Concrete cover thickness

If the part has a cut, enter the concrete cover thicknesses at cut positions.

Enter the concrete cover thicknesses on the plane and from the plane.

Enter the concrete cover thickness at the start and end of the bars.
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Spacing

Option Description
Spacing Define the spacing of reinforcement

bars.

Use a space to separate spacing
values. Enter a value for each space
between the bars. For example, if
there are 3 bars, enter 2 values.

Number of bars Enter the number of reinforcing bars.

Select the location of reinforcing bars from the list. The default is that the bars
are on both sides.

Hooks tab
Use the Hooks tab to create hooks and define their properties.

Hook type

Define the hook type separately for the start and end of the part. The options
are:

Option Description
No hook

Standard 90-degree hook

Standard 135-degree hook

Standard 180-degree hook

Custom hook
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If you select a standard hook, the Angle, Radius, and Length use predefined
dimensions.

Option Description
Angle Enter a value between -180 and +180

degrees.
Radius Enter the internal bending radius of

the hook.
Length Enter the length of the straight part.

Select the direction of hooks from the Direction list.

Select to create the hooks for split rebars from the Hooks for split rebars list.

Beam end reinforcement (79)
Beam end reinforcement (79) creates reinforcement for the end of a
concrete beam or strip footing.

Bars created

• Horizontal U-shaped bars (types 1 and 2)

• Vertical U-shaped bars (types 3A and 3B)

• Oblique bar (type 4)

• Stirrups (types 5A and 5B)

 Description
1 Horizontal U bars (type 2)
2 Horizontal U bars (type 1)
3 Oblique bar (type 4)
4 Vertical U bars (type 3A)
5 Stirrups (type 5A)
6 Vertical U bars (type 3B)
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 Description
7 Stirrups (type 5B)

Use for

Situation More information
Standard beams Use bars 3A and 5A for the beam end.
Dapped beams  
Beams with anchor bolt hole in the
notched area

 

Beams and strip footings that have a
rectangular cross section

 

Do not use for

Parts that have irregular cross sections.

Before you start

• Create the concrete beam or strip footing.

• Calculate the required area of reinforcement.

Picking order

1. Select concrete beam or strip footing.

2. Pick position.

Picture tab
Use the Picture tab to define concrete cover thickness, distances from the
concrete surface to the bars, and angle of bar 4.
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Bars tab
Use the Bars tab to define which bars to create, bar dimensions, and to slice
bars 3A and 3B.

Horizontal U bars 1 and 2

Use the following options to create bars in the lower area of the beam end, in
the horizontal planes (bar type 1):

Option Description
Two bars on each plane.
One in the middle of the
beam end, the other
extending to the sides of
the beam.
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Option Description
One bar on each plane,
extending to the sides of
the beam.

One bar on each plane, in
the middle of the beam
end.

Two identical, overlapping
bars on each plane.

To create bars in the upper area of the beam end, around a hole, enter
dimensions for bar 2.

Vertical U bars 3A and 3B

To create vertical U-shaped bars, enter dimensions for:

• Bar 3A: for the notched area of the beam.

• Bar 3B: for the higher part of the beam.

Splicing bars 3

You can create vertical U bars (bar type 3) of two bars joined with a splice. To
do this, use the following list box on the Bars tab:

If you choose to splice bars, you can select the splice type:
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Option Description
Lap up Creates a lap splice above the horizontal

center line of the beam end.
Lap down Creates a lap splice below the horizontal

center line of the beam end.
Lap both Creates a lap splice centered to the

horizontal center line of the beam end.
Coupler Creates a coupler.
Weld joint Creates a welded joint.

For lap splices, you can define the lap length L and whether the bars are on
top of each other or parallel to each other.

For all splice types, you can define the offset of the splice center point from
the horizontal center line of the beam end.

Stirrups 5A and 5B

To create stirrups for beam ends, enter dimensions for:

• Bar 5A: for the notched area of the beam.

• Bar 5B: for the higher part of the beam.

Groups tab
Use the Groups tab to define grouping properties of bars.

Enter the number and spacing of bars in each group of bar types. If the
spacing varies, enter each value individually.

Attributes tab
Use the Attributes tab to define bar properties.

Option Description
Grade Strength of the steel used in the

reinforcing bars.
Size Diameter of the reinforcing bar.
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Define the name for the reinforcing

bars.

Tekla Structures uses the name in
drawings and reports.
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Option Description
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Corbel reinforcement (81)
Corbel reinforcement (81) creates reinforcement for one or two corbels in a
concrete column. The two corbels must have the same top level, thickness,
and horizontal location.

Objects created

• Main bars

• Stirrups

• Additional bars

Use for

Situation Description
Two corbels, beveled and
rounded, with the same top
level, thickness, and horizontal
location.

Two additional bars crossing
each other.
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Situation Description
One straight corbel.

One additional bar.

Limitations

Do not use Corbel reinforcement (81) for two very different corbels.

Before you start

• Create the concrete column and beams.

• Create the corbels. Use Corbel connection (14) or a seating connection to
create the corbels.

Selection order

1. Select the main part (concrete column).

2. Select the secondary parts (one or more corbels).

3. Click the middle mouse button to create the reinforcement.

Main bars tab
Use the Main bars tab to control the main bar length, concrete cover
thickness, reinforcing bar spacing, and reinforcing bar properties.
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 Description
1 Main bar length.
2 Distance from the concrete surface to the main bar.

Option Description
Grade Strength of the steel used in the

reinforcing bars.
Size Diameter of the reinforcing bar.
Name Define a name for the main bars.

Tekla Structures uses the name in
drawings and reports.

Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Prefix Prefix for the part position number.
Start number Start number for the part position

number.

Follow shape

This setting also affects the transverse stirrups.

Option Description
Inclined

The last rebar segment follows the
inclined corbel edge.
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Option Description
Horizontal

The last rebar segment is created
horizontally.

Cover thickness

 Description
1 Concrete cover thickness.
2 Number of bars in the reinforcement.
3 Space between the reinforcing bars.

Stirrups/Transverse stirrups/Diagonal stirrups tab
Use the Stirrups, Transverse stirrups and Diagonal stirrups tabs to control
the stirrup creation, stirrup type, concrete cover thickness, reinforcing bar
spacing and properties.

Stirrups

Define the distance from the concrete surface to the stirrups.

Option Option Option

Concrete cover thickness

Define the concrete cover thickness. You can select that the concrete cover is
the same at each side.
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Option Option Option

Option Description
Number of
bars

Define the number of bars in the reinforcement.

Spacing values Define the space between the reinforcing bars.
Transverse
stirrups in
column

Select whether the column is reinforced with
transverse stirrups.

Name Define a name for the stirrups.

Tekla Structures uses the name in drawings and
reports.

Size Diameter of the reinforcing bar.
Grade Strength of the steel used in the reinforcing bars.
Class Use Class to group reinforcement.

For example, you can display reinforcement of
different classes in different colors.

Prefix Prefix for the part position number.
Start number Start number for the part position number.

Stirrup type

Option Description
The stirrup consists of a bent single reinforcing bar.

Define the hook length.

The default values (for the standard 90 degree stirrup
hook) are read from the rebar_database.inp file.

Select a suitable overlap position for this stirrup type.
The stirrup consist of two overlapping U bars that face
each other.

Define minimum and maximum overlapping length.
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Option Description
The stirrup consists of two overlapping U bars.

Define minimum and maximum overlapping length.

The transverse stirrup is one open U-bar.

Additional bars tab
Use the Additional bars tab to control the creation of additional bars in
corbels, concrete cover thickness, and additional bar properties.

Additional bars

Option Description
No additional bars.

One additional bar.

Two additional bars parallel to each other.

Two additional bars crossing each other.

Two pairs of additional bars crossing each
other.

Stirrups and cover thickness

Define the distance from the concrete surface to the stirrups and the
additional bar dimension.
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Define the concrete cover thickness.

Option Description
Grade Strength of the steel used in the reinforcing bars.
Size Diameter of the reinforcing bar.
Name Define a name for the additional bars.

Tekla Structures uses the name in drawings and
reports.

Class Use Class to group reinforcement.

For example, you can display reinforcement of
different classes in different colors.

Prefix Prefix for the part position number.
Start number Start number for the part position number.

Rebar assembly tab
Use the Rebar assembly tab to add the created reinforcement as a rebar
assembly to the cast units.

Create as rebar assembly

You can add the created reinforcement as a rebar assembly to the cast units
with a predefined assembly type, name, prefix, and start number.
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Option Description
Create as rebar assembly Select Yes to create all reinforcement

as one rebar assembly, and to include
it to the cast unit of the input part.

Add to existing rebar assembly • Do not add: New rebar is added
as a rebar assembly to the cast
unit.

• As single bars: Add all new rebars
directly into an existing rebar
assembly as rebars.

• As sub-assembly: Add all new
rebars to their own new rebar
assembly, which is then included
as a sub-assembly to the main
rebar assembly.

Rebar assembly type Select the rebar assembly type.

If you do not select the type, the
default value of the rebar assembly is
used.

Name, Profile, Start number Define the name, profile, and start
number.

If you do not define these, the default
values of the rebar assembly are
used.

Round column reinforcement (82)
Round column reinforcement (82) creates reinforcement for a concrete
column that has a round cross section.

Objects created

• Longitudinal main bars (6)

• Stirrups

• Column end reinforcement
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Use for

Situation Description
Round concrete column with main
bars bent outside the column.
Continuous spiral stirrup.

Round concrete column with straight
main bars protruding from the
column, or entirely inside the column.
Separate stirrups. Top of the column
is reinforced.

Limitations

Do not use for rectangular columns.

Selection order

1. Select the main part (column).

The component is created automatically when the part is selected.
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Part identification key

 Part
1 Main bars
2 Stirrups
3 Column end reinforcement
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Main bars tab
Use the Main bars tab to control the length of the vertical and horizontal
extensions of the main bars at the top and bottom of the column, the
thickness of the concrete cover over stirrups, and the cranking of the main
bars.

Main bar properties

Option Description
Number of bars Number of main bars.
Rotation Rotation of main bars.
Grade Strength of the steel used in the reinforcing bars.
Size Diameter of the main bars.
Bending radius Bending radius of the main bars.
Class Use Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.

Name Name for the main bars.

Tekla Structures uses the name in drawings and reports.
Prefix Prefix for the part position number.
Start number Start number for the part position number.

Hooks at top / bottom

Option Description
Type Select the hook angle.
Length Length of the hook.
Bending radius Bending radius of the hook.

Cranking

You can create cranked reinforcing bars at the top and at the bottom of the
column. Enter the vertical and sloped distance dimensions.
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Enter the horizontal dimensions of top and bottom cranked bar as distance
between center of bars or as outer distance of bars:

Stirrups tab
Use the Stirrups tab to control the thickness of the concrete cover over the
stirrups at the top and bottom of the column, spacing and number of stirrups
or laps in each stirrup group, stirrup types and stirrup shapes.
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Stirrup dimensions

1. Thickness of the concrete cover over the stirrups at the top and the
bottom of the column. The default cover thickness is 50 mm.

Group 1 is the top stirrup group, 5 is the bottom stirrup group. Group 3 is
always created.

2. Spacing of stirrups in each stirrup group.

3. Number of stirrups in each stirrup group.

4. Select how the stirrups are distributed.

• Exact space, flexible at ends: Tekla Structures uses exactly the
spacing value you specify, and evens out the stirrup distribution at the
column ends.

• Target space: Tekla Structures creates the stirrups at even spacings
and tries to use the spacing value you specify.

Stirrup types

Option Description
Separate stirrups

Single, continuous spiral stirrup

Separate spiral stirrups
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Option Description
Single, continuous stirrup

Stirrup shape

Select the shape of the stirrup from the list.

Stirrup overlap

Select the angle or the length of stirrup overlap. The option is not active if you
have created spiral stirrups.

The overlapping angle can be of maximum 180 degrees.

The overlapping length can be in millimeters or inches.

Stirrup attributes tab
Use the Stirrup attributes tab to control the grade, size, class, name, and
numbering properties of the stirrups.

Stirrup properties

Option Description
Grade Strength of the steel used in the reinforcing bars.
Size Diameter of the stirrups.
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Option Description
Name Name for the stirrups.

Tekla Structures uses the name in drawings and reports.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.

Prefix Prefix for the part position number.
Start number Start number for the part position number.

Top tab
Use the Top tab to control the thickness of the concrete cover of the top
reinforcement, the number of top bars, and their spacing and rotation.

Column top reinforcement

1. Define the concrete cover thickness.

2. Define the length of the ultimate leg.

Column top reinforcement rotation

Select how to rotate the reinforcement at the top of columns.

Column top reinforcement properties

Option Description
Number of bars Number of top bars.
Grade Strength of the steel used in the reinforcing bars.
Size Diameter of the top bars.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.
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Option Description
Name Name for the top bars.

Tekla Structures uses the name in drawings and reports.
Prefix Prefix for the part position number.
Start number Start number for the part position number.

Bottom tab
Use the Bottom tab to control the thickness of the concrete cover of the
bottom reinforcement, the number of bars, and their spacing and rotation.

Column bottom reinforcement

1. Define the concrete cover thickness.

2. Define the length of the ultimate leg.

Column bottom reinforcement rotation

Select how to rotate the reinforcement at the bottom of columns.

Column bottom reinforcement properties

Option Description
Number of bars Number of bottom bars.
Grade Strength of the steel used in the reinforcing bars.
Size Diameter of the reinforcing bar.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.

Name Name for the bottom bars.

Tekla Structures uses the name in drawings and reports.
Prefix Prefix for the part position number.
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Option Description
Start number Start number for the part position number.

Advanced (main bars) tab
Use the Advanced (main bars) tab to control the main bar extensions
separately for each bar.

Option Description
In Bar index, enter the bar number
for which to define the extension.
Define the size, the distance from the
column edge and the length of each
extension.

Select whether the main bars are
tapered or moved according to the
upper surface, if the top of the
column is skewed.

Select whether to cut bars by the cut
in the column.

Rebar grouping

Select to create bars as a rebar group or as single bars from the Creation
method list.

Rebar assembly tab
Use the Rebar assembly tab to add the created reinforcement as a rebar
assembly to the cast units.

Create as rebar assembly

You can add the created reinforcement as a rebar assembly to the cast units
with a predefined assembly type, name, prefix, and start number.

Entensions
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Option Description
Create as rebar assembly Select Yes to create all reinforcement

as one rebar assembly, and to include
it to the cast unit of the input part.

Rebar assembly type Select the rebar assembly type.

If you do not select the type, the
default value of the rebar assembly is
used.

Name, Profile, Start number Define the name, profile, and start
number.

If you do not define these, the default
values of the rebar assembly are
used.

Rectangular column reinforcement (83)
Rectangular column reinforcement (83) creates reinforcement for a
concrete column that has a rectangular cross section.

Objects created

• Longitudinal main bars: corner bars (4), side bars

• Stirrups

• Intermediate links

• Column end reinforcement

Use for

Situation Description
Rectangular concrete column with
corner bars and side bars bent
outside the column. Side bars on long
sides. Intermediate links tie side bars
at every second stirrup.
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Situation Description
Rectangular concrete column with
straight corner and side bars entirely
inside the column. End of column
reinforced.

Limitations

Do not use for round columns.

Selection order

1. Select the main part (column).

The component is created automatically when the part is selected.
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Part identification key

 Part
1 Corner bars
2 Side bars
3 Stirrups
4 Intermediate links

Main bars tab
Use the Main bars tab to control the corner bar properties, the symmetry
options, rotation, and concrete cover thickness.
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Basic corner bar properties

Define the grade, size and bending radius of the corner bars. The active
settings depend on the selected symmetry option.

Option Description
Grade Strength of the steel used in the reinforcing bars.
Size Diameter of the reinforcing bar.
Bending radius Define the bending radius of the corner bars.

Define the concrete cover thickness.

Select whether the thickness is the same on all sides.

Symmetry options

Select the symmetry option. Use the symmetrical conditions to define which of
the corner bars have the same grade, size, and bending radius properties. The
corner bars that have same properties are symmetrical.

Rotation

In square columns, you can select the perpendicular sides of a column if the
sides require different reinforcement. You can rotate all reinforcement in a
square column by 90 degrees.

Additional corner bar properties

Option Description
Class Use Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.

Name Define a name for the main bars.

Tekla Structures uses the name in drawings and reports.
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Option Description
Prefix Prefix for the part position number.
Start number Start number for the part position number.

Bar ends tab
Use the Bar ends tab to control the length of vertical and horizontal
extensions for the corner bars and side bars, and the cranking.

  
Bar creation Select whether the extensions of

corner bars and side bars are created
symmetrically on both sides of the
column.

If you select Not symmetrical, you
can enter separate extension values
for the opposite sides of the column.

Vertical extension Define the length of the vertical
extension outside the column for
corner bars and side bars.

The active settings depend on Bar
creation: Symmetrical or Not
symmetrical.

Horizontal extension Define the length of the horizontal
extension for corner bars and side
bars.

The active settings depend on Bar
creation: Symmetrical or Not
symmetrical.

Corner bars

Side bars 1

Side bars 2

Select the hook type, and define the
hook length and bending radius.
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Top corner bar direction

Bottom corner bar direction

Select the direction of the corner
bars.

The options illustrate whether the
direction is a horizontal extension or
a cranking option.

Cranking You can create cranked reinforcing
bars at the top and at the bottom of
the column.

To activate the cranking options,

select  in the Top corner
bar direction and Bottom corner
bar direction lists. Define the
dimensions for the cranked bars.

Concrete components 3389 Reinforcement



  

To successfully create the cranked
reinforcing bars, ensure that the
bending radius is not too large.

Align cranking When set to Yes, the cranking of the
corner bars is automatically aligned to
the horizontal extension direction.
This helps you to output two-
dimensional bars easier.

Edge dimensions Define the edge distance from the
column corner to the point where the
cranking starts

.

Select cranking from the edge or
center line of the rebar:

Define the cranking separately for the
corner bars and the side bars.
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Side bars tab
Use the Side bars tab to control the number of side bars, side bar spacing and
placing, symmetry options, and properties.

Number of side bars

Define the number and spacing of side bars. You can define two sets of side
bars on each side of the column.

You can define the side bars separately for each side of the column.

The active settings depend on the selected symmetry option.

Placing of side bars

Select the horizontal and vertical placing for the side bars. Select whether the
bars are placed starting from the corner or at equal spaces.

Distance between corner bars and side bars.

Distance between side bars.

Symmetry options

Select the symmetry option. Using the symmetrical conditions you can define
which side bars are symmetrical, and which side bars use the same properties.

Side bar properties

Option Description
Grade Define the strength of the steel used in the reinforcing

bars.
Size Define the diameter of the reinforcing bar.
Bending radius Define the bending radius of the side bars.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.
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Option Description
Name Define a name for the side bars.

Tekla Structures uses the name in drawings and reports.
Prefix Define a prefix for the part position number.
Start number Define a start number for the part position number.

Stirrups tab
Use the Stirrups tab to control the stirrup properties.

Stirrup dimensions

  
1 Define the thickness of the concrete cover over the stirrups at the top

and the bottom of the column. The default cover thickness is 50 mm.

Group 1 is the top stirrup group, 5 is the bottom stirrup group. Group
3 is always created.

2 Define the spacing of stirrups in each stirrup group.
3 Define the number of stirrups in each stirrup group.
4 Select how the stirrups are distributed.
5 If you select the Distance list option, enter different spacing values

for the groups.
6 Define the cover thickness for each stirrup group.
7 Define the gaps between the stirrup groups.

Create stirrups

Select whether the stirrups are created as individual reinforcing bars, rebar
group, or spiral rebar group.

Concrete components 3392 Reinforcement



Rebar lapping at stirrup corners

Select the how the rebars lap at the stirrup corners. The options are 135-
degree hooks or 90-degree hooks at the bar end, or overlapping U-shape
stirrups.

You can define the overlap length for the U-shape stirrups.

Ignore cuts

If you have a recess or a hole in the column, you can select to ignore the cuts
at the top and the bottom of the column when the stirrups are created.

Stirrup properties

Option Description
Grade Define the strength of the steel used in the reinforcing

bars.
Size Define the diameter of the reinforcing bar.
Name Define a name for the stirrups.

Tekla Structures uses the name in drawings and reports.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.

Prefix Define a prefix for the part position number.
Start number Define a start number for the part position number.
Overlap length Define the overlap length for the U-shape stirrups.

Intermediate links tab
Use the Intermediate links tab to control the intermediate links to tie all side
bars.

If you have rectangular columns that have very large cross sections, the side
bars may be far from the corners of the stirrups. You will need to create
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intermediate links to tie all side bars, and to prevent them from buckling when
they are in compression.

Intermediate links are created for each stirrup group.

NOTE Intermediate links are created between Side bars 1 or Side bars 2
that are symmetrical.

For Side bars 2 intermediate links are created only if no Side bars 1
are created.

Create as one group

Select whether all the stirrups are created as a single group.

Properties of intermediate links

Option Description
Grade Define the strength of the steel used in the reinforcing

bars.
Size Define the diameter of the reinforcing bar.
Name Define a name for the stirrups.

Tekla Structures uses the name in drawings and reports.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.

Prefix Define a prefix for the part position number.
Start number Define a start number for the part position number.

Spacing of intermediate links

Spacing is the same as stirrup spacing.

Spacing is double the stirrup spacing (intermediate links at
every second stirrup).

Same as above, but for alternate stirrups.

No intermediate links are created.

Intermediate link type

Select the type of the link.
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Intermediate link pattern

Select whether intermediate links go in one direction or in a crossing pattern.

Hook orientation

Select the hook orientation for both sides.

Closed stirrups as intermediate links

Select whether to use closed stirrups as intermediate links.
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If you select closed stirrups, select the type of the bar lapping at the stirrup
corners.

Zone without intermediate links

Define the zone length where intermediate links are not created. In this zone,
the stirrups tie the side bars. The distance is measured from the stirrup
corner.

If you have selected to use closed stirrups, you can define the distance from
the corner of the closed stirrups.

Top / Bottom tabs
Use the Top and Bottom tabs to control the top and bottom reinforcement
thickness of the concrete cover, number of bars, spacing and rotation.

Number and spacing of bars

Define the number and spacing of the top or bottom bars.

You can define the number of transverse bars in both cross directions.

Column top / bottom reinforcement

 Description
1 Define the concrete cover thickness from the top / bottom of the

column.
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 Description
2 Define the length of the rebar legs.
3 Define the concrete cover thickness from the sides of the column.
4 Define the distance from the edge of the column to the edge of the

first rebar in the group.

Placing of top or bottom bars

Select the horizontal and vertical placing for the top or bottom bars. Select
whether the bars are placed starting from the corner or at equal spaces.

Distance between corner bars and side bars.

Distance between side bars.

Rotation

Select how to rotate the reinforcement at the top or bottom of columns.

No rotation.

Transverse bars are perpendicular to the longer side of
the column.
Rotation angle is 90 degrees.

Transverse bars are parallel to the longer side of the
column.

Top and bottom reinforcement properties

Option Description
Grade Define the strength of the steel used in the reinforcing

bars.
Size Define the diameter of the reinforcing bar.
Bending radius Define the bending radius of the top or bottom bars.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.

Name Define a name for the top or bottom bars.

Tekla Structures uses the name in drawings and reports.
Prefix Define a prefix for the part position number.

Concrete components 3397 Reinforcement



Option Description
Start number Define a start number for the part position number.

Rebar assembly tab
Use the Rebar assembly tab to add the created reinforcement as a rebar
assembly to the cast units.

Create as rebar assembly

You can add the created reinforcement as a rebar assembly to the cast units
with a predefined assembly type, name, prefix, and start number.

Option Description
Create as rebar assembly Select Yes to create all reinforcement

as one rebar assembly, and to include
it to the cast unit of the input part.

Rebar assembly type Select the rebar assembly type.

If you do not select the type, the
default value of the rebar assembly is
used.

Name, Profile, Start number Define the name, profile, and start
number.

If you do not define these, the default
values of the rebar assembly are
used.

Hole reinforcement for slabs and walls (84)
Hole reinforcement for slabs and walls (84) creates a hole in a concrete slab
or wall and reinforcement around the hole.
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Bars created

• Straight bars along hole edges

• Diagonal bars close to hole corners

• U-shaped edge bars

Use for

Situation More information
Rectangular or round holes in
concrete slabs and walls

 

Straight and edge bars only,
no diagonal bars.

Diagonal and edge bars only,
no straight bars.

Hole rotated from the
direction of the slab.

One diagonal bar at each
corner.
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Situation More information
Different number of bars on
each side of the hole in the
wall. No diagonal bars.

Before you start

• Create the concrete slab or wall.

• Calculate the required area of reinforcement.

Selection order

1. Select the center of the hole.

2. Select the concrete slab or wall.

Picture tab
Use the Picture tab to define creation of the hole, hole and bar dimensions,
and concrete cover thickness.

Hole

Select to create a hole and reinforce it or to create reinforcements to an
existing hole from the Create list.

Select the shape of the hole:

Option Description
Rectangular

Round

Select the pivot point for hole offsets:
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Option Description
Hole center

Hole corner

Enter the rotation angle of the hole:

Concrete cover

Enter the cover thicknesses for horizontal and vertical edge bars.

Horizontal Vertical

Generation start point

You can specify which point of the slab is taken as the origin where the
creation plane starts. This means that the created reinforcement is aligned to
the slab edge starting from that point.
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Horizontal and vertical bars tab
Use the Horizontal and vertical bars tab to define which bars are closest to
the surface of the concrete, and the properties of bar groups along the sides
of the hole.

The slab or wall direction defines the direction of the hole and which bars are
to the left and right of, and above and below the hole.

Option Description
Grade Strength of the steel used in the

reinforcing bars.
Size Diameter of the reinforcing bar.
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Define the name for the reinforcing

bars.

Tekla Structures uses the name in
drawings and reports.

Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Additional bars tab
Use the Additional bars tab to create additional bars and define their
properties.
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Enter the length of additional bars from the opening corner.

Enter the additional bars offsets from horizontal and vertical bars.

Option Description
Grade Strength of the steel used in the

reinforcing bars.
Size Diameter of the reinforcing bar.
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Edge bars tab
Use the Edge bars tab to define the properties of bar groups on each side.

The slab or wall direction defines the direction of the hole and which bars are
to the left and right of, and above and below the hole.

Option Description
Grade Strength of the steel used in the

reinforcing bar.
Size Diameter of the reinforcing bar.
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
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Option Description
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Diagonal bars tab
Use the Diagonal bars tab to define the properties of bar groups at each
corner of the hole.

The slab or wall direction defines the direction of the hole and which bars are
to the left and right of, and above and below the hole.

Option Description
Grade Strength of the steel used in the

reinforcing bars.
Size Diameter of the reinforcing bar.
Prefix Prefix for the part position number.
Start number Start number for the part position

number.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Hole creation and reinforcement (85)
Hole creation and reinforcement (85) creates a hole in a concrete part and
reinforcement around the hole.

Bars created

• Straight bars at hole edges

• Stirrups

• Z-shaped bars

Concrete components 3404 Reinforcement



Use for

Situation More information
Rectangular hole, stirrups on
each side of the hole, no Z-
shaped bars.

Round hole, Z-shaped bars, no
stirrups around the hole.

Concrete beams or columns  
Round or rectangular holes Hole only. No additional

reinforcement around it.
With or without Z-shaped
bars or stirrups

 

Do not use for

Parts that have round or irregular cross sections.

Before you start

• Create the concrete part.

• Calculate the required area of reinforcement.

Selection order

1. Select the center of the hole.

2. Select the concrete part.

Picture tab
Use the Picture tab to define hole properties, bar dimensions and locations,
concrete cover thickness, and angle of Z-shaped bars.
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Holes

Use these options to create holes and additional reinforcement:

Option Description
Creates a hole and
additional
reinforcement
around it.

Only creates a hole,
no reinforcement.

Use these options to define the direction of holes:

Option Description
Hole along the local
y direction of the
part.

Hole along the local
z direction of the
part.

Z-shape bars

Use these options to define Z-shaped bars around round holes:

Option Description
Concrete cover
measured in the
direction of the
radius of the hole.

Concrete cover
measured from the
corner of the
bounding box
around the hole.

Use these options to define the direction of Z-shaped bars:
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Option Description
 

 

Bars tab
Use the Bars tab to define bar properties.

Option Description
Grade Strength of the steel used in the

reinforcing bars.
Size Diameter of the reinforcing bar.
Name Tekla Structures uses the name in

drawings and reports.
Class Use Class to group reinforcement.

For example, you can display
reinforcement of different classes in
different colors.

Prefix Prefix for the part position number.
Start number Start number for the part position

number.

Stirrups tab
Use the Stirrups tab to define stirrups properties and additional settings.

Stirrups

Use these options to define the stirrups around holes:

Option Description
Single stirrups

Bundled stirrups
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Hooks

Option Description
135-degree hooks

90-degree hooks

Braced girder (88)
Braced girder (88) creates braced girders in a precast concrete part, such as in
a thin-shell slab or in a sandwich wall panel. The girders are cast into the
concrete part and they also work as a part of the reinforcement and as a
connector between the precast and cast-in-place concrete.

Objects created

The girders consist of the following parts:

• Two bottom reinforcing bars

• One or two top reinforcing bars

• Two connecting reinforcing bars

Instead of using reinforcing bars, you can use profiles and plates to create the
braced girders.

Use for

Situation Description
Braced girders are created in the
precast concrete slab.
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Situation Description
Braced girders are created in the
precast concrete sandwich panel.

Braced girders are created in a wide
plate floor with an opening.

Braced girders are created in a hollow
wall.

Profile as a girder.
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Selection order

1. Select the concrete part.

The girders are created automatically.

Part identification key

 Part
1 Top reinforcing bar
2 Connecting reinforcing bar
3 Bottom reinforcing bar

Picture tab
Use the Picture tab to control the creation, shape and dimensions of
reinforcing bars.

Reinforcing bar dimensions and shape

 Description
1 Distance between the end of the top reinforcing bar and the

part end.
2 Distance between the end of the connecting reinforcing bar and

the part end.
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 Description
3 Distance between the end of the bottom reinforcing bar and the

part end.
4 Radius of the connecting reinforcing bar.
5 Distance between bendings.

Define the distance between the bottom reinforcing bars, and the distance
between the top and bottom reinforcing bars.

If you add two reinforcing bars at the top, you can define the distance of these
reinforcing bars from the top of the connecting reinforcing bars.

Examples
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Examples
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Girder creation

Option Description
Create Select the type of the bottom, top and connecting

reinforcing bars (Bar a, b, c):

• Reinforcing bar

• Steel rod

• No (The reinforcing bar is not created.)
Profile Profile selection is activated when you select the

following girder option:

Define a prefix and a start number for the part
position number, and material, name, comment,
and class.

Plate Plate creation is activated when you select the
following girder option:

Define a prefix and a start number for the part
position number, and material, name, comment,
and class.

Add as Select the method that is used to connect the
girders to the cast unit:

Sub-assembly, Welded, No

Reinforcing bar properties

Define the reinforcing bar properties for the top, bottom and the connecting
reinforcing bars.

Option Description
Size Size of the reinforcing bar.
Grade/Material Grade of the reinforcing bar.
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Option Description
Name

Prefix

Start number

Comment

Class

A name, a prefix and a start number for the part
position number, and comment and class for the
reinforcing bar.

Create as rebar assembly

You can add the created reinforcement as a rebar assembly to the cast units
with a predefined assembly type, name, prefix, and start number.

Option Description
Create as rebar assembly Select Yes to create all reinforcement

as one rebar assembly, and to include
it to the cast unit of the input part.

Add to existing rebar assembly • Do not add: New rebar is added
as a rebar assembly to the cast
unit.

• As single bars: Add all new rebars
directly into an existing rebar
assembly as rebars.

• As sub-assembly: Add all new
rebars to their own new rebar
assembly, which is then included
as a sub-assembly to the main
rebar assembly.

Rebar assembly type Select the rebar assembly type.

If you do not select the type, the
default value of the rebar assembly is
used.

Name, Profile, Start number Define the name, profile, and start
number.

If you do not define these, the default
values of the rebar assembly are
used.

Parts tab
Use the Parts tab to control the positioning and number of girders.
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Workplane orientation

Option Description
Workplane position Use this setting to control to which side of the

input part the girders are created.

• Part XY plane

• Part YZ plane

• Part ZX plane

• Model creates the girders according to the
current work plane in the model.

• Top in form face sets the work plane parallel to
the top in form face plane.

Position in plane

Rotation

Position in depth

Define the orientation of the girder on the work
plane.

Girder position in z direction

Select how the girders are positioned in the z direction.
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Examples

Geometry
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Option Description
Multiple L factor Define the accuracy for the rounding of the girder

length.

The default value is 1.0. With the default value, there are
no decimals in the girder length.

Geometry Select the geometry for the connecting reinforcing bars.

Examples:
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Option Description

Girder position in y direction

Select how the girders are positioned in the y direction.
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Examples
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Examples

Extra girders

Select whether additional girder groups are created.

Examples
For example, if you have selected this option:
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Examples
Extra girder groups is set to None: No additional girder groups are created
between 2 existing braced girders.
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Examples
Extra girder groups is set to By number: Additional girder groups are
created based on the entered number. Distances between the groups are
equally divided.
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Examples
Extra girder groups is set to By distance: The number of additional girder
groups is based on the defined distance. The distances between the girder
groups are equally divided.

Girder group

Define whether additional girders are created from the existing girders.

Number is the number of girders in the girder group.

Distance list is the distance between the girders in the girder group.

e = is the position of the girders from the reference line.
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Option Description
• Girder group is positioned in the middle of the

reference line.

• Girder group is positioned on the right side of the
reference line.

• Girder group is positioned on the left side of the
reference line.

Examples
Existin
g
girders
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Examples
Additio
nal
girders

Geometry tab
Use the Geometry tab to control how openings and part length affect the
girder creation.

Option Description
Create always girders Select whether girders are always

created.

If you select Yes, girders are created
even when the girder is placed fully
outside the concrete part.

Openings Select whether girders are created in
openings.
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Option Description
Length Select how girders adapt to the part

shape.
Minimum length Define the minimum length of the

girder.
Maximum length Define the maximum length of the

girder.

The girder is split when the maximum
length is reached.

Examples of minimum length
No minimum length defined:
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Examples of minimum length
Defined minimum length (no girder created):

Double wall tab
Use the Double wall tab to select how a second concrete element affects the
girders in Braced girder (88).

Look up sec concrete element

Select whether a second concrete element affects the creation of the girders.
Define the class of the second wall in the Class box.

Select the first wall, and if the second wall matches the defined class, a girder
is created. You can also enter a series of classes. You can use this creation
method in combination with the options defined for openings on the
Geometry tab.

The example below shows a hollow wall where inside and outside shells have
different geometry.

Examples
A hollow core wall where inside and outside shells have different geometry.

Look up second concrete element = No
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Examples

A hollow core wall where inside and outside shells have different geometry.

Look up second concrete element = Yes
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Examples

UDA tab

You can define UDAs.

Braced girder (89)
Braced girder (89) creates braced girders between selected points in a precast
concrete part, such as in a thin-shell slab or in a sandwich wall panel. The
girders are cast into the concrete part and they also work as a part of the
reinforcement and as a connector between the precast and cast-in-place
concrete.

Objects created

The girders consist of the following parts:
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• Two bottom reinforcing bars

• One or two top reinforcing bars

• Two connecting reinforcing bars

Instead of using reinforcing bars, you can use profiles and plates to create the
braced girders.

Use for

Situation Description
Braced girders are created in the
precast concrete slab.

Braced girders are created in the
precast concrete sandwich panel.

Braced girders are created in a wide
plate floor with an opening.
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Situation Description
Braced girders are created in a hollow
wall.

Profile as a girder.

Selection order

1. Select the concrete part.

2. Pick the starting point of a girder.

3. Pick the end point of a girder.

Part identification key

 Part
1 Top reinforcing bar
2 Connecting reinforcing bar
3 Bottom reinforcing bar
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Picture tab
Use the Picture tab to control the creation, shape and dimensions of
reinforcement bars.

Reinforcing bar dimensions and shape

 Description
1 Distance between the end of the top reinforcing bar and the

picked point.
2 Distance between the end of the connecting reinforcing bar and

the picked point.
3 Distance between the end of the bottom reinforcing bar and the

picked point.
4 Radius of the connecting reinforcing bar.
5 Distance between bendings.

Define the distance between the bottom reinforcing bars, and the distance
between the top and bottom reinforcing bars.

If you add two reinforcing bars at the top, you can define the distance of these
reinforcing bars from the top of the connecting reinforcing bars.
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Examples
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Examples

Girder creation

Option Description
Create Select the type of the bottom, top and connecting

reinforcing bars (Bar a, b, c):

• Reinforcing bar

• Steel rod

• No (The reinforcing bar is not created.)
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Option Description
Profile Profile selection is activated when you select the

following girder option:

Define a prefix and a start number for the part position
number, and material, name, comment, and class.

Plate Plate creation is activated when you select the following
girder option:

Define a prefix and a start number for the part position
number, and material, name, comment, and class.

Add as Select the method that is used to connect the girders to
the cast unit:

Sub-assembly, Welded, No

Reinforcing bar properties

Define the reinforcing bar properties for the top, bottom and the connecting
reinforcing bars.

Option Description
Size Size of the reinforcing bar.
Grade/Material Grade of the reinforcing bar.
Name

Prefix

Start number

Comment

Class

A name, a prefix and a start number for the part position
number, and comment and class for the reinforcing bar.
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Create as rebar assembly

You can add the created reinforcement as a rebar assembly to the cast units
with a predefined assembly type, name, prefix, and start number.

Option Description
Create as rebar assembly Select Yes to create all reinforcement

as one rebar assembly, and to include
it to the cast unit of the input part.

Add to existing rebar assembly • Do not add: New rebar is added
as a rebar assembly to the cast
unit.

• As single bars: Add all new rebars
directly into an existing rebar
assembly as rebars.

• As sub-assembly: Add all new
rebars to their own new rebar
assembly, which is then included
as a sub-assembly to the main
rebar assembly.

Rebar assembly type Select the rebar assembly type.

If you do not select the type, the
default value of the rebar assembly is
used.

Name, Profile, Start number Define the name, profile, and start
number.

If you do not define these, the default
values of the rebar assembly are
used.

Parts tab
Use the Parts tab to control the positioning and number of girders.

Workplane orientation
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Option Description
Workplane
position

Use this setting to control to which side of the input part
the girders are created.

• Part XY plane

• Part YZ plane

• Part ZX plane

• Model creates the girders according to the current
work plane in the model.

• Top in form face sets the work plane parallel to the
top in form face plane.

Position in plane

Rotation

Position in depth

Define the orientation of the girder on the work plane.

Girder position in z direction

Select how the girders are positioned in the z direction.
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Example
Braced girders are positioned to picked points. The braced girders are related
to the top side of the part.

Geometry

Option Description
Multiple L factor Define the accuracy for the rounding of the girder

length.

The default value is 1.0. With the default value, there are
no decimals in the girder length.

Geometry Select the geometry for the connecting reinforcing bars.

Examples:
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Option Description
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Girder position in y direction

Select how the girders are positioned in the y direction.

Examples
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Examples

Extra girders

Select whether additional girder groups are created.

Examples
For example, if you have selected this option:
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Examples
Extra girder groups is set to None: No additional girder groups are created
between 2 existing braced girders.
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Examples
Extra girder groups is set to By number: Additional girder groups are
created based on the entered number. Distances between the groups are
equally divided.
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Examples
Extra girder groups is set to By distance: The number of additional girder
groups is based on the defined distance. The distances between the girder
groups are equally divided.

Girder group

Define whether additional girders are created from the existing girders.

Number is the number of girders in the girder group.

Distance list is the distance between the girders in the girder group.

e = is the position of the girders from the reference line.
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Option Description
• Girder group is positioned in the middle of the

reference line.

• Girder group is positioned on the right side of the
reference line.

• Girder group is positioned on the left side of the
reference line.

Examples
Existin
g
girders
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Examples
Additio
nal
girders

Geometry tab
Use the Geometry tab to control how openings and part length affect the
girder creation.

Option Description
Create always girders Select whether girders are always

created.

If you select Yes, girders are created
even when the girder is placed fully
outside the concrete part.

Openings Select whether girders are created in
openings.
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Option Description
Length Select how girders adapt to the part

shape.
Minimum length Define the minimum length of the

girder.
Maximum length Define the maximum length of the

girder.

The girder is split when the maximum
length is reached.

Examples of minimum length
No minimum length defined:
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Examples of minimum length
Defined minimum length (no girder created):

Double wall
Use the Double wall tab to select how a second concrete element affects the
girders.

Look up sec concrete element

Select whether a second concrete element affects the creation of the girders.
Define the class of the second wall in the Class box.

Select the first wall, and if the second wall matches the defined class, a girder
is created. You can also enter a series of classes. You can use this creation
method in combination with the options defined for openings on the
Geometry tab.

The example below shows a hollow wall where inside and outside shells have
different geometry.

Examples
A hollow core wall where inside and outside shells have different geometry.

Look up second concrete element = No
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Examples

A hollow core wall where inside and outside shells have different geometry.

Look up second concrete element = Yes
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Examples

UDA tab

You can define UDAs.

Reinforcement mesh array in area (89) / Reinforcement mesh array
(91)
Reinforcement mesh array in area (89) / Reinforcement mesh array (91)
create reinforcement meshes for an entire concrete part, or for a defined
polygonal area. Reinforcement mesh array (91) is suitable especially for
precast panels and slabs.

Objects created

• Reinforcement meshes
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Use for

Situation Description
Array of overlapping
rectangular meshes.

Array of meshes in a
polygonal area that you
define. Meshes clipped to
fit the defined area.

Before you start

• Create the concrete part.

• Set the work plane parallel to the plane where you want to create the mesh
array.

Selection order

Component Create reinforcement mesh
Reinforcem
ent mesh
array in
area (89)

1. To attach the reinforcement mesh array:

• to the entire part, pick the starting point of the mesh

• to a selected area, pick points to define the polygonal
shape of the mesh

2. Click the middle mouse button to create the reinforcement
mesh array.

Reinforcem
ent mesh
array (91)

1. Select the part.

The reinforcement mesh array is created automatically
when the part is selected.

Picture tab
Use the Picture tab to define the mesh catalog type, cover thickness and
location, mesh generation, cuts, and mesh area perimeter.
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Mesh type

Select the mesh catalog type from the mesh catalog.

Cover thickness

Define the mesh location and give values for Cover thickness on plane and
Cover thickness from plane.

Define the cross bar location for top and bottom.

Mesh generation

Option Description
Generation
direction

To rotate the mesh generation direction around the
alignment point, enter an angle.

Direction of
bottom layer

Select Opposite of top layer to mirror the bottom layer.

Cut by father
part cuts

Select Yes to cut the mesh with the cuts made in the
father part.

Clipping outside Select Yes to clip the meshes to fit the part or the
selected area.

Mesh area
perimeter

Select the outline which the mesh follows.

The meshes in the examples below are created by picking
the same points but with different mesh area perimeters.
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Option Description
 Example: Polygon

 Example: Part

Concrete components 3453 Reinforcement



Option Description
 Example: Polygon + Part

Hole cover
thickness

Define the hole cover thickness.

Generation start point

Enter the polygon generation start point index.

Overlapping tab
On the Overlapping tab, define the minimum and maximum overlapping
along the longitudinal and crossing direction, and set the mesh offset.

Option Description
Overlapping Define the minimum and maximum overlap along the

Long side and Short side of the mesh.
Mesh offset Define how the meshes are placed.

When you are creating both the top and the bottom
mesh, you can shorten the starting mesh layer of both
meshes separately. This allows you to move the whole
mesh layer while the mesh layout defined in Mesh
offset is retained.
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Option Description
Mesh start offset Define mesh start offset for the first mesh. The length

of the first mesh is divided by the selected value.

For example, if you select the Mesh start offset to be
1/4, the length of the first mesh is divided by 1/4.

If you select Specified, the Start length offset option
becomes visible and you can enter the offset for the
first mesh.

Attributes tab
On the Attributes tab, define the numbering properties, name, and class of
the reinforcement meshes.

Rebar in beam (90)
Rebar in beam (90) adds reinforcement bars to concrete beams.

Parts created

Complete reinforcement structure: stirrups and perpendicular rebars are
created in the concrete part.

Use for

Situation More information
Rebars in concrete
beam.
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Situation More information
Rebars in a concrete
column.

Do not use for

Use this component to add reinforcement bars to a concrete part.

Before you start

Before the component can be created, you need to create a concrete part first.

Primary bottom bars tab
Use the Primary bottom bars tab to define the properties of the lower
reinforcing bars.

Properties

Option Description
Grade Defines the grade of the main bottom

reinforcing bars. This field cooperates
with the Size field.

Size Defines the diameter of the main
bottom reinforcing bars. Pressing
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Option Description
the ... button right of the field will
open the Select rebar dialog box.

In the dialog box you can select the
grade and the accompanying
diameter.

NOTE Selecting a size will override
the value in the Grade field.

Bend lengths left Defines the length of the left end-
extension.

Bend lengths right Defines the length of the right end-
extension.

End conditions left/right

Picklist to define the rebars’ end condition on the left and right side. The
options are:

Picklist item Example
Default

90 Degree

135 Degree

180

-180
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Picklist item Example
-135

-90

-45

45

Bar not to create

Picklist to define which rebar should not be created. The options are:

Picklist
Item

Example

_
O
_
O
_
O
_
O
_
O
_
_
.
_
O
_
O
_
O
_
.
_
_
O
_
O
_
O
_
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Picklist
Item

Example

O
_
.
_
_
.
_
O
_
O
_
O
_
.
_

Creation method

This field defines the way the rebars are created. There are three options:

Option Description
No rebars No bottom rebars are created.
Number of bars A fixed numer of bars is created. The

spacing between the bars is
automatically calculated.

By spacing A accompanying field becomes
active. The entered value is the fixed
spacing for the rebars. The number
of rebars is calculated automatically.

Positioning and distances

In the right upper side of this tab a picture and some picklists are displayed.
These fields and lists are to define the position and de rebar distances.

The distance fields are used for defining the size of the rebars. The picklists are
for positioning. Below some examples for the positioning rebars on the left
side:

Picklist
item

Description Example

The part edge is
normative for
positioning the rebar.

The concrete parts’
reference point is
normative for
positioning the rebar.
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Picklist
item

Description Example

The picked position is
normative.

The edge of the top
part cut is normative
for positioning the
rebar.
The edge of the
bottom part cut is
normative for
positioning the rebar.
The centerline of the
concrete part is
normative for
positioning the rebar.
 

 

  

 

Shape and pattern

The picklists and input fields are used to define the rebar shape, rebar pattern
and rebar distribution.
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In the left bottom side of the tab, some picklists are available for defining the
shape and distribution of the bottom rebars.

A - Shape of rebar

These picklists define the common shape of the rebars on both ends of the
concrete part. For some shapes distances can be entered (B).

B - Distance fields

These distance fields only apply for two rebar shapes (A).

C - Rebar pattern

Picklist for defining the rebar pattern. The picklist contains six options:

D - Consider part cuts in longitudinal direction

This picklist defines if part cuts in the concrete part should be taken into
account when positioning the rebars.

Picklist
item

Example
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Picklist
item

Example

E - Consider part cuts in vertical direction

These picklists contain options for defining if rebar shape should consider the
partcuts in vertical direction. For both top side and bottom side the placing can
be defined. Examples:

Picklist item Example

Side left tab
Use the Side left tab to create and define the properties of the horizontal
rebars on the left side.

The rebars which can be created are placed in longitudinal direction (just as
the Primary bars), but now the bends are created horizontally. The options on
this tab (defining rebar shape, dimensions, number of bars, and rebar
distribution) are similar to the options on the Primary bottom bars tab.

Examples of rebars which can be created with this tab:
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Side right tab
Use the Side right tab to create and define the properties of the horizontal
rebars on the right side.
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Similar to the Side left tab, but now the reference is the parts’ right side.

Stirrups tab
Use the Stirrups tab to define the dimensions of the stirrups in first section of
the concrete part.

In the picture below, the options are grouped.

Section A - Stirrup dimensions

Concrete components 3464 Reinforcement



Option Description
Grade Defines the grade of the main bottom

reinforcing bars. This field cooperates
with the Size field.

Size Defines the diameter of the main
bottom reinforcing bars. Pressing
the ... button right of the field will
open the Select rebar dialog box.

In the dialog box you can select the
grade and the accompanying
diameter.

NOTE Selecting a size will override
the value in the Grade field.

Bend lengths left Defines the length of the left end-
extension.

Bend lengths right Defines the length of the right end-
extension.

Section B - Stirrup dimensions

One input field is available for defining a fixed distance from concrete parts’
bottom side to bottom side of stirrup.

NOTE This offset is normative.

The input fields in the bottom side of this section are for defining the offset,
width and height of the stirrups.

Section C - Stirrup shape

In this section the general shape of the stirrups is defined.

First there is the Create stirrups option. This picklist has three options:

• No - No stirrups are created

• As one group - Stirrups are created as one group

• As separate group - Stirrups are created as separate groups

The general shape of the stirrup can be defined. You can choose a shape from
the picklist:
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Picklist
item

Description Example

No stirrups are
created

U-shape stirrups

C-shape inside

Closed box

Closed box
overlap
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Picklist
item

Description Example

Divided stirrup

Divided stirrups
overlap

 

Double U-shape

Single U-shape
left

Single U-shape
right

Stirrup rotation

The rotation of the stirrups can be set with below picklist. The picklist contains
four options: each option will rotate the stirrup 90 degrees counterclockwise.
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Stirrup spacing tab
Use the Stirrup spacing tab to define the distribution of the stirrups along the
concrete part.

You can define six zones for the distribution. For each zone you can set a
number of stirrups. The distance between the stirrups can be defined in two
ways:

• Fixed spacing between each stirrup.

• Distance between outer stirrups. (Spacing is then calculated from this
distance divided by the number of stirrups.)

Examples:

Picklist item Example

Stirrups 2 tab
Use the Stirrups 2 tab to define a second group of stirrups.
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This tab can be used if the shape of the concrete part is not uniform. For
example, if a part cut is applied, you may need different stirrups on that area.

Stirrups 2

Stirrups

Stirrups 2 spacing tab
Use the Stirrups 2 spacing tab to define the spacing of the second group of
stirrups.

Stirrups 3 tab
Use the Stirrups 3 tab to define a third group of stirrups.

You may need this tab in case the concrete part contains multiple part cuts.
For each area, the properties of the stirrups can be configured.

Example:

Stirrups 2

Concrete components 3469 Reinforcement



Stirrups

Stirrups 3

Stirrups 3 spacing tab
Use the Stirrups 3 spacing tab to define the spacing of the third group of
stirrups.

Advanced tab
Use the Advanced tab to define the naming and numbering properties of
rebars and stirrups.

The following information can be added:

• Comment

• Name

• Rebar profile Default Name
Main bottom rebars RB
Main top rebars RB
Side left RB
Side right RB
Stirrups STIRRUP
Stirrups2 STIRRUP
Stirrups3 STIRRUP

• Class

If the Class fields are left blank, then the following default classes will be
used:

Rebar profile Default Class
Main bottom rebars 201
Main top bars 202
Side left 203
Side right 204
Stirrups 301
Stirrups2 302
Stirrups3 303

• Series

If this field is left blank, the prefix will be empty for all rebar profiles.
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• Start number

If this field is left blank, Tekla Structures will use '1' as default start number
for all rebar profiles.

Configuration tab
Use the Configuration tab to define the bending radius and rotation.

Bending radius

The bending radius can be set separately for the main reinforcing bars and the
stirrups. Furthermore the radius can be set separately for the main bends and
the hook-bends.

The bending radius can be determined in three ways:

Picklist item Description
rebar_database.inp The bending radius is determined

from a configuration file
rebar_database.inp. This file is
located in the profil folder.

Relative to
diameter

For this option the radius is
calculated by multiplying the
reinforcing bar diameter with the
entered coefficient.

Bending radius Use this option to use a fixed value
for the bending radius.

Rotation

The picklist determines the orientation of the complete rebar structure in the
concrete part. The picklist contains four options, each item representents a 90
degree rotation.

Border rebar for single edge (93)
Border rebar for single edge (93) creates pin bars (U bars) and edge bars on
the edge of a concrete part.

Objects created

• Pin bars (U bars)

• Edge bars

Use for

Use this component to create pin bars in a concrete part.
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Example beam Example concrete panel

Example floor

Example shapes of rebars

Before you start

Create the concrete part where you want to place the border rebars, usually a
wall panel or a slab.

Selection order

1. Select the part where you want to create the border rebars.

2. Pick two input points on the desired edge of the part.

Pins tab
Use the Pins tab to define the properties of the pin bars.

Properties

Option Description
Grade Define the grade.

This setting is connected to the Size
setting.

Size Define the size.

Click the ... button to open the Select
rebar dialog box. Selecting the size
also affects the Grade value.
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Option Description
End conditions left

End conditions right

Select the end hook type for the left
and right side of the pin bar.

• Default (no hook)

• 90 Degree

• 135 Degree

• 180

• -180

• -135

Concrete components 3473 Reinforcement



Option Description
• -90

• -45

• 45

Bend lengths left Define the length of the left end
extension.

To define the length, select some
other value than Default in End
conditions left.

Bend lengths right Define the length of the right end
extension.

To define the length, select some
other value than Default in End
conditions right.

Shape of pin bars
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 Description
1 Select the shape of the pin bars.

2 Define the vertical dimensions.
3 Select if both bars 1 and 2 are created, or only one of them.

Pin bar direction for bevel edges

Select the direction of pin bars for bevel edges.
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Dimensions

Define the pin bar dimensions.

Pin bar direction

Select the pin direction. This setting depends on the selected pin bar shape.
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Pin spacing tab
Use the Pin spacing tab to define the pin bar creation and distribution along
the concrete part.

Pin zones

You can define six zones for the pin bar distribution. For each zone, you can
define the number of pin bars.

 Description
1 Set the pin bar offset from the sides.
2 Define which pin bars are created.

The bars illustrated as dots are not created.

Pin bar zone settings

Option Description
Number of spaces Define how many spacings are

created for the zone.
Space Define the spacing value for the zone.
Length Define the length of the zone. Length

is used if Number of spaces is left
empty.

Concrete components 3477 Reinforcement



Option Description
Horizontal space Define the horizontal spacing of pin

bars.

This setting is available if you have set
Different spacing horizontal and
vertical to Yes.

Vertical space Define the vertical spacing of pin
bars.

This setting is available if you have set
Different spacing horizontal and
vertical to Yes.

Pin bar distribution range

Select the pin bar distribution range in relation to the input points.
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Cover thickness

 Description
1 Define the minimum cover thickness for holes and notches.

Spacing for partial cuts

 Description
1 Define the pin bar spacing.
2 Define the vertical cut dimension.
3 Define the horizontal cut dimension.

Creation settings

Option Description
Creation method Select how the spacing of pin bars is

defined.

• By exact spacings creates fixed
spacing between each pin bar.

• By exact spacing value with
flexible first and last space
creates fixed, regular spaces
between the bars. Both the first
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Option Description
and last spaces adjust to even out
bar distribution.

Different spacing for horizontal
and vertical

Select whether to reinforce multiple
edges of a wall without changing the
settings.

Consider openings Select whether openings are taken
into account and how the bar groups
are created.

Edge bars tab
Use the Edge bars tab to define the edge bar dimensions and properties.

Edge bars

Option Description
Create rebars Select whether edge bars are created.
Standard rebar Define the grade and size of the first

bar group.
Create second group Select whether to create a second bar

group.

Define the grade and size of the
second bar group.

End conditions on edge

Define the shape and dimensions of the bar ends of edge bars. You can define
both sides separately.

Select a shape:
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End conditions on opening

Define the shape and dimensions of the bar ends of opening bars. You can
define both sides separately.

Select a shape:
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Number of bars and spacing

 Description
1 Define either the spacing value or the number of edge bars.

You can define the first and second bar group separately.
2 Define which bars are created.

The bars illustrated as dots are not created.
3 Define the edge distances for the groups.

Edge bar shape

Select the edge bar shape in relation to the input points.
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Consider openings

Select whether openings are taken into account.

Hook length

Define the length of the hook. You can define the hook length if you have
selected to create hooks in Consider openings.

Advanced tab
Use the Advanced tab to define the properties for edge bars, pin bars, and
rebar assemblies.

Edge bars and pin bars

Option Description
Comment Add content to the comment UDA.
Name Name that is shown in drawings and

reports.
Class Class number for the rebars.
Serie Prefix for the rebar position number.
Start number Start number for the rebar position

number.

Rebar groups

Select the number of edge bar groups. Define the grade and size properties on
the Edge bars tab.
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Extra rotation

Select how the pin bars are rotated.

Option Example
No

Pin bars are not rotated.
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Option Example
Around X

Pin bars are rotated around the x
axis.

Around Y

Pin bars are rotated around the y axis.

Create as rebar assembly

You can add the created reinforcement as a rebar assembly to the cast units
with a predefined assembly type, name, prefix, and start number.
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Option Description
Create as rebar assembly Select Yes to create all reinforcement

as one rebar assembly, and to include
it to the cast unit of the input part.

Rebar assembly type Select the rebar assembly type.

If you do not select the type, the
default value of the rebar assembly is
used.

Name, Prefix, Start number Define the name, prefix, and start
number.

If you do not define these, the default
values of the rebar assembly are
used.

Attach to Select which part the rebar assembly
will be attached to, the main part or
the neighbor part.

Define the neighbor part selection
criteria on the Configuration tab.

Configuration tab
Use the Configuration tab to define further settings for controlling border
rebar creation.

Configuration settings

Option Description
Bending radius Define the bending radius for pin bars and

edge bars.

• rebar_database.inp
The radius values defined in the rebar
catalog for main bars and tie/stirrup are
used.

The rebar_database.inp file is by
default located in the \profil folder.

• Relative to diameter

The radius is calculated by multiplying the
rebar diameter with the entered value.

• Bending radius

Define a fixed value for the bending
radius.
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Option Description
Detect outside geometry Define how part cuts are detected inside the

concrete part. Typically, this setting is needed
when the concrete part has recess cuts.

Use the Distance in material setting and the
options in the position in plane list to move
the plane that is used in searching for part
cuts.

The plane location is visualized in the model
if you set the Draw geometry with profiles
to Yes.

Draw geometry with profiles Select whether to create construction lines to
visualize the location of the part cut detection
plane.

You can change the location in Distance in
material.

Detect neg. volume If a recess cut is applied to the concrete part,
you can use Difference in thickness to
control whether the recess cut is taken into
account.

Draw axis Select whether to visualize the internal
coordinate system of the component.

If you select Yes, three small parts with a
round diameter are created at the
component axis, starting from the origin. This
can help to set up the component, and to
give more clearness in component
orientation.

Select No to remove the visualization.
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Option Description

Attach pins to

Attach edge bars to

Select whether the pins and edge bars are
attached to the main part or the neighbor
part.

Find neighbor Define how the neighbor part is identified, by
name or by class.

Rectangular area reinforcement (94)
Rectangular area reinforcement (94) creates reinforcement for a rectangular
area. Select the part where the reinforcement is placed and pick two points to
create the reinforcement. The part defines the thickness of the reinforced
area, and the two points define the geometry and the location of the
reinforced area.

Objects created

• Longitudinal main bars: corner bars (4), side bars

• Stirrups

• Intermediate links

• Top and bottom bars
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Use for

Situation Description
Concrete wall panel with
corner and side bars
inside the wall. Top and
bottom ends reinforced.
Intermediate links tie side
bars at every second
stirrup.

1 No rotation

2 Rotation in plane

3 Rotation out of plane

Selection order

1. Select the part.

2. Pick the first point.

3. Pick the second point.

Picking the points (2 and 3) determines the area where the reinforcement is
placed.

The reinforcement is created automatically when the second point is picked.

Concrete components 3489 Reinforcement



Part identification key

 Part
1 Corner bars
2 Side bars
3 Stirrups
4 Intermediate links

Concrete components 3490 Reinforcement



 Part
5 Top / Bottom bars

Picture tab
Use the Picture tab to select the reinforcement location and to set the
reinforcement direction.

Rectangular area

Select how the reinforcement is extended over the wall.

Option Description
Column reinforcement area

Area reinforcement with vertical rebars

Beam reinforcement area

Area reinforcement with horizontal rebars

Area reinforcement using input points that define
the direction for the creation plane

Define the width of the area.
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Rotation

Rectangular area reinforcement (94) is based on the geometry of a standard
panel. Using the component on slabs or beams in certain planes can affect the
geometry of the reinforcement. By using the In plane or Out of plane options,
you can adjust the reinforcement to the correct behavior.

Select the reinforcement direction in different part geometry and rotation
situations:

• No

• In plane

• Out of plane

Main bars tab
Use the Main bars tab to control the corner bar properties, the symmetry
options, rotation, and concrete cover thickness.

Basic corner bar properties

Define the grade, size and bending radius of the corner bars. The active
settings depend on the selected symmetry option.

Option Description
Grade Define the strength of the steel used in the

reinforcing bars.
Size Define the diameter of the reinforcing bar.
Bending radius Define the bending radius of the corner bars.

Define the concrete cover thickness.

Select whether the thickness is the same on all
sides.

Symmetry options

Select the symmetry option. Use the symmetrical conditions to define which of
the corner bars have the same grade, size, and bending radius properties. The
corner bars that have same properties are symmetrical.
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Rotation

In square reinforced parts, you can select the perpendicular sides if the sides
require different reinforcement. You can rotate all reinforcement by 90
degrees.

Additional corner bar properties

Option Description
Class Use the Class to group reinforcement.

For example, you can display reinforcement of
different classes in different colors.

Name Define a name for the main bars.

Tekla Structures uses the name in drawings and
reports.

Prefix Define a prefix for the part position number.
Start number Define a start number for the part position

number.

Hooks at top / bottom

Option Description
Type Select the hook angle.
Length Length of the hook.
Bending radius Bending radius of the hook.

Bar ends tab
Use the Bar ends tab to control the length of the vertical and horizontal
extensions for the corner bars and side bars, and the cranking.

Option Description
Bar creation Select whether the extensions of corner bars

and side bars are created symmetrically on
both sides of the rectangular reinforcement.

If you select Not symmetrical, you can enter
separate extension values for the opposite
sides of the reinforcement.
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Option Description
Vertical extension Define the length of the vertical extension for

corner bars and side bars outside the
reinforced part.

The active settings depend on Bar creation:
Symmetrical or Not symmetrical.

Horizontal extension Define the length of the horizontal extension
for corner bars and side bars.

The active settings depend on Bar creation:
Symmetrical or Not symmetrical.

Top corner bar direction

Bottom corner bar
direction

Select the direction of the corner bars.

Cranking You can create cranked reinforcing bars at the
top and at the bottom of the reinforcement.

To activate the cranking options, select

in the Top corner bar direction and
Bottom corner bar direction lists. Define the
dimensions for the cranked bars.

To successfully create the cranked reinforcing
bars, ensure that the bending radius is not too
large.
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Option Description
Edge dimensions Define the edge distance from the reinforced

part corner to the point where the cranking

starts .

Define the cranking separately for the corner
bars and the side bars.

Side bars tab
Use the Side bars tab to control the number of side bars, side bar spacing and
placing, symmetry options, and properties.

Number of side bars

Define the number and spacing of side bars. You can define two sets of side
bars on each side of the rectangular reinforcement.

You can define the side bars separately for each side.

The active settings depend on the selected symmetry option.

Placing of side bars

Select the horizontal and vertical placing for the side bars. Select whether the
bars are placed starting from the corner or at equal spaces.

Distance between corner bars and side bars.

Distance between side bars.
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Symmetry options

Select the symmetry option. Using the symmetrical conditions you can define
which side bars are symmetrical, and which side bars use the same properties.

Side bar properties

Option Description
Grade Define the strength of the steel used in the

reinforcing bars.
Size Define the diameter of the reinforcing bar.
Bending radius Define the bending radius of the side bars.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of
different classes in different colors.

Name Define a name for the side bars.

Tekla Structures uses the name in drawings and
reports.

Prefix Define a prefix for the part position number.
Start number Define a start number for the part position number.

Stirrups tab
Use the Stirrups tab to control the stirrup properties.

Stirrup dimensions
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 Description
1 Define the thickness of the concrete cover over the

stirrups at the top and the bottom of the rectangular
reinforcement. The default cover thickness is 50 mm.

Group 1 is the top stirrup group, 5 is the bottom stirrup
group. Group 3 is always created.

2 Define the spacing of stirrups in each stirrup group.
3 Define the number of stirrups in each stirrup group.
4 Select how the stirrups are distributed.
5 If you select the Distance list option, enter different

spacing values for the groups.
6 Define the cover thickness for each stirrup group.
7 Define the gaps between the stirrup groups.

Create stirrups

Select whether the stirrups are created as individual reinforcing bars, rebar
group, or spiral rebar group.

Rebar lapping at stirrup corners

Select how the rebars lap at the stirrup corners. The options are 135-degree
hooks or 90-degree hooks at the bar end, or overlapping U-shape stirrups.

You can define the overlap length for the U-shape stirrups.

Ignore cuts

If you have a recess or a hole in the reinforced part, you can select to ignore
the cuts at the top and the bottom of the part when the stirrups are created.
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Stirrup properties

Option Description
Grade Define the strength of the steel used in the reinforcing

bars.
Size Define the diameter of the reinforcing bar.
Name Define a name for the stirrups.

Tekla Structures uses the name in drawings and reports.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.

Prefix Define a prefix for the part position number.
Start number Define a start number for the part position number.
Overlap length Define the overlap length for the U-shape stirrups.

Intermediate links tab
Use the Intermediate links tab to control the intermediate links to tie all side
bars.

Intermediate links are created for each stirrup group.

NOTE Intermediate links are created between Side bars 1 or Side bars 2
that are symmetrical.

For Side bars 2 intermediate links are created only if no Side bars 1
are created.

Create as one group

Select whether all the stirrups are created as a single group.

Properties of intermediate links

Option Description
Grade Define the strength of the steel used in the reinforcing

bars.
Size Define the diameter of the reinforcing bar.
Name Define a name for the stirrups.

Tekla Structures uses the name in drawings and reports.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of different
classes in different colors.

Prefix Define a prefix for the part position number.
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Option Description
Start number Define a start number for the part position number.

Spacing of intermediate links

Option Description
Spacing is the same as stirrup spacing.

Spacing is double the stirrup spacing (intermediate
links at every second stirrup).

Same as above, but for alternate stirrups.

No intermediate links are created.

Intermediate link type

Select the type of the link.

Intermediate link pattern

Select whether intermediate links go in one direction or in a crossing pattern.
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Hook orientation

Select the hook orientation for both sides.

Closed stirrups as intermediate links

Select whether to use closed stirrups as intermediate links.

If you select closed stirrups, select the type of the bar lapping at the stirrup
corners.
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Zone without intermediate links

Define the zone length where intermediate links are not created. In this zone,
the stirrups tie the side bars. The distance is measured from the stirrup
corner.

If you have selected to use closed stirrups, you can define the distance from
the corner of the closed stirrups.

Top / Bottom tabs
Use the Top and Bottom tabs to control the top and bottom reinforcement
thickness of the concrete cover, number of bars, spacing and rotation.

Number and spacing of bars

Define the number and spacing of the top or bottom bars.

You can define the number of transverse bars in both cross directions.

Top / bottom reinforcement

 Description
1 Define the concrete cover thickness from the top / bottom

of the rectangular reinforcement.
2 Define the length of the rebar legs.
3 Define the concrete cover thickness from the sides of the

rectangular reinforcement.
4 Define the distance from the edge of the rectangular

reinforcement to the edge of the first rebar in the group.

Placing of top or bottom bars

Select the horizontal and vertical placing for the top or bottom bars. Select
whether the bars are placed starting from the corner or at equal spaces.
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Option Description
Distance between corner bars and side bars.

Distance between side bars.

Rotation

Select how to rotate the reinforcement at the top or bottom.

Option Description
No rotation.

Transverse bars are perpendicular to the longer side
of the rectangular reinforcement.
Rotation angle is 90 degrees.

Transverse bars are parallel to the longer side of the
rectangular reinforcement.

Top and bottom reinforcement properties

Option Description
Grade Define the strength of the steel used in the reinforcing

bars.
Size Define the diameter of the reinforcing bar.
Class Use the Class to group reinforcement.

For example, you can display reinforcement of
different classes in different colors.

Name Define a name for the top or bottom bars.

Tekla Structures uses the name in drawings and
reports.

Prefix Define a prefix for the part position number.
Start number Define a start number for the part position number.

Rebar assembly tab
Use the Rebar assembly tab to add the created reinforcement as a rebar
assembly to the cast units.
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Create as rebar assembly

You can add the created reinforcement as a rebar assembly to the cast units
with a predefined assembly type, name, prefix, and start number.

Option Description
Create as rebar assembly Select Yes to create all reinforcement

as one rebar assembly, and to include
it to the cast unit of the input part.

Rebar assembly type Select the rebar assembly type.

If you do not select the type, the
default value of the rebar assembly is
used.

Name, Profile, Start number Define the name, profile, and start
number.

If you do not define these, the default
values of the rebar assembly are
used.

Wall panel reinforcement / Double wall edge and opening
reinforcement
Wall panel reinforcement is used for detailing single precast wall panels. It
includes the reinforcement for the panel edges, around the openings, a mesh
for the whole panel and additional bars, for example, with a wall shoe
connection. Double wall edge and opening reinforcement is used for
detailing double walls by connecting two panels to each other. It includes the
reinforcement for the panel edges and around the openings.

Objects created

• Reinforcement

• Stirrups

• Mesh (for single panels)

Concrete components 3503 Reinforcement



Use for

Situation Description
Wall panel reinforcement with
openings and reinforcement in the
panel edges and around openings.

Double wall with opening and
reinforcement around the opening.

Ring reinforcement goes around both
shells.

All reinforcing bars that connect the
shells (U-bars and stirrups) are
attached to the shell that is selected
at creation.

Ring, beam and column reinforcing
bars are attached to the selected shell
that has been the input.

Selection order

1. Select the concrete part to reinforce.

The reinforcement is created automatically.

Picture tab
Use the Picture tab to select how the corners of a wall panel are reinforced.

Option Description
Corner
reinforcem
ent

Select how the corners are
reinforced and the bar is offset
on both sides of the corner.
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Option Description

Minimum
breaking
distance

Cuts smaller than this value are ignored and the reinforcing
bars are not cut.

Rebar
count

Creates a single layer of
reinforcement.

Creates two layers of
reinforcement.

Cover
thickness

Distance from the edge of the wall panel to the side of the
outermost bar.

Door
minimum
height

Cuts greater than this value are considered as door openings
and the additional reinforcing bars that are needed, for
example, in shoe connections are not created.

Minimum
bar length

Edge bars shorter than this value are not created.

Create
stirrups
priority

Select whether horizontal or vertical reinforcing bars are on
top.
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Option Description
Minimum
edge length

The edge stirrups are not created if the dimension is less than
the defined minimum value.

Create
reinforcem
ent in

Select whether the reinforcement is created in the selected part
or in the entire cast unit.

This setting is available in Wall panel reinforcement.
Longitudin
al
overhangs

Select Target to create variable overhang lengths. This creates
meshes as full length meshes minus the cover thickness.

Select Exact to create centered meshes with a fixed overhang
length.

Minimum
gap

Define the gap between the meshes in the corners.

Reinforcement tab
Use the Reinforcement tab to create the reinforcing bars around the wall
panel edges.

Option Description
Wall panel
edge
reinforcem
ent type

Creates normal
reinforcement.
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Option Description
Creates U reinforcement.

No reinforcement is created.

Creates stirrups.

Mesh Select whether a mesh is created for the whole panel.

If a mesh is created, you can define the mesh properties, or use
custom settings.

You can use the Mesh Bars component to create the mesh.

This option is available in Wall panel reinforcement.
Create
edge
reinforcem
ent

Select whether reinforcement is created at the edges.

If you select Yes, define the horizontal and vertical reinforcing
bar properties.

This option is available in Double wall edge and opening
reinforcement.
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Option Description
Horizontal
reinforcing
bars

Define the horizontal reinforcing bar properties for the wall
panel edges.

Note that horizontal bars have three sets of properties,
depending on the length of the bar.

For example, if the length of the main bar is less than 3000, it
uses the options on the left, if in between 3000 and 6000, the
middle options and if greater than 6000, the options on the
right.

Vertical
reinforcing
bars

Define the vertical reinforcing bar properties for the wall panel
edges.

Note that vertical bars have two sets of properties, depending
on the length of the bar.

U
Reinforcem
ent

Select whether to create U rebars and stirrups as a rebar group,
or as bent meshes. The bent meshes are always created in the
outer layer of the reinforcement.

Define the U reinforcing bar properties.

Each side of the wall panel has a separate set of U reinforcing
bar properties.

Opening tab
Use the Opening tab to create the reinforcing bars around the wall panel
window and door openings.

Option Description
Opening
reinforcem
ent type

Can be set for all four opening edges.
Creates normal
reinforcement.
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Option Description
Creates U reinforcement.

No reinforcement is created.

Creates stirrups.

Horizontal
reinforcing
bars

Define the horizontal reinforcing bar properties.

Note that horizontal bars have separate sets of properties for
the top and the bottom bars.

Vertical
reinforcing
bars

Define the vertical reinforcing bar properties.

U
Reinforcem
ent

Select whether to create U rebars and stirrups as a rebar group,
or as bent meshes. The bent meshes are always created in the
outer layer of the reinforcement.

Define the U reinforcing bar properties.

Each side of the opening has a separate set of U reinforcing bar
properties.

Door tab
Use the Door tab to define the door reinforcement.

Option Description
Door
reinforcem
ent type

Can be set for all three edges.
Creates normal
reinforcement.
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Option Description
Creates U reinforcement.

No reinforcement is created.

Creates stirrups.

Horizontal
reinforcing
bars

Define the horizontal reinforcing bar properties.

Vertical
reinforcing
bars

Define the vertical reinforcing bar properties.

U
Reinforcem
ent

Select whether to create U rebars and stirrups as a rebar group,
or as bent meshes. The bent meshes are always created in the
outer layer of the reinforcement.

Define the U reinforcing bar properties.

Each side of the door has a separate set of U reinforcing bar
properties.

Notch tab
Use the Notch tab to define the notch reinforcement.

Option Description
Notch
reinforcem
ent type

Can be set for two edges.
Creates normal
reinforcement.

Concrete components 3510 Reinforcement



Option Description
Creates U reinforcement.

No reinforcement is created.

Creates stirrups.

Horizontal
reinforcing
bars

Define the horizontal reinforcing bar properties.

Vertical
reinforcing
bars

Define the vertical reinforcing bar properties.

U
Reinforcem
ent

Select whether to create U rebars and stirrups as a rebar group,
or as bent meshes.The bent meshes are always created in the
outer layer of the reinforcement.

Define the U reinforcing bar properties.

Each side of the notch has a separate set of U reinforcing bar
properties.

Diagonals tab
Use the Diagonals tab to create diagonal reinforcing bars at the corners of the
openings.

Option Description
Create diagonals Select whether diagonal reinforcing bars are created

or not.
Diagonals count Number of diagonal reinforcing bars.
Size Select the diameter of a bar.
Grade Define the strength of the steel used in the bars.
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Option Description
Bending radius Define the bar bending radius.
L1 and L2 L1 + L2: Length of the diagonal reinforcing bars.
C Distance between the diagonal reinforcing bar and the

corner of the opening.

Column tab
Use the Column tab to a create column reinforcement.

Option Description
Column
reinforcem
ent

Column reinforcement is as high as the
part.

Column reinforcement does not reach
higher than the top edge of opening.

Column reinforcement is approximately
the L value higher than opening edge.

Column reinforcement is approximately
the L value lower than the opening
edge.

Column
reinforcem
ent
properties

Select whether column reinforcing bars are created or not.

• Minimum column height H: cuts and openings smaller
than the minimum value are not taken into account in the
column creation.

• Maximum column width B: if the width between two
openings or cuts or edges is greater than the maximum
value, then the column reinforcement is not created.

• Column height offset L1: distance between the column
reinforcement end and the opening edge.

• Column height offset L2: same as L1 but for the bottom
part of column reinforcement.
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Option Description
Main
reinforcing
bars

Define the main reinforcing bar properties.

Note that main bars have three sets of properties, depending
on the width of the column.

Stirrup
type

Select the stirrup type.

Reinforcing
stirrups

Select whether to create rebar stirrups as a rebar group, or as
bent meshes. The bent meshes are always created in the outer
layer of the reinforcement.

Define the stirrup properties.

Note that stirrups have three sets of properties, depending on
the width of the column.

Beam window top / Beam window bottom tab
Use the Beam window top and Beam window bottom tabs to create a beam
reinforcement on top of the opening and below the opening.

Beam window top Beam window bottom

Option Description
Beam
reinforcement
properties

Select whether beam reinforcing bars are created or
not.

• Maximum beam height Hmax: distance from the
edge of the wall to the edge of the opening. If the
height is greater than the maximum, then the
beam reinforcement is not created.

• Minimum beam length Lmin: distance between
the sides of the opening. If the width of the
opening is less than the minimum, then the beam
reinforcement is not created.
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Option Description
Top Define the beam top reinforcement properties.

Note that the reinforcing bars have two sets of
properties, depending on the length of the beam.

Bottom Define the beam bottom reinforcement properties.

Note that the reinforcing bars have two sets of
properties, depending on the length of the beam.

Stirrup type Select whether to create stirrups as a rebar group, or
as bent meshes. The bent meshes are always created
in the outer layer of the reinforcement.

Select the stirrup type.
Reinforcing stirrups Define the stirrup properties.

Note that stirrups have two sets of properties,
depending on the length of the beam.

Additional tab
Use the Additional tab to create additional horizontal and vertical reinforcing
bars.

Option Description
Additional
reinforcing bars

Select whether additional reinforcing bars are created
or not.

Define the additional reinforcing bar properties.

Attributes tab
Use the Attributes tab to control the reinforcing bar properties of the created
parts.

Option Description
Prefix Define a prefix for the part position number.
Start number Define a start number for the part position number.
Name Define a name for the part.

Tekla Structures uses the name in drawings and
reports.

Class Define the part class number.

Multiple Wire Size Mesh
Multiple Wire Size Mesh creates reinforcement meshes with multiple
reinforcing bar sizes. The created reinforcement mesh is optimized for a mesh
welding machine. Multiple Wire Size Mesh can be used for slabs and wall
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panels. The slabs and wall panels can be of any polygonal shape with any
number of openings. The reinforcing bars in the mesh can be of different size,
and the spacings between the bars can vary.

Objects created

• Reinforcement meshes

Use for

Situation Description
Three zones of longitudinal
reinforcing bars

Before you start

Create a polygon slab or a wall panel with any number of openings. Enter zone
values to define the width of the area to be reinforced in both the longitudinal
and crossing directions. Each direction can be divided up to five zones.

Selection order

1. Select the main part (slab or wall panel).

The reinforcement mesh is created automatically.

Mesh Parameters tab
Use the Mesh Parameters tab to control the mesh creation and cover
thickness.

Option Description
Define the concrete cover thickness.

Create Rebars Define to which side of the slab or the wall
panel the reinforcing bars are created.

Longitudinal Direction Define whether the x or the y direction is
used as the longitudinal direction when the
reinforcing bars are created.

By default, the x direction is the longitudinal
direction.
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Longitudinal Wires/Crossing Wires tab
Use the Longitudinal Wires or the Crossing Wires tab to control the mesh
creation in the longitudinal or the crossing direction, and the reinforcement
zones.

Option Description
Wire sizes Define the sizes of the reinforcing bars used in

the pattern.

Separate the sizes with a space.
Min overhang Define the minimum length of the reinforcing

bar extension.
Max overhang Define the maximum length of the reinforcing

bar extension.
Min spacing Define the minimum space between the

reinforcing bars.

The value must be divisible by the grid size.

For example, if the Min spacing is 150, Max
spacing is 300 and the Grid size is 50, the
spacings are 150, 200, 250 and 300.

Max spacing Define the maximum space between the
reinforcing bars.

The value must be divisible by the grid size.

For example, if the Min spacing is 150, Max
spacing is 300 and the Grid size is 50, the
spacings are 150, 200, 250 and 300

Grid size Define the mesh grid size.

For example, if the Min spacing is 150, Max
spacing is 300 and the Grid size is 50, the
spacings are 150, 200, 250 and 300.

This value depends on the welding machine.
Min wire length Define the minimum reinforcing bar length.
Min number of welding
points

Define the minimum number of crossing
reinforcing bar intersections.

Pattern width to fulfill Define the width of the pattern that is filled
with the mesh.

This value is used when the zone width is
greater than the given value.

Zone width value type Define the width of the area to be reinforced as
a percentage of the whole slab or wall panel
width, or as the actual length.
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Option Description
Width, Real width, Mesh
area per length

Define the mesh width, real width and area per
length in each zone.

Load pattern from file Select the external text file where you have
defined the patterns for longitudinal and
crossing reinforcing bars.

If you use the external patterns file, Multiple
Wire Size Mesh tries to determine a pattern
with a suitable area per length value for every
zone and apply these values to the zones.

Attributes tab
Use the Attributes tab to control the reinforcement properties in the
longitudinal and in the crossing directions.

Option Description
Prefix Define a prefix for the part position number.
Start Number Define a starting number for the part position

number.
Grade Define the strength of the steel used in the

reinforcing bars.
Name Define a name for the longitudinal and the crossing

reinforcing bars.

Tekla Structures uses the name in drawings and
reports.

Class Use Class to group the longitudinal and the crossing
reinforcing bars.

For example, you can display the longitudinal and
the crossing reinforcing bars of different classes in
different colors.

Configuration file for reinforcing bar patterns
Use an external text file to define the patterns for longitudinal and crossing
reinforcing bars.

Every pattern starts from the Pattern line, followed by, for example, the
pattern name. Each Bar Size and Spacing pair is on a separate row. The Bar
Size and Spacing values are separated by a space.

The file has the following format:

< Pattern > < Name >
<Bar Size> <Spacing>
<Bar Size> <Spacing>
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……………………………
<Bar Size> <Spacing>

Examples

Pattern 1
10 200
10 200
8 100
8 300
10 400
Pattern 2
10 200
10 200
8 100
8 100

Embedded anchors (8)
Embedded anchors (8) creates one or more embeds in a concrete part.

Objects created

• Embeds

• Thickening parts

• Reinforcing bars

• Hangup bars

• Crane cables
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Use for

Situation Description
Two custom anchors.

Bolt anchors that are custom parts,
hangup bars and crane cables.
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Situation Description
Cast-in lifting anchors that are custom
parts.

Cast-in wire rope lifting hoops that
are custom parts.

Adjusting anchors are in the front
side. The component is applied two
times.

Selection order

1. Select a concrete part.

2. Pick one point to position the embed.

You can also select multiple points, depending on how the embeds are
divided.

3. Click the middle mouse button to create the embeds.
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Part identification key

 Part
1 Concrete part (wall, column, beam, slab)
2 Point

You can select multiple points.

Input tab
Use the Input tab to control the custom parts used for the embeds, the input
points for placing the embeds and the component direction properties.

Input point sequence

Select the distribution method for the embeds. You can also adjust the
placement of embeds on the Input tab.

Option Description
Select a concrete part and pick one
position point for the anchor.
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Option Description
Select a concrete part and pick multiple
position points for the anchors.

Select a concrete part and pick three
points to define the plane.

Pick a point to place the embed.

Select a concrete part and pick three
points to define the plane.

Pick multiple points to place the
embeds.

Up direction

Define how the embeds are rotated.

This option is not available if the three-point-plane option is selected from the
Input points sequence list.

You can use the global directions +X,-X,+Y,-Y,+Z,-Z or the local directions +X,-
X,+Y,-Y,+Z,-Z to define a specific face of a typical cube-shaped (slab, wall, beam
of column) part.

Alternatively, you can use the Top in form face option. This option aligns the
embedded anchors with the top form face of the cast unit.
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-X local:

+X global:

Top in
form
face:
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Embed handling

Select whether the embed is handled as a detail or as a modeling tool.

In general, a detail uses the shape of the main part for positioning the
embeds, and a modeling tool uses the picked points for positioning the
embeds.

Embed offset

Define embed offsets in X- and/or Y-direction, from the picked position points.

Anchor type

Select the type of the anchors from the Anchor type dropdown list. The
options are:

• Anchor created by top part and bottom part

• Component part

• Component detail

• Surface treatment

• Component part and component detail

• Component part and top and bottom part

• Component detail and top and bottom part

Custom part

Option Description
Partname component 1. Select a custom part from the Applications &

components catalog to be used as embed.

2. Select the configuration file.
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Option Description
3. Select whether the custom parts must be used

for the embeds.

• If set to Do not connect, define the embeds’
shape on the Input tab.

• Use the other options to connect the custom
part to the main part as welded, added
material, add to cast unit, or add as sub-
assembly.

4. Select how the embeds are rotated. The default
direction is 2 point +x.

5. Select how the embeds are rotated around a
position point.

6. Check the top in form face in direction to adapt
the direction of the custom part.

Detailname
component

1. Select a custom detail from the Applications &
components catalog to be used as embed.

2. Select the configuration file.
Surface treatment 1. Define the thickness, width, and height of the

surface treatment.

2. Enter the name, color, and subtype.

Concrete components 3525 Reinforcement



Custom part positioning examples
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Placement tab
Use the Placement tab to control the placing of the embeds, crane cable
angles and safety factor properties and to select the lifting anchors.

You can define the input point sequence, lift system and embed dimensions
both in reference line and cross section direction.

Input points sequence

Select the distribution method of the embeds.

Use the a and b boxes on the right to enter the values.

Option Description
Embed is placed on a selected
position point.

Embed is placed on a center of gravity
(COG) point in the part length
direction.

Multiple embeds.

Define dimensions a and b.

Reference = COG

Define dimensions a and b.

Reference = COG

If embeds are likely to be placed
outside the part, then value d is used.
Define dimensions a and b as
percentages of the part length.

Reference = COG

Define dimension a as a percentage
of the part length.

Reference = COG

Define dimension a.

The right embed is calculated from
COG.

Define dimension a as a percentage
of the total part length.

Reference = COG
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Option Description
Embed is placed in the middle of the
part.

Define dimensions a and b.

Reference = middle of the part

Define dimensions a and b as
percentages of the part length.

Reference = middle of the part

Define dimensions a and b.

The distances are from the embeds to
the part ends.

Define dimensions a and b as
percentages of the part length.

The distances are from the embeds to
the part ends.
Three embeds in a triangular plate.

Define the vertical distance a from
COG.

Three embeds in a triangular plate.

Define the vertical distance a from
COG as a percentage of the width b.

Lift system

Select the crane cable lifting system.

Dimensions

Option Description
a Define embed dimension a.
b Define embed dimension b.
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Option Description
c Define distance c.
d Define anchor distance from the part

edge.
h Define crane cable height.
α Define crane cable angle α.
β Define cable angle β.
Rounding Define the rounding value for anchor

distances.

Additional embeds

Define additional embeds. Use the boxes on the left and right to define
distances. You can enter multiple distances. Use a space to separate the
values.

Use the middle box to define the number of additional embeds.

Mirroring

• Define the COG (center of gravity) for the selected parts, all connected
parts, all connected parts without steel, an assembly, or assembly without
steel parts.

All connected parts and All connected parts without steel include parts
connected by bolts and welds.

Assembly and Assembly without steel parts include the parts in the
current assembly only.
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• Select whether embeds are mirrored.

Mirroring is useful for asymmetric custom part embeds. You can mirror
and flip both in the reference line direction and cross section direction, and
rotate anchors and horizontal bars based on the lifting direction.

• Select whether both anchors are created, or only left or right anchor.

Lift.dat configuration file

You can use a configuration file to calculate the lifting capacities of lifting
anchors.

Set Browse configuration file to Yes, and define the full path to the
configuration file. The default file is lift.dat, located in the profil folder.

The lift.dat configuration file contains a list of all custom lifting anchors
belonging to the default Tekla Structures installation. The anchors are sorted
based on fabricator and type, component name and lifting capacity. You can
add more custom components to the list in the configuration file. The file can
be opened in any text editor, for example Notepad.
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• Type

Groups where lifting anchors can be selected.

• Type client

Description of types.

• Name CuCoPa

Name of custom component part as listed in the Applications &
components catalog.

• Lift force (kg)

Lifting capacity in kilograms.

• Dir

Direction. Component direction during creation of custom component part.

• Attribute file

Link to the configuration file.
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The anchor type can be selected from the list. The first list option corresponds
to the first type (1) in the lift.dat configuration file.

The last list option is All types and use preference list. This option searches
from all groups. A preference can be defined in the Preference type list. Start
with the highest preference group and separate the groups with a space.

Several fabricators have lifting anchors with the same lifting capacity, but with
different anchor lengths. Use the order in the configuration file to define which
anchor is selected. First found anchor with correct capacity = 1, second found
anchor = 2, and so on.

NOTE If you have selected to use a custom part, ensure that the
corresponding custom parts are available in the model. Names of the
custom parts should not contain spaces, because they are not read
from the lift.dat configuration file.

Safety factor

Define the safety factor. The weight to be lifted up is multiplied with this factor
in the anchor calculation.
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Braced girder

Select to move the anchors to the closest braced girder in Move to closest
braced girder.

Enter the Maximum displacement and Placement offset of the anchors.

Define the Class and Name for the top bar in the braced girder. Select
whether to detect braced girders in the whole assembly.

Avoid reinforcement

Select whether all reinforcement types are detected in the main part and
define the placement offset to avoid collision with anchors.

Define the Class and Name for the reinforcement. Select whether to detect
reinforcement in the whole assembly.

Top placement tab
Use the Top placement tab to define the embed offsets and how the
information message box and crane cables are shown.

Offset

Define the embed offsets at both ends of the concrete part. An embed which
is positioned exactly in the middle of the concrete part stays in that position
and does not get an offset.

Show information message boxes

Define whether a message box containing the embed calculation results is
shown. The message box shows the weight to be lifted up, the real lift-up
weight including a safety factor, and the selected anchor.

The message box appears only if you have set Browse configuration file to
Yes on the Placement tab.
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Show crane cables

Define whether crane cables are shown. If set to Yes, crane cables are shown
as construction lines or profiles with the α angle, defined on the Placement
tab.

Thickening tab
Use the Thickening tab to define the thickening of the concrete layer. The
thickening is especially useful for sandwich walls where shells are thickened
near lifting anchors.
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In the example below, a thickening is added with an extra insulation layer.

Thickening options

Select the side where thickening is applied. You can also define the thickness.

Option Description
No thickening.

Right side thickening.

Thickness is defined from center of the embed.

Right side thickening.

Thickness is defined from side of the embed.
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Option Description
Right side thickening.

Thickness is defined from side of the shell.

Left side thickening.

Thickness is defined from center of the embed.

Left side thickening.

Thickness is defined from side of the embed.

Left side thickening.

Thickness is defined from side of the shell.

Thickening on both sides.

Thickness is defined from center of the embed.

Thickening on both sides.

Thickness is defined from side of the embed.

Thickening on both sides.

Thickness is defined from side of the shell.

Thickening width and height

Select the thickening part reference, and define the thickening width and
thickening height.
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Option Description
Width is defined from center of the embed.

Height is defined from the top side of concrete.

Width is defined from center of the embed.

Height is defined from the bottom side of concrete
shell.

Width is defined from the side of concrete shell.

Height is defined from the top side of concrete
shell.

Width is defined from the side of concrete shell.

Height is defined from the bottom side of embed.

Side view

Option to combine multiple thickening parts into one if the distance between
the thickenings is smaller than or equal to the defined value.
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Thickening part

Select how the thickening is connected to the shell. Define the thickening
properties.

Additional insulation

Select how to add insulation to thickening part.

Option Description
Insulation classes Define the class of the insulation which is used in

the concrete shell.

If the defined class number matches the class of
the insulation in the model, then the insulation will
be cut at the location of the thickening.

Foil classes Define the class of the insulation which is used in
the sandwich wall.

If the defined class number matches the class of
the insulation, then the insulation will be cut at the
location of the thickening

Create extra insulation Select whether an additional insulation layer is
created.
Define the thickness of the insulation.
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Option Description

Additional options for the insulation part

Option Description
Extra insulation
part

Select whether the insulation part is added, and how it is
added.

To Select the part to which the insulation part is added.

Picture tab
Use the Picture tab to control the embed dimensions, connection method and
rotation.

Embed dimensions

Define if the embed needs to be recessed. You can define the dimensions of
the recess, distance from the recess plane to the top of the embed and select
the shape of the cutout.

Select the shape of the cutout.

Option Example
Circle
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Option Example
Square

Half moon X

Half moon Y

As negative volume

Select whether cutout profiles are handled as empty cutouts or cutouts with a
formwork part.

Top part/Bottom part

Set the part class and rotation. Each option rotates the embed 90 degrees
counterclockwise. You can define also a fixed rotation angle.

Positioning

Select how to position the top and the bottom parts of the embed.
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Option Example
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Option Example

An example of an anchor that is positioned on top of the concrete part.
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Create top part

Select whether the top part of embed is created, and if set to Yes, select how
the part is connected to concrete part.

Create bottom part

Select whether the bottom part of embed is created, and if set to Yes, select
how the part is connected to the concrete part.

Top part tab
Use the Top part tab to define the top part of the embed.

Top part dimensions

Use the diameter and height boxes to define the shape of the top part of the
embed. You can define the main diameters of parts 1, 2, 3, 4 and 5 also on the
Parts tab.

Examples

Embed top part defined on the Top part tab, embed bottom part defined on
the Bottom part tab.
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Bottom part tab
Use the Bottom part tab to define the bottom part of the embed.

Bottom part dimensions

Use the diameter and height boxes to define the shape of the bottom part of
the embed. You can define the main diameters of parts 1, 2, 3, 4 and 5 also on
the Parts tab.
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Parts tab
Use the Parts tab to define the embed top and bottom part properties and the
formwork part properties.

Part properties

Both the top and the bottom part are build from multiple profiles. You can
define profiles for each section.
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Define the part properties for the top, bottom and formwork part. If the profile
properties are left empty, the lengths and diameters defined on the Top part
and Bottom part tabs are used.

Option Description
t, b, h Part thickness, width and height.
Pos_No Prefix and a start number for the part

position number.
Material Material grade.
Name Name for the part.
Comment Add a comment for the part.

You can define UDAs for the top and bottom parts.
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Reinforcing bar tab
Use the Reinforcing bar tab to define additional reinforcing bars for the
embeds.

You can define the reinforcing bar shape and hook properties, and the
reinforcing bar profile properties in two directions.

Example

Grade, Size

The Grade and Size options work together. Click the … button next to the Size
box to open the reinforcing bar catalog and to select a grade and a size for bar
A and bar B.

End conditions left/End conditions right

Select the shape of the reinforcing bar.

Bend lengths left/Bend lengths right, Bend radius

Define the bend length for the hooks and the bend radius.
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Rotation

Select how to rotate the reinforcing bars and define the rotation angle.

Dimensions

Define the reinforcing bar dimensions and the number of bars.
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Hangup bars tab
Use the Hangup bars tab to define additional reinforcing bars for the embeds.

You can define the reinforcing bar shape and hook properties, and the
reinforcing bar profile properties.

Example

Grade, Size

The Grade and Size options work together. Click the … button next to the Size
box to open the reinforcing bar catalog and to select a grade and a size.

End conditions left/End conditions right

Select the shape of the reinforcing bar.
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Bend lengths left/Bend lengths right, Bend radius

Define the bend length for the hooks and the bend radius.

Rotation

Select how to rotate the hangup reinforcing bars and define the rotation angle.
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Dimensions

Option Description Default
1 Select how to place the hangup

reinforcing bars.

Use the values a, b, c, d, e, f and
the angles alpha and beta to
define the dimensions of the
hangup reinforcing bars.

 

2 Define the number of hangup
reinforcing bars.

0

3 Define the cover thickness.  
4 Define the distance between

hangup reinforcing bars.
100 mm
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Horizontal bar tab
Use the Horizontal bar tab to define additional horizontal reinforcing bars for
the embeds.

You can define the reinforcing bar shape and hook properties, and the
reinforcing bar profile properties.

Example

Grade, Size

The Grade and Size options work together. Click the … button next to the Size
box to open the reinforcing bar catalog and to select a grade and a size.

End conditions left/End conditions right

Select the shape of the reinforcing bar.

Bend lengths left/Bend lengths right, Bend radius

Define the bend length for the hooks and the bend radius.

Rotation

Select how to rotate the horizontal reinforcing bars and define the rotation
angle.

Side view

You can create sloped horizontal reinforcing bars. Define the number of bars
and the distance between them. Use value d to define cover thickness for the
top side and value f to define the reinforcing bar length.
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Top view

Select a reinforcing bar shape.

Use values a, b, c, d, e, f and the angle α to define the dimensions of the
horizontal reinforcing bars.
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Special bar tab
Use the Special bar tab to define additional U-shaped reinforcing bars for the
embeds.

You can define the reinforcing bar shape and hook properties, and the
reinforcing bar profile properties in two directions.

Example

Grade, Size

The Grade and Size options work together. Click the … button next to the Size
box to open the reinforcing bar catalog and to select a grade and a size for bar
A and bar B.

End conditions left/End conditions right

Select the shape of the reinforcing bar.

Bend lengths left/Bend lengths right, Bend radius

Define the bend length for the hooks and the bend radius.

Rotation

Select how to rotate the U-shaped reinforcing bars and define the rotation
angle.

Shape

Select a reinforcing bar shape.
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Use the values a, b, c, d, e, f and the angles α to define the dimensions of the
U-shaped reinforcing bars.

Advanced tab
Use the Advanced tab to define UDAs and reinforcing bar properties for the
reinforcing bars, hangup bars, special bars and horizontal bars.

Reinforcing bar properties

Option Description
Comment Add a comment for the reinforcing bars.
Name Define a name that is shown in drawings and

reports.
Class Define the class number for the reinforcing

bars.
Serie Define a prefix for the bar position number.
Start number Define a start number for the bar position

number.
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Create as rebar assembly

You can add the created reinforcement as a rebar assembly to the cast units
with a predefined assembly type, name, prefix, and start number.

Option Description
Create as rebar assembly Select Yes to create all reinforcement

as one rebar assembly, and to include
it to the cast unit of the input part.

Add to existing rebar assembly • Do not add: New rebar is added
as a rebar assembly to the cast
unit.

• As single bars: Add all new rebars
directly into an existing rebar
assembly as rebars.

• As sub-assembly: Add all new
rebars to their own new rebar
assembly, which is then included
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Option Description
as a sub-assembly to the main
rebar assembly.

Rebar assembly type Select the rebar assembly type.

If you do not select the type, the
default value of the rebar assembly is
used.

Name, Profile, Start number Define the name, profile, and start
number.

If you do not define these, the default
values of the rebar assembly are
used.

Embed (1008)
Embed (1008) creates one or more embeds in concrete parts. You can create
multiple embeds to be used as lifting anchors with one insertion point.

Objects created

• Embeds

• Reinforcing bars

Use for

Situation Description
Embeds

Selection order

1. Select a concrete part.

2. Pick one point on the part face where you want to insert the embed.

The detail is created automatically when you pick the point.

Picture tab
Use the Picture tab to control the embed dimensions, connection method and
rotation.
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Embed dimensions

Define if the embed needs to be recessed. You can define the dimensions of
the recess, distance from the recess plane to the top of the embed, select the
shape of the cutout and whether the cutouts are handled as empty cutouts or
cutouts with a formwork part.

Option Example
Circle

Half moon X
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Option Example
Square

Half moon Y

Top part/Bottom part

Set the part class and rotation. Each option rotates the embed 90 degrees
counterclockwise. You can define also a fixed rotation angle.

How to connect top part to concrete element

Select whether the top part of the embed is created, and if set to Yes, select
how the part is connected to the concrete part.

How to connect bottom part

Select whether the bottom part of the embed is created, and if set to Yes,
select how the part is connected to the concrete part.
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Select a custom part from the Applications & components catalog

Select a custom part from the Applications & components catalog to be used
as embed. To use saved custom component properties, select the saved
properties file.

Use the Yes and subassembly option to add the embed as a subassembly to
the main part. The default direction is 2 point +x.

Top part tab
Use the Top part tab to define the top part of the embed.

Top part dimensions

Use the diameter and height boxes to define the shape of the top part of the
embed. You can define the main diameters of parts 1, 2, 3, 4 and 5 also on the
Parts tab.

Examples

Embed top part defined on the Top part tab, embed bottom part defined on
the Bottom part tab.

Bottom part tab
Use the Bottom part tab to define the bottom part of the embed.
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Bottom part dimensions

Use the diameter and height boxes to define the shape of the bottom part of
the embed. You can define the main diameters of parts 1, 2, 3, 4 and 5 also on
the Parts tab.

For examples, see Top part tab.

Parts tab
Use the Parts tab to define the embed top and bottom part profiles and the
formwork part properties.

Part properties

Both the top and the bottom part are build from multiple profiles. You can
define profiles for each section.

Define the part properties for the top, bottom and formwork part. If the profile
properties are left empty, the lengths and diameters defined on the Top Part
and Bottom Part tabs are used.

Option Description
t, b, h Define the part thickness, width and height.
Pos_No Define a prefix and a start number for the part

position number.
Material Define the material grade.
Name Define a name for the part.
Comment Add a comment for the part.

You can define UDAs for the top and bottom parts.
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Placement tab
Use the Placement tab to define the embed placing, positioning and embed
distribution.

Positioning

Select how to position the top and the bottom part of the embed.

Placing

Define the placing type of the embed. Depending on the component insertion
points, multiple embeds can be created.

Option Description
Embed is placed on a selected position point.
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Option Description
Embed is placed on a center of gravity (COG)
point in the part length direction.

Multiple embeds.

Define dimensions a and b.

Reference = COG

Define dimensions a and b as percentages of
the part length.

Reference = COG

Embed is placed in the middle of the part,
along the length of the concrete part.

Multiple embeds.

Define dimension a as a percentage of the
total part length.

Reference = COG
Embed is placed in the middle of the part.

Define dimensions a and b.

Reference = middle of the part

Define dimensions a and b as percentages of
the part length.

Reference = middle of the part

Define dimensions a and b.

The distances are from the embeds to the part
ends.

Define dimensions a and b as percentages of
the part length.

The distances are from the embeds to the part
ends.
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Dimensions

Define embed dimensions a and b.

Center of gravity

Define concrete part COG (center of gravity) for the embeds.

Number of extra anchors

The spacing distance between multiple embeds.

Reinforcing bar tab
Use the Reinforcing bar tab to define extra reinforcing bars for the embeds.

You can define the reinforcing bar shape properties, and the reinforcing bar
profile properties in two directions.

You can define the number, shape, dimension and covering thickness of the
reinforcing bars.

Advanced tab
Use the Advanced tab to define bar properties for reinforcing bars A and B.

Reinforcing bar properties

Option Description
Comment Add a comment for the reinforcing bars.
Name Define a name that is shown in drawings and reports.
Class Define the part class number for the reinforcing bars.
Serie Define a prefix for the part position number.
Start number Define a start number for the part position number.

Create as rebar assembly

You can add the created reinforcement as a rebar assembly to the cast units
with a predefined assembly type, name, prefix, and start number.
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Option Description
Create as rebar assembly Select Yes to create all reinforcement

as one rebar assembly, and to include
it to the cast unit of the input part.

Add to existing rebar assembly • Do not add: New rebar is added
as a rebar assembly to the cast
unit.

• As single bars: Add all new rebars
directly into an existing rebar
assembly as rebars.

• As sub-assembly: Add all new
rebars to their own new rebar
assembly, which is then included
as a sub-assembly to the main
rebar assembly.

Rebar assembly type Select the rebar assembly type.

If you do not select the type, the
default value of the rebar assembly is
used.

Name, Profile, Start number Define the name, profile, and start
number.

If you do not define these, the default
values of the rebar assembly are
used.

Bolts
Click the Bolts button to open the Bolts dialog box where you can define extra
embeds and embed offsets.

Embed (1008) uses only the Horizontal Dist. and Vertical Dist. options, the
other options are not taken into account.

Example

In the example below, the bolt placement uses fixed dimensions from part
edges, defined on the Placement tab. Extra embeds are defined in the Bolts
dialog box.
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Optionally, you can also use the Sec/first and Positioning options to define a
distance from the edge of the beam.
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General tab

Click the link below to find out more:

General tab

Analysis tab

Click the link below to find out more:

Analysis tab

Continuous Beam Reinforcement
You can reinforce a continuous beam using a macro called
ContinuousBeamReinforcement. The macro creates main top and bottom
bars, stirrups, fittings, and additional top and bottom bars using system
components. Longitudinal reinforcement (70) creates the main and
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additional top and bottom bars, Stirrup reinforcement (67) creates stirrups,
and Battering connection (13) creates fittings.

To reinforce a continuous beam:

1. Click the Applications & components button  in the side pane to
open the Applications & components catalog.

2. Click the arrow next to Applications to open the applications list.

3. Double-click ContinuousBeamReinforcement.

4. Select the beams and click Next.

5. Select the columns and click Next.

6. If needed, modify the reinforcement properties, and click Finish. 

The reinforcements are created.

Limitations

The beams must be aligned for the reinforcing to be successful.
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Example

Lifting
This section introduces components that can be used for lifting.

Click the links below to find out more:

• Lifting anchor (80) (page 3570)

Lifting anchor (80)
Lifting anchor (80) creates two lifting anchors (or anchor groups) for a
concrete part and places them symmetrically on either side of the part’s center
of gravity.
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 Description
1 30% of part length (default)
2 Center of gravity

Objects created

• Lifting anchors (2 or more)

• Recesses for anchors (optional)

Use for

Situation More information
Straight anchor with
straight legs

(Type A in the anchor
properties file, see
Anchor properties
from a file)

Straight anchor with L-
shaped legs

(Type D)
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Situation More information
Angle anchor with
straight legs

(Type B)

Angle anchor with L-
shaped legs

(Type C)

Custom components as
anchors

Anchors recessed into
the part.

Skew and/or rotated
anchors

Before you start

Create the concrete part.
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Selection order

1. Concrete part.

Picture tab
Use the Picture tab to define anchor properties, to use custom components
as anchors, to create recess and define recess dimensions.

Lifting anchor properties

The properties of lifting anchors are:

Option Description
Create anchors Select how the anchors are created.
Anchor dimensions The options are:

• Use dialog values

• Select from file, see Anchor
properties from file.

You need to enter different
dimensions for different anchor
types.

Distance from Set the anchor distribution from the
center of gravity or part end.

You can set the distance either by
length or by percentage of the length.
The distance between an anchor (or
anchor group) and the center of
gravity of the part. Default is 30% of
the part length.

The distance between an anchor (or
group) and the center line of the part.

Number of bars/spacings The number and spacing of anchors
in a group. If the spacing varies, enter
each value individually.

Custom See Custom component as lifting
anchor.
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Option Description
Component
Custom settings
Up direction

The option to define if the anchors
are recessed into the part.

The skew angle of anchors. Anchor
heads are skewed towards the part’s
center of gravity.

Rotate anchor The option to rotate anchors. The
options are:

• No: Anchors parallel to the part.

• Yes: Anchors perpendicular to the
part.

Grade Strength of the steel used in the
anchor.

Size Diameter of the anchor bar.
Name Name that is shown in drawings and

reports.
Prefix, Start number Prefix and start number for the part

position number.
Class Part class number.

Side

Select the side of the part where Tekla Structures creates the anchors:

Option Description
Front

Top

Default
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Option Description

Back

Below

Start end

Finish end

Recesses

Select one of the following options to define if the lifting anchors are recessed
into the concrete part:

Option Description
Anchors on the surface of the part.

Default

Anchors recessed into the part.

If you choose to recess the anchors into the part, use the following fields to
define the shape and dimensions of the recesses:
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Custom component as lifting anchor

To use custom components as lifting anchors:

1. In the Custom list box, select Yes.

2. Click the ... button next to the Component field to open the Select
component dialog box.

3. Browse for the custom component you want to use as lifting anchor.

The component you select must be a custom part and have two or three
input points.

The component should be created so that the first and the second input
points are on the concrete surface and along the longitudinal axis of the
concrete part.

TIP For more information on how to create custom parts that can be
used as lifting anchors, see Creating standard embeds for global
use.

4. Select the component and click OK.

5. To use saved custom component properties, select the saved properties
file in Custom settings.

6. If the anchor position is not correct, select another option in the Up
direction list box.

Rebar assembly tab
Use the Rebar assembly tab to add the created reinforcement as a rebar
assembly to the cast units.

Create as rebar assembly

You can add the created reinforcement as a rebar assembly to the cast units
with a predefined assembly type, name, prefix, and start number.

Option Description
Create as rebar assembly Select Yes to create all reinforcement

as one rebar assembly, and to include
it to the cast unit of the input part.
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Option Description
Add to existing rebar assembly • Do not add: New rebar is added

as a rebar assembly to the cast
unit.

• As single bars: Add all new rebars
directly into an existing rebar
assembly as rebars.

• As sub-assembly: Add all new
rebars to their own new rebar
assembly, which is then included
as a sub-assembly to the main
rebar assembly.

Rebar assembly type Select the rebar assembly type.

If you do not select the type, the
default value of the rebar assembly is
used.

Name, Profile, Start number Define the name, profile, and start
number.

If you do not define these, the default
values of the rebar assembly are
used.

Anchor properties from file

You can define lifting anchor properties by entering values in the dialog box, or
you can create a file containing the anchor properties you want to use. Use
any standard text editor to create the file and save it as LiftingAnchors.dat
in the model folder.

To use the anchor properties you define in a file:

1. In the Lifting anchor (80) dialog box, select Select from file from the
Anchor dimensions list box.

2. Click the ... button to browse for the file.

Example

Create a row in the file for each lifting anchor. Enter the following properties,
separated by spaces:

• Anchor capacity [kN], including safety and material factors

• Type [A, B, C, or D], see the Use for table.

• Grade [characters]

• Size [characters]

• Anchoring length 1 [mm]
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• Anchoring length 2 [mm]

• Protruding dimension of the anchor outside the part [mm]

• Penetrating dimension of the anchor inside the part [mm]

• Bending radius [mm]

• Hook length [mm] (0 = no hook)

• Angle of leg 1 [degrees]

• Angle of leg 2 [degrees]

Here is an example of a lifting anchor file (Tekla Structures ignores the
comments enclosed in /* */):

Tekla Structures will use the first anchor in the file that:

1. Has the shape and type you define using the graphic list boxes in the
Lifting anchor (80) dialog box.

2. Can carry the part’s weight with other identical anchors. The total number
of anchors is two times the number you specify in the Number of bars
field.
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4 Disclaimer

© 2023 Trimble Solutions Corporation and its licensors. All rights reserved.

This Software Manual has been developed for use with the referenced
Software. Use of the Software, and use of this Software Manual are governed
by a License Agreement. Among other provisions, the License Agreement sets
certain warranties for the Software and this Manual, disclaims other
warranties, limits recoverable damages, defines permitted uses of the
Software, and determines whether you are an authorized user of the Software.
All information set forth in this manual is provided with the warranty set forth
in the License Agreement. Please refer to the License Agreement for important
obligations and applicable limitations and restrictions on your rights. Trimble
does not guarantee that the text is free of technical inaccuracies or
typographical errors. Trimble reserves the right to make changes and
additions to this manual due to changes in the software or otherwise.

In addition, this Software Manual is protected by copyright law and by
international treaties. Unauthorized reproduction, display, modification, or
distribution of this Manual, or any portion of it, may result in severe civil and
criminal penalties, and will be prosecuted to the full extent permitted by law.

Tekla Structures, Tekla Model Sharing, Tekla PowerFab, Tekla Structural
Designer, Tekla Tedds, Tekla Civil, Tekla Campus, Tekla Downloads, Tekla User
Assistance, Tekla Discussion Forum, Tekla Warehouse and Tekla Developer
Center are either registered trademarks or trademarks of Trimble Solutions
Corporation in the European Union, the United States, and/or other countries.
More about Trimble Solutions trademarks: http://www.tekla.com/tekla-
trademarks. Trimble is a registered trademark or trademark of Trimble Inc. in
the European Union, in the United States and/or other countries. More about
Trimble trademarks: http://www.trimble.com/trademarks.aspx. Other product
and company names mentioned in this Manual are or may be trademarks of
their respective owners. By referring to a third-party product or brand, Trimble
does not intend to suggest an affiliation with or endorsement by such third
party and disclaims any such affiliation or endorsement, except where
otherwise expressly stated.

Portions of this software:

EPM toolkit © 1995-2006 Jotne EPM Technology a.s., Oslo, Norway. All rights
reserved.
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Portions of this software make use of Open CASCADE Technology software.
Open Cascade Express Mesh Copyright © 2019 OPEN CASCADE S.A.S. All rights
reserved.

PolyBoolean C++ Library © 2001-2012 Complex A5 Co. Ltd. All rights reserved.

FLY SDK - CAD SDK © 2012 VisualIntegrity™. All rights reserved.

This application incorporates Open Design Alliance software pursuant to a
license agreement with Open Design Alliance. Open Design Alliance Copyright
© 2002-2020 by Open Design Alliance. All rights reserved.

CADhatch.com © 2017. All rights reserved.

FlexNet Publisher © 2016 Flexera Software LLC. All rights reserved.

This product contains proprietary and confidential technology, information
and creative works owned by Flexera Software LLC and its licensors, if any. Any
use, copying, publication, distribution, display, modification, or transmission of
such technology in whole or in part in any form or by any means without the
prior express written permission of Flexera Software LLC is strictly prohibited.
Except where expressly provided by Flexera Software LLC in writing,
possession of this technology shall not be construed to confer any license or
rights under any Flexera Software LLC intellectual property rights, whether by
estoppel, implication, or otherwise.

To see the third party open source software licenses, go to Tekla Structures,
click File menu --> Help --> About Tekla Structures and then click the 3rd
party licenses option.

The elements of the software described in this Manual are protected by
several patents and possibly pending patent applications in the United States
and/or other countries. For more information go to page http://
www.tekla.com/tekla-patents.

Disclaimer 3580

http://www.tekla.com/tekla-patents
http://www.tekla.com/tekla-patents


Index

B
Bolted gusset brace (167)........................ 2655
bracing components

corner bracing connections...............2423
bracing elements

crushed tube in points (S48)..............2639
gusset tube in bolts (S49)...................2640
gusset tube in points (S47)................ 2638

bracing panels
create....................................................2646

built-up
beams...................................................2144
columns................................................2171
frames.................................................. 2183

C
cast-in-place.............................................. 3568
cast-in-situ................................................. 3568
CIP...............................................................3568
concrete components.............................. 2765
concrete detailing..................................... 2765
concrete stairs

about.................................................... 3215
connections

brace to tower leg............................... 2647
seating (concrete)................................2766

continuous beam
reinforcing............................................3568

convert
slabs......................................................3029
wall panels........................................... 3029

corbel connection (14)..............................2795
cross arms

create....................................................2645
crushed tube in points (S48)................... 2639
Crushed tube in points (S64)...................2637

F
floor layout................................................ 3029

G
gusset tube in bolts (S49).........................2640
gusset tube in points (S47)...................... 2638

L
Leg - 1 diagonal (178)............................... 2653
Leg - 2 and 3 diagonals (177) ..................2651

M
mesh bar by area......................................3319
mesh bars.................................................. 3319

P
parts

created by bracing components....... 2287
glossary................................................ 2287

points
create in tower (S43, S66)...................2666

R
reinforcement

for foundations................................... 3293
reinforcing

continuous beam................................ 3568

S
seating connections..................................2766

3581



steel components......................................... 34

T
Tower 1 diagonal (87)............................... 2648
Tower 2 diagonal (89)............................... 2650
tower bracing

modify.................................................. 2661
tower components

brace to brace connections............... 2654
brace to tower leg connections.........2647
create bracing panels......................... 2646
create cross arms................................2645
create legs............................................2643
create tower.........................................2642
modify bracing.................................... 2661

tower legs
create....................................................2643

tower
create....................................................2642

W
wall layout..................................................3029

3582


	Contents
	1 System components
	2  Steel components 
	2.1 Shear tab connections
	Shear plate (34)
	Picture tab
	Parts tab
	Parameters tab
	Bolts
	General tab
	Design tab
	Analysis tab
	Welds

	Welded shear plate (43)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Notch tab
	General tab
	Design tab
	Analysis tab
	Welds

	Shear tab plate connection (80)
	Picture tab
	Parts tab
	Parameters tab
	General tab
	Design tab
	Analysis tab
	Bolt properties
	Welds

	Shear plate (103)
	Picture tab
	Parts tab
	Notch tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Two sided shear plate (118)
	Picture tab
	Parts tab
	Notch tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Column with shear plate (131)
	Picture tab
	Plates tab
	Stiffeners tab
	Bolts tab
	Notch tab
	General tab
	Design tab
	Analysis tab
	Welds

	Bolted moment connection (134)
	Picture tab
	Shear plate tab
	Flange plate tab
	Stiffeners tab
	Shear bolts tab
	Flange bolts tab
	Doubler plate tab
	General tab
	Design type tab
	Analysis tab
	Welds

	Shear plate simple (146)
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Beam cut tab
	Angle box tab
	BoxPBolts tab
	BoxSBolts tab
	General tab
	Design type tab
	Analysis tab
	Welds

	Welded to top flange (147)
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Beam cut tab
	General tab
	Design tab
	Analysis tab
	Welds

	Welded to top flange S (149)
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Beam cut tab
	General tab
	Design tab
	Analysis tab
	Welds

	Moment connection (181)
	Picture tab
	Plates tab
	Stiffeners tab
	Notch tab
	Bolts tab
	Beam cut tab
	Doubler plates tab
	General tab
	Design type tab
	Analysis tab
	Welds

	Full depth (184)
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Beam cut tab
	General tab
	Design tab
	Analysis tab
	Welds tab

	Full depth S (185)
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Beam cut tab
	General tab
	Design tab
	Analysis tab
	Welds

	JP Full depth special (185)
	Picture tab
	Plates tab
	Stiffeners tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Shear plate tube column (189)
	Picture tab
	Plates tab
	1stSecBolts and 2ndSecBolts tabs
	General tab
	Design tab
	Analysis tab
	Welds


	2.2 Clip angle connections
	Angle cleat (3)
	Picture tab
	Parts tab
	Parameters tab
	Notch tab
	General tab
	Design tab
	Analysis tab
	Bolts
	Welds

	Two sided angle cleat (25)
	Picture tab
	Parts tab
	Parameters tab
	Notch tab
	Bolts
	General tab
	Analysis tab
	Design tab

	Clip angle (116)
	Picture tab
	Parts tab
	Notch tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Two sided clip angle (117)
	Picture tab
	Parts tab
	Notch tab
	Bolts tab
	General tab
	Design tab
	Analysis tab

	Clip angle (141)
	Picture tab
	Parts tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Plate washers tab
	Beam cut tab
	Angle box tab
	BoxPBolts tab
	BoxSBolts tab
	General tab
	Design type tab
	Analysis tab
	Welds

	Two sided clip angle (143)
	Picture tab
	Parts tab
	Haunch tab
	Notch tab
	Bolts tab
	Bolt settings tab
	Plate washers tab
	Angle box tab
	BoxPBolts tab
	BoxSBolts tab
	Beam cut tab
	General tab
	Design type tab
	Analysis tab
	Welds


	2.3 Bent plate connections
	Bent plate (151)
	Picture tab
	Parts tab
	Top notch / Btm notch tab
	Flange cuts tab
	Stiffeners tab
	Bolts tab
	Beam cut tab
	General tab
	Design type tab
	Analysis tab
	Welds

	Bent plate (190)
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Beam cut tab
	General tab
	Design tab
	Analysis tab
	Welds


	2.4 End plate connections and details
	Seating cap plate (2)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Bearing plate (7)
	Picture tab
	Parts tab
	Parameters tab
	Console Blt tab
	L-profile Blt tab
	General tab
	Design tab
	Analysis tab
	Welds

	Column - 2 beams (14)
	Picture tab
	Bolts 1 - 2 tab
	Bolts 3/Bolts 4 tabs
	Holes - Plate 1/Holes - Plate 2/Holes - Plates 3 and 4 tabs
	General tab
	Analysis tab
	Welds

	Joining plates (14)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Holes tab
	General tab
	Design tab
	Analysis tab
	Welds
	Dstv connection properties

	Two-sided end plate (24)
	Picture tab
	Parts tab
	Parameters tab
	Notch tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Wooden purlin shoe (15)
	Picture tab
	Parts tab
	Holes tab
	Extra weld parameters tab
	General tab
	Analysis tab
	Welds

	Stiffened end plate (27)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Holes - end plate tab
	Holes - front plate tab
	General tab
	Design tab
	Analysis tab
	Welds
	Dstv connection properties

	Stub (28)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Rods tab
	General tab
	Design tab
	Analysis tab
	Welds

	End plate (29)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Notch tab
	General tab
	Design tab
	Analysis tab
	Welds

	Seating cap (37)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Holes tab
	General tab
	Design tab
	Analysis tab
	Welds

	Haunch (40)
	Picture tab
	Parameters tab
	Haunch tab
	Extra plates
	Chamfers tab
	Holes tab
	Bolts tab
	Open beam tab
	General tab
	Design tab
	Analysis tab
	Welds

	Cranked beam (41)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Chamfers tab
	Holes tab
	General tab
	Design tab
	Analysis tab
	Welds

	Hql connection (46)
	Picture tab
	Parts tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Plate with nail (47)
	Picture tab
	Parts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Spacer plate (48)
	Picture tab
	Parts tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Double plate (50)
	Picture tab
	Parts tab
	Parameters tab
	Flange Blt tab
	Web bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Fit haunch (51)
	Picture tab
	Parts tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Partial stiff end plate (65)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Holes - end plate tab
	Holes - front plate tab
	General tab
	Design tab
	Analysis tab
	Welds
	Dstv connection properties

	End plate (101)
	Picture tab
	End plate tab
	Notch tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	End plate with compensating flange plates (111)
	Picture tab
	Parts tab
	Notch tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Two-sided end plate with compensating flange plates (112)
	Picture tab
	Parts tab
	Notch tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Two sided end plate (115)
	Picture tab
	End plates tab
	Notch tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Stub connection (119)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	Two sided end plate (142)
	Picture tab
	Plates 1 tab
	Plates 2 tab
	Haunch tab
	Notch tab
	Bolts tab
	Holes tab
	General tab
	Design type tab
	Analysis tab
	Welds

	End plate (144)
	Example: Add an end plate using End plate (144)
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Holes tab
	Angle box tab
	General tab
	Design type tab
	Analysis tab
	Welds

	End plate detail (1002)
	Picture tab
	Parts tab
	General tab
	Analysis tab
	Welds

	Angle cut (1057)
	Picture tab
	Parameters tab
	General tab
	Analysis tab

	Cast-in plate (1069)
	Picture tab
	Parts tab
	Studs/Anchors tab
	Nail holes tab
	Bolts tab
	General tab
	Design type tab
	Analysis tab
	Welds


	2.5 Splice connections
	Column splice (42)
	Picture tab
	Part tab
	Parameters tab
	Web bolts tab
	Flange bolts tab
	General tab
	Design tab
	Analysis tab

	Box girder splice (45)
	Picture tab
	Parts tab
	Flange blt tab
	Web bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Diagonal splice (53)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Design tab
	Analysis tab

	Splice connection (77)
	Picture tab
	Parts tab
	Parameters tab
	Web bolts tab
	Top flange bolts / Bottom flange bolts tab
	Weld prep tab
	Deck plates tab
	General tab
	Design tab
	Analysis tab
	Welds

	Column splice (132)
	Picture tab
	Parts tab
	Parameters tab
	Flange blt tab
	Web bolts tab
	General tab
	Design tab
	Analysis tab
	Welds


	2.6 Joist connections
	Joist to beam, type 1 (160)
	Picture tab
	Stabilizer tab
	Bearing plate tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Joist to column, type 1 (161)
	Picture tab
	Bolts tab
	Plate tab
	Bearing plate tab
	Stabilizer tab
	Stabilizer angle bolts tab
	Stabilizer plate bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	2-Sided joist to column (162)
	Picture tab
	Bolts tab
	Cap plate tab
	Moment plate tab
	Stabilizer tab
	Stabilizer angle bolts tab
	Stabilizer plate bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Joist to column, type 2 (163)
	Picture tab
	Seat tab
	Angle seat stiffeners tab
	Bearing plate tab
	Stabilizer tab
	Seat bolts tab
	Stabilizer angle bolts tab
	Stabilizer plate bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Joist to beam and column (164)
	Picture tab
	Bearing plate tab
	Bolts tab
	Stabilizer tab
	Stabilizer angle bolts tab
	Stabilizer plate bolts tab
	General tab
	Design tab
	Analysis tab
	Welds


	2.7 Welded connections
	Cross (4)
	Picture tab
	Parts tab
	Parameters tab
	General tab
	Design tab
	Analysis tab
	Welds

	Offshore (9)
	Picture 1 tab
	Picture 2 tab
	Weld description tab
	General tab
	Analysis tab
	Welds

	Fitting (13)
	Picture tab
	Parts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Round tube (23)
	Picture tab
	Parameters tab
	General tab
	Design tab
	Analysis tab
	Welds

	Welded column (31)
	Picture tab
	Parts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Welded tee (32)
	Picture tab
	Parts tab
	Parameters tab
	Primary bolts tab
	Secondary bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Weld preparation (44)
	Picture tab
	Parameters tab
	General tab
	Design tab
	Analysis tab
	Welds

	New notch (49)
	Picture tab
	Parts tab
	Parameters tab
	General tab
	Design tab
	Analysis tab
	Welds

	Welded beam to beam (123)
	Picture tab
	Parameters tab
	Define weld preparations
	Chamfers tab
	General tab
	Design tab
	Analysis tab
	Welds

	Welded column with stiffeners (128)
	Picture tab
	Stiffeners tab
	Beam cut tab
	Notch tab
	Doubler plate tab
	General tab
	Design tab
	Analysis tab
	Welds

	Beam prep (183)
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	Notch tab
	Beam cut tab
	Doubler plate tab
	General tab
	Design tab
	Analysis tab
	Welds

	Offshore (194)
	Picture tab
	Parts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Doubler plate (1022)
	Picture tab
	Parts tab
	Doubler plate tab
	General tab
	Analysis tab
	Welds

	Cap plate detail
	Picture tab
	Parts tab
	General tab
	Welds

	Pipe doubler plate
	Picture tab
	Parts tab
	General tab
	Analysis tab
	Welds

	Ring plate
	Picture tab
	Parts tab
	Chamfers tab
	General tab
	Welds


	2.8 Seated connections
	Stiffener seating (12)
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	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Seating with nail (36)
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	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Design tab
	Analysis tab

	Seating (39)
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	Parts tab
	Parameters tab
	Bolts tab
	Holes tab
	General tab
	Design tab
	Analysis tab
	Welds

	U.S. Seat connection (72)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Stabilizer tab
	Stabilizer bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	U.S. Seat connection 2 (73)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Stabilizer tab
	Stabilizer bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	U.S. Seat connection 3 (74)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Notch tab
	General tab
	Design tab
	Analysis tab
	Welds

	U.S. Seat connection 4 (75)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Angle profile box (170)
	Picture tab
	Parts tab
	Parameters tab
	Pbolts tab
	Sbolts tab
	SBoltsDown tab
	Notch tab
	Stiffeners tab
	General tab
	Design tab
	Analysis tab
	Welds


	2.9 Opening connections
	Create hole around part (92)
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	Parameters tab
	General tab
	Design tab
	Analysis tab

	Rebar hole
	Parameters tab
	Advanced tab

	Notch (76)
	Notch tab
	Parameters tab
	General tab
	Analysis tab


	2.10 Bracing
	Tensioner (7)
	Plate tab
	Fork tab
	Parameters tab
	Bolts tab
	Tensioner tab
	Extra tensioners tab
	UDA tab
	General tab
	Analysis tab
	Welds

	Tensioner brace (13)
	Picture tab
	Levels tab
	Parts tab
	Joints tab
	Joints dir tab
	General tab
	Analysis tab

	Tensioner brace and compression bar (13)
	Picture tab
	Parts tab
	Compression bar tab
	Joints tab
	Joints dir tab
	UDA tab

	Tensioner central gusset (18)
	Picture tab
	Fork tab
	Parameters tab
	Bolts tab
	Tensioner T tab
	Extra tensioners
	UDA tab
	General tab
	Analysis tab
	Welds

	Turnbuckle bracing (S3)
	Picture tab
	Turnbuckle tab
	Connection tab
	Bolts tab

	Muffe (26)
	Picture tab
	Parts tab
	Parameters tab
	General tab
	Analysis tab
	Design tab

	Traction bar (52)
	Picture tab
	Parts tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Turnbuckle connection (126)
	Picture tab
	Parts tab
	Parameters tab
	General tab
	Design tab
	Analysis tab

	Generation of purlins (50)
	Picture tab
	Parts tab
	Joints tab
	UDA tab

	Gusset+ T
	Picture tab
	Gusset tab
	Brace connection tab
	Bolts tab
	Main part welds / Cut T welds tabs
	General tab
	Design tab
	Analysis tab


	2.11 Tubes
	Tube splice (6)
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	Parts tab
	Bolts tab
	End plates tab
	General tab
	Design tab
	Analysis tab
	Welds

	Tube gusset (20)
	Picture tab
	Gusset tab
	Brace conn tab
	Stiffeners tab
	Gusset conn tab
	Brace bolts 1/Brace bolts 2/Brace bolts 3 tab
	Cross plates tab
	General tab
	Design tab
	Analysis tab
	Welds

	Squeezed tube bolted (102)
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	Stiffeners tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	Squeezed tube (103)
	Picture tab
	Parts tab
	Parameters tab
	General tab
	Analysis tab
	Welds

	Tube-Chamfer
	Parameters tab
	Welding tab
	General tab
	Analysis tab

	Tube-CrossingSaddle
	Parameters tab
	Welding tab
	General tab
	Analysis tab

	Tube-MitreSaddle+Hole
	Parameters tab
	Weldings tab
	General tab
	Analysis tab

	Tube-Saddle+Hole
	Parameters tab
	Welding tab
	General tab
	Analysis tab

	Tube-SlottedHole
	Parameters tab
	Weldings tab
	General tab
	Analysis tab


	2.12 Platework
	Rectangle to circle (17)
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	Parts tab
	Parameters tab
	Welds

	Triangles generation (19)
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	Parameters tab
	Plate tab
	Profile tab
	Chamfers tab

	Unfold surface (21)
	Plates tab
	Big plate tab
	Parameters tab
	UDA tab
	Surrounding rectangle tab


	2.13 Frames
	Truss (S78)
	Picture tab
	Parts tab
	Parameters tab
	Cap plate tab

	Opening Frame
	Picture tab
	Parts tab
	Connections tab
	Welds tab


	2.14 Stairs
	Rail connection (70)
	Picture tab
	Parts tab
	Parameters tab
	Pbolts tab
	Sbolts tab
	Notch tab
	General tab
	Design tab
	Analysis tab
	Welds

	Stairs (S71)
	Picture tab
	Stair set up tab
	Steps tab
	Bracket tab
	Welds

	Wooden steps pan (S72)
	Picture tab
	Stair setup tab
	Bolts tab
	Wooden pan tab
	Welds

	Polybeam pan (S73)
	Picture tab
	Stair setup tab
	Bolts tab
	Polybeam pan tab
	Welds

	Handrail 1 (74)
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	Parts tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	Z pan (S74)
	Picture tab
	Stair setup tab
	Z pan tab
	Horizontal bracket tab
	Vertical bracket tab
	Bent plate bracket tab
	Welds

	Kickplate (S75)
	Picture tab
	Parameters tab
	Welds

	Stanchions (S76)
	Picture tab
	Parts tab
	Parameters tab

	Railings (S77)
	Picture tab
	Parameters tab
	Rails tab
	Middle Rails tab
	Vertical Rails tab
	Panels tab
	Bends tab
	Welds

	Stairs (S82)
	Picture tab
	Parts tab
	Parameters tab
	Welds

	Stanchion side plate (83)
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	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Multiple beam railing (S84)
	Picture tab
	Parts tab
	Parameters tab
	Welds

	Stringer to channel (127)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	Connection plate (1026)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Analysis tab

	Stair base detail (1038)
	Picture tab
	Parts tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	Stair base detail (1039)
	Picture tab
	Parts tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	Stair base detail (1043)
	Picture tab
	Parts tab
	Parameters tab
	PBolts tab
	SBolts tab
	General tab
	Analysis tab
	Welds

	Ladder (S35)
	Picture tab
	Parts tab
	Parameters tab

	Cage ladder (S60)
	Picture tab
	Parts tab
	Parameters tab
	Cage tab
	Bolts tab
	Supports tab
	Welds

	Ship Ladder
	Picture tab
	Parts tab
	Platform tab
	Steps tab
	Rails tab
	Detail B tab
	Welds tab

	Wall Rails
	General tab
	Endings tab
	Elbows tab
	Brackets tab
	Bolts tab
	Parts tab
	Welds tab


	2.15  Stiffeners and gussets 
	Beam with stiffener (129)
	Picture tab
	Plates tab
	Stiffeners tab
	Bolts tab
	Notch tab
	Haunch tab
	General tab
	Design tab
	Analysis tab
	Welds

	Gusset stiffeners (171)
	Picture tab
	Parts tab
	Chamfer tab
	General tab
	Analysis tab
	Welds

	Column with stiffeners W (182)
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch
	Notch tab
	Bolts tab
	Beam cut tab
	Doubler plate
	General tab
	Design type tab
	Analysis tab
	Welds

	Column with stiffeners (186)
	Example: Add a beam-to-column connection using the Column with stiffeners (186) connection
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Doubler plate tab
	General tab
	Design tab
	Analysis tab
	Welds

	Column with stiffeners S (187)
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Doubler plate tab
	General tab
	Design tab
	Analysis tab
	Welds

	Column with stiffeners (188)
	Picture tab
	Plates tab
	Stiffeners tab
	Haunch tab
	Notch tab
	Bolts tab
	Beam cut tab
	Doubler plate tab
	General tab
	Design tab
	Analysis tab
	Welds

	Stiffeners (1003)
	Picture tab
	Parts tab
	Parameters tab
	General tab
	Design tab
	Analysis tab
	Welds

	Column stiffeners (1030)
	Picture tab
	Parts tab
	Parameters tab
	General tab
	Analysis tab
	Welds

	Stiffeners (1041)
	Picture tab
	Parts tab
	General tab
	Analysis tab
	Welds

	Multiple stiffeners (1064)
	Picture tab
	Parts tab
	Parameters tab
	Stiffeners tab
	General tab
	Design type tab
	Analysis tab
	Welds

	Standard gusset (1065)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Analysis tab


	2.16 Base plates
	U.S. Base plate connection (71)
	Picture tab
	Parts tab
	Parameters tab
	Stiffeners tab
	Beam Stiff tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Round joining plates (124)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Base plate (1004)
	Example: Add a base plate and anchor rods using Base plate (1004)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Anchor rods tab
	Extra plates tab
	General tab
	Analysis tab
	Welds

	Stiffened base plate (1014)
	Picture tab
	Parts tab
	Parameters tab
	Bolts
	Stiffeners
	Anchor rods tab
	Extra plates tab
	General tab
	Analysis tab
	Welds

	Web stiffened base plate (1016)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Stiffeners tab
	Anchor rods tab
	Extra plates tab
	General tab
	Analysis tab
	Welds

	Simple base plate 2 (1031)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Stiffeners tab
	Grouting holes tab
	General tab
	Analysis tab
	Welds

	Base plate (1042)
	Picture tab
	Parts tab
	Parameters tab
	Anchor rods tab
	Extra plates tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	U.S. Bearing plate (1044)
	Picture tab
	Plates tab
	Stiffeners tab
	Bolts tab
	Anchor rods tab
	General tab
	Design type tab
	Analysis tab
	Welds

	U.S. Base plate (1047)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Stiffeners tab
	Anchor rods tab
	Extra plates tab
	General tab
	Analysis tab
	Welds

	Circular base plates (1052)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Anchor rods tab
	Extra plates tab
	General tab
	Analysis tab
	Welds

	Base plate (1053)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	Box column base plate (1066)
	Picture tab
	Parts tab
	Parameters tabs
	Flow holes tab
	Bolts tab
	Height of ribs tab
	General tab
	Analysis tab
	Welds tab


	2.17 
Built-up Components

	Beams
	Box girder (S13)
	Picture tab
	Parts tab
	Parameters tab
	Welds

	Cross profile (S32)
	Picture tab
	Parts tab
	Parameters tab
	Welds

	Cross plate profile (S33)
	Picture tab
	Parts tab
	Parameters tab
	Welds

	Tapered beam (S98)
	Picture tab
	Parts tab
	Parameters tab
	Welds

	Tapered beam 2 (S45)
	Picture tab
	Parts tab
	Welds

	PEB Tapered section (S94)
	Picture tab
	Parts tab
	Welds


	Columns
	Tapered column (S99)
	Picture tab
	Parts tab
	Parameters tab
	Welds

	Tapered column 2 (S44)
	Picture tab
	Parts tab
	Welds


	Frames
	Tapered frame comonor (S53)
	Picture tab
	Parts tab
	Column tab
	Column 2 tab
	Column 3 tab
	Beam 1 tab
	Beam 1_2 tab
	Beam 2 tab
	Beam 2_2 tab
	Welds

	PEB Frame (S92)
	Picture tab
	Parameters tab


	Connections and details
	Pipe column and beam panel zone (21)
	Design dimensions tab
	Fabrication dimensions tab
	Panel parts tab
	Diaphragm tab
	Cantilevers tab
	Bracket tab
	General tab
	Design tab
	Analysis tab
	Welds

	Batten plates (S85)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	Welds

	Tapered column (136)
	Picture tab
	Parameters tab
	Diaphragm tab
	Penetrating diaphragm
	Inner diaphragm
	General tab
	Design tab
	Analysis tab
	Welds

	Tapered beam to tapered column (197)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	Tapered column to tapered beam (199)
	Picture tab
	Parts tab
	Parameters tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	Tapered beam to beam (200)
	Picture tab
	Parts tab
	Chamfer tab
	Bolts tab
	General tab
	Analysis tab
	Welds

	Tapered column base plate (1068)
	Picture tab
	Parts tab
	Bolts tab
	Parameters tab
	Anchor rods tab
	Extra plates tab
	General tab
	Analysis tab
	Welds

	PEB Knee joint (S93)
	Picture tab
	Parts tab
	Bolts tab
	Welds



	2.18  Bracing components
	Glossary of parts
	Simple gusset plate connections
	Simple bolt connection (5)
	Picture tab
	Bolts tab
	General tab
	Analysis tab

	Welded gusset (10)
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	Gusset tab
	Brace conn tab
	Stiffeners tab
	General tab
	Design tab
	Analysis tab
	Welds

	Bolted gusset (11)
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	Gusset tab
	Brace conn
	Stiffeners tab
	Gusset bolts tab
	Brace bolts 1 / Brace bolts 2 / Brace bolts 3 tab
	Angle bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Bracing cross (19)
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	Parameters tab
	Bolts tab
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	Design tab
	Analysis tab
	Welds

	Tube crossing (22)
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	Brace conn tab
	Brace bolts 1 tab
	Rib plates tab
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	Design tab
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	Welds

	Std bracing connection (67)
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	Parameters tab
	Brace bolts 1 tab
	Brace bolts 2 tab
	Gusset tab
	General tab
	Design tab
	Analysis tab
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	Wrapped cross (61)
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	Brace conn tab
	Shim plates tab
	Brace bolts tab
	Angle bolts tab
	General tab
	Design tab
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	Gusseted cross (62)
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	Gusset tab
	Brace conn tab
	Shim plates tab
	Gusset conn tab
	Stiffeners tab
	Brace bolts 1 / Brace bolts 2 / Brace bolts 3 tab
	General tab
	Design tab
	Analysis tab
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	Portal bracing (105)
	Picture tab
	Parts tab
	Parameters tab
	Bolts 1 / Bolts 2 / Bolts 3 tabs
	General tab
	Design tab
	Analysis tab
	Welds

	Bolted gusset (196)
	Picture tab
	Gusset tab
	Brace conn tab
	Gusset bolts tab
	Brace bolts 1 / Brace bolts 2 / Brace bolts 3 tab
	Angle bolts tab
	Stiffeners tab
	General tab
	Design tab
	Analysis tab
	Welds


	Corner bracing connections
	Corner tube gusset (56)
	Picture tab
	Gusset tab
	Brace conn tab
	Stiffeners tab
	Brace bolts 1 / Brace bolts 2 tab
	General tab
	Design tab
	Analysis tab
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	Corner bolted gusset (57)
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	Gusset tab
	Stiffeners tab
	Brace bolts 1 / Brace bolts 2 tabs
	Angle bolts tab
	General tab
	Design tab
	Analysis tab
	Welds

	Wraparound gusset (58)
	Picture tab
	Gusset tab
	Brace conn tab
	Shim plates
	Gusset bolts 1 / Gusset conn 2 tab
	Brace bolts 1 / Brace bolts 2 tab
	Clip angle extra bolts 1 tab
	Beam cut tab
	General tab
	Design tab
	Analysis tab
	Welds

	Hollow brace wraparound gusset (59)
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	Gusset tab
	Brace conn tab
	Gusset conn 1 / Gusset conn 2 tab
	Brace bolts 1 / Brace bolts 2 tab
	General tab
	Design tab
	Analysis tab
	Welds

	Wraparound gusset cross (60)
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	Gusset tab
	Brace conn tab
	Gusset conn 1 / Gusset conn 2 tabs
	Brace bolts 1 / Brace bolts 2 tab
	Angle bolts tab
	General tab
	Design tab
	Analysis tab
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	Corner wrapped gusset (63)
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	Brace conn tab
	Shim plates tab
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	Brace bolts 1 / Brace bolts 2 tab
	Angle bolts 1 / Angle bolts 2 tabs
	General tab
	Design tab
	Analysis tab
	Welds

	Bent gusset (140)
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	Gusset tab
	Gusset bolts tab
	Brace bolts 1 tab
	Brace bolts 2/Brace bolts 3 tab
	Plates tab
	General tab
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